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Chapter 1. Solution overview

Many organizations and endeavors require efficient operational supervision and coordination. All have in
common the need for the right information to be brought together so that the right people can make fast,
accurate decisions and track the effect of those decisions. IBM® Intelligent Operations Center is a software
solution that is designed to facilitate effective supervision and coordination of operations.

Authorities face common challenges in their core systems and in making improvements to systems that
are interconnected. Authorities that are forward-looking want to use the improvements in efficiency and
effectiveness of smarter core systems. They adopt new ways of thinking about and using these systems.
The application of advanced information technology can help authorities better understand, predict, and
intelligently respond to patterns of behavior and events.

For example, IBM defines an intelligent city in terms of the improvements in quality of life and economic
well-being that are achieved through applying information technologies (IT) to plan, design, build, and
operate the city infrastructure. An intelligent city is not primarily about "the latest technology." It is about
finding ways to use technology to make the most effective use of the existing resources, to improve the
life of the citizens of the city.

IBM Intelligent Operations Center uses the power of the real-world data that is generated by computer
systems by performing the following tasks:
v Collecting and managing the right data
v Integrating and analyzing that data
v Facilitating easy and timely access to information
v Presenting related information in a coherent way

The benefits of this solution are to:
v Adjust systems to achieve results that are based on the insights that are gained
v Optimize planned and unplanned operations by using a holistic reporting and monitoring approach
v Build convergence of domains in an organization by facilitating communication and collaboration
v Improve quality of service and reduce expense by coordinating events

An operation can be divided into individual domains, which generally match with the organization
structure and the expertise of the people involved. In a city, the expertise is held in departments, for
example, in transportation, water, and public safety.

As the complexity of operations in a domain increases, a more customized solution is required. IBM
Intelligent Operations Center has a number of different integration points where customization can take
place. These integration points and the infrastructure that is included give IBM Business Partners, service
providers, and customers the flexibility to build a broad and powerful solution.

Intended audience
This product documentation is intended for people who are using, installing, administering, and
maintaining IBM Intelligent Operations Center. It also contains implementation documentation for
configuring the solution and integrating the external underlying systems that IBM Intelligent Operations
Center requires.

This product documentation is based on the assumption that users have prior knowledge of or
proficiency in using the component products that are included in this solution. The product
documentation is also based on the assumption that users have a basic knowledge of the Red Hat
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Enterprise Linux operating system. Training for the component products or the operating system is
outside the scope of this product documentation. If you require training for these products, ask your
systems integrator or IBM representative where you can obtain information about base component
training opportunities.

Features
IBM Intelligent Operations Center provides measuring, monitoring, and modeling facilities that can
integrate underlying systems into one solution to improve operational efficiency, planning, and
coordination.

IBM Intelligent Operations Center is a product within the IBM Smarter Cities® Software Solutions product
family. IBM Intelligent Operations Center can be installed on existing hardware (on premises) or it can be
deployed in the cloud. IBM Intelligent Operations Center can be installed by itself, or you can install it
with other products from the IBM Smarter Cities Software Solutions product family.

IBM Intelligent Operations Center is a GUI-based product that provides role-based access to data for an
organization and underlying domains. It has event management and integrated mapping capabilities. The
solution can supply and track the appropriate procedures and activities in preparation for and response
to events. It also has key performance indicator (KPI), reporting, and collaboration capabilities for
improved effectiveness. These features provide authorities with the ability to integrate domains for
improved cooperation and decision-making.

Event and data management

IBM Intelligent Operations Center provides an event reporting and data tracking mechanism to enable
identification and understanding across underlying domains. You can manage predicted events, planned
events, and current events as they evolve. For example, replacing pipes that run under a road is a
planned event or work order that involves both water and traffic operations. A severe weather event that
is forecast to arrive in the next 24 hours is a predicted event. A traffic jam is a current event that is
affected by both the road works and weather.

An integrated geographic information system (GIS) or location plan maps events visually. You can gauge
the impact of events through interactive mapping and scenario analysis. You can filter information about
events that are based on date and time, location, and other categories that you define. You can view the
filtered information either highlighted on a map, or listed in a table. The information is easy to access
when and where you need it.

Response and activity management

IBM Intelligent Operations Center provides a system for storing appropriate procedures and activities
that are associated with events. You can track the progress of procedures, and monitor or update the
status of activities that are assigned to you.

Status monitoring

IBM Intelligent Operations Center provides a tool for creating and displaying KPIs. The KPIs can be
updated as underlying data changes. You can accomplish the following tasks:
v Summarize executive-level status for a single domain or across domains
v Highlight issues and identify problems
v Investigate further by drilling down into the KPI details
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Instant notification and messaging

IBM Intelligent Operations Center provides a workspace where you can maintain notifications for matters
that need attention. You can use this workspace to monitor KPIs.

IBM Lotus® Sametime® provides an integrated collaboration and communication tool that you can use for
instant messages where and when it is needed.

Viewing reports

In IBM Intelligent Operations Center you can view reports of events as graphs, tables, or pie charts. You
can filter the information that is displayed in the reports that are based on date and time, location, and
other categories that you define. You can use this facility to collect and present the information that is
most useful to you on an up-to-date and regular basis. This facility gives you all the advantages of
tailored summaries and graphical presentation.

Users and benefits
IBM Intelligent Operations Center is designed for personnel who are involved with operational control in
organizations, government departments, and local or city authorities: executives, supervisors, and
operators.

The following table describes the users and benefits that are associated with using IBM Intelligent
Operations Center.

Table 1. IBM Intelligent Operations Center users and benefits

If you are a... This software can help you...

Executive v Gain an executive level summary of events through
maps, dashboards, and notifications

v Determine measures of organizational success with
key performance indicators (KPIs)

v Identify and track issues through reports

v Direct priorities and implementation of policy that is
based on data that is provided

Supervisor v Identify and act on conflicts and issues that are shown
on maps, dashboards, and notifications

v Manage events by adding new events, editing existing
events, and canceling events

v Store and manage the execution of procedures and
activities that are associated with events

v Monitor KPIs

v Communicate quickly and easily on matters of
importance

v View filtered data in reports

Operator v Create, edit, and monitor events that are displayed in
maps and lists

v Receive and update status on assigned activities

v Run regular and up-to-date reports

v Communicate quickly and easily in emergencies and
other situations that require a response
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Table 1. IBM Intelligent Operations Center users and benefits (continued)

If you are a... This software can help you...

Solution administrator v Create, update, and delete data sources

v Configure the filter options that are displayed to users

v Configure the geospatial map, and the location maps

v Manage KPI relationships, and configure how KPIs are
displayed to users

v Create and edit standard operating procedure
definitions

System administrator v Administer individual components of the system
through administration consoles

v Verify components of the system by running the
system verification check tool

v Add, modify, and delete system properties

v Add new users and assign them to the appropriate
role-based authorization group

v Ensure data security by assigning permissions to
access data sources to the appropriate users and
groups

v Set up permissions that are appropriate to the required
areas of expertise and required access to data sources

v Customize pages to suit the organization
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Components
At a high level, the structure of IBM Intelligent Operations Center can be divided into major components,
subsystems, and services.

The following diagram shows a high-level view of IBM Intelligent Operations Center.
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IBM Intelligent Operations Center provides web-based, one-stop portals to event information, overall
status, and details. The user interface (UI) presents customized information in various preconfigured
views in common formats. All information is displayed through easy-to-use dashboards.

Web server

The web server manages client requests to IBM Intelligent Operations Center.

Application server

The application server provides a set of services for accessing and visualizing data that is managed by
IBM Intelligent Operations Center. The data ingest service is used to import data from disparate external
sources, such as databases and files. Because of the variety of data that can be supplied from these
external sources, the data is normalized into a common format that can be used to calculate key
performance indicators, trigger standard operating procedures and notifications, and provide
spatial-temporal data.
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The contacts and instant messaging service provides capabilities that enable effective, real-time
communication.

The business monitoring service monitors incoming data records, and uses the information that is
contained in the data records to generate key performance indicators. In the user interface layer, that is
provided by the Portal service, users can view key performance indicators, standard operating
procedures, notifications, and reports. Users can also view spatial-temporal data on a geospatial map, or
they can view specific details that represent a building or a stadium either on a location map, or in a list
view.

The application server provides security services that ensure only authorized users and groups can access
data.

Data server

The data server stores all the databases that are used in IBM Intelligent Operations Center.

Analytics server

The analytics server contains the following components that might be used by either custom solutions, or
by other domain applications:

Messaging service and broker service
The messaging service that is provided by WebSphere® MQ, and the broker service that is
provided by WebSphere Message Broker, can be used to receive and transform data in formats
that IBM Intelligent Operations Center does not support. When the data is transformed, it can be
written either to a database table, or to a CSV file that IBM Intelligent Operations Center can
process.

Analytic service
The analytic service contains IBMSPSS® WebSphere Business Modeler and IBM ILOG® CPLEX®

Optimization Studio.

Report service
You can use the report service that is provided by IBM Cognos® Report Studio to generate
reports.

Related concepts:
“Administering the services” on page 187
Use the Administration Consoles to administer the services that are provided by the solution.
Related tasks:
“Verifying the installation” on page 87
After installing IBM Intelligent Operations Center , verify that the product has been correctly installed.
Verification ensures all components are started and operating as expected.

Event management
IBM Intelligent Operations Center focuses on the integration and optimization of information within and
across multiple domains in a central operations hub, in real time and over long periods. Event data
management enables IBM Intelligent Operations Center to assimilate data from multiple systems to
constantly predict and react to significant events and trends.

Event messages are self-contained data items that contain basic but complete information to which
recipients can respond. The IBM Intelligent Operations Center data receiver component pulls data items
from CSV files and database tables. In addition, data items can be sent to IBM Intelligent Operations
Center through a REST API.
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Events come into IBM Intelligent Operations Center in different forms, which are based on the nature of
the operations and domains in the central operations hub. Some examples of the forms of event are
triggers, thresholds, complex events, and manually generated events.

Triggers are events that are generated by something that happens and usually require an action to be
taken by the recipient. The following list contains some examples of triggers:
v Fire or smoke alarms that are set off
v Information technology systems that go down
v Intrusion detectors that are tripped
v Natural events that are picked up by sensors, such as earth tremors

IBM Intelligent Operations Center can receive information about such events from external systems and
route it to the appropriate action. For example, the appropriate action might be to trigger a procedure, or
to route the information to an integration point. In general, it is likely that lower-level indicators would
be summarized and only passed to the IBM Intelligent Operations Center if they merited wider attention.
For example, all fires might not be reported as events. However, a fire that involves multiple divisions of
the fire service and environmental protection expertise, because of hazardous material, would merit
reporting to the operations center.

Threshold events help you determine when the measurements that are obtained from a sensor or other
source have moved outside the normal range. Basic threshold events are comparisons that compare two
or more measures and report a trend. More sophisticated threshold events can compare measures against
a threshold that is created by historical information. The following events are examples of threshold
events:
v Over and under temperature alarms
v High and low water levels
v Air quality and water purity that breaches environmental standards
v Excessive power consumption

IBM Intelligent Operations Center can manage such events in the form of key performance indicators
(KPIs).

Complex events bring together information from multiple systems to determine whether a group of
related events should be reported. For example, the toll road authority receives a trigger event from its
monitoring system that indicates that the computer link for credit card authorization is down, followed
shortly by a threshold event from the financial system warning that they are close to their credit limit for
unauthorized payments. The combination of the two issues is much more serious than either in isolation,
so a complex event is generated to raise awareness and coordinate a resolution.

Events that are entered manually are especially important to cities. Some of the events are observed
incidents, such as crimes and traffic accidents. Other examples of events that are entered manually are
those events that are generated from emergency calls from citizens, from reports that are made by city
officials, or from management systems that report on city status. The following events are the most
common types of event that are entered manually:
v Severe weather warnings
v Crime reports
v Fires
v Road traffic incidents – accidents, congestion, unusual loads
v Upcoming events – rock concerts, road races, parades

Complex event processing allows a city to easily identify exceptions to city systems, occasionally to
identify trends from unrelated data, and to predict future issues.
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What's new in version 1.6
IBM Intelligent Operations Center 1.6 introduces useful new features for the administrator and the user.

In the documentation, the following icons are used:

v Features that are available if you install interim fix PO01443 are indicated by a green plus icon.
Interim fix PO01443 provides Common Alerting Protocol (CAP) event support for IBM Intelligent
Operations Center version 1.6. CAP event support is included automatically in IBM Intelligent
Operations Center version 1.6.0.1.

v 1.6.0.1 Features that are available in IBM Intelligent Operations Center version 1.6.0.1 are indicated
by an icon that contains the text “1.6.0.1”.

v 1.6.0.2 Features that are available in IBM Intelligent Operations Center version 1.6.0.2 are indicated
by an icon that contains the text “1.6.0.2”.

Related information:

Interim fix download for CAP event support for IBM Intelligent Operations Center V1.6

What's new for the user
In IBM Intelligent Operations Center 1.6, you can use the new filter panel to filter the data that is
displayed on a map, or in reports.

Filtering data on the maps and in the list

Use the new filter panel to filter data:
v Displayed either on a geospatial map, on a location map, or in a list.
v Based on date and time, location, and other categories such as the type or source of the event.
v Save your current filter settings so that you easily reapply them later.

To learn more about the filter panel, see the link at the end of the topic.

Viewing the maps with added detail

Location map markers indicators indicate positions on the map where one or more detailed maps are
available with information on that location.

You can add your own data items to geospatial maps, to location maps, or to the list of data item details.

To learn more about viewing maps and list, see the link at the end of the topic.

Filtering data in reports

You can view reports of events as either graphs, tables, or bar charts. You can customize the data that is
displayed in the reports by setting the appropriate options in the filter panel.

To learn more about viewing reports, see the link at the end of the topic.
Related concepts:
“Filtering data on the maps and list” on page 378
In the appropriate operations view, use the filter panel to define what data is displayed in the content
panel. The content panel contains the Map tab, the Location Map tab, and the List tab.
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“Viewing data on the maps and list” on page 369
In the content panel of the operations view, you can view data on a geospatial map, on a location map,
or in list format.
“Viewing reports” on page 382
Use the supporting content panel to view reports of events as graphs, tables, or pie charts. The reports
that are displayed are dependent on specific data source outputs and specific events that you can select
from the filter panel and that are visible in the current view of the map only. View data source results by
time, either in bar chart or tabular format. You can also view results by data source, either in pie chart or
tabular format. Toggle between the chart and tabular format by clicking the Chart and List tabs in the
Data Source Results By Time and Total Results By Data Source reports. These reports help you to identify
trends and plan responses to current and future events.

What's new for the administrator
In version 1.6, the Solution Administration view provides new configuration wizards for configuring data
sources, and standard operating procedures. You can also configure the maps and associated filter
options, and key performance indicators (KPIs).

Configuring data sources

Use the Data Sources tool to configure a data source that supplies data to IBM Intelligent Operations
Center
v Give basic instructions about how the data is processed, for example, how often to check for new data.
v Choose the geometry format and how to supply information about position to represent the data item

on the map.
v Assign the appropriate access to data and authorization privileges for your data source to portal

groups or users.
v From the available actions, select a set of allowable actions that can be performed on the data items

that are associated with the data source.

Data can be acquired either from a CSV file or from a database.

Data can be acquired from CAP messages.

1.6.0.1 1.6.0.2 Solution administrators can create a data source that can be used to supply data
items through only either the user interface, or the REST API. This type of data source is not connected to
an external source.

Data can be routed to the solution as a whole, to key performance indicators (KPIs), to a selected
standard operating procedure, or to a predefined integration topic.

1.6.0.1 1.6.0.2 Data can also be routed to a correlation topic.

To learn more about configuring data sources, see the link at the end of the topic.

Defining standard operating procedures and activities

Use the wizard to define standard operating procedures and activities:
v Define and assign different types of activities to standard operating procedure definitions; examples of

activity types include a conditional activity for which you specify if-then-else conditions, or a REST
activity that sends a call to a REST service.

v Assign owners and monitors to the activities; if an instance of a standard operating procedure is
launched, the activities are automatically assigned to the owners that you specify in the definition.
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v Launch an instance of a standard operating procedure; also, in a data source definition, you can specify
that a standard operating procedure is launched automatically in response to an event.

To learn more about defining standard operating procedures and activities, see the link at the end of
the topic.

Configuring the geospatial map and location maps

You can use a graphical user interface to configure the base map, pan, and zoom for the geospatial maps
display.

When you are configuring a location map, you assign it to a collection and a position on the geospatial
map. The collection is then represented by a marker on the geospatial map.

To learn more about configuring the geospatial map and location maps, see the link at the end of the
topic.

Customizing the filter panel

Customize the filter panel to make it easier for your users to view the data that is relevant to them:
v Add date and time ranges, and holiday ranges, to the Date & Time pane.
v Add your own filter panes to organize and group data sources for more efficient filter selections.
v Reorder filter panes, and reorder the data sources that they contain.

To learn more about customizing the filter panel, see the link at the end of the topic.

Customizing key performance indicators

When you customize KPIs, there is an extra option available to edit the KPI permissions. You can specify
who is authorized to see specific KPIs.

To learn more about customizing key performance indicator hierarchies, see the link at the end of
the topic.

Working with system properties

In the Solution Administration view, you can see all the IBM Intelligent Operations Center system
properties at a glance:
v Create, modify, and delete system properties.
v Assign system properties to groups, for easier retrieval through the REST service.

To learn more about creating and editing system properties, see the link at the end of the topic.

Translating field text

Use the translation wizard to specify translated versions of fields that are displayed in the user interface.
The language that is displayed depends on the locale that is selected in either the user profile, or in the
browser.

To learn more about translating field text, see the link at the end of the topic.
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REST APIs

IBM Intelligent Operations Center provides a set of APIs that are implemented using Representational
State Transfer (REST) Services. The REST services provide a set of uniform resource identifiers (URIs) that
you can use to access and edit data in IBM Intelligent Operations Center components, such as data
sources, the filter panel, KPIs, and system properties.

To learn more about using the REST APIs, see the link at the end of the topic.
Related concepts:
“Configuring a data source” on page 99
Use the Data Sources tool to configure a data source that supplies data to IBM Intelligent Operations
Center.
“Configuring standard operating procedures” on page 136
A standard operating procedure is a set of instructions that describes all the relevant steps and activities
of a process or procedure. Standard operating procedures are essential to an organization to deliver
consistent, measured, high-quality responses to complex and unpredictable events.
“Configuring geospatial maps” on page 117
In the Solution Administration view, you can configure the maps that are available to the user, the initial
map center point, and the map zoom level.
“Configuring location maps” on page 132
In the System Administration view, you can customize location maps for display on the Location Map
tab. The Location Map tab is part of the content panel on the operations views.
“Configuring the filter panel” on page 114
In the Solution Administration view, you can decide how you want to group data sources. Then, for each
group, you can configure a pane that is displayed in the filter panel. The data sources that you select are
listed in the pane.
“Configuring KPIs” on page 120
In the Solution Administration view, you can configure Key Performance Indicators (KPIs) and their
hierarchical display in the user interface. The KPIs are displayed on the status views in IBM Intelligent
Operations Center.
Related tasks:
“Configuring system properties” on page 189
View, create, modify, and delete system properties in the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent Operations Center.
“Translating field text” on page 171
Use the translation wizard to enter a translation for any field where you can enter text. Translated fields
are displayed in the user interface according to the locale that is selected in either the user profile, or in
the browser.
Related reference:
“IBM Intelligent Operations Center REST interface” on page 455
IBM Intelligent Operations Center provides a set of APIs that are implemented by using Representational
State Transfer (REST) Services. The REST services provide a set of uniform resource identifiers (URIs) that
access data in IBM Intelligent Operations Center components, such as system properties and key
performance indicators (KPIs).

What's new for the installer
IBM Intelligent Operations Center 1.6 provides installation enhancements and additional environment
support.
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High availability environment configuration

IBM Intelligent Operations Center 1.6 can be installed in a standard or high availability environment. The
high availability environment provides failover support to standby servers. Failover improves the
reliability of the overall IBM Intelligent Operations Center system.

Installation options

IBM Intelligent Operations Center 1.6 provides four installation options: two for a standard environment
and two for a high availability environment. For each environment a GUI installer and command line
installer are provided.

The GUI installer installs a predefined IBM Intelligent Operations Center configuration allowing minimal
customization during the installation progress.

The command line installer provides greater configuration flexibility during the installation process and
should be used where the GUI installer does not meet environment requirements.

What's new in version 1.6.0.1
1.6.0.1

IBM Intelligent Operations Center version 1.6.0.1 provides several new features, and provides updates to
existing features. New features include support for data filtering by area on the map, data analysis, and
data correlation.

Named areas

Solution administrators can configure data sources to be available as named area types. In the operations
views, users can then filter data based on boundaries that are defined by named areas. The named areas
are defined in data items that are received from named area type data sources.

Users can also use area status views to obtain a view of key performance indicators (KPIs) that highlights
key data for specific named areas.

To learn more about named areas and filtering by boundary, see the links.

Area data items

Users can create a data item that contains a new area that is drawn by the user on a geospatial map. The
data item is displayed on the maps and in the list.

To learn more about creating a data item that contains a new area, see the link.

Data analysis

Data analysis can be used to highlight patterns of data in relation to time and position by generating
hotspots on the geospatial map. Solution administrators can use the Hotspots tool to configure hotspot
analysis definitions.

Users can run hotspot analysis to identify patterns of data on the map that can increase their
understanding of the data and help decision-making.

To learn more about data analysis and hotspots, see the link.
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Data source acquisition

Solution administrators can now create a data source that can be used to supply data items through
either the user interface entry, or the REST API methods only. This type of data source is not connected to
an external source, and all the data source properties are preassigned.

If a database is used to acquire data, data can now be acquired from SQL Server databases, or from DB2®

databases.

Data can also now be acquired from CAP messages.

To learn more about data source acquisition methods, see the link.

CAP event support

CAP event support is included automatically in IBM Intelligent Operations Center version 1.6.0.1. Interim
fix PO01443 provides Common Alerting Protocol (CAP) event support for IBM Intelligent Operations
Center version 1.6.

To learn more about CAP event support, see the link.

Data correlation

A solution administrator can configure a data source to be available for correlation. A solution
administrator can also configure routing criteria to route data items from a data source to a correlation
topic. The correlation process sends notifications when correlations occur.

To learn more about data correlation, see the link.

Linking data items to standard operating procedures

Through the preview card, users can either associate a data item to an instance of a standard operating
procedure that is already running, or users can launch a new instance of a standard operating procedure.

To learn more about linking data items to standard operating procedures, see the link.

Notifications

Notifications now displays errors that result from background processes. The Notifications list also
indicates the severity of each notification.

To learn more about Notifications, see the link.

Cognos reports

Solution administrators can use a new theme to create reports pages, and a new reports portlet for
displaying Cognos reports. Reports pages are displayed as views in the IBM Intelligent Operations Center
interface.

To learn more about displaying Cognos reports, see the link.
Related concepts:
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“Area status with KPIs” on page 367
Use the area status views to obtain a view of key performance indicators (KPIs) that highlights key data
for specific named areas. Users can monitor, manage, and respond to status changes in relation to
organizational performance in specific areas of the map.
“Analyzing data hotspots” on page 385
Use the Map tab to analyze data, for the areas that you select on the map, in the form of hotspots that
are generated by a predefined analysis. The hotspots view assists you in monitoring, managing, and
responding to key issues.
“Configuring hotspot analysis” on page 128
Use the Hotspots tool to configure hotspot analysis definitions for the solution. Hotspot analysis can
highlight patterns of data in relation to time and position on the geospatial map. As an administrator you
can create a hotspot analysis definition, update an analysis that is already listed, or delete a hotspot
analysis definition from the solution.
“Integrating with the CAP” on page 166
You can use the Common Alerting Protocol (CAP) to exchange data between IBM Intelligent Operations
Center and external systems.
“Data item correlation” on page 155
A solution administrator can configure a data source to be available for correlation. A solution
administrator can also configure routing criteria to route data items from a data source to a correlation
topic. When a data item is routed to a correlation topic, the correlation process assesses whether the data
item is correlated with other correlation data items. The correlation process sends notifications when
correlations occur.
“Viewing notifications” on page 387
Click Notifications to view a dynamic list of your notifications and their details.
Related tasks:
“Filtering by boundary” on page 379
In the Boundary pane, define the boundary for which you want data to be displayed in the content
panel.
“Adding an area or a line data item” on page 373
You can create a data item that is associated with an area on a geospatial map and added to a data
source. The data item is added to the Map and List tabs at the same time.
“Creating a data source” on page 101
As an administrator, you can use the data sources tool to add and configure a data source.
“Linking data items to standard operating procedures” on page 391
Through the preview card, you can either associate a data item to an instance of a standard operating
procedure that is already running, or you can launch a new instance of a standard operating procedure.
“Displaying Cognos reports” on page 183
IBM Intelligent Operations Center provides a theme for creating reports pages and a reports portlet for
displaying Cognos reports. When you create a reports page, the page is displayed as a view in the IBM
Intelligent Operations Center interface.
Related information:

Interim fix download for CAP event support for IBM Intelligent Operations Center V1.6

What's new in version 1.6.0.2
1.6.0.2

IBM Intelligent Operations Center version 1.6.0.2 provides several new features, and provides updates to
existing features. New features include enhanced user profile management, where users can customize
notification settings. Solution administrators can use a new component customization tool to create
customized user interface components. For KPIs, solution administrators can map KPIs to reports.
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User profile

Users can configure what notifications they receive, and how they receive them. Users can choose
whether a dark theme, or a new gray theme, is applied to their views.

To learn more about editing user profiles, see the links.

Notifications

The Notifications window has been enhanced to provide more information about notifications.
Color-coded icons indicate the severity of notifications at a glance, and system errors from background
processes are included in notifications.

Users can now configure their notifications settings in their user profile. Users can choose to receive KPI
notifications, and to receive system error notifications that relate to the import of data. In addition to
system notifications that are displayed in the Notifications window, users can also receive SMS and email
notifications, if they are configured by an administrator.

To learn more about notifications, see the links.

Map

Users can create a data item that is associated with an area on a geospatial map and added to a data
source. The categories of areas that users can now draw on the map include multi-points, lines,
multi-lines, and multi-areas.

Through the More Actions menu, users can now browse and upload, directly from any location, a CSV
file that supplies data for the selected data source.

Administrators can set the maximum number of data items that are rendered on the map by configuring
the MaxFeaturesToRenderOnMap system property. Limiting the number of data items that are rendered on
the map can help to improve performance.

To learn more about updates to the map, see the links.

Customizing components

Solution administrators can use a new component customization tool that is in the Solution
Administration view to extend and customize the functionality of the solution. Administrators can create
customized components that they can add to the user interface. They can also replace an existing
component with a customized component. Administrators can customize the preview cards and full
properties windows that are displayed for data items in the maps, and in the list. For data sources,
administrators can assign customized actions that are displayed in the More Actions menu. Finally,
administrators can also customize how data items, and hotspots, are rendered on the map by configuring
the advanced visualization component type.

To learn more about customizing components, see the links.

KPIs

Solution administrators can map KPIs to reports that are displayed in the status views, and that users can
view to analyze trends in KPIs.
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Administrators can create, import, and export hierarchies of KPIs that are associated with IBM Intelligent
Operations Center.

To learn more about KPI reports and KPI hierarchies, see the links.

Data sources

In the data sources tool that is in the Solution Administration view, if you acquire data from a CSV file,
you can now browse and upload a CSV file directly from any location.

You can use a new area mapping minimal property to determine whether incoming data items are
contained within the boundary of any data item from one of a list of specified named area type data
sources.

If you route data to a standard operating procedure, you can choose whether, for every matching record,
to launch a new instance of the standard operating procedure. Alternatively, you can choose to update an
existing instance of an active standard operating procedure.

To learn more about updates to the data sources tool, see the links.

Installed products

The products installed with IBM Intelligent Operations Center have been updated to more current release
levels:
v WebSphere Application Server Network Deployment 7.0.0.27 to 7.0.0.31.
v WebSphere Application Server Network Deployment 8.0.0.6 to 8.0.0.8 .
v IBM HTTP Server (and the WebSphere Application Server plug-in) 8.0.0.6 to 8.0.0.8 .
v WebSphere Portal Enable 8.0.0.1 CF 05 to 8.0.0.1 CF 08 (including GSKit fix IFPI05309).
v IBM Java™ 1.7.0.4.2 to 1.7.0.6.1.
v DB2 Enterprise Server Edition 10.1.0.1 to 10.1.0.3.
v Tivoli® Directory Integrator 7.1.1.2 to 7.1.1.3.
v Tivoli Directory Server 6.3.0.18 to 6.3.0.26 (including the GSKit 8.0.50.16).
v IBM Security Identity Manager 6.0 to 6.0.0.2.
v IBM Message Broker 8.0.0.1 to 8.0.0.3.
v IBM ILOG CPLEX Optimization Studio 12.5 to 12.6.

To learn more about the products installed with IBM Intelligent Operations Center 1.6.0.2, see the
links.

Newly installed SDK

The IBM Cognos Business Intelligence 10.2 SDK is installed with IBM Intelligent Operations Center
1.6.0.2.

Platform control tool

The following updates have been implemented in the platform control tool:
v The IOCControl tool syntax has been simplified using the same syntax for the standard and high

availability environments.
v A standard component naming scheme has been implemented for both the standard and high

availability environments to simplify starting, stopping, and querying components.
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v High availability disaster recovery (HADR) start and stop functionality has been improved.

To learn more about the platform control tool, see the links.

Installation precheck

The following updates have been implemented to the installation precheck step:
v Checks added to determine if enough disk space is available on each server.
v Checks added for new RPM requirements.
v Checks added to ensure passwords in properties files are correct for their user IDs.
Related concepts:
“Localizing the user interface” on page 171
To change the locale and time zone that are displayed in the solution portal, edit your user profile. If you
do not configure specific locale settings in your user profile, the browser settings are applied. The locale
and time zone settings that you configure in your user profile override your browser settings.
“Viewing notifications” on page 387
Click Notifications to view a dynamic list of your notifications and their details.
“Starting, stopping, and querying status in a standard environment” on page 190
The platform control tool allows a user to stop, start, and query IBM Intelligent Operations Center
components running in a standard environment. A platform control tool tool is also available for IBM
Intelligent Operations Center running in a high availability environment.
“Starting, stopping, and querying status in a high availability environment” on page 198
The platform control tool allows a user to stop, start, and query IBM Intelligent Operations Center
services running in a high availability environment. A platform control tool tool is also available for IBM
Intelligent Operations Center running in a standard environment.
Related tasks:
“Adding an area or a line data item” on page 373
You can create a data item that is associated with an area on a geospatial map and added to a data
source. The data item is added to the Map and List tabs at the same time.
“Adding a point data item” on page 372
Create a data item that is associated with a point on the map. The data item is added to the Map and List
tabs at the same time.
“Exporting or importing KPI hierarchies” on page 122
You can create a hierarchy of KPIs that are associated with the IBM Intelligent Operations Center
solution. As an administrator, you can import an existing KPI hierarchy as a JavaScript Object Notation
(JSON) file, or export the existing KPI hierarchy to a JSON file.
“Mapping KPIs to reports” on page 125
As an administrator, you can map KPIs to reports that are displayed in the status views. You can map the
same report to more than one KPI. Optionally, you can add a set of parameters to each report that might
modify the data that is displayed by the report. The parameter values are used to generate a Cognos
reports query, and the parameter values are also displayed as a label on the instance of the generated
report.
“Viewing reports from KPI preview cards” on page 385
From the KPI preview cards in the status views, you can view reports that are mapped to KPIs.
“Viewing or editing your user profile” on page 169
You can view and edit the information in your solution user profile. Edit your user profile to set your
time zone, language preference, and notification settings. You can also reset your password and modify
your personal details.
“Setting displayed and returned data item limits” on page 118
You can set the maximum number of data items that are returned to the map and the list, and that are
rendered on the map.
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“Customizing components” on page 174
To extend and customize the functionality of your solution, you can create customized components that
you can add to the user interface. You can also replace an existing component with a customized
component. For example, for a particular system component, you can replace an existing preview card
with a new, customized preview card.
“Creating a data source” on page 101
As an administrator, you can use the data sources tool to add and configure a data source.
“Routing data from your data source” on page 111
For the data that is received from your data source, set routing expressions that define how the data is
processed by the solution. Data items that match the required expression or combination of expressions
are routed to the selected destination.
Related reference:
“Data source minimal property settings” on page 105
Assign properties from your data source to each minimal property and choose the settings that are
appropriate for your data.
“Products and components installed with IBM Intelligent Operations Center in a standard topology” on
page 456
The IBM Intelligent Operations Center solution installs a number of software products and components
for the standard topology.
“Products and components installed with IBM Intelligent Operations Center in a high availability
topology” on page 460
The IBM Intelligent Operations Center solution installs a number of software products and components
for the high availability topology.
“Products included, but not installed, with IBM Intelligent Operations Center” on page 462
The IBM Intelligent Operations Center package includes products that are not installed when IBM
Intelligent Operations Center is installed. If required for specific use cases, these products can be installed
after IBM Intelligent Operations Center is installed.

Copyright notice and trademarks

Copyright notice
© Copyright IBM Corporation 2011, 2014. All rights reserved. May only be used pursuant to an IBM
software license agreement. No part of this publication may be reproduced, transmitted, transcribed,
stored in a retrieval system, or translated into any computer language, in any form or by any means,
electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, without prior written
permission of IBM Corporation. IBM Corporation grants you limited permission to make hardcopy or
other reproductions of any machine-readable documentation for your own use, provided that each such
reproduction shall carry the IBM Corporation copyright notice. No other rights under copyright are
granted without prior written permission of IBM Corporation. The document is not intended for
production and is furnished “as is” without warranty of any kind. All warranties on this document are
hereby disclaimed, including the warranty of non-infringement and the implied warranties of
merchantability and fitness for a particular purpose.

U.S. Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP
Schedule Contract with IBM Corporation.

Trademarks
Cognos, CPLEX, IBM, ibm.com®, DB2, Domino®, GDDM®, ILOG, Lotus, Notes®, Passport Advantage®,
Rational®, Sametime, Tivoli, Service Request Manager®, Smarter Cities, SPSS, Redbooks®, WebSphere, and
Worklight®, are trademarks of the IBM Corporation in the United States, other countries, or both.
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Microsoft, Internet Explorer, Windows, and the Windows logo are trademarks of Microsoft Corporation in
the United States, other countries, or both.

Intel and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the
United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Adobe, Acrobat, Portable Document Format (PDF), and PostScript are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States, other countries, or both.

Oracle, Javascript, JavaBeans, and Java are registered trademarks of Oracle and/or its affiliates.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other names may be trademarks of their respective owners. Other company, product, and service names
may be trademarks or service marks of others.
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Chapter 2. Installing the solution

IBM Intelligent Operations Center provides installation options to install the IBM Intelligent Operations
Center environment and application. After installing IBM Intelligent Operations Center, some additional
configuration is required.

Preparing for installation
Before deploying IBM Intelligent Operations Center, understand the IBM Intelligent Operations Center
system configuration and ensure that the prerequisites are met for the environment.

IBM Intelligent Operations Center system services
IBM Intelligent Operations Center servers provide a number of services.

Analytics services
Provides data analysis, presentation, and reporting services.

Application build quality assurance services
Provides collaboration, automation and governance services for project information and status
updates throughout the development lifecycle.

Application design and development services
Provides services for work-items, project activities, build, team progress dashboards and reports,
planning, advanced source control and software configuration management.

Application deployment and management services
Provides services for software assembly, deployment and management.

Application services
Provides Java Enterprise Edition services supporting the solution.

Authentication and authorization services
Provides authentication and authorization services to the solution, applications, and other
services.

Business monitoring services
Provides aggregation, analysis, and presentation of business process and activity information in
real-time.

Collaboration services
Provides services to enable real-time collaboration for users and applications.

Configuration services
Manages the product configuration including inventory and change management.

Database services
Provides the database services for the solution and applications.

Event ingestion services
Provides services to collect, aggregate, present, and handle system events.

Identity management services
Provides services to manage the IBM Intelligent Operations Center application and end user IDs.

Installation services
Provides services to install IBM Intelligent Operations Center.

KPI services
Provides services to handle key performance indicators and associated actions.
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Messaging services
Provides message and workflow services.

Mobile services
Provides services enabling mobile users.

Password management services
Provides services to manage solution passwords.

Platform management services
Provides runtime management services including the ability to start, stop, and query the status of
IBM Intelligent Operations Center services and components.

Platform usage services
Provides services to analyze solution usage.

Standard operating procedure services
Provides services handling the processing of standard operating procedures.

Usage analysis services
Provides logging of usage data such as user log on, log out, timeout, and log in failures.

User directory integration - password synchronization plug-in services
Provides password synchronization where password changes are intercepted at the end points
and redirected to the identity management services.

User interface services
Provides services supporting user interaction with the product.

User directory and user directory integration services
Provides mapping between user and group names and values and integration with additional
directories.

Web services
Provides HTTP, HTTPS, and other web services to the solution.

The following service is only available if the optional semantic model server is installed.

Semantic model services
Provides services allowing applications to model real world objects and relationships.

The following service is only available if the optional Data Studio tool is installed.

Data design services
Provides data design capabilities to application builders.

IBM Intelligent Operations Center servers in the standard topology
IBM Intelligent Operations Center is installed on four servers in a standard topology.

Application server
This server provides the following services:
v Application services
v Business monitoring services
v User Interface services
v Collaboration services
v Mobile services
v Identity management services
v Authentication services
v Password management services
v Platform usage services

22 IBM Intelligent Operations Center: IBM Intelligent Operations Center Product Documentation



v KPI services
v Event ingestion services
v Standard operating procedure services
v Usage analysis services
v User directory integration - password synchronization plug-in services

Data server
This server provides the following services:
v Database services
v Data design services
v User directory services
v User directory integration services
v User directory integration - password synchronization plug-in services

Analytics server
This server provides the following services:
v Installation services
v Messaging services
v Analytics services
v Platform management services
v Messaging services
v Reporting services
v User directory integration - password synchronization plug-in services

Web server
This server provides the following service:
v Web server services
v User directory integration - password synchronization plug-in services

Semantic model server (optional)
This server provides the following service:
v Semantic model services

IBM Intelligent Operations Center servers in the high availability
topology
IBM Intelligent Operations Center is installed on eight servers in a high availability topology
environment.

Application server 1
This server provides the following services:
v Application services
v Business monitoring services
v User Interface services
v Collaboration services
v Mobile services
v Identity management services
v Authentication services
v Password management services
v Platform usage services
v KPI services
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v Event ingestion services
v Standard operating procedure services
v Usage analysis services
v User directory integration - password synchronization plug-in services

Application server 2
This server provides the following services:
v Application services
v Business monitoring services
v User Interface services
v Mobile services
v Authentication services
v Platform usage services
v KPI services
v Event ingestion services
v Standard operating procedure services
v Usage analysis services
v User directory integration - password synchronization plug-in services

Data server 1
This server provides the following services:
v Database services
v Data design services
v User directory services
v User directory integration services
v User directory integration - password synchronization plug-in services

Data server 2
This server provides the following services:
v Database services
v Data design services
v User directory services
v User directory integration - password synchronization plug-in services

Analytics server 1
This server provides the following services:
v Installation services
v Messaging services
v Analytics services
v Platform management services
v Reporting services
v User directory integration - password synchronization plug-in services

Analytics server 2
This server provides the following services:
v Installation services
v Messaging services
v Analytics services
v Platform management services
v Reporting services
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v User directory integration - password synchronization plug-in services

Web server 1
This server provides the following service:
v Web server services
v User directory integration - password synchronization plug-in services

Web server 2
This server provides the following service:
v Web server services
v User directory integration - password synchronization plug-in services

Semantic model server (optional)
This server provides the following service:
v Semantic model services

Installation server
The server used when installing IBM Intelligent Operations Center depends on whether IBM Intelligent
Operations Center is being installed in a standard or high availability environment.

For a standard environment, the installation server is the analytics server.

For a high availability environment, the installation server is analytics server 1.

IBM Intelligent Operations Center hardware requirements for a
standard environment
Four servers meeting minimum requirements are required to install IBM Intelligent Operations Center
using the standard topology. An optional semantic model server is required if semantic model services
are required. The analytics server also serves as the installation server.

The servers must have Intel x86-64 or AMD x86-64 processors.

The minimum requirements for servers used by IBM Intelligent Operations Center are shown in Table 2.
The recommended minimum disk space does not include space for boot and swap partitions. These
directories should be defined before IBM Intelligent Operations Center is installed.

Table 2. Minimum hardware requirements

Resource
Application
server Analytics server Data server Web server

Semantic model
server (optional)

CPUs 4 4 4 2 4

Memory 16 GB 16 GB 16 GB 2 GB 16 GB

Network adapters 1 1 1 1 1

Disk space 90 GB 112 GB 112 GB 65 GB 90 GB

Additional disk
space required
during
installation

70 GB 139 GB (189 GB if
the download
media is to be
stored on the
server)

17 GB 27 GB 10 GB

The minimum requirements for the directories on each server, excluding space required for the boot and
swap partitions is shown in Table 3 on page 26.
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Table 3. Minimum space requirements for each directory

Directory
Minimum
space Notes

/ 8 GB

/opt 7 GB or 32
GB

7 GB is required for the web server, 32 GB is required for all other
servers.

/usr 8 GB

/home 5 GB

/tmp 12 GB

/chroot 1 GB

/datahome 22 GB Only required on the analytics server and data server.

/loghome 8 GB Only required on the analytics server.

/installMedia 10 GB, 17
GB, 27 GB,
37 GB, or 70
GB

This directory can have a different name. However, if the directory is
given a different name, the directory must be defined in the
installation property file or in the GUI installation panels. This
directory can be deleted after installation.

The amount of space required is dependent on the server.

v Semantic model server (optional): 10 GB

v Data server: 17 GB

v Web server: 27 GB

v Analytics server: 37 GB

v Application server: 70 GB

/distributionMedia 102 GB This directory can have a different name. However, if the directory is
given a different name, the directory must be defined in the
installation property file or in the GUI installation panels. This
directory is only required on the installation server

/var 8 GB

/SWAP 8 GB

Related tasks:
“Preparing the servers” on page 34
Before installing IBM Intelligent Operations Center, all servers, including the optional semantic model
server (if used), must be correctly prepared or the installation will fail. The precheck step will verify that
many of these requirements have been implemented for all servers except the semantic model server.
Related information:

System requirements

IBM Intelligent Operations Center hardware requirements for a high
availability environment
Eight servers meeting minimum requirements are required to install IBM Intelligent Operations Center
using the high availability topology. An optional semantic model server is required if semantic model
services are required. Analytics server 1 also serves as the installation server.

The servers must have Intel x86-64 or AMD x86-64 processors.

The minimum requirements for servers used by IBM Intelligent Operations Center are shown in Table 4
on page 27. The recommended minimum disk space does not include space for boot and swap partitions.
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Important: The configuration of data server 1 and data server 2 should be virtually identical. The
configuration includes the hardware, operating system level and patches, network devices, and database
versions. Having these servers as identical as possible will help with a smooth database failover process
should one be required.

Table 4. Minimum hardware requirements

Resource
Application
server 1

Application
server 2

Analytics
server 1

Analytics
server 2 Data server 1 Data server 2 Web server 1 Web server 2

Semantic
model server
(optional)

CPUs 4 4 4 4 4 4 2 2 4

Memory 16 GB 16 GB 16 GB 16 GB 16 GB 16 GB 2 GB 2 GB 16 GB

Network
adapters

1 1 1 1 1 1 1 1 1

Disk space 90 GB 90 GB 112 GB 112 GB 112 GB 112 GB 65 GB 65 GB 90 GB

Additional
disk space
required
during
installation

70 GB 70 GB 139 GB (189 GB
if the download
media is to be
stored on the
server)

37 GB 17 GB 17 GB 27 GB 27 GB 10 GB

The minimum requirements for the directories on each server, excluding space required for the boot and
swap partitions is shown in Table 5.

Table 5. Minimum space requirements for each directory

Directory
Minimum
space Notes

/ 8 GB

/opt 7 GB or 32
GB

7 GB is required for the web server 1 and web server 2, 32 GB is
required for all other servers.

/usr 8 GB

/home 5 GB

/tmp 12 GB

/chroot 1 GB

/datahome 22 GB Only required on analytics server 1, analytics server 2, data server 1,
and data server 2.

/loghome 8 GB Only required on analytics server 1 and analytics server 2.

/installMedia 10 GB, 17
GB, 27 GB,
37 GB, or 70
GB

This directory can have a different name. However, if the directory is
given a different name, the directory must be defined in the
installation property file or in the GUI installation panels. This
directory can be deleted after installation.

The amount of space required is dependent on the server.

v Semantic model server (optional): 10 GB

v Data server 1 and data server 2: 17 GB

v Web server 1 and web server 2: 27 GB

v Analytics server 1 and analytics server 2: 37 GB

v Application server 1 and application server 2: 70 GB

/distributionMedia 102 GB This directory can have a different name. However, if the directory is
given a different name, the directory must be defined in the
installation property file or in the GUI installation panels. This
directory is only required on the installation server

/var 8 GB

/SWAP 8 GB
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In addition, a customer-provided load balancer infrastructure is required to connect to the web server.
Related tasks:
“Preparing the servers” on page 34
Before installing IBM Intelligent Operations Center, all servers, including the optional semantic model
server (if used), must be correctly prepared or the installation will fail. The precheck step will verify that
many of these requirements have been implemented for all servers except the semantic model server.
Related information:

System requirements

Prerequisite software requirements
Before installing IBM Intelligent Operations Center, all servers must have the appropriate software
installed.

IBM Intelligent Operations Center requires Red Hat Enterprise Server Linux version 6 at release 6.3 or
higher. Specific Linux RPM packages must be installed as part of the steps to prepare the servers.

A workstation with Windows is also required to configure single sign-on for collaboration services.

It is recommended that the servers only have the prerequisite software installed. Any installation of IBM
Intelligent Operations Center installed on the servers must be removed before installing IBM Intelligent
Operations Center.
Related tasks:
“Installing Linux packages for the standard environment” on page 40
Before installing IBM Intelligent Operations Center, Linux packages need to be installed on the servers.
“Installing Linux packages for the high availability environment” on page 44
Before installing IBM Intelligent Operations Center, Linux packages need to be installed on the servers.
“Configuring single sign-on for collaboration services” on page 69
Import the WebSphere Portal SSO LTPA token into the application server to allow users to access
collaboration services without having to reenter their credentials.
“Preparing the servers” on page 34
Before installing IBM Intelligent Operations Center, all servers, including the optional semantic model
server (if used), must be correctly prepared or the installation will fail. The precheck step will verify that
many of these requirements have been implemented for all servers except the semantic model server.
Related information:

System requirements

Supported browsers
The IBM Intelligent Operations Center solutions interface supports a number of browsers. Some browsers
can be used with limitations.

IBM Intelligent Operations Center has been tested, and is supported, on the following browsers:
v Microsoft Internet Explorer 9.x (32-bit only)
v Mozilla Firefox 17 ESR
v Chrome V23
v Safari 6.0 for Mac OS X
v Safari 5.1 for Windows

Internet Explorer Compatibility View

IBM Intelligent Operations Center does not support Internet Explorer 9 Compatibility View.
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Minimum screen resolution

IBM Intelligent Operations Center is designed to run at a minimum 1280 x 800 screen resolution.

Media packaging
IBM Intelligent Operations Center can be ordered as a package of DVDs or can be obtained through
Passport Advantage.

The product number is 5725-D69.
Related information:

Passport Advantage

Installation options
IBM Intelligent Operations Center provides four different installation options.

Options are provided for a standard environment and a high availability environment. For each of these
environments two installers are provided.

The graphical installer provides a simplified installation with minimal options to configure the installed
system.

The command line installer provides greater flexibility in configuring the installed system.

Installation checklists
Installation checklists are available for the installation options for IBM Intelligent Operations Center.
These checklists provide an overview of the installation steps and can be used to track the installation
progress.

Checklist - installing the standard topology using the command line
installer
Use this checklist to track the installation steps when installing the IBM Intelligent Operations Center
standard topology using the command line installer.

Procedure
__ 1. Review the IBM Intelligent Operations Center preventive service planning technote for changes to

the product documentation that might affect the installation and usage of IBM Intelligent
Operations Center.

__ 2. Make sure you have the necessary hardware.
__ 3. Make sure the required software is installed on the hardware.
__ 4. Optional: Use the kickstart file to prepare Red Hat Enterprise Linux on the servers. Operating

system preparation can also be done manually as part of the Prepare the servers. steps.
__ 5. Prepare the servers.

a. Set up TCP/IP networking.
b. Disable security settings.
c. Set up ssh services.
d. Configure users requiring ssh access and passwords.
e. Install required Linux packages.
f. Set other pre-installation requirements.
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g. Prepare the installation server
__ 6. Verify and customize the installation properties as required.
__ 7. Define the topology for the installation by editing the topology properties file.
__ 8. Run the command line installer.

Important: Make sure you record the topology password. The topology password is needed
when running the password management tool and platform control tool. The default topology
password is ibmioc16.

__ 9. Verify the installation prior to configuring IBM Intelligent Operations Center.
__ 10. Configure IBM Intelligent Operations Center.

__ a. Configure collaboration services if you are using IPv6.
__ b. Configure single sign-on for collaboration services.
__ c. Remove HTTPOnly setting for IBM Business Monitor.
__ d. Optional: Configure the session timeout.
__ e. Optional: Configure the LTPA timeout.

__ 11. Verify that IBM Intelligent Operations Center is correctly installed.
__ 12. Optional: Install and configure semantic model services.
__ 13. Verify that IBM Intelligent Operations Center is correctly installed.
__ 14. Install any other applications.

Results

The IBM Intelligent Operations Center architecture and IBM Intelligent Operations Center application are
installed and ready for use.

Checklist - installing the standard topology using the graphical
installer
Use this checklist to track the installation steps when installing the IBM Intelligent Operations Center
standard topology using the GUI installer.

Procedure
__ 1. Review the IBM Intelligent Operations Center preventive service planning technote for changes to

the product documentation that might affect the installation and usage of IBM Intelligent
Operations Center.

__ 2. Make sure you have the necessary hardware.
__ 3. Make sure the required software is installed on the hardware.
__ 4. Optional: Use the kickstart file to prepare Red Hat Enterprise Linux on the servers. Operating

system preparation can also be done manually as part of the Prepare the servers. steps.
__ 5. Prepare the servers.

a. Set up TCP/IP networking.
b. Disable security settings.
c. Set up ssh services.
d. Configure users requiring ssh access and passwords.
e. Install required Linux packages.
f. Set other pre-installation requirements.
g. Prepare the installation server

__ 6. Run the standard environment GUI installer.
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Important: Make sure you record the topology password. The topology password is needed
when running the password management tool and platform control tool. The default topology
password is ibmioc16.

__ 7. Verify the installation prior to configuring IBM Intelligent Operations Center.
__ 8. Configure IBM Intelligent Operations Center.

__ a. Configure collaboration services if you are using IPv6.
__ b. Configure single sign-on for collaboration services.
__ c. Remove HTTPOnly setting for IBM Business Monitor.
__ d. Optional: Configure the session timeout.
__ e. Optional: Configure the LTPA timeout.

__ 9. Optional: Install and configure semantic model services.
__ 10. Verify that IBM Intelligent Operations Center is correctly installed.
__ 11. Install any other applications.

Results

The IBM Intelligent Operations Center architecture and IBM Intelligent Operations Center application are
installed and ready for use.

Checklist - installing the high availability topology using the command
line installer
Use this checklist to track the installation steps when installing the IBM Intelligent Operations Center
standard topology using the command line installer.

Procedure
__ 1. Review the IBM Intelligent Operations Center preventive service planning technote for changes to

the product documentation that might affect the installation and usage of IBM Intelligent
Operations Center.

__ 2. Make sure you have the necessary hardware.
__ 3. Make sure the required software is installed on the hardware.
__ 4. Optional: Use the kickstart file to prepare Red Hat Enterprise Linux on the servers. Operating

system preparation can also be done manually as part of the Prepare the servers. steps.
__ 5. Prepare the servers.

a. Set up TCP/IP networking.
b. Disable security settings.
c. Set up ssh services.
d. Configure users requiring ssh access and passwords.
e. Install required Linux packages.
f. Set other pre-installation requirements.
g. Prepare the servers to run in a high availability environment.
h. Prepare the installation server

__ 6. Verify and customize the installation properties as required.
__ 7. Define the topology for the installation by editing the topology properties file.
__ 8. Run the command line installer.

Important: Make sure you record the topology password. The topology password is needed
when running the password management tool and platform control tool. The default topology
password is ibmioc16.
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__ 9. Verify the installation prior to configuring IBM Intelligent Operations Center.
__ 10. Configure IBM Intelligent Operations Center.

__ a. Configure collaboration services if you are using IPv6.
__ b. Configure single sign-on for collaboration services.
__ c. Remove HTTPOnly setting for IBM Business Monitor.
__ d. Configure additional cluster manager relationships.
__ e. Optional: Configure the session timeout.
__ f. Optional: Configure the LTPA timeout.
__ g. Optional: Configure an optional external network file system.
__ h. Optional: Configure the Cognos model in a high availability environment

__ 11. Verify that IBM Intelligent Operations Center is correctly installed.
__ 12. Optional: Install and configure semantic model services.
__ 13. Verify that IBM Intelligent Operations Center is correctly installed.
__ 14. Install any other applications.

Results

The IBM Intelligent Operations Center architecture and IBM Intelligent Operations Center application are
installed and ready for use.

Checklist - installing the high availability topology using the graphical
installer
Use this checklist to track the installation steps when installing the IBM Intelligent Operations Center
high availability topology using the graphical installer.

Procedure
__ 1. Review the IBM Intelligent Operations Center preventive service planning technote for changes to

the product documentation that might affect the installation and usage of IBM Intelligent
Operations Center.

__ 2. Make sure you have the necessary hardware.
__ 3. Make sure the required software is installed on the hardware.
__ 4. Optional: Use the kickstart file to prepare Red Hat Enterprise Linux on the servers. Operating

system preparation can also be done manually as part of the Prepare the servers. steps.
__ 5. Prepare the servers.

a. Set up TCP/IP networking.
b. Disable security settings.
c. Set up ssh services.
d. Configure users requiring ssh access and passwords.
e. Install required Linux packages.
f. Set other pre-installation requirements.
g. Prepare the servers to run in a high availability environment.
h. Prepare the installation server

__ 6. Run the high availability environment GUI installer.

Important: Make sure you record the topology password. The topology password is needed
when running the password management tool and platform control tool. The default topology
password is ibmioc16.

__ 7. Verify the installation prior to configuring IBM Intelligent Operations Center.
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__ 8. Configure IBM Intelligent Operations Center.
__ a. Configure collaboration services if you are using IPv6.
__ b. Configure single sign-on for collaboration services.
__ c. Configure additional cluster manager relationships.
__ d. Remove HTTPOnly setting for IBM Business Monitor.
__ e. Optional: Configure the session timeout.
__ f. Optional: Configure the LTPA timeout.
__ g. Optional: Configure an optional external network file system.
__ h. Optional: Configure the Cognos model in a high availability environment

__ 9. Optional: Install and configure semantic model services.
__ 10. Verify that IBM Intelligent Operations Center is correctly installed.
__ 11. Install any other applications.

Results

The IBM Intelligent Operations Center architecture and IBM Intelligent Operations Center application are
installed and ready for use.

Using kickstart files to prepare Red Hat Enterprise Linux
IBM Intelligent Operations Center includes sample Red Hat Enterprise Linux V6 kickstart files to prepare
the operating system for standard and high availability environments on virtual or hardware servers.

About this task

IBM Intelligent Operations Center server requirements assume that the minimal installation option is
selected during the installation of Red Hat Enterprise Linux. The minimal option provides only the @core
and @server-policy packages essential to run Red Hat Enterprise Linux. The @core and @server-policy
packages provide the required Linux rpm packages for a single-purpose server or desktop appliance and
maximizes performance and security for the installation. The kickstart files included with IBM Intelligent
Operations Center includes all packages needed for IBM Intelligent Operations Center and can be used to
prepare the servers for installation.

The kickstart files can be found in the /rhel-kickstart directory in the installation media.

The kickstart files provided for a standard environment are:
v std_ks-iopana-min.cfg - kickstart file for the analytics server
v std_ks-iopapp-min.cfg - kickstart file for the application server
v std_ks-iopdb-min.cfg - kickstart file for the data server
v std_ks-iopdmz-min.cfg - kickstart file for the web server
v std_ks-iopmdl-min.cfg - kickstart file for the semantic model server

The kickstart files provided for a high availability environment are:
v ha_ks-iopana1-min.cfg - kickstart file for the analytics server 1
v ha_ks-iopana2-min.cfg - kickstart file for the analytics server 2
v ha_ks-iopapp1-min.cfg - kickstart file for the application server 1
v ha_ks-iopapp2-min.cfg - kickstart file for the application server 2
v ha_ks-iopdb1-min.cfg - kickstart file for the data server 1
v ha_ks-iopdb2-min.cfg - kickstart file for the data server 2
v ha_ks-iopdmz1-min.cfg - kickstart file for the web server 1
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v ha_ks-iopdmz2-min.cfg - kickstart file for the web server 2
v ha_ks-iopmdl1-min.cfg - kickstart file for the semantic model server

Procedure

Setup each kickstart file.
1. Edit the kickstart file.
2. Change the lang value to the language for your installation. The default is en_US.UTF-8.
3. Change the rootpw value to the root password for the system. The default is ibmioc16.
4. Change the timezone value to the time zone for your installation. The default is America/New_York.
5. Change the network information for the target system. The default is different for each server.
6. Optional: Change the file system partition layout. In the default configuration, all file system

partitions are created under one disk.
Use the kickstart file to configure the server or virtual machine.
7. Complete the pre-install steps in the kickstart file.
8. Use the kickstart file to install and configure Red Hat Enterprise Linux on the hardware server or

virtual machine.
9. Complete the post-install steps in the kickstart file.

10. Create a snapshot of the virtual machine or a backup of the hardware server.

What to do next

After the operating system is configured on all hardware servers or virtual machines using the kickstart
files, continue with the other server preparation steps. The kickstart files install the required Linux
packages, so those steps can be skipped. After the servers are prepared, install IBM Intelligent Operations
Center.
Related tasks:
“Preparing the servers”
Before installing IBM Intelligent Operations Center, all servers, including the optional semantic model
server (if used), must be correctly prepared or the installation will fail. The precheck step will verify that
many of these requirements have been implemented for all servers except the semantic model server.
“Installing Linux packages for the standard environment” on page 40
Before installing IBM Intelligent Operations Center, Linux packages need to be installed on the servers.
“Installing Linux packages for the high availability environment” on page 44
Before installing IBM Intelligent Operations Center, Linux packages need to be installed on the servers.

Preparing the servers
Before installing IBM Intelligent Operations Center, all servers, including the optional semantic model
server (if used), must be correctly prepared or the installation will fail. The precheck step will verify that
many of these requirements have been implemented for all servers except the semantic model server.

About this task

If running in a virtual environment, using a template for these steps can help reduce setup time. Follow
the steps in each section for each server or create a RHEL template with these steps.
Related concepts:
“Prerequisite software requirements” on page 28
Before installing IBM Intelligent Operations Center, all servers must have the appropriate software
installed.
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“IBM Intelligent Operations Center hardware requirements for a standard environment” on page 25
Four servers meeting minimum requirements are required to install IBM Intelligent Operations Center
using the standard topology. An optional semantic model server is required if semantic model services
are required. The analytics server also serves as the installation server.
“IBM Intelligent Operations Center hardware requirements for a high availability environment” on page
26
Eight servers meeting minimum requirements are required to install IBM Intelligent Operations Center
using the high availability topology. An optional semantic model server is required if semantic model
services are required. Analytics server 1 also serves as the installation server.

Setting up TCP/IP networking
Before installing IBM Intelligent Operations Center, TCP/IP networking needs to be set up on the servers.

About this task

If you are installing IBM Intelligent Operations Center for a high availability environment, you must use
IPV4. High availability server clustering does not support IPV6.

Procedure
1. Define a fully-qualified name and short host name using a DNS server or by definition in the

/etc/hosts file.
2. Make sure that the HOSTNAME set in /etc/sysconfig/network is set to the short host name and not

the fully qualified host name. For example, set HOSTNAME=xyz instead of HOSTNAME=xyz.yourco.com.
3. Verify the hostname, fully qualified hostname, and domain names are configured on all servers. The

servers are correctly configured if the following tests complete successfully.
a. The hostname -s command returns the defined short host name for the server.
b. The hostname -f command returns the fully qualified domain and host name for the server.
c. The hostname -d command returns the domain name of the server.
d. The results of a ping command, or ping6 command for IPV6 environments, with the short host

name for each server indicates that the server is accessible.
e. The results of a ping command, or ping6 command for IPV6 environments, with the fully-qualified

name for each server indicates that the server is accessible.
4. Enable local loopback addressing for each server in the /etc/hosts file.
5. Verify local loopback addressing. The servers are correctly configured if the following tests complete

successfully.
a. The ping -n localhost command returns the address 127.0.0.1.
b. The ping -n localhost.localdomain command returns the address 127.0.0.1.
c. The ping6 -n localhost6 command in an IPV6 environment returns the address ::1.
d. The ping6 -n localhost6.localdomain6 command in an IPV6 environment returns the address

::1.
6. Add or update the net.ipv4.tcp_fin_timeout=15 parameter in the /etc/sysctl.conf file for the

following servers:
v Application server
v Analytics server
v Data server
v Web server
v Semantic model server (if used)
Restart the server after changing the /etc/sysctl.conf file.
If this step is not done when the servers are prepared, the IBM Intelligent Operations Center
installation program will correct the setting for all servers except the semantic model server.

Chapter 2. Installing the solution 35



TCP/IP networking
Prior to installing IBM Intelligent Operations Center, TCP/IP networking between the servers must be
correctly configured.

If you are installing IBM Intelligent Operations Center for a high availability environment, you must use
IPV4. High availability server clustering does not support IPV6.

All servers used by IBM Intelligent Operations Center must be configured with a short host name and a
fully-qualified host name. The host names must resolve on each server to the correct IP address.
Configuration can be done using a DNS server or by adding definitions to the /etc/hosts file.

The fully-qualified host name for each server must have at least three components. For example:
myhost.mydomain.com where the top level domain is a standard Internet top-level domain.

Important: Short host names and fully-qualified host names must be specified in the correct case. For
example, MyCompany.MyDomain.com cannot be specified as mycompany.mydomain.com.

IPv6 networking is supported by IBM Intelligent Operations Center, but IPv4 must be installed and
configured as well. IPv4 addresses do not need to be assigned to the servers, but the IPv4 loopback
address (127.0.0.1) must be enabled and the localhost host name must resolve to 127.0.0.1.

Configuration changes are shown in Table 6 on page 37. These are guidelines for setting up TCP/IP
networking on the IBM Intelligent Operations Center installation server and target servers by editing the
Linux network configuration files. The configuration notes in Table 6 on page 37 are only guidelines. Any
network setup conforming to the requirements described previously should work.
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Table 6. TCP/IP configuration guidelines

File Notes

/etc/hosts The hosts file resolves TCP/IP names to IP addresses. If
the configuration does not have a DNS server, all servers
and their IP addresses, short host names, and
fully-qualified names must be defined in this file. Local
loopback addresses and host names are also defined in
this file.

If a DNS server is being used, hosts which are resolved
by the DNS do not need to be included in this file.
Important: When using IPv4, the local loopback address
127.0.0.1 must be mapped to the localhost and
localhost.localdomain host names.

The following is a sample /etc/hosts file using IPv4
addresses.

# local loopback definitions -- do not remove
# or alter these!
127.0.0.1 localhost.localdomain localhost
# use the following if IPv6 is enabled in your
# network definitions
::1 localhost6.localdomain localhost6

# target runtime servers for the standard topology
192.168.0.210 iocweb.ioc16.com iocweb
192.168.0.211 iocapp.ioc16.com 1ocapp
192.168.0.212 iocdb.ioc16.com iocdb
192.168.0.213 iocana.ioc16.com iocana

# target runtime servers for the high availability
topology
192.168.0.210 iocweb1.ioc16.com iocweb1
192.168.0.211 iocweb2.ioc16.com iocweb2
192.168.0.212 iocapp1.ioc16.com iocapp1
192.168.0.213 iocapp2.ioc16.com iocapp2
192.168.0.214 iocdb1.ioc16.com iocdb1
192.168.0.215 iocdb2.ioc16.com iocdb2
192.168.0.216 iocana1.ioc16.com iocana1
192.168.0.217 iocana2.ioc16.com iocana2

Use IPv6 address notation to assign IPv6 static addresses
.

Both IPv6 and IPv4 addresses can be defined on the
same server.
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Table 6. TCP/IP configuration guidelines (continued)

File Notes

/etc/sysconfig/network-scripts/ifcfg-adapter_name The ifcfg-adapter_name file defines the basic network
settings for the specified network adapter. The Linux
assigned name for the network adapter is specified by
adapter_name. The typical value for adapter_name is eth0
but might be different for your environment.

For IPv4 networking the following parameters should be
defined.

IPADDR Specify the IPv4 IP address of the server being
configured.

NETMASK
Specify the IPv4 network mask of the server
being configured.

GATEWAY
Specify the IPv4 default network IP address of
the server being configured.

BOOTPROTO
If static IP addressing is being used, specify
none.

NM_CONTROLLED
Specify no to disable the Network Management
service from modifying the ifcfg-adapter_name
file.

ONBOOT Specify yes to start the adapter automatically.

IPV6INIT
Specify yes if the adapter is to use IPv6
networking.

IPV6ADDR
Specify the server IPv6 IP address if
IPV6INIT=yes is specified.

IPV6_DEFAULTGW
Specify the server IPv6 default network gateway
IP address if IPV6INIT=yes is specified.

/etc/sysconfig/network The network file specifies general networking parameters.

For IPv4 networking the following parameters should be
defined:

NETWORKING
Specify yes to enable IPv4 networking.

NETWORKING_IPV6
Specify yes if IPv6 networking is also desired.

HOSTNAME
Specify the server short host name.

Hostname configuration changes made by editing the
/etc/sysconfig/network file will not take affect until the
server is restarted. If a restart isn’t desired, change the
hostname for the current shell session by running the
hostname new_host_name command. For example, to
change the hostname of the server to iocweb, run the
hostname iocweb command.
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Table 6. TCP/IP configuration guidelines (continued)

File Notes

/etc/resolv.conf The resolv.conf file is used to define DNS servers for
the network and a default search domain. If DNS servers
are not being used, this file should be empty.

If a DNS server is used, the resolv.conf should contain
the following lines:

search domain_name
nameserver first_DNS_server
nameserver second_DNS_server

For example:

search yourcompany.com
nameserver 10.75.20.10
nameserver 10.75.20.11

The search value specifies the default search domain.
The first nameserver value is the IP address of the DNS
server. A second nameserver value can be used to specify
a secondary DNS server. The second nameserver
specification is optional.

When correctly configured, each server must successfully pass the following tests:
1. The hostname -s command returns the defined short host name for the server.
2. The hostname -f command returns the fully qualified domain and host name for the server.
3. The hostname -d command returns the domain name of the server.
4. The results of a ping command, or ping6 command for IPV6 environments, with the short host name

for each server indicates that the server is accessible.
5. The results of a ping command, or ping6 command for IPV6 environments, with the fully-qualified

name for each server indicates that the server is accessible.
Related tasks:
“Preparing the servers” on page 34
Before installing IBM Intelligent Operations Center, all servers, including the optional semantic model
server (if used), must be correctly prepared or the installation will fail. The precheck step will verify that
many of these requirements have been implemented for all servers except the semantic model server.

Disabling security settings
Before installing IBM Intelligent Operations Center, certain security settings must be disabled. These can
be re-enabled after IBM Intelligent Operations Center is installed.

About this task

If the following steps are not done prior to installing IBM Intelligent Operations Center, the installer will
disable any firewalls. SELinux will also be disabled unless set to "permissive". If set to "permissive" the
setting will be retained. In all cases the installation will proceed successfully. The installer will not make
these changes for the semantic model server.

Procedure
1. Disable SELinux (Security Enforcing Linux) by editing the /etc/selinux/config file and changing

SELINUX to disabled. After changing the configuration, restart the server.
2. Disable all Linux firewalls.
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Setting up SSH services
Before installing IBM Intelligent Operations Center, ssh services need to be set up on the servers. The
service needs to be enabled for root login with password authentication.

About this task

TCP/IP port 22 must be configured in the operating system as an available ssh access port for use during
installation processing. The TCP/IP port number for platform control tool ssh access is specified in the
topology properties file. Only the platform control tool uses the configured port.

Procedure
1. Edit the /etc/ssh/sshd_config file.
2. Make sure the following lines are specified as follows. Make sure there is no # sign at the start of

these lines.
PermitRootLogin yes
PasswordAuthentication yes

3. Save the changed file.
4. Start, or restart, the sshd service on each server by running the service sshd restart command.

Updating the SSH configuration
IBM Intelligent Operations Center installation requires SSH configuration changes to successfully run.

About this task

On each IBM Intelligent Operations Center server review the contents of the /etc/ssh/sshd_config file
and change the file as required.

Procedure
1. Make a backup copy of the file by running the following command: cp /etc/ssh/sshd_config

/etc/ssh/sshd_config.orig

2. Edit the /etc/ssh/sshd_config file.
3. Comment out any AllowUsers statements.
4. Comment out any AllowGroups statements.
5. Set any PermitRootLogin statement to yes until IBM Intelligent Operations Center installation is

complete. If there isn't a PermitRootLogin statement in the file, don't add one.
6. Set any PasswordAuthentication statement to yes until IBM Intelligent Operations Center installation

is complete. If there is no PasswordAuthentication statement, do not add one.
7. Save the changes.
8. Make a backup copy of the changed file by running the following command: cp /etc/ssh/

sshd_config /etc/ssh/sshd_config.ioc_maintenance

9. If you changed the sshd_config file, run the following to activate the changes: service sshd restart

What to do next

After IBM Intelligent Operations Center has been successfully installed, return the /etc/ssh/sshd_config
to its original state and run the following command to activate the changes: service sshd restart

Installing Linux packages for the standard environment
Before installing IBM Intelligent Operations Center, Linux packages need to be installed on the servers.
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About this task

Linux package requirements assumes that the Minimal option is selected during Red Hat installation. The
Minimal option provides only the @core and @server-policy packages which are essential to run Red Hat
Enterprise Linux. A minimal installation provides the base for a single-purpose server or desktop
appliance and maximizes performance and security for the installation.

The Linux packages in following table must be installed on the IBM Intelligent Operations Center servers.
The redhat-lsb package is required on the analytics server if the GUI installer will be used. These
packages are available from Red Hat.

Table 7. Required Linux packages for IBM Intelligent Operations Center servers

Application server Analytics server Data server Web server
Semantic model server
(optional)

bc.x86_64
compat-db.i686
compat-db.x86_64
compat-glibc.x86_64
compat-glibc-headers.x86_64
compat-libstdc++*i686
dos2unix.x86_64
elfutils.x86_64
elfutils-libs.i686
elfutils-libs.x86_64
gettext.x86_64
glibc.i686
glibc.x86_64
gtk2.i686
gtk2.x86_64
gtk2-engines.i686
gtk2-engines.x86_64
libaio.i686
libaio.x86_64
libgcc.i686
libgcc.x86_64
libXmu.i686
libXmu.x86_64
libXp.i686
libXpm.x86_64
libXtst.i686
libXtst.x86_64
nfs-utils.x86_64
nfs-utils-lib.x86_64
nss-softokn-freebl.i686
nss-softokn-freebl.x86_64
ntp.x86_64
openmotif22.i686
openmotif22.x86_64
openssh-clients.x86_64
pam_passwdqc.x86_64
rpm-build.x86_64
tcsh.x86_64
unzip.x86_64
zip.x86_64
zlib.i686
zlib.x86_64

1.6.0.2

pam.i686
pam-devel.i686

compat-db.i686
compat-db.x86_64
compat-glibc.x86_64
compat-glibc-headers.x86_64
compat-libstdc++*i686
dos2unix.x86_64
elfutils.x86_64
elfutils-libs.i686
elfutils-libs.x86_64
gettext.x86_64
gettext-libs.x86_64
glibc.i686
glibc.x86_64
gtk2.i686
gtk2.x86_64
gtk2-engines.i686
gtk2-engines.x86_64
libaio.i686
libaio.x86_64
libgcc.i686
libgcc.x86_64
libXft.i686
libXft.x86_64
libXmu.i686
libXtst.i686
libXtst.x86_64
nfs-utils.x86_64
nfs-utils-lib.x86_64
nss-softokn-freebl.i686
nss-softokn-freebl.x86_64
ntp.x86_64
openmotif22.i686
openmotif22.x86_64
openssh-clients.x86_64
pam_passwdqc.x86_64
redhat-lsb.x86_64
rpm-build.x86_64
tcsh.x86_64
unzip.x86_64
zlib.i686
zlib.x86_64

1.6.0.2

pam.i686
pam-devel.i686

audit-libs.i686
audit-libs.x86_64
compat-libstdc++*i686
compat-libstdc++*x86_64
dos2unix.x86_64
gettext.x86_64
glibc.i686
glibc.x86_64
ksh.x86_64
libaio.i686
libaio.x86_64
libgcc.i686
libgcc.x86_64
libstdc++.i686
nss-softokn-freebl.i686
nss-softokn-freebl.x86_64
ntp.x86_64
openssh-clients.x86_64
pam.i686
pam-devel.i686
pam_passwdqc.x86_64
tcsh.x86_64
unzip.x86_64
xorg-x11-xauth.x86_64
zlib.i686
zlib.x86_64

compat-db.i686
compat-db.x86_64
dos2unix.x86_64
elfutils.x86_64
elfutils-libs.i686
elfutils-libs.x86_64
gettext.x86_64
glibc.i686
glibc.x86_64
gtk2.i686
gtk2.x86_64
gtk2-engines.i686
gtk2-engines.x86_64
ksh.x86_64
libgcc.i686
libgcc.x86_64
libXp.i686
libXpm.i686
libXpm.x86_64
libXpm-devel.i686
libXpm-devel.x86_64
nss-softokn-freebl.i686
nss-softokn-freebl.x86_64
ntp.x86_64
openssh-clients.x86_64
pam_passwdqc.x86_64
rpm-build.x86_64
tcsh.x86_64
unzip.x86_64
zlib.i686
zlib.x86_64

audit-libs.i686
audit-libs.x86_64
bc.x86_64
compat-db.i686
compat-db.x86_64
compat-glibc.x86_64
compat-glibc-headers.x86_64
compat-libstdc++*i686
compat-libstdc++*x86_64
dos2unix.x86_64
elfutils.x86_64
elfutils-libs.i686
elfutils-libs.x86_64
gettext.x86_64
gettext-libs.x86_64
glibc.i686
glibc.x86_64
gtk2.i686
gtk2.x86_64
gtk2-engines.i686
gtk2-engines.x86_64
ksh.x86_64
libaio.i686
libaio.x86_64
libcanberra.x86_64
libgcc.i686
libgcc.x86_64
libstdc++.i686
libXft.i686
libXft.x86_64
libXmu.i686
libXmu.x86_64
libXp.i686
libXpm.i686
libXpm.x86_64
libXpm-devel.i686
libXpm-devel.x86_64
libXtst.i686
libXtst.x86_64
nss-softokn-freebl.i686
nss-softokn-freebl.x86_64
ntp.x86_64
openmotif22.i686
openmotif22.x86_64
openssh-clients.x86_64
pam.i686
pam-devel.i686
pam_passwdqc.x86_64
rpm-build.x86_64
tcsh.x86_64
unzip.x86_64
xorg-x11-xauth.x86_64
zip.x86_64
zlib.i686
zlib.x86_64

Procedure
1. All required Linux packages can be installed in all servers, or, only the packages required for each

server can be installed.
v To install all packages on all servers, run the following commands on each server. Each yum

command needs to be specified as a single line.
yum install -y audit-libs.i686 audit-libs.x86_64 bc.x86_64
compat-db.i686 compat-db.x86_64 compat-glibc.x86_64
compat-glibc-headers.x86_64 compat-libstdc++*i686
compat-libstdc++*x86_64 dos2unix.x86_64 elfutils.x86_64
elfutils-libs.i686 elfutils-libs.x86_64
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gettext.x86_64
gettext-libs.x86_64 glibc.i686 glibc.x86_64 gtk2.i686 gtk2.x86_64
gtk2-engines.i686 gtk2-engines.x86_64 ksh.x86_64
libaio.i686
libaio.x86_64 libgcc.i686 libgcc.x86_64 libstdc++.i686 libXft.i686
libXft.x86_64 libXmu.i686 libXmu.x86_64 libXp.i686 libXpm.i686
libXpm.x86_64 libXpm-devel.i686 libXpm-devel.x86_64 libXtst.i686
libXtst.x86_64 nfs-utils.x86_64 nfs-utils-lib.x86_64
nss-softokn-freebl.i686 nss-softokn-freebl.x86_64 ntp.x86_64
openmotif22.i686 openmotif22.x86_64 openssh-clients.x86_64
pam.i686 pam-devel.i686 redhat-lsb.x86_64 rpm-build.x86_64
unzip.x86_64 xorg-x11-xauth.x86_64 zip.x86_64 zlib.i686 zlib.x86_64
pam_passwdqc.x86_64 tcsh.x86_64

yum -y update

v To install only the packages required by each server, run the following commands. Each yum
command needs to be specified as a single line.
On the application server:
yum install -y bc.x86_64 compat-db.i686 compat-db.x86_64
compat-glibc.x86_64 compat-glibc-headers.x86_64
compat-libstdc++*i686 dos2unix.x86_64 elfutils.x86_64
elfutils-libs.i686 elfutils-libs.x86_64 gettext.x86_64
glibc.i686 glibc.x86_64 gtk2.i686 gtk2.x86_64 gtk2-engines.i686
gtk2-engines.x86_64 libaio.i686
libaio.x86_64 libgcc.i686
libgcc.x86_64 libXmu.i686 libXmu.x86_64 libXp.i686 libXpm.x86_64
libXtst.i686 libXtst.x86_64 nfs-utils.x86_64 nfs-utils-lib.x86_64
nss-softokn-freebl.i686 nss-softokn-freebl.x86_64 ntp.x86_64
openmotif22.i686 openmotif22.x86_64 openssh-clients.x86_64
pam.i686 pam-devel.i686
rpm-build.x86_64 unzip.x86_64 zip.x86_64 zlib.i686 zlib.x86_64
pam_passwdqc.x86_64 tcsh.x86_64

yum -y update

On the analytics server:
yum install -y compat-db.i686 compat-db.x86_64 compat-glibc.x86_64
compat-glibc-headers.x86_64 compat-libstdc++*i686 dos2unix.x86_64
elfutils.x86_64 elfutils-libs.i686 elfutils-libs.x86_64
gettext.x86_64 gettext-libs.x86_64 glibc.i686 glibc.x86_64
gtk2.i686 gtk2.x86_64 gtk2-engines.i686 gtk2-engines.x86_64

libaio.i686 libaio.x86_64 libgcc.i686 libgcc.x86_64 libXft.i686
libXft.x86_64 libXmu.i686 libXtst.i686 libXtst.x86_64
nfs-utils.x86_64 nfs-utils-lib.x86_64 nss-softokn-freebl.i686
nss-softokn-freebl.x86_64 ntp.x86_64 openmotif22.i686
openmotif22.x86_64 openssh-clients.x86_64
pam.i686 pam-devel.i686 redhat-lsb.x86_64
rpm-build.x86_64 unzip.x86_64 zlib.i686 zlib.x86_64
pam_passwdqc.x86_64 tcsh.x86_64

yum -y update

On the data server:
yum install -y audit-libs.i686 audit-libs.x86_64
compat-libstdc++*i686 compat-libstdc++*x86_64 dos2unix.x86_64
gettext.x86_64 glibc.i686 glibc.x86_64 ksh.x86_64 libaio.i686
libaio.x86_64 libgcc.i686 libgcc.x86_64 libstdc++.i686
nss-softokn-freebl.i686 nss-softokn-freebl.x86_64 ntp.x86_64
openssh-clients.x86_64 pam.i686 pam-devel.i686 unzip.x86_64
xorg-x11-xauth.x86_64 zlib.i686 zlib.x86_64
pam_passwdqc.x86_64 tcsh.x86_64

yum -y update
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On the web server:
yum install -y compat-db.i686 compat-db.x86_64 dos2unix.x86_64
elfutils.x86_64 elfutils-libs.i686 elfutils-libs.x86_64
gettext.x86_64 glibc.i686 glibc.x86_64 gtk2.i686 gtk2.x86_64
gtk2-engines.i686 gtk2-engines.x86_64 ksh.x86_64 libgcc.i686
libgcc.x86_64 libXp.i686 libXpm.i686 libXpm.x86_64
libXpm-devel.i686 libXpm-devel.x86_64 nss-softokn-freebl.i686
nss-softokn-freebl.x86_64 ntp.x86_64 openssh-clients.x86_64
rpm-build.x86_64 unzip.x86_64 zlib.i686
zlib.x86_64 pam_passwdqc.x86_64 tcsh.x86_64

yum -y update

On the semantic model server:
yum install -y audit-libs.i686 audit-libs.x86_64 bc.x86_64
compat-db.i686 compat-db.x86_64 compat-glibc.x86_64
compat-glibc-headers.x86_64 compat-libstdc++*i686
compat-libstdc++*x86_64 dos2unix.x86_64 elfutils.x86_64
elfutils-libs.i686 elfutils-libs.x86_64 gettext.x86_64
gettext-libs.x86_64 glibc.i686 glibc.x86_64 gtk2.i686 gtk2.x86_64
gtk2-engines.i686 gtk2-engines.x86_64 ksh.x86_64 libaio.i686
libaio.x86_64 libcanberra.x86_64 libgcc.i686 libgcc.x86_64
libstdc++.i686 libXft.i686 libXft.x86_64 libXmu.i686 libXmu.x86_64
libXp.i686 libXpm.i686 libXpm.x86_64 libXpm-devel.i686
libXpm-devel.x86_64 libXtst.i686 libXtst.x86_64
nss-softokn-freebl.i686 nss-softokn-freebl.x86_64 ntp.x86_64
openmotif22.i686 openmotif22.x86_64 openssh-clients.x86_64 pam.i686
pam-devel.i686 rpm-build.x86_64 unzip.x86_64 xorg-x11-xauth.x86_64
zip.x86_64 zlib.i686 zlib.x86_64
pam_passwdqc.x86_64 tcsh.x86_64

yum -y update

2. Optional: Install the Linux packages for the X Window System on the installation server. These
packages are required if the GUI installer will be used.
a. Install the packages for the GNOME or KDE desktop.

To install the GNOME desktop run:
yum -y groupinstall "X Window System" Desktop

To install the KDE desktop run:
yum -y groupinstall "X Window System" "KDE Desktop"

b. Run yum -y update

c. Start the desktop by running init 5. To make the GUI desktop the default desktop, do the
following.
1) Edit the /etc/inittab file.
2) Change the initdefault property from 3 to 5. The updated line should be as follows.

id:5:initdefault:

3) Save the changes.
4) Restart the server.

3. Optional: Install the Linux packages for the X Window System on the application server. These
packages are required if the password management tool will be used.
a. Install the packages for the GNOME or KDE desktop.

To install the GNOME desktop run:
yum -y groupinstall "X Window System" Desktop

To install the KDE desktop run:
yum -y groupinstall "X Window System" "KDE Desktop"

b. Run yum -y update
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c. Start the desktop by running init 5. To make the GUI desktop the default desktop, do the
following.
1) Edit the /etc/inittab file.
2) Change the initdefault property from 3 to 5. The updated line should be as follows.

id:5:initdefault:

3) Save the changes.
4) Restart the server.

4. If the graphical installer is to be used in Chinese, Japanese, or Korean, run the appropriate command.

Language Command

Chinese yum install -y "@Chinese Support"

Japanese yum install -y "@japanese Support"

Korean yum install -y "@Korean Support"

Related information:

http://www.redhat.com/

Installing Linux packages for the high availability environment
Before installing IBM Intelligent Operations Center, Linux packages need to be installed on the servers.

About this task

Linux package requirements assumes that the Minimal option is selected during Red Hat installation. The
Minimal option provides only the @core and @server-policy packages which are essential to run Red Hat
Enterprise Linux. A minimal installation provides the base for a single-purpose server or desktop
appliance and maximizes performance and security for the installation.

The Linux packages in following table must be installed on the IBM Intelligent Operations Center servers.
The redhat-lsb package is required on the analytics server if the GUI installer will be used. These
packages are available from Red Hat.
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Table 8. Required Linux packages for primary IBM Intelligent Operations Center servers

Application server 1 Analytics server 1 Data server 1 Web server 1
Semantic model server
(optional)

bc.x86_64
compat-db.i686
compat-db.x86_64
compat-glibc.x86_64
compat-glibc-headers.x86_64
compat-libstdc++*i686
dos2unix.x86_64
elfutils.x86_64
elfutils-libs.i686
elfutils-libs.x86_64
gettext.x86_64
glibc.i686
glibc.x86_64
gtk2.i686
gtk2.x86_64
gtk2-engines.i686
gtk2-engines.x86_64
libaio.i686
libaio.x86_64
libgcc.i686
libgcc.x86_64
libXmu.i686
libXmu.x86_64
libXp.i686
libXpm.x86_64
libXtst.i686
libXtst.x86_64
nfs-utils.x86_64
nfs-utils-lib.x86_64
nss-softokn-freebl.i686
nss-softokn-freebl.x86_64
ntp.x86_64
openmotif22.i686
openmotif22.x86_64
openssh-clients.x86_64
pam_passwdqc.x86_64
rpm-build.x86_64
tcsh.x86_64
unzip.x86_64
zip.x86_64
zlib.i686
zlib.x86_64

1.6.0.2

pam.i686
pam-devel.i686

compat-db.i686
compat-db.x86_64
compat-glibc.x86_64
compat-glibc-headers.x86_64
compat-libstdc++*i686
dos2unix.x86_64
elfutils.x86_64
elfutils-libs.i686
elfutils-libs.x86_64
gettext.x86_64
gettext-libs.x86_64
glibc.i686
glibc.x86_64
gtk2.i686
gtk2.x86_64
gtk2-engines.i686
gtk2-engines.x86_64
libaio.i686
libaio.x86_64
libgcc.i686
libgcc.x86_64
libXft.i686
libXft.x86_64
libXmu.i686
libXtst.i686
libXtst.x86_64
nfs-utils.x86_64
nfs-utils-lib.x86_64
nss-softokn-freebl.i686
nss-softokn-freebl.x86_64
ntp.x86_64
openmotif22.i686
openmotif22.x86_64
openssh-clients.x86_64
pam_passwdqc.x86_64
redhat-lsb.x86_64
rpm-build.x86_64
tcsh.x86_64
unzip.x86_64
zlib.i686
zlib.x86_64

The following is required for the
high availability environment
only.

ksh.x86_64

1.6.0.2

pam.i686
pam-devel.i686

audit-libs.i686
audit-libs.x86_64
compat-libstdc++*i686
compat-libstdc++*x86_64
dos2unix.x86_64
gettext.x86_64
glibc.i686
glibc.x86_64
ksh.x86_64
libaio.i686
libaio.x86_64
libgcc.i686
libgcc.x86_64
libstdc++.i686
nss-softokn-freebl.i686
nss-softokn-freebl.x86_64
ntp.x86_64
openssh-clients.x86_64
pam.i686
pam-devel.i686
pam_passwdqc.x86_64
tcsh.x86_64
unzip.x86_64
xorg-x11-xauth.x86_64
zlib.i686
zlib.x86_64

The following is required for the
high availability environment
only.

zip.x86_64

compat-db.i686
compat-db.x86_64
dos2unix.x86_64
elfutils.x86_64
elfutils-libs.i686
elfutils-libs.x86_64
gettext.x86_64
glibc.i686
glibc.x86_64
gtk2.i686
gtk2.x86_64
gtk2-engines.i686
gtk2-engines.x86_64
ksh.x86_64
libgcc.i686
libgcc.x86_64
libXp.i686
libXpm.i686
libXpm.x86_64
libXpm-devel.i686
libXpm-devel.x86_64
nss-softokn-freebl.i686
nss-softokn-freebl.x86_64
ntp.x86_64
openssh-clients.x86_64
pam_passwdqc.x86_64
rpm-build.x86_64
tcsh.x86_64
unzip.x86_64
zlib.i686
zlib.x86_64

audit-libs.i686
audit-libs.x86_64
bc.x86_64
compat-db.i686
compat-db.x86_64
compat-glibc.x86_64
compat-glibc-headers.x86_64
compat-libstdc++*i686
compat-libstdc++*x86_64
dos2unix.x86_64
elfutils.x86_64
elfutils-libs.i686
elfutils-libs.x86_64
gettext.x86_64
gettext-libs.x86_64
glibc.i686
glibc.x86_64
gtk2.i686
gtk2.x86_64
gtk2-engines.i686
gtk2-engines.x86_64
ksh.x86_64
libaio.i686
libaio.x86_64
libcanberra.x86_64
libgcc.i686
libgcc.x86_64
libstdc++.i686
libXft.i686
libXft.x86_64
libXmu.i686
libXmu.x86_64
libXp.i686
libXpm.i686
libXpm.x86_64
libXpm-devel.i686
libXpm-devel.x86_64
libXtst.i686
libXtst.x86_64
nss-softokn-freebl.i686
nss-softokn-freebl.x86_64
ntp.x86_64
openmotif22.i686
openmotif22.x86_64
openssh-clients.x86_64
pam.i686
pam-devel.i686
pam_passwdqc.x86_64
rpm-build.x86_64
tcsh.x86_64
unzip.x86_64
xorg-x11-xauth.x86_64
zip.x86_64
zlib.i686
zlib.x86_64
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Table 9. Required Linux packages for standby IBM Intelligent Operations Center servers
Application server 2 Analytics server 2 Data server 2 Web server 2

bc.x86_64
compat-db.i686
compat-db.x86_64
compat-glibc.x86_64
compat-glibc-headers.x86_64
compat-libstdc++*i686
dos2unix.x86_64
elfutils.x86_64
elfutils-libs.i686
elfutils-libs.x86_64
gettext.x86_64
glibc.i686
glibc.x86_64
gtk2.i686
gtk2.x86_64
gtk2-engines.i686
gtk2-engines.x86_64
libaio.i686
libaio.x86_64
libgcc.i686
libgcc.x86_64
libXmu.i686
libXmu.x86_64
libXp.i686
libXpm.x86_64
libXtst.i686
libXtst.x86_64
nfs-utils.x86_64
nfs-utils-lib.x86_64
nss-softokn-freebl.i686
nss-softokn-freebl.x86_64
ntp.x86_64
openmotif22.i686
openmotif22.x86_64
openssh-clients.x86_64
pam_passwdqc.x86_64
rpm-build.x86_64
tcsh.x86_64
unzip.x86_64
zip.x86_64
zlib.i686
zlib.x86_64

1.6.0.2

pam.i686
pam-devel.i686

compat-db.i686
compat-db.x86_64
compat-glibc.x86_64
compat-glibc-headers.x86_64
compat-libstdc++*i686
dos2unix.x86_64
elfutils.x86_64
elfutils-libs.i686
elfutils-libs.x86_64
gettext.x86_64
gettext-libs.x86_64
glibc.i686
glibc.x86_64
gtk2.i686
gtk2.x86_64
gtk2-engines.i686
gtk2-engines.x86_64
libaio.i686
libaio.x86_64
libgcc.i686
libgcc.x86_64
libXft.i686
libXft.x86_64
libXmu.i686
libXtst.i686
libXtst.x86_64
nfs-utils.x86_64
nfs-utils-lib.x86_64
nss-softokn-freebl.i686
nss-softokn-freebl.x86_64
ntp.x86_64
openmotif22.i686
openmotif22.x86_64
openssh-clients.x86_64
pam_passwdqc.x86_64
redhat-lsb.x86_64
rpm-build.x86_64
tcsh.x86_64
unzip.x86_64
zlib.i686
zlib.x86_64

The following is required for the high
availability environment only.

ksh.x86_64

1.6.0.2

pam.i686
pam-devel.i686

audit-libs.i686
audit-libs.x86_64
compat-libstdc++*i686
compat-libstdc++*x86_64
dos2unix.x86_64
gettext.x86_64
glibc.i686
glibc.x86_64
ksh.x86_64
libaio.i686
libaio.x86_64
libgcc.i686
libgcc.x86_64
libstdc++.i686
nss-softokn-freebl.i686
nss-softokn-freebl.x86_64
ntp.x86_64
openssh-clients.x86_64
pam.i686
pam-devel.i686
pam_passwdqc.x86_64
tcsh.x86_64
unzip.x86_64
xorg-x11-xauth.x86_64
zlib.i686
zlib.x86_64

The following is required for the high
availability environment only.

zip.x86_64

compat-db.i686
compat-db.x86_64
dos2unix.x86_64
elfutils.x86_64
elfutils-libs.i686
elfutils-libs.x86_64
gettext.x86_64
glibc.i686
glibc.x86_64
gtk2.i686
gtk2.x86_64
gtk2-engines.i686
gtk2-engines.x86_64
ksh.x86_64
libgcc.i686
libgcc.x86_64
libXp.i686
libXpm.i686
libXpm.x86_64
libXpm-devel.i686
libXpm-devel.x86_64
nss-softokn-freebl.i686
nss-softokn-freebl.x86_64
ntp.x86_64
openssh-clients.x86_64
pam_passwdqc.x86_64
rpm-build.x86_64
tcsh.x86_64
unzip.x86_64
zlib.i686
zlib.x86_64

Procedure
1. All required Linux packages can be installed in all servers, or, only the packages required for each

server can be installed.
v To install all packages on all servers, run the following commands on each server. Each yum

command needs to be specified as a single line.
yum install -y audit-libs.i686 audit-libs.x86_64 bc.x86_64
compat-db.i686 compat-db.x86_64 compat-glibc.x86_64
compat-glibc-headers.x86_64 compat-libstdc++*i686
compat-libstdc++*x86_64 dos2unix.x86_64 elfutils.x86_64
elfutils-libs.i686 elfutils-libs.x86_64
gettext.x86_64
gettext-libs.x86_64 glibc.i686 glibc.x86_64 gtk2.i686 gtk2.x86_64
gtk2-engines.i686 gtk2-engines.x86_64 ksh.x86_64
libaio.i686
libaio.x86_64 libgcc.i686 libgcc.x86_64 libstdc++.i686 libXft.i686
libXft.x86_64 libXmu.i686 libXmu.x86_64 libXp.i686 libXpm.i686
libXpm.x86_64 libXpm-devel.i686 libXpm-devel.x86_64 libXtst.i686
libXtst.x86_64 nfs-utils.x86_64 nfs-utils-lib.x86_64
nss-softokn-freebl.i686 nss-softokn-freebl.x86_64 ntp.x86_64
openmotif22.i686 openmotif22.x86_64 openssh-clients.x86_64
pam.i686 pam-devel.i686 redhat-lsb.x86_64 rpm-build.x86_64
unzip.x86_64 xorg-x11-xauth.x86_64 zip.x86_64 zlib.i686 zlib.x86_64
pam_passwdqc.x86_64 tcsh.x86_64

yum -y update
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v To install only the packages required by each server, run the following commands. Each yum
command needs to be specified as a single line.
On application server 1 and application server 2:
yum install -y bc.x86_64 compat-db.i686 compat-db.x86_64
compat-glibc.x86_64 compat-glibc-headers.x86_64
compat-libstdc++*i686 dos2unix.x86_64 elfutils.x86_64
elfutils-libs.i686 elfutils-libs.x86_64 gettext.x86_64
glibc.i686 glibc.x86_64 gtk2.i686 gtk2.x86_64 gtk2-engines.i686
gtk2-engines.x86_64 libaio.i686
libaio.x86_64 libgcc.i686
libgcc.x86_64 libXmu.i686 libXmu.x86_64 libXp.i686 libXpm.x86_64
libXtst.i686 libXtst.x86_64 nfs-utils.x86_64 nfs-utils-lib.x86_64
nss-softokn-freebl.i686 nss-softokn-freebl.x86_64 ntp.x86_64
openmotif22.i686 openmotif22.x86_64 openssh-clients.x86_64
pam.i686 pam-devel.i686
rpm-build.x86_64 unzip.x86_64 zip.x86_64 zlib.i686 zlib.x86_64
pam_passwdqc.x86_64 tcsh.x86_64

yum -y update

On analytics server 1 and analytics server 2:
yum install -y ksh* unzip ksh.x86_64

yum install -y compat-db.i686 compat-db.x86_64 compat-glibc.x86_64
compat-glibc-headers.x86_64 compat-libstdc++*i686 dos2unix.x86_64
elfutils.x86_64 elfutils-libs.i686 elfutils-libs.x86_64
gettext.x86_64 gettext-libs.x86_64 glibc.i686 glibc.x86_64
gtk2.i686 gtk2.x86_64 gtk2-engines.i686 gtk2-engines.x86_64

libaio.i686 libaio.x86_64 libgcc.i686 libgcc.x86_64 libXft.i686
libXft.x86_64 libXmu.i686 libXtst.i686 libXtst.x86_64
nfs-utils.x86_64 nfs-utils-lib.x86_64 nss-softokn-freebl.i686
nss-softokn-freebl.x86_64 ntp.x86_64 openmotif22.i686
openmotif22.x86_64 openssh-clients.x86_64
pam.i686 pam-devel.i686 redhat-lsb.x86_64
rpm-build.x86_64 unzip.x86_64 zlib.i686 zlib.x86_64
pam_passwdqc.x86_64 tcsh.x86_64

yum -y update

On data server 1 and data server 2:
yum install -y zip.x86_64

yum install -y audit-libs.i686 audit-libs.x86_64
compat-libstdc++*i686 compat-libstdc++*x86_64 dos2unix.x86_64
gettext.x86_64 glibc.i686 glibc.x86_64 ksh.x86_64 libaio.i686
libaio.x86_64 libgcc.i686 libgcc.x86_64 libstdc++.i686
nss-softokn-freebl.i686 nss-softokn-freebl.x86_64 ntp.x86_64
openssh-clients.x86_64 pam.i686 pam-devel.i686 unzip.x86_64
xorg-x11-xauth.x86_64 zlib.i686 zlib.x86_64
pam_passwdqc.x86_64 tcsh.x86_64

yum -y update

On web server 1 and web server 2:
yum install -y compat-db.i686 compat-db.x86_64 dos2unix.x86_64
elfutils.x86_64 elfutils-libs.i686 elfutils-libs.x86_64
gettext.x86_64 glibc.i686 glibc.x86_64 gtk2.i686 gtk2.x86_64
gtk2-engines.i686 gtk2-engines.x86_64 ksh.x86_64 libgcc.i686
libgcc.x86_64 libXp.i686 libXpm.i686 libXpm.x86_64
libXpm-devel.i686 libXpm-devel.x86_64 nss-softokn-freebl.i686
nss-softokn-freebl.x86_64 ntp.x86_64 openssh-clients.x86_64
rpm-build.x86_64 unzip.x86_64 zlib.i686
zlib.x86_64 pam_passwdqc.x86_64 tcsh.x86_64

yum -y update
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On the semantic model server:
yum install -y audit-libs.i686 audit-libs.x86_64 bc.x86_64
compat-db.i686 compat-db.x86_64 compat-glibc.x86_64
compat-glibc-headers.x86_64 compat-libstdc++*i686
compat-libstdc++*x86_64 dos2unix.x86_64 elfutils.x86_64
elfutils-libs.i686 elfutils-libs.x86_64 gettext.x86_64
gettext-libs.x86_64 glibc.i686 glibc.x86_64 gtk2.i686 gtk2.x86_64
gtk2-engines.i686 gtk2-engines.x86_64 ksh.x86_64 libaio.i686
libaio.x86_64 libcanberra.x86_64 libgcc.i686 libgcc.x86_64
libstdc++.i686 libXft.i686 libXft.x86_64 libXmu.i686 libXmu.x86_64
libXp.i686 libXpm.i686 libXpm.x86_64 libXpm-devel.i686
libXpm-devel.x86_64 libXtst.i686 libXtst.x86_64
nss-softokn-freebl.i686 nss-softokn-freebl.x86_64 ntp.x86_64
openmotif22.i686 openmotif22.x86_64 openssh-clients.x86_64 pam.i686
pam-devel.i686 rpm-build.x86_64 unzip.x86_64 xorg-x11-xauth.x86_64
zip.x86_64 zlib.i686 zlib.x86_64
pam_passwdqc.x86_64 tcsh.x86_64

yum -y update

2. Optional: Install the Linux packages for the X Window System on the installation server. These
packages are required if the GUI installer will be used.
a. Install the packages for the GNOME or KDE desktop.

To install the GNOME desktop run:
yum -y groupinstall "X Window System" Desktop

To install the KDE desktop run:
yum -y groupinstall "X Window System" "KDE Desktop"

b. Run yum -y update

c. Start the desktop by running init 5. To make the GUI desktop the default desktop, do the
following.
1) Edit the /etc/inittab file.
2) Change the initdefault property from 3 to 5. The updated line should be as follows.

id:5:initdefault:

3) Save the changes.
4) Restart the server.

3. Optional: Install the Linux packages for the X Window System on the application server. These
packages are required if the password management tool will be used.
a. Install the packages for the GNOME or KDE desktop.

To install the GNOME desktop run:
yum -y groupinstall "X Window System" Desktop

To install the KDE desktop run:
yum -y groupinstall "X Window System" "KDE Desktop"

b. Run yum -y update

c. Start the desktop by running init 5. To make the GUI desktop the default desktop, do the
following.
1) Edit the /etc/inittab file.
2) Change the initdefault property from 3 to 5. The updated line should be as follows.

id:5:initdefault:

3) Save the changes.
4) Restart the server.

4. If the graphical installer is to be used in Chinese, Japanese, or Korean, run the appropriate command.
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Language Command

Chinese yum install -y "@Chinese Support"

Japanese yum install -y "@japanese Support"

Korean yum install -y "@Korean Support"

5. 1.6.0.2 The nfs-utils rpm package must be at the 1.2.3-36 level on analytics server 1 and analytics
server 2. Update the package using the following steps:
a. Download nfs-utils-1.2.3-36.el6.x86_64.rpm from a Linux support server.
b. Run rpm -qa nfs_utils* as the root user. The installed nfs-utils packages will be returned. The

nfs-utils-lib level can be ignored. If nfs-utils-1.2.3-39.el6.x86_64 is returned, no further
action is required.

c. If a value other than nfs-utils-1.2.3-39.el6.x86_64 is returned, as the root user run rpm -e
--nodeps nfs-utils-n.n.n-nn.el6.x86_64 where n.n.n-nn is the value displayed by the rpm -qa
command.

d. Run the rpm -ivh your_download_location/nfs-utils-1.2.3-36.el6.x86_64.rpm command as the
root user where your_download_location is the directory where nfs-utils-1.2.3-36.el6.x86_64.rpm
was downloaded.

Related information:

http://www.redhat.com/

Setting other pre-installation requirements
Before installing IBM Intelligent Operations Center, additional server setup is required.

Procedure
1. Ensure that all servers have the same time and date set as indicated by the Linux operating system. A

time synchronization service can be used.
2. Make sure no version of IBM Java is installed on any of the servers.
3. Set UMASK to 022.
4. Add the following lines to the /etc/security/limits.conf file on all servers to set the maximum

open file descriptors to 20480.
* soft nofile 20480
* hard nofile 20480

This will set the default (soft) limit of the number of open files for all users to 20480 and the
maximum (hard) limit for all users to 20480. If other applications require more than 20480 open files,
increase the hard limit as required.
If these settings are not made when the servers are prepared, the IBM Intelligent Operations Center
installation program will configure the required settings.
The configured open file descriptors can be displayed by running the ulimit -n command.

5. Add the following lines to the /etc/security/limits.d/90-nproc.conf file on all servers to set the
maximum number of user processes to 16384.
* soft nproc 16384
root soft nproc unlimited
* hard nproc 16384
root hard nproc 16384

This will set the default (soft) limit of the number of user processes for all users to 16384 and the
maximum (hard) limit for all users to 16384. If other applications require more than 16384 user
processes, increase the hard limit as required.
If these settings are not made when the servers are prepared, the IBM Intelligent Operations Center
installation program will configure the required settings.
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The configured user process limits can be displayed by running the ulimit -u command.

Preparing the servers for high availability
Before installing IBM Intelligent Operations Center in a high availability environment, additional server
setup is required. These steps are not required on the optional semantic model server.

Procedure
1. Ensure that your network is running IPV4. High availability server clustering does not support IPV6.
2. Ensure that the following is configured correctly so Tivoli System Automation clustering technology

can be successfully installed.
a. Ensure hostnames are specified correctly.
b. Ensure values contained in the TSA.* configuration properties in the topology properties file are

correctly configured. For example, make sure the NIC specified in the TSA.PRIMARY.USERNIC
property exists and is active during installation.

c. Ensure the DB2 High-Availability Disaster Recovery (HADR) ports are available. These ports are
used to replicate information from the primary databases to the standby databases. By default
these ports are in the 55000 range.

3. On analytics server 1 and analytics server 2, ensure the rpcidmapd, nfs and rpcbind services are set to
start automatically and that the services are started. The command to change the startup information
for a specified service is chkconfig service_name on, where service_name is the name of the service. The
command to start a specified service is /etc/init.d/service_name start, where service_name is the
name of the service.

Related tasks:
Configuring hostnames
Before installing IBM Intelligent Operations Center, TCP/IP networking needs to be set up on the servers.

Preparing the installation server
The installation server must be prepared before IBM Intelligent Operations Center can be installed.

About this task

In a standard environment, the analytics server is used as the installation server. In a high availability
environment, analytics server 1 is used as the installation server

Procedure
1. Obtain the IBM Intelligent Operations Center installation package by ordering the package of DVDs

or by obtaining the images from Passport Advantage.
2. On the installation server, create a directory named /distributionMedia, if the directory does not

already exist. If you want to use a directory other than /distributionMedia, make note of the
directory name. You will need to specify the different directory name during installation. In the
following steps, /distributionMedia is used in the examples.

3. If using physical DVDs, copy the installation images to the installation server.
a. Mount a DVD.
b. Copy the DVD contents to the /distributionMedia directory, or the directory you created.
c. Unmount the DVD.
d. Repeat until the contents of all DVDs are copied to the directory on the installation server.

4. If using ISO images from Passport Advantage, copy the installation images to the installation server.
a. Create a /distributionMedia/iso directory or an /iso subdirectory under the directory you

created in step 2. The following instructions will use /distributionMedia/iso in the examples.
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b. Download or copy each ISO image from Passport Advantage to the /iso subdirectory.
c. Create a directory to mount the ISO image. This can be done by running the following command:

mkdir /mnt/ioc16. The following instructions will use /mnt/ioc16 in the examples.
d. Mount the ISO image by running the following command: mount -o loop /distributionMedia/

iso/iso_filename /mnt/ioc16 where iso_filename is the name of one of the ISO image files.
e. Copy the ISO contents to /distributionMedia by running the following command: cp -r

/mnt/ioc16/* /distributionMedia.
f. Repeat mounting and copying ISO contents until all ISO image files have been processed.
g. Delete the /distributionMedia/iso directory unless you want to archive the original ISO images.

5. If the command line installer is to be used to install IBM Intelligent Operations Center, unpack the
installation package. This step is not required if the GUI installer will be used.
a. Change to the /installHome directory, or the directory you created.
b. Run the tar -zxvf ioc.tar.gz command.

Topology properties files
The topology properties files defines the customer-customizable properties for the deployment of IBM
Intelligent Operations Center. This file must be edited to meet the needs of the customer’s environment.
Any properties in the provided topology properties file not documented should not be changed.

After modifying the topology properties file, save a copy to a secure location. The file contains
security-sensitive information, such as user names and passwords for the system, in clear text. Default
access rights to the topology properties file will disclose system administration passwords to anyone on
the system. If an unauthorized person has access to this file, they will have full access to the system. The
file should not remain on the production servers.

The topology properties file can be used after installation in the following ways:
v As a repository of password information if a password is forgotten.
v As a repository for passwords when they are changed in the system. The modified topology properties

file can be used to update the passwords used by the platform control tool.
v As a backup of installation information if the system needs to be reinstalled. The topology properties

file can be used without having to redefine all the installation parameters.

IBM Intelligent Operations Center provides the following topology files:

File name Purpose Used in

install_home/ioc16/resource/
custom.properties

Defines the location of the installation
media, working directories, and other
properties. This file can be edited to
meet the needs of the customer’s
environment.

Standard environment and high
availability environment

install_home/ioc16/topology/
iop.std.properties

Defines the customer-customizable
properties for the deployment
including host names and passwords.
This file can be edited to meet the
needs of the customer’s environment.

Standard environment

install_home/ioc16/topology/
iop.ha.properties

Defines the customer-customizable
properties for the deployment
including host names and passwords.
This file can be edited to meet the
needs of the customer’s environment.

High availability environment
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Customizing the installation properties
The installation properties file provides definitions required by the installation scripts. These properties
can be modified when using the command line installation options.

About this task

On the installation server, go to the directory where the IBM Intelligent Operations Center installation
package was copied. In these steps, this directory is referred to as install_home. The installation server is
the analytics server. In a high availability topology, analytics server 1 is the installation server.

Procedure

Optional: Edit the install_home/ioc16/resource/custom.properties file and change the following
property values if desired. Any properties values in the file not listed in Table 10 should not be changed.
For those installing IBM Intelligent Operations Center for the first time, it is recommended that the
default values be used.

Table 10. IBM Intelligent Operations Center installation properties

Property Description Default value

image.basedir.local The name of the directory on the
installation server containing the IBM
Intelligent Operations Center installation
files. This is the directory where the
installation media files were copied
before running the installation tool. This
directory is referred to as install_media in
other installation instructions.

/distributionMedia

image.tempdir.local The directory on the installation server
used to store temporary files during the
installation.

/tmp/ioc/images

backup.local This directory is for internal use only. /tmp/ioc/backup

Unix.image.basedir.remote The directory on the target servers where
the packages to be installed on that server
will be copied.

/installMedia/ioc/image

Unix.script.basedir.remote The directory on the target servers where
the installation scripts to be run on that
server will be copied.

/installMedia/ioc/script

connection.timeout Time (in milliseconds) to wait for a
connection to the target servers before
failing.

15000

waiting.time Time (in milliseconds) to wait before
retrying a failed connection

20000

retry.count Number of times to retry a failed
connection before failing the installation

12

If unchanged, the default values will be used.
Related concepts:
“Password information for a standard environment” on page 56
Passwords for various user IDs used in the IBM Intelligent Operations Center solution are defined in the
topology properties file. For security reasons the default passwords shipped with IBM Intelligent
Operations Center should be changed.

52 IBM Intelligent Operations Center: IBM Intelligent Operations Center Product Documentation



Target server information for a standard environment
The SERVERS section of the topology properties file defines properties for the target servers.

Table 11 shows the server property values that must be specified in the topology properties file for your
environment.

Table 11. Target server properties

Property Description

DB.1.HOST The fully-qualified host name of the data server

DB.1.ACCOUNT.PWD The password for the root user on the data server

DB.1.SSH_PORT The port number for ssh access to the data server

APP.1.HOST The fully-qualified host name of the application server

APP.1.ACCOUNT.PWD The password for the root user on the application server

APP.1.SSH_PORT The port number for ssh access to the application server

ANA.1.HOST The fully-qualified host name of the analytics server

ANA.1.ACCOUNT.PWD The password for the root user on the analytics server

ANA.1.SSH_PORT The port number for ssh access to the analytics server

WEB.1.HOST The fully-qualified host name of the web server

WEB.1.ACCOUNT.PWD The password for the root user on the web server

WEB.1.SSH_PORT The port number for ssh access to the web server

Important: Host name values must be fully-qualified host names entered in the case defined. For
example, IOC16App.IOC16.com is not the same as ioc16app.ioc16.com.

An ssh port number can be set for each server. However, the configured port numbers will only be used
by the platform control tool. Port 22 must be enabled for ssh access on each server. Port 22 is required for
ssh access by IBM Intelligent Operations Center during installation.

Target server information for a high availability environment
The SERVERS section of the topology properties file defines properties for the target servers.

Table 12 shows the server property values that must be specified in the topology properties file for your
environment.

Table 12. Target server properties

Property Description

DB.1.HOST The fully-qualified host name of the data server 1

DB.1.ACCOUNT.PWD The password for the root user on the data server 1

DB.1.SSH_PORT The port number for ssh access to the data server 1

DB.2.HOST The fully-qualified host name of the data server 2

DB.2.ACCOUNT.PWD The password for the root user on the data server 2

DB.2.SSH_PORT The port number for ssh access to the data server 2

APP.1.HOST The fully-qualified host name of the application server 1

APP.1.ACCOUNT.PWD The password for the root user on the application server
1

APP.1.SSH_PORT The port number for ssh access to the application server
1
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Table 12. Target server properties (continued)

Property Description

APP.2.HOST The fully-qualified host name of the application server 2

APP.2.ACCOUNT.PWD The password for the root user on the application server
2

APP.2.SSH_PORT The port number for ssh access to the application server
2

ANA.1.HOST The fully-qualified host name of the analytics server 1

ANA.1.ACCOUNT.PWD The password for the root user on the analytics server 1

ANA.1.SSH_PORT The port number for ssh access to the analytics server 1

ANA.2.HOST The fully-qualified host name of the analytics server 2

ANA.2.ACCOUNT.PWD The password for the root user on the analytics server 2

ANA.2.SSH_PORT The port number for ssh access to the analytics server 2

WEB.1.HOST The fully-qualified host name of the web server 1

WEB.1.ACCOUNT.PWD The password for the root user on the web server 1

WEB.1.SSH_PORT The port number for ssh access to the web server 1

WEB.2.HOST The fully-qualified host name of the web server 2

WEB.2.ACCOUNT.PWD The password for the root user on the web server 2

WEB.2.SSH_PORT The port number for ssh access to the web server 2

Important: Host name values must be fully-qualified host names entered in the case defined. For
example, IOC16App.IOC16.com is not the same as ioc16app.ioc16.com.

An ssh port number can be set for each server. However, the configured port numbers will only be used
by the platform control tool. Port 22 must be enabled for ssh access on each server. Port 22 is required for
ssh access by IBM Intelligent Operations Center during installation.

Directory services information
The topology properties file defines values used to encrypt user passwords and other sensitive data
within the directory.

Encryption is based on two values: LDAP.SEED and LDAP.SALT.

Values must be printable ASCII characters. Printable ASCII characters are characters with code point
values from 33 to 126. A blank space cannot be used.

Table 13. Directory services properties

Property Description

LDAP.SEED A 12 to 1016 character string, consisting of printable
ASCII characters, between code points 33 through 126.

A cryptographically-strong string should be used. For
example, a long string comprised of mixed-case letters,
number and special characters without common words
or phrases.
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Table 13. Directory services properties (continued)

Property Description

LDAP.SALT A 12 character string, consisting of printable ASCII
characters, between code points 33 and 126.
Important: LDAP.SALT must be exactly 12 characters in
length. A value of more or less characters will cause the
installation to fail.

Record the LDAP.SEED and LDAP.SALT values outside of the system. The values will be needed if you need
to export or replicate directory entries.

LDAP suffix
The LDAP suffix information used in IBM Intelligent Operations Center is defined in the topology
properties file.

Only the ou, o, and c LDAP parameters can be changed. The parameters must meet the requirements
shown in Table 14.

Table 14. LDAP parameter syntax rules

Parameter Rules

c Must be exactly two characters in length containing only the following:

v Lowercase letters (a-z)

v Uppercase letters (A-Z)

o Must be 1-30 characters in length containing only the following:

v Lowercase letters (a-z)

v Uppercase letters (A-Z)

v Numbers (0-9)

v Dash (-)

v Underscore (_)

ou Must be 1-30 characters in length containing only the following:

v Lowercase letters (a-z)

v Uppercase letters (A-Z)

v Numbers (0-9)

v Dash (-)

v Underscore (_)

The values of ou, o, and c must match when specified for the following properties:
v LDAP.SUFFIX

v LDAP.BASE.ENTRY

v LDAP.USER.ENTRY

v LDAP.GROUP.ENTRY

v LDAP.PROXY.DN

For example:
LDAP.SUFFIX ou=SWG,o=IBM,c=US
LDAP.BASE.ENTRY ou=SWG,o=IBM,c=US
LDAP.USER.ENTRY ou=USERS,ou=SWG,o=IBM,c=US
LDAP.GROUP.ENTRY ou=GROUPS,ou=SWG,o=IBM,c=US
LDAP.PROXY.DN ou=SWG,o=IBM,c=US
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Lightweight Third-Party Authentication domain
IBM Intelligent Operations Center uses a Lightweight Third-Party Authentication (LTPA) token to enable
single sign-on across many services. The LTPA domain name must be specified in the topology properties
file.

Specify the LTPA domain name for your environment in the WAS.LTPA.DOMAIN property. The appropriate
value can be obtained by running the hostname -d command on application server in a standard
environment or on application server 1 in a high availability environment.

In a standard environment the value should be the same on the following servers:
v application server
v analytics server

In a high availability environment the value should be the same on the following servers:
v application server 1
v application server 2
v analytics server 1
v analytics server 2

The LTPA domain name is the parent portion of the fully qualified hostname of the servers. For example,
if the fully-qualified hostname is server.yourco.com then the LTPA domain is yourco.com.

Clustering properties
Properties configuring the clustering topology components must be defined before installing IBM
Intelligent Operations Center in a high availability environment.

Table 15. Clustering properties

Property Description

TSA.NETWORK.SUBNET The subnet mask for the network hosting the data
servers. This is the subnet mask for the network interface
cards (NIC) on both data servers.

TSA.PRIMARY.USENIC The name of the network interface card (NIC) on data
server 1. The NIC name can be found by running the
ifconfig command on data server 1.

TSA.STANDBY.USENIC The name of the network interface card (NIC) on data
server 2. The NIC name can be found by running the
ifconfig command on data server 2.

TSA.QUORUM.IP An IP address for a highly available system that is not
part of the IBM Intelligent Operations Center
environment. This IP address must be reachable from
both IBM Intelligent Operations Center data server 1 and
data server 2.

No software will be installed at this location. The only
requirement is that the system be available during
installation and at runtime.

Password information for a standard environment
Passwords for various user IDs used in the IBM Intelligent Operations Center solution are defined in the
topology properties file. For security reasons the default passwords shipped with IBM Intelligent
Operations Center should be changed.
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Passwords can only contain the following characters:
v Lowercase letters (a-z)
v Uppercase letters (A-Z)
v Numbers (0-9)
v Dash (-)
v Period (.)
v Underscore (_)
v Tilde (~)

Dash and period cannot be used as the first character in a password.

Unless otherwise noted, passwords must be 30 characters or less.

Table 16. Password properties

Property Associated user name Description

WEB.1.ACCOUNT.PWD root Root password for the web server

DB.1.ACCOUNT.PWD root Root password for the data server

APP.1.ACCOUNT.PWD root Root password for the application
server

ANA.1.ACCOUNT.PWD root Root password for the analytics
server

MDL.1.ACCOUNT.PWD root Root password for the semantic
model server

LDAP.DB.PWD dsrdbm01 LDAP directory database

LDAP.ADMIN.DN.PWD cn=root LDAP administrator bind

LDAP.BIND.DN.PWD cn=bind LDAP bind

LDAP.PROXY.INSTANCE.PWD tdsproxy LDAP proxy instance

LDAP.PROXY.ADMIN.DN.PWD cn=root LDAP proxy administrator bind

LDAP.PROXY.BIND.DN.PWD cn=bind LDAP proxy bind

LDAP.REPLICA.BIND.DN.PWD cn=master LDAP replica bind

ISIM.KEYSTORE.PWD none Keystore password

ISIM.POSIX.LINUX.PWD posixagent POSIX Linux user

WBM.DB.USER.PWD db2ibm Business activity monitoring service
database

IHS.KEYSTORE.PWD none HTTP server keystore

WORKLIGHT.DB.USER.PWD db2wrklt IBM Worklight database user ID

WORKLIGHT.APPCNTR.USER.PWD appcenteradmin IBM Worklight appcenter user ID

WAS.ADMIN.ACCOUNT.PWD waswebadmin Application services administrator.
This password must be the same as
PORTAL.ADMIN.ACCOUNT.PWD.

WAS.LTPA.PWD none LTPA token

PORTAL.ADMIN.ACCOUNT.PWD waswebadmin Administrator for the WebSphere
Application Server console for the
WebSphere Portal server. This
password must be the same as
WAS.ADMIN.ACCOUNT.PWD.

Chapter 2. Installing the solution 57



Table 16. Password properties (continued)

Property Associated user name Description

PORTAL.ADMIN.UID.PWD wpsadmin Administrator for the WebSphere
Portal server. This password must be
the same as DOMINO.ST.ADMIN.PWD.

PORTAL.DB.USER.PWD db2port1 WebSphere Portal database

DOMINO.USER.PWD notes Collaboration user

DOMINO.ORG.PWD IBM Collaboration organization

DOMINO.ADMIN.PWD notes admin Collaboration administrator

DOMINO.ST.ADMIN.PWD wpsadmin Collaboration portal administrator.
This password must be the same as
PORTAL.ADMIN.UID.PWD.

DOMINO.ST.BIND.PWD wpsbind Collaboration LDAP bind

DEFAULT.PWD.DAS dausr1 Database services administrative
server

DEFAULT.PWD.DB2 db2inst1, db2inst2 Database services data server

DEFAULT.PWD.IHS ihsadmin HTTP server

DEFAULT.PWD.MQM mqm Messaging services user

MQM.CONN.USER.PWD mqmconn Messaging services connection

IOP.ADMIN.USER.PWD ibmadmin System administration tools

This user is granted privileges
equivalent to the root user on the
target servers. The platform control
tool runs under this user name.
Because of the access afforded this
user, make sure this password is a
long value, is different from other
passwords, and is kept secure.

IOP.USER.USER.PWD ibmuser System general user

Important: The following passwords should not be changed: ISIM.ADMIN.USER.PWD and
ISIM.SYSTEM.USER.PWD.
Related concepts:
Chapter 3, “Securing the solution,” on page 89
Security is important within the IBM Intelligent Operations Center because the solution is central to
essential operations. To ensure security, it is important that you are aware of the default settings and that
you manage users of the solution to give all users the correct level of access.
Related tasks:
“Customizing the installation properties” on page 52
The installation properties file provides definitions required by the installation scripts. These properties
can be modified when using the command line installation options.
Related reference:
“Sample users” on page 91
During the deployment of IBM Intelligent Operations Center, sample users are created.
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Password information for a high availability environment
Passwords for various user IDs used in the IBM Intelligent Operations Center solution are defined in the
topology properties file. For security reasons the default passwords shipped with IBM Intelligent
Operations Center should be changed.

Passwords can only contain the following characters:
v Lowercase letters (a-z)
v Uppercase letters (A-Z)
v Numbers (0-9)
v Dash (-)
v Period (.)
v Underscore (_)
v Tilde (~)

Dash and period cannot be used as the first character in a password.

Unless otherwise noted, passwords must be 30 characters or less.

Table 17. Password properties

Property Associated user name Description

WEB.1.ACCOUNT.PWD root Root password for the web server 1

WEB.2.ACCOUNT.PWD root Root password for the web server 2

DB.1.ACCOUNT.PWD root Root password for the data server 1

DB.2.ACCOUNT.PWD root Root password for the data server 2

APP.1.ACCOUNT.PWD root Root password for the application
server 1

APP.2.ACCOUNT.PWD root Root password for the application
server 2

ANA.1.ACCOUNT.PWD root Root password for the analytics
server 1

ANA.2.ACCOUNT.PWD root Root password for the analytics
server 2

MDL.1.ACCOUNT.PWD root Root password for the semantic
model server

LDAP.DB.PWD dsrdbm01 LDAP directory database

LDAP.ADMIN.DN.PWD cn=root LDAP administrator bind

LDAP.BIND.DN.PWD cn=bind LDAP bind

LDAP.PROXY.INSTANCE.PWD tdsproxy LDAP proxy instance

LDAP.PROXY.ADMIN.DN.PWD cn=root LDAP proxy administrator bind

LDAP.PROXY.BIND.DN.PWD cn=bind LDAP proxy bind

LDAP.REPLICA.BIND.DN.PWD cn=master LDAP replica bind

ISIM.KEYSTORE.PWD none Keystore password

ISIM.POSIX.LINUX.PWD posixagent POSIX Linux user

WBM.DB.USER.PWD db2ibm Business activity monitoring service
database

IHS.KEYSTORE.PWD none HTTP server keystore

WORKLIGHT.DB.USER.PWD db2wrklt IBM Worklight database user ID
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Table 17. Password properties (continued)

Property Associated user name Description

WORKLIGHT.APPCNTR.USER.PWD appcenteradmin IBM Worklight appcenter user ID

WAS.ADMIN.ACCOUNT.PWD waswebadmin Application services administrator

WAS.LTPA.PWD none LTPA token

PORTAL.ADMIN.ACCOUNT.PWD waswebadmin Administrator for the WebSphere
Application Server console for the
WebSphere Portal server

PORTAL.ADMIN.UID.PWD wpsadmin Administrator for the WebSphere
Portal server

PORTAL.DB.USER.PWD db2port1 WebSphere Portal database

DOMINO.USER.PWD notes Collaboration user

DOMINO.ORG.PWD IBM Collaboration organization

DOMINO.ADMIN.PWD notes admin Collaboration administrator

DOMINO.ST.ADMIN.PWD wpsadmin Collaboration portal administrator

DOMINO.ST.BIND.PWD wpsbind Collaboration LDAP bind

DEFAULT.PWD.DAS dausr1 Database services administrative
server

DEFAULT.PWD.DB2 db2inst1, db2inst2 Database services data server

DEFAULT.PWD.IHS ihsadmin HTTP server

DEFAULT.PWD.MQM mqm Messaging services user

MQM.CONN.USER.PWD mqmconn Messaging services connection

IOP.ADMIN.USER.PWD ibmadmin System administration tools

This user is granted privileges
equivalent to the root user on the
target servers. The platform control
tool runs under this user name.
Because of the access afforded this
user, make sure this password is a
long value, is different from other
passwords, and is kept secure.

IOP.USER.USER.PWD ibmuser System general user

Important: The following passwords should not be changed: ISIM.ADMIN.USER.PWD and
ISIM.SYSTEM.USER.PWD.

Preinstall server validation
IBM Intelligent Operations Center validates the server environment before installing to make sure that the
servers meet hardware and software requirements.

Table 18 summarizes the server validation done prior to installing IBM Intelligent Operations Center. No
validation is done for the optional semantic model server.

Table 18. IBM Intelligent Operations Center server validation

Resource Application server Analytics server Data server Web server

Linux distribution Red Hat Enterprise
Server

Red Hat Enterprise
Server

Red Hat Enterprise
Server

Red Hat Enterprise
Server
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Table 18. IBM Intelligent Operations Center server validation (continued)

Resource Application server Analytics server Data server Web server

Linux release Version 6, release 6.3
or higher

Version 6, release 6.3
or higher

Version 6, release 6.3
or higher

Version 6, release 6.3
or higher

CPUs 4 4 4 2

Free space in
/datahome

not applicable not applicable 22 GB not applicable

Free space in /opt 32 GB 7 GB 7 GB 7 GB

Free space in /tmp 12 GB 12 GB 12 GB 12 GB

SELinux disabled disabled disabled disabled

Firewall disabled disabled disabled disabled

DNS (if configured) The following
commands are used
to validate that the
DNS is properly
configured:

nslookup -ip
nslookup -name

The following
commands are used
to validate that the
DNS is properly
configured:

nslookup -ip
nslookup -name

The following
commands are used
to validate that the
DNS is properly
configured:

nslookup -ip
nslookup -name

The following
commands are used
to validate that the
DNS is properly
configured:

nslookup -ip
nslookup -name

IPv6

Required even if IPv6
is not used in the
environment.

Verifies that the IPv6
module is loaded.

Verifies that the IPv6
module is loaded.

Verifies that the IPv6
module is loaded.

Verifies that the IPv6
module is loaded.

SSH configuration v Allow remote ssh
log in.

v Allow the root user
to login using ssh.

v Allow password
authentication.

v Allow remote ssh
log in.

v Allow the root user
to login using ssh.

v Allow password
authentication.

v Allow remote ssh
log in.

v Allow the root user
to login using ssh.

v Allow password
authentication.

v Allow remote ssh
log in.

v Allow the root user
to login using ssh.

v Allow password
authentication.

Available ports for
the high availability
topology

9060
9080

9060
9080

55002
55003
55004
55005
55006
55007
55008
55009
55010
55011
55012
55013
55014
55015
55016

not applicable

Available ports for
the standard topology

9060
9080

9060
9080

50000
50001
50002

not applicable

File handle limit 20480 20480 20480 20480

nprof limit (ulimit) 16384 16384 16384 16384

Memory 16 GB 16 GB 16 GB 2 GB
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Table 18. IBM Intelligent Operations Center server validation (continued)

Resource Application server Analytics server Data server Web server

Hostname v Defined hostname
is valid.

v Defined short
hostname is valid.

v Defined short host
name is the same
as the value
returned by the
hostname command

v Defined hostname
meets internet
standards RFC-1123
and RFC-952

v Defined hostname
is valid.

v Defined short
hostname is valid.

v Defined short host
name is the same
as the value
returned by the
hostname command

v Defined hostname
meets internet
standards RFC-1123
and RFC-952

v Defined hostname
is valid.

v Defined short
hostname is valid.

v Defined short host
name is the same
as the value
returned by the
hostname command

v Defined hostname
meets internet
standards RFC-1123
and RFC-952

v Defined hostname
is valid.

v Defined short
hostname is valid.

v Defined short host
name is the same
as the value
returned by the
hostname command

v Defined hostname
meets internet
standards RFC-1123
and RFC-952

Connectivity Ping command sent
to other nodes
returns successfully.

Ping command sent
to other nodes
returns successfully.

Ping command sent
to other nodes
returns successfully.

Ping command sent
to other nodes
returns successfully.

UMASK 022 022 022 022

The following additional tests are run.
v Each server is checked to ensure the required Linux packages are installed.
v Network speed is checked by uploading the file identified in the precheck.network.reffile property

in the resources/custom.properties file. If the upload speed is greater than the value specified in the
precheck.network.KBSec property in the resources/custom.properties file, the test will fail. The reason
for the network speed test is that slow networks can result in installation failures due to timeouts.

Running the standard environment command line installer
IBM Intelligent Operations Center is installed using a script that prepares and checks the servers, installs
IBM Intelligent Operations Center and associated tools in a standard environment.

Procedure
1. Log on to the installation server as the root user.

For a standard environment, the installation server is the analytics server.
2. Change to the /install_home/ioc16/bin directory.
3. Run the . ./ioc-env.sh command.
4. Run the ./iop.std.install.sh -p topology_password command. The topology_password is used to

provide security to the topology defined for IBM Intelligent Operations Center. The password is
required to make changes to the IBM Intelligent Operations Center installation and is the initial
password for the IBM Intelligent Operations Center tools.
Passwords can only contain the following characters:
v Lowercase letters (a-z)
v Uppercase letters (A-Z)
v Numbers (0-9)
v Dash (-)
v Period (.)
v Underscore (_)
v Tilde (~)
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Dash and period cannot be used as the first character in a password.
If a topology_password is not specified during the step to create the topology keystore, the
topology_password will be set to ibmioc16. A menu of install steps is displayed.

5. A license agreement is presented. Accepting the license is required before the installation can proceed.
6. Select an option from the menu.

Table 19. Installation options

Selection Installation Phase Step Description Average run time

1 Precheck Validate installation media checksums 15 minutes

2 Prepare Copy templates to the topology directory 2 minutes

3 Prepare Create topology keystore 1 minute

4 Prepare Parameterize all topologies 2 minutes2 minutes

5 Prepare (Optional) Encrypt all topologies 1 minute

6 Prepare Run "Setup/Target" topology 5 minutes

7 Prepare Run environmental prerequisite checks 15 minutes

8 Install (Optional) Upload media to target servers

If the media is not uploaded using this step it will be
uploaded in the next step. By uploading the media as a
separate step, a checkpoint can be taken after uploading the
media.

1 hour

9 Install Run ’standard’ base product installation topology 2 hours 30 minutes

10 Install Run ’standard’ product configuration topology 5 hours

11 Install Install Identity Manager component 1 hour 15 minutes

12 Install (Optional) Install Data Studio tool 15 minutes

13 Install Install platform control tool 15 minutes

14 Install Install system verification check tool tool 1 hour 15 minutes

15 Install Install IBM Intelligent Operations Center application 2 hours

7. Continue from step 4 on page 62 selecting installation steps in order. Do not select the next step until
the previous installation step has completed. Do not restart any servers until all steps have completed
successfully. The installation step can also be specified on the command. For example:
./iop.std.install.sh -p topology_password 1.

Note: If installing on virtual machines, take a snapshot of all virtual machines before installing the
IBM Intelligent Operations Center application. This will allow you to restore the snapshots if the
application installation fails. Without the snapshots the entire installation must be restarted. Do the
following to take the snapshot:
a. Log on to the analytics server as the root user and enter the following commands in a terminal

window:
su - ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./IOCControl -a stop -c all -p topology_password

b. Take a snapshot of all virtual machines.
c. Run the following command to restart the base architecture processes:

./IOCControl -a start -c all -p topology_password
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Results

Installation progress is displayed and written to logs located in the /install_home/ioc16/log directory on
the installation server.

Running the high availability environment command line installer
IBM Intelligent Operations Center is installed using a script that prepares and checks the servers, installs
IBM Intelligent Operations Center and associated tools in a high availability environment.

Procedure
1. Log on to the installation server as the root user.

For a high availability environment, the installation server is analytics server 1.
2. Change to the /install_home/ioc16/bin directory.
3. Run the . ./ioc-env.sh command.
4. Run the ./iop.ha.install.sh -p topology_password command. The topology_password is used to

provide security to the topology defined for IBM Intelligent Operations Center. The password is
required to make changes to the IBM Intelligent Operations Center installation and is the initial
password for the IBM Intelligent Operations Center tools.
Passwords can only contain the following characters:
v Lowercase letters (a-z)
v Uppercase letters (A-Z)
v Numbers (0-9)
v Dash (-)
v Period (.)
v Underscore (_)
v Tilde (~)

Dash and period cannot be used as the first character in a password.
If a topology_password is not specified during the step to create the topology keystore, the
topology_password will be set to ibmioc16. A menu of install steps is displayed.

5. A license agreement is presented. Accepting the license is required before the installation can proceed.
6. Select an option from the menu.

Table 20. Installation options

Selection Installation Phase Step Description Average run time

1 Precheck Validate installation media checksums 15 minutes

2 Prepare Copy templates to the topology directory 2 minutes

3 Prepare Create topology keystore 1 minute

4 Prepare Parameterize all topologies 2 minutes

5 Prepare (Optional) Encrypt all topologies 1 minutes

6 Prepare Run "Setup/Target" topology 5 minutes

7 Prepare Run environmental prerequisite checks 15 minutes

8 Install (Optional) Upload media to target servers

If the media is not uploaded using this step it will be
uploaded in the next step. By uploading the media as a
separate step, a checkpoint can be taken after uploading the
media.

1 hour

9 Install Run HA base product installation topology 3 hours 45 minutes
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Table 20. Installation options (continued)

Selection Installation Phase Step Description Average run time

10 Install Run HA configure product topology 8 hours 15 minutes

11 Install Install Identity Management component 1 hour 15 minutes

12 Install Prepare and configure DB2 HADR Cluster Management 15 minutes

13 Install (Optional) Install Data Studio tool 15 minutes

14 Install Install platform control tool 15 minutes

15 Install Install system verification check tool tool 1 hour 30 minutes

16 Install Install IBM Intelligent Operations Center application 4 hours

7. Continue from step 4 on page 64 selecting installation steps in order. Do not select the next step until
the previous installation step has completed. Do not restart any servers until all steps have completed
successfully. The installation step can also be specified on the command. For example:
./iop.ha.install.sh -p topology_password 1.

Note: If installing on virtual machines, take a snapshot of all virtual machines before installing the
IBM Intelligent Operations Center application. This will allow you to restore the snapshots if the
application installation fails. Without the snapshots the entire installation must be restarted. Do the
following to take the snapshot:
a. Log on to the analytics server as the root user and enter the following commands in a terminal

window:
su - ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./IOCControl -a 091 -p topology_password

b. Take a snapshot of all virtual machines.
c. Run the following command to restart the base architecture processes:

./IOCControl -a 001 -p topology_password

Results

Installation progress is displayed and written to logs located in the /install_home/ioc16/log directory on
the installation server.

Running the standard environment GUI installer
IBM Intelligent Operations Center can be installed using a graphical installer. This installer limits the
options provided during the installation process. If your environment requires configuration options not
provided by the GUI installer, use the command line installer to install IBM Intelligent Operations Center
and associated tools in a standard environment.

Procedure
1. On a graphical console, log on to the installation server.
2. Open a command line console.
3. Change to the the directory containing the IntelligentOperationsCenter-install.bin file. By

default this is the /installHome directory.
4. Run the ./IntelligentOperationsCenter-install.bin command as the root user. The GUI installer

will be displayed.
5. Select your preferred language and click OK.
6. Review the welcome panel and click Next.
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7. Read and accept the license agreement to continue the installation. If you do not accept the license
agreement, the installation will be terminated.

8. Select the location where the installation media is stored. By default this is the /distributionMedia
directory. Click Next.

9. If the installer detects a previously attempted installation of IBM Intelligent Operations Center, select
whether to continue with the previous installation attempt or start a new installation. When a new
installation is started, the previously attempted installation will be archived.

10. Select the installation directory. The default direction is /opt/ibm/IOC16install. Click Next. This
folder will contain the installation scripts, tools, and other resources.

11. Select the type of topology to be installed. Click Next.
12. Specify the domain name. Click Next. The domain name is the DNS domain name of your company

or organization. Typically it is the parent portion of the fully-qualified hostnames of the organization
servers. For example, if the fully qualified hostname of a server is server.us.co.com the domain
name would be us.co.com.

13. Specify the topology password. Click Next. Make note of this password. The topology password is
used during the operation of IBM Intelligent Operations Center. For example, the topology password
is used when running the platform control tool.

14. Specify the admin password. Click Next. Make note of this password. This password is required to
administer products provided by IBM Intelligent Operations Center using those product’s
administration consoles or tools. For example, this password is required to log on to the WebSphere
Application Server Integrated Solutions Console to administer WebSphere Application Server and to
log on to WebSphere Portal as the portal administrator.

15. Specify the LDAP SALT and SEED keys. Click Next.
16. On the subsequent panels enter the fully-qualified hostname, root user name, root password, and ssh

port for each of the servers. Click Next after entering the information for each server. The default ssh
port is 22.

17. After all installation parameter values are entered, select to proceed or cancel the installation.
Installation proceeds without further input. Installation progress is displayed in a terminal session
and written to the /opt/ibm/IOCinstall/install.log on the installation server. When complete, the
installer will display a panel indicating successful completion.

18. Click Done.
19. Close the terminal window displaying the installation log.

Results

IBM Intelligent Operations Center is installed and ready for post-installation configuration.

Running the high availability environment GUI installer
IBM Intelligent Operations Center can be installed using a graphical installer. This installer limits the
options provided during the installation process. If your environment requires configuration options not
provided by the GUI installer, use the command line installer to install IBM Intelligent Operations Center
and associated tools in a high availability environment.

Procedure
1. On a graphical console, log on to the installation server.
2. Open a command line console.
3. Change to the the directory containing the IntelligentOperationsCenter-install.bin file. By

default this is the /installHome directory.
4. Run the ./IntelligentOperationsCenter-install.bin command as the root user. The GUI installer

will be displayed.
5. Select your preferred language and click OK.
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6. Review the welcome panel and click Next.
7. Read and accept the license agreement to continue the installation. If you do not accept the license

agreement, the installation will be terminated.
8. Select the location where the installation media is stored. By default this is the /distributionMedia

directory. Click Next.
9. If the installer detects a previously attempted installation of IBM Intelligent Operations Center, select

whether to continue with the previous installation attempt or start a new installation. When a new
installation is started, the previously attempted installation will be archived.

10. Select the installation directory. The default direction is /opt/ibm/IOC16install. Click Next. This
folder will contain the installation scripts, tools, and other resources.

11. Select the type of topology to be installed. Click Next.
12. Specify the domain name. Click Next. The domain name is the DNS domain name of your company

or organization. Typically it is the parent portion of the fully-qualified hostnames of the organization
servers. For example, if the fully qualified hostname of a server is server.us.co.com the domain
name would be us.co.com.

13. Specify the topology password. Click Next. Make note of this password. The topology password is
used during the operation of IBM Intelligent Operations Center. For example, the topology password
is used when running the platform control tool.

14. Specify the admin password. Click Next. Make note of this password. This password is required to
administer products provided by IBM Intelligent Operations Center using those product’s
administration consoles or tools. For example, this password is required to log on to the WebSphere
Application Server Integrated Solutions Console to administer WebSphere Application Server and to
log on to WebSphere Portal as the portal administrator.

15. Specify the LDAP SALT and SEED keys. Click Next.
16. On the subsequent panels enter the fully-qualified hostname, root user name, root password, and ssh

port for each of the servers. Click Next after entering the information for each server. The default ssh
port is 22.

17. After all installation parameter values are entered, select to proceed or cancel the installation.
Installation proceeds without further input. Installation progress is displayed in a terminal session
and written to the /opt/ibm/IOCinstall/install.log on the installation server. When complete, the
installer will display a panel indicating successful completion.

18. Click Done.
19. Close the terminal window displaying the installation log.

Results

IBM Intelligent Operations Center is installed and ready for post-installation configuration.

Verifying the installation prior to post-installation configuration
After running the installer, verify that IBM Intelligent Operations Center has been correctly installed
before starting the post-installation configuration steps.

Procedure
1. Use the platform control tool to stop all components.
2. Check that all components have stopped successfully by reviewing the displayed messages.
3. Shut down the Linux operating system on all servers.
4. Power-down and power-up all runtime servers or reboot all servers.
5. Use the platform control tool to start all components.
6. Use the platform control tool to query the status of all components.
7. Check that you can access the IBM Intelligent Operations Center.
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a. In a browser go to https://web_hostname/wps/portal where web_hostname is the hostname of the
web server.

b. Log on as a IBM Intelligent Operations Center administrator, for example, wpsadmin. The wpsadmin
password is defined in the topology property file PORTAL.ADMIN.UID.PWD property.

The Supervisor: Operations page will be displayed.
8. Run all the tests in the system verification check tool.
9. Check that all tests have run successfully.

What to do next

If any errors are noted, resolve the errors and rerun these steps.
Related tasks:
“How to use the system verification check tool” on page 209
The system verification check tool is used to determine the operational status of services comprising the
IBM Intelligent Operations Center system.
“Querying the status of the components in a standard environment” on page 197
The platform control tool can be used to determine the status of the components running on IBM
Intelligent Operations Center standard environment servers.
“Querying the status of the components in a high availability environment” on page 207
The platform control tool can be used to determine the status of the components running on IBM
Intelligent Operations Center high availability environment servers.
“Starting the components in a standard environment” on page 191
The platform control tool can be used to start the components running on IBM Intelligent Operations
Center standard environment servers.
“Starting the components in a high availability environment” on page 199
The platform control tool can be used to start the components running on IBM Intelligent Operations
Center high availability environment servers.
“Stopping the components in a standard environment” on page 194
The platform control tool can be used to stop components running on IBM Intelligent Operations Center
standard environment servers.
“Stopping the components in a high availability environment” on page 203
The platform control tool can be used to stop components running on IBM Intelligent Operations Center
high availability servers.

Post-installation IBM Intelligent Operations Center configuration
After installing IBM Intelligent Operations Center, several post-installation configuration steps need to be
done to complete the installation.

Configuring collaboration services for IPv6
If your installation uses IPv6 networking, configuration steps are required for collaboration services.

About this task

The IBM Intelligent Operations Center architecture needs to be installed before configuring IPv6
networking for collaboration services.

Procedure
1. Follow the steps in the Lotus Domino documentation to configure Lotus Domino for IPv6 addressing.
2. Follow the steps in the Lotus Sametime Standard documentation to configure Lotus Sametime

Standard for IPv6 addressing.
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3. Follow the steps in the WebSphere Portal documentation to configure trust for the Sametime Contact
List portlet if you are not using an IPv4 network with an IPv4 address assigned to the application
server.

Related information:

Configuring Lotus Domino for IPv6 addressing

Configuring the Sametime Community Server to support IPv6

Configuring trust for the Sametime Contact List portlet

Configuring single sign-on for collaboration services
Import the WebSphere Portal SSO LTPA token into the application server to allow users to access
collaboration services without having to reenter their credentials.

Before you begin

To complete this task a Lotus Notes 8.5.x client is required. An existing Notes Client can be used or one
can be installed on a Windows client using the notes_designer_admin853_w32en.exe file in the
/distributionMedia folder on the installation server. The workstation must be able to connect to the
application server over TCP/IP using the fully-qualified host name.

About this task

The IBM Intelligent Operations Center architecture needs to be installed before importing the Lightweight
Third-Party Authentication (LTPA) token.

This token was created during the installation of the IBM Intelligent Operations Center architecture.

Procedure
1. Install a Lotus Notes 8.5.x client on a workstation. An existing installation can be used. The

workstation must be able to connect to the application server over TCP/IP using the fully-qualified
host name.

2. Copy the /opt/IBM/ISP/stproxy.ltpa file from the application server to the workstation running
Lotus Notes. This is the LTPA token that will be imported into the collaboration service directory.

3. Copy the /local/notesdata/admin.id file from the application server to the workstation running
Lotus Notes. This is the ID file for the collaboration service administrator. You will use this ID to
login to the collaboration services directory.

4. On the workstation, start the Lotus Notes client and log on with the admin.id file.
a. On the Lotus Notes log on panel, click User Name.
b. Navigate to the directory where you copied that admin.id file and select it.
c. Enter the password defined in the topology properties file for the DOMINO.ADMIN.PWD property.
d. Click Yes if a security warning is displayed.

5. Open the names.nsf file.
a. Click File > Open > Lotus Notes Application.
b. Enter the fully-qualified host name of the application server in Look In.
c. Enter names.nsf in File Name.
d. Click Open.

6. Navigate to Web > Web Configurations.
7. Select Web SSO Configuration for LTPA Token and click Edit Document.
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8. Click Keys > Import WebSphere LTPA Keys. Click OK if a warning is received about overwriting
existing keys.

9. Enter the path to where the stproxy.ltpa file was copied. Click OK.
10. Enter the password for the LTPA token. The password is defined in the topology properties file

WAS.LTPA.PWD property.
11. In Token Format select LtpaToken2.
12. Click OK > Save and Close.
13. In a standard environment, restart the collaboration service using the platform control tool.

a. Log on to the management server and open a terminal window.
b. Run su -ibmadmin.
c. Run /opt/IBM/ISP/mgmt/scripts/IOCControl -a stop -c st -p password where password is the

password for the platform control tool defined when the platform control tool was installed.
d. Run /opt/IBM/ISP/mgmt/scripts/IOCControl -a start -c st -p password where password is the

password for the platform control tool defined when the platform control tool was installed.
14. In a high availability environment, restart the collaboration service using the platform control tool.

a. Log on to the management server and open a terminal window.
b. Run su -ibmadmin.
c. Run /opt/IBM/ISP/mgmt/scripts/IOCControl -a 611 -p password where password is the password

for the platform control tool defined when the platform control tool was installed.
d. Run /opt/IBM/ISP/mgmt/scripts/IOCControl -a 261 -p password where password is the password

for the platform control tool defined when the platform control tool was installed.

Setting the session timeout
The session timeout determines the time a user can remain idle before the session is terminated and the
user must log in again. The session time out includes administrators logged in through the portal service.

About this task

When IBM Intelligent Operations Center is installed, no session time out is defined. Users will stay
logged in until they log out even if the session is idle.

If your organization has security policies requiring that sessions log out after a period of inactivity, use
the following steps to define a session timeout for your IBM Intelligent Operations Center system.

Procedure

Configure server timeouts.
1. Using a web browser go to http://application_server:9061/ibm/console where application_server is

the host name of the application server in a standard environment and application server 1 in a high
availability environment.

2. Log on as the admin user with the password defined for PORTAL.ADMIN.ACCOUNT.PWD in the topology
properties file.

3. Click Servers > Server Type > WebSphere Application Servers > WebSphere Portal.
4. Click Container Settings > Session management > Set Timeout.
5. Enter the desired timeout value in minutes.
6. Click OK.
7. Click Save.
8. Click Servers > Server Type > WebSphere Application Servers > STProxyServer1.
9. Click Container Settings > Session management > Set Timeout.
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10. Enter the desired timeout value in minutes.
11. Click OK.
12. Click Save.
13. Click Servers > Server Type > WebSphere Application Servers > CongnosX_GW1.
14. Click Container Settings > Session management > Set Timeout.
15. Enter the desired timeout value in minutes.
16. Click OK.
17. Click Save.
18. Click Servers > Server Type > WebSphere Application Servers > CongnosX_Disp1.
19. Click Container Settings > Session management > Set Timeout.
20. Enter the desired timeout value in minutes.
21. Click OK.
22. Click Save.
If running in a high availability environment, configure the following additional servers.
23. Click Servers > Server Type > WebSphere Application Servers > CongnosX_Disp2.
24. Click Container Settings > Session management > Set Timeout.
25. Enter the desired timeout value in minutes.
26. Click OK.
27. Click Save.
28. Click Servers > Server Type > WebSphere Application Servers > CongnosX_GW2.
29. Click Container Settings > Session management > Set Timeout.
30. Enter the desired timeout value in minutes.
31. Click OK.
32. Click Save.
33. Click Servers > Server Type > WebSphere Application Servers > WebSphere_Portal_PortalNode2.
34. Click Container Settings > Session management > Set Timeout.
35. Enter the desired timeout value in minutes.
36. Click OK.
37. Click Save.
Set the Cognos inactivity timeout.
38. Log on to the analytics server in the standard environment and both analytics server 1 and analytics

server 2 in the high availability environment as the root user.
39. Run /opt/IBM/cognos/c10_64/bin64/cogconfig.sh

40. Click Security > Authentication.
41. Specify the desired timeout value in seconds for Inactivity timeout in seconds.
42. Click File > Save.
43. Repeat for the second analytics server in the high availability environment.
Restart the server.
44. Stop and restart the application and analytic components using the platform control tool.

Setting the LTPA timeout
The Lightweight Third-Party Authentication (LTPA) timeout determines the time a user can remain
logged on before the session is terminated and the user must log in again. The LTPA time out includes
administrators logged in through the portal service.
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About this task

When IBM Intelligent Operations Center is installed, an LTPA timeout of 150 minutes is configured. Users
will stay logged in until they log out after 150 minutes have elapsed.

If your organization has security policies requiring that sessions log out after a different period of time,
use the following steps to define the LTPA timeout for your IBM Intelligent Operations Center system.

Procedure
1. Using a web browser go to http://application_server:9061/ibm/console where application_server is

the host name of the application server in a standard environment and application server 1 in a high
availability environment.

2. Log on as the admin user with the password defined for PORTAL.ADMIN.ACCOUNT.PWD in the topology
properties file.

3. Click Security > Global security > LTPA.
4. Enter the desired LPTA timeout value in minutes.
5. Click Apply.
6. Click Save.
7. Stop and restart all IBM Intelligent Operations Center components using the platform control tool. If

IBM Intelligent Operations Center is still being installed, the servers will be restarted during
installation full verification.

Configuring the IBM HTTP Server system administrator email address
Configure the system administrator email address that is included in system generated messages.

About this task

On the web server in a standard environment or web server 1 and web server 2 in a high availability
environment, change the IBM HTTP Server configuration to reference the system administrator email
address to be contacted for server issues.

Procedure
1. Edit the /opt/IBM/HTTPServer/conf/httpd.conf file.
2. Change the ServerAdmin value to the email address of the system administrator to be contacted for

server issues.
3. Save the file.
4. Using the platform control tool restart the IBM HTTP Server.

Removing HTTPOnly setting for IBM Business Monitor
HTTPOnly must be disabled for IBM Business Monitor to function property.

Procedure
1. Using a web browser go to http://application_server:9061/admin where application_server is the

host name of the application server in a standard environment and application server 1 in a high
availability environment.

2. Log on as the admin user with the password defined for WAS.ADMIN.ACCOUNT.PWD in the topology
properties file.

3. Click Servers > Server Types > Websphere application servers.
4. Click WBM_DE.AppTarget.WBMNode1.0.
5. In "Container Settings" click Session Management.
6. In "General Properties" click Enable cookies.
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7. Clear the Set session cookies to HTTPOnly to help prevent cross-site scripting attacks checkbox.
8. Click OK and Save. The changes will be saved to the master configuration.
9. If running a high availability environment, repeat steps 3 on page 72 through 8 and make the same

changes for WBM_DE.AppTarget.WBMNode2.0.
10. Click Servers > Clusters > Websphere application server clusters.
11. Select WBM_DE.AppTarget and click Stop. The IBM Business Monitor cluster will be stopped.
12. Click System administration > Nodes.
13. Select WBM Nodes and click Full resynchronize. The changes will be synchronized to all IBM

Business Monitor nodes.
14. Click Servers > Clusters > Websphere application server clusters.
15. Select WBM_DE.AppTarget and click Start. The IBM Business Monitor cluster will be started.

Configuring a secondary collaboration services LDAP server in a high
availability environment
A secondary LDAP server is required for collaboration services when running a high availability
environment.

Procedure
1. Install a Lotus Notes 8.5.x client on a workstation. An existing installation can be used. The

workstation must be able to connect to the application server 1 over TCP/IP using the fully-qualified
host name.

2. Copy the /local/notesdata/admin.id file from application server 1 to the workstation running Lotus
Notes. This is the ID file for the collaboration service administrator. You will use this ID to login to
the collaboration services directory.

3. On the workstation, start the Lotus Notes client and log on with the admin.id file.
a. On the Lotus Notes log on panel, click User Name.
b. Navigate to the directory where you copied the admin.id file and select it.
c. Enter the password defined in the topology properties file for the DOMINO.ADMIN.PWD property.
d. Click Yes if a security warning is displayed.

4. Open the names.nsf file.
a. Click File > Open > Lotus Notes Application.
b. Enter the fully-qualified host name of the application server 1 in Look In.
c. Enter names.nsf in File Name.
d. Click Open.

5. Open the da.nsf file.
a. Click File > Open > Lotus Notes Application.
b. Enter the fully-qualified host name of application server 1 in Look In.
c. Enter da.nsf in File Name.
d. Click Open.

6. Duplicate the existing directory assistance entry.
7. Update the duplicate directory assistance entry.

a. On the Basics tab set Group Authorization to No.
b. For Search Order specify 2.
c. On the LDAP tab change the LDAP host from your primary LDAP hostname to your secondary

LDAP hostname.
8. Open the stconfig.nsf file.

a. Click File > Open > Lotus Notes Application.
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b. Enter the fully-qualified host name of application server 1 in Look In.
c. Enter stconfig.nsf in File Name.
d. Click Open.

9. Click By Form.
10. Duplicate the LDAPServer form.
11. Update the duplicated form.

a. For LDAP Connection specify the fully-qualified hostname of your secondary LDAP.
b. For Search Order specify 2.

12. Restart collaboration services.
a. Log on to analytics server 1 or analytics server 2 as the ibmadmin user. If logged on as a different

user, change to the ibmadmin user by running the su - ibmadmin command.
a. Run the following commands:

IOCControl -a 611 -p password
IOCControl -a 261 -p password

where password is the topology password defined when the IBM Intelligent Operations Center
was installed.

Configuring additional cluster manager relationships in a high
availability environment
After installing IBM Intelligent Operations Center in a high availability environment, cluster manager
relationships need to be configured.

About this task

If this configuration is not done, an uncontrolled failure of the primary data server, or its network
interface, will not switch the databases to the standby data server. When the failover fails, IBM Intelligent
Operations Center will become inoperable.

Procedure
1. Log on to analytics server 1.
2. Open a terminal window.
3. If not logged on as the root user, run the su - root command to change to the root user.
4. Run cd install_home/ioc16/bin where install_home is the directory where the installation files were

copied when installing IBM Intelligent Operations Center.
5. Run . ./ioc-env.sh

6. Run ./ba.sh installTopology -t iop.ha.tsapatch -p topology_password where topology_password is
the topology password defined when IBM Intelligent Operations Center was installed.

Configuring the optional external network file system in a high
availability environment
The optional external network file system is configured using a script.

About this task

The external network file system is used to provide a more robust failover solution for messaging
services.
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Procedure
1. Log on to the installation server as the root user.
2. Change to the /install_home/ioc16/bin directory.
3. Run the ./ioc-env.sh command.
4. Run the ./iop.ha.wmqextnfs.sh -p topology_password command. The topology_password is the one

specified when IBM Intelligent Operations Center was installed or was subsequently modified. If not
specified, topology_password will default to ibmioc16. A menu of install steps is displayed.

5. Select an option from the menu.

Table 21. External network file system configuration options

Selection Phase Step Description Average run time

1 Prepare Copy template to topology directory 1 minute

2 Prepare Parameterize topology 1 minute

3 Prepare Encrypt topology 1 minute

4 Install Setup the external network file system 7 minutes

6. Continue from step 4 selecting installation steps in order. Do not select the next step until the
previous installation step has completed. The installation step can also be specified on the command.
For example: ./iop.ha.wmqextnfs.sh -p topology_password 1.

Results

Installation progress is displayed and written to logs located in the /install_home/ioc16/log directory on
the installation server.

Configure the Cognos model in a high availability environment
IBM Intelligent Operations Center can publish a Cognos model when a data source is created or updated.
In a high availability environment, you must configure Cognos to enable IBM Intelligent Operations
Center to publish the Cognos model.

About this task

In a high availability environment, when IBM Intelligent Operations Center tries to publish a Cognos
model, an error occurs if two dispatchers are running. The following error message is displayed in the
log files:
BME-AS-0022 Model not open is obtained.

The following notification is sent to the solution administrator:
The Cognos models were not updated.

Use the following procedure to either stop one of the dispatchers, or to stop the metadataService for one
of the dispatchers.

Procedure
1. Start IBM Cognos Administration.
2. Click the Configuration tab.
3. In the menu, click Dispatchers and Services. In a high availability environment, two dispatchers are

listed.
4. Choose one of the following options:

v To stop one of the dispatchers, click More next to the dispatcher and then click Stop Immediately.
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v To stop the metadataService for one of the dispatchers, select the dispatcher. Next to the
MetadataService, click More and then click Stop Immediately.

Results

With only one dispatcher service or MetadataService running, IBM Intelligent Operations Center can
publish the Cognos model when a data source is created or updated. When the Cognos model is
successfully published, a notification is sent to the administrator.

Defining the optimized interactive processes communication method
1.6.0.2

The Optimized Interactive Processes (OIP) Extreme Messaging (XM) component packaged with IBM
Intelligent Operations Center must be configured to define the communication methods if email or SMS
notifications are to be used. If email is to be used, the server SMTP services are used to deliver outgoing
email. For SMS notifications an SMS gateway provided by a third party is required. If neither notification
method is required, these steps are optional.

Procedure
1. Click Administration > Solution Administration > Administration Consoles > OIP Administration.
2. Copy the URL from the window that is displayed to a private window in the browser.

Note: To display a private window:
v in Firefox, click New Private window.
v in Internet Explorer, click Safety >InPrivate Browsing.

3. Log on as the WebSphere Application Server admin user.

Note: Complete initialization steps 4 - 7 the first time that you run OIP.
4. Click Configuration and click Stop to stop the XM component.
5. Wait until XM Server State has a value of Stopped.
6. Click init and wait until Save Changes is displayed.
7. Click Start and wait until XM Server State has a value of Started.
8. Click Accounts.
9. Click the plus sign (+).

10. In Add Account enter iocAccount for Name.
11. Click OK.
12. Under Accounts click iocAccount.
13. Select None for Report policy.
Email configuration
14. In Outgoing Channels click the plus sign (+).
15. For Communication Method select email.
16. Click Next.
17. Provide the following information:

Title IOC Account Outgoing Email

Address
iocAccount@EventServer_FQDN

Session Name
IOC Account Outgoing Email
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JNDI name
mail/iocAccount_out

Host Name
The fully qualified domain name of your SMTP server

Protocol
smtp

Port Your SMTP server port (default is 25)

User name
Your SMTP server user name used for sending email

Password
The password for User name

18. Click Finish.
SMS configuration
19. In Outgoing Channels click the plus sign (+).
20. For Communication Method select sms.
21. Select mobileGateway.
22. Click Next.
23. Provide the following information:

Title IOC Notification Outgoing SMS

SMS Mobile gateway hostname / IP
Enter the value appropriate for your SMS gateway configuration.

Mobile gateway port
Enter the value appropriate for your SMS gateway configuration.

24. If the gateway is secured, select Secured and provide the following information:

Username
Enter the value appropriate for your SMS gateway configuration.

Password
Enter the value appropriate for your SMS gateway configuration.

25. Click Finish.
Related tasks:
“Configuring notification settings” on page 388
You can configure the solution to notify you if a specific event occurs. There are three types of
notifications: system, SMS, and email. You can view and edit your notification settings in your IBM
Intelligent Operations Center user profile.

Configuring the optimized interactive process maintenance tasks
1.6.0.2

The optimized interactive processes extreme messaging component packaged with IBM Intelligent
Operations Center must be configured to define how messages about maintenance tasks are to be sent
and received.

Procedure
1. Go to http://AppServer_FQDN:10039/xm-admin/ and log on as the WASAdmin user.
2. Click Configuration.
3. Click Maintenance Tasks.
4. Adjust the settings according to your preferences.
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Note: To receive alerts by SMTP or SMS, you must clear each of the Use maintenance time window
check boxes.

Installing and configuring semantic model services
IBM Intelligent Operations Center provides a semantic model services application and sample model.
This service needs to be installed and configured prior to use.

Installing the optional semantic model server in a standard environment
The optional IBM Intelligent Operations Center semantic model server is installed in a standard
environment using a script.

Procedure
1. Log on to the data server as the root user.
2. Run the su - db2inst1 -c "db2 update dbm cfg using NUMDB 24" command.
3. Log on to the installation server as the root user.
4. Change to the /install_home/ioc16/bin directory.
5. Run the ./ioc-env.sh command.
6. Run the ./iop.mdl.std.install.sh -p topology_password command. The topology_password is the one

specified when IBM Intelligent Operations Center was installed or was subsequently modified. If not
specified, topology_password will default to ibmioc16. A menu of install steps is displayed.

7. Select an option from the menu.

Table 22. Semantic model server installation options

Selection Installation Phase Step Description Average run time

1 Precheck Validate installation media checksums 8 minutes

2 Prepare Copy templates to the topology directory 1 minute

3 Prepare Parameterize all topologies 1 minute

4 Prepare Encrypt all topologies 1 minute

5 Install Install semantic model server application 2 hours 10 minutes

8. Continue from step 6 selecting installation steps in order. Do not select the next step until the
previous installation step has completed. The installation step can also be specified on the command.
For example: ./iop.mdl.std.install.sh -p topology_password 1.

Results

Installation progress is displayed and written to logs located in the /install_home/ioc16/log directory on
the installation server.

Installing the optional semantic model server in a high availability environment
The optional IBM Intelligent Operations Center semantic model server is installed in a high availability
environment using a script.

Procedure
1. Log on to data server 1 as the root user.
2. Run the su - db2inst1 -c "db2 update dbm cfg using NUMDB 24" command.
3. Log on to the installation server as the root user.
4. Change to the /install_home/ioc16/bin directory.
5. Run the ./ioc-env.sh command.
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6. Run the ./iop.mdl.ha.install.sh -p topology_password command. The topology_password is the one
specified when IBM Intelligent Operations Center was installed or was subsequently modified. If not
specified, topology_password will default to ibmioc16. A menu of install steps is displayed.

7. Select an option from the menu.

Table 23. Semantic model server installation options

Selection Installation Phase Step Description Average run time

1 Precheck Validate installation media checksums 8 minutes

2 Prepare Copy templates to the topology directory 1 minute

3 Prepare Parameterize all topologies 1 minute

4 Prepare Encrypt all topologies 1 minute

5 Install Install semantic model server application 2 hours 10 minutes

8. Continue from step 6 selecting installation steps in order. Do not select the next step until the
previous installation step has completed. The installation step can also be specified on the command.
For example: ./iop.mdl.ha.install.sh -p topology_password 1.

Results

Installation progress is displayed and written to logs located in the /install_home/ioc16/log directory on
the installation server.

Configuring the Jazz team server
The IBM Intelligent Operations Center semantic model services is installed on a Jazz™ team server. The
Jazz team server needs to be configured before the IBM Intelligent Operations Center semantic model
services are installed.

About this task

The IBM Intelligent Operations Center architecture needs to be installed before configuring the Jazz team
server.

Procedure
1. In a web browser go to http://sms_host:82/jts/setup where sms_host is the fully qualified host

name of the semantic model server.
2. Log on with the user ID iicsystemuser and password passw0rd.
3. Click Next.
4. On the Configure Public URI page, provide a Public URI Root value in the form

https://sms_host:9448/jts and select I understand that once the Public URI is set, it cannot
be modified. Click Next.

5. Click Test Connection. A message should be displayed that the configuration test was successful.
6. Click Next to save the settings and continue.
7. Configure the database on the Configure Database page.

a. Select DB2 for Database Vendor.
b. Select JDBC for Connection Type.
c. Enter the DB2 database password defined as the DEFAULT.PWD.DB2 property in the topology

properties file for JDBC Password. Ignore the displayed password message.
d. For JDBC Location enter //db_host:50001/JTS:user=db2inst1;password={password}; where

db_host is the host name of the data server. The {password} string must be entered as shown. Do
not substitute with a password value.
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e. Click Test Connection. If an error occurs, check and correct any entries. If the entries are correct,
make sure the database services are started on the data server using the platform control tool.

f. After a message is displayed that no Jazz tables are present in the database, click Create Tables.
Processing will take several minutes to complete.

g. Click Next.
8. On the Enable E-mail Notification page set the value to Disabled and click Next.

9. The Register Applications page should display "No new applications detected." Click Next.
10. Select LDAP for the User Registry Type in Step 1 on the Setup User Registry page.
11. In Step 2 configure LDAP for the Jazz Team Server registry.

a. Enter ldap://db_host:389 for LDAP Registry Location where db_host is the fully qualified host
name of the data server in a standard environment or data server 1 in a high availability
environment.

b. Enter OU=USERS,OU=SWG,O=IBM,C=US for Base User DN. If the LDAP suffix parameters were
changed from the default values, the values for SWG, IBM, and US must match what was
configured in the topology properties file.

c. Enter userId=uid,name=cn,emailAddress=mail for User Property Names Mapping.
d. Enter OU=GROUPS,OU=SWG,O=IBM,C=US for Base Group DN. If the LDAP suffix parameters were

changed from the default values, the values for SWG, IBM, and US must match what was
configured in the topology properties file.

e. For Jazz to LDAP Group Mapping make sure the value is set to JazzAdmins=JazzAdmins,
JazzUsers=JazzUsers, JazzDWAdmins=JazzDWAdmins, JazzProjectAdmins=JazzProjectAdmins,
JazzGuests=JazzGuests.

f. Enter cn for Group Name Property.
g. Enter cn for Group Member Property.

12. Click Test Connection. If a warning message is displayed, click show details. If the warning is about
the mail property you can ignore the message.

13. For Client Access License Type select IBM Integrated Information Core - IIC Model Server.
14. Click Next.
15. For Configure Data Warehouse select the I do not wish to configure the data warehouse at this

time checkbox.
16. Click Finish on the Summary page.

Results

The Jazz team server is operational.
Related concepts:
“LDAP suffix” on page 55
The LDAP suffix information used in IBM Intelligent Operations Center is defined in the topology
properties file.

Installing semantic model services
The semantic model services and a sample application are provided with IBM Intelligent Operations
Center.

About this task

Configuration of the Jazz Team Server on the semantic model server is required before using the semantic
model services.
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Procedure
1. In a web browser go to http://sms_host:82/jts/admin where sms_host is the fully-qualified host

name of the semantic model server.
2. On the Server Administration page, click Server > Configuration > Register Applications.
3. Click Add on the Registered Applications page.
4. Add the Model Server application on the Add Application page.

a. Enter Model Server for Application Name.
b. Enter http://sms_host:82/modelserver/scr, where sms_host is the fully qualified host name of the

semantic model server, for Discovery URL.
c. Enter a value of your choice for Consumer Secret This value will be used to provide access to the

application. The value should be treated with the same security as a password.
d. Enter iicsystemuser for Functional ID

The Application Type will change to Model Server.
5. If there are no errors, click Finish.

Verifying semantic model services configuration
A semantic model services sample application is provided with IBM Intelligent Operations Center and
can be used to verify the correct installation and configuration of the semantic model services.

Procedure
1. Prepare the sample model files.

a. On the installation server find the iic15_2_stagebuildtoserver.xx.jar file in the install_media
directory.

b. Expand the iic15_2_stagebuildtoserver.xx.jar file into a directory of your choice. In the rest of
these steps this directory is referred to as model_home.

2. Install the sample model.
a. In a web browser on the server where model_home is located, go to http://sms_host:82/iic/

console where sms_host is the fully-qualified host name of the semantic model server.
b. Log on as the iicsystemuser user with passw0rd as the password.
c. Click Model Manager > Ontologies > Browse.
d. Navigate to the install_media/ioc/image/IIC/install/modelServices/post_install/ directory.
e. Open the rsm.owl file.
f. Click Load. The file will be loaded.
g. Click Model Manager > Ontologies > Browse.
h. Navigate to the install_media/ioc/image/IIC/install/modelServices/post_install/ directory.
i. Open the modelServer.owl file.
j. Click Load. The file will be loaded.
k. Click Model Manager > Ontologies > Browse.
l. Navigate to the install_media/ioc/image/IIC/install/ktpRuntimeServices/post_install/

directory.
m. Open the kpi.owl file.
n. Click Load. The file will be loaded.
o. Click Model Manager > Load > Browse

p. Navigate to the install_media/ioc/image/IIC/samples/rdf/rsm/ directory.
q. Open the IBMOilDownstreamSampleRDF.xml file.
r. Click Load. The file will be loaded.
s. Click Model Manager > Load > Browse
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t. Navigate to the install_media/ioc/image/IIC/samples/rdf/rsm/ directory.
u. Open the IBMOilUpstreamSampleRDF.xml file.
v. Click Load. The file will be loaded.
w. Click Model Manager > Load > Browse

x. Navigate to the install_media/ioc/image/IIC/samples/rdf/rsm/ directory.
y. Open the IBMOilDownstreamSampleReferenceRDF.xml file.
z. Click Load. The file will be loaded.
aa. Click Model Manager > Load > Browse

ab. Navigate to the install_media/ioc/image/IIC/samples/rdf/rsm/ directory.
ac. Open the IBMOilUpstreamSampleReferenceRDF.xml file.
ad. Click Load. The file will be loaded.

3. Verify that the sample model is correctly installed.
a. Click Model Manager > Query > Query. A predefined query will run. An XML structure will be

displayed with the query results. The top level tag should be spargl and have secondary tags head
and results.

b. Click Model Explorer and make sure you can browse the model.
4. Use the model to verify the installation of model manager.

a. In a web browser on the semantic model server, go to http://sms_host:82/iic/ibmoil where
sms_host is the fully-qualified host name of the semantic model server.

b. Click IBM Oil Company > Variables. Web service URLs are displayed.

Results

The semantic model services and IBMOil sample model are installed.

Improving semantic model services performance
Configure the semantic model services provided by IBM Intelligent Operations Center to improve
performance when running queries against models.

Procedure
1. In a web browser go to http://sms_host:82/iic/console where sms_host is the fully-qualified host

name of the semantic model server.
2. Add the property values in Table 24 to the OPCWEBSERVICE category.

Table 24. OPCWEBSERVICE properties

Property Value

cache.browse.timetolive.second 3600

cache.timetolive.second 2592000

cache.wait.second.after.create.action 1

3. Update or add the following properties and values in Table 25 on page 83 in the RSM category.
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Table 25. RSM properties

Property Value

mvmViewPath.0 http://iec.ch/TC57/CIMgeneric# ISA95_Enterprise##http://iec.ch/TC57/
CIMgeneric# RSM_OrganizationalEntity.ManagesAspectOf_PhysicalEntity
##iec.ch/TC57/CIMgeneric# ISA95_Site##http://iec.ch/TC57/CIMgeneric#
RSM_PhysicalEntity.contains_PhysicalEntity##http:// iec.ch/TC57/CIMgeneric#
ISA95_Area##http://iec.ch/TC57/CIMgeneric#
RSM_PhysicalEntity.contains_PhysicalEntity##http:// iec.ch/TC57/CIMgeneric#
ISA95_ProductionUnit##http:// iec.ch/TC57/CIMgeneric#
RSM_PhysicalEntity.ManagedBy_OrganizationalEntity##http://
iec.ch/TC57/CIMgeneric# RSM_OrganizationalEntity##http://
iec.ch/TC57/CIMgeneric# RSM_OrganizationalEntity.has_measurement##http://
iec.ch/TC57/CIM-generic#RSM_Measurement##http:// iec.ch/TC57/
CIMgeneric# RSM_Measurement.HasA_MeasurementValue##http://
iec.ch/TC57/CIM-generic#RSM_MeasurementValue

mvmViewPath.1 http://iec.ch/TC57/CIMgeneric# ISA95_Enterprise##http://iec.ch/TC57/
CIMgeneric# RSM_OrganizationalEntity.ManagesAspectOf_PhysicalEntity
##iec.ch/TC57/CIMgeneric# ISA95_Area##http://iec.ch/TC57/CIMgeneric#
RSM_PhysicalEntity.contains_PhysicalEntity##http:// iec.ch/TC57/CIMgeneric#
ISA95_ProductionUnit##http://iec.ch/TC57/CIMgeneric#
ISA95_WorkCenter.Contains_Equipment##http:// iec.ch/TC57/CIMgeneric#
RSM_WorkEquipment##http:// iec.ch/TC57/CIMgeneric#
RSM_PhysicalEntity.has_measurement##http:// iec.ch/TC57/CIM-
generic#RSM_Measurement##http:// iec.ch/TC57/CIMgeneric#
RSM_Measurement.HasA_MeasurementValue##http:// iec.ch/TC57/CIM-
generic#RSM_MeasurementValue

mvmDownLevelPreRequest 3

mvmCacheProperty.0 cim:RSM_IdentifiedObject.name

mvmMaxQueryURI 500

mvmMaxSparqlEntry 4000

4. Click Publish. The new and modified properties will be saved.
5. Restart the semantic model services using the platform control tool.
6. In a web browser go to http://sms_host:82/iic/console where sms_host is the fully-qualified host

name of the semantic model server.
7. Make any solution or application-specific changes as needed. If changes are required, the changes will

be identified in the product or solution documentation.

Installing tools provided with the solution
Toolkits and development tools are included with the IBM Intelligent Operations Center. These are used
when customizing IBM Intelligent Operations Center.

With the exception of Rational Application Developer, these are provided on the IBM Intelligent
Operations Center Developer's Toolkit DVD or image. Rational Application Developer is included with
IBM Intelligent Operations Center on separate DVDs or images.

Lotus Sametime Client

For information on installing and using the Lotus Sametime Client , see the Lotus Domino and Lotus
Notes product documentation.
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WebSphere Message Broker Toolkit

For information on installing and using the WebSphere Message Broker Toolkit, see the WebSphere
Message Broker product documentation.

IBM Business Monitor Development Toolkit

For information on installing and using the IBM Business Monitor Development Toolkit, see the IBM
Business Monitor product documentation.

Rational Application Developer

Rational Application Developer is only to be used with the IBM Business Monitor Development Toolkit to
create KPI models.

For information on installing and using Rational Application Developer, see the Rational Application
Developer product documentation.
Related concepts:
“Creating and integrating KPIs” on page 156
Key performance indicator (KPI) models can be created and modified using a business monitoring
development toolkit and the Key Performance Indicators configuration tool.
Related information:

Lotus Domino and Lotus Notes product documentation

WebSphere Message Broker product documentation

IBM Business Monitor product documentation

Rational Application Developer product documentation

Deleting sample users
IBM Intelligent Operations Center is shipped with sample users. For security reasons these users should
be deleted after IBM Intelligent Operations Center is installed in a production environment.

About this task

To delete the predefined users, complete the following steps:

Procedure
1. On the application server, sign into WebSphere Portal.
2. On the Administration portal, click Access > Users and Groups > All Authenticated Portal Users.
3. Click the delete icon for the following users:

v tdelorne
v scollins
v akelly
v ballen

Important: Do not delete the following required users. If you delete them, IBM Intelligent Operations
Center will not operate properly.
v admin
v wpsadmin
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v isimsystem
v ITIM Manager
v appcenteradmin
v wpsbind
v notesadmin

Related reference:
“Sample users” on page 91
During the deployment of IBM Intelligent Operations Center, sample users are created.

Removing sample data
IBM Intelligent Operations Center supplies sample data by default. For example, sample KPIs or sample
monitor models might be supplied. The sample KPIs are designed to provide guidance for implementing
different types of KPI with the IBM Business Monitor Development Toolkit. Sample monitor models are
provided for water, transportation, and public safety. You can remove the sample data if required, either
by using the solution interface or by using DB2 commands.

Removing sample KPIs by using the solution interface
About this task

You can delete the following sample KPIs:
v Public Safety
v Transportation
v Water

Procedure
1. Log on to IBM Intelligent Operations Center as wpsadmin.
2. In the Solution Administration view, click Key Performance Indicators.
3. Right-click on the sample KPI that you want to remove, and then select Remove.
4. Click Save.

Removing sample KPIs by using DB2 commands
About this task

You can delete all of the sample KPIs by using DB2 commands.

Procedure
1. Log on to the IBM Intelligent Operations Center data server as wpsadmin.
2. At the command prompt, enter the following commands:

su db2inst2
db2 connect to IOCDB
db2 "delete from IOC.KPI_Hierarchy WHERE MODELID like ’ioc_sample_%’"

Related concepts:
“Sample KPIs” on page 179
Sample KPIs are provided with the IBM Intelligent Operations Center. The sample KPIs are designed to
provide guidance for implementing different types of KPI with the IBM Business Monitor Development
Toolkit. Sample monitor models are provided for water, transportation, and public safety.
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Removing the sample monitor models
About this task

Use the following procedure to delete sample monitor models in IBM Intelligent Operations Center. You
can delete the following sample monitor models:
v ioc_sample_public_safety_model
v ioc_sample_transportation_model
v ioc_sample_water_model

Procedure
1. Click Applications > Monitor Models.
2. Click the version for the sample monitor model that you want to delete, for example,

ioc_sample_public_safety_model.
3. Click Manager Schema.
4. Click Run Delete Schema Script, and then click OK.
5. Click Applications > Monitor Models.
6. Select the check box for the model that you want to delete, for example

ioc_sample_public_safety_model, and then click Stop.
7. Click Applications > Application Types > Websphere enterprise applications.
8. Select the model_to_deleteApplication.ear check box

where: model_to_delete is the model that you want to delete, for example,
ioc_sample_public_safety_modelApplication.ear.

9. Click Uninstall, and then save your changes.

What to do next

For further details, see Sample KPIs in the IBM Intelligent Operations Center product documentation.

Removing installation files from the production system
While installing IBM Intelligent Operations Center, the installation service configuration, installation
media, and log files are written to the servers. After the installation completes and the installation has
been verified, files that are only used in the installation process can be removed from the production
system servers.

The following can be archived and removed from all servers:
v The directory defined by the Unix.image.basedir.remote property in the topology properties file. The

default location is /installMedia/ioc/image.
v The directory defined by the Unix.script.basedir.remote property in the topology properties file. The

default location is /installMedia/ioc/script.

The following can be archived and deleted from the installation server, which is the analytics server in a
standard environment and analytics server 1 in a high availability environment.
v The directory defined by the image.basedir.local property in the custom.properties file. The default

location is /distributionMedia.
v The directory defined by the image.tempdir.local property in the custom.properties file. The default

location is /tmp/ioc/images.
v The directory defined by the backup.local property in the custom.properties file. The default location

is /tmp/ioc/backup.
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Since the topology properties file on the installation server contains passwords in clear text, this file
should be stored in a secure location.

Verifying the installation
After installing IBM Intelligent Operations Center , verify that the product has been correctly installed.
Verification ensures all components are started and operating as expected.

About this task

Two verification procedures are provided. The quick verification procedure can be used immediately after
installing IBM Intelligent Operations Center and any time a quick verification of the overall system is
desired. The full verification procedure take significantly more time, but should be done before IBM
Intelligent Operations Center is considered fully-operational.

Procedure

Quick verification
1. Check that you can access the IBM Intelligent Operations Center.

a. In a browser go to https://web_hostname/wps/portal where web_hostname is the hostname of the
web server.

b. Log on as a IBM Intelligent Operations Center administrator, for example, wpsadmin. The
wpsadmin password is defined in the topology property file PORTAL.ADMIN.UID.PWD property.

The Supervisor: Operations page will be displayed.
2. Run all the tests in the system verification check tool.
3. Check that all tests have run successfully.
4. Use the platform control tool to start any components that need to be started.

Full verification
5. Use the platform control tool to stop all components.
6. Check that all components have stopped successfully by reviewing the displayed messages.
7. Shut down the Linux operating system on all servers.
8. Power-down and power-up all runtime servers or reboot all servers.
9. Use the platform control tool to start all components.

10. Use the platform control tool to query the status of all components.
11. Check that you can access the IBM Intelligent Operations Center.

a. In a browser go to https://web_hostname/wps/portal where web_hostname is the hostname of the
web server.

b. Log on as a IBM Intelligent Operations Center administrator, for example, wpsadmin. The
wpsadmin password is defined in the topology property file PORTAL.ADMIN.UID.PWD property.

The Supervisor: Operations page will be displayed.
12. Run all the tests in the system verification check tool.
13. Check that all tests have run successfully.

What to do next

If any errors are noted, resolve the errors and rerun these steps.
Related concepts:
“Components” on page 5
At a high level, the structure of IBM Intelligent Operations Center can be divided into major components,
subsystems, and services.
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“Viewing product version details” on page 187
In the Solution Administration view, you can view details of the version of IBM Intelligent Operations
Center and the integrated IBM Smarter Cities Software Solutions that you installed. You can also view
details of any updates that you applied since installation.
Related tasks:
“How to use the system verification check tool” on page 209
The system verification check tool is used to determine the operational status of services comprising the
IBM Intelligent Operations Center system.
“Querying the status of the components in a standard environment” on page 197
The platform control tool can be used to determine the status of the components running on IBM
Intelligent Operations Center standard environment servers.
“Querying the status of the components in a high availability environment” on page 207
The platform control tool can be used to determine the status of the components running on IBM
Intelligent Operations Center high availability environment servers.
“Starting the components in a standard environment” on page 191
The platform control tool can be used to start the components running on IBM Intelligent Operations
Center standard environment servers.
“Starting the components in a high availability environment” on page 199
The platform control tool can be used to start the components running on IBM Intelligent Operations
Center high availability environment servers.
“Stopping the components in a standard environment” on page 194
The platform control tool can be used to stop components running on IBM Intelligent Operations Center
standard environment servers.
“Stopping the components in a high availability environment” on page 203
The platform control tool can be used to stop components running on IBM Intelligent Operations Center
high availability servers.

88 IBM Intelligent Operations Center: IBM Intelligent Operations Center Product Documentation



Chapter 3. Securing the solution

Security is important within the IBM Intelligent Operations Center because the solution is central to
essential operations. To ensure security, it is important that you are aware of the default settings and that
you manage users of the solution to give all users the correct level of access.

Default passwords

Your first task in securing the solution is to ensure that all default passwords are changed. For more
information about the default passwords, see the link at the end of the topic.

Secure connection

The IBM Intelligent Operations Center is HTTPS enabled by default. You can change HTTPS settings for
the business monitoring service that processes key performance indicators (KPIs).

Any change to the HTTPS setting for an individual service must be accompanied by an update to the
corresponding port setting. For more details on changing the settings in the system properties, see the
link at the end of the topic.

User authentication

User authentication is associated with authorization rights that give the user access to the appropriate
features. IBM Intelligent Operations Center supports integration to the existing security infrastructure for
single sign-on.

IBM Intelligent Operations Center user permissions are managed through WebSphere Portal users and
groups. WebSphere Portal uses the Lightweight Directory Access Protocol (LDAP) database that is
provided by the Tivoli Directory Server, which runs on the data server.

The security system that is provided with the IBM Intelligent Operations Center can accommodate many
user groups, roles, and permissions. Accommodating many user groups, roles, and permissions can lead
to a security regime that is difficult to manage. It is recommended that administrators restrict the number
of groups and permissions.

User roles and permissions

Membership of a role-based user group provides a way of controlling access to the IBM Intelligent
Operations Center. The users in a group have access only to the features of the solution that correspond
to their role. Being a member of a role-based user group also helps users to focus on the appropriate
tasks. The standard roles are CityWideSupervisor, CityWideOperator, CityWideExecutive, and
CityWideAdmin.

To add a user to IBM Intelligent Operations Center:
1. Choose a group that is appropriate to the role of the user in the organization, and make the user a

member of that group.
2. Complete a profile for the user and include at least the user ID, name, and password.

Data sources and permissions

Access to a feature in IBM Intelligent Operations Center does not mean that a user can view all the data
sources that it contains. To ensure that users see only the appropriate data, access is determined during
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the configuration of individual data sources. An administrator can assign access to a data source to both
user groups, and to individual users.

WebSphere Portal Enable

WebSphere Portal Enable provides a platform that can be scaled to accommodate the required set of
users. It also provides role-based access that can be adjusted to reflect the required organization structure.
You can view, create, and delete users or user groups with the Manage Users and Groups portlet. You
can also change group memberships. For more information about this portlet, see the link at the end of
the topic to the WebSphere Portal product documentation.
Related concepts:
“Password information for a standard environment” on page 56
Passwords for various user IDs used in the IBM Intelligent Operations Center solution are defined in the
topology properties file. For security reasons the default passwords shipped with IBM Intelligent
Operations Center should be changed.
Related tasks:
“Configuring system properties” on page 189
View, create, modify, and delete system properties in the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent Operations Center.
Related information:

IBM WebSphere Portal 8 product documentation

User roles and access
IBM Intelligent Operations Center implements security by limiting access to features based on user roles.

To use a specific feature of IBM Intelligent Operations Center, a user must be a member of the user role
group that provides the required access to that feature. A user is made a member of a user role group by
an administrator. The following table shows how real-life roles might map to the user role groups with
login access levels in IBM Intelligent Operations Center.

Table 26. Job roles and IBM Intelligent Operations Center user role groups

Job role Responsibilities User role group

Executive v Reviews status for the executive's area of
responsibility by monitoring key performance
indicators (KPIs)

v Looks for trends or groupings of where things are
happening to make strategic decisions on how to
improve situations

v Communicates with staff and constituents about
what insights they have derived and how they can
address problems

CityWideExecutive

Supervisor or manager v Reviews status for the supervisor's or manager's area
of responsibility and drills into details for areas of
concern

v Responds to notifications when status changes
negatively

v Supervises day-to-day operations and directs work
of staff

v Decides on short-term corrective measures

CityWideSupervisor
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Table 26. Job roles and IBM Intelligent Operations Center user role groups (continued)

Job role Responsibilities User role group

Operator v Monitors incoming data updates and views details

v Responds to requests to address a situation

v Keeps information about an event or item that is in
progress current by updating information

v Looks for trends or areas of concern where
correctional short-term actions are required

CityWideOperator

Solution administrator Configures IBM Intelligent Operations Center
components, including data sources, filter options,
maps, key performance indicators, and standard
operating procedures.

CityWideAdmin

System administrator Administers all aspects of users including defining
groups, assigning permissions to groups, and assigning
users to groups. Provides users with the correct access
level. Access level is assigned based on group
membership. A system administrator can also configure
all the IBM Intelligent Operations Center components,
similar to a solution administrator.

wpsadmins

Before customizing roles and defining users for your organization, familiarize yourself with the IBM
Intelligent Operations Center security system.

Sample users
During the deployment of IBM Intelligent Operations Center, sample users are created.

Generic sample users are defined with user role groups and corresponding access permissions. These
sample users are defined as examples only, and are listed in the following table. Other users are required
for administration of the solution. For a complete list of users, see the link, "Deleting sample users", at the
end of the topic.

Table 27. Users defined in the IBM Intelligent Operations Center

User ID User role group

Sample users

tdelorne CityWideExecutive

scollins CityWideSupervisor

akelly CityWideOperator

ballen CityWideAdmin

Required user

wpsadmin wpsadmins

When you are ready to define users for your organization, delete only the sample users. You must not
delete the wpsadmin user. The wpsadmin user is essential for administration tasks that are associated with
IBM Intelligent Operations Center.

Important: Replace the default password of the wpsadmin user with a new password. For information
about updating portal administrator user IDs and passwords, see the WebSphere Portal documentation.
Related concepts:
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“Password information for a standard environment” on page 56
Passwords for various user IDs used in the IBM Intelligent Operations Center solution are defined in the
topology properties file. For security reasons the default passwords shipped with IBM Intelligent
Operations Center should be changed.
Related tasks:
“Deleting sample users” on page 84
IBM Intelligent Operations Center is shipped with sample users. For security reasons these users should
be deleted after IBM Intelligent Operations Center is installed in a production environment.
Related information:

IBM WebSphere Portal 8 product documentation

User role groups and authorization permissions
In IBM Intelligent Operations Center, a set of permissions for accessing views and the features that they
contain is associated with each user role group.

An administrator assigns a role to a user by making the user a member of the corresponding user role
group. Each user is assigned membership of one or more user role groups.

The following table lists the permissions for each user role group that is supplied with IBM Intelligent
Operations Center. For each user role group, an authorization permission is granted for each sample view
that is provided in IBM Intelligent Operations Center. A user who is authorized to access a view is
authorized to access all the features that the view contains. However, if a view contains a filter panel, in
the panes that contain data sources, a user can view only the data sources for which they have been
assigned either read, or read and write access. An administrator can assign a user access to a data source
either as an individual, or by making the user a member of a group that has access to the data source.

Table 28. IBM Intelligent Operations Center sample views and associated user role group permissions
Sample view CityWideExecutive CityWideSupervisor CityWideOperator CityWideAdmin wpsadmins

Supervisor:
Operations

None User permission None Solution administrator
permission

System administrator
permission

Supervisor: Status None User permission None Solution administrator
permission

System administrator
permission

Operator:
Operations

None None User permission Solution administrator
permission

System administrator
permission

Executive:
Operations

User permission None None Solution administrator
permission

System administrator
permission

Executive: Status User permission None None Solution administrator
permission

System administrator
permission

Portal
Administration

None None None None System administrator
permission

Solution
Administration,
System
Administration

None None None None System administrator
permission

Solution
Administration,
Configuration Tools

None None None Solution administrator
permission

System administrator
permission

IBM Intelligent Operations Center authorization permissions are assigned based on Lightweight Directory
Access Protocol (LDAP) groups. The following definitions apply to the authorization permissions:
v User permission is the authority that is granted to a user that gives the user access to view and work

with features.
v Administrator permission is the authority that is granted to an administrator that gives the

administrator access to do the following tasks:
– Configure features
– Create, modify, or delete users and user groups

Related tasks:
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“Securing your data source” on page 111
For your data source, assign users or groups the appropriate access to data and authorization privileges.

Adding a user
You can add users to IBM Intelligent Operations Center.

Procedure
1. Log on to the solution portal as a portal administrator. For example, wpsadmin, or another user who is

a member of the wpsadmins portal group.
2. On the main navigation bar at the top of the view, click Administration > Portal Administration.
3. On the sidebar menu, click Access > Users and Groups.
4. Click All Portal User Groups. The list of role groups for IBM Intelligent Operations Center, and any

other IBM Smarter Cities Software Solutions that are installed in this environment, are displayed.
5. Scroll through the list to find the user role group that you want to assign to your users.
6. Select a role group for IBM Intelligent Operations Center. The IDs of the existing group members are

listed.
7. Add a user by using one of the following steps:

v To add a new user, click New User and complete the required Profile Management fields.

Note: To save time, you can duplicate group assignments for a new user that is based on an
existing user. Select the new user, and then click the Duplicate group assignments icon. Select the
existing user from whom you want to duplicate group membership.

v To add an existing user or group of users, click Add Member, and select one or more users or
groups from the list.

8. Click OK.

Results

A message confirms if the submission is successful. If you added a new user, a user profile is created and
displayed on the group list. The new user is authorized to access IBM Intelligent Operations Center
according to the permissions that are assigned to the selected role group.
Related tasks:
“Viewing or editing your user profile” on page 169
You can view and edit the information in your solution user profile. Edit your user profile to set your
time zone, language preference, and notification settings. You can also reset your password and modify
your personal details.

Adding a group
You can add groups to IBM Intelligent Operations Center.

Procedure
1. Log on to the solution portal as a portal administrator. For example, wpsadmin, or another user who is

a member of the wpsadmins portal group.
2. On the main navigation bar at the top of the view, click Administration > Portal Administration.
3. On the sidebar menu, click Access > Users and Groups.
4. To add a new group, click New Group, and enter a name for the user group.
5. Click OK.
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Results

A message confirms if the submission is successful. Click All Portal User Groups to see the new group
displayed in the list.

What to do next
v Add the group to the WebSphere Application Server Network Deployment junction ACL.
v Set authorization permissions for the group. For information about assigning access to pages, see the

IBM WebSphere Portal 7 product documentation.
Related information:

IBM WebSphere Portal 8 product documentation

Viewing or modifying group membership
View or modify group membership to manage the access permissions of users in IBM Intelligent
Operations Center.

About this task

Select the group that corresponds to the role for which you want to view or change membership.
Membership of a role group gives users access to the parts of the solution that are appropriate to that
role.

Hover over an icon to view hover help that indicates the purpose of the icon.

Procedure
1. Log on to the solution portal as a portal administrator. For example, wpsadmin, or another user who is

a member of the wpsadmins portal group.
2. On the main navigation bar at the top of the view, click Administration > Portal Administration.
3. On the sidebar menu, click Access > Users and Groups.
4. Click All Portal User Groups. The list of role groups for IBM Intelligent Operations Center, and any

other IBM Smarter Cities Software Solutions that are installed in this environment, are displayed.
5. Select a role group for IBM Intelligent Operations Center. The IDs of the existing group members are

listed.
6. You can do the following actions in relation to group membership:

v View membership of other groups by clicking the View membership icon for the user ID.
v Add a user or users to the group by clicking Add member, and then selecting the user or users to

be added.
v Remove a user from the group by clicking the Remove icon for the user ID.

Viewing or editing a user profile
View or edit the profile of a user to set or reset any of the user profile attributes, including the password.
You cannot change the user ID.

About this task

Select the user from the authenticated portal users list to open the user profile and change profile details.
Each user can also change the user's own profile.

Hover over an icon to view hover help that indicates the purpose of the icon.
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Procedure
1. Log on to the solution portal as a portal administrator. For example, wpsadmin, or another user who is

a member of the wpsadmins portal group.
2. On the main navigation bar at the top of the view, click Administration > Portal Administration.
3. On the sidebar menu, click Access > Users and Groups.
4. Click All Portal User Groups. The list of role groups for IBM Intelligent Operations Center, and any

other IBM Smarter Cities Software Solutions that are installed in this environment, are displayed.
5. For a user ID, click the edit icon to display the user profile attributes.
6. If you want to change the password, enter a new password for New password and Confirm

password.
7. You can enter, edit, or delete information in any of the remaining fields.
8. Click OK to submit the changes that you have made.

Results

The user profile is updated with the changes that you submit.

Note: For a user to see data in a specific time zone, select that time zone in the user profile. When a time
zone is not selected in the user profile, the system uses the WebSphere Portal time zone.
Related tasks:
“Viewing or editing your user profile” on page 169
You can view and edit the information in your solution user profile. Edit your user profile to set your
time zone, language preference, and notification settings. You can also reset your password and modify
your personal details.

Deleting a user or group
You can delete a user or group from IBM Intelligent Operations Center.

About this task

Deleting a user fromIBM Intelligent Operations Center also removes the user's access to other solutions in
IBM Smarter Cities Software Solutions. Deleting a group also removes that group from other solutions.

Hover over an icon to view hover help that indicates the purpose of the icon.

Procedure
1. Log on to the solution portal as a portal administrator. For example, wpsadmin, or another user who is

a member of the wpsadmins portal group.
2. On the main navigation bar at the top of the view, click Administration > Portal Administration.
3. On the sidebar menu, click Access > Users and Groups.
4. Choose one of the following options:

v Click All Portal User Groups to display a list of groups.
v Click All Authenticated Portal Users to display a list of users.

5. Click the Remove icon for the user or group that you want to delete.

Results

The user or group that you delete no longer exists in IBM Smarter Cities Software Solutions. Deleting a
group does not delete members of the group.
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Importing users and groups
You can import users in bulk into IBM Intelligent Operations Center through the portal administration
console.

About this task

The XML file that is required for this task is on the application server: /opt/IBM/WebSphere/
PortalServer/doc/xml-samples/CreateUser.xml. You can modify the XML file to add users to IBM
Intelligent Operations Center.

When you add multiple users, add all the users first, before adding the users to groups. See the example
at the end of the topic.

As an alternative to the following procedure, you can run the xmlaccess.sh script from the command
line. The script is on the application server.

Procedure
1. Add new users and the groups to which they belong to the CreateUser.xml file.
2. Log on to the solution portal as a portal administrator. For example, wpsadmin, or another user who is

a member of the wpsadmins portal group.
3. On the main navigation bar at the top of the view, click Administration > Portal Administration.
4. On the sidebar menu, click Portal Settings > Import XML.
5. Click Browse, and then locate your updated XML file.
6. Click Import.

Results

WebSphere Portal Server automatically creates the associated entries in the directory on the Tivoli
Directory Server.

Example

The following example modifies the XML file to add two users to IBM Intelligent Operations Center, and
to add each user to one role group:
<?xml version="1.0" encoding="UTF-8"?>
<request xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="PortalConfig_8.0.0.xsd" type="update"
create-oids="true>
<portal action="locate">
<user action="update" name="cityuser001" firstname="City"

lastname="user001" password="passw0rd">
<parameter name="preferredLanguage" type="string"

update="set">en_US</parameter>
<parameter name="cn" type="string" update="set">City user001</parameter>
</user>
<user action="update" name="cityuser002" firstname="City"

lastname="user002" password="passw0rd">
<parameter name="preferredLanguage" type="string"

update="set">en_US</parameter>
<parameter name="cn" type="string" update="set">City user002</parameter>
</user>
<group action="update" name="CityWideExecutive">
<member-user update="set" id="cityuser001">
</group>
<group action="update" name="ioc_base_fire">
<member-user update="set" id="cityuser001">
<group action="update" name="CityWideOperator">
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<member-user update="set" id="cityuser002">
</group>
</portal>
</request>

Related concepts:
“Administering the services” on page 187
Use the Administration Consoles to administer the services that are provided by the solution.
Related information:

IBM WebSphere Portal 8 product documentation

Tivoli Directory Server product documentation

Defining standard operating procedure roles
The standard operating procedure component obtains the current authentication credentials to determine
what actions each user is authorized to do. Each user is authorized to do standard operating procedure
actions that are based on the LDAP Roles that the user is assigned to, and must match the distinguished
name (DN) that is used in association with the standard operating procedure objects.

The following table outlines which roles can do what actions in relation to standard operating
procedures.

Table 29. Standard operating procedure actions and required roles

Action Role required

Create a standard operating procedure v Users who are listed in either the SopAdminRoles system property, or in
the SopAuthorRoles system property.

Read a standard operating procedure
definition

v Users who are listed in either the SopAdminRoles system property, or in
the SopAuthorRoles system property.

v Any role that is granted read access either by the creator, or by an
editor of the definition.

Update or delete a standard operating
procedure definition

v Users who are listed in the SopAdminRoles system property.

v Any role that is granted write access either by the creator, or by an
editor of the definition.

Launch an instance of a standard
operating procedure

v Users who are listed in the SopAdminRoles system property.

v Any role that is granted write access in the standard operating
procedure definition, either by the creator or by an editor.

Read the details for an instance of a
standard operating procedure

v Users who are listed in the SopAdminRoles system property.

v Any role that is granted read access in the standard operating
procedure definition, either by the creator or by an editor.

v Any role that is granted read access in the activity definition, either by
the creator or by an editor.

Update or delete an instance of a
standard operating procedure

v Users who are listed in the SopAdminRoles system property.

v Any role that is granted write access in the standard operating
procedure definition, either by the creator or by an editor.

v Any role that is granted write access in the activity definition, either by
the creator or by an editor.
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Table 29. Standard operating procedure actions and required roles (continued)

Action Role required

Read the details for an activity v Users who are listed in the SopAdminRoles system property.

v Any role that is granted read access in the standard operating
procedure definition, either by the creator or by an editor.

v Any role that is granted read access in the activity definition, either by
the creator or by an editor.

Update an activity v Users who are listed in the SopAdminRoles system property.

v Any role that is granted write access in the standard operating
procedure definition, either by the creator or by an editor.

v Any role that is granted write access in the activity definition, either by
the creator or by an editor.

Create references in the library Users who are listed in the following system properties:

v ReferenceLibrarianRoles

v SopAdminRoles

v SopAuthorRoles

Note: Only ReferenceLibrarianRoles users can create shared references.

Edit and delete references in the library v Users who are listed in the ReferenceLibrarianRoles system property.

v Users who are listed in the SopAdminRoles system property and the
SopAuthorRoles system property can edit and delete only references
that they have created.

Related tasks:
“Configuring standard operating procedure definitions” on page 136
When you define a standard operating procedure, you define activities that are included in the standard
operating procedure. You can specify the order in which some or all of the activities in a standard
operating procedure are executed. For example, you can specify that a particular activity is not started
until the previous activity is completed or skipped. You also assign owners and monitors to the standard
operating procedure.
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Chapter 4. Configuring the solution

Configure IBM Intelligent Operations Center in the Solution Administration view.

Configuring a data source
Use the Data Sources tool to configure a data source that supplies data to IBM Intelligent Operations
Center.

You can also update some configuration parameters for a data source that is already in the solution, or
you can delete a data source from the solution.

After you create a data source, use the filter panel tool to assign your data source to a filter pane in the
filter panel. You can group data sources under a category and display them together on a filter pane.
Users can then select the data source in the filter panel in the operations views. The combination of
options that users select in the filter panel determines what data items are displayed on the maps and in
the list.

When you configure a data source, you can assign an icon to represent it. To configure a filter pane, select
a color that is used in map markers that represent all the data sources in a data group. A data source is
identifiable on the map by a combination of the icon symbol and the color of the group that the data
source belongs to.

You can configure the following items for a data source:

1. Acquisition method
Select the method for acquiring data from the data source. When you select the method, you are
prompted for the information that is required to connect to that type of data source and acquire
the data. The following acquisition types are supported:
v CSV file
v Database

v Common Alerting Protocol (CAP)
v 1.6.0.1 1.6.0.2 User interface entry, for injecting data items through either the maps, list,

or REST API only

This step is mandatory for the creation of a data source.

2. Basic information
Supply basic information about how your data is to be used by the solution. Give your data
source a name to be used throughout the solution user interface. Give basic instructions about
how the data is processed, for example, how often to check for new data. This step is mandatory
for the creation of a data source.

3. Minimal properties
Map properties from your data source to the minimal set of properties that are required and that
are common to all data sources in the solution. By default, minimal properties are assigned
common labels in the user interface. You can view the minimal properties either on a preview
card, or in a row of the table on the List tab. Set minimal properties to receive the data formats
that you require in relation to time and representation on a map. Choose the geometry format
and how to supply information about position to represent the data item on the map. For
example, representation on the map can be in the form of a single point, multiple points, lines,
multiple lines, or a polygon. This step is mandatory for the creation of a data source.
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4. Key and full properties
Define extra details for individual properties of your data source. A property that is not defined
as either a minimal property, or a key property, is treated as a full property by default. Key
properties are displayed with the minimal properties on a preview card or List tab in the user
interface. Full properties are displayed in a full property window when you request more
information. You can assign a property a label for the user interface. You can provide instructions
about how the data that is associated with a property is processed and presented. This step is
mandatory for the creation of a data source.

5. Security
Assign the appropriate access to data and authorization privileges for your data source to portal
groups or users. For example, to allow a specific user, or a group of users, to view items that
come from your data source, define read-only access.

6. Routing

Assign the routing instructions for processing the data that is received by the solution based on
individual properties in your data source. Data can be routed to the solution as a whole, to key
performance indicators (KPIs), to a selected standard operating procedure, or to a predefined
integration topic.

1.6.0.1 1.6.0.2 You can also route data to a correlation topic.

7. Actions

1.6 1.6.0.1 From the available actions, select a set of allowable actions that can be
performed on the data items that are associated with the data source.

1.6.0.2 You can assign actions to data sources by using the component customization tool that
is in the Solution Administration view. For more information, see the Customizing components
section.

The actions are displayed in the More Actions menu on the preview card for associated data
items.

8. Appearance
To represent the data from your data source on a map, assign an icon to represent point positions
on a map. Assign a color style for geometry formats other than point representation. The color
style is used in association with the geometric format information that you selected with your
minimal properties. You can also use expressions to change the style of appearance that is
assigned to the data source based on individual properties from your data source. To enable data
items to be displayed on a map as required, complete this step by entering information about the
appearance of the items. This assignment depends on the settings for map position and geometry
format that you choose at step 3. Icons are not affected by the shape color setting as icon color is
set by filter panel configuration.

Related concepts:
“Guidelines on preparing data for the solution” on page 146
To view and filter the data that you require on the maps and list in IBM Intelligent Operations Center,
prepare the data in your data source. Then, configure your data source in the Solution Administration
view.
“Data item routing” on page 150
IBM Intelligent Operations Center processes incoming data items to determine how information is
displayed.
“Integrating with data sources” on page 145
A data source is used to exchange information between the IBM Intelligent Operations Center and
external systems.
Related tasks:
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“Customizing components” on page 174
To extend and customize the functionality of your solution, you can create customized components that
you can add to the user interface. You can also replace an existing component with a customized
component. For example, for a particular system component, you can replace an existing preview card
with a new, customized preview card.

Creating a data source
As an administrator, you can use the data sources tool to add and configure a data source.

Before you begin

Ensure that your data source contains data in a format that can be received by the system and that can be
processed and updated as required.

About this task

In the data sources tool, the first four tabs only are mandatory for the creation of a data source. The
remaining tabs are optional for the creation of a data source in the system and can be completed later. If
you do decide to complete your data source configuration later, note the information at the end of step 11
on page 102.

Fields that are marked with an asterisk in the data sources tool are always required. Defaults are
provided by the system for most fields except for a few fields where user input is mandatory.

You can specify translated text options for any field that contains text to be displayed as a label in the
user interface. Enter the default text for the label. Then, enter text for any language you require from the
languages that are supported. The language that is displayed depends on the locale that is selected either
in the user profile, or in the browser. If a language preference is set, the user profile setting overrides the
browser language setting.

If you select the Common Alerting Protocol (CAP) as the format for acquiring data, you can specify
that CAP messages that are received through the data source are displayed either on the geospatial map,
or on the location map. The elements that are defined in the CAP specification are mapped to data source
properties. Some data source options are preselected, and some data source properties are mapped to
CAP elements automatically. You cannot change these automatic settings.

Procedure

For more information about the following steps, see the subsequent topics in the section.
1. To access the data sources configuration tool, click Administration > Solution Administration >

Configuration Tools > Data Sources.
2. To start the data sources tool that guides you through the steps to create a data source, click Create.
3. On the Acquire tab, choose one of the following data source acquisition methods, and enter the

information that is required to connect to the data source.

Upload a CSV file

1.6 1.6.0.1 For the directory path, enter /opt/IBM/ioc/csv. Before you can upload a
CSV file, you must copy the CSV file to the /opt/IBM/ioc/csv directory that is on the
application server.

1.6.0.2 Browse to the location of the CSV file that you want to upload. The CSV file that
you select is copied to the appropriate directory on the application server.
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Connect to a database
Enter either the host name or IP address, port, user ID, password, database name, and
database table.

Common Alerting Protocol (CAP)
To create a data source that receives CAP messages, select the appropriate option to be able
to display the CAP messages either on the geospatial map, or on the location map.

1.6.0.1 1.6.0.2 User interface entry
To create a data source that can be used to inject data items through either the maps, list, or
REST API only, select one of these options. If you select one of these options, all the data
source properties are preassigned. A data source is created that is not connected to an
external source.
v If you want to display injected data items on the geospatial map, select User interface

entry for geospatial maps. The location is contained in a well-known text (WKT) format
string.

v If you want to display injected data items on the location map, select User interface entry
for location maps. An area property is assigned to the data source.

4. Click Next to go to the Basics tab.
5. Supply the basic information that is required for your data source. You must enter a name and a

unique identifier. A description is optional. Accept the defaults, or change the settings in the general
information fields.

6. Click Next to go to the Minimal Properties tab.
7. In each of the minimal property fields, select a property from your data source to assign to the

minimal property that is required by the system. Change the default settings as appropriate for your
data source.

8. Click Next to go to the Key & Full Properties tab.
9. From your data source properties list, select the properties that you want to define as key properties.

Define other property characteristics as appropriate for your data source.
10. Complete the fields in the Property Details box as required, or accept the defaults.
11. Optional: From the remaining tabs, select the fields that you want to change. You can provide input

to fields on the following tabs.
v Security

v Routing

v 1.6 1.6.0.1 Actions

v Appearance

Note: If you do not configure security for your data source, the default is that only you have access
to view the data items. If you select a point geometry format for your data source and you do not
configure appearance, data items from your data source cannot be displayed in the user interface.

1.6.0.2 You can assign actions to data sources by using the component customization tool that is
in the Solution Administration view. For more information, see the Customizing components section.

12. To add your data source to the solution, click OK.

Results

In the administration view, you can see the data source that you added on the list of data sources. This
list is available for data source configuration and for filter panel configuration.
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What to do next

You can update or complete the configuration of a data source later. To enable data items to be displayed
on a map, configure your data source for display on the filter panel in the operations views. Click
Configuration Tools > filter panel. For more information about filter panel configuration options, see the
link at the end of the topic.
Related concepts:
“Integrating with data sources” on page 145
A data source is used to exchange information between the IBM Intelligent Operations Center and
external systems.
“Configuring the filter panel” on page 114
In the Solution Administration view, you can decide how you want to group data sources. Then, for each
group, you can configure a pane that is displayed in the filter panel. The data sources that you select are
listed in the pane.
Related tasks:
“Customizing components” on page 174
To extend and customize the functionality of your solution, you can create customized components that
you can add to the user interface. You can also replace an existing component with a customized
component. For example, for a particular system component, you can replace an existing preview card
with a new, customized preview card.
Related information:

OASIS Common Alerting Protocol Version 1.2

Updating data source configuration
As an administrator you can update the settings for a data source.

About this task

Existing data sources are listed in the side panel of the Data Sources configuration view. You can select a
data source and complete the tabs and fields that are available for update. You cannot edit fields that are
related to the parts of an existing data source that cannot be changed. On the Acquire tab, you can edit
only the source database password for the data receiver when applicable. On the Minimal Properties tab,
the fields that you can edit depend on the version of IBM Intelligent Operations Center that is installed.

On the Key & Full Properties tab, you can edit only the translated values for the labels.

Procedure

For more information about updating data source configuration, see the subsequent topics in the section.
1. Click Administration > Solution Administration > Configuration Tools > Data Sources.
2. Select the data source that you want to change.
3. Select the tab and fields that you want to change. You can provide input to fields on the following

tabs:
v Basics

v Minimal Properties

v Security

v Routing

v 1.6 1.6.0.1 Actions

v Appearance
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1.6.0.2 You can assign actions to data sources by using the component customization tool that is in
the Solution Administration view. For more information, see the Customizing components section.

4. Save your updated data source configuration.

Results

In the administration view, you can access the updated data source on the list of data sources. This list is
available for data source configuration and for filter panel configuration. When the data source is
configured to be displayed on the filter panel, you can access the updated data source on the filter panel
after a browser refresh. For more information about filter panel configuration, see the link at the end of
the topic.
Related concepts:
“Configuring the filter panel” on page 114
In the Solution Administration view, you can decide how you want to group data sources. Then, for each
group, you can configure a pane that is displayed in the filter panel. The data sources that you select are
listed in the pane.

Data source basic settings
Choose settings on the Basics tab to provide the basic input and selections that are appropriate for your
data source.

Depending on the options that you select, only the relevant fields are displayed.

Table 30. Description of the fields on the Basics tab

Field Description

Data source label A name for your data source. This name is the default
label that is attached to the data source throughout the
user interface.

Data source unique text identifier A text string that is unique to this data source. This
string can be the same as the string that you entered in
the Data source label field.

Description A description of your data source. Completion of this
field is optional.

Data for analysis Indicates whether the data is to be used in an analysis
process. Refer to the documentation that is specific to
your solution for more detail.
Note: This option applies to IBM Intelligent City
Planning and Operations.

1.6.0.1 1.6.0.2 Data for boundary Select Yes for this option if you want the data source to
be available as a named area type. The value of this
option is preselected to No for either Common Alerting
Protocol (CAP) data sources, or for location map data
sources.

If you want to import named area data from an SQL file,
you must insert the named area data into the SQL file
before you create the data source. A named area type
data source is not polled for updated data after the data
source is created. For more information, see the Defining
named areas by using SQL topic.

Asset or resource data Indicates whether the data is to be used in an asset or
resource-related process. Refer to the documentation that
is specific to your solution for more detail.
Note: This option applies to IBM Intelligent City
Planning and Operations.
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Table 30. Description of the fields on the Basics tab (continued)

Field Description

1.6.0.1 1.6.0.2 Data for correlation Indicates whether you want to use data from the data
source for correlation.

1.6.0.1 1.6.0.2 Report model Indicates whether you want the data source to be
included in the Cognos Framework report model.

Polling interval The polling interval of your data source which ensures
that you receive updates. This setting indicates how
often the system polls the database for new data. Set a
value of 0 to take initial details and never poll for
updates.

The polling interval value is not used for CAP data
sources.

1.6.0.1 1.6.0.2 The polling interval value is not
used for user interface entry data sources.

Archive interval The archive interval of your data source that indicates
the period that the data is stored in the system. At the
end of this period a database script is run to remove and
back up the data.

Related tasks:

1.6.0.1 1.6.0.2 “Defining named areas by using SQL” on page 149
You might want to define a named area type data source that has many named areas. Instead of drawing
each named area polygon individually on the map, you can define the named area polygons by using an
SQL table. Then, create a data source that connects to a database to acquire the named area data from the
SQL table.

Data source minimal property settings
Assign properties from your data source to each minimal property and choose the settings that are
appropriate for your data.

Depending on the options that you selected in previous tabs, you might be able to edit only some of the
properties, and some values might be either predefined, or preselected.

1.6.0.1 1.6.0.2 For user interface entry data sources, all the properties are preassigned.

Table 31. Description of the fields on the Minimal Properties tab

Field Description

Name The property to supply the name of the data item for
display in the user interface. If you do not select a
property, the system generates a name.

For Common Alerting Protocol (CAP) data sources,
the property is mapped to the headline CAP element.
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Table 31. Description of the fields on the Minimal Properties tab (continued)

Field Description

Area name The property to supply the area name, if you want a
data item to be displayed on a location map. When you
select a property in this field, your data items are not
displayed on the geospatial map.

For CAP for location maps only, the property is
mapped to the areaId value, which is in the CAP
geocode element that is within the area element.

1.6.0.2 Area mapping Area mapping determines whether incoming data items
are contained within the boundary of any data item from
one of the named area type data sources. Assign one or
more data sources from data sources that are available as
named area types.

Start date and time, End date and time The properties that supply the values that indicate the
start and end times for a data item. The start date and
time value can be used to filter data items in accordance
with the filter panel.

You can select time stamp or string format. The system
default is to expect time and date in the standard
relational database time stamp format. If you set the field
type to String, you must supply the string format on the
Timezone & Other tab. For more information about
setting these formats, see the Time format and Date
format field descriptions. For some data source types, the
Timestamp option is preselected for the value of Field
type.

For CAP data sources, the value of Start date and
time is mapped to the onset CAP element, and the value
of End date and time is mapped to the expires CAP
element.

Last update date and time The property that contains the time that a data item is
updated. An update to the data that is already stored in
the system is triggered when the value of this property
in your data source is more recent than the value that is
stored by the system.

For CAP data sources, a synthetic value from the
data receiver is assigned.
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Table 31. Description of the fields on the Minimal Properties tab (continued)

Field Description

Location format The format in which your data source supplies the data
for a map marker:

v Select Latitude and longitude to supply coordinates
for a single point marker.

v Select Shape to supply data for any of the geometry
format options that are listed on the Timezone &
Other tab.

For CAP data sources, the Shape option is
preselected for the value of Location format.

1.6.0.1 1.6.0.2 If you selected the Data for
boundary option on the Basics tab, the value of Location
format is preassigned to Shape.

Shape The property in your data source that stores the shape
data. Input is required here when you select the shape
option in the Location format field. If the shape data is
stored in a separate data source, in this field select the
property in your data source that contains a lookup
value. This value is intended to provide a match for the
value of the property in the Lookup name field.

For CAP data sources, the value of Shape is set to
location, and location is mapped to the area CAP
element. However, a location is not required. If an area
value is not supplied in the CAP message, the location
value is set to null, and the CAP message is not
displayed on the map. If the CAP message matches any
routing expressions that you define on the Routing tab,
it is still routed to the appropriate destinations.

Lookup location, Lookup name The database table and property name that are required
when the shape data is stored in a separate lookup data
source.

v In the Lookup name field, enter the property that
contains a value to match the Shape field value.

v In the Lookup location field, enter the corresponding
database table name.

The property that contains the matching value identifies
a row of the database table. The system looks at that
row, in a property that is called Location, to find the
shape data. The database information that you supply on
the Acquire tab is applied to the lookup data source,
except for the database table information that you supply
here.

Chapter 4. Configuring the solution 107



Table 31. Description of the fields on the Minimal Properties tab (continued)

Field Description

Geometry format The format for the marker on the map. Based on your
choice in the Location format, select the appropriate
geometry here. Depending on what you select in this
field, assign either an icon or a color style on the
Appearance tab:

v Select a point marker and assign an icon.

v Select a shape marker and assign a color style.

For CAP data sources, select All. The geometry
format is determined by the content of the CAP message.
CAP messages can contain either points, or polygons.

1.6.0.1 1.6.0.2 If you selected Yes for the Data
for boundary option on the Basics tab, the value of
Geometry format is preassigned to Polygon.

Assessment date The date a data item is due for assessment. Some
solution applications incorporate a data assessment.
Refer to the documentation that is specific to your
solution for more detail.

Time zone offset The property that contains an adjustment to be applied
when your data source is in a timezone that is different
from the system timezone. The unit of measure for the
value is minutes. The value must be divisible by 30, for
example, 30, 60, or 90. The adjustment is applied only to
time values in the Start date and time and End date and
time properties. In a sample scenario, you want to adjust
for the following requirements:

v Your data source staging table properties contain start
and end time values that are expressed in GMT+5
hours

v The solution’s target table properties contain time
values that are expressed in GMT+1 hour

Enter a value of 240 to apply an adjustment in time of
240 minutes (4 hours).

For CAP data sources, you cannot edit the Time
zone offset property, which is predefined.

Time format, Date format The format in which time and date string values are
supplied by your data source. The format must be
compliant with the standard contained in the link at the
end of the topic. If you set the date and time field type
to String on the Time & Date tab, enter the format here.

Related concepts:
“Data source time stamp synchronization” on page 156
When the data receiver receives updated information for a data source, a time stamp is applied to the
updated data source. The method that is used to determine the time stamp depends on several factors.
Related information:

Supported date and time format
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Data source key and full property settings
On the Key & Full Properties tab, set the optional parameters for specific properties that are appropriate
for your data source.

Minimal and key properties are displayed automatically in the user interface on the List tab and map
preview cards. By default, each of your data source properties is a full property if it is not assigned to a
minimal or key property in the solution. Full properties are shown only when you click the preview card
for more information.

On the Key & Full Properties tab, select a property from your data source and, in the fields that are
provided, set the parameters that you require for that property. Depending on the options that you
selected in previous tabs, you might be able to edit only some of the properties, and some values might
be either predefined, or preselected.

For Common Alerting Protocol (CAP) data sources, all the CAP elements that are included in the
specification are listed as data source properties. However, for each property, you can edit the value of
the User interface label field only. The properties that are in the following list are key properties, and the
remaining properties are full properties:
v areaId (CAP for location maps only)
v category
v certainty
v event
v msgType
v sender
v severity
v urgency

1.6.0.1 1.6.0.2 For user interface entry data sources, all the properties are preassigned, except for
the value of User interface label.

Table 32. Description of the fields on the Key & Full Properties tab

Field Description

User interface label The name that is assigned to a key or full property for
use throughout the user interface. The name of a
minimal property that is displayed on the List tab and
preview card is set by the system and cannot be
changed. However, you can provide a label for a
minimal property to be used for another application.
Refer to the documentation that is specific to your
solution for more detail.

Key property An option to assign key status to a full property. A key
property is displayed automatically in the user interface
on the List tab and map preview cards. You cannot
assign key status to a minimal property.

Data type The format in which the data value of the property is
stored. Select from a list of allowed options. Ensure that
the format selected is compatible with the type of
property. For example, a property that contains a priority
number is assigned a data type of Integer.
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Table 32. Description of the fields on the Key & Full Properties tab (continued)

Field Description

Length The maximum length that is allowed for the string value
of a property with a data type of Character. The system
has an upper limit of 32704 characters. This field is
displayed only when you select Character in the Data
type field.

Precision, Decimal places The precision and decimal places that are allowed for the
value of a property with a data type of Decimal. For
example, a value of 123.45 has three precision digits,
123, and two decimal places, 45. The total length of the
property value is equal to the number of precision digits
plus the number of decimal places, where the total
length must be in the range 1-31 digits. There can be 0 -
31 decimal places in the value, where a valid value is a
number with 0 precision digits and 31 decimal places.
The Precision and Decimal places fields are displayed
only when you select Decimal in the Data type field.

Optimize for filtering An option to specify the property is optimized for
efficient filtering of data items in relation to the property.
If you select Yes, a database index is created. This
optimization is useful for a property that is frequently
used for sorting or searching, for example, a name.

Distribute on charts An option to indicate that the property value is used in
charts. Refer to the documentation that is specific to your
solution for more detail.
Note: This option applies to IBM Intelligent City
Planning and Operations.

Used as an index ID An option to assign the property value to be part or all
of a unique key ID for a data item. A data source can be
defined with one or more properties that are used as an
index ID. An update from your data source must match
this ID to update a data item in the system.
Note: If a data source is defined without any property
that is used as an index ID, all updates to the data
source are stored as new data items in the system.

Updatable An option to specify that the property data can be
updated by the system. You cannot select this option if
the property is selected as an index ID.

Filter enumerated values An option to provide the user with extra data item filters
based on the values of this property that are received at
run time. If the field is set to Yes, the filter panel
displays these values as filter options. If this field is set
to the default No, the values of this property are not
provided to the user as filter options.
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Table 32. Description of the fields on the Key & Full Properties tab (continued)

Field Description

Allowed values Enter the values that the user can select as extra filter
criteria. The filter panel displays the values that you
enter as filter options. Enter values that are separated by
commas and ensure any spaces that are used match the
values as you intended. You can enter allowed values at
configuration time only when Filter enumerated values
is set to No.
Note: If Filter enumerated values is No for all properties
and no allowed values are entered here for your data
source, the user does not see the More option on the
filter panel. There are no extra filter criteria available for
selection on the data source pane.

Related information:

OASIS Common Alerting Protocol Version 1.2

Securing your data source
For your data source, assign users or groups the appropriate access to data and authorization privileges.

About this task

To allow a user access to data items from your data source on a map or list in the user interface, assign
the required access level. The list that is provided contains the users and groups that are defined by the
administrator for the system. The default access is read and write access for the creator of the data source
only, and no access for other users.

1.6.0.1 1.6.0.2 Administrators have read and write access to every data source.

Users or groups who have read-only access can view data items, and can update data items in fields that
can be updated. Users or groups who have read and write access have the same access as users with
read-only access, but they can also configure the data source if they have access to the Solution
Administration view.

Procedure
1. To access the data sources configuration tool, click Administration > Solution Administration >

Configuration Tools > Data Sources.
2. On the Security tab, select a user or group from the list of names.
3. Select the appropriate access level for the user or group.
4. In the data sources tool, move to another tab, or click OK to save your data source for use in the

system.
5. Click Save to apply updates to an existing data source.
Related reference:
“User role groups and authorization permissions” on page 92
In IBM Intelligent Operations Center, a set of permissions for accessing views and the features that they
contain is associated with each user role group.

Routing data from your data source
For the data that is received from your data source, set routing expressions that define how the data is
processed by the solution. Data items that match the required expression or combination of expressions
are routed to the selected destination.
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About this task

You can route your data items by defining an expression that is selected for a specific criterion. Then, you
can route the data to one of the following destination options:
v Select Intelligent Operations Center to route the data to the system as a whole.
v Select Key Performance Indicators to route the data to KPI processing, depending on the value and

KPI configuration.
v Select Standard Operating Procedures to route the data to a standard operating procedure that is

defined in the solution. 1.6.0.2 You can choose whether to launch a new instance of the standard
operating procedure for every matching record.

v Select Integration Topic to route the data to a WebSphere Application Server integration topic that has
been previously defined.

v 1.6.0.1 1.6.0.2 Select Correlation Topic to route the data to a topic where it is used for
correlation. If you want to route data to a correlation topic, you must select Yes for the Data for
correlation option on the Basics tab.

Procedure
1. To access the data sources configuration tool, click Administration > Solution Administration >

Configuration Tools > Data Sources.
2. On the Routing tab, to add routing details for a property from your data source, do the following

substeps. Repeat the substeps for each routing expression that you want to add.
a. Click Add Routing Expression.
b. Complete the Property, Operation, and Criteria fields to define an expression. The resulting

condition selects the data to be routed.
c. Select the Route to option for data to be routed and processed by the system.

3. If you have multiple expressions that are routed to the same target, check that the overall expression
logic that is defined in the Expression logic field is correct. The system uses the expression logic
when it processes your data:
v Choose All expressions must be true to apply a logical AND operation to the combination of

expressions.
v Choose Any expression must be true to apply a logical OR operation to the combination of

expressions.
4. In the data sources tool, move to another tab, or click OK to save your data source for use in the

system.
5. Click Save to apply updates to an existing data source.

Note: There is a delete button at the side of each routing expression. To delete an expression, click the
delete button and then save.

Related concepts:
“Data item routing” on page 150
IBM Intelligent Operations Center processes incoming data items to determine how information is
displayed.
“Data source routing updates not reflected in filtered results” on page 447
If you edit the routing criteria for a data source, it might take several refresh cycles before data items that
match the updated routing criteria are displayed.
“Configuring KPIs” on page 120
In the Solution Administration view, you can configure Key Performance Indicators (KPIs) and their
hierarchical display in the user interface. The KPIs are displayed on the status views in IBM Intelligent
Operations Center.
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“Configuring standard operating procedures” on page 136
A standard operating procedure is a set of instructions that describes all the relevant steps and activities
of a process or procedure. Standard operating procedures are essential to an organization to deliver
consistent, measured, high-quality responses to complex and unpredictable events.

Assigning actions to your data source
1.6 1.6.0.1

You can choose which user actions to apply to data items that are received from your data source. Some
actions are applied by default.

About this task

From the default list of actions that are supplied, select the actions that you require as options for the
user interface. The selected actions are offered on the More Actions menu of the preview card.

1.6.0.2 You can assign actions to data sources by using the component customization tool that is in the
Solution Administration view. For more information, see the Customizing components section.

Procedure
1. To access the data sources configuration tool, click Administration > Solution Administration >

Configuration Tools > Data Sources.
2. On the Actions tab, change the availability of actions that are on the Available Action list by selecting

the appropriate Use? option. Select Yes to make an action available.
3. In the data sources tool, move to another tab, or click OK to save your data source for use in the

system.
4. Click Save to apply updates to an existing data source.
Related tasks:
“Defining custom actions for data sources” on page 182
You can define custom actions that are displayed as available actions on the Actions tab in the data
source configuration tool. If you assign a custom action to a data source, it is displayed in the More
Actions menu that is on the preview card for the data source.
“Customizing components” on page 174
To extend and customize the functionality of your solution, you can create customized components that
you can add to the user interface. You can also replace an existing component with a customized
component. For example, for a particular system component, you can replace an existing preview card
with a new, customized preview card.

Configuring the appearance of your data on the map
Assign either an icon or a color to map markers to represent the data items from your data source. You
can set conditions to change the appearance of the map marker according to the value of a property that
is within your data source.

Before you begin

A data item can be represented by either an icon at a point on the map, or multiple icons at points on a
map. Alternatively, a data item can be represented by one of a range of other geometrical formats: a line,
multiple lines, a shape, or multiple shapes. On the Minimal Properties tab, specify the geometric format
of the marker that you want to represent your data on the map. On the Minimal Properties tab, you can
also specify a lookup location for shape data values.
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About this task

Configure appearance to define how data items from your data source are displayed on the map. You can
either select an icon, or define a color depending on the geometry format that you choose.

You can assign an icon to a marker that is in point format. You can assign a color style to a marker that is
in any geometrical format other than a point. The color of an icon is controlled by the category that is
assigned to the data source in the filter panel configuration. If you want to upload your own icon into
the solution, the icon must be in Portable Network Graphics (PNG) format.

Procedure
1. To access the data sources configuration tool, click Administration > Solution Administration >

Configuration Tools > Data Sources.
2. On the Appearance tab, click either Icons or Styles, depending on whether you want to assign an

icon or a color style to the map marker that represents your data.

Icons

To assign an icon as a map marker, select the icon of your choice in the Available icons field,
or upload your own icons by clicking Upload Dark Icon and Upload Light Icon.

Note: You must upload both dark and light versions of your icon so that the icon can be seen
throughout the solution interface.

Styles

To assign a color for the entire data source, in the Style for data source fields, select a color.
Select a color either for Line color or for Fill color, depending on the geometrical format that
you chose on the Minimal Properties tab.

Note: The color style that is applied here overrides the color that is selected in the filter panel
configuration. The color that is selected in the filter panel configuration applies to point data only.

3. Optional: To assign a style to a specific property in your data source:
a. On the Styles tab, click Add a style.

b. Enter a name.
c. Select a color.
d. To create an expression to control where the color style is used, click Assign style to an

expression.
4. In the data sources tool, move to another tab, or click OK to save your data source for use in the

system. Click Save to apply the updates to an existing data source.
Related concepts:
“Data item icons” on page 183
You can design your own icons and upload image files to represent data items in the operations views,
the status views, and the Solution Administration view. The image files that you upload must meet
certain requirements.

Configuring the filter panel
In the Solution Administration view, you can decide how you want to group data sources. Then, for each
group, you can configure a pane that is displayed in the filter panel. The data sources that you select are
listed in the pane.

You can assign a color to each pane, and change the order in which the filter panes are displayed. You
can also define the date and time ranges, and the holidays that are displayed in the Date & Time pane.
Related tasks:
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“Creating a data source” on page 101
As an administrator, you can use the data sources tool to add and configure a data source.
“Updating data source configuration” on page 103
As an administrator you can update the settings for a data source.
“Creating an analysis definition” on page 131
Configure the parameters for a data analysis definition that can be associated with geographical areas on
the map. The analysis has the potential to indicate patterns of data by displaying hotspots on the map.

Creating a pane
Use the following procedure to create a pane that is displayed in the filter panel. Then, select the data
sources that are displayed in the pane.

Procedure
1. Click Configuration Tools > Filter Panel.
2. Click Create.
3. In the Create a Pane window, specify the details for the pane:

a. Enter a value for Pane name.
b. Select a color to associate with the pane from the Color to use palette. When you filter data from

this pane, the data item markers are displayed in this color. However, if the data source is not
represented by point locations on the map, the color settings that an administrator configures in
the Appearance tab of the data sources configuration wizard override the color that you specify
here.

c. In the Available data sources list, click each data source that you want to include in the pane, and
then click the Add selected available data source to this pane icon to move it to the Data sources
included on this pane list.

d. To reorder data sources that are in the Data sources included on this pane list, click a data source,
and then click either the Move selected data source down icon, or the Move selected data source
up icon.

e. Click OK. The pane is created and the pane name is displayed at the end of the list of panes.
4. To reposition a pane in the filter panel, click its name in the list, and then click either the Move

selected pane down icon, or the Move selected pane up icon.
Related tasks:
“Configuring the appearance of your data on the map” on page 113
Assign either an icon or a color to map markers to represent the data items from your data source. You
can set conditions to change the appearance of the map marker according to the value of a property that
is within your data source.

Modifying a pane
Use the following procedure to modify a pane that is displayed in the filter panel. You can change the
title and the data sources that are displayed in the pane, and change the color that is associated with the
data source group.

Procedure
1. Click Configuration Tools > Filter Panel.
2. Click the name of the pane that you want to modify.
3. Modify the details for the pane as appropriate:

v Edit the value of Pane name.
v Select a color to associate with the pane from the Color to use palette. When you filter data from

this pane, the data item markers are displayed in this color. However, if the data source is not
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represented by point locations on the map, the color settings that an administrator configures in the
Appearance tab of the data sources configuration wizard override the color that you specify here.

v To add a data source to the pane, click it in the Available data sources list, and then click the Add
selected available data source to this pane icon to move it to the Data sources included on this
pane list.

v To remove a data source from the pane, click it in the Data sources included on this pane list, and
then click the Remove selected data source from this pane icon to move it back to the Available
data sources list.

v To reorder data sources that are in the Data sources included on this pane list, click a data source,
and then click either the Move selected data source down icon, or the Move selected data source
up icon.

4. Click Save.
5. To reposition a pane in the filter panel, click its name in the list, and then click either the Move

selected pane down icon, or the Move selected pane up icon.

Deleting a pane
Use the following procedure to delete a pane from the filter panel.

Procedure
1. Click Configuration Tools > Filter Panel.
2. Click the name of the pane that you want to delete.
3. Click Delete, and then in the confirmation window, click OK. A message is displayed that confirms

that the pane has been deleted.

Editing the Saved Filters pane or the Favorites pane
Use the following procedure to edit either the Saved Filters pane, or the Favorites pane, that is displayed
in the filter panel. You can delete saved filters or favorites.

About this task

Depending on which version of IBM Intelligent Operations Center is installed, the name of the pane
might be either Saved Filters, or Favorites.

Procedure
1. Click Configuration Tools > Filter Panel.
2. Click either Saved Filters, or Favorites.
3. To delete either a saved filter, or a favorite, click the Delete icon.
4. Click Save.

Defining date and time and holiday ranges
Use the following procedure to define date and time range options, and holiday options that are
displayed in the Date & Time pane in the filter panel. For example, you can specify options that make it
easy to filter data based on weekends, rush hour, opening hours, and public holidays.

Procedure
1. Click Configuration Tools > Filter Panel.
2. To specify date and time range options, click the Date & Time tab:

a. To add a date and time option, click Add.
b. In the row that is added, specify the following details:

v Enter a value for Name, for example, Weekends.
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v Select a value from the From Day(s) list, for example, Friday.
v Select a value from the From Time(s) list, for example, 05:00pm.
v Select a value from the To Day(s) list, for example, Sunday.
v Select a value from the To Time(s) list, for example, 09:00pm.

3. To specify holiday options, click the Holidays tab:
a. To add a holiday option, click Add.
b. In the row that is added, specify the following details:

v Enter a value for Name, for example, 4th July 2012.
v For Date, either enter a value, or select a date from the calendar, for example, 07/04/2012.

4. To delete either a date and time, or a holiday option, click the Delete icon at the end of the row.
5. When you finish adding, editing, and deleting rows, click Save.

Configuring geospatial maps
In the Solution Administration view, you can configure the maps that are available to the user, the initial
map center point, and the map zoom level.

As a user, on the Map tab in the operations view, you can change the base map that is displayed by
selecting from the options that are listed in the More Actions menu. You can control the location and
zoom level of the selected map with the pan and zoom controls on the map.

As an administrator, in the Solution Administration view, you can customize geospatial maps:
v Default base map, map menu, and maps that are available for display on the Map tab
v Default pan and zoom level for each available map
Related concepts:
“Map tab” on page 370
Use the Map tab to see current information that is represented on a geospatial map. You can obtain
information from data items marked on the map. Select your data sources on the filter panel and your
base map from the list of maps available in the solution.

Managing base maps
As an administrator, you can create, edit, or delete base maps in the solution.

About this task

The Geospatial Map tool provides you with a menu of actions to create, edit, or delete a map for display
on the Map tab. To create a base map in the solution, follow the procedure.

Procedure
1. Click Administration > Solution Administration > Configuration Tools > Geospatial Map.
2. Click Create.

3. Enter the name to be attached to the map in the user interface.
4. Select the type for the base map provider and complete the fields that are required for that provider.

XYZ Enter the URL for your own web map tile service and, optionally, an appropriate attribution
for the map.

OpenStreetMap
Enter the URL or the OpenStreetMap web map tile service and, optionally, an appropriate
attribution for the map.
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Google
Enter the layer type that you require for Google, for example, Terrain, Satellite, or Hybrid.

5. To assign this map as the default map for the Map tab, select the check box.
6. Click Save.

Results

In the operations view, on the Map tab, you can see the new map in the list of maps that are available in
the solution. You can select the map for display on the Map tab.

If you assign a map as the default map, it is displayed by default on the Map tab. Select the default map
for display by clicking Reset in the More Actions menu on the Map tab.

What to do next

You can edit or delete maps in the list. To edit a map, highlight the required map name and click Edit.
Base Map Properties window is similar to the Create New Base Map window and you can edit the
fields as required.
Related tasks:
“Setting the map center and zoom”
As an administrator, you can set the center point coordinates and the zoom level of any geospatial base
map in the solution.

Setting the map center and zoom
As an administrator, you can set the center point coordinates and the zoom level of any geospatial base
map in the solution.

Procedure
1. Click Administration > Solution Administration > Configuration Tools > Geospatial Map.
2. On the Base Maps tab, select the map that you want to work with and click Map Location.
3. Set the required center point coordinates and zoom level by using the map controls. You can see the

current settings in the Latitude, Longitude, and Zoom level fields beside the map.
4. Click Save.

Results

In the operations view, on the Map tab, the center point coordinates and the zoom level that you set are
the initial defaults for that base map.
Related concepts:
“Controlling the map” on page 369
You can move the cursor around the map by using your mouse or keyboard.
Related tasks:
“Managing base maps” on page 117
As an administrator, you can create, edit, or delete base maps in the solution.

Setting displayed and returned data item limits
1.6.0.2

You can set the maximum number of data items that are returned to the map and the list, and that are
rendered on the map.
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Procedure

Do the following steps in the Solution Administration view:
v To set the maximum number of data items that are rendered on the map, configure the

MaxFeaturesToRenderOnMap system property.
v To set the maximum number of data items that are returned to the map and the list, configure the

StatMaxAllowedFeaturesInResponse system property.
Related tasks:
“Configuring system properties” on page 189
View, create, modify, and delete system properties in the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent Operations Center.

Adding KML overlays
1.6.0.2

A KML file contains layers and collections of features that you can add onto an IBM Intelligent
Operations Center map. If you have data in XML format, you can use the KML schema to add features
onto a map without requiring a data source. As an administrator, you can add KML overlays to base
maps.

About this task

To add KML overlays to a map, configure the IBM Intelligent Operations Center KmlUrls system property.
The order in which the layers are displayed in the Map Overlays pane within the filter panel depends on
the order that they are defined in the KmlUrls system property. To add a KML overlay to the map in the
solution, follow the procedure.

Procedure
1. Log on to the application server as ibmadmin and create the following directory:

/opt/IBM/WebSphere/wp_profile/installedApps/cell1/ioc_theme_ear.ear/ioc_theme_static_js_web.war/
js/com/ibm/ioc/kml/

2. Copy your KML files to the directory that you created in the step 1.
3. Edit the KmlUrls system property to display the KML overlays that you require. For example, to

configure two overlays simultaneously, modify the system property with the following values:
[{"label": {"group": "KMLLayer", "key": "layer1"},
"url": "/ibm/ioc/theme/static/js/js/com/ibm/ioc/kml/UpdateKMLFile.kml"},
{"label": {"group": "KMLLayer", "key": "layer2"},
"url": "/ibm/ioc/theme/static/js/js/com/ibm/ioc/kml/KMLSAMPLE.kml"}]

where:
v label is the KML overlay label.
v group and key are the values that are used to look up the label for the layer in the I18N resource

service.

Note: An administrator must add the relevant values to the ioc.i18n_resource table.
v URL is the URL of the KML layer file.

4. Save your changes.

Results

In the operations views, all of the selectable KML layers are displayed in the Map Overlays pane in the
filter panel.
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What to do next

For more information, see the Configuring system properties topic. Also, for more information, see the
context root information in the WebSphere Application Server product documentation.
Related tasks:
“Configuring system properties” on page 189
View, create, modify, and delete system properties in the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent Operations Center.
“Viewing KML overlays” on page 374
If an administrator configures one or more KML overlays for the map, the Map Overlays pane is
displayed in the filter panel. A KML overlay contains extra information about data items that can be
displayed on the map, for example, locations and icons.

Configuring KPIs
In the Solution Administration view, you can configure Key Performance Indicators (KPIs) and their
hierarchical display in the user interface. The KPIs are displayed on the status views in IBM Intelligent
Operations Center.

You can customize the navigation tree of KPI hierarchies that is displayed on the status views of the user
interface. You can also view, change, copy, create, and delete KPIs from the KPI models that are available
within the solution.

KPI navigation tree

In the Key Performance Indicators window, you can see the KPI hierarchies of parent and child KPIs.
These are the KPI hierarchies that are displayed in the KPI navigation tree on the status views of the user
interface. The root level nodes correspond to KPI models. On the status views, KPIs are represented by
colored cells. The color indicates the status of the KPI.

On the Relationships and Display tab, the information that is described in the following table is
available for each root level node.

Name title of the root level node

Type type of root level node or owning organization for KPIs

Model ID identifier for the corresponding KPI model

Icon icon that represents the root level node, owning
organization or data source

KPI model

In the Key Performance Indicators window, you can see details of the KPI models that you are
authorized to view. You can find details of all the KPIs in each model.

On the KPI Definition tab, the information that is described in the following table is available for each
KPI in the KPI models.

KPI Name Title of the KPI. You can click the KPI name to see the
properties.

Model ID of the model the KPI belongs to.
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Created Method of creation of the KPI:

v A modeled KPI is a KPI created at the model level
using IBM WebSphere Business Monitor.

v A dashboard KPI is a KPI created using the Key
Performance Indicators tool.

Type Type of KPI:

v An aggregate KPI has a value that is based on the
metric and aggregation method you select.

v An expression KPI has a value that is based on other
KPIs or user-defined functions, using an XPath
expression that you define.

Access Access level of a KPI:

v A shared KPI is a KPI that other users have access to
view.

v A private KPI is a KPI that cannot be shared with
users other than the owner.

Related concepts:
“Data item routing” on page 150
IBM Intelligent Operations Center processes incoming data items to determine how information is
displayed.
“Monitoring status through KPIs” on page 384
Use the status view to see the status of key performance indicators (KPIs) in summary or in detail
format.
Related tasks:
“Routing data from your data source” on page 111
For the data that is received from your data source, set routing expressions that define how the data is
processed by the solution. Data items that match the required expression or combination of expressions
are routed to the selected destination.

Sample KPIs
A set of sample KPIs is provided with the solution. These KPIs are designed to provide guidance for
planning and implementing different types of KPIs to suit your organization. Examples are provided in
the areas of water, transportation, and public safety.

Viewing or changing KPI hierarchies
As an administrator, you can view, change, or remove KPI models as they are displayed on the status
views.

Procedure
1. Click Administration > Solution Administration > Configuration Tools > Key Performance

Indicators.
2. On the Relationships and Display tab, expand a root level node to see lower levels of the model tree

you want to view.
3. Click a root level node title to preview its details.
4. Click a KPI to preview its details on the Relationships and Display window.
5. In the Relationships and Display tab, you can move, add, change, or remove existing items, as

follows:
v To move subitems within a tree, drag the item to the position you require. Green or red indicators

indicate whether a move is allowed or not.

Chapter 4. Configuring the solution 121



v To add to a tree from the list of existing subitems for a KPI model, right-click on the item to contain
the subitem and click Add KPI.

v To go to the KPI Properties window and change a subitem, right-click on the item and click Edit.
v To remove a root level node or a subitem from a tree, right-click the item and click Remove.

Removing a root node item removes all of the subitems it contains.
6. Click Save to save any changes you made, or cancel if you did not make any changes.

Note: It is not possible here to edit the details of an owning organization or root level node.

1.6.0.2 This is apart from the name and the icon. If you want to change an owning organization,remove it and replace it with another.

Exporting or importing KPI hierarchies
1.6.0.2

You can create a hierarchy of KPIs that are associated with the IBM Intelligent Operations Center
solution. As an administrator, you can import an existing KPI hierarchy as a JavaScript Object Notation
(JSON) file, or export the existing KPI hierarchy to a JSON file.

About this task

To avoid reconstructing a KPI hierarchy, you can import an existing KPI hierarchy JSON file that was
exported from a different instance of IBM Intelligent Operations Center. The KPI hierarchy import
imports the existing KPI hierarchy into the solution, and then replaces the hierarchy that is already in the
solution with the imported KPI hierarchy.

To generate a copy of an existing IBM Intelligent Operations Center KPI hierarchy, you can export the
hierarchy to a JSON file. The KPI hierarchy export exports the entire KPI hierarchy. If you export a KPI
hierarchy, links to reports, named areas, or authorizations are not maintained as the hierarchy must be
transferable between IBM Intelligent Operations Center installations. To display the replacement KPI in
the status view, edit your permissions.

Procedure
1. Click Administration > Solution Administration > Configuration Tools > Key Performance

Indicators.

2. In the Relationships and Display tab, complete one of the following steps.
v To export the full KPI hierarchy for the solution, do the following substeps:

a. Click Export KPI Hierarchy.
b. Use the file explorer to select the location to export the KPI hierarchy JSON file to.

v To import a KPI hierarchy into the solution, do the following substeps:
a. Click Import KPI Hierarchy.
b. Use the file explorer to locate the KPI hierarchy JSON file that you import.

Results

The KPI hierarchy that you selected is either exported from the solution or imported into the solution.

Adding, editing, or deleting an owning organization
As an administrator, you can add an owning organization as a root level node to be displayed on the
status views. You can edit the details of an existing owning organization at root level. 1.6.0.2 However,
you cannot edit the model detail. You can also delete an owning organization at root level and its
associated sublevel nodes are deleted also.
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About this task

To add a root level node, follow the procedure.

Procedure
1. Click Administration > Solution Administration > Configuration Tools > Key Performance

Indicators.
2. At the top of the Relationships and Display tab, click Add Owning Organization.
3. Enter the name of the owning organization to be displayed in the solution interface.
4. From the drop-down list of the Model field, select the KPI model for the root level node to be added.
5. From the drop-down list of the Icon field, select the file name for the icon to represent the root level

node.
6. Click OK to add the root level node to the tree on the Relationships and Display window.
7. Click Save to update the display in the status view.

Results

The root level node that you added is displayed in the tree hierarchy and is available for display on the
status views in the user interface.

What to do next

To edit the details of an owning organization, select the name from the tree on the Relationships and
Display window, right-click, and change the details as directed in the procedure.

To delete an owning organization, select the name from the tree on the Relationships and Display
window, right-click, select Remove from the drop-down menu, and click Save.

Changing the KPI legend
As an administrator, you can change the KPI legend at the top of the status views.

Procedure
1. Click Administration > Solution Administration > Configuration Tools > Key Performance

Indicators.
2. On the Relationships and Display tab, click Update KPI Legend.
3. Change the display for the KPI legend as follows:

v To add a range, click Add Row.
v To change a range, edit the fields under Range Name, Color, Icon.
v To delete a range, click the delete icon.

4. Click OK and Save to confirm and update the legend displayed on the status views.

Validating KPI ranges
You can validate the range that is assigned to each KPI in the navigation tree.

About this task

The validation program ensures that the ranges assigned to each KPI match the ranges that are defined in
the legend and are logical. For example, the validation check ensures that ranges are concurrent and do
not overlap.
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Procedure
1. Click Administration > Solution Administration > Configuration Tools > Key Performance

Indicators.
2. On the Relationships and Display tab, click Update KPI Legend.
3. In the Validate KPI Ranges window, click Run Validation. The result of the validation check for each

KPI is listed in a table, see example.
4. Click Cancel to close the window.

Example

This example shows the format and part of a table that results from a validation check.

KPI Validation

Firefighter Injuries Fire Station One Valid

Fire Department Valid

Crime Response Time Valid

Delayed Flights Airport Two Valid

Public Safety Budget Valid

Editing KPI permissions
Assign to users or groups, the appropriate access to KPIs and associated authorization privileges.

About this task

To allow a user access to KPIs from a model on a status view in the user interface, assign the required
access level. The list that is provided contains the users, groups, and default access levels that are defined
by the administrator. The access level you set for a KPI applies to that KPI and any child KPIs that it has.

Procedure
1. To access the KPI configuration tool, click Administration > Solution Administration >

Configuration Tools > Key Performance Indicators

2. On the Relationships and Display tab, select a KPI in the KPI tree hierarchy.
3. At the top of the Relationships and Display tab, click Edit Permissions.
4. Select a user or group from the list of names.
5. Select the appropriate access level for the user or group in relation to your KPI.
6. Click OK and Save to confirm the update.

Mapping KPIs to named areas
1.6.0.1 1.6.0.2

As an administrator, you can map KPIs to named areas for display on the area status views in the user
interface.

Procedure
1. Click Administration > Solution Administration > Configuration Tools > Key Performance

Indicators.

2. Select the KPI you want to associate with one or more named areas. You can select only top-level
KPIs for this purpose.

3. At the top of the Relationships and Display tab, click Map KPI to Named Area.
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4. In the Choose the named area data source field, select from the list of available named area data
sources.

Note: Only data sources that are assigned the named area data type are available for KPI mapping.
To assign named area type to a data source, set the field Data for Boundary to Yes when you
configure the data source.

5. Select one or more of the check boxes for the available named area data items that are listed.
6. Click OK to map the KPI to the named areas you selected.
7. Click Save to update the named areas available for selection in the area status view.

Results

The named areas that you selected are mapped to the appropriate KPI. As a user, you can select one or
more of these named areas on the map or list of the area status views and the relevant KPIs are
displayed.

Example

For monitoring crime in specific areas of a major city, you might want to map KPIs to a data source with
data on police precincts that are represented by the named areas drawn on the map.

Mapping KPIs to reports
1.6.0.2

As an administrator, you can map KPIs to reports that are displayed in the status views. You can map the
same report to more than one KPI. Optionally, you can add a set of parameters to each report that might
modify the data that is displayed by the report. The parameter values are used to generate a Cognos
reports query, and the parameter values are also displayed as a label on the instance of the generated
report.

About this task

You can add parameters that apply only to the selected report for the selected KPI; for example, the
parameters might refer to the name and identifier for a report that contains data for a subregion of a
larger municipal region. You can specify any parameters when you generate a Cognos reports query.
However, the result of your query depends on whether the report requires the parameters that you
supply. If the report does not require the parameters that you supply, the parameters are not processed
by the solution.

Procedure
1. Click Administration > Solution Administration > Configuration Tools > Key Performance

Indicators.

2. Select the KPI that you want to associate with one or more reports.
3. At the top of the Relationships and Display tab, click Map KPI to reports.
4. Under Available reports, select one or more check boxes from the list of available reports and click

OK. The associated reports are displayed in the Reports field for each KPI.
5. Optional: Under Add parameters, for each selected report, enter alphanumeric values for Type and

Value, and then click Add.
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Results

The reports that you selected are mapped to the appropriate KPI. As a user, you can select one or more of
the reports from the KPI preview card on either the map or the list in the status views. The relevant KPIs
are displayed in the reports.

Example

You might want to create a report for monitoring crime in specific areas of a major city. To create the
report, you map KPIs to the report that contains data from police precincts during a specified time frame.

What to do next

To disable report headers in the report that you display, configure the following report parameters with a
value of false:
v cv.toolbar

v cv.header

For more information about generating a Cognos reports query URL with parameters, and configurable
report parameters, see the IBM Cognos Business Intelligence product documentation.
Related tasks:
“Viewing reports from KPI preview cards” on page 385
From the KPI preview cards in the status views, you can view reports that are mapped to KPIs.
Related information:

IBM Cognos Business Intelligence 10.2.0 information center

Viewing or changing a KPI model
As an administrator, you can use the KPI Definition tab to view or change the KPI models available
within the solution.

The Filter by model field contains a drop-down list of business process models that you are authorized
to view. Select All models to see all models and all KPIs. Select the name of a specific model to focus on
and only the KPIs belonging to that model are displayed. The KPIs are sorted and displayed in
alphabetical order.
Related concepts:
“Creating and integrating KPIs” on page 156
Key performance indicator (KPI) models can be created and modified using a business monitoring
development toolkit and the Key Performance Indicators configuration tool.

Copying or creating a KPI
As an administrator, you can use the KPI Definition tab to create KPIs belonging to the KPI models
available within the solution.

You can create a new KPI for an existing model in the solution. Alternatively, you can select from the list
of KPIs displayed, a KPI to copy, and edit.

Copying a KPI
Make a copy of an existing KPI from a model in the solution.

Procedure
1. Click Administration > Solution Administration > Configuration Tools > Key Performance

Indicators > KPI Definition.
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2. Select a KPI. On the action bar, click More Actions > Copy. The KPI properties window opens.
3. Type a new KPI name in the KPI Name field.
4. To change the KPI, edit the fields on the tabs of the properties window. For more details about editing

these fields to create an aggregate or expression KPI, click the link at the end of the topic.

Note: The KPI that you create within the solution is defined as a dashboard KPI.
5. To save and exit from the updated KPI properties window, click OK. To save and continue changing

the copied KPI, click Apply. To exit without saving, click Cancel.

Creating a KPI
Create a KPI for one of the KPI models in the solution.

Procedure
1. Click Administration > Solution Administration > Configuration Tools > Key Performance

Indicators > KPI Definition.
2. On the action bar, click Create.
3. Click New Aggregate KPI or New Expression KPI. The KPI Properties window opens.
4. To change the KPI, edit the fields on the tabs of the properties window. For more details about editing

these fields to create an aggregate or expression KPI, click the link at the end of the topic.

Note: The KPI that you create within the solution is defined as a dashboard KPI.

Changing or deleting a KPI
As an administrator, you can use the KPI Definition tab to view, change or delete KPIs belonging to the
KPI models available within the solution.

You can create a new KPI for an existing model in the solution. Alternatively, you can select from the list
of KPIs displayed, a KPI to copy, and edit.

Viewing or changing a KPI
View or change an existing KPI belonging to a model in the solution.

Procedure
1. Click Administration > Solution Administration > Configuration Tools > Key Performance

Indicators > KPI Definition.
2. Select a KPI. On the action bar, click Edit. The KPI Properties window opens.
3. To change the KPI, edit the fields on the tabs of the properties window. 1.6.0.2 In the KPI

Properties window, you cannot change the model of a dashboard KPI.

Note: In the KPI Properties window, you cannot change the definition or the model of a modeled
KPI.

4. To save and exit from the updated KPI properties window, click OK. To exit without saving, click
Cancel.

Deleting a KPI
Delete an existing KPI belonging to a model in the solution.

Procedure
1. Click Administration > Solution Administration > Configuration Tools > Key Performance

Indicators > KPI Definition.
2. Select a KPI.
3. On the action bar, click Delete.

Chapter 4. Configuring the solution 127



Note: In the KPI Definition window, you cannot delete a modeled KPI. Within the solution, you can
delete only dashboard KPIs.

Configuring hotspot analysis
1.6.0.1 1.6.0.2

Use the Hotspots tool to configure hotspot analysis definitions for the solution. Hotspot analysis can
highlight patterns of data in relation to time and position on the geospatial map. As an administrator you
can create a hotspot analysis definition, update an analysis that is already listed, or delete a hotspot
analysis definition from the solution.

A hotspot is a colored circle on a geospatial map that represents a cluster of data items that are collected
and analyzed based on criteria that you define. The properties that can be analyzed are the source, the
map position, and the start time of the data items. The data items that are selected for a hotspot are given
a percentage score that is based on the result of the analysis and a corresponding color in the range
yellow to red.

When you create a hotspot analysis definition, use the Filter Panel tool to assign that analysis to a filter
pane. That analysis is then available for selection on the filter panel in the user interface. The settings on
the filter panel, with the hotspot analysis definition, control the data analyzed and the generation of
hotspots on the map.

You can configure the following criteria for the data analysis and view the result in the form of hotspots
on the map.

Data sources
Select the data sources that you want to analyze from the available list. In general, to maximize
efficiency and ease of interpretation of the analysis result, select no more than two or three data
sources.

Analysis type
Select the type of analysis to be carried out on the data sources that you specified. The analysis
type is defined by distance and correlation rules. The rules are applied by matching data
according to the source, the position, and the start time of the data items. A score is then
calculated for the collected data items. The basis for the analysis is detailed in Table 33 on page
130.

Distance limit
Define the maximum distance that governs the analysis of the data items for a hotspot. Each data
item that is added to a cluster has at least one other item in the cluster that is within the
maximum distance. The center and location of the cluster is the position at the center of the
clustered items. The radius of the cluster is the distance from the center to the position of data
item most distant from the center point.

Time limit
An extra option to narrow the criteria is to define the time period that governs the analysis of the
data items for a hotspot. Each data item selected is within the maximum distance and time
interval when tested against at least one other data item from each of the specified data sources.

Number of data items
Define a threshold for the minimum number of data items that are required to generate a hotspot
on the map.

Note: Data items can overlap in time, but it is only the interval between the start date and time of each
that is used to determine whether they are related and in a hotspot.
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Analysis type

The analysis type defines how data items are collected in a cluster and represented by a hotspot on the
geospatial map. The type of analysis to be carried out is defined by the time, distance, and the data
source relationship rule that is applied to the data items. A cluster of data items accumulates until it
reaches the point at which no other items are found according to the rules applied.

A score is calculated for the collected data items in the cluster. The score is awarded based on the
proportion of data items in the cluster that adhere to the relationship rule. The ratio of the related data
items in the cluster to the number of data items collected in the cluster is expressed as a percentage that
ranges from 0% to 100%. The percentage score is represented by the color of the hotspot on the map. The
color range is from yellow to red representing the scores from 0% to 100%.

Note: The relationship rule is that a data item is within the maximum distance (and the time interval, if
applicable) of either:
v Another item from each data source in the analysis, or
v One other item that is within the maximum distance of an item from each of the other data sources in

the analysis

The following table shows, for each analysis type, what criteria must be met for items to be clustered,
and how the scores are awarded.
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Table 33. The criteria for data item collection and testing in each type of analysis

Analysis type
Step 1: Clustering data
items

Step 2: Generating a
hotspot on the map Step 3: Scoring a hotspot

A. Cluster by distance 1. From one of the
specified data sources

2. With a property that
contains a point map
position

3. Within the specified
distance when tested
against at least one
other data item

4. Within the threshold for
the minimum number
of data items

No further testing required The percentage is
calculated from the
proportion of data items in
the cluster that are related
based on the distance
between them. The score in
this analysis type is always
100% and so the color of
the hotspot is always red.

B. Cluster by distance and
correlate data sources

Within the specified distance
when tested against at least
one data item from each of
the specified data sources

The percentage is
calculated from the
proportion of data items in
the cluster from different
data sources that are
related based on the
distance between them.
The score must be greater
than 0% to display a
hotspot on the map,
otherwise the cluster is
hidden. The score can be
up to maximum of 100%
for a single hotspot.

C. Cluster by distance and
correlate data sources with
time

Within the specified distance
and time interval when tested
against at least one other
data item from each of the
specified data sources

The percentage is
calculated from the
proportion of data items
from different data sources
that are related based on
the distance and time
between them. The score
must be greater than 0% to
display a hotspot on the
map, otherwise the cluster
is hidden. The score can be
up to maximum of 100%
for a single hotspot.

Hotspot score

The following table shows an example of how the score is calculated when a hotspot analysis definition
of Cluster by distance and correlate data sources is run with the Boundary set to a city area on the map.
The Date & Time filter is set to cover a one week period. The data items that are represented on the map
are street light outages and petty crime reports. Three of the hotspots that are generated by the analysis
are examined in the table.

Table 34. Example of hotspot scoring

City area data item
analysis Hotspot 1 Hotspot 2 Hotspot 3

Total number of data items
collected in the cluster

40 20 20

Number of related data
items from different data
sources in the cluster

30 10 4
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Table 34. Example of hotspot scoring (continued)

City area data item
analysis Hotspot 1 Hotspot 2 Hotspot 3

Calculation 30/40 *100 = 75 10/20 * 100 = 50 4/20 * 100 = 20

Score per cluster 75%= Red 50% = Orange 20% = Yellow

In this example, you can first observe the position of the data items on the map, representing reports of
street light outage and petty crime. Then, run the data analysis. You can see that there is a significant
number of related data items that are collected in clusters. You can identify where these related items
occur in hotspots on the map. You can also see that hotspot 1 has the highest number of related items
when compared with hotspots 2 and 3. The data indicates that a high level of petty crime occurs near to
street light outage at the location of hotspot 1. You might want to act based on this data to prioritize
street light repairs at that location.
Related concepts:
“Analyzing data hotspots” on page 385
Use the Map tab to analyze data, for the areas that you select on the map, in the form of hotspots that
are generated by a predefined analysis. The hotspots view assists you in monitoring, managing, and
responding to key issues.

Creating an analysis definition
1.6.0.1 1.6.0.2

Configure the parameters for a data analysis definition that can be associated with geographical areas on
the map. The analysis has the potential to indicate patterns of data by displaying hotspots on the map.

About this task

To create an analysis definition, complete the form according to the procedure.

Procedure
1. To access the Hotspots configuration tool, click Administration > Solution Administration >

Configuration Tools > Hotspots.
2. Click Create.
3. Enter a name for your analysis definition and optionally a brief description.

Note: Only the name of the analysis is displayed in the user interface, not the description. To assist
users, enter a name that reflects the purpose of the analysis.

4. To choose the data sources that are required for your analysis, in the Available data sources field,
select one or more check boxes.

5. To select a threshold for the number of items that are required to form a hotspot, in the Minimum
data items field, enter the number of data items.

6. Select an analysis from the list in the Analysis type field.

Note: The data sources that you select must comply with the required specifications of the analysis
type that you select.

Option Description

Cluster by distance v At least one data source

v Maximum distance between data items
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Option Description

Cluster by distance and correlate type v At least two data sources

v Maximum distance between data items of different
data sources

Cluster by distance and correlate type with time v At least two data sources

v Maximum distance between data items of different
data sources

v Maximum time interval between data items of
different data sources

7. Enter a distance and unit of measurement in the Maximum distance fields.
8. If the analysis type that you selected requires a time interval specification, enter a time interval and

unit of measurement in the Maximum time interval fields.
9. Click OK.

Results

The analysis view that you defined is displayed in the list of analyses and can be selected for edit or
deleted from the solution. All the analyses in the list are also available for configuration in the Filter
Panel configuration tool.

What to do next

To run the analysis in the user interface, configure the analysis for display on the filter panel in the
operations view. Click Configuration Tools > Filter Panel. For more information about filter panel
configuration, see the link at the end of the topic.
Related concepts:
“Configuring the filter panel” on page 114
In the Solution Administration view, you can decide how you want to group data sources. Then, for each
group, you can configure a pane that is displayed in the filter panel. The data sources that you select are
listed in the pane.

Configuring location maps
In the System Administration view, you can customize location maps for display on the Location Map
tab. The Location Map tab is part of the content panel on the operations views.

On the Location Map tab, you can select a specific location map from the menu. On the Map tab of the
content panel, a marker indicates where location maps are available.

You can customize on the Location Map tab:
v A map, diagram, or plan to display on the Location Map tab.
v Areas within location maps to enable data items that are associated with those areas to be displayed on

location maps.
v A hierarchy of location maps to enable a menu on the Location Map tab and markers on the Map tab.

Menu items are displayed in alphabetical order. Location maps are divided by:
– Collection depending on where on the geospatial map the location maps occur
– Category depending on the type of location map in the collection
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In the Location Maps tool, you can easily create, view, update, and delete location maps, collections, and
areas. You can create new categories. You can delete existing categories, but you cannot update existing
categories. Categories, collections, location maps, and areas are hierarchical as detailed in the following
definitions.

Category
A category contains one or more collections of location maps. A category assists the user by
organizing the menu so that location maps can be found easily. For example, a category that is
called Police Stations contains collections of location maps that represent police stations in a city.

Collection
A collection contains one or more location maps. A collection usually consists of a set of maps
and is represented by a marker at a position on a geospatial map. A collection must be assigned
location coordinates and a category. For example, a collection that is called Fourth Precinct
contains location maps that are associated with a police station in the fourth precinct of a city.

Location Map
A location map is any image that represents a location in the required detail. A location map
must be assigned to a collection. For example, Floor 1 is a location map of the first floor of a
building. This location map is assigned to a collection of maps for the Fourth Precinct police
station within a category called Police Stations.

Area An area is a user-defined shape, a polygon, that outlines a portion of a location map. An area
must be assigned a name and description. The name is a unique identifier that represents that
portion of the location map. Any data item with an area identifier that is received by the solution,
is displayed on all location maps that have that area that is defined. For example, the Fourth
Precinct map collection has an area that is called Staircase on the Floor 1 and Floor 2 location
maps. There is also an option to assign a parent identifier to an area.

Use the parent identifier on more than one location map to create a hierarchy of areas. For example,
create areas to represent the seating stands on the first floor of a sports stadium. Each seating stand is
defined on the detailed location map of the first floor of the stadium. Additionally, give each seating
stand a parent identifier to indicate that it is on the first floor of the stadium. A data item with an area
identifier for one of the seating stands is displayed on the detailed seating map of the first floor. This
data item is also displayed on an overview location map of the stadium. The first floor area on the
overview map has the same area identifier as the parent identifier that is used for the seating stand areas.

For more information about configuring location maps, see the link at the end of the topic.
Related concepts:
“Location Map tab” on page 375
Use the Location Map tab to obtain current information about what is happening at a specific location.
You can obtain information from data items marked on the location map. Select your data sources on the
filter panel and your location map from the list of maps available in the solution. A location map in IBM
Intelligent Operations Center is a map, diagram, or plan with predefined areas for interaction, for
example, seating areas in a major sports stadium.

Viewing and uploading map images
As an administrator, you can view or upload map images that are available to use when you are creating
location maps in the solution.

About this task

You can create a map that is displayed on the Location Map tab. As a precursor to that task you can
upload map images. Any images that you upload are then available to use when you create a new
location map.
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Procedure
1. Click Administration > Solution Administration > Configuration Tools > Location Maps.
2. Click Location Map Images. All available images are displayed.
3. Click Upload.

Note: The accepted formats for location map images are PNG, JPG, GIF, and SVG.
4. Locate your map image file and click Open.

Results

The image is added to the available images displayed when you click Location Map Images.
Related tasks:
“Creating, updating, or deleting a location map”
As an administrator, you can create, update, or delete a location map in the solution.

Creating, updating, or deleting a location map
As an administrator, you can create, update, or delete a location map in the solution.

About this task

You can create, edit, or delete a map for display on the Location Map tab.

To create a location map in the solution, use the wizard as described in the procedure. To create a
location map, complete the first two tabs. Completion of the third tab is optional and can be done at a
later stage. On any tab, you can cancel, or move back to a previous tab.

Procedure
1. Click Administration > Solution Administration > Configuration Tools > Location Maps.
2. Click Create.
3. Choose your map name and image.

a. In the Map Title field, enter a name for your map.
b. Beside the Map Image field, click Browse.
c. Select the map image from the pictures of available images. The image file name that you select is

entered automatically in the Map Image field and the map image is displayed on the tab.
d. To move to the next step, click Next.

4. Choose your map collection and category.
a. Click Choose Existing Category, and in the Category list, choose an existing category for your

location map. Alternatively, click Create New Category, and in the Category Name field, enter the
name of a new category.

b. Click Choose Existing Collection, and in the Collection list, choose an existing collection for your
location map. Alternatively, click Create New Collection, enter the name of a new collection and
its latitude and longitude coordinates.

5. Optional: Click Next to create the named areas for your location map. For more information about
configuring areas on a location map, see the link at the end of the topic.

6. To complete creation of your new location map and exit the wizard, click OK.
7. To save your new location map for display on the Location Map tab, click Save.

Results

After a browser refresh, your changes are displayed on the Location Map tab on the content panel of the
operations views.
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What to do next

Click a name on the menu to highlight it. You have the following options:
v To update a location map, edit the appropriate fields on the configuration tabs as described in the

procedure.
v To update a collection name and position coordinates, enter your changes on the Update Collection

window and click Save.
v To delete a location map, or collection, click Delete.
Related tasks:
“Viewing and uploading map images” on page 133
As an administrator, you can view or upload map images that are available to use when you are creating
location maps in the solution.
“Creating, updating, or deleting areas on a location map”
As an administrator you can create, update, or delete areas for display on your location map.

Creating, updating, or deleting areas on a location map
As an administrator you can create, update, or delete areas for display on your location map.

Before you begin

To create areas when you are creating a location map with the wizard, click Next to move to the Create
Named Areas tab.

To update existing areas on a location map, click Administration > Solution Administration >
Configuration Tools > Location Maps > Create Named Areas.

Procedure
1. To draw an area on the map, activate the drawing tool by clicking the polygon symbol in the corner

of the window. Click the required start position on the map and then click each corner of a polygon
to draw your shape on the map. Double-click to finish the polygon. Click the hand symbol to exit the
drawing tool. A new area is displayed on the map, by default it is highlighted in blue.

2. Enter a name and description for your new area.

Note:
To create an area on the location map, the limit for the name is 64 characters. For data sources whose
data items are displayed on the location map, a property in your data source contains a value for the
area name. The maximum length of the area name property must be long enough to accommodate the
area name.

3. Optional: To assign a parent area to the area, select from the list of names in the Parent area name
field.

4. To keep your new area, click Add, or to delete the new area, click Cancel.
5. To save the new area for display on the Location Map tab, click Save.

Results

After a browser refresh, your changes are displayed on the Location Map tab on the content panel of the
operations views.

What to do next

To update the name, description or parent identifier details for an area, click the name of the area to be
updated. You have the following options:
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v To confirm an update to an area on the map, click Update

v To undo an update to an area on the map, click Cancel

To delete an area, click the delete icon beside the area name. To save and see your confirmed update or
deletion on the Location Map tab, click Save.
Related tasks:
“Creating, updating, or deleting a location map” on page 134
As an administrator, you can create, update, or delete a location map in the solution.

Configuring standard operating procedures
A standard operating procedure is a set of instructions that describes all the relevant steps and activities
of a process or procedure. Standard operating procedures are essential to an organization to deliver
consistent, measured, high-quality responses to complex and unpredictable events.

The following list outlines how standard operating procedures are created and used:
1. A list is created of all the issues that might occur in a target environment and need a managed

response. The list is created based on previous experience and applied knowledge.
2. A subject matter expert writes a procedure to manage the issue, for example:

v Who is involved?
v When are they involved?
v How are they involved?
v What supplies the updated data or receives an action?

3. When the response procedure is defined, a standard operating procedure administrator configures a
standard operating procedure definition.

4. Standard operating procedures can be started manually or automatically during run time.
5. Standard operating procedure activities can be tracked and integrated in the IBM Intelligent

Operations Center user interface.
Related tasks:
“Routing data from your data source” on page 111
For the data that is received from your data source, set routing expressions that define how the data is
processed by the solution. Data items that match the required expression or combination of expressions
are routed to the selected destination.

Configuring standard operating procedure definitions
When you define a standard operating procedure, you define activities that are included in the standard
operating procedure. You can specify the order in which some or all of the activities in a standard
operating procedure are executed. For example, you can specify that a particular activity is not started
until the previous activity is completed or skipped. You also assign owners and monitors to the standard
operating procedure.

About this task

Only authorized standard operating procedure authors and administrators can configure standard
operating procedure definitions. Authorized standard operating procedure authors are listed in the
SopAuthorRoles system property. Authorized standard operating procedure administrators are listed in
the SopAdminRoles system property.

You have the option of saving a draft and not sending it for approval until a later date. A standard
operating procedure cannot be launched until it has been approved.
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Procedure
1. In the Solution Administration view, click Configuration Tools > Standard Operating Procedures >

Definition.
2. Click Create.
3. On the Basics tab, enter a Name and a Description for the standard operating procedure definition.
4. For General Settings, if you want the activities that are associated with the standard operating

procedure to be completed in the specified order, select Activities are done in order.
5. For References, to add a reference to the standard operating procedure, use the following substeps:

a. Click Add Reference.
b. From the Reference list, either select a reference that has already been added to the library, or to

add a reference to the library, do the following substeps:
1) Select Add New, and then click Add.
2) Enter values for Name, and for URI. You must enter a fully qualified URI.
3) Optionally, enter a description.
4) Click Add.

The reference is added and automatically marked as private.

The References table lists the references that you have added. To delete a reference, click the Delete
icon next to the reference.

6. Click Next.
7. Optional: On the Roles tab, specify the owners that you want to be responsible for monitoring the

standard operating procedure:
a. Select the appropriate role names from the Available Roles list, and then either drag the names to

the Selected Roles list, or click Add.
b. For each selected role, select an option to specify what access they have:

v If you want a role to be able to monitor activities that are associated with the standard
operating procedure, select Reader.

v If you want a role to be able to monitor and complete activities that are associated with the
standard operating procedure, select Owner.

c. To remove role names from the Selected Roles list, select the appropriate role names, and then
either drag the names to the Available Roles list, or click Remove.

The users that are defined in the SopAdminRoles system property are default owners and readers.
8. Click Next.
9. On the Activities tab, to add an activity to the standard operating procedure, click Add.

10. To create an activity definition, in the Create Activity Definition window, do the following substeps:
a. If the activity is mandatory to the standard operating procedure, select the Required check box.
b. 1.6.0.2 If you want the activity to start automatically, select the Autostart check box.
c. For Name, either enter a name to add an activity, or select a name from the list to add a copy of

an activity that has already been defined. If you select an existing activity, the remaining fields
are populated with values from that activity's definition.

d. Optional: For Roles, select an activity owner from the Owners list, and select an activity monitor
from the Readers list. Alternatively, enter a comma separated list of user names for either one or
both of the role types. The users that are defined in the SopAdminRoles system property are
default owners and readers.

e. Optional: For Duration, enter a numerical value, and select a measurement unit from the list.
f. Optional: For Description, enter a description of the activity.
g. Select the type of activity from the Activity Type list:
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Manual Activity An activity that is done manually by the owner. Provide
details in the Description field.

Automation Activity An activity that initiates and tracks a particular work
order in IBM SmartCloud® Control Desk 7.5.1. Select a
predefined work order from the list.

If-Then-Else Activity A conditional activity that allows branching based on
specific criteria. Select values for Then and Else.

Notification Activity An activity that displays a notification window that
contains an email template for the activity owner to
complete, and then sends an email notification.
Notification templates are stored as references in the
reference library. To select the email template that will be
displayed to the owner, select a reference from Reference
name. To preview the email template, click Preview.

REST Service Activity An activity that creates a REST service call:

v For REST service, enter or select a REST service URL.

v For USER ID, enter a user ID to access the REST
service.

v For Password, enter a password to access the REST
service.

SOP Activity An activity that launches another standard operating
procedure. From the SOP list, select the name of a
standard operating procedure.

h. Optional: To add a reference to the activity, follow the substeps that are given in Step 5 on page
137.

i. Click Add.

The activity is appended to the list of activities.
11. Edit the activities in the list:

v To view a summary of the details for an activity, expand the name of the activity.
v If you selected the Activities are done in order option for the standard operating procedure, to

reorder the activities, click and drag the activity names.
v To edit an activity, click its name, and then click Edit. Edit the activity as required, and then click

Save.
v To delete an activity, click its name, and then click Delete.

12. Click Next.
13. On the Summary tab, review the summary information for the standard operating procedure, and

then click Save. The standard operating procedure definition is displayed in the list.
14. Optional: To submit the standard operating procedure definition for approval, click its name in the

list, and then select Submit for Approval from the Submit for Approval list. Alternatively, to delete
the draft standard operating procedure definition, select Discard Draft from the list.

Related concepts:
“Defining standard operating procedure roles” on page 97
The standard operating procedure component obtains the current authentication credentials to determine
what actions each user is authorized to do. Each user is authorized to do standard operating procedure
actions that are based on the LDAP Roles that the user is assigned to, and must match the distinguished
name (DN) that is used in association with the standard operating procedure objects.
Related tasks:
“Configuring system properties” on page 189
View, create, modify, and delete system properties in the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent Operations Center.
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Related information:

IBM SmartCloud Control Desk Version 7.5.1 product documentation

Copying, deleting, and refreshing definitions
Instead of creating a new standard operating procedure definition each time, you can copy an existing
standard operating procedure definition, and then use it as the starting point for creating another
definition. You can also delete and refresh definitions.

Procedure

In the Solution Administration view, click Configuration Tools > Standard Operating Procedures >
Definition.
v To copy a standard operating procedure definition, click its name in the list, and then click Copy. A

copy of the definition is added to the list. For example, if the name of the original definition is SOP1,
the copy is automatically named Copy of SOP1. You can edit the copied definition, and rename it.

v To delete a standard operating procedure definition, click its name in the list, and then click Delete.

Note: All versions of the standard operating procedure definition, and any instances of the standard
operating procedure that have been triggered and are running, are deleted.

v To refresh all the standard operating procedure definitions in the list, click Refresh. The definitions are
refreshed with updates that have been made by other administrators.

Working with drafts and approvals
When you create a standard operating procedure definition, a draft version is saved initially. When you
submit a draft version for approval, a version of the standard operating procedure definition is saved,
where the version name is the approval time stamp value. You can create another draft that is based on
an approved version.

About this task

After you select a standard operating procedure definition, select the version of the definition that you
want to work with from the Version list:
v If you select Draft from the Version list and the draft has not been submitted for approval, the Submit

for Approval list is displayed.
v If you select Draft from the Version list and the draft has been submitted for approval, the Approve

list is displayed.
v If you select an approved time stamp value from the Version list, the Create Draft list is displayed.

You can have a maximum of only one draft version in progress for each standard operating procedure
definition. If a draft version exists already, the Create Draft list is not displayed.

Procedure

Working with drafts that have not been submitted for approval:
v To submit a draft for approval, select Submit for Approval from the Submit for Approval list.
v To discard a draft, select Discard Draft from the Submit for Approval list.
Working with drafts that have been submitted for approval:
v To approve a draft, select Approve from the Approve list.
v To disapprove a draft, select Disapprove from the Approve list. The version name is changed from the

time stamp value back to Draft.
Working with an approved version:
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v To create a draft that is based on an approved version, select the version name from the Version list,
and then select Create Draft from the Create Draft list.

Viewing and editing definitions
Use the following procedure to view and edit standard operating procedure definitions.

About this task

You can edit only a draft version of a standard operating procedure definition. For more details about
specifying definition settings, see the topic about configuring standard operating procedure definitions in
this section.

Procedure
1. In the Solution Administration view, click Configuration Tools > Standard Operating Procedures >

Definition.
2. Click the name of the standard operating procedure definition that you want to view or edit.
3. From the Version list, select a version. If you want to edit the standard operating procedure definition

and the Version list contains only approved versions, you must create a draft version; select the
version that you want to edit, and then click Create Draft.

4. Choose one of the following options:
v To view basic information about the standard operating procedure definition, expand Details.
v To edit basic information for the standard operating procedure definition, click Edit, and then make

your changes. To save your changes to the basic information, click Save. Alternatively, to cancel
your changes and close the definition, click Cancel.

v To either view or edit activities, roles, and references, or to view the change log and instances for
the standard operating procedure definition, click the following tabs:

Activities A list of the activities that are associated with the
definition is displayed.

v To view details for the activity, expand the name of an
activity.

v To add an activity, click Add.

v To edit an activity, click the name of the activity, and
then click Edit.

v To delete an activity, click the name of the activity, and
then click Delete.

Roles A list of roles and associated access types is displayed.
To edit the roles, click Edit.

References A list of the references that are associated with the
definition is displayed.

v To view details for the reference, expand the name of a
reference.

v To add a reference, click Add.

v To edit a reference, click the name of the reference, and
then click Edit.

v To delete a reference, click the name of the reference,
and then click Delete.

Change Log The change history of the standard operating procedure
definition is displayed.
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Instances A list of the instances of the standard operating
procedure that are running or have completed is
displayed in a table. For more information about instance
status and editing instances, see the link at the end of the
topic.

Related tasks:
“Viewing and editing instances of a standard operating procedure”
For a standard operating procedure definition, you can review the instances of the standard operating
procedure that have been launched. You can view an instance in the Standard Operating Procedure
Details window, where you can edit an instance, or change the status of an instance.

Launching standard operating procedures
You can manually launch an instance of a standard operating procedures in the Solution Administration
view.

About this task

When you launch a standard operating procedure, the most recently approved version is launched.

Procedure
1. In the Solution Administration view, click Configuration Tools > Standard Operating Procedures >

Definition.
2. Click the name of the standard operating procedure definition for which you want to launch an

instance.
3. From the Definition Actions drop-down list, select Launch. A message is displayed that confirms that

an instance of the standard operating procedure has been created.

Viewing and editing instances of a standard operating procedure
For a standard operating procedure definition, you can review the instances of the standard operating
procedure that have been launched. You can view an instance in the Standard Operating Procedure
Details window, where you can edit an instance, or change the status of an instance.

About this task

You can view the previous and current instances of a standard operating procedure definition. An
instance of a standard operating procedure is created each time that the standard operating procedure is
launched, whether automatically or manually.

Procedure
1. In the Solution Administration view, click Configuration Tools > Standard Operating Procedures >

Definition.
2. Click the name of the standard operating procedure for which you want to view the instances.
3. From the Version list, select a version.
4. Click the Instances tab. The table indicates the status of each instance, where the status can be active,

started, completed, or stopped. For each instance, the table also indicates the start time, the end time,
and the activity status. For the activity status, each column is headed by a status icon. The column
indicates the number of activities in the instance with that status. The icons indicate the following
status values:
v Completed status indicates the number of activities that have been completed.
v Active status indicates that the standard operating procedure has been launched and the instance is

active.
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v Waiting status indicates the number of activities that are waiting to be started.
v Skipped status indicates the number of activities that have been skipped by the owner.
v Automation exception status indicates that a problem occurred in IBM SmartCloud Control Desk

7.5.1 with the number of automated activities that are indicated.
5. In the table, double-click an instance.
6. In the Standard Operating Procedure Details window, choose from the following options:

v To edit basic information for the standard operating procedure instance, from the list, select Edit. To
save your changes to the basic information, click Save. Alternatively, to cancel your changes, click
Cancel.

v To either view or edit activities, references, and roles, or to view the comments and change log for
the standard operating procedure instance, click the tabs. 1.6.0.2 You can also view or edit
events.

v To stop the instance, if it has been started, select Stop.
v To start the instance, if it has been stopped, select Start.
v To export details of the standard operating procedure instance, from the list, select Export.
v To add a comment to the instance of the standard operating procedure, from the list, select Add

Comment.

Exporting and importing standard operating procedure definitions
You can export your standard operating procedure definitions as an XML file, and import a previously
exported standard operating procedure definitions file.

Procedure

In the Solution Administration view, click Configuration Tools > Standard Operating Procedures >
Definition.
v To export your standard operating procedure definitions to an XML file, do the following substeps:

1. From the Definition Actions drop-down list, select Export All.
2. In the window that is displayed, click Save File, and then browse to a location to save the exported

standard operating procedure definitions.
v To import standard operating procedure definitions from a previously exported XML file, do the

following substeps:
1. From the Definition Actions drop-down list, select Import.
2. In the Import Standard Operating Procedures window, choose a file to upload. The imported

definitions are displayed in the list of standard operating procedure definitions. You can import a
standard operating procedure definition that has the same name as an existing standard operating
procedure definition. In this case, the existing standard operating procedure definition is not
overwritten. Instead, two standard operating procedure definitions with the same name are
displayed in the list of definitions.

Working with references
The reference library contains links that are useful and easily accessible for completing standard
operating procedures; for example, phone lists, email addresses, forms, and notification templates. You
can add, edit, delete, and launch references in the standard operating procedure reference library.

About this task

Only authorized reference librarians can edit the reference library. Authorized reference librarians are
listed in the ReferenceLibrarianRoles system property.
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Procedure

In the Solution Administration view, click Configuration Tools > Standard Operating Procedures >
References.
v To add a reference to the library, do the following substeps:

1. Click Add.
2. Enter values for Name, and for URI. You must enter a fully qualified URI.
3. Optional: Enter a description.
4. If you want the reference to be private, select the Private check box.
5. Click Add. The reference is displayed in the table.

Note: Private references are not displayed in the table unless you select the Show Private check
box.

v To view private references, from the drop-down list at the top of the table, select the Show Private
check box.

v To view archived references, from the drop-down list at the top of the table, select the Show Archived
check box.

v To edit a reference in the library, do the following substeps:
1. Select the reference.
2. Click Edit, and then edit the values.
3. Either select or clear the Private check box as required. Private references are not displayed in the

table unless you select the Show Private check box.
4. Either select or clear the Archive check box as required. Archived references are not displayed in

the table unless you select the Show Archived check box.
5. Click Save.

v To delete references from the library, select the references that you want to delete, and then click
Delete.

v To open a reference in the library, select the reference, and then click Launch URI. The reference URI is
opened in a new browser window.

Related tasks:
“Configuring system properties” on page 189
View, create, modify, and delete system properties in the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent Operations Center.

Creating notification templates
You can add a notification template to the reference library that can be used to send an email; for
example, in a notification activity.

Procedure
1. Create a text file that contains the email template, and then post the text file to a website. An example

email template is shown below: The following text shows example template text:
To:
Subject:This is a test notification
Body:This is some text to show how
you can add multiple lines for
the body.

The To, Subject, and Body fields are all optional.
2. In the Solution Administration view, click Configuration Tools > Standard Operating Procedures >

References.
3. Click Add.
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4. Enter a Name for the notification template.
5. Enter the URI to the text file that contains the notification template.
6. Enter a description. Ensure that the first line of the description contains only the keyword

NOTIFICATION. You can add further description details to subsequent lines.
7. Click Add.
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Chapter 5. Integrating the solution

Products and services can be integrated with the IBM Intelligent Operations Center. The IBM Intelligent
Operations Center can incorporate the relevant data and updates.

Incoming data items can be related to key performance indicators (KPI) that are monitored by the IBM
Intelligent Operations Center. Data coming into IBM Intelligent Operations Center can also be related to
standard operating procedures.

Examples of systems that can be integrated
Products and services can be integrated with the IBM Intelligent Operations Center.

Examples of systems and services:
v Systems reporting on public safety issues.
v Systems reporting on traffic events.
v Systems reporting on water quality and usage.
v Systems providing data on outages and status of related work orders.

These systems must be able to communicate with the IBM Intelligent Operations Center and send data
items and measurements in the supported data format to the IBM Intelligent Operations Center.

Integrating with data sources
A data source is used to exchange information between the IBM Intelligent Operations Center and
external systems.

In IBM Intelligent Operations Center, data sources provide a generic format for exchanging data. Data
source configuration is compatible with emerging techniques, such as web services, while offering
enhanced capabilities. Data sources provide the following capabilities:
v Flexible geographic targeting using latitude and longitude shapes and other geospatial representations

in three dimensions
v Multilingual and multi-audience messaging
v Phased and delayed effective times and expirations
v Enhanced message update and cancellation features
v Digital encryption and signature compatibility
v Digital images and audio facilities

Data items are self-contained data messages that can be sent or used by components of the solution. Data
items can be published to topic queues and read by all potentially interested subscribing IT systems. Data
source configuration standardizes content so multiple domains can send and receive events in a common
format using common conventions. The standard defines the mandatory and optional fields in the data
item and the acceptable values for those fields. Data item processing management can mediate between
earlier formats and the standardized format. Data sources can be configured to handle day-to-day
operations in addition to emergency situations. For more information about the configuration of data
items, see the link at the end of the topic.

The data source configuration helps minimize data exchange per item. Because data items are formatted
in XML, the data format can be written and read by various systems, thereby preventing the exchange of
meaningless data or data creating dangerous confusion.

© Copyright IBM Corp. 2011, 2013 145



IBM Intelligent Operations Center provides persistent storage of data items and a standard interface for
presenting them.

While the entire data item is accepted by the IBM Intelligent Operations Center, some data can be used to
calculate key performance indicators (KPI), to activate standard operating procedures, or other
customized applications.

IBM Intelligent Operations Center uses the WebSphere Message Broker to integrate data items.
Related concepts:
“Configuring a data source” on page 99
Use the Data Sources tool to configure a data source that supplies data to IBM Intelligent Operations
Center.

Guidelines on preparing data for the solution
To view and filter the data that you require on the maps and list in IBM Intelligent Operations Center,
prepare the data in your data source. Then, configure your data source in the Solution Administration
view.

Prepare in your data source the data that you want to be received by IBM Intelligent Operations Center.
To enable IBM Intelligent Operations Center to receive the data, include the minimal property values that
are required by the system and the key properties values that suit your operation. The following list
highlights important considerations on acquiring data and in relation to the minimal and key property
values. For more detailed information about configuring your data source in IBM Intelligent Operations
Center, see the related link.

Configure the data source correctly
If all of the following conditions are met, the data import process fails, and an error is displayed:
v You import data from a data source into the solution where the start and end date columns for

the solution are configured as string values.
v The data source start and end date columns are not string values.
v The data source time column contains values that are not time type values.

To prevent the import process from failing, configure the data source so that the start date and
end date columns are string data types. Also, leave the time column in the data source empty.
The data import process correctly assigns the default time values.

Acquire the data
1.6.0.1 1.6.0.2 If you want the system to acquire data from an SQL Server database, install

a Microsoft JDBC driver to create the data source. This driver is not supplied with IBM Intelligent
Operations Center.

1.6.0.1 1.6.0.2 Data for boundary
If you have a data source that contains data for named areas to be marked on the geospatial map,
you can set the area boundary conditions for the data that you want to view. The solution can
filter data for display in relation to areas as follows:
v Data that is used for display on the geospatial map in an operations view
v Data that is used for generating hotspots that are displayed on the geospatial map in an

operations view
v Data that is used for the KPIs that are displayed in an area status view

Polling interval
Set the polling interval of your data source to ensure that the system receives updates according
to the time interval that you require. This setting indicates how often the system checks for new
data. Set a value of 0, if you want to receive the initial data and never look for updates.
Otherwise, set the time interval for receipt of updates.
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Area name
If you assign a property in your data source to hold area names from the location map, the data
from that data source cannot be displayed on the geospatial map. Data from the data source can
be displayed on the location map only.

Note: The database property must be able to contain the maximum number of characters that
occur in location map area names.

Last update date and time
The last update date and time property is a required property for database data sources if you
want to receive updates. For CSV files, the time stamp of the CSV file is the value that is used
automatically for this property.

Time zone offset
The time zone offset value is required for all data sources and affects the start and end time
values. Set the value to 0 if your data source is in the same time zone as the system. The value is
measured in minutes but must be divisible by 30.

Shape If the position of your data item is in well-known text (WKT) format, select the shape option
under location properties. You must also map the property from your data source that supplies
the position value.

Note: To represent the data with points or shapes on the map, coordinates must be in WKT
format. Data that is received for the points or shapes that are supported must be in a valid WKT
format. This requirement applies to all the supported methods of data input: database tables, CSV
files, and user input through the user interface.

Latitude and longitude
Latitude and longitude can be supplied as separate properties when data is received from
database tables or CSV files.

Key & full properties
Assign your data source properties to be key properties if you want to see the data in the list and
preview card format in the operations and status views. Latitude and longitude can also be
supplied as separate properties when data is received from database tables or CSV files.

Filter enumerated values
Property values that are received at run time, which are known as 'enumerated values', can be
used for filtering data on the map or list tab. To use values for this purpose, when you configure
the data source, set the Key property field to Yes and the Filter enumerated values field to Yes.

Allowed values
Property values that are entered at data source configuration time, which are known as 'allowed
values', can be used for filtering data on the map or list tab. To use values for this purpose, enter
the values in the Allowed values field when you configure the data source. You must also set the
Key property field to Yes and the Filter enumerated values field to No.

Note: This configuration also restricts the values that a user can enter when a new data item is
added on the map or list tab.

Used as an index ID
If you want data updates in the source to update existing data in the solution, set a value in the
ID field. If you do not provide a value for this field, each data item is considered a new data item
when the source is updated. The ID value must be unique in your source. If the last update date
and time fields and fields other than this ID are modified at source, the item is updated.

Note: In this case, the source is the system of record and changes that are made in IBM
Intelligent Operations Center are overwritten by source updates.

The following guidelines apply to CSV files only:
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v The first line of the CSV file must contain a list of the property names, which are separated by
commas.

v Each line after the first line of the CSV file must contain an identical number of values to match the
property names in the first line.

v There must be no extra commas at the end of any line and the number of commas on each line must
be the same.

v Apostrophes, single quotation marks, or double quotation marks are not supported.
v When a CSV file is processed by the system, the name is changed, for example,

Test3_processed_123.csv.
v To update an existing CSV file data source, place a file with the original name in the directory on the

application server. Every line of the CSV file is processed for each file that is received, so you might
want to remove existing entries to avoid duplication.

Related concepts:
“Configuring a data source” on page 99
Use the Data Sources tool to configure a data source that supplies data to IBM Intelligent Operations
Center.

DB2 data source
There are some conditions to consider when you are preparing a DB2 database data source.

Big integer and decimal data types

Some DB2 number data types are subject to rounding in the IBM Intelligent Operations Center user
interface. For example, decimal and big integer data type values are rounded to numbers of 16 digits or
decimals with 17 digits.

The IBM Intelligent Operations Center uses JavaScript, which has double-precision 64-bit format IEEE 754
values to represent numbers. This method provides 53-bit precision. Some DB2 data types, for example
decimal and big integer data types, allow higher levels of precision, up to 63 bits. The REST API services
can avail of the full range of possible values. However, when these values are displayed or submitted
through the user interface, they might be rounded to fit the lower precision limit of the JavaScript.

Elements of the user interface can be affected by this limit in the following ways:
v Viewing the data property value on the List tab, you see a different value to the value stored in the

DB2 database.
v Viewing the data property value on the preview card, you see a different value to the value stored in

the DB2 database.
v Entering data for the property in the New Item dialog cannot be completed and results in an error.

Character data type

If you have the character data type in your source DB2 database, it might result in unexpected behavior
when the data source is configured to use a routing expression. This behavior can occur because extra
spaces are incorporated in the message sent to WebSphere Business Monitor as result of data source
routing expression processing.

The character data type in DB2 is a fixed-length column. For example, declare a name property,
CHAR(20), and input a name that is shorter than 20 characters, "IBM". DB2 adds spaces to this value.
When the data is processed by the data import logic, an expression is evaluated. The data receiver sends
the characters "IBM" plus 17 empty character spaces to the routing destination and to the DB2 target table
for storage in the IBM Intelligent Operations Center. The result is that your data is not routed as you
expected.
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Defining named areas by using SQL
1.6.0.1 1.6.0.2

You might want to define a named area type data source that has many named areas. Instead of drawing
each named area polygon individually on the map, you can define the named area polygons by using an
SQL table. Then, create a data source that connects to a database to acquire the named area data from the
SQL table.

About this task

For the named areas to be created successfully, you must do the following steps in order. You must insert
the named area polygon data into the SQL table before you create the data source that acquires the data
from the SQL table. SQL data for a named area type data source is acquired only when the data source is
created. A named area type data source is not polled for updated data after the data source is created.

Procedure
1. Log on to the IBM Intelligent Operations Center data server, and then connect to a database.
2. Create a named area data source table. Ensure that the lengths of the properties in the table are large

enough to contain the values of the well-known text (WKT) format for the polygons that define your
named areas. If the properties are not large enough to contain the polygon values, the named areas
will not be created. For example, the following SQL commands create a table that is named
SAMPLE.NAMED_AREA.
drop table SAMPLE.NAMED_AREA;
create table SAMPLE.NAMED_AREA (
StartDateTime TIMESTAMP,
EndDateTime TIMESTAMP,
LOCATION VARCHAR(500),
NAME VARCHAR(30),
LastUpdateDateTime TIMESTAMP,
TIMEZONEOFFSET INTEGER,
INCIDENT_NUMBER VARCHAR(100),
PROBLEM VARCHAR(100),
CALL_DISPOSITION VARCHAR(100),
PRIORITY_NUMBER INTEGER
)

DATA CAPTURE NONE;

3. Insert the named area data into the named area table. The following example inserts a single polygon
into the table:
INSERT INTO SAMPLE.NAMED_AREA (
STARTDATETIME,
ENDDATETIME,
LOCATION,
NAME,
LASTUPDATEDATETIME,
TIMEZONEOFFSET,
INCIDENT_NUMBER,
PROBLEM,
CALL_DISPOSITION,
PRIORITY_NUMBER)
VALUES (
CURRENT_TIMESTAMP,
CURRENT_TIMESTAMP,
’POLYGON((-93.64833644901181 45.07616323264413,-93.54259304081118

45.0732538434894,-93.55083278690229 45.012607882373146,
-93.64970974003148 45.02037415319953,-93.64833644901181
45.07616323264413))’,

’Polygon_001’,
CURRENT_TIMESTAMP,
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0,’10021’,
’problem’,
’call_dispostion’,
’2’);

4. Log on to IBM Intelligent Operations Center, and create a data source by following the instructions in
the Configuring a data source section. Note the following points:
v On the Acquire tab, for the data source acquisition method, select Connect to a database.
v On the Basics tab, for Data for boundary, select Yes.

Results

In the operations views, in the Boundary pane on the filter panel, the named area that you defined in the
SQL file is displayed in the list of named areas for the data source.
Related concepts:
“Configuring a data source” on page 99
Use the Data Sources tool to configure a data source that supplies data to IBM Intelligent Operations
Center.
Related reference:
“Data source basic settings” on page 104
Choose settings on the Basics tab to provide the basic input and selections that are appropriate for your
data source.

Data item routing
IBM Intelligent Operations Center processes incoming data items to determine how information is
displayed.

Other products and services can be integrated with the IBM Intelligent Operations Center through the
message bus service. KPIs are monitored by the business monitoring service.

Data items are received by the IBM Intelligent Operations Center. The data items can be displayed on a
list, and can affect what is displayed in the user interface either on a geospatial map, or on a location
map. Data items that do not have corresponding KPI or standard operating procedure routing are
displayed according to the information that is received about the data item.

The configuration of the corresponding data source determines how data items are routed when they are
received into the system. The Data Sources configuration tool provides the following destination and
processing options:
v IBM Intelligent Operations Center
v Key performance indicator
v Standard operating procedure
v Integration topic

You can create multiple routing expressions that route data items to multiple destinations. However, take
care if one of the routing expressions has IBM Intelligent Operations Center as the destination. The other
routing expressions are evaluated only if the routing expression that routes the data items to IBM
Intelligent Operations Center evaluates to true.

Therefore, if you use the same property to route data items to multiple destinations, where one of the
destinations is IBM Intelligent Operations Center, the property must have the same value in each routing
expression. Otherwise, if the routing expression that routes the data items to IBM Intelligent Operations
Center evaluates to false, then none of the other routing expressions are evaluated. For example,
consider the scenario where you define the following routing expressions:
v If the value of property A equals ABC, route the data items to IBM Intelligent Operations Center.
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v If the value of property A equals DEF, route the data items to KPI processing.

In the previous scenario, data items are never sent to KPI processing. For a data item, if the value of A
equals ABC, the data item is imported into IBM Intelligent Operations Center. If the value of A equals DEF,
the data item is not imported into IBM Intelligent Operations Center at all and the second expression is
not evaluated.

For more information about the Data Sources configuration tool and data routing, see the link at the end
of the topic.

Key performance indicator

When you configure a data source, you can route data items to KPI processing by IBM Business Monitor,
so that they are incorporated into the calculation of KPI values. The definition of KPIs in a KPI model
determines how KPIs are displayed on the status views in the user interface, and also determines how
information from data items is processed. For example, if a KPI threshold is exceeded, the data item
might be flagged with a higher urgency or severity. An administrator can use the Key Performance
Indicators configuration tool to change or extend existing KPI models in IBM Intelligent Operations
Center. KPI models are initially created in IBM Business Monitor. For more information about configuring
and integrating KPIs, see the links at the end of the topic.

Standard operating procedure

When you configure a data source, you can route data items to a specific standard operating procedure. If
a data item matches the routing expression, a new instance of a standard operating procedure is created
that is based on the selected standard operating procedure definition. If an instance of the standard
operating procedure is already running, the data item is associated with the active standard operating
procedure instance. For more information about configuring and viewing standard operating procedures
definitions, see the link at the end of the topic.

Integration topic

You can add your own routing destination to the solution. You can create a WebSphere Application
Server integration topic and add it to the solution.

If you update the routing schema file with the custom properties for the data source that you want to
route to the integration topic, the routing schema file can be used to generate a set of Java JAXB classes.
Applications that are listening to the integration topic can use the routing schema file to convert an
incoming XML message to Java classes that the applications can then process.
Related concepts:
“Configuring a data source” on page 99
Use the Data Sources tool to configure a data source that supplies data to IBM Intelligent Operations
Center.
“Configuring KPIs” on page 120
In the Solution Administration view, you can configure Key Performance Indicators (KPIs) and their
hierarchical display in the user interface. The KPIs are displayed on the status views in IBM Intelligent
Operations Center.
“Creating and integrating KPIs” on page 156
Key performance indicator (KPI) models can be created and modified using a business monitoring
development toolkit and the Key Performance Indicators configuration tool.
“Configuring standard operating procedures” on page 136
A standard operating procedure is a set of instructions that describes all the relevant steps and activities
of a process or procedure. Standard operating procedures are essential to an organization to deliver
consistent, measured, high-quality responses to complex and unpredictable events.
Related tasks:
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“Routing data from your data source” on page 111
For the data that is received from your data source, set routing expressions that define how the data is
processed by the solution. Data items that match the required expression or combination of expressions
are routed to the selected destination.

Routing schema file
The base IBM Intelligent Operations Center routing schema file contains elements for the properties that
are common to all data sources. Update the routing schema file to also include the properties that are
unique to the data sources. The updated schema file is used to route data to KPIs. The updated schema
file can also be used when applications are created that process records that are routed to integration
topics.

Base routing schema file

XML messages that are routed to KPIs are based on the following IOC-routing-v1.6.xsd base routing
schema file. The IOC-routing-v1.6.xsd file is included in the sample monitor models.
<complexType>
<all>
<!-- * Minimal properties */ -->
<element name="DATASOURCEID" type="integer" minOccurs="1" maxOccurs="1" />
<element name="OBJECTID" type="integer" minOccurs="1" maxOccurs="1" />
<element name="STARTDATETIME" type="dateTime" minOccurs="1" maxOccurs="1" />
<element name="ENDDATETIME" type="dateTime" minOccurs="1" maxOccurs="1" />
<element name="LASTUPDATETIME" type="dateTime" minOccurs="1" maxOccurs="1" />
<element name="ASSESSMENTDATETIME" type="dateTime" minOccurs="1" maxOccurs="1" />
<element name="TIMEZONEOFFSET" type="integer" minOccurs="1" maxOccurs="1" />
<element name="LOCATION" type="string" minOccurs="1" maxOccurs="1" />
<element name="NAME" type="string" minOccurs="1" maxOccurs="1" />
<!-- * Key/Full properties */ -->
</all>

</complexType>

Sample modified routing schema file

To make the base routing schema file work for ioc_sample_monitor_models, the IOC-routing-v1.6.xsd
base routing schema file must be modified to match the following example. Depending on how the data
source is configured, all the following key and full properties might, or might not, be included in the
routed XML message.
<complexType>
<all>
<!-- * Minimal properties */ -->
<element name="DATASOURCEID" type="integer" minOccurs="1" maxOccurs="1" />
<element name="OBJECTID" type="integer" minOccurs="1" maxOccurs="1" />
<element name="STARTDATETIME" type="dateTime" minOccurs="1" maxOccurs="1" />
<element name="ENDDATETIME" type="dateTime" minOccurs="1" maxOccurs="1" />
<element name="LASTUPDATETIME" type="dateTime" minOccurs="1" maxOccurs="1" />
<element name="ASSESSMENTDATETIME" type="dateTime" minOccurs="1" maxOccurs="1" />
<element name="TIMEZONEOFFSET" type="integer" minOccurs="1" maxOccurs="1" />
<element name="LOCATION" type="string" minOccurs="1" maxOccurs="1" />
<element name="NAME" type="string" minOccurs="1" maxOccurs="1" />
<!-- * Key/Full properties */ -->
<element name="SUPPLY" type="string" minOccurs="0" maxOccurs="1" />
<element name="DEMAND" type="string" minOccurs="0" maxOccurs="1" />
<element name="REVENUE" type="string" minOccurs="0" maxOccurs="1" />
<element name="PROJECTED_REVENUE" type="string" minOccurs="0" maxOccurs="1" />
<element name="BUDGET" type="string" minOccurs="0" maxOccurs="1" />
<element name="EXPENSES" type="string" minOccurs="0" maxOccurs="1" />
<element name="AIRPORT" type="string" minOccurs="0" maxOccurs="1" />
<element name="DELAYS" type="string" minOccurs="0" maxOccurs="1" />
<element name="INCIDENT_NUMBER" type="string" minOccurs="1" maxOccurs="1" />
<element name="STATION" type="string" minOccurs="0" maxOccurs="1" />
<element name="SOURCE" type="string" minOccurs="0" maxOccurs="1" />
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<element name="DISCHARGE" type="string" minOccurs="0" maxOccurs="1" />
<element name="PRECINCT" type="string" minOccurs="0" maxOccurs="1" />
<element name="PROBLEM" type="string" minOccurs="0" maxOccurs="1" />
<element name="SEVERITY" type="string" minOccurs="0" maxOccurs="1" />
<element name="LEAKAGE" type="string" minOccurs="0" maxOccurs="1" />
<element name="LEVEL" type="string" minOccurs="0" maxOccurs="1" />
<element name="PH" type="string" minOccurs="0" maxOccurs="1" />
<element name="TURBIDITY" type="string" minOccurs="0" maxOccurs="1" />
<element name="DEPARTMENT" type="string" minOccurs="0" maxOccurs="1" />
</all>
</complexType>

Data source routing for KPI updates
IBM Intelligent Operations Center can determine whether an incoming data item must be routed to a
KPI.

If a data item arrives from a data source that is configured for KPI routing, the system generates a KPI
XML message that it sends to be processed by the monitor model in IBM Business Monitor. You must
add the properties that are unique to the data source to the routing schema file, so that the monitor
model can extract the properties from the incoming XML message. For more information about editing
the routing schema file, see the link to the topic about modeling KPIs.

The following sample XML message updates a KPI that is associated with ioc_sample_monitor_models:
<iocrt:record xsi:schemaLocation="urn:ibm:industry:solutions:ioc:routing:1.6

IOC-routing-v1.6.xsd " >
<iocrt:AIRPORT> null</iocrt:AIRPORT>
<iocrt:BUDGET> null</iocrt:BUDGET>
<iocrt:LEAKAGE> null</iocrt:LEAKAGE>
<iocrt:DELAYS> null</iocrt:DELAYS>
<iocrt:LEVEL> null</iocrt:LEVEL>
<iocrt:DEMAND> null</iocrt:DEMAND>
<iocrt:DEPARTMENT> null</iocrt:DEPARTMENT>
<iocrt:NAME> water quality</iocrt:NAME>
<iocrt:PH> Take Action</iocrt:PH>
<iocrt:TIMEZONEOFFSET> 0</iocrt:TIMEZONEOFFSET>
<iocrt:DISCHARGE> null</iocrt:DISCHARGE>
<iocrt:PRECINCT> null</iocrt:PRECINCT>
<iocrt:EXPENSES> null</iocrt:EXPENSES>
<iocrt:PROBLEM> null</iocrt:PROBLEM>
<iocrt:ID> 26</iocrt:ID>
<iocrt:PROJECTED_REVENUE> null</iocrt:PROJECTED_REVENUE>
<iocrt:INCIDENT_NUMBER> null</iocrt:INCIDENT_NUMBER>
<iocrt:REVENUE> null</iocrt:REVENUE>
<iocrt:SEVERITY> null</iocrt:SEVERITY>
<iocrt:SOURCE> null</iocrt:SOURCE>
<iocrt:STATION> null</iocrt:STATION>
<iocrt:OBJECTID> 1974</iocrt:OBJECTID>
<iocrt:LASTUPDATEDATETIME> 2013-07-29T08:36:30+00:00</iocrt:LASTUPDATEDATETIME>
<iocrt:DATASOURCEID> 28</iocrt:DATASOURCEID>
<iocrt:SUPPLY> null</iocrt:SUPPLY>
<iocrt:TURBIDITY> Caution</iocrt:TURBIDITY>
<iocrt:LOCATION> POINT(-93.3047103742181 45.00458169489491)</iocrt:LOCATION>
<iocrt:ENDDATETIME> 2013-07-29T08:36:30+00:00</iocrt:ENDDATETIME>
<iocrt:ASSESSMENTDATETIME> 2013-07-26T16:20:12+00:00</iocrt:ASSESSMENTDATETIME>
<iocrt:STARTDATETIME> 2013-07-26T16:20:12+00:00</iocrt:STARTDATETIME>
</iocrt:record>

Related concepts:
“Configuring KPIs” on page 120
In the Solution Administration view, you can configure Key Performance Indicators (KPIs) and their
hierarchical display in the user interface. The KPIs are displayed on the status views in IBM Intelligent
Operations Center.
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“Viewing notifications” on page 387
Click Notifications to view a dynamic list of your notifications and their details.
Related tasks:
“Modeling KPIs” on page 158
Model KPIs with Rational Application Developer or WebSphere Integration Developer, with the IBM
Business Monitor development toolkit installed.

Routing data to an integration topic
IBM Intelligent Operations Center can determine whether an incoming data item must be routed to an
integration topic, and then send the data for processing to a predefined WebSphere Application Server
integration topic.

Before you begin
v Create an integration topic for the processing application that you require.
v If you want to convert incoming XML messages from your data source to Java classes that can be

processed by your application, update the routing schema file with the custom properties for the data
source.

About this task

If a data item is from a data source that is configured to be routed to an integration topic, the system
sends an XML message to the WebSphere Application Server integration topic for processing. Follow the
procedure to define the WebSphere Application Server integration topic.

Procedure
1. Click Solution Administration > System Administration > Administration Consoles.
2. Click Application Server.
3. Log in with your administration user ID and password.
4. Add your new application to the application server by stepping through the New Enterprise

Application wizard.
a. Click Applications > New Application > New Enterprise Application.
b. Select the path to the new application on a local or remote file system and browse the system to

locate and upload the file
c. Choose the fast path option to install.
d. At the Map modules to servers step, select the existing server.
e. Select PortalCluster from the list, and click Apply.
f. Click Next until you reach the summary step and click Finish.

5. Click Resources > JMS > Activation Specification.
6. Click New to add an activation specification.

a. To accept the default scope of cell=cell1 and the default message provider, click OK.
7. On the Configuration tab, complete the general properties form for the activation specification.

a. Enter the display name; for example, topicTestAS.
b. Enter the JNDI name; for example, eis/topicTestAS.
c. In the Destination type field, select Topic.
d. Enter the JNDI name of the destination, jms/iocIntegration.
e. In the Bus name field, select IOC.cell1.BUS.

8. Click Servers > Clusters > Websphere application server clusters, select PortalCluster and click
Start.

9. Log out of WebSphere Application Server
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Results

When a data source contains a data item that fulfills a routing expression condition with a destination of
Integration Topic, the data is directed to the integration topic.

What to do next

For information about how to route data from a data source to an integration topic, see the link at the
end of the topic.
Related tasks:
“Routing data from your data source” on page 111
For the data that is received from your data source, set routing expressions that define how the data is
processed by the solution. Data items that match the required expression or combination of expressions
are routed to the selected destination.

Data item correlation
1.6.0.1 1.6.0.2

A solution administrator can configure a data source to be available for correlation. A solution
administrator can also configure routing criteria to route data items from a data source to a correlation
topic. When a data item is routed to a correlation topic, the correlation process assesses whether the data
item is correlated with other correlation data items. The correlation process sends notifications when
correlations occur.

The correlation process includes the following steps:
1. The correlation topic reads the following correlation settings from the system properties table:

radius The maximum distance between the routed data item and correlated data items. The default
value is 200.

distanceUnit
The unit that the distance between data items is measured in, which can be either meters,
kilometers, or statute miles. The default value is METER. The other valid values are KILOMETER
and STATUTE_MILE.

minutesBefore, minutesAfter
The maximum time difference between the routed data item and correlated data items. The
time difference is measured in minutes and is relative to the start date of each data item. The
default value is 120 for both minutesBefore and minutesAfter.

notificationSummaryThreshold
If the number of correlations for a particular data item exceeds the notification summary
threshold, a summary notification is sent instead of individual notifications. The default value
is 10.

targetGroups
The user groups to whom correlation notifications are sent. The default value is
["CityWideOperator","CityWideSupervisor","wpsadmins"].

2. Within data sources that are activated for correlation, the correlation topic searches for data items that
match all of the following conditions. The conditions are based on the correlation settings, and are
assessed relative to the routed data item.
v The data items are within the predefined spatial distance for correlation.
v The data items are within the predefined time distance for correlation.
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3. If the correlation topic finds correlations, it either sends individual correlation notifications, or a
summary notification. The correlation topic sends a summary notification if the notification summary
threshold is exceeded. The notifications are sent to the groups that are defined in the target groups
system property.

Note: The distance and time values that are included in notifications are the maximum distance and
time values that are defined in the correlation settings. Therefore, the values do not represent the
exact distance and time between correlated data items.

Sample individual notification

An individual notification might contain a headline that is similar to the following example:
Source Name in Emergency Services data source might be related to Target Name in Police data source.

The notification body might contain text that is similar to the following example:
Target Name is located less than 13.2m away and started between 4 minutes before and
15 minutes after Source Name.

Sample summary notification

A summary notification might contain a headline that is similar to the following example:
Source Name in Emergency Services data source might be related to 23 data items in Police data source.

The notification body might contain text that is similar to the following example:
23 data items are located less than 13.2m away and started between 4 minutes before and
15 minutes after Source Name.

Data source time stamp synchronization
When the data receiver receives updated information for a data source, a time stamp is applied to the
updated data source. The method that is used to determine the time stamp depends on several factors.

The time stamp that is applied to an updated data source is determined depending on the following
conditions:
v If the last updated time stamp is not mapped for the data source, at each refresh interval the data

receiver refreshes the target database table with the data that is in the source database table.
v If a timezone offset is not supplied, all time stamps are stored in the target database table as GMT

time stamps.
v If a timezone offset is supplied, the timezone offset is applied to the incoming time stamp, and the

time stamp is then stored in the target database table as a GMT time stamp.
v If the time is not synchronized between the source system and the target system, the time stamp that is

applied to a data source cannot be predicted. For example, if the time stamp that is on the source
system is ahead of the time stamp that is on the target system, items might be duplicated in the target
system.

Related reference:
“Data source minimal property settings” on page 105
Assign properties from your data source to each minimal property and choose the settings that are
appropriate for your data.

Creating and integrating KPIs
Key performance indicator (KPI) models can be created and modified using a business monitoring
development toolkit and the Key Performance Indicators configuration tool.
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The IBM Business Monitor development toolkit can be installed with Rational Application Developer,
both products are supplied with IBM Intelligent Operations Center. The IBM Business Monitor
development toolkit can also be installed with WebSphere Integration Developer.

Before defining or modifying a KPI you must understand the data source and the XML schema that the
KPI is based on. For example, if you are defining a KPI that tracks the level of a water source, you need
to know what schema corresponds to the data item properties that need to be tracked, such as the name
of the water source and the water depth in feet. After a KPI is added or modified in this way it must be
deployed to the IBM Business Monitor server.

For additional information about the IBM Business Monitor and the IBM Business Monitor development
toolkit, see the IBM Business Monitor product documentation.

When you have established KPI models and metrics through IBM Business Monitor, you can develop and
modify the KPIs with the Key Performance Indicators configuration tool in IBM Intelligent Operations
Center.
Related concepts:
“Data item routing” on page 150
IBM Intelligent Operations Center processes incoming data items to determine how information is
displayed.
“Configuring KPIs” on page 120
In the Solution Administration view, you can configure Key Performance Indicators (KPIs) and their
hierarchical display in the user interface. The KPIs are displayed on the status views in IBM Intelligent
Operations Center.
“Viewing or changing a KPI model” on page 126
As an administrator, you can use the KPI Definition tab to view or change the KPI models available
within the solution.
“Customizing KPIs” on page 178
In IBM Intelligent Operations Center, you can customize key performance indicator (KPI) models to suit
your business processes.
“Sample KPIs” on page 179
Sample KPIs are provided with the IBM Intelligent Operations Center. The sample KPIs are designed to
provide guidance for implementing different types of KPI with the IBM Business Monitor Development
Toolkit. Sample monitor models are provided for water, transportation, and public safety.
Related reference:
“Installing tools provided with the solution” on page 83
Toolkits and development tools are included with the IBM Intelligent Operations Center. These are used
when customizing IBM Intelligent Operations Center.
Related information:

IBM Business Monitor product documentation

Monitor models and KPIs
A business monitor model defines key performance indicators (KPIs) and associated metrics,
dependencies that are related to inbound events, conditions that require business actions, and the
outbound events that report conditions that might trigger business actions.

An IBM Business Monitor monitor model can contain the following submodels:
v Monitor details model
v KPI model
v Dimensional model
v Visual model
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v Event model

The monitor details model contains most of the monitor model information.

The sample monitor models that are provided with the IBM Intelligent Operations Center do not use the
visual or dimensional models.

The monitor details model defines one or more monitoring contexts. A monitoring context defines the
information that is to be collected and monitored from one or more inbound events. For the IBM
Intelligent Operations Center, the monitored entities are routing messages. A routing message is an XML
message that is generated from a data item that is received by IBM Intelligent Operations Center from a
data source. The information that is collected from the XML messages is used to calculate a KPI.

The KPI model contains one or more KPI contexts. The contexts define the KPIs, and their associated
triggers and events. KPI contexts can process inbound events, evaluate recurring wait-time triggers, and
send outbound events. For example, the context can specify that an XML notification should be sent
when a KPI is out of the defined range.

The event model refers to all event inbound and outbound definitions that are used in the monitor
model. It refers to XML schemas that describe the structure of individual event parts.

Monitoring context instances
A monitoring context instance is information that is collected at a specific point in time within a
monitoring context.

For IBM Intelligent Operations Center, a monitoring context instance corresponds to a routing message. A
routing message is an XML message that is generated by the IBM Intelligent Operations Center each time
that a data item is received from a data source. When such an XML message is received by IBM Business
Monitor, a monitoring context instance is created or reused. The metrics within that context instance are
populated with the XML message values that are based on the monitoring context.

A monitoring context can be defined to either create a new instance for each routing message, or to reuse
an existing instance. For example, if you want a KPI to calculate the average weekly water level at a
specific location with the water level sampled daily, you would create a new monitoring context instance
for each routing message. Each instance would contain the daily water level and the KPI would average
the measurements over the seven day period.

KPIs are calculated with the metrics that are defined for a monitoring context. When you are defining an
aggregation KPI, you specify the monitoring context and metric that are used as input to the KPI
aggregation function. When the KPI is evaluated, the metric values for the monitoring context instances
are used by the aggregation function to calculate the KPI value.

Modeling KPIs
Model KPIs with Rational Application Developer or WebSphere Integration Developer, with the IBM
Business Monitor development toolkit installed.

About this task

KPIs are modeled using either Rational Application Developer or WebSphere Integration Developer, with
the IBM Business Monitor development toolkit. Rational Application Developer and the IBM Business
Monitor development toolkit are supplied with IBM Intelligent Operations Center. For more information
about these tools, see the product documentation link at the end of the topic.
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Monitoring models are contained within business monitoring projects. Models and projects are created
using the Rational Application Developer business monitor wizards that are provided by the IBM
Business Monitor development toolkit.

To model a KPI, complete the procedure.

Procedure
1. Understand your data source and the data items that are to be received by IBM Intelligent

Operations Center.
2. Understand the purpose of the KPI. For example, KPIs can be used in the following ways:

v If a limit is reached or exceeded, the KPI indicates that action should be taken.
v The KPI is used to calculate historical or statistical data.

3. Determine the name for the monitoring context. The IBM Intelligent Operations Center naming
convention is to use the data item name as the monitoring context name. Each data item that is
received by IBM Intelligent Operations Center generates a routing message with the data in XML
format. The sample models that are provided with IBM Intelligent Operations Center generate a
separate monitoring context instance for each routing message that is sent to IBM Business Monitor.

4. In either Rational Application Developer or WebSphere Integration Developer, with the IBM Business
Monitor development toolkit installed, define the inbound event for the monitoring context. The
inbound event definition specifies the structure of the routing message that is monitored by the
context, a key that uniquely defines the context, and the metrics that define the information that is
extracted from the message.
a. Create the XML schema. The schema defines the structure of the inbound event to IBM Business

Monitor
b. Specify the name and ID for the IBM Business Monitor inbound event. IDs cannot contain spaces

or special characters. By default, the ID is created from the name with underscores substituted
for spaces. All the sample models that are provided by IBM Intelligent Operations Center use the
default IDs.

c. Specify the XML schema that you created that is to be used for the data item. The schema must
exist in the modeling project. The IBM Intelligent Operations Center provides a copy of the
schema in the sample ioc_sample_monitor_models modeling project.

d. Define any required filtering of routing messages. For example, limit monitoring to data items
with specific property values that represent a specific level of severity.

e. Specify the metrics that are to be extracted from the XML message.
f. Define a context key to uniquely identify the monitoring context instance. Key values are

specified by an inbound event when the monitoring context instance is generated.
g. Specify whether inbound events are correlated.

5. Specify the KPI context. A KPI context is a container for KPIs and their associated triggers and
events. Unlike a monitoring context, a KPI context contains no keys or metrics. Before you create any
KPIs, you must create a KPI context as a container.

6. Create the KPI within the previously defined KPI context.
7. Specify the type of KPI: Decimal or Duration.
8. Define the KPI ranges, values, and color indicators. Most of the sample IBM Intelligent Operations

Center KPIs define three ranges and associated colors.

Table 35. Sample KPI range and color definitions

Name Color RGB

Acceptable green 699037

Caution yellow FDBA1A

Critical red C32E14
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9. Define how the KPI value is calculated. KPI values are determined in one of two ways. If the value
comes from a metric that uses an aggregation function, the KPI is referred to as an aggregate KPI. If
the value is calculated based on other KPIs or user-defined XPath functions, the KPI is referred to as
an expression KPI.
In the IBM Intelligent Operations Center samples, the lowest level KPIs, those KPIs without child
KPIs, are defined as aggregate KPIs. The higher level KPIs, those KPIs with child KPIs, are defined
as expression KPIs.
Aggregate KPI values are calculated from metrics that are populated with data sent in XML
messages sent to the IBM Business Monitor server. An aggregation function is then run on this data.
Aggregation functions include the following functions:
v average

v maximum

v minimum

v sum

v number of occurrences

v standard deviation

The values are expressed as quantifiable measurements. For example, average crime response time (5
minutes, 7 seconds) or average water level (100.5).
Expression KPI values are calculated from KPI ranges and calculations. In IBM Intelligent Operations
Center samples, the parent KPIs have calculations that cause the KPI to evaluate to a value of 0, 1, or
2 depending on the values of their child KPIs. A value of 0 maps to the acceptable range, 1 to the
caution range, and 2 to the critical range. The samples use calculation expressions to set the KPI
value to the highest urgency level that exists among its child KPIs.

10. Optional: Specify the time filter for an aggregate KPI. Aggregation KPIs can have optional time
filters that limit the time period for which the KPI value is calculated. The time period can be a
repeating interval (for example, the last completed or current period), a rolling interval, or a fixed
interval. All sample IBM Intelligent Operations Center aggregate KPIs have defined time filters.

11. Optional: Specify a data filter for the KPI. For example, if the average crime response time is to be
calculated for Police Precinct One and no other precinct, a data filter can be used to remove all other
monitoring contexts.

12. Define how the KPI values are updated, including triggers, inbound events to IBM Business Monitor
server, and outbound events to IBM Intelligent Operations Center.

13. Test the KPI. IBM Business Monitor development toolkit has a test environment for testing the KPIs
before deployment; for details see the link at the end of the topic.

14. Deploy the monitor model application.
Related concepts:
“Defining KPI hierarchies” on page 161
You can define parent-child relationships between KPIs and design how KPIs are displayed in IBM
Intelligent Operations Center. Design your own KPI hierarchies so that you can look up KPIs in a way
that suits your business process.
“KPI communication with IBM Business Monitor” on page 161
IBM Intelligent Operations Center communicates with IBM Business Monitor through specific monitoring
or key performance indicator (KPI) contexts.
“Data source routing for KPI updates” on page 153
IBM Intelligent Operations Center can determine whether an incoming data item must be routed to a
KPI.
Related tasks:
“Deploying monitor models” on page 164
After key performance indicators (KPIs) and their monitor models are defined, the monitor models must
be deployed to IBM Business Monitor. IBM Business Monitor runs on the IBM Intelligent Operations
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Center application server.
Related reference:
“Routing schema file” on page 152
The base IBM Intelligent Operations Center routing schema file contains elements for the properties that
are common to all data sources. Update the routing schema file to also include the properties that are
unique to the data sources. The updated schema file is used to route data to KPIs. The updated schema
file can also be used when applications are created that process records that are routed to integration
topics.
Related information:

IBM Business Monitor product documentation

XML Path Language (XPath) 2.0 (Second Edition) documentation

Defining KPI hierarchies
You can define parent-child relationships between KPIs and design how KPIs are displayed in IBM
Intelligent Operations Center. Design your own KPI hierarchies so that you can look up KPIs in a way
that suits your business process.

In IBM Business Monitor you can implement a KPI that is based on the value of another KPI. However,
you cannot define a parent-child relationship between KPIs. To simplify this task, IBM Intelligent
Operations Center provides a Key Performance Indicators configuration tool for the administrator. For
information about this tool, see the link at the end of the topic.

The IBM Intelligent Operations Center sample KPIs define a series of Police Department KPIs with a
hierarchical design as shown in the following example:
Police Department ----------------------------- level 1

Crime Response Time ------------------------- level 2
Crime Response Time Precinct One ----- level 3
Crime Response Time Precinct Two ----- level 3

In this case, Police Department has one child: Crime Response Time. Crime Response Time has two
children: Crime Response Time Precinct One and Crime Response Time Precinct Two.

The two level 3 KPIs are defined in the KPI model as aggregate KPIs. That is, their values are calculated
using a metric value and an aggregation function. All other KPIs in this set are expression KPIs with their
values calculated from the values of the other KPIs. For example:
v Crime Response Time is based on the values of Crime Response Time Precinct One and Crime Response

Time Precinct Two.
v Police Department is based on the value of Crime Response Time.
Related concepts:
“Configuring KPIs” on page 120
In the Solution Administration view, you can configure Key Performance Indicators (KPIs) and their
hierarchical display in the user interface. The KPIs are displayed on the status views in IBM Intelligent
Operations Center.
Related tasks:
“Modeling KPIs” on page 158
Model KPIs with Rational Application Developer or WebSphere Integration Developer, with the IBM
Business Monitor development toolkit installed.

KPI communication with IBM Business Monitor
IBM Intelligent Operations Center communicates with IBM Business Monitor through specific monitoring
or key performance indicator (KPI) contexts.
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IBM Intelligent Operations Center data is contained in inbound events that are sent to IBM Business
Monitor and outbound events that are received from IBM Business Monitor.

Outbound events from the IBM Business Monitor server are placed on an external message queue. IBM
Intelligent Operations Center uses this mechanism to asynchronously receive KPI updates.

Note: Set the MonitorServerSecurityEnabled property to specify whether the connection to IBM Business
Monitor uses SSL for secure connection. For more information about how to change this property in the
system properties table, see the link at the end of the topic.
Related tasks:
“Configuring system properties” on page 189
View, create, modify, and delete system properties in the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent Operations Center.
“Modeling KPIs” on page 158
Model KPIs with Rational Application Developer or WebSphere Integration Developer, with the IBM
Business Monitor development toolkit installed.

Triggers
IBM Business Monitor uses triggers to detect data that initiates extra processing. The KPI sample models
that are provided with IBM Intelligent Operations Center define two types of trigger.

A trigger is fired when an XML routing message, also known as an inbound event, is received by IBM
Business Monitor server for a defined KPI set.

A data item that is received by IBM Intelligent Operations Center generates a routing message that might
result in a change to the KPI. IBM Intelligent Operations Center determines whether the KPI is changed
when it receives notification from the IBM Business Monitor server. For outbound events, a trigger
determines when a notification message is sent.

Message-based triggers can be used to send notifications to IBM Intelligent Operations Center when the
input for a KPI calculation changes. However, message-based triggers cannot be used in the situation
when a KPI value changes after a defined time period expires.

In the IBM Intelligent Operations Center samples, time-based triggers are used to send notifications to the
IBM Intelligent Operations Center for those KPIs with short time period definitions. For example, the
Severe Traffic Accidents KPI is defined to expire every hour. If the KPI has a value of 3 at 10:00, and
no messages are received for that KPI during the next hour, then the time period expires and the KPI
value is reset to 0.

Defining inbound events to IBM Business Monitor
In IBM Intelligent Operations Center samples, inbound events are used to determine when a trigger is
fired. Inbound events for a KPI context are defined in a similar manner to inbound events for a
monitoring context.

About this task

Inbound events are defined using either Rational Application Developer, or WebSphere Integration
Developer with IBM Business Monitor. For more information about using these tools, see the product
documentation for these products.

To define an inbound event, follow the procedure.

Procedure
1. Select the KPI context for the inbound event.
2. Create the inbound event and specify the event name and ID.
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3. Specify the XML schema.
4. Specify the filter condition.
5. Select the KPI context and create a new inbound event.
6. Create a trigger for the inbound event.
7. Make sure that the trigger is repeatable; the trigger fires each time the trigger source is updated and

the trigger condition is met.
8. Select the trigger source.
9. Define the trigger condition. When the trigger condition is met, the trigger fires.

Example

The sample monitor models are defined so that a trigger fires each time the IBM Business Monitor server
receives an XML routing message from IBM Intelligent Operations Center.

Defining outbound events from IBM Business Monitor
Outbound events define the information that is sent from IBM Business Monitor to IBM Intelligent
Operations Center when a trigger fires.

About this task

IBM Intelligent Operations Center uses the outbound notifications that are sent from the IBM Business
Monitor server to determine if the KPI has changed. If the KPI has changed, IBM Intelligent Operations
Center obtains the KPI data from the IBM Business Monitor server, updates the KPI cache information,
and updates the IBM Intelligent Operations Center data.

Outbound events are defined using either Rational Application Developer, or WebSphere Integration
Developer with the IBM Business Monitor development toolkit. For more information about using these
tools, see the information centers for these products.

To define an outbound event, complete the following procedure.

Procedure
1. Select the KPI context for the outbound event.
2. Create the outbound event and specify the event name and ID.
3. Specify the notification schema. The ioc-notification-v1.0.xsd notification schema file is in the

ioc_sample_monitor-models project.
4. Define the content of the outbound event. The content is based on the notification schema.
5. Under notification, for the value of sentfrom, enter Monitor.
6. Add the parameter elements to the event content, as defined in the following sub-steps:

a. For the first parameter, specify modelID for parameterName and the monitor model ID for
parameterValue. For example, ioc_sample_public_safety_model.

b. For each KPI in the KPI set, add parameters to specify the KPI ID and KPI value. The KPI ID is
specified using the parameterName element and the KPI value is specified using the
parameterValue element. The KPI ID must be associated with a KPI in the KPI set. Use the
xs:string() function to specify the KPI value as a string. For example, parameterName can be
Police_Department and parameterValue can be xs:string(Police_Department).

Example

The following is an example of a notification that is to be sent to IBM Intelligent Operations Center:
<ns1:notification>

<ns1:notificationType> Alert</ns1:notificationType>
<ns1:sentFrom> Monitor</ns1:sentFrom>
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<ns1:headline> Police Department KPI Changed</ns1:headline>
<ns1:description> Police Department KPI Changed</ns1:description>
<ns1:kpiLink> Police Department</ns1:kpiLink>
<ns1:category> Safety</ns1:category>
<ns1:parameter>

<ns1:parameterName> modelId</ns1:parameterName>
<ns1:parameterValue>

ioc_sample_public_safety_model</ns1:parameterValue>
</ns1:parameter>
<ns1:parameter>

<ns1:parameterName> Police_Department</ns1:parameterName>
<ns1:parameterValue> 0</ns1:parameterValue>

</ns1:parameter>
<ns1:parameter>

<ns1:parameterName> Crime_Response_Time</ns1:parameterName>
<ns1:parameterValue> 0</ns1:parameterValue>

</ns1:parameter>
<ns1:parameter>

<ns1:parameterName> Crime_Response_Time_Precinct_One</ns1:parameterName>
<ns1:parameterValue> PT3M30.000S</ns1:parameterValue>

</ns1:parameter>
<ns1:parameter>

<ns1:parameterName> Crime_Response_Time_Precinct_Two</ns1:parameterName>
<ns1:parameterValue> PT3M30.000S</ns1:parameterValue>

</ns1:parameter>
</ns1:notification>

Deploying monitor models
After key performance indicators (KPIs) and their monitor models are defined, the monitor models must
be deployed to IBM Business Monitor. IBM Business Monitor runs on the IBM Intelligent Operations
Center application server.

About this task

To deploy a monitor model that is to be used by IBM Business Monitor, generate Java Platform,
Enterprise Edition projects from the defined models. After the Java Platform, Enterprise Edition projects
are generated, the model application can be exported as an EAR file. The EAR file can then be deployed
into IBM Business Monitor running on the IBM Intelligent Operations Center application server.

Procedure
1. In either Rational Application Developer, or WebSphere Integration Developer with the IBM Business

Monitor development toolkit installed, right-click the monitor model that requires project generation
in the Enterprise Explorer tab. For example, ioc_sample_public_safety_model.

2. Click Generate Monitor JEE Projects. The following projects are created: modelApplication,
modelLogic, and modelModerator.

3. Export the monitor model application by right-clicking the modelApplication project and clicking
Export > EAR.

4. Before the EAR file is deployed into IBM Business Monitor, test the KPIs. Follow the instructions in
the IBM Business Monitor product documentation.

5. Deploy the EAR file into the IBM Business Monitor server. Follow the instructions in the IBM
Business Monitor product documentation.

Related tasks:
“Modeling KPIs” on page 158
Model KPIs with Rational Application Developer or WebSphere Integration Developer, with the IBM
Business Monitor development toolkit installed.
Related information:

IBM Business Monitor product documentation
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KPI display labels and values
IBM Intelligent Operations Center provides a DB2 database table that can be used to provide alternative
display labels from those labels that are provided by the IBM Business Monitor models.

KPI names and range names are defined in the sample IBM Business Monitor models that are provided
with IBM Intelligent Operations Center. The following names are examples of KPI names:
v Water
v Water Quality

The following names are examples of range names:
v Acceptable
v Caution
v Critical

Each artifact, for example KPI range, that is defined in IBM Business Monitor has an ID that is associated
with the display name. IDs cannot contain spaces while display names can contain spaces. The IDs are
used as keys to look up labels in a database table. IBM Intelligent Operations Center uses the IDs to
select KPI display labels. If no value is specified in the database table for an ID, the value that is specified
in the IBM Business Monitor definition is used.

KPI display values are globalized by IBM Business Monitor with the ISO language and country codes of
the IBM Business Monitor server. For example, a KPI percentage value is displayed in the format 12.61%
when the locale is en_US and 12,61% when the locale is fr_FR. Database table definitions are not used for
these values.

The default IBM Intelligent Operations Center properties database table is IOC.I18N_RESOURCE. The
following example is an extract from the KPI group in that table:
GROUP LOCALE KEY VALUE
KPI default kpiNoValue There is no data available to determine the KPI value
KPI default kpiRangeUndetermined Undetermined
KPI default kpiNoRangeDefined There is no KPI range defined
KPI default Flood_Control Flood Control
KPI default Water_Levels Water Levels
KPI default Flow_Discharge_City_River Flow Discharge City River
KPI default Water_Level_City_Lake Water Level City Lake

The values of kpiNoValue and kpiRangeUndetermined are used by IBM Intelligent Operations Center when
the IBM Business Monitor KPIs return a null value. For example, the Water Level City Lake KPI is
defined with a repeating daily time period that is based on the last full period. If no updates are received
for that KPI on a Sunday, and the KPI is requested on Monday, null is returned because no data is
available for the previous day. The display value is set to No data to determine the KPI valueand the
range display name is set to undetermined.

The other entries in this sample extract, Flood_Control, Water_Levels, Flow_Discharge_City_River, and
Water_Level_City_Lake, define the display labels for the KPI IDs These IDs are defined in the
ioc_sample_water_model sample monitor model that is provided by IBM Intelligent Operations Center.
The entries can specify text to replace the text values that are specified in IBM Business Monitor. For
example, the database table can be used to provide translated values instead of changing the model itself.
(’KPI’, ’default’, ’Flow_Discharge_City_River’, ’Flow Discharge City River’)
(’KPI’, ’de’, ’Flow_Discharge_City_River’, ’Durchfluss des Flusses’)

Caching KPIs
IBM Intelligent Operations Center configuration settings determine when KPI values are retrieved from
the IBM Business Monitor.
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IBM Intelligent Operations Center maintains KPI values in a cache. By default, the KPIs are loaded from
IBM Business Monitor into the cache and the cache is refreshed according to the time interval that is
specified by the KpiRefreshInterval property in the system properties table. This refresh time can be
altered depending on your requirements to deliver updated KPIs to IBM Intelligent Operations Center.
For more information on changing properties in the system properties table, see the link at the end of the
topic.

Note that when you create a KPI in the Key Performance Indicators configuration tool, updates to the
KPI depend solely on the cache refresh. When a KPI is defined in IBM Business Monitor, a trigger
mechanism can be defined to implement additional processing in response to changes in that KPI.
Related tasks:
“Configuring system properties” on page 189
View, create, modify, and delete system properties in the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent Operations Center.

Integrating with the CAP
You can use the Common Alerting Protocol (CAP) to exchange data between IBM Intelligent Operations
Center and external systems.

When a solution administrator creates a data source, the solution administrator can select CAP as the
format for acquiring data, and can specify that CAP messages that are received through the data source
are displayed either on the geospatial map, or on the location map. The elements that are defined in the
CAP specification are mapped to data source properties. For more information about the CAP
specification, see the OASIS Common Alerting Protocol Version 1.2.
Related information:

OASIS Common Alerting Protocol Version 1.2

CAP message routing
A solution administrator can define multiple Common Alerting Protocol (CAP) data sources. However,
each data source sends all CAP messages that are received to all destinations, unless the solution
administrator specifies that CAP messages are routed based on the values of message properties.

By default, the IOC V1.6 schema is used to route CAP messages. However, if you want to use a key
performance indicator (KPI) model that was developed for IBM Intelligent Operations Center V1.5, with
IBM Intelligent Operations Center V1.6, use the CAP schema to route CAP messages. To set up the
routing of CAP messages to the KPI model if the value of the message code property is kpi, use the
following configuration steps:
1. In the Solution Administration view, click System Administration > System Properties and set the

value of the RouteCAPXML property to true.
2. In the CAP data source definition, define a routing expression that routes CAP messages to the Key

Performance Indicators routing destination if the value of code equals kpi.

It is not possible to route CAP messages based on parameters that are in the CAP message.

CAP message publishing
Configure your publishing client to publish Common Alerting Protocol (CAP) messages either to the
WebSphere Message Broker message queue, or to the WebSphere Application Server JMS resources.

WebSphere Message Broker message queue

To publish CAP messages to the WebSphere Message Broker message queue, use the following
configuration settings:
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Queue manager
IOC.MB.QM

Queue manager port number
1414

Queue manager host name
IBM Intelligent Operations Center analytics server host name

WebSphere Application Server JMS resources

To publish CAP messages to the WebSphere Application Server JMS resources, use the following
configuration settings.
v Queue Connection Factory:

Name ioc.mb.con.factory

JNDI Name
jms/ioc.mb.con.factory

v Queue

Name cap.in.q

JNDI Name
jms/cap.in.q

Displaying CAP messages on the maps and in the list
A solution administrator can configure panes on the filter panel that users can use to filter Common
Alerting Protocol (CAP) messages according to the values of the CAP message elements.

By selecting the appropriate options on the filter panel, you can view each CAP message that is received
from a CAP data source as a data item on the appropriate map, and in the list. If you want to be able to
display CAP messages on both the geospatial map, and on the location map, you must specify a separate
data source for each map type. On the maps and in the list, you can view the content of the CAP
message in the preview card, and in the Full Properties window.

The CAP specification defines enumerated values for some CAP message elements. Through the filter
panel, you can also filter on the enumerated values of the following CAP message elements that are
mapped to data source key properties:
v category
v certainty
v severity
v urgency

Updating and canceling CAP messages
For data ingestion, Common Alerting Protocol (CAP) messages are updated and canceled according to
the CAP specification. There are two ways to update and cancel CAP messages.

You can update and cancel CAP message data items either by sending an update CAP message, or by
sending a cancel CAP message. Alternatively, you can either update, or cancel, CAP messages by using
the More Actions menu in the maps and in the list in the same way as for all other data items.
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Chapter 6. Customizing the solution

You can customize the solution to suit your particular operation.

Use the Portal Administration view to customize the user interface. In the Solution Administration view,
System Administration, you can customize system properties that affect the system-wide configuration of
IBM Intelligent Operations Center. In the Solution Administration view, Configuration Tools, you have
options to customize the main components of the IBM Intelligent Operations Center.

Customizing the solution to suit your particular operation or business includes the following tasks.
Customizing is closely related to integrating the solution and the appropriate links are included.

Viewing or editing your user profile
1.6.0.2

You can view and edit the information in your solution user profile. Edit your user profile to set your
time zone, language preference, and notification settings. You can also reset your password and modify
your personal details.

About this task

Your system administrator can create new profiles and reset all attributes in existing user
profiles.

Procedure
1. To modify your user profile, select Edit Profile from the list that is next to your user name at the top

of the view. Modify some or all of the attributes of your user profile.
v To modify general profile attributes, for example, name, email, and telephone number, click My

Profile.
v To modify display settings for the solution, click Display Settings. Modify the color scheme, the

preferred language, or the time zone. The color scheme that you select modifies the colors that are
displayed in the solution. You can also modify your locale and time zone settings in your browser.

v To modify notification settings for the solution; for example, whether to display notifications, or the
length of time to display notifications for, click Notification Settings.

v To modify your profile password, click Change Password.
2. Refresh the browser page for the changes to take effect.
Related concepts:
“Localizing the user interface” on page 171
To change the locale and time zone that are displayed in the solution portal, edit your user profile. If you
do not configure specific locale settings in your user profile, the browser settings are applied. The locale
and time zone settings that you configure in your user profile override your browser settings.

Viewing or editing your user profile
1.6 1.6.0.1

You can view and edit the information in your solution user profile. An administrator creates a user
profile for each new user.
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About this task

The following table lists the attributes that your user profile contains. An administrator can edit all of the
attributes. The attributes that users can edit are indicated in the table.

Table 36. Solution user profile attributes

Attribute Description
User can
edit?

User ID* An administrator assigns a user ID to each new user for identification purposes. No

Password* An administrator assigns a password for security. The password must be unique and 5
- 60 characters in length. Valid passwords contain only the characters a-z, A-Z, period
".", dash "-", and underscore "_ ".

Yes

Given name A given name, or first name. Yes

Surname* A surname, last name, or family name. Yes

Email An email address. Yes

Profile image A profile image; for example, a photograph. Yes

Telephone
number

A telephone number. Yes

Job title A job title. Yes

Preferred
language

A preferred language, can be selected from a list. Yes

Time zone A preferred time zone, can be selected from a list. Yes

Notification
display limit

Notification display time limit in days. If a notification is older than the number of
days specified in this limit, it is not displayed in the Notifications window. The default
value is 3.

Yes

Note: Attributes that are marked with an asterisk are required for the successful creation of a new user.
Attributes that are not marked with an asterisk are optional.

Procedure
1. To view or edit your user profile, from the list that is next to your user name at the top of the view,

select Edit Profile.
2. Optional: To change your password, do the following substeps:

a. Enter your Current password. The password that you enter is not displayed.
b. Enter your New password, and then enter it again in Confirm password.

3. Optional: Edit the information in the remaining fields.
4. To submit your changes, click OK.

Results

Your user profile is updated with any changes.

Configuring display settings
1.6.0.2

You can view and edit your display settings in your IBM Intelligent Operations Center user profile.
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Procedure
1. To modify your user profile, select Edit Profile from the list that is next to your user name at the top

of the view.
2. To modify display settings, click Display Settings.

v Select a light or dark color scheme.
v Select the language from the Preferred language list.
v Select the time zone from the Time zone list.

Related tasks:
“Viewing or editing your user profile” on page 169
You can view and edit the information in your solution user profile. Edit your user profile to set your
time zone, language preference, and notification settings. You can also reset your password and modify
your personal details.

Localizing the user interface
To change the locale and time zone that are displayed in the solution portal, edit your user profile. If you
do not configure specific locale settings in your user profile, the browser settings are applied. The locale
and time zone settings that you configure in your user profile override your browser settings.

The locale setting determines the language that all text is displayed in. If a language is unavailable in the
solution, the closest related language is used. For example, if French Canadian is unavailable, the system
reverts to French, which in turn reverts to English, which is always available.

All dates and times are displayed according to your time zone setting in the format that is specified in
the system properties database. If you are an administrator, you can customize the date and time formats.
Related tasks:
“Configuring system properties” on page 189
View, create, modify, and delete system properties in the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent Operations Center.
“Viewing or editing your user profile” on page 169
You can view and edit the information in your solution user profile. Edit your user profile to set your
time zone, language preference, and notification settings. You can also reset your password and modify
your personal details.

Translating field text
Use the translation wizard to enter a translation for any field where you can enter text. Translated fields
are displayed in the user interface according to the locale that is selected in either the user profile, or in
the browser.

About this task

You can specify the translated versions of any field where you can enter text. For fields that have
translated versions, the language that is displayed in the user interface depends on the locale that is set
in the user profile. If a preferred language is not set in the user profile, the language that is displayed
depends on the locale that is selected in the browser.

Procedure
1. Either click the translation wizard icon, or click within a field where you can enter text.
2. Select the required language from the scrolling list of supported locales that is displayed in the

window.
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3. Enter the translated version of the field text in the appropriate supported locales fields. If you enter
only a default value, then the default is always displayed. For example, if you are viewing the
solution in Arabic and no Arabic translation is specified, then the default value is displayed.

4. Click OK.

Adding locales to the solution
You can add a locale to the solution by configuring the SupportedLocales system property.

Procedure
1. In the Solution Administration view, configure the SupportedLocales system property and insert the

value for the new locale.
2. Log on to the data server as the root user.
3. Enter the following commands at the command line:

su - db2inst2
DB2 connect to iocdb
DB2 INSERT INTO IOC.I18N_RESOURCE ("GROUP", "LOCALE", "KEY", "VALUE")
VALUES (’group_value’, ’locale_value’, ’key_value’, ’value’);

Where
v group_value is the name of the resource collection.
v locale_value is the locale of the value.
v key_value is the name of the value. Do not include a period (.) character in the value.
v value is the translated value.

Example

The following example steps show how to add the Thai locale to the solution:
1. In the Solution Administration view, insert the value th for the Thai locale into the SupportedLocales

system property. The following example shows the format of the SupportedLocales system property
value:
["ar", "de", "en", "es", "fr", "it", "ko", "pt-br", "ru", “th”, "zh", "zh-tw"]

2. Log on to the data server as the root user.
3. Enter the following commands at the command line:

su - db2inst2
DB2 connect to iocdb
DB2 INSERT INTO IOC.I18N_RESOURCE
("GROUP", "LOCALE", "KEY", "VALUE") VALUES
(’I18nLocale’, ’default’, ’th’, ’Thai’),
(’I18nLocale’, ’ar’, ’th’, ’�����������’),
(’I18nLocale’, ’de’, ’th’, ’thailändisch’),
(’I18nLocale’, ’en’, ’th’, ’Thai’),
(’I18nLocale’, ’es’, ’th’, ’tailandés’),
(’I18nLocale’, ’fr’, ’th’, ’thailandes’),
(’I18nLocale’, ’it’, ’th’, ’tailandese’),
(’I18nLocale’, ’ko’, ’th’, ’���’),
(’I18nLocale’, ’pt-br’, ’th’, ’tailandês’),
(’I18nLocale’, ’ru’, ’th’, ’�������’),
(’I18nLocale’, ’th’, ’th’, ’�������’),
(’I18nLocale’, ’zh’, ’th’, ’��’),
(’I18nLocale’, ’zh-tw’, ’th’, ’��’)

Related tasks:
“Configuring system properties” on page 189
View, create, modify, and delete system properties in the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent Operations Center.
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Customizing the user interface
You can customize elements of the IBM Intelligent Operations Center user interface to suit your
operation.

In addition to customizing the layout and appearance of portlets, you can also create new pages. For
more information, see the WebSphere Portal product documentation.
Related information:

IBM WebSphere Portal 8 product documentation

Creating or customizing a page
If you are an administrator, you can create new pages to be included in IBM Intelligent Operations
Center, and specify what content to display on those pages. You can customize the appearance and layout
of the content that is included on each page.

About this task

Use the WebSphere Portal user interface to customize pages and portlets. If you create static content for a
page, a page is displayed with four selectable vertical panels. To determine the content for the new page,
click Add Portlets in the selected panel. The upper panel determines the content in the leading edge of
the new page. The second panel down determines the content in the trailing edge of the new page. The
third panel down determines the main content of the new page, and the lower panel determines the
content at the bottom of the new page.

Procedure
1. Open WebSphere Portal, from any of the Operations or Status views.
2. In WebSphere Portal, click Portal User Interface.
3. To work with your pages or to create new pages, click Manage Pages>Select Page. Navigate to the

page where you want to add a child page, and click New Page.
4. Complete the required fields. If you are working with solution pages or creating new solution pages,

create or update the Title field and set the Theme value to IOC Portal 8 Theme. Ensure that the Type
of Page value is set to Static Content; the setting means that the IBM Intelligent Operations Center
page layout is used.

5. Click Add Portlets in the panels on the page and add content as detailed in the following steps.
v Click the top panel to add an IBM Intelligent Operations Center filter panel to the leading edge of

the new page.

Note: You can add only 0 or 1 filter panels per page.
v Click the second panel down to add a supporting content panel to the trailing edge of the new

page. Alternatively, you can add specialized content that uses the IBM Intelligent Operations Center
API.

v Click the third panel down to add a content panel to the page that includes the map, location map,
and list data. You can also click the third panel down to add both a KPI navigation tree and KPI
content pane to the page. Alternatively, you can add specialized content that uses the IBM
Intelligent Operations Center API.

v Click the bottom panel to add specialized content to the bottom of the new page; for example, a
ticker tape application.

6. Complete the modifications you require. For more information about using WebSphere Portal to
customize portlets, see the WebSphere Portal product documentation.

Note: When customizing a page, apart from the main content panel, any panels that are left empty
are not displayed in the new page. The empty panels are removed dynamically from the solution.
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Related information:

IBM WebSphere Portal 8 product documentation

Customizing the content panel
You can customize the content panel in IBM Intelligent Operations Center, and specify which tabs and
content to display. The content panel is implemented through a content viewer portlet, and an
administrator can customize it through the WebSphere Portal administrative interface.

About this task

The administrator adds comma-separated values to the ioc_ui_content_viewer_portlet portlet that
include a path, prefix, module name, and the order in which a new tab is displayed in the content panel.
The comma-separated values load a JavaScript module that provides the tab functionality.

Procedure
1. In the Supervisor: Operations view, click Portal Administration>Portlet Management>Portlets.
2. To customize the content panel, from the list of installed portlets, select

ioc_ui_content_viewer_portlet.
3. To configure the content panel settings, click Configure portlet and edit the required settings.
4. Enter the configuration parameter in the New parameter field with the prefix of contentView-Tab-XXX,

where XXX is the parameter name.
5. Enter the parameter values in the New value field as shown in Table 1. The table describes the

addition of two different example calendar components to the IBM Intelligent Operations Center
content panel tabs. Replace the following variables in the parameter values with the appropriate
values:
v PATH_LOCATION is the absolute path to the new content.
v PATH_NAME is the name of the path to the new content.
v MODULE is the name of the module. The module implements functions that are described in the

ioc_theme_static_js_web\WebContent\js\com\ibm\ioc\contentviewer\View.js file to respond to
different filter panel events. For example, select a data source.

v TAB_ORDER is the order in which the tab is displayed in the content panel. The order starts from 0,
where 0 is the first tab that is displayed.

Note: Specify the path and prefix parameter values if the module is not an Intelligent Operations
Center module.

Example

Table 37. Example settings for the addition of tabs to the content panel.

Parameter name Parameter value

contentView-Tab-Graph-Visualisation PATH_LOCATION:/test_ioc_common_widgets/js/
test,PATH_NAME:test,MODULE:test/com/bin/ioc/
contentviewer/views/SampleVisualisation,TAB_ORDER:3

contentView-Tab-locMap MODULE:ioc/com/ibm/map/MapViewWrapper,TAB_ORDER:0

Customizing components
1.6.0.2
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To extend and customize the functionality of your solution, you can create customized components that
you can add to the user interface. You can also replace an existing component with a customized
component. For example, for a particular system component, you can replace an existing preview card
with a new, customized preview card.

About this task

You can replace the following types of component with custom components:

Preview card
You can use customized preview cards for data sources.

Action
You can assign customized actions to data sources.

Full properties window
You can display a customized full properties window for data source items.

Advanced visualization
You can also customize how data source items, and hotspots, are rendered on the map by
configuring the advanced visualization component type.

Related tasks:
“Setting displayed and returned data item limits” on page 118
You can set the maximum number of data items that are returned to the map and the list, and that are
rendered on the map.

Creating components
1.6.0.2

Use the component customization tool to create customized components that you can add to the user
interface. For example, you can either create your own customized preview card, or you can create
actions that you make available in the More Actions menu on the preview card. You can also create
customized full properties windows and advanced visualization components.

Before you begin

Create and install a module that contains the code to implement the component. For example, to create a
custom action, implement the action through a Dojo script that is in a JavaScript file. You can download
sample custom modules that are packaged in a WAR file. For more information, see the Defining custom
modules topic that is in this section.

Note the module name, the path location, and the path name for the module.

Procedure
1. In the Solution Administration view, click Configuration Tools > Component Customization.
2. Click Create.
3. In the Create Custom Component window, enter the details for your custom component. The details

that you must enter include the following values:

Name For example, if you are creating a custom component by using one of the samples, enter one
of the following names:
v Sample Action

v Sample Map Visualization

v Sample Preview

Type Select the appropriate component type from the list. For example, if you are using the sample
action, select Action.
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Target The custom component is associated with the target value, for example, data source.

Path location
The path location value specifies the path to the module where the custom component is
implemented. If you are using one of the sample modules, enter the following path:
/ioc_sample_extensions/js/test

Path name
The path name value specifies a name for the path location. If you are using one of the
sample modules, enter the value sample.

Module name
The module name value specifies the name of the module where the custom component is
implemented. If you are using one of the sample modules, enter the correct module name
from the following list:
v sample/com/ibm/ioc/action/SampleCustomAction

v sample/com/ibm/ioc/previewcard/SampleCustomPropertiesPane

v sample/com/ibm/ioc/map/SampleCustomRenderer

Results

After you click OK in the Create Custom Component window, the name of the new component is listed
in the appropriate component type submenu under Configure Components.

Example

For example, if you added an action component that has the name Cancel All, the Configure
Components > Action submenu has a new Cancel All menu option.

What to do next

If you want to add the new component to the user interface, use the Add Components to User Interface
menu option.

Defining custom modules: 1.6.0.2

Define custom modules through Dojo scripts that you can use in your customized components. For
example, you can define custom modules to implement customized actions and preview cards. You can
download sample custom modules that are packaged in a WAR file and are ready to install into IBM
Intelligent Operations Center.

About this task

Do the following procedure on the data server. To view sample Dojo scripts that implement custom
modules, see the related link. The sample Dojo scripts are packaged in a WAR file that you can
download.

Procedure

1. To create and package custom modules, choose one of the following options:
v From the related link, download a WAR file that contains sample custom modules.
v Define each custom module through a Dojo script that is in a JavaScript file, and then create a WAR

file that contains the JavaScript files.
2. Install the WAR file into WebSphere Application Server.
3. Map the module to both the web server, which is the IBM HTTP Server server, and the portal cluster:
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Standard environment
WebSphere:cell=cell1,node=ihsnode1,server=ihsserver1
WebSphere:cell=cell1,cluster=PortalCluster

High availability environment
WebSphere:cell=cell1,node=ihsnode2,server=ihsserver2
WebSphere:cell=cell1,node=ihsnode1,server=ihsserver1
WebSphere:cell=cell1,cluster=PortalCluster

4. Ensure that the WAR file starts correctly.
5. In a browser, verify that you can access the JavaScript files at http://web_server/

ioc_sample_extensions/js/test/com/ibm/ioc/action. For example, verify that you can access the
sample custom action JavaScript file at http://web_server/ioc_sample_extensions/js/test/com/ibm/
ioc/action/SampleCustomAction.js.

Related information:

Sample custom modules

Configuring components
1.6.0.2

You can configure the settings for existing components that are in the system; for example, you can
modify the path and module settings for customized components.

About this task

For each of the component types, default components are indicated by a circular icon that contains a
diagonal line. For default components, you can edit only the name and description.

Procedure
1. In the Solution Administration view, click Configuration Tools > Component Customization >

Configure Components.
2. Click the type, and then click the name, of the component that you want to configure. For example, if

you want to edit the Update action component, click Action > Update.
3. Configure the component settings, and then click Save. For more information about the settings that

you can configure for customized components, see the Creating components topic.

Adding components to the user interface
1.6.0.2

Choose the components that you want to display in the user interface. You can customize specific system
components within a category of system components. For example, for data sources, you can specify that
a customized preview card is displayed for data items that are received from a particular data source.

Procedure
1. In the Solution Administration view, click Configuration Tools > Component Customization > Add

Components to User Interface.
2. Select the type of component that you want to either add, or replace. For example, if you want to

replace the default preview card that is displayed for items from a data source, select Preview Card. If
you want to add actions to the More Actions menu that is displayed for items from a data source,
select Action.

3. Select a system component that you want to customize. Depending on the type of component that
you selected, you can choose components from either Data Sources, or Hotspots.

4. Customize the system component by either adding or replacing components:
v If you selected Preview Card for the component type, select a preview card from the list of

available preview cards.
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v If you selected Action for the component type, select the actions that you want to use from the list
of available actions.

v If you selected Advanced Visualization for the component type, select the advanced visualization
that you want to use from the list.

v If you selected Full Properties Window for the component type, select the full properties window
that you want to use from the list.

5. Repeat the previous two steps for the other system components that you want to customize, and then
click Save.

Customizing KPIs
In IBM Intelligent Operations Center, you can customize key performance indicator (KPI) models to suit
your business processes.

KPIs are designed to supply statistical data that can be used to analyze trends or to indicate problem
areas. KPI data is updated by data items coming into the system from your data source.

IBM Intelligent Operations Center provides a set of sample KPIs and events that can be used to update
KPI status. There are three sample KPI models supplied with the IBM Intelligent Operations Center. The
models are based on the sample monitoring and business processes related to public safety,
transportation, and water supply. For more information about the sample KPIs, see the link.

Each solution follows a KPI creation and integration process to set up the KPIs required for the specific
business environment. You can create your own KPI models with the IBM Business Monitor. For more
information about creating and integrating KPIs with the IBM Intelligent Operations Center, see the link.

Use the Key Performance Indicators configuration tool to customize KPIs in the IBM Intelligent
Operations Center. The Key Performance Indicators tool is provided for the administrator as one of the
Solution Administration view options. For more information about configuring KPIs with the tool, see the
link.

Using the tool, you can view KPI properties; create, copy, or modify KPIs; and view or change the
hierarchical displays for KPI models.

Use the KPI Definition tab to define the KPIs associated with a specific KPI model in the IBM Intelligent
Operations Center. The following list outlines the options available on the KPI Definition tab:
v View the current list of KPIs belonging to a KPI model.
v View the properties of an existing KPI.
v Update the properties of an existing KPI.
v Create a KPI for a KPI model:

– An aggregate KPI has a value that is calculated with a defined metric
– An Expression KPI has a value that is based on other KPIs

v Delete a KPI.

Your updates are saved to IBM Business Monitor models stored in the IBM Intelligent Operations Center
database. Your updates are also reflected, at the next browser refresh, on the status views of the user
interface.

Note: KPIs created in IBM Business Monitor are defined as "modeled". Any KPIs created or copied in
IBM Intelligent Operations Center configuration tool are defined as "dashboard". Modeled KPIs cannot be
deleted and have some limitations on updating within the configuration tool.
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Use the Relationships and Display tab to update the KPI hierarchies that are displayed on the status
views.
v View the existing KPI hierarchies.
v View the main properties of a KPI.
v Change the tree structure by moving or removing items in a KPI hierarchy.
v Add predefined KPIs to a hierarchy.

Your updates are reflected at the next refresh of the status views in the user interface.

Note: Any updates to the display hierarchy are independent of the KPI model. An understanding of the
KPI model is necessary to ensure that the updates adhere to the logic of the KPI model.
Related concepts:
“Sample KPIs”
Sample KPIs are provided with the IBM Intelligent Operations Center. The sample KPIs are designed to
provide guidance for implementing different types of KPI with the IBM Business Monitor Development
Toolkit. Sample monitor models are provided for water, transportation, and public safety.
“Creating and integrating KPIs” on page 156
Key performance indicator (KPI) models can be created and modified using a business monitoring
development toolkit and the Key Performance Indicators configuration tool.
“Configuring KPIs” on page 120
In the Solution Administration view, you can configure Key Performance Indicators (KPIs) and their
hierarchical display in the user interface. The KPIs are displayed on the status views in IBM Intelligent
Operations Center.

Sample KPIs
Sample KPIs are provided with the IBM Intelligent Operations Center. The sample KPIs are designed to
provide guidance for implementing different types of KPI with the IBM Business Monitor Development
Toolkit. Sample monitor models are provided for water, transportation, and public safety.

The lowest level KPIs are defined as aggregate KPIs. Aggregate KPIs are calculated from values that are
contained in incoming data items and a function such as average, maximum, minimum, sum, number of
occurrences, or standard deviation. Their values are expressed as quantifiable measurements. The data
item properties that are routed to KPIs are identified in the data source configuration. The higher level
KPIs are mapped to values that are based on the mapping that was defined when the sample KPI was
created.

The value of a higher level sample KPI is a number that equates to a color and the level of response
recommended. A value of 0 is acceptable. A value of 1 indicates caution or monitoring. A value of 2
indicates that action is required. The value of the lowest level KPI is a duration, a decimal, a percentage,
or a currency that depends on the KPI it represents. The following values are examples of the lowest
level KPI values:
v 15% is the actual value of a KPI representing the percentage of delayed flights at a particular airport

over a period.
v 5 minutes, 7 seconds is the actual value of a KPI representing the average crime response time for a

location over a period.

The source files for the sample models are provided in an archive file that can be imported into Rational
Application Developer or WebSphere Integration Developer with the IBM Business Monitor Toolkit
installed. The archive file can be modified to change, add, or delete KPI definitions. The definitions can
then be regenerated and redeployed to the IBM Intelligent Operations Center. For more information about
KPI integration, see the link.

The following sample models are supplied with the IBM Intelligent Operations Center:
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v ioc_sample_public_safety_model

v ioc_sample_transportation_model

v ioc_sample_water_model

These models contain the following sample KPIs:
v Water

– Flood Control
- Water Levels

v Flow Discharge City River
v Water Level City Lake

– Water Management
- Strategical Planning

v Water Leakage
v Water Supply vs Demand

– Water Quality
- Physical Indicators

v Turbidity
v pH

v Transportation
– Airports

- Delayed Flights
v Delayed Flights Airport One
v Delayed Flights Airport Two

– Roads and Traffic
- Road Events

v Severe Traffic Accidents
– Transportation Management

- Revenue
v Bridges and Tunnel Tolls
v Parking Facilities Revenue

v Public Safety
– Fire Department

- Firefighter Injuries
v Firefighter Injuries Fire Station One
v Firefighter Injuries Fire Station Two

– Police Department
- Crime Response Time

v Crime Response Time Precinct One
v Crime Response Time Precinct Two

– Public Safety Management
- Public Safety Budget

v EMS Department Budget
v Fire Department Budget
v Police Department Budget

Related concepts:
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“Customizing KPIs” on page 178
In IBM Intelligent Operations Center, you can customize key performance indicator (KPI) models to suit
your business processes.
“Creating and integrating KPIs” on page 156
Key performance indicator (KPI) models can be created and modified using a business monitoring
development toolkit and the Key Performance Indicators configuration tool.

Backing up before customizing KPIs
Before customizing KPIs, back up existing KPIs in the IBM Intelligent Operations Center. This advice
applies to KPIs that created or modified with IBM Business Monitor, or with the Key Performance
Indicators configuration tool in IBM Intelligent Operations Center.

About this task

Before you customize KPI models and modify KPIs, you might want to back up existing models. The
procedure exports all KPIs from the specified model to the specified file, and imports KPIs from the
specified file to the specified model.

Procedure
1. Log on to the application server.
2. Change to the bin directory of the IBM Business Monitor profile: /opt/IBM/WebSphere/AppServer/

profiles/wbmProfile1/bin

3. To export KPIs, run the following command: ./wsadmin.sh -wsadmin_classpath "../../../plugins/
com.ibm.wbimonitor.lifecycle.spi.jar:../../../plugins/com.ibm.wbimonitor.repository.jar"
-lang jython -f "../../../scripts.wbm/kpi/exportKpis.jy" "xml_file_path"
model_IDmodel_version ALL

The variable xml_file_path represents the name and path of the XML file to which you are exporting
KPIs. The variables model_ID and model_version represent the ID and version of the KPI model from
which you are exporting KPIs.

Note: You can see the model_ID and model_version on the Relationships and Display tab of the Key
Performance Indicators tool. Click a KPI to see the KPI preview details.

4. To import KPIs, run the following command: ./wsadmin.sh -wsadmin_classpath "../../../plugins/
com.ibm.wbimonitor.lifecycle.spi.jar:../../../plugins/com.ibm.wbimonitor.repository.jar"
-lang jython -f "../../../scripts.wbm/kpi/importKpis.jy" "xml_file_path"

The variable xml_file_path represents the name and path of the XML file from which you are
importing KPIs.

Example

To export all KPIs from the model, ioc_sample_public_safety_model, to /tmp/kpis.xml, run the following
command. The value of xml_file_path is /tmp/kpis.xml. The value of model_ID is
ioc_sample_public_safety_model. The value of model_version is 2011-02-18T10:49:46.
./wsadmin.sh -wsadmin_classpath "../../../plugins/com.ibm.wbimonitor.lifecycle.spi.jar:
../../../plugins/com.ibm.wbimonitor.repository.jar" -lang jython -f "../../../scripts.wbm
/kpi/exportKpis.jy" "/tmp/kpis.xml" ioc_sample_public_safety_model
2011-02-18T10:49:46 ALL

For more information about working with KPI models, see the link to the IBM Business Monitor product
documentation.
Related information:

IBM Business Monitor product documentation
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Defining custom actions for data sources
1.6 1.6.0.1

You can define custom actions that are displayed as available actions on the Actions tab in the data
source configuration tool. If you assign a custom action to a data source, it is displayed in the More
Actions menu that is on the preview card for the data source.

About this task

In the following procedure, an action with the name Camera Feed is created as an example. Do the
procedure on the data server.

Procedure
1. Define the custom action through a Dojo script that is in a JavaScript file. For example, implement the

Dojo script in a JavaScript file that has the name CameraFeed.js. The Dojo script extends the
BaseMoreAction script. The Dojo script overrides the performAction function that is triggered when a
user selects an item in the More Actions menu. To view a sample Dojo script, see the related link.

2. Create a web module that contains the JavaScript file. Depending on how the web module is
packaged, it might be either a WAR file, or an EAR file.

3. Install the web module into WebSphere Application Server.
4. Map the module to both the IBM HTTP Server server and the portal cluster:

Standard environment
WebSphere:cell=cell1,node=ihsnode1,server=ihsserver1
WebSphere:cell=cell1,cluster=PortalCluster

High availability environment
WebSphere:cell=cell1,node=ihsnode2,server=ihsserver2
WebSphere:cell=cell1,node=ihsnode1,server=ihsserver1
WebSphere:cell=cell1,cluster=PortalCluster

5. In a browser, verify that you can access the JavaScript file at https://host:port/sample/custom/more/
actions/js/test/CameraFeed.js.

6. Define an entry for the custom action in the IOC.Available_Extensions database table. The following
SQL query defines an entry for the Camera Feed action.
INSERT INTO IOC.Available_Extensions (Name, Type, Disabled, Multiple, PathLocation, PathName, Module)
VALUES (’CameraFeed’, ’ACTION’, ’1’, ’0’, ’/sample/custom/more/actions/js’, ’exmp’, ’exmp/test/CameraFeed’);

The following list defines the parameters of the SQL query:

Name
The action name that is displayed in the available actions list in the data source configuration
tool. Do not insert spaces into the name.

Type
The type of extension. For custom actions, specify a value of ACTION.

Disabled
Specifies whether the action is assigned to every data source by default. Specify a value of 0 to
assign the action by default, otherwise specify a value of 1. In the available actions table in the
data source configuration tool, the values Yes and No indicate whether an action is assigned to the
data source.

Multiple
Specifies whether the action can be applied to multiple data items. To enable the action to be
applied to only single data items, specify a value of 0. To enable the action to be applied to
multiple data items, specify a value of 1.
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PathLocation
The path location for the JavaScript file that runs the action.

PathName
The path name for the JavaScript file that runs the action.

Module
The JavaScript module that runs the action.

7. To insert a globalization value for the Camera Feed action into the I18N_RESOURCE table in the IOC
database, enter the following command:
INSERT INTO IOC.I18N_RESOURCE ("GROUP", "LOCALE", "KEY", "VALUE")
VALUES (’PreviewCard’, ’default’, ’action_CameraFeed’, ’Camera Feed’);

Note: The value of KEY must have the prefix action_, for example, action_CameraFeed.

The previous SQL query inserts a globalization value for the default locale. You can insert a
globalization value for another locale: for LOCALE, enter the appropriate code, and for VALUE, enter an
action name that is appropriate to the locale.

Related tasks:
“Assigning actions to your data source” on page 113
You can choose which user actions to apply to data items that are received from your data source. Some
actions are applied by default.
Related information:

Sample Dojo scripts

Data item icons
You can design your own icons and upload image files to represent data items in the operations views,
the status views, and the Solution Administration view. The image files that you upload must meet
certain requirements.

The following list outlines the requirements that icon image files must satisfy:
v Store the icon in transparent PNG file format.
v Upload two image files for each icon, containing dark and light versions of the icon, so that the icon

can be seen throughout the solution interface:
– In the operations views, the light version of the icon is displayed when the color of the paddle is a

dark color, and the dark version of the icon is displayed when the color of the paddle is a light
color.

– In the status views, the light version of the icon is displayed
– In the administration views, the dark version of the icon is displayed.

v Both the dark version and the light version of the icon must be stored in an image file with the same
file name. Therefore, when you create the dark and light icon image files, you must store each file in a
separate directory to avoid one file overwriting the other.

Related tasks:
“Configuring the appearance of your data on the map” on page 113
Assign either an icon or a color to map markers to represent the data items from your data source. You
can set conditions to change the appearance of the map marker according to the value of a property that
is within your data source.

Displaying Cognos reports
1.6.0.1 1.6.0.2
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IBM Intelligent Operations Center provides a theme for creating reports pages and a reports portlet for
displaying Cognos reports. When you create a reports page, the page is displayed as a view in the IBM
Intelligent Operations Center interface.

Before you begin

You can configure a data source to be available for inclusion in Cognos reports:
1. In the data source configuration tool, click the Basics tab.
2. For Report model, select Yes.

If you want to display Cognos reports in a high availability environment, you must complete the
configuration that is described in the Configure the Cognos model in a high availability environment link.

For each report that you want to display, obtain the default action URL from the Cognos Connection
console. Then, edit the default action URL before you use it to configure Cognos reports as described in
the main procedure. To obtain and edit the default action URL, as a system administrator, complete the
following steps:
1. To open the Cognos Connection console, in the Solution Administration view, click System

Administration > Administration Consoles > Report Administration.
2. In the Cognos Connection console, expand the IOC directory.
3. In the reports portlet, locate the report that you want to display.
4. In the actions column for the report, click Set properties.
5. On the General tab, click View the search path, ID and URL.
6. Note the value of the Default Action URL.
7. In the IBM Intelligent Operations Center Solution Administration view, click System Properties >

AnalyticServerDispatchUrl, and copy the host name and the port number from the Value field.
8. In the default action URL that you noted, replace the host name and the port number with the host

name and the port number that you copied from the AnalyticServerDispatchUrl system property.
9. Ensure that the edited default action URL uses the HTTPS protocol.

Use the edited default action URL to configure a report as described in the main procedure.

About this task

The name of the reports theme is IOC Portal 8 Reports Theme and it contains two non-collapsible panes.
The name of the reports portlet is ioc_ui_reports_portlet. You can use the reports theme to create a
reports page and then position two reports portlets side by side in the reports page.

Because the preferences that you configure for a portlet are global, copy the reports portlet and then
customize the copied reports portlet to display Cognos reports.

In the Portal Administration view, use the following procedure to create a reports page that contains up
to two reports portlets. You can configure each reports portlet to contain up to three reports.

For more information about managing pages and portlets, see Creating or customizing a page, or the
WebSphere Portal Server product documentation.

Procedure
1. In the IBM Intelligent Operations Center interface, click Administration > Portal Administration.

Configure reports portlets
2. Click Portlet Management > Portlets.
3. Configure a reports portlet for display in the reports page:

a. Locate ioc_ui_reports_portlet in the list of portlets, and then click the Copy portlet icon.
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b. Save the copy of the reports portlet with an appropriate name, for example,
ioc_ui_cognos1_portlet.

c. Locate the new reports portlet in the list of portlets, and then click the Configure portlet icon.
d. Configure the height and URL of up to three reports to be displayed in the reports portlet.

Obtain the URL for each report by using the steps that are in the previous Before you begin
section.

e. To disable report headers and toolbars in the reports portlet that you display, add the following
value to the end of the URL for each report:
v &cv.toolbar=false&cv.header=false

4. Optional: Repeat the previous step to configure a second reports portlet for display in the reports
page.

Configure reports page
5. Click Portal User Interface > Manage Pages.
6. Click Content Root > City Name > Citywide.
7. Click New Page.
8. Select or specify the appropriate options for the reports page. For Theme, select IOC Portal 8

Reports Theme.
9. Configure the reports page to display the reports portlets that you created previously.

10. To disable report headers in the report that you display, configure the following report parameters
with a value of false:
v cv.toolbar

v cv.header

What to do next

For more information about configurable report parameters, see the IBM Cognos Business Intelligence
product documentation.
Related tasks:
“Creating or customizing a page” on page 173
If you are an administrator, you can create new pages to be included in IBM Intelligent Operations
Center, and specify what content to display on those pages. You can customize the appearance and layout
of the content that is included on each page.
“Configure the Cognos model in a high availability environment” on page 75
IBM Intelligent Operations Center can publish a Cognos model when a data source is created or updated.
In a high availability environment, you must configure Cognos to enable IBM Intelligent Operations
Center to publish the Cognos model.
Related information:

IBM WebSphere Portal 8 product documentation

Configuring IBM logos in the solution
You can modify the IBM titles and logos that are displayed in IBM Intelligent Operations Center.

Procedure

Note: If you have a high availability environment, edit the relevant logo files on both of the application
servers in the cluster. If you modify the IBM Intelligent Operations Center file system, for example, if you
replace a logo image file, recursively set the permissions on any changed files. Set the file owner value to
ibmadmin and set the file group value to ibmadmins.
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v To customize the title that is displayed in the banner of IBM Intelligent Operations Center views, for
example, City Name, complete the following steps in the Portal Administration view:
1. Click Portal User Interface > Manage Pages > Content Root.
2. In the table, find the row that has the value ioc.Home for the Unique name or Identifier.
3. Click the Edit Page Properties icon.
4. Edit the value of the Title field.

v To customize the browser title in IBM Intelligent Operations Center views, complete the following
steps:
1. Log on to the database server as db2inst2.
2. The i18n_resource table is in the ioc schema in the iocdb database. In the i18n_resource table, modify

the value for all entries that have a group value of Theme and a key value of theme_title. To retrieve
the entries, complete the following instructions:
db2 connect to iocdb
db2 select * from ioc.i18n_resource where group=’Theme’ and key=’theme_title’

v You can customize the IBM logo that is displayed in the upper corner of the banner in IBM Intelligent
Operations Center views, for example, the Solution Administration views. Log on to the application
server as the root user and choose one of the following options.
1. To change the IBM logo on either Solution Administration views, or white-themed views, replace

the following PNG file:
/opt/IBM/WebSphere/wp_profile/installedApps/cell1/ioc_theme_ear.ear/
ioc_theme_static_js_web.war/compressedJS/idx/themes/oneui/idx/app/
images/headerLogo.png

2. To change the IBM logo on dark-themed views, replace the following file:
/opt/IBM/WebSphere/wp_profile/installedApps/cell1/ioc_theme_ear.ear/
ioc_theme_static_js_web.war/compressedJS/idx/themes/oneuidark/idx/app/
images/headerLogo.png

3. To change the IBM logo on gray-themed views, replace the following file:
/opt/IBM/WebSphere/wp_profile/installedApps/cell1/ioc_theme_ear.ear/
ioc_theme_static_js_web.war/compressedJS/idx/themes/oneuidarkgrey/idx/app/
images/headerLogo.png

v To change the IBM logo that is displayed in the banner on the login page for the solution, log on to the
application server as the root user and complete the following steps:
1. Edit the following styles.css file:

/opt/IBM/WebSphere/wp_profile/installedApps/cell1/ioc_theme_ear.ear/
ioc_theme_static_css_web.war/ioc/login.css

2. At the end of the styles.css file, add custom CSS content that is similar to the following example
code:
.wpthemeBanner .wpthemeBranding img {

background-image: url("../images/custom_logo.jpg");
background-position: 0 0;
width:80px;
height:80px;

}

where:
custom_logo.jpg is the custom logo file.

3. In the styles.css file, edit the values of height and width for the logo as required.
4. Copy the custom logo file, for example, custom_logo.jpg, to the following directory:
/opt/IBM/WebSphere/wp_profile/installedApps/cell1/ioc_portal_ear.ear/
ioc_ui_login_portlet.war/_ioc_ui_login_portlet/images

v To customize the background image file for the login page, replace the following file:
/opt/IBM/WebSphere/wp_profile/installedApps/cell1/ioc_portal_ear.ear/
ioc_ui_login_portlet.war/images/ioc_login_background_19201280.jpg
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Chapter 7. Administering the solution

Administer IBM Intelligent Operations Center in the Solution Administration view.

Logging on
Log on to access the IBM Intelligent Operations Center user interface.

Before you begin

Contact your local administrator to obtain your user ID and password. Your administrator is responsible
for ensuring that you have the security access level that is appropriate to your role in your organization.
Your administrator will also supply you with the web address URL for accessing the solution portal.

About this task

Use the following procedure to start a new browser session and access IBM Intelligent Operations Center.
You can also access the solution from other IBM Smarter Cities Software Solutions that are installed in
your environment. From the main navigation bar at the top of the portal, select IBM Intelligent
Operations Center.

Procedure
1. Enter the URL into the address field of the browser.

Note: The fully qualified domain name is required in the URL, for example, https://web_hostname/
wps/portal where web_hostname is the host name of the web server. If you use the IP address instead
of the registered fully qualified domain name, some windows do not open correctly.

2. On the login page, enter your user ID and password.
3. Click Log In.

Results

Only the pages, features, and data that you have permission to access are displayed. Contact your
administrator if you require more access.

Viewing product version details
In the Solution Administration view, you can view details of the version of IBM Intelligent Operations
Center and the integrated IBM Smarter Cities Software Solutions that you installed. You can also view
details of any updates that you applied since installation.

In the Solution Administration view, click System Administration > About. This page displays details
about installed software, components, and fixes.

Note: The information that is displayed for each fix depends on the completion of the appropriate step in
the installation instructions that are supplied with that fix.

Administering the services
Use the Administration Consoles to administer the services that are provided by the solution.
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For each service, links in the Administration Consoles direct you either to an administration console, or
to information about how to access administration.

You can customize the links through system properties; for example, you can specify whether an
administration console link uses either the http protocol, or the https protocol. By default, the
administration console links use the https protocol. For more information about system properties, see the
link at the end of the topic.

Web server

Table 38. Administration on the web server

Console Administration

Web server To administer security on the web server, use the link to
the WebSphere Application Server 8.0 Deployment
Manager console for IBM HTTP Server.

Application server

Table 39. Administration on the application server

Console Administration

Application server To administer various services that are provided by IBM
Intelligent Operations Center, use the links to the
web-based consoles for WebSphere Application Server.
You can control the servers, manage resources and
service providers, change host settings and other
environmental settings.

Contacts administration For information about how to download and set up
Domino Administration Client for Lotus Domino
contacts administration, see the IBM Lotus Domino and
Notes product documentation.

Security Identity Manager Use the link to the web-based console for Security
Identity Manager to centrally administer user and
application IDs, and to manage passwords, user
provisioning, and auditing capabilities. You can use
LDAP and Linux adapters that are installed and
configured in IBM Tivoli Directory Integrator to remotely
manage LDAP and Linux accounts from Security Identity
Manager.

Mobile application development To manage the repository of mobile applications, track
devices that are registered with the IBMWorklight
Application Center, and view the applications that are
installed on a specific device, use the link to the IBM
Worklight Application Center 6.0 console.

1.6.0.2 OIP administration Use the link to the web-based console for OIP
administration to centrally administer and configure the
optimized interactive process tasks and settings for the
solution. For example, to configure SMS or email settings
for the solution.
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Data server

Table 40. Administration on the data server

Console Administration

Database For information about how to administer the database
with DB2 Enterprise Server Edition, see the IBM DB2
Database for Linux, UNIX, and Windows product
documentation. You can perform tasks with the database
control center GUI or the command line.

Directory To administer the user’s directory, use the web-based
console for Tivoli Directory Server. For information about
how to use the Tivoli Directory Server web-based
console, see the IBM Tivoli Directory Server product
documentation.

Analytics server

Table 41. Administration on the analytics server

Console Administration

Report administration To set up reports, use the link to the web-based console
for IBM Cognos Connection. You can create new reports
or modify existing ones. You can also configure data
sources, set up public and private folders, define
permissions and distribution, and schedule reports to run
automatically.

Data mining and modeling For information about using the IBM SPSS Modeler data
mining tools to develop and deploy predictive models
for improved decision making, see the link to the IBM
SPSS Modeler product documentation.

Data optimization For information about how to build optimization models
by using mathematical algorithms, see the link to the
IBM ILOG CPLEX Optimization Studio product
documentation.

Messaging For information about defining and administering local
and remote WebSphere MQ objects, such as queues and
queue managers, see the link to the WebSphere MQ
product documentation.

Message bus For information about configuring and administering
message brokers, and for information about developing,
testing, and debugging message flow applications, see
the link to the WebSphere Message Broker product
documentation.

Related tasks:
“Configuring system properties”
View, create, modify, and delete system properties in the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent Operations Center.

Configuring system properties
View, create, modify, and delete system properties in the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent Operations Center.
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Procedure

To view, create, modify, or delete system properties, in the Solution Administration view, click System
Administration > System Properties. To view the value and description of a system property, click the
name of the property. Click the field help icons to view information about the names and values that you
can enter.
v To create a system property, click Create:

1. In the Create a System Property window, enter a value for Name.
2. Optional: Enter a value for Value.
3. Optional: Enter a value for Group. System properties that are members of the same group can be

retrieved by a single call to the system properties REST service.
4. Optional: Enter a value for Description.
5. Click OK.

v To modify a system property, click the name of the property:
1. Edit the Value, Description, and Group for the property as appropriate.
2. Click Save.

v To delete a system property, click the name of the property:
1. Click Delete.
2. In the confirmation window, click OK.

Starting, stopping, and querying status in a standard environment
The platform control tool allows a user to stop, start, and query IBM Intelligent Operations Center
components running in a standard environment. A platform control tool tool is also available for IBM
Intelligent Operations Center running in a high availability environment.
Related concepts:
“Starting, stopping, and querying status in a high availability environment” on page 198
The platform control tool allows a user to stop, start, and query IBM Intelligent Operations Center
services running in a high availability environment. A platform control tool tool is also available for IBM
Intelligent Operations Center running in a standard environment.
“What's new in version 1.6.0.2” on page 14
IBM Intelligent Operations Center version 1.6.0.2 provides several new features, and provides updates to
existing features. New features include enhanced user profile management, where users can customize
notification settings. Solution administrators can use a new component customization tool to create
customized user interface components. For KPIs, solution administrators can map KPIs to reports.

Understanding platform control tool standard environment
components

1.6.0.2

Platform control tool components are combined into logical groupings and named using a parent/child
relationship.

For example, in the standard environment, directory components can be started, stopped, or queried at
the base level or at lower component levels.
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Table 42. Example directory component and subcomponent platform control tool names in the standard environment

Base component Components Subcomponents

dir dbstds dbstdsadm

dbstdsserv

dbstdi

Base components for the standard environment are:

dir Directory components

dbs Database components

sec Security components

msg Messaging components

col Collaboration components

app Application components

ana Analytics components

Components and subcomponents are named in the form server + product or service. For example, dbstds
is Tivoli Directory Server on the data server.

For more information on component and subcomponent names, see the iopmgmt.std.help.txt file
shipped with IBM Intelligent Operations Center.

Starting the components in a standard environment
The platform control tool can be used to start the components running on IBM Intelligent Operations
Center standard environment servers.

About this task

The IOCControl command must be run as the ibmadmin user. If not logged on as the ibmadmin, run the su
- ibmadmin command to switch to the ibmadmin user.

Attention: Starting individual components should only be done by experienced IBM Intelligent
Operations Center administrators. Unpredictable results can occur if components are not started in the
required order.

Procedure

On the analytics server run the following command to start all the IBM Intelligent Operations Center
components.
IOCControl -a start -c all -p password

where password is the topology password defined when the IBM Intelligent Operations Center was
installed. If the password value contains special characters, the password value must be enclosed in single
quotation marks. For example: ’pass$phrase’
The components are started in the required order. Prerequisite components are started before dependent
components. For example, database and directory components are started first.
To start only one component, run the following command.
IOCControl -a start -c component -p password
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where component is an ID listed under Target Options in the IOCControl help and where password is the
topology password defined when the IBM Intelligent Operations Center was installed. If the password
value contains special characters, the password value must be enclosed in single quotation marks. For
example: ’pass$phrase’
Optionally the nostatus option can be added to the command. This will suppress any output returned
from the command.

Results

The requested IBM Intelligent Operations Center components are started.

What to do next

If the IOCControl command did not result in the desired outcome, check the logs in the
/opt/IBM/ISP/mgmt/logs directory. The logs contain the results of the most recent IOCControl command.

1.6.0.2 The log file name begins with the action specified for -a.
Related tasks:
“Stopping the components in a standard environment” on page 194
The platform control tool can be used to stop components running on IBM Intelligent Operations Center
standard environment servers.
“Querying the status of the components in a standard environment” on page 197
The platform control tool can be used to determine the status of the components running on IBM
Intelligent Operations Center standard environment servers.
“Getting help for the platform control tool in a standard environment” on page 198
Information is available about the options for running the platform control tool in a standard
environment.

Required start order in the V1.6.0.2 standard environment
1.6.0.2

In the standard environment, IBM Intelligent Operations Center components must be started in a specific
order.

The platform control tool is used to start IBM Intelligent Operations Center components. While it is
recommended that the platform control tool -a start -c all -p password command be used to start all
components, there might be times when individual components need to be started.

The following table shows the required start order for the components. Components can be started by
using the base component or individual component for the -c value.

Table 43. Start order for IBM Intelligent Operations Center standard edition components

Base component Component Started product or service

dir dbstds Tivoli Directory Server

dbstdi Tivoli Directory Integrator

dbs dbsdb24adm DB2 Enterprise Server Edition administration server

dbsdb24mid DB2 Enterprise Server Edition for middleware

dbsdb24app DB2 Enterprise Server Edition for applications

sec appisim IBM Security Identity Manager

msg anamb IBM Message Broker

col appdomino IBM Lotus Sametime
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Table 43. Start order for IBM Intelligent Operations Center standard edition components (continued)

Base component Component Started product or service

app appdmgr WebSphere Application Server Deployment Manager

appbmon IBM Business Monitor

appstproxy IBM Lotus Sametime Proxy Server

appwrklt IBM Worklight

appwpe WebSphere Portal Extend

appiop Intelligent Operations Platform server

webihs IBM HTTP Server

ana anacognos IBM Cognos Business Intelligence

anacplex IBM ILOG CPLEX Optimization Studio

anaspss IBM SPSS Modeler

Required start order in the V1.6 and V1.6.0.1 standard environment
1.6 1.6.0.1

In the standard environment, IBM Intelligent Operations Center components must be started in a specific
order.

The platform control tool is used to start IBM Intelligent Operations Center components. While it is
recommended that the platform control tool -a start -c all -p password command be used to start all
components, there might be times when individual components need to be started.

Some components have dependencies on other components, so components must be started in a specific
order.

In general, components should be started in three groups:

Group 1
tds, db24mid, db24app

Group 2
sim

Group 3
all remaining components

Start the components in group 1 first, then start group 2, and finally start group 3. The components
within each group can be started in any order.

Table 44. IBM Intelligent Operations Center component start order dependencies

Component Description

Components that must be
running before this
component is started

tds Tivoli Directory Server None

db24mid DB2 Enterprise Server Edition for middleware None

db24app DB2 Enterprise Server Edition for applications None

sim IBM Security Identity Manager tds

appdmgr WebSphere Application Server Deployment Manager tds

wbm WebSphere Business Modeler tds, wpe
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Table 44. IBM Intelligent Operations Center component start order dependencies (continued)

Component Description

Components that must be
running before this
component is started

st IBM Lotus Sametime tds

stproxy IBM Lotus Sametime Proxy Server tds

wpe WebSphere Portal Extend tds

wmb IBM Message Broker tds

cognos IBM Cognos Business Intelligence tds, wpe

wrklit IBM Worklight tds, wpe

iopsvr Intelligent Operations Platform server tds, wpe

ihsweb IBM HTTP Server tds

Stopping the components in a standard environment
The platform control tool can be used to stop components running on IBM Intelligent Operations Center
standard environment servers.

About this task

The IOCControl command must be run as the ibmadmin user. If not logged on as the ibmadmin, run the su
- ibmadmin command to switch to the ibmadmin user.

Attention: Stopping individual components should only be done by experienced IBM Intelligent
Operations Center administrators. Unpredictable results can occur if components are not stopped in the
required order.

Procedure

On the analytics server run the following command to stop all the IBM Intelligent Operations Center
components.
IOCControl -a stop -c all -p password

where password is the topology password defined when the IBM Intelligent Operations Center was
installed. If the password value contains special characters, the password value must be enclosed in single
quotation marks. For example: ’pass$phrase’
To stop only one component, run the following command.
IOCControl -a stop -c component -p password

where component is an ID listed under Target Options in the IOCControl help and where password is the
topology password defined when the IBM Intelligent Operations Center was installed. If the password
value contains special characters, the password value must be enclosed in single quotation marks. For
example: ’pass$phrase’

1.6.0.2 Optionally the nostatus option can be added to the command. This will suppress any output
returned from the command.

Results

The requested IBM Intelligent Operations Center components are stopped.
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What to do next

If the IOCControl command did not result in the desired outcome, check the logs in the
/opt/IBM/ISP/mgmt/logs directory. The logs contain the results of the most recent IOCControl command.

1.6.0.2 The log file name begins with the action specified for -a.
Related tasks:
“Starting the components in a standard environment” on page 191
The platform control tool can be used to start the components running on IBM Intelligent Operations
Center standard environment servers.
“Querying the status of the components in a standard environment” on page 197
The platform control tool can be used to determine the status of the components running on IBM
Intelligent Operations Center standard environment servers.
“Getting help for the platform control tool in a standard environment” on page 198
Information is available about the options for running the platform control tool in a standard
environment.

Required stop order in the V1.6.0.2 standard environment
1.6.0.2

In the standard environment, IBM Intelligent Operations Center components must be stopped in a
specific order.

The platform control tool is used to stop IBM Intelligent Operations Center components. While it is
recommended that the platform control tool -a stop -c all -p password command be used to stop all
components, there might be times when individual components need to be stopped.

The following table shows the required stop order for the components. Components can be stopped by
using the base component or individual component for the -c value.

Table 45. Stop order for IBM Intelligent Operations Center standard edition components

Base component Component Started product or service

ana anaspss IBM SPSS Modeler

anacplex IBM ILOG CPLEX Optimization Studio

anacognos IBM Cognos Business Intelligence

app webihs IBM HTTP Server

appiop Intelligent Operations Platform server

appwpe WebSphere Portal Extend

appwrklt IBM Worklight

appstproxy IBM Lotus Sametime Proxy Server

appbmon WebSphere Business Modeler

appdmgr WebSphere Application Server Deployment Manager

col appdomino IBM Lotus Sametime

msg anamb IBM Message Broker

sec appisim IBM Security Identity Manager

dbs dbsdb24app DB2 Enterprise Server Edition for applications

dbsdb24mid DB2 Enterprise Server Edition for middleware

dbsdb24adm DB2 Enterprise Server Edition administration server
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Table 45. Stop order for IBM Intelligent Operations Center standard edition components (continued)

Base component Component Started product or service

dir dbstdi Tivoli Directory Integrator

dbstds Tivoli Directory Server

Required stop order in the V1.6 and V1.6.0.1 standard environment
1.6 1.6.0.1

In the standard environment, IBM Intelligent Operations Center components must be stopped in a
specific order.

The platform control tool is used to stop IBM Intelligent Operations Center components. While it is
recommended that the platform control tool -a stop -c all -p password command be used to stop all
components, there might be times when individual components need to be stopped.

Some components have dependencies on other components, so components must be stopped in a specific
order.

In general, components should be stopped in three groups:

Group 1
appdmgr, ihsweb, wbm, st, stproxy, wpe, wmb, cognos, wrklt, iopsvr

Group 2
sim

Group 3
db24mid, db24app, tds

Stop the components in group 1 first, then stop group 2, and finally stop group 3. The components
within each group can be stopped in any order.

Table 46. IBM Intelligent Operations Center component stop order dependencies

Component Description

Components that must be
stopped before this
component is stopped

appdmgr WebSphere Application Server Deployment Manager wpe

ihsweb IBM HTTP Server wpe

wbm WebSphere Business Modeler None

st IBM Lotus Sametime stproxy

stproxy IBM Lotus Sametime Proxy Server None

wpe WebSphere Portal Extend iopsvr, wrklt, cognos, wbm

wmb IBM Message Broker None

cognos IBM Cognos Business Intelligence None

wrklit IBM Worklight None

iopsvr Intelligent Operations Platform server None

sim IBM Security Identity Manager None

db24mid DB2 Enterprise Server Edition for middleware wpe

db24app DB2 Enterprise Server Edition for applications wpe

tds Tivoli Directory Server All other services
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Querying the status of the components in a standard environment
The platform control tool can be used to determine the status of the components running on IBM
Intelligent Operations Center standard environment servers.

About this task

The IOCControl command must be run as the ibmadmin user. If not logged on as the ibmadmin, run the su
- ibmadmin command to switch to the ibmadmin user.

Procedure

On the analytics server run the following command to query the status all the IBM Intelligent Operations
Center components.
IOCControl -a status -c all -p password

where password is the topology password defined when the IBM Intelligent Operations Center was
installed. If the password value contains special characters, the password value must be enclosed in single
quotation marks. For example: ’pass$phrase’
To check only one component, run the following command.
IOCControl -a status -c component -p password

where component is an ID listed under Target Options in the IOCControl help and where password is the
topology password defined when the IBM Intelligent Operations Center was installed. If the password
value contains special characters, the password value must be enclosed in single quotation marks. For
example: ’pass$phrase’

Results

Components that are started will display [ on ]. Components that are not started will display [ off ].

1.6.0.2 If [ unknown ] is displayed, a problem occurred while trying to determine the status of the
component. Possible problems include:
v A network connection problem between the platform control tool and the component.
v A resource shortage on the server. For example, lack of available disk space for logging resulting in the

server being unable to handle new work requests.
v An optional product not completely installed.
v Other component-specific issues.

Retry the command. If [ unknown ] continues to be displayed, check the logs for additional information.

Note: 1.6.0.2 If the component specified by -c has defined subcomponents, the status of the
subcomponents are displayed instead of the status of the parent component. The platform control tool
help lists the components and subcomponents defined by IBM Intelligent Operations Center.

What to do next

If the IOCControl command did not result in the desired outcome, check the logs in the
/opt/IBM/ISP/mgmt/logs directory. The logs contain the results of the most recent IOCControl command.
Related tasks:
“Starting the components in a standard environment” on page 191
The platform control tool can be used to start the components running on IBM Intelligent Operations
Center standard environment servers.
“Stopping the components in a standard environment” on page 194
The platform control tool can be used to stop components running on IBM Intelligent Operations Center
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standard environment servers.
“Getting help for the platform control tool in a standard environment”
Information is available about the options for running the platform control tool in a standard
environment.

Getting help for the platform control tool in a standard environment
Information is available about the options for running the platform control tool in a standard
environment.

About this task

The IOCControl command must be run as the ibmadmin user. If not logged on as the ibmadmin, run the su
- ibmadmin command to switch to the ibmadmin user.

Procedure

On the analytics server run the one of the following commands to see options for the IOCControl
command.

1.6.0.2

IOCControl -a help
or IOCControl -h

1.6 1.6.0.1

IOCControl -a 000
or
IOCControl -h

Results

The options for the IOCControl command are displayed.
Related tasks:
“Starting the components in a standard environment” on page 191
The platform control tool can be used to start the components running on IBM Intelligent Operations
Center standard environment servers.
“Stopping the components in a standard environment” on page 194
The platform control tool can be used to stop components running on IBM Intelligent Operations Center
standard environment servers.
“Querying the status of the components in a standard environment” on page 197
The platform control tool can be used to determine the status of the components running on IBM
Intelligent Operations Center standard environment servers.

Starting, stopping, and querying status in a high availability
environment
The platform control tool allows a user to stop, start, and query IBM Intelligent Operations Center
services running in a high availability environment. A platform control tool tool is also available for IBM
Intelligent Operations Center running in a standard environment.
Related concepts:
“Starting, stopping, and querying status in a standard environment” on page 190
The platform control tool allows a user to stop, start, and query IBM Intelligent Operations Center
components running in a standard environment. A platform control tool tool is also available for IBM
Intelligent Operations Center running in a high availability environment.
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“What's new in version 1.6.0.2” on page 14
IBM Intelligent Operations Center version 1.6.0.2 provides several new features, and provides updates to
existing features. New features include enhanced user profile management, where users can customize
notification settings. Solution administrators can use a new component customization tool to create
customized user interface components. For KPIs, solution administrators can map KPIs to reports.

Understanding platform control tool high availability environment
components

1.6.0.2

Platform control tool components are combined into logical groupings and named using a parent/child
relationship.

For example, in the high availability environment, directory components can be started, stopped, or
queried at the base level or at lower component levels.

Table 47. Example directory component and subcomponent platform control tool names in the high availability
environment

Base component Components Subcomponents Sub-subcomponents

dirgrp dirpri dbstdspri dbstdsapmpri

dbstdsservpri

anatdsproxypri anatdsproxyadmpri

anatdsproxyservpri

dbstdipri

dirsby dbstdssby dbstdsadmsby

dbstdsservsby

anatdsproxysby anatdsproxyadmsby

anatdsproxyservsby

Base components for the high availability environment are:

dirgrp Directory components

dbsgrp Database components

secgrp Security components

msggrp Messaging components

colgrp Collaboration components

appgrp Application components

anagrp Analytics components

Components and subcomponents are named in the form server + product or service. For example,
dbstdspri is Tivoli Directory Server on data server 1.

For more information on component and subcomponent names, see the iopmgmt.ha.help.txt file shipped
with IBM Intelligent Operations Center.

Starting the components in a high availability environment
The platform control tool can be used to start the components running on IBM Intelligent Operations
Center high availability environment servers.
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About this task

The IOCControl command must be run as the ibmadmin user. If not logged on as the ibmadmin, run the su
- ibmadmin command to switch to the ibmadmin user.

Attention: Starting individual components should only be done by experienced IBM Intelligent
Operations Center administrators. Unpredictable results can occur if components are not started in the
required order.

Procedure
1. Log on to analytics server 1 or analytics server 2 as the ibmadmin user. If logged on as a different user,

change to the ibmadmin user by running the su - ibmadmin command. Under normal operations use
the platform control tool on analytics server 1. If analytics server 1 is unavailable you can run the
platform control tool on analytics server 2 . Do not use the platform control tool on analytics server 1
and analytics server 2 at the same time or unpredictable results can occur.

2. 1.6.0.2 Run the following command to start all the IBM Intelligent Operations Center components.
IOCControl -a start -c all -p password

where password is the topology password defined when the IBM Intelligent Operations Center was
installed. If the password value contains special characters, the password value must be enclosed in
single quotation marks. For example: ’pass$phrase’
Optionally the nostatus option can be added to the command. This will suppress any output returned
from the command.
The components are started in the required order. Prerequisite components are started before
dependent components. For example, database and directory components are started first.
To start only one component, run the following command.
IOCControl -a start component -p password

where component is an ID listed in the IOCControl help and where password is the topology password
defined when the IBM Intelligent Operations Center was installed. If the password value contains
special characters, the password value must be enclosed in single quotation marks. For example:
’pass$phrase’

Optionally the nostatus option can be added to the command. This will suppress any output returned
from the command.

3. 1.6 1.6.0.1 Run the following command to start all the IBM Intelligent Operations Center
components.
IOCControl -a 001 -p password

where password is the topology password defined when the IBM Intelligent Operations Center was
installed. If the password value contains special characters, the password value must be enclosed in
single quotation marks. For example: ’pass$phrase’
Optionally the nostatus option can be added to the command. This will suppress any output returned
from the command.
The components are started in the required order. Prerequisite components are started before
dependent components. For example, database and directory components are started first.
To start only one component, run the following command.
IOCControl -a action -p password

where action is an ID listed in the IOCControl help and where password is the topology password
defined when the IBM Intelligent Operations Center was installed. If the password value contains
special characters, the password value must be enclosed in single quotation marks. For example:
’pass$phrase’
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Optionally the nostatus option can be added to the command. This will suppress any output returned
from the command.

Results

The requested IBM Intelligent Operations Center components are started.

What to do next

If the IOCControl command did not result in the desired outcome, check the logs in the
/opt/IBM/ISP/mgmt/logs directory. The logs contain the results of the most recent IOCControl command.

1.6.0.2 The log file name begins with the action specified for -a.
Related tasks:
“Stopping the components in a high availability environment” on page 203
The platform control tool can be used to stop components running on IBM Intelligent Operations Center
high availability servers.
“Querying the status of the components in a high availability environment” on page 207
The platform control tool can be used to determine the status of the components running on IBM
Intelligent Operations Center high availability environment servers.
“Getting help for the platform control tool in a high availability environment” on page 208
Information is available about the options for running the platform control tool in a high availability
environment.

Required start order in a V1.6.0.2 high availability environment
1.6.0.2

In the high availability environment, IBM Intelligent Operations Center components must be started in a
specific order.

The platform control tool is used to start IBM Intelligent Operations Center components. While it is
recommended that the platform control tool -a start -c all -p password command be used to start all
components, there might be times when individual components need to be started.

The following table shows the required start order for the components. Components can be stopped by
using the base component or individual component for the -c value.

Table 48. Start order for IBM Intelligent Operations Center high availability components

Base component Component Description

dirgrp dirpri Start platform directory components (primary)

v Tivoli Directory Server

v Tivoli Directory Server proxy server

v Tivoli Directory Integrator

dirsby Start platform directory components (standby)

v Tivoli Directory Server

v Tivoli Directory Server proxy server
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Table 48. Start order for IBM Intelligent Operations Center high availability components (continued)

Base component Component Description

dbsgrp dbssby Start database components (standby)

v DB2 Enterprise Server Edition administration server

v DB2 Enterprise Server Edition for middleware

v DB2 Enterprise Server Edition for applications

dbspri Start database components (primary)

v DB2 Enterprise Server Edition administration server

v DB2 Enterprise Server Edition for middleware

v DB2 Enterprise Server Edition for applications

secgrp secpri Start security components (primary)

v IBM Security Identity Manager

secsby RESERVED

msggrp msgpri Start platform messaging servers (primary)

v IBM Message Broker

msgsby Start platform messaging servers (standby)

v IBM Message Broker

colgrp colpri Start collaboration components (primary)

v IBM Lotus Sametime

colsby RESERVED

appgrp apppri Start platform application servers (primary)

v WebSphere Application Server Deployment Manager

v IBM Business Monitor

v IBM Lotus Sametime Proxy Server

v IBM Worklight

v WebSphere Portal Extend

v Intelligent Operations Platform server

v IBM HTTP Server

appsby Start platform application servers (standby)

v WebSphere Application Server Deployment Manager

v IBM Business Monitor

v IBM Lotus Sametime Proxy Server

v IBM Worklight

v WebSphere Portal Extend

v Intelligent Operations Platform server

v IBM HTTP Server

anagrp anapri Start platform analytics servers (primary)

v IBM Cognos Business Intelligence

v IBM ILOG CPLEX Optimization Studio

v IBM SPSS Modeler

anasby Start platform analytics servers (standby)

v IBM Cognos Business Intelligence

v IBM ILOG CPLEX Optimization Studio

v IBM SPSS Modeler
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Required start order in a V1.6 and V1.6.0.1 high availability environment
1.6 1.6.0.1

In the high availability environment, IBM Intelligent Operations Center components must be started in a
specific order.

The platform control tool is used to start IBM Intelligent Operations Center components. While it is
recommended that the platform control tool start all option be used to start all components, there might
be times when individual components need to be started.

Some components have dependencies on other components, so components must be started in a specific
order.

Table 49. IBM Intelligent Operations Center component start order dependencies

Component Description

Services that must be
running before this
component is started

101 Start LDAP components (primary) None

111 Start LDAP components (standby) 101

121 Start LDAP proxy components (primary) 101

131 Start LDAP proxy components (standby) 111, 121

141 Start database components (standby) None

151 Start database components (primary) 141, 903

201 Start platform applications servers (primary) 101

211 Start platform applications servers (standby) 111

221 Start platform analytics servers (primary) 101

231 Start platform analytics servers (standby) 111

241 Start platform messaging servers (primary) 101

251 Start platform messaging servers (standby) 111

261 Start collaboration components (primary) 101

271 Start reporting components (primary) 101

301 Start web components (primary) 101

311 Start web components (standby) 101

Stopping the components in a high availability environment
The platform control tool can be used to stop components running on IBM Intelligent Operations Center
high availability servers.

About this task

The IOCControl command must be run as the ibmadmin user. If not logged on as the ibmadmin, run the su
- ibmadmin command to switch to the ibmadmin user.

Attention: Stopping individual components should only be done by experienced IBM Intelligent
Operations Center administrators. Unpredictable results can occur if components are not stopped in the
required order.

Chapter 7. Administering the solution 203



Procedure
1. Log on to analytics server 1 or analytics server 2 as the ibmadmin user. If logged on as a different user,

change to the ibmadmin user by running the su - ibmadmin command. Under normal operations use
the platform control tool on analytics server 1. If analytics server 1 is unavailable you can run the
platform control tool on analytics server 2 . Do not use the platform control tool on analytics server 1
and analytics server 2 at the same time or unpredictable results can occur.

2. 1.6.0.2 Run the following command to stop all the IBM Intelligent Operations Center components.
IOCControl -a stop -c all -p password

where password is the topology password defined when the IBM Intelligent Operations Center was
installed. If the password value contains special characters, the password value must be enclosed in
single quotation marks. For example: ’pass$phrase’
To stop only one component, run the following command.
IOCControl -a stop -c component -p password

where component is an ID listed in the IOCControl help and where password is the topology password
defined when the IBM Intelligent Operations Center was installed. If the password value contains
special characters, the password value must be enclosed in single quotation marks. For example:
’pass$phrase’

3. 1.6 1.6.0.1 Run the following command to stop all the IBM Intelligent Operations Center
components.
IOCControl -a 091 -p password

where password is the topology password defined when the IBM Intelligent Operations Center was
installed. If the password value contains special characters, the password value must be enclosed in
single quotation marks. For example: ’pass$phrase’
To stop only one component, run the following command.
IOCControl -a action password

where action is an ID listed in the IOCControl help and where password is the topology password
defined when the IBM Intelligent Operations Center was installed. If the password value contains
special characters, the password value must be enclosed in single quotation marks. For example:
’pass$phrase’

Results

The requested IBM Intelligent Operations Center components are stopped.

What to do next

If the IOCControl command did not result in the desired outcome, check the logs in the
/opt/IBM/ISP/mgmt/logs directory. The logs contain the results of the most recent IOCControl command.

1.6.0.2 The log file name begins with the action specified for -a.
Related tasks:
“Starting the components in a high availability environment” on page 199
The platform control tool can be used to start the components running on IBM Intelligent Operations
Center high availability environment servers.
“Querying the status of the components in a high availability environment” on page 207
The platform control tool can be used to determine the status of the components running on IBM
Intelligent Operations Center high availability environment servers.
“Getting help for the platform control tool in a high availability environment” on page 208
Information is available about the options for running the platform control tool in a high availability
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environment.

Required stop order in a V1.6.0.2 high availability environment
1.6.0.2

In the high availability environment, IBM Intelligent Operations Center components must be stopped in a
specific order.

The platform control tool is used to stop IBM Intelligent Operations Center components. While it is
recommended that the platform control tool -a stop -c all -p password command be used to stop all
components, there might be times when individual components need to be stopped.

The following table shows the required stop order for the components. Components can be stopped by
using the base component or individual component for the -c value.

Table 50. Stop order for IBM Intelligent Operations Center high availability components

Base component Component Description

anagrp anasby Stop platform analytics servers (standby)

v IBM Cognos Business Intelligence

v IBM ILOG CPLEX Optimization Studio

v IBM SPSS Modeler

anapri Stop platform analytics servers (primary)

v IBM Cognos Business Intelligence

v IBM ILOG CPLEX Optimization Studio

v IBM SPSS Modeler

appgrp appsby Stop platform applications servers (standby)

v WebSphere Application Server Deployment Manager

v IBM Business Monitor

v IBM Lotus Sametime Proxy Server

v IBM Worklight

v WebSphere Portal Extend

v Intelligent Operations Platform server

v IBM HTTP Server

apppri Stop platform applications servers (primary)

v WebSphere Application Server Deployment Manager

v IBM Business Monitor

v IBM Lotus Sametime Proxy Server

v IBM Worklight

v WebSphere Portal Extend

v Intelligent Operations Platform server

v IBM HTTP Server

colgrp colsby RESERVED

colpri Stop collaboration components (primary)

v IBM Lotus Sametime

msggrp msgsby Stop platform messaging servers (standby)

v IBM Message Broker

msgpri Stop platform messaging servers (primary)

v IBM Message Broker
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Table 50. Stop order for IBM Intelligent Operations Center high availability components (continued)

Base component Component Description

secgrp secsby RESERVED

secpri Stop security components (primary)

v IBM Security Identity Manager

dbsgrp dbspri Start database components (primary)

v DB2 Enterprise Server Edition administration server

v DB2 Enterprise Server Edition for middleware

v DB2 Enterprise Server Edition for applications

dbssby Start database components (standby)

v DB2 Enterprise Server Edition administration server

v DB2 Enterprise Server Edition for middleware

v DB2 Enterprise Server Edition for applications

dirgrp dirsby Stop platform directory components (standby)

v Tivoli Directory Server

v Tivoli Directory Server proxy server

dirpri Stop platform directory components (primary)

v Tivoli Directory Server

v Tivoli Directory Server proxy server

v Tivoli Directory Integrator

Required stop order in a V1.6 and V1.6.0.1 high availability environment
1.6 1.6.0.1

In the high availability environment, IBM Intelligent Operations Center components must be stopped in a
specific order.

The platform control tool is used to stop IBM Intelligent Operations Center components. While it is
recommended that the platform control tool stop all command be used to stop all components, there
might be times when individual components need to be stopped.

Table 51. IBM Intelligent Operations Center component start order dependencies

Component Description

Services that must be
running before this
component is started

501 Stop web components (standby) None

511 Stop web components (primary) 501

601 Stop reporting components (primary) None

611 Stop collaboration components (primary) None

621 Stop platform messaging servers (standby) None

631 Stop platform messaging servers (primary) 621

641 Stop platform analytics servers (standby) None

651 Stop platform analytics servers (primary) 641

661 Stop platform applications servers (standby) None

671 Stop platform applications servers (primary) 661

751 Stop database components (primary) 601, 611, 631, 651, 671, 953

741 Stop database components (standby) 621, 641, 661, 955
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Table 51. IBM Intelligent Operations Center component start order dependencies (continued)

Component Description

Services that must be
running before this
component is started

701 Stop LDAP proxy components (standby) 641

711 Stop LDAP proxy components (primary) 651

721 Stop LDAP components (standby) 601, 611, 621, 631, 641, 651,
661, 671, 953

731 Stop LDAP components (primary) 601, 611, 621, 631, 641, 651,
661, 671, 953, 731

Querying the status of the components in a high availability
environment
The platform control tool can be used to determine the status of the components running on IBM
Intelligent Operations Center high availability environment servers.

About this task

The IOCControl command must be run as the ibmadmin user. If not logged on as the ibmadmin, run the su
- ibmadmin command to switch to the ibmadmin user.

Procedure
1. Log on to analytics server 1 or analytics server 2 as the ibmadmin user. If logged on as a different user,

change to the ibmadmin user by running the su - ibmadmin command. Under normal operations use
the platform control tool on analytics server 1. If analytics server 1 is unavailable you can run the
platform control tool on analytics server 2 . Do not use the platform control tool on analytics server 1
and analytics server 2 at the same time or unpredictable results can occur.

2. 1.6.0.2 Run the following command to query the status all the IBM Intelligent Operations Center
components.
IOCControl -a status -c all -p password

where password is the topology password defined when the IBM Intelligent Operations Center was
installed. If the password value contains special characters, the password value must be enclosed in
single quotation marks. For example: ’pass$phrase’
To check only one component, run the following command.
IOCControl -a status -c component -p password

where component is an ID in the IOCControl help and where password is the topology password
defined when the IBM Intelligent Operations Center was installed. If the password value contains
special characters, the password value must be enclosed in single quotation marks. For example:
’pass$phrase’

3. 1.6 1.6.0.1 Run the following command to query the status all the IBM Intelligent
Operations Center components.
IOCControl -a 801 -p password

where password is the topology password defined when the IBM Intelligent Operations Center was
installed. If the password value contains special characters, the password value must be enclosed in
single quotation marks. For example: ’pass$phrase’
To check only one component, run the following command.
IOCControl -a action -p password
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where action is an ID in the IOCControl help and where password is the topology password defined
when the IBM Intelligent Operations Center was installed. If the password value contains special
characters, the password value must be enclosed in single quotation marks. For example:
’pass$phrase’

Results

Components that are started will display [ on ]. Components that are not started will display [ off ].

1.6.0.2 If [ unknown ] is displayed, a problem occurred while trying to determine the status of the
component. Possible problems include:
v A network connection problem between the platform control tool and the component.
v A resource shortage on the server. For example, lack of available disk space for logging resulting in the

server being unable to handle new work requests.
v An optional product not completely installed.
v Other component-specific issues.

Retry the command. If [ unknown ] continues to be displayed, check the logs for additional information.

Note: 1.6.0.2 If the component specified by -c has defined subcomponents, the status of the
subcomponents are displayed instead of the status of the parent component. The platform control tool
help lists the components and subcomponents defined by IBM Intelligent Operations Center.
Related tasks:
“Starting the components in a high availability environment” on page 199
The platform control tool can be used to start the components running on IBM Intelligent Operations
Center high availability environment servers.
“Stopping the components in a high availability environment” on page 203
The platform control tool can be used to stop components running on IBM Intelligent Operations Center
high availability servers.
“Getting help for the platform control tool in a high availability environment”
Information is available about the options for running the platform control tool in a high availability
environment.

Getting help for the platform control tool in a high availability
environment
Information is available about the options for running the platform control tool in a high availability
environment.

About this task

The IOCControl command must be run as the ibmadmin user. If not logged on as the ibmadmin, run the su
- ibmadmin command to switch to the ibmadmin user.

Procedure
v 1.6.0.2 On analytics server 1 or analytics server 2 run the one of the following commands to see

options for the IOCControl command.
IOCControl -a help

or

IOCControl -h

v 1.6 1.6.0.1 On analytics server 1 or analytics server 2 run the one of the following commands
to see options for the IOCControl command.
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IOCControl -a 000

Results

The options for the IOCControl command are displayed.
Related tasks:
“Starting the components in a high availability environment” on page 199
The platform control tool can be used to start the components running on IBM Intelligent Operations
Center high availability environment servers.
“Stopping the components in a high availability environment” on page 203
The platform control tool can be used to stop components running on IBM Intelligent Operations Center
high availability servers.
“Querying the status of the components in a high availability environment” on page 207
The platform control tool can be used to determine the status of the components running on IBM
Intelligent Operations Center high availability environment servers.

Verifying the components
The system verification check tool tool tests components within IBM Intelligent Operations Center to
determine if they are accessible and operational.

How to use the system verification check tool
The system verification check tool is used to determine the operational status of services comprising the
IBM Intelligent Operations Center system.

About this task

The system verification check tool tool verifies system capabilities.

For details on individual tests and troubleshooting if the tests fails, click Help for the test.

Properties provides additional information about the test for use when calling IBM Software Support.

Procedure
1. Log on to IBM Intelligent Operations Center as a user with administrator authority.
2. Click Administration > Solution Administration in the top banner.
3. Click System Administration > System Verification Check in the side menu.
4. Select the test or tests to be run by doing one of the following:

v Click a specific test to be run.
v Click Run All Tests to test the capabilities of all selections.

Results

The icon will be displayed when a test completes successfully. The icon will be displayed when
a test fails. If a test fails, follow the problem determination instructions for the test to resolve the errors.

These instructions can also be accessed by clicking the icon or Help.

If a specific test was run, the run results of the test are displayed at the bottom of the portlet along with
the test execution time. If Run All Tests was selected, this information is not displayed.
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What to do next

The tool can be reset, and all results cleared, by clicking Reset.

Determining the status of IBM Intelligent Operations Center services
and components
IBM Intelligent Operations Center provides a number of system verification check tool tests that can be
used to determine the operational status of various IBM Intelligent Operations Center services and
components.

The tests are logically grouped by function. For example, collaboration and monitoring.

Analytics (Cognos Connection console via Web Server) Test
The Analytics (Cognos Connection console via Web Server) test determines if Cognos, on the analytics
server, can be accessed by the Cognos Servlet Gateway and Cognos Administration Portal URL.

Resources

The Analytics (Cognos Connection console via Web Server) test uses the following resource:
v Cognos (on the analytics server system).

Problem determination
If the Analytics (Cognos Connection console via Web Server) test fails, do the following to find and
resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use anacognos
(in a standard environment) or anacognosgrp (in a high availability environment) and specify your
topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use cognos and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
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su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To start the primary web server, specify 701 for action.
v To start the standby web server, specify 711 for action.
v To stop the primary web server, specify 511 for action.
v To stop the standby web server, specify 501 for action.
v To check the status of the primary analytics server, specify 841 for action.
v To check the status of the standby analytics server, specify 843 for action.
v To start the primary analytics server, specify 221 for action.
v To start the standby analytics server, specify 231 for action.
v To stop the primary analytics server, specify 651 for action.
v To stop the standby analytics server, specify 641 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. On the analytics server review the following Cognos logs:
v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_Disp1/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_Disp1/SystemErr.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_GW1/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_GW1/SystemErr.log

v All logs in the /opt/IBM/cognos/c10_64/logs/ directory.
5. Verify that the file system on the analytics server has not reached capacity. This can be determined by

running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.

6. Verify that Cognos Dispatcher and Cognos Gateway servers are started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
manual steps:
a. On the analytics server system log on as ibmadmin (Cognos user).
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (the default is admin) and
WAS_ADMIN_PWD is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped.is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/cognosProfile1/bin/startNode.sh. Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.
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d. If message ADMU0509I: The Application Server "CognosX_Disp1" cannot be reached. It appears
to be stopped. is displayed, start CognosX_Disp1 using the following command:
/opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/startServer.sh CognosX_Disp1.
Skip this step if message ADMU0508I: The Application Server "CognosX_Disp1" is STARTED. is
displayed. If you had to start CognosX_Disp1, a message similar to the following will be
displayed: ADMU3000I: Server CognosX_Disp1 open for e-business; process id is 26654.

e. If message ADMU0509I: The Application Server "CognosX_GW1" cannot be reached. It appears
to be stopped. is displayed, start CognosX_GW1 using the following command:
/opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/startServer.sh CognosX_GW1. Skip
this step if message ADMU0508I: The Application Server "CognosX_GW1" is STARTED. is displayed.
If you had to start CognosX_GW1, a message similar to the following will be displayed:
ADMU3000I: Server CognosX_GW1 open for e-business; process id is 26676.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CognosX_Disp1
c. CognosX_GW1

Stop servers in this order:
a. CognosX_GW1
b. CognosX_Disp1
c. nodeagent
The CognosX_GW1 server is stopped by running the following command in a command window on
the analytics server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopServer.sh
CognosX_GW1 -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere
Application Server administrator password.
The CognosX_Disp1 server is stopped by running the following command in a command window on
the analytics server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopServer.sh
CognosX_Disp1 -wasadmin WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is
the WebSphere administrator ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere
Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the analytics
server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere Application Server administrator
password.

7. Verify that Cognos Dispatcher and Cognos Gateway servers are started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
steps using the WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
analytics server.

b. View the status of the CognosX-Disp1 and CognosX_GW1 servers by clicking Servers > Server
Types > WebSphere application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
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The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CognosX_Disp1
c. CognosX_GW1

Stop servers in this order:
a. CognosX_GW1
b. CognosX_Disp1
c. nodeagent
To stop the CognosX_GW1 and CognosX_Disp1 servers, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the analytics
server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere Application Server administrator
password.

8. Verify the Cognos Administration Portal can be accessed from the the web server using following
URL: http://WEB_SERVER_HOST/ServletGateway/servlet/Gateway. Where the WEB_SERVER_HOST is
host name for the web server.

What to do next

Resolve any issues or errors found and retry the test.

Analytics (Cognos Connection console) Test
The Analytics (Cognos Connection console) test determines if Cognos, on the analytics server, can be
accessed by the Cognos Servlet Gateway and Cognos Administration Portal URL.

Resources

The Analytics (Cognos Connection console) test uses the following resource:
v Cognos (on the analytics server system).

Problem determination
If the Analytics (Cognos Connection console) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the component and to start and stop it

as needed. For component use anacognos and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password
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c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the component and to start
and stop it as needed. For component use cognos and specify your topology password for
topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. On the analytics server review the following Cognos logs:
v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_Disp1/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_Disp1/SystemErr.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_GW1/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_GW1/SystemErr.log

v All logs in the /opt/IBM/cognos/c10_64/logs/ directory.
4. Verify that the file system on the analytics server has not reached capacity. This can be determined by

running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.

5. Verify that Cognos Dispatcher and Cognos Gateway servers are started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
manual steps:
a. On the analytics server system log on as ibmadmin (Cognos user).
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (the default is admin) and
WAS_ADMIN_PWD is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped.is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/cognosProfile1/bin/startNode.sh. Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

d. If message ADMU0509I: The Application Server "CognosX_Disp1" cannot be reached. It appears
to be stopped. is displayed, start CognosX_Disp1 using the following command:
/opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/startServer.sh CognosX_Disp1.
Skip this step if message ADMU0508I: The Application Server "CognosX_Disp1" is STARTED. is
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displayed. If you had to start CognosX_Disp1, a message similar to the following will be
displayed: ADMU3000I: Server CognosX_Disp1 open for e-business; process id is 26654.

e. If message ADMU0509I: The Application Server "CognosX_GW1" cannot be reached. It appears
to be stopped. is displayed, start CognosX_GW1 using the following command:
/opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/startServer.sh CognosX_GW1. Skip
this step if message ADMU0508I: The Application Server "CognosX_GW1" is STARTED. is displayed.
If you had to start CognosX_GW1, a message similar to the following will be displayed:
ADMU3000I: Server CognosX_GW1 open for e-business; process id is 26676.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CognosX_Disp1
c. CognosX_GW1

Stop servers in this order:
a. CognosX_GW1
b. CognosX_Disp1
c. nodeagent
The CognosX_GW1 server is stopped by running the following command in a command window on
the analytics server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopServer.sh
CognosX_GW1 -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere
Application Server administrator password.
The CognosX_Disp1 server is stopped by running the following command in a command window on
the analytics server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopServer.sh
CognosX_Disp1 -wasadmin WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is
the WebSphere administrator ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere
Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the analytics
server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere Application Server administrator
password.

6. Verify that Cognos Dispatcher and Cognos Gateway servers are started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
steps using the WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
analytics server.

b. View the status of the CognosX-Disp1 and CognosX_GW1 servers by clicking Servers > Server
Types > WebSphere application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.
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Start servers in this order:
a. nodeagent
b. CognosX_Disp1
c. CognosX_GW1

Stop servers in this order:
a. CognosX_GW1
b. CognosX_Disp1
c. nodeagent
To stop the CognosX_GW1 and CognosX_Disp1 servers, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the analytics
server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere Application Server administrator
password.

7. Verify that the Cognos Administration Portal can be accessed from the WebSphere Portal system, on
the analytics server, using following URL: http://ANALYTICS_SERVER_HOST:9444/ServletGateway/
servlet/Gateway. Where the ANALYTICS_SERVER_HOST is host name for the analytics server.

What to do next

Resolve any issues or errors found and retry the test.

Analytics (Cognos Connection console) [1] Test
The Analytics (Cognos Connection console) [1] test determines if Cognos, on analytics server 1 in a high
availability environment, can be accessed by the Cognos Servlet Gateway and Cognos Administration
Portal URL.

Resources

The Analytics (Cognos Connection console) [1] test uses the following resource:
v Cognos (on the analytics server system).

Problem determination
If the Analytics (Cognos Connection console) [1] test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the servers and to start and stop them

as needed. Run the following commands with the desired options. For component use anacognosgrp
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password
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2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 841 for action.
v To check the status of the standby server, specify 843 for action.
v To start the primary server, specify 221 for action.
v To start the standby server, specify 231 for action.
v To stop the primary server, specify 651 for action.
v To stop the standby server, specify 641 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. On the analytics server review the following Cognos logs:
v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_Disp1/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_Disp1/SystemErr.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_GW1/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_GW1/SystemErr.log

v All logs in the /opt/IBM/cognos/c10_64/logs/ directory.
4. Verify that the file system on the analytics server has not reached capacity. This can be determined by

running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.

5. Verify that Cognos Dispatcher and Cognos Gateway servers are started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
manual steps:
a. On the analytics server system log on as ibmadmin (Cognos user).
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (the default is admin) and
WAS_ADMIN_PWD is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped.is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/cognosProfile1/bin/startNode.sh. Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

d. If message ADMU0509I: The Application Server "CognosX_Disp1" cannot be reached. It appears
to be stopped. is displayed, start CognosX_Disp1 using the following command:
/opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/startServer.sh CognosX_Disp1.
Skip this step if message ADMU0508I: The Application Server "CognosX_Disp1" is STARTED. is
displayed. If you had to start CognosX_Disp1, a message similar to the following will be
displayed: ADMU3000I: Server CognosX_Disp1 open for e-business; process id is 26654.

e. If message ADMU0509I: The Application Server "CognosX_GW1" cannot be reached. It appears
to be stopped. is displayed, start CognosX_GW1 using the following command:
/opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/startServer.sh CognosX_GW1. Skip
this step if message ADMU0508I: The Application Server "CognosX_GW1" is STARTED. is displayed.
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If you had to start CognosX_GW1, a message similar to the following will be displayed:
ADMU3000I: Server CognosX_GW1 open for e-business; process id is 26676.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CognosX_Disp1
c. CognosX_GW1

Stop servers in this order:
a. CognosX_GW1
b. CognosX_Disp1
c. nodeagent
The CognosX_GW1 server is stopped by running the following command in a command window on
the analytics server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopServer.sh
CognosX_GW1 -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere
Application Server administrator password.
The CognosX_Disp1 server is stopped by running the following command in a command window on
the analytics server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopServer.sh
CognosX_Disp1 -wasadmin WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is
the WebSphere administrator ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere
Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the analytics
server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere Application Server administrator
password.

6. Verify that Cognos Dispatcher and Cognos Gateway servers are started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
steps using the WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
analytics server.

b. View the status of the CognosX-Disp1 and CognosX_GW1 servers by clicking Servers > Server
Types > WebSphere application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CognosX_Disp1
c. CognosX_GW1
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Stop servers in this order:
a. CognosX_GW1
b. CognosX_Disp1
c. nodeagent
To stop the CognosX_GW1 and CognosX_Disp1 servers, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the analytics
server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere Application Server administrator
password.

7. Verify that the Cognos Administration Portal can be accessed from the WebSphere Portal system, on
the analytics server, using following URL: http://ANALYTICS_PRIMARY_HOST:9444/ServletGateway/
servlet/Gateway. Where the ANALYTICS_PRIMARY_HOST is host name for analytics server 1.

What to do next

Resolve any issues or errors found and retry the test.

Analytics (Cognos Connection console) [2] Test
The Analytics (Cognos Connection console) [2] test determines if Cognos, on analytics server 2 in a high
availability environment, can be accessed by the Cognos Servlet Gateway and Cognos Administration
Portal URL.

Resources

The Analytics (Cognos Connection console) [2] test uses the following resource:
v Cognos (on the analytics server system).

Problem determination
If the Analytics (Cognos Connection console) [2] test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the servers and to start and stop them

as needed. Run the following commands with the desired options. For component use anacognosgrp
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 841 for action.
v To check the status of the standby server, specify 843 for action.
v To start the primary server, specify 221 for action.
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v To start the standby server, specify 231 for action.
v To stop the primary server, specify 651 for action.
v To stop the standby server, specify 641 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. On the analytics server review the following Cognos logs:
v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_Disp1/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_Disp1/SystemErr.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_GW1/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_GW1/SystemErr.log

v All logs in the /opt/IBM/cognos/c10_64/logs/ directory.
4. Verify that the file system on the analytics server has not reached capacity. This can be determined by

running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.

5. Verify that Cognos Dispatcher and Cognos Gateway servers are started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
manual steps:
a. On analytics server 2 system log on as ibmadmin (Cognos user).
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (the default is admin) and
WAS_ADMIN_PWD is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped.is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/cognosProfile1/bin/startNode.sh. Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

d. If message ADMU0509I: The Application Server "CognosX_Disp2" cannot be reached. It appears
to be stopped. is displayed, start CognosX_Disp2 using the following command:
/opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/startServer.sh CognosX_Disp2.
Skip this step if message ADMU0508I: The Application Server "CognosX_Disp2" is STARTED. is
displayed. If you had to start CognosX_Disp2, a message similar to the following will be
displayed: ADMU3000I: Server CognosX_Disp2 open for e-business; process id is 26654.

e. If message ADMU0509I: The Application Server "CognosX_GW2" cannot be reached. It appears
to be stopped. is displayed, start CognosX_GW2 using the following command:
/opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/startServer.sh CognosX_GW2. Skip
this step if message ADMU0508I: The Application Server "CognosX_GW2" is STARTED. is displayed.
If you had to start CognosX_GW2, a message similar to the following will be displayed:
ADMU3000I: Server CognosX_GW2 open for e-business; process id is 26676.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
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a. nodeagent
b. CognosX_Disp2
c. CognosX_GW2

Stop servers in this order:
a. CognosX_GW2
b. CognosX_Disp2
c. nodeagent
The CognosX_GW2 server is stopped by running the following command in a command window on
the analytics server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopServer.sh
CognosX_GW2 -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere
Application Server administrator password.
The CognosX_Disp2 server is stopped by running the following command in a command window on
the analytics server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopServer.sh
CognosX_Disp2 -wasadmin WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is
the WebSphere administrator ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere
Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the analytics
server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere Application Server administrator
password.

6. Verify that Cognos Dispatcher and Cognos Gateway servers are started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
steps using the WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
analytics server.

b. View the status of the CognosX-Disp2 and CognosX_GW2 servers by clicking Servers > Server
Types > WebSphere application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CognosX_Disp2
c. CognosX_GW2

Stop servers in this order:
a. CognosX_GW2
b. CognosX_Disp2
c. nodeagent
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To stop the CognosX_GW2 and CognosX_Disp2 servers, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the analytics
server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (the default is admin) and WAS_ADMIN_PWD is the WebSphere Application Server administrator
password.

7. Verify that the Cognos Administration Portal can be accessed from the WebSphere Portal system, on
the analytics server, using following URL: http://ANALYTICS_BACKUP_HOST:9444/ServletGateway/
servlet/Gateway. Where the ANALYTICS_BACKUP_HOST is host name for analytics server 2.

What to do next

Resolve any issues or errors found and retry the test.

Analytics (SPSS Modeler) Test
The Analytics (SPSS Modeler) test determines if the SPSS Modeler server is running on the analytics
server.

Resources

The Analytics (SPSS Modeler) test uses the following resource:
v SPSS Modeler server (on the analytics server)

Problem determination
If the Analytics (SPSS Modeler) test fails, do the following to find and resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use anaspss (in
a standard environment) or anaspssgrp (in a high availability environment) and specify your topology
password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use cognos and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password
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c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 841 for action.
v To start the primary server, specify 271 for action.
v To stop the primary server, specify 601 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. On the analytics server review the following SPSS Modeler log:
v /opt/IBM/SPSS/ModelerServer/15.0/log/messages.log

5. Verify that the file system on the analytics server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.

6. Verify the SPSS Modeler server is started.
a. On the analytics server log on as the ibmadmin user.
b. Run the following command.

/opt/IBM/SPSS/ModelerServer/15.0/modelersrv.sh list

Output similar to the following should be returned:
PID PPID USER VSZ PCPU COMMAND
11021 1 ibmadmin 352724 0.0 modelersrv_15_0

7. If the server is not listed, start the SPSS Modeler server by running the following command:
/opt/IBM/SPSS/ModelerServer/15.0/modelersrv.sh start

8. If the server is running, stop the server and restart it.
a. Stop the SPSS Modeler server by running one of the following commands.

/opt/IBM/SPSS/ModelerServer/15.0/modelersrv.sh stop

/opt/IBM/SPSS/ModelerServer/15.0/modelersrv.sh kill

b. Start the SPSS Modeler server by running the following command.
/opt/IBM/SPSS/ModelerServer/15.0/modelersrv.sh start

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST CplexServer1) Test
The Application Server (REST CplexServer1) test tests access to the WebSphere Application Server REST
service on the target server.
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Resources

The Application Server (REST CplexServer1) test uses the following resource:
v WebSphere Application Server on the analytics server.

Problem determination
If the Application Server (REST CplexServer1) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use anacplex
(in a standard environment) or anacplexgrp (in a high availability environment) and specify your
topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use cplex and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 841 for action.
v To check the status of the standby server, specify 843 for action.
v To start the primary server, specify 221 for action.
v To start the standby server, specify 231 for action.
v To stop the primary server, specify 651 for action.
v To stop the standby server, specify 641 for action.

Specify your topology password for topology_password.
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su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the analytics server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/CPLEXProfile1/logs/CPlexServer1/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/CPLEXProfile1/logs/CPlexServer1/SystemErr.log

5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the CPlexServer1 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/CPLEXProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/CPLEXProfile1/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "CPlexServer1" cannot be reached. It appears
to be stopped. is displayed, start the CPlexServer1 server using the following command:
/opt/IBM/WebSphere/AppServer/profiles/CPLEXProfile1/bin/startServer.sh CPlexServer1. Skip
this step if message ADMU0508I: The Application Server "CPlexServer1" is STARTED. is
displayed. If you had to start CPlexServer1, a message similar to the following will be displayed:
ADMU3000I: Server CPlexServer1 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CPlexServer1

Stop servers in this order:
a. CPlexServer1
b. nodeagent
The CPlexServer1 server is stopped by running the following command in a command window on
the application server: /opt/IBM/WebSphere/AppServer/profiles/CPLEXProfile1/bin/stopServer.sh
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-all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application
Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/CPLEXProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

7. Verify that the CPlexServer1 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the CPlexServer1 server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/CPLEXProfile1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CPlexServer1

Stop servers in this order:
a. CPlexServer1
b. nodeagent
To stop the CPlexServer1 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/CPLEXProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST CPlexServer2) Test
The Application Server (REST CPlexServer2) test tests access to the WebSphere Application Server REST
service on the target server.

Resources

The Application Server (REST CPlexServer2) test uses the following resource:
v WebSphere Application Server on analytics server 2.

226 IBM Intelligent Operations Center: IBM Intelligent Operations Center Product Documentation



Problem determination
If the Application Server (REST CPlexServer2) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
anacplexgrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 841 for action.
v To check the status of the standby server, specify 843 for action.
v To start the primary server, specify 221 for action.
v To start the standby server, specify 231 for action.
v To stop the primary server, specify 651 for action.
v To stop the standby server, specify 641 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On analytics server 2 review the following WebSphere Application Server logs:
v CPlexServer2/opt/IBM/WebSphere/AppServer/profiles/CPLEXProfile1/logs/CPlexServer2/

SystemOut.log

v CPlexServer2/opt/IBM/WebSphere/AppServer/profiles/CPLEXProfile1/logs/CPlexServer2/
SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.
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5. Verify that the CPlexServer2 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: CPlexServer2/opt/IBM/WebSphere/AppServer/profiles/

CPLEXProfile1/bin/serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD
where WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and
WAS_ADMIN_PWD is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: CPlexServer2/opt/
IBM/WebSphere/AppServer/profiles/CPLEXProfile1/bin/startNode.sh . Skip this step if message
ADMU0508I: The Application Server "nodeagent" is STARTED. is displayed. If you had to start the
nodeagent, a message similar to the following will be displayed: ADMU3000I: Server nodeagent
open for e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "CPlexServer2" cannot be reached. It appears
to be stopped. is displayed, start the CPlexServer2 server using the following command:
CPlexServer2/opt/IBM/WebSphere/AppServer/profiles/CPLEXProfile1/bin/startServer.sh
CPlexServer2. Skip this step if message ADMU0508I: The Application Server "CPlexServer2" is
STARTED. is displayed. If you had to start CPlexServer2, a message similar to the following will be
displayed: ADMU3000I: Server CPlexServer2 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CPlexServer2

Stop servers in this order:
a. CPlexServer2
b. nodeagent
The CPlexServer2 server is stopped by running the following command in a command window on
the application server: CPlexServer2/opt/IBM/WebSphere/AppServer/profiles/CPLEXProfile1/bin/
stopServer.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER
is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere
Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: CPlexServer2/opt/IBM/WebSphere/AppServer/profiles/CPLEXProfile1/bin/
stopNode.sh -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere
administrator password.

6. Verify that the CPlexServer2 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the CPlexServer2 server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
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The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the CPlexServer2/opt/IBM/WebSphere/AppServer/profiles/
CPLEXProfile1/bin/startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CPlexServer2

Stop servers in this order:
a. CPlexServer2
b. nodeagent
To stop the CPlexServer2 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: CPlexServer2/opt/IBM/WebSphere/AppServer/profiles/CPLEXProfile1/bin/
stopNode.sh -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere
administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST CognosX_Disp1) Test
The Application Server (REST CognosX_Disp1) test tests access to the WebSphere Application Server
REST service on the target server.

Resources

The Application Server (REST CognosX_Disp1) test uses the following resource:
v WebSphere Application Server on the analytics server.

Problem determination
If the Application Server (REST CognosX_Disp1) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
anacognosdisp (in a standard environment) or anacognosdispgrp (in a high availability environment)
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password
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2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use cognos and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 841 for action.
v To check the status of the standby server, specify 843 for action.
v To start the primary server, specify 221 for action.
v To start the standby server, specify 231 for action.
v To stop the primary server, specify 651 for action.
v To stop the standby server, specify 641 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the analytics server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_Disp1/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_Disp1/SystemErr.log

5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the CognosX_Disp1 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.
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c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/cognosProfile1/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "CognosX_Disp1" cannot be reached. It appears
to be stopped. is displayed, start the CognosX_Disp1 server using the following command:
/opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/startServer.sh CognosX_Disp1.
Skip this step if message ADMU0508I: The Application Server "CognosX_Disp1" is STARTED. is
displayed. If you had to start CognosX_Disp1, a message similar to the following will be
displayed: ADMU3000I: Server CognosX_Disp1 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CognosX_Disp1

Stop servers in this order:
a. CognosX_Disp1
b. nodeagent
The CognosX_Disp1 server is stopped by running the following command in a command window on
the application server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopServer.sh
-all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application
Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

7. Verify that the CognosX_Disp1 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the CognosX_Disp1 server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CognosX_Disp1
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Stop servers in this order:
a. CognosX_Disp1
b. nodeagent
To stop the CognosX_Disp1 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST CognosX_Disp2) Test
The Application Server (REST CognosX_Disp2) test tests access to the WebSphere Application Server
REST service on the target server.

Resources

The Application Server (REST CognosX_Disp2) test uses the following resource:
v WebSphere Application Server on analytics server 2.

Problem determination
If the Application Server (REST CognosX_Disp2) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
anacognosdispgrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 841 for action.
v To check the status of the standby server, specify 843 for action.
v To start the primary server, specify 221 for action.
v To start the standby server, specify 231 for action.
v To stop the primary server, specify 651 for action.
v To stop the standby server, specify 641 for action.

Specify your topology password for topology_password.
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su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On analytics server 2 review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_Disp2/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_Disp2/SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the CognosX_Disp2 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/cognosProfile1/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "CognosX_Disp2" cannot be reached. It appears
to be stopped. is displayed, start the CognosX_Disp2 server using the following command:
/opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/startServer.sh CognosX_Disp2.
Skip this step if message ADMU0508I: The Application Server "CognosX_Disp2" is STARTED. is
displayed. If you had to start CognosX_Disp2, a message similar to the following will be
displayed: ADMU3000I: Server CognosX_Disp2 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CognosX_Disp2

Stop servers in this order:
a. CognosX_Disp2
b. nodeagent
The CognosX_Disp2 server is stopped by running the following command in a command window on
the application server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopServer.sh
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-all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application
Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the CognosX_Disp2 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the CognosX_Disp2 server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CognosX_Disp2

Stop servers in this order:
a. CognosX_Disp2
b. nodeagent
To stop the CognosX_Disp2 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST CognosX_GW1) Test
The Application Server (REST CognosX_GW1) test tests access to the WebSphere Application Server REST
service on the target server.

Resources

The Application Server (REST CognosX_GW1) test uses the following resource:
v WebSphere Application Server on the analytics server.
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Problem determination
If the Application Server (REST CognosX_GW1) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
anacognosgw (in a standard environment) or anacognosgwgrp (in a high availability environment) and
specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use cognos and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 841 for action.
v To check the status of the standby server, specify 843 for action.
v To start the primary server, specify 221 for action.
v To start the standby server, specify 231 for action.
v To stop the primary server, specify 651 for action.
v To stop the standby server, specify 641 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log
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v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the analytics server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_GW1/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_GW1/SystemErr.log

5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the CognosX_GW1 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/cognosProfile1/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "CognosX_GW1" cannot be reached. It appears
to be stopped. is displayed, start the CognosX_GW1 server using the following command:
/opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/startServer.sh CognosX_GW1. Skip
this step if message ADMU0508I: The Application Server "CognosX_GW1" is STARTED. is displayed.
If you had to start CognosX_GW1, a message similar to the following will be displayed:
ADMU3000I: Server CognosX_GW1 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CognosX_GW1

Stop servers in this order:
a. CognosX_GW1
b. nodeagent
The CognosX_GW1 server is stopped by running the following command in a command window on
the application server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopServer.sh
-all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application
Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.
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7. Verify that the CognosX_GW1 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the CognosX_GW1 server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CognosX_GW1

Stop servers in this order:
a. CognosX_GW1
b. nodeagent
To stop the CognosX_GW1 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST CognosX_GW2) Test
The Application Server (REST CognosX_GW2) test tests access to the WebSphere Application Server REST
service on the target server.

Resources

The Application Server (REST CognosX_GW2) test uses the following resource:
v WebSphere Application Server on analytics server 2.

Problem determination
If the Application Server (REST CognosX_GW2) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
anacognosgwgrp and specify your topology password for topology_password.
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a. To check the status of the component run the following commands:
su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 841 for action.
v To check the status of the standby server, specify 843 for action.
v To start the primary server, specify 221 for action.
v To start the standby server, specify 231 for action.
v To stop the primary server, specify 651 for action.
v To stop the standby server, specify 641 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On analytics server 2 review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_GW2/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/logs/CognosX_GW2/SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the CognosX_GW2 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server 1 system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/cognosProfile1/bin/startNode.sh . Skip this step if message ADMU0508I: The
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Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "CognosX_GW2" cannot be reached. It appears
to be stopped. is displayed, start the CognosX_GW2 server using the following command:
/opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/startServer.sh CognosX_GW2. Skip
this step if message ADMU0508I: The Application Server "CognosX_GW2" is STARTED. is displayed.
If you had to start CognosX_GW2, a message similar to the following will be displayed:
ADMU3000I: Server CognosX_GW2 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CognosX_GW2

Stop servers in this order:
a. CognosX_GW2
b. nodeagent
The CognosX_GW2 server is stopped by running the following command in a command window on
the application server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopServer.sh
-all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application
Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the CognosX_GW2 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the CognosX_GW2 server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. CognosX_GW2

Stop servers in this order:
a. CognosX_GW2
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b. nodeagent
To stop the CognosX_GW2 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/cognosProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST IopServer1) Test
The Application Server (REST IopServer1) test tests access to the WebSphere Application Server REST
service on the target server.

Resources

The Application Server (REST IopServer1) test uses the following resource:
v WebSphere Application Server on the application server.

Problem determination
If the Application Server (REST IopServer1) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appiop (in a
standard environment) or appiopgrp (in a high availability environment) and specify your topology
password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use iopsvr and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
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su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/IopProfile1/logs/IopServer1/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/IopProfile1/logs/IopServer1/SystemErr.log

5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the IopServer1 server is started. Verification can be done using the WebSphere Application
Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/IopProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/IopProfile1/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "IopServer1" cannot be reached. It appears to
be stopped. is displayed, start the IopServer1 server using the following command:
/opt/IBM/WebSphere/AppServer/profiles/IopProfile1/bin/startServer.sh IopServer1. Skip this
step if message ADMU0508I: The Application Server "IopServer1" is STARTED. is displayed. If
you had to start IopServer1, a message similar to the following will be displayed: ADMU3000I:
Server IopServer1 open for e-business; process id is 26654.
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Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. IopServer1

Stop servers in this order:
a. IopServer1
b. nodeagent
The IopServer1 server is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/IopProfile1/bin/stopServer.sh -all
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server
administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/IopProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

7. Verify that the IopServer1 server is started. Verification can be done using the WebSphere Application
Server Administrative Console or by manual steps. The following are the steps using the WebSphere
Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the IopServer1 server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/IopProfile1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. IopServer1

Stop servers in this order:
a. IopServer1
b. nodeagent
To stop the IopServer1 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/IopProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.
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What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST IopServer2) Test
The Application Server (REST IopServer2) test tests access to the WebSphere Application Server REST
service on the target server.

Resources

The Application Server (REST IopServer2) test uses the following resource:
v WebSphere Application Server on application server 2.

Problem determination
If the Application Server (REST IopServer2) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appiopgrp
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log
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v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On application server 2 review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/IopProfile2/logs/IopServer2/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/IopProfile2/logs/IopServer2/SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the IopServer2 server is started. Verification can be done using the WebSphere Application
Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/IopProfile2/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/IopProfile2/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "IopServer2" cannot be reached. It appears to
be stopped. is displayed, start the IopServer2 server using the following command:
/opt/IBM/WebSphere/AppServer/profiles/IopProfile2/bin/startServer.sh IopServer2. Skip this
step if message ADMU0508I: The Application Server "IopServer2" is STARTED. is displayed. If
you had to start IopServer2, a message similar to the following will be displayed: ADMU3000I:
Server IopServer2 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. IopServer2

Stop servers in this order:
a. IopServer2
b. nodeagent
The IopServer2 server is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/IopProfile2/bin/stopServer.sh -all
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server
administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/IopProfile2/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the IopServer2 server is started. Verification can be done using the WebSphere Application
Server Administrative Console or by manual steps. The following are the steps using the WebSphere
Application Server Administrative Console:
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a. Log on to the WebSphere Application Server Administrative Console at http://
APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the IopServer2 server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/IopProfile2/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. IopServer2

Stop servers in this order:
a. IopServer2
b. nodeagent
To stop the IopServer2 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/IopProfile2/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST STProxyServer1) Test
The Application Server (REST STProxyServer1) test tests access to the WebSphere Application Server
REST service on the target server.

Resources

The Application Server (REST STProxyServer1) test uses the following resource:
v WebSphere Application Server on the application server.

Problem determination
If the Application Server (REST STProxyServer1) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appstproxy
(in a standard environment) or appstproxygrp (in a high availability environment) and specify your
topology password for topology_password.
a. To check the status of the component run the following commands:
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su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use stproxy and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServerv7/profiles/STPAppProfile1/logs/STProxyServer1/

SystemOut.log
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v /opt/IBM/WebSphere/AppServerv7/profiles/STPAppProfile1/logs/STProxyServer1/
SystemErr.log

5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the STProxyServer1 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServerv7/profiles/STPAppProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServerv7/profiles/STPAppProfile1/bin/startNode.sh . Skip this step if message ADMU0508I:
The Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent,
a message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "STProxyServer1" cannot be reached. It
appears to be stopped. is displayed, start the STProxyServer1 server using the following
command: /opt/IBM/WebSphere/AppServerv7/profiles/STPAppProfile1/bin/startServer.sh
STProxyServer1. Skip this step if message ADMU0508I: The Application Server "STProxyServer1"
is STARTED. is displayed. If you had to start STProxyServer1, a message similar to the following
will be displayed: ADMU3000I: Server STProxyServer1 open for e-business; process id is
26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. STProxyServer1

Stop servers in this order:
a. STProxyServer1
b. nodeagent
The STProxyServer1 server is stopped by running the following command in a command window on
the application server: /opt/IBM/WebSphere/AppServerv7/profiles/STPAppProfile1/bin/stopServer.sh
-all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application
Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServerv7/profiles/STPAppProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

7. Verify that the STProxyServer1 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.
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b. View the status of the STProxyServer1 server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServerv7/profiles/STPAppProfile1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. STProxyServer1

Stop servers in this order:
a. STProxyServer1
b. nodeagent
To stop the STProxyServer1 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServerv7/profiles/STPAppProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST WBM_DE_AppTarget.WBMNode1.0) Test
The Application Server (REST WBM_DE_AppTarget.WBMNode1.0) test tests access to the WebSphere
Application Server REST service on the target server.

Resources

The Application Server (REST WBM_DE_AppTarget.WBMNode1.0) test uses the following resource:
v WebSphere Application Server on the application server.

Problem determination
If the Application Server (REST WBM_DE_AppTarget.WBMNode1.0) test fails, do the following to find
and resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appbmon (in
a standard environment) or appbmongrp (in a high availability environment) and specify your topology
password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
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su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use wbm and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/logs/WBM_DE_AppTarget.WBMNode1.0/

SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/logs/WBM_DE_AppTarget.WBMNode1.0/
SystemErr.log
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5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the WBM_DE_AppTarget.WBMNode1.0 server is started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/wbmProfile1/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "WBM_DE_AppTarget.WBMNode1.0" cannot be
reached. It appears to be stopped. is displayed, start the server using the following command:
/opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/startServer.sh
WBM_DE_AppTarget.WBMNode1.0. Skip this step if message ADMU0508I: The Application Server
"WBM_DE_AppTarget.WBMNode1.0" is STARTED. is displayed. If you had to start the server, a
message similar to the following will be displayed: ADMU3000I: Server
WBM_DE_AppTarget.WBMNode1.0 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WBM_DE_AppTarget.WBMNode1.0

Stop servers in this order:
a. WBM_DE_AppTarget.WBMNode1.0
b. nodeagent
The WBM_DE_AppTarget.WBMNode1.0 server is stopped by running the following command in a
command window on the application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/
bin/stopServer.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is
the WebSphere Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

7. Verify that the WBM_DE_AppTarget.WBMNode1.0 server is started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
steps using the WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.
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b. View the status of the WBM_DE_AppTarget.WBMNode1.0 server by clicking Servers > Server
Types > WebSphere application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WBM_DE_AppTarget.WBMNode1.0

Stop servers in this order:
a. WBM_DE_AppTarget.WBMNode1.0
b. nodeagent
To stop the WBM_DE_AppTarget.WBMNode1.0 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST WBM_DE_AppTarget.WBMNode2.0) Test
The Application Server (REST WBM_DE_AppTarget.WBMNode2.0) test tests access to the WebSphere
Application Server REST service on the target server.

Resources

The Application Server (REST WBM_DE_AppTarget.WBMNode2.0) test uses the following resource:
v WebSphere Application Server on application server 2.

Problem determination
If the Application Server (REST WBM_DE_AppTarget.WBMNode2.0) test fails, do the following to find
and resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appbmongrp
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password
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c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On application server 2 review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/logs/WBM_DE_AppTarget.WBMNode2.0/

SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/logs/WBM_DE_AppTarget.WBMNode2.0/
SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WBM_DE_AppTarget.WBMNode2.0 server is started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
manual steps:
a. On the application server 2 system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/wbmProfile2/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "WBM_DE_AppTarget.WBMNode2.0" cannot be
reached. It appears to be stopped. is displayed, start the WBM_DE_AppTarget.WBMNode2.0
server using the following command: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/bin/
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startServer.sh WBM_DE_AppTarget.WBMNode2.0. Skip this step if message ADMU0508I: The
Application Server "WBM_DE_AppTarget.WBMNode2.0" is STARTED. is displayed. If you had to start
WBM_DE_AppTarget.WBMNode2.0, a message similar to the following will be displayed:
ADMU3000I: Server WBM_DE_AppTarget.WBMNode2.0 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WBM_DE_AppTarget.WBMNode2.0

Stop servers in this order:
a. WBM_DE_AppTarget.WBMNode2.0
b. nodeagent
The WBM_DE_AppTarget.WBMNode2.0 server is stopped by running the following command in a
command window on the application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/
bin/stopServer.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is
the WebSphere Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WBM_DE_AppTarget.WBMNode2.0 server is started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
steps using the WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WBM_DE_AppTarget.WBMNode2.0 server by clicking Servers > Server
Types > WebSphere application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WBM_DE_AppTarget.WBMNode2.0

Stop servers in this order:
a. WBM_DE_AppTarget.WBMNode2.0
b. nodeagent
To stop the WBM_DE_AppTarget.WBMNode2.0 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/bin/stopNode.sh -username
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WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST WebSphere_Portal) Test
The Application Server (REST WebSphere_Portal) test tests access to the WebSphere Application Server
REST service on the target server.

Resources

The Application Server (REST WebSphere_Portal) test uses the following resource:
v WebSphere Application Server on the application server.

Problem determination
If the Application Server (REST WebSphere_Portal) test fails, do the following to find and resolve the
access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appwpe (in a
standard environment) or appwpegrp (in a high availability environment) and specify your topology
password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use wpe and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
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v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the WebSphere_Portal server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/wp_profile/bin/serverStatus.sh -all

-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server
administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
wp_profile/bin/startNode.sh . Skip this step if message ADMU0508I: The Application Server
"nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a message similar to the
following will be displayed: ADMU3000I: Server nodeagent open for e-business; process id is
26654.

a. If message ADMU0509I: The Application Server "WebSphere_Portal" cannot be reached. It
appears to be stopped. is displayed, start the WebSphere_Portal server using the following
command: /opt/IBM/WebSphere/wp_profile/bin/startServer.sh WebSphere_Portal. Skip this step
if message ADMU0508I: The Application Server "WebSphere_Portal" is STARTED. is displayed. If
you had to start WebSphere_Portal, a message similar to the following will be displayed:
ADMU3000I: Server WebSphere_Portal open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal
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Stop servers in this order:
a. WebSphere_Portal
b. nodeagent
The WebSphere_Portal server is stopped by running the following command in a command window
on the application server: /opt/IBM/WebSphere/wp_profile/bin/stopServer.sh -all -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server administrator
password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

7. Verify that the WebSphere_Portal server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WebSphere_Portal server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/wp_profile/bin/startNode.sh command in
a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal

Stop servers in this order:
a. WebSphere_Portal
b. nodeagent
To stop the WebSphere_Portal server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST WebSphere_Portal_Portal_Node2) Test
The Application Server (REST WebSphere_Portal_Portal_Node2) test tests access to the WebSphere
Application Server REST service on the target server.
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Resources

The Application Server (REST WebSphere_Portal_Portal_Node2) test uses the following resource:
v WebSphere Application Server on application server 2.

Problem determination
If the Application Server (REST WebSphere_Portal_Portal_Node2) test fails, do the following to find and
resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appwpegrp
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On application server 2 review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_Portal_Node2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_Portal_Node2/SystemErr.log
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4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WebSphere_Portal_Portal_Node2 server is started. Verification can be done using the
WebSphere Application Server Administrative Console or by manual steps. The following are the
manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/wp_profile/bin/serverStatus.sh -all

-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server
administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
wp_profile/bin/startNode.sh . Skip this step if message ADMU0508I: The Application Server
"nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a message similar to the
following will be displayed: ADMU3000I: Server nodeagent open for e-business; process id is
26654.

a. If message ADMU0509I: The Application Server "WebSphere_Portal_Portal_Node2" cannot be
reached. It appears to be stopped. is displayed, start the WebSphere_Portal_Portal_Node2
server using the following command: /opt/IBM/WebSphere/wp_profile/bin/startServer.sh
WebSphere_Portal_Portal_Node2. Skip this step if message ADMU0508I: The Application Server
"WebSphere_Portal_Portal_Node2" is STARTED. is displayed. If you had to start
WebSphere_Portal_Portal_Node2, a message similar to the following will be displayed: ADMU3000I:
Server WebSphere_Portal_Portal_Node2 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal_Portal_Node2

Stop servers in this order:
a. WebSphere_Portal_Portal_Node2
b. nodeagent
The WebSphere_Portal_Portal_Node2 server is stopped by running the following command in a
command window on the application server: /opt/IBM/WebSphere/wp_profile/bin/stopServer.sh
-all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application
Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WebSphere_Portal_Portal_Node2 server is started. Verification can be done using the
WebSphere Application Server Administrative Console or by manual steps. The following are the
steps using the WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.
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b. View the status of the WebSphere_Portal_Portal_Node2 server by clicking Servers > Server Types
> WebSphere application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/wp_profile/bin/startNode.sh command in
a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal_Portal_Node2

Stop servers in this order:
a. WebSphere_Portal_Portal_Node2
b. nodeagent
To stop the WebSphere_Portal_Portal_Node2 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST WorklightServer1) Test
The Application Server (REST WorklightServer1) test tests access to the WebSphere Application Server
REST service on the target server.

Resources

The Application Server (REST WorklightServer1) test uses the following resource:
v WebSphere Application Server on the application server.

Problem determination
If the Application Server (REST WorklightServer1) test fails, do the following to find and resolve the
access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appwrklt
(in a standard environment) or appwrkltgrp (in a high availability environment) and specify your
topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
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su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use wrklt and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the aplication server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/logs/WorklightServer1/

SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/logs/WorklightServer1/
SystemErr.log
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5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the WorklightServer1 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/WorklightProfile1/bin/startNode.sh . Skip this step if message ADMU0508I:
The Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent,
a message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "WorklightServer1" cannot be reached. It
appears to be stopped. is displayed, start the WorklightServer1 server using the following
command: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/startServer.sh
WorklightServer1. Skip this step if message ADMU0508I: The Application Server
"WorklightServer1" is STARTED. is displayed. If you had to start WorklightServer1, a message
similar to the following will be displayed: ADMU3000I: Server WorklightServer1 open for
e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WorklightServer1

Stop servers in this order:
a. WorklightServer1
b. nodeagent
The WorklightServer1 server is stopped by running the following command in a command window
on the application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/
stopServer.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER
is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere
Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

7. Verify that the WorklightServer1 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WorklightServer1 server by clicking Servers > Server Types > WebSphere
application servers.
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The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/
bin/startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WorklightServer1

Stop servers in this order:
a. WorklightServer1
b. nodeagent
To stop the WorklightServer1 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST WorklightServer2) Test
The Application Server (REST WorklightServer2) test tests access to the WebSphere Application Server
REST service on the target server.

Resources

The Application Server (REST WorklightServer2) test uses the following resource:
v WebSphere Application Server on application server 2.

Problem determination
If the Application Server (REST WorklightServer2) test fails, do the following to find and resolve the
access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
appwrkltgrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
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su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On application server 2 review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/logs/WorklightServer2/

SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/logs/WorklightServer2/
SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WorklightServer2 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server 2 system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/WorklightProfile2/bin/startNode.sh . Skip this step if message ADMU0508I:
The Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent,
a message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "WorklightServer2" cannot be reached. It
appears to be stopped. is displayed, start the WorklightServer2 server using the following
command: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/bin/startServer.sh
WorklightServer2. Skip this step if message ADMU0508I: The Application Server
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"WorklightServer2" is STARTED. is displayed. If you had to start WorklightServer2, a message
similar to the following will be displayed: ADMU3000I: Server WorklightServer2 open for
e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WorklightServer2

Stop servers in this order:
a. WorklightServer2
b. nodeagent
The WorklightServer2 server is stopped by running the following command in a command window
on the application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/bin/
stopServer.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER
is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere
Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WorklightServer2 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WorklightServer2 server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/
bin/startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WorklightServer2

Stop servers in this order:
a. WorklightServer2
b. nodeagent
To stop the WorklightServer2 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/bin/stopNode.sh
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-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (REST isim1) Test
The Application Server (REST isim1) test tests access to the WebSphere Application Server REST service
on the target server.

Resources

The Application Server (REST isim1) test uses the following resource:
v WebSphere Application Server on the application server.

Problem determination
If the Application Server (REST isim1) test fails, do the following to find and resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appisim (in
a standard environment) or appisimgrp (in a high availability environment) and specify your topology
password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use sim and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
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v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServerv7/profiles/isim1/logs/isim1/SystemOut.log

v /opt/IBM/WebSphere/AppServerv7/profiles/isim1/logs/isim1/SystemErr.log

5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the isim1 server is started. Verification can be done using the WebSphere Application
Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServerv7/profiles/isim1/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "isim1" cannot be reached. It appears to be
stopped. is displayed, start the isim1 server using the following command: /opt/IBM/WebSphere/
AppServerv7/profiles/isim1/bin/startServer.sh isim1. Skip this step if message ADMU0508I: The
Application Server "isim1" is STARTED. is displayed. If you had to start isim1, a message
similar to the following will be displayed: ADMU3000I: Server isim1 open for e-business;
process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. isim1
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Stop servers in this order:
a. isim1
b. nodeagent
The isim1 server is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/stopServer.sh -all
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server
administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

7. Verify that the isim1 server is started. Verification can be done using the WebSphere Application
Server Administrative Console or by manual steps. The following are the steps using the WebSphere
Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the isim1 server by clicking Servers > Server Types > WebSphere application
servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. isim1

Stop servers in this order:
a. isim1
b. nodeagent
To stop the isim1 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Application Server (WebSphere Application Server Admin Console) Test
The Application Server (WebSphere Application Server Admin Console) test accesses the WebSphere
Application Server on the application server.
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Resources

The Application Server (WebSphere Application Server Admin Console) test uses the following resource:
v WebSphere Application Server (on the application server)

Problem determination
If the Application Server (WebSphere Application Server Admin Console) test fails, do the following to
find and resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appdmgr (in
a standard environment) or appdmgrgrp (in a high availability environment) and specify your topology
password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use appdmgr and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
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su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/dmgr/logs/dmgr/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/dmgr/logs/dmgr/SystemErr.log

5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the dmgr server is started by the WebSphere Application Server administrative console or
by manual steps. The following are the manual steps.
a. On the application server log on as ibmadmin.
b. Start the dmgr server by running the following command.

/opt/IBM/WebSphere/AppServer/profiles/dmgr/bin/startManager.sh

The dmgr server can be stopped by running the following command in a command window on
the application server:
/opt/IBM/WebSphere/AppServer/profiles/dmgr/bin/stopManager.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD

where WAS_ADMIN_USER is the WebSphere Application Server administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere Application Server administrator ID password

7. Verify that the dmgr server is started by the WebSphere Application Server administrative console or
by manual steps. The following are the steps using the WebSphere Application Server administrative
console.
a. Log on to the WebSphere Application Server administrative console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
administrator ID (usually admin) and password. APPLICATION_SERVER_HOST is the application
server hostname.

8. Verify that the dmgr server is started by the WebSphere Application Server administrative console or
by manual steps. The following are the steps using the WebSphere Application Server administrative
console.
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WebSphere_Portal server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable.
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To stop the dmgr server, select the server and click Stop.

What to do next

Resolve any issues or errors found and retry the test.

Business Monitoring (WebSphere Business Monitor console) Test
The Business Monitoring (WebSphere Business Monitor console) test determines if the IBM Business
Monitor server is running and the administration console is available.

Resources

The Business Monitoring (WebSphere Business Monitor console) test uses the following resource:
v WebSphere Application Server named WBM_DE.AppTarget.WBMNode1.0

Problem determination
If the Business Monitoring (WebSphere Business Monitor console) test fails, do the following to find and
resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appbmon
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the component and to start
and stop it as needed. For component use wbm and specify your topology password for
topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log
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b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/logs/WBM_DE_AppTarget.WBMNode1.0/

SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/logs/WBM_DE_AppTarget.WBMNode1.0/
SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WBM_DE_AppTarget.WBMNode1.0 server is started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/wbmProfile1/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "WBM_DE_AppTarget.WBMNode1.0" cannot be
reached. It appears to be stopped. is displayed, start the server using the following command:
/opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/startServer.sh
WBM_DE_AppTarget.WBMNode1.0. Skip this step if message ADMU0508I: The Application Server
"WBM_DE_AppTarget.WBMNode1.0" is STARTED. is displayed. If you had to start the server, a
message similar to the following will be displayed: ADMU3000I: Server
WBM_DE_AppTarget.WBMNode1.0 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WBM_DE_AppTarget.WBMNode1.0

Stop servers in this order:
a. WBM_DE_AppTarget.WBMNode1.0
b. nodeagent
The WBM_DE_AppTarget.WBMNode1.0 server is stopped by running the following command in a
command window on the application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/
bin/stopServer.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is
the WebSphere Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/stopNode.sh -username
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WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WBM_DE_AppTarget.WBMNode1.0 server is started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
steps using the WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WBM_DE_AppTarget.WBMNode1.0 server by clicking Servers > Server
Types > WebSphere application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WBM_DE_AppTarget.WBMNode1.0

Stop servers in this order:
a. WBM_DE_AppTarget.WBMNode1.0
b. nodeagent
To stop the WBM_DE_AppTarget.WBMNode1.0 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

Business Monitoring (WebSphere Business Monitor console) [1] Test
The Business Monitoring (WebSphere Business Monitor console) [1] test determines if the primary IBM
Business Monitor server in a high availability environment is running and the administration console is
available.

Resources

The Business Monitoring (WebSphere Business Monitor console) [1] test uses the following resource:
v WebSphere Application Server named WBM_DE.AppTarget.WBMNode1.0

Problem determination
If the Business Monitoring (WebSphere Business Monitor console) [1] test fails, do the following to find
and resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appbmongrp
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:
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su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. Use the platform control tool to check the status of the servers and to start and stop them as needed.
Run the following commands with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/logs/WBM_DE_AppTarget.WBMNode1.0/

SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/logs/WBM_DE_AppTarget.WBMNode1.0/
SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WBM_DE_AppTarget.WBMNode1.0 server is started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
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AppServer/profiles/wbmProfile1/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "WBM_DE_AppTarget.WBMNode1.0" cannot be
reached. It appears to be stopped. is displayed, start the server using the following command:
/opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/startServer.sh
WBM_DE_AppTarget.WBMNode1.0. Skip this step if message ADMU0508I: The Application Server
"WBM_DE_AppTarget.WBMNode1.0" is STARTED. is displayed. If you had to start the server, a
message similar to the following will be displayed: ADMU3000I: Server
WBM_DE_AppTarget.WBMNode1.0 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WBM_DE_AppTarget.WBMNode1.0

Stop servers in this order:
a. WBM_DE_AppTarget.WBMNode1.0
b. nodeagent
The WBM_DE_AppTarget.WBMNode1.0 server is stopped by running the following command in a
command window on the application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/
bin/stopServer.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is
the WebSphere Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WBM_DE_AppTarget.WBMNode1.0 server is started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
steps using the WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WBM_DE_AppTarget.WBMNode1.0 server by clicking Servers > Server
Types > WebSphere application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WBM_DE_AppTarget.WBMNode1.0
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Stop servers in this order:
a. WBM_DE_AppTarget.WBMNode1.0
b. nodeagent
To stop the WBM_DE_AppTarget.WBMNode1.0 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

Business Monitoring (WebSphere Business Monitor console) [2] Test
The Business Monitoring (WebSphere Business Monitor console) [2] test determines if the backup IBM
Business Monitor server in a high availability environment is running and the administration console is
available.

Resources

The Business Monitoring (WebSphere Business Monitor console) [2] test uses the following resource:
v WebSphere Application Server named WBM_DE.AppTarget.WBMNode2.0

Problem determination
If the Business Monitoring (WebSphere Business Monitor console) [2] test fails, do the following to find
and resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appbmongrp
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
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a. On the application server review the following WebSphere Portal logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On application server 2 review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/logs/WBM_DE_AppTarget.WBMNode2.0/

SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/logs/WBM_DE_AppTarget.WBMNode2.0/
SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WBM_DE_AppTarget.WBMNode2.0 server is started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
manual steps:
a. On the application server 2 system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/wbmProfile2/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "WBM_DE_AppTarget.WBMNode2.0" cannot be
reached. It appears to be stopped. is displayed, start the WBM_DE_AppTarget.WBMNode2.0
server using the following command: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/bin/
startServer.sh WBM_DE_AppTarget.WBMNode2.0. Skip this step if message ADMU0508I: The
Application Server "WBM_DE_AppTarget.WBMNode2.0" is STARTED. is displayed. If you had to start
WBM_DE_AppTarget.WBMNode2.0, a message similar to the following will be displayed:
ADMU3000I: Server WBM_DE_AppTarget.WBMNode2.0 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WBM_DE_AppTarget.WBMNode2.0

Stop servers in this order:
a. WBM_DE_AppTarget.WBMNode2.0
b. nodeagent
The WBM_DE_AppTarget.WBMNode2.0 server is stopped by running the following command in a
command window on the application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/
bin/stopServer.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
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WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is
the WebSphere Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WBM_DE_AppTarget.WBMNode2.0 server is started. Verification can be done using
the WebSphere Application Server Administrative Console or by manual steps. The following are the
steps using the WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WBM_DE_AppTarget.WBMNode2.0 server by clicking Servers > Server
Types > WebSphere application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WBM_DE_AppTarget.WBMNode2.0

Stop servers in this order:
a. WBM_DE_AppTarget.WBMNode2.0
b. nodeagent
To stop the WBM_DE_AppTarget.WBMNode2.0 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Collaboration (Lotus Domino console) Test
Collaboration (Lotus Domino console) test determines if the Domino Directory is accessible through its
URL.

Resources

The Collaboration (Lotus Domino console) test uses the following resource:
v Domino Server (on the application server).

Problem determination
If the Collaboration (Lotus Domino console) test fails, do the following to find and resolve the problem.

Chapter 7. Administering the solution 277



Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appdomino
(in a standard environment) or appdominogrp (in a high availability environment) and specify your
topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use st and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the server, specify 871 for action.
v To start the server, specify 261 for action.
v To stop the server, specify 611 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following Lotus Domino logs:

v /local/notesdata/console.out

v /local/notesdata/log.nsf

v All logs in the /local/notesdata/IBM_TECHNICAL_SUPPORT/ directory.
5. Verify that the file systems on the application server system have not reached capacity. This can be

determined using the df -h command.
6. Verify that the Lotus Domino Process components are running.
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a. Login to the Lotus Domino Directory console at http://APP_SERVER_HOST:84/names.nsf where
APP_SERVER_HOST is the host name of the application server. Login using the Domino
administrator username and password.

b. If the console cannot be accessed, on the application server, run the ps -ef | grep notes
command to determine if the Lotus Domino processes are running. The Lotus Domino processes
are:
v server
v event
v update
v replica
v router
v adminp
v calconn
v sched
v http
v rnrmgr
v staddin

7. If some, but not all, processes are running, stop the running processes before restarting all the
processes.
a. On the application server, login as the notes user.
b. Change to the /local/notesdata directory.
c. Run the "nohup /opt/IBM/lotus/bin/server -q >console.out 2>&1 &" command to stop all

running Lotus Domino processes.
d. Check that all processes have stopped by running the ps -ef | grep notes command.
e. If any Lotus Domino processes are still running, stop them using the kill -9 pid where pid is the

process identifier of the Lotus Domino process.
8. If the Lotus Domino processes are not running, start the Lotus Domino Server components.

a. On the application server, login as the notes user.
b. Change to the /local/notesdata directory.
c. Run the "nohup /opt/IBM/lotus/bin/server > console.out 2>&1 &" command to start all Lotus

Domino Server components.

What to do next

Resolve any issues or errors found and retry the test.

Collaboration (Lotus Sametime console) Test
Collaboration (Lotus Sametime console) test determines if the Sametime Console is accessible through its
URL.

Resources

The Collaboration (Lotus Sametime console) test uses the following resource:
v Sametime Server (on the application server).

Problem determination
If the Collaboration (Lotus Sametime console) test fails, do the following to find and resolve the problem.
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Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appdomino
(in a standard environment) or appdominogrp (in a high availability environment) and specify your
topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use st and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the server, specify 871 for action.
v To start the server, specify 261 for action.
v To stop the server, specify 611 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Collect and review the Sametime Community Server configuration and log files.
a. Log on the application server as a notes user.
b. Change to the /local/notesdata directory.
c. Run the sh stdiagzip.sh command. This command will collect all pertinent log files and write

them to the /local/notesdata/ directory.
d. Review the logs in the /local/notesdata/ directory.

5. Verify that the file systems on the application server system have not reached capacity. This can be
determined using the df -h command.

6. Verify that the Sametime Process components are running.
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a. Login to the Sametime Home page at http://APP_SERVER_HOST:84/stcenter.nsf where
APP_SERVER_HOST is the host name of the application server. Login using the Domino
administrator username and password.

b. On the Sametime Home page click Administer the server.
c. On the Server - Overview page, make sure all the Sametime services are running.

7. If some, but not all, processes are running, stop the running processes before restarting all the
processes.
a. On the application server, login as the notes user.
b. Change to the /local/notesdata directory.
c. Run the "nohup /opt/IBM/lotus/bin/server -q >console.out 2>&1 &" command to stop all

running Sametime processes.
d. Check that all processes have stopped by running the ps -ef | grep notes command.
e. If any processes are still running, stop them by using the kill -9 pid where pid is the process

identifier of the Lotus Domino process.
8. If the Sametime processes are not running, start the Lotus Sametime Server components.

a. On the application server, login as the notes user.
b. Change to the /local/notesdata directory.
c. Run the "nohup /opt/IBM/lotus/bin/server > console.out 2>&1 &" command to start all Lotus

Sametime Server components.

What to do next

Resolve any issues or errors found and retry the test.

Collaboration (Lotus Sametime Proxy console) Test
The Collaboration (Lotus Sametime Proxy console) test determines if the Lotus Sametime Proxy Web
Application can be accessed by the Lotus Sametime Proxy Web Application URL.

Resources

The Collaboration (Lotus Sametime Proxy console) test uses the following resource:
v Sametime Proxy (on the application server).

Problem determination
If the Collaboration (Lotus Sametime Proxy console) test fails, do the following to find and resolve the
access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appstproxy
(in a standard environment) or appstproxygrp (in a high availability environment) and specify your
topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
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su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the server, specify 871 for action.
v To start the server, specify 261 for action.
v To stop the server, specify 611 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. On the application server review the following Sametime Proxy Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/STPAppProfile1/logs/STProxyServer1/SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/STPAppProfile1/logs/STProxyServer1/SystemErr.log

4. Verify that the file systems on the application server system have not reached capacity. This can be
determined using the df -h command.

5. Verify that the Sametime Proxy Server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/STPAppProfile1/bin/

serverStatus.sh -all -username waswebadmin -password WAS_ADMIN_PWD where
WAS_ADMIN_PWD is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped.is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/STProxyServer1/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

d. If message ADMU0509I: The Application Server "STProxyServer1" cannot be reached. It
appears to be stopped. is displayed, start STProxyServer1 using the following command:
/opt/IBM/WebSphere/AppServer/profiles/STPAppProfile1/bin/startServer.sh STProxyServer1.
Skip this step if message ADMU0508I: The Application Server "STProxyServer1" is STARTED. is
displayed. If you had to start STProxyServer1, a message similar to the following will be
displayed: ADMU3000I: Server STProxyServer1 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. STProxyServer1

Stop servers in this order:
a. STProxyServer1
b. nodeagent
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The STProxyServer1 server is stopped by running the following command in a command window on
the Application Server: /opt/IBM/WebSphere/AppServer/profiles/STPAppProfile1/bin/stopServer.sh
STProxyServer1 -username waswebadmin -password WAS_ADMIN_PWD where WAS_ADMIN_PWD is the
WebSphere administrator password.
The nodeagent is stopped by running the following command in a command window on the
Application Server: /opt/IBM/WebSphere/AppServer/profiles/STPAppProfile1/bin/stopNode.sh
-username waswebadmin -password WAS_ADMIN_PWD where WAS_ADMIN_PWD is the WebSphere
administrator password.

6. Verify that the Sametime Proxy Server is are started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the STProxyServer1 server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/STProxyServer1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. STProxyServer1

Stop servers in this order:
a. STProxyServer1
b. nodeagent
To stop the STProxyServer1 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
Application Server: /opt/IBM/WebSphere/AppServer/profiles/STPAppProfile1/bin/stopNode.sh
-username waswebadmin -password WAS_ADMIN_PWD where WAS_ADMIN_PWD is the WebSphere
administrator password.

7. Verify that the Sametime Proxy Console can be accessed from the WebSphere Portal system, on the
application server, using following URL: http://APPLICATION_SERVER_HOST:9085/stwebclient/
popup.jsp. Where the APPLICATION_SERVER_HOST is host name for the application server.

What to do next

Resolve any issues or errors found and retry the test.

Database (database name) Test
The Database (database name) tests the DB2 manager status of the database name DB2 instance on the data
server by running the db2status script.
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Resources

The Database (database name) test uses the following resource:
v The Application DB2 instance (on the data server)

Problem determination
If the Database (database name) test fails, do the following to find and resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use dbsdb24app
(in a standard environment) or dbsdb24appgrp (in a high availability environment) and specify your
topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use db24app and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 821 for action.
v To check the status of the standby server, specify 823 for action.
v To start the primary server, specify 141 for action.
v To start the standby server, specify 151 for action.
v To stop the primary server, specify 701 for action.
v To stop the standby server, specify 711 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

284 IBM Intelligent Operations Center: IBM Intelligent Operations Center Product Documentation



4. Check that there is network connectivity between the application server where the test was initiated
and the data server where the database resides. This can be done by sending ping commands with
both the short and fully-qualified host name of the data server from the application server. The results
of the ping commands will show if the host name is being correctly resolved by the DNS or
/etc/hosts file.

5. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

6. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.

7. Verify that the database manager used by the data server is started.
a. On the data server, run the following command from a command window as the Applications

DB2 instance user (db2inst2).
db2 get snapshot for dbm | grep "Database manager status"

If the database manager is started for the database name instance, the following message is
displayed: Database manager status = Active.

8. If the DB2 processes are not running, start them by running su - db2inst2 from the command
window if running as the root user. Otherwise, run db2start to start the Database Manager.

9. Check the DB2 logs for errors related to the database instance used for this test. The logs are located
on the data server in the /datahome/db2inst2/sqllib/db2dump directory. Check the db2diag.log in the
/datahome/db2inst2/sqllib/db2dump directory for errors issued when starting the database used for
this test.

What to do next

Resolve any issues or errors found and retry the test.

Database (DB2 Instance - Applications) Test
The Database (DB2 Instance - Applications) tests the DB2 manager status of the DB2 instance on the data
server by running the db2status script.

Resources

The Database (DB2 Instance - Applications) test uses the following resource:
v The DB2 Applications instance (on the data server)

Problem determination
If the Database (DB2 Instance - Applications) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use dbsdb24app
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
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su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the component and to start
and stop it as needed. For component use db24app and specify your topology password for
topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. Check that there is network connectivity between the application server where the test was initiated
and the data server where the database resides. This can be done by sending ping commands with
both the short and fully-qualified host name of the data server from the application server. The results
of the ping commands will show if the host name is being correctly resolved by the DNS or
/etc/hosts file.

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

5. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.

6. Verify that the database manager used by the data server is started.
a. On the data server, run the following command from a command window as the Applications

instance user.
db2 get snapshot for dbm | grep "Database manager status"

If the database manager is started for the Applications instance, the following message is
displayed: Database manager status = Active.

7. If the DB2 processes are not running, start them by running su - db2inst2 from the command
window if running as the root user. Otherwise, run db2start to start the Database Manager.

8. Check the DB2 logs for errors related to the database instance used for this test. The logs are located
on the data server in the /datahome/db2inst2/sqllib/db2dump directory. Check the db2diag.log in the
/datahome/db2inst2/sqllib/db2dump directory for errors issued when starting the database used for
this test.

What to do next

Resolve any issues or errors found and retry the test.
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Database (DB2 Instance - Applications) [1] Test
The Database (DB2 Instance - Applications) [1] tests the DB2 manager status of the DB2 instance on data
server 1 in a high availability environment by running the db2status script.

Resources

The Database (DB2 Instance - Applications) [1] test uses the following resource:
v The DB2 Applications instance (on the data server)

Problem determination
If the Database (DB2 Instance - Applications) [1] test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
dbsdb24appgrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 821 for action.
v To check the status of the standby server, specify 823 for action.
v To start the primary server, specify 141 for action.
v To start the standby server, specify 151 for action.
v To stop the primary server, specify 701 for action.
v To stop the standby server, specify 711 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Check that there is network connectivity between the application server where the test was initiated
and the data server where the database resides. This can be done by sending ping commands with
both the short and fully-qualified host name of the data server from the application server. The results
of the ping commands will show if the host name is being correctly resolved by the DNS or
/etc/hosts file.

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
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v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

5. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.

6. Verify that the database manager used by the data server is started.
a. On the data server, run the following command from a command window as the Applications

instance user.
db2 get snapshot for dbm | grep "Database manager status"

If the database manager is started for the Applications instance, the following message is
displayed: Database manager status = Active.

7. If the DB2 processes are not running, start them by running su - db2inst2 from the command
window if running as the root user. Otherwise, run db2start to start the Database Manager.

8. Check the DB2 logs for errors related to the database instance used for this test. The logs are located
on the data server in the /datahome/db2inst2/sqllib/db2dump directory. Check the db2diag.log in the
/datahome/db2inst2/sqllib/db2dump directory for errors issued when starting the database used for
this test.

What to do next

Resolve any issues or errors found and retry the test.

Database (DB2 Instance - Applications) [2] Test
The Database (DB2 Instance - Applications) [2] tests the DB2 manager status of the DB2 instance on data
server 2 in a high availability environment by running the db2status script.

Resources

The Database (DB2 Instance - Applications) [2] test uses the following resource:
v The DB2 Applications instance (on the data server)

Problem determination
If the Database (DB2 Instance - Applications) [2] test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
dbsdb24appgrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password
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2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 821 for action.
v To check the status of the standby server, specify 823 for action.
v To start the primary server, specify 141 for action.
v To start the standby server, specify 151 for action.
v To stop the primary server, specify 701 for action.
v To stop the standby server, specify 711 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Check that there is network connectivity between the application server where the test was initiated
and the data server where the database resides. This can be done by sending ping commands with
both the short and fully-qualified host name of the data server from the application server. The results
of the ping commands will show if the host name is being correctly resolved by the DNS or
/etc/hosts file.

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

5. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.

6. Verify that the database manager used by the data server is started.
a. On the data server, run the following command from a command window as the Applications

instance user.
db2 get snapshot for dbm | grep "Database manager status"

If the database manager is started for the Applications instance, the following message is
displayed: Database manager status = Active.

7. If the DB2 processes are not running, start them by running su - db2inst2 from the command
window if running as the root user. Otherwise, run db2start to start the Database Manager.

8. Check the DB2 logs for errors related to the database instance used for this test. The logs are located
on the data server in the /datahome/db2inst2/sqllib/db2dump directory. Check the db2diag.log in the
/datahome/db2inst2/sqllib/db2dump directory for errors issued when starting the database used for
this test.

What to do next

Resolve any issues or errors found and retry the test.

Database (DB2 Instance - Directory Server) Test
The Database (DB2 Instance - Directory Server) tests the DB2 manager status of the DB2 instance on the
data server by running the db2status script.
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Resources

The Database (DB2 Instance - Directory Server) test uses the following resource:
v The DB2 Directory Server instance (on the data server)

Problem determination
If the Database (DB2 Instance - Directory Server) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use dbstdsserv
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the component and to start
and stop it as needed. For component use tds and specify your topology password for
topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. Check that there is network connectivity between the application server where the test was initiated
and the data server where the database resides. This can be done by sending ping commands with
both the short and fully-qualified host name of the data server from the application server. The results
of the ping commands will show if the host name is being correctly resolved by the DNS or
/etc/hosts file.

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

5. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.
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6. Verify that the database manager used by the data server is started.
a. On the data server, run the following command from a command window as the Directory Server

instance user.
db2 get snapshot for dbm | grep "Database manager status"

If the database manager is started for the Directory Server instance, the following message is
displayed: Database manager status = Active.

7. If the DB2 processes are not running, start them by running su - dsrdbm01 from the command
window if running as the root user. Otherwise, run db2start to start the Database Manager.

8. Check the DB2 logs for errors related to the database instance used for this test. The logs are located
on the data server in the /datahome/dsrdbm01/sqllib/db2dump directory.

9. Check the db2diag.log for errors issued when starting the database used for this test.

What to do next

Resolve any issues or errors found and retry the test.

Database (DB2 Instance - Directory Server) [1] Test
The Database (DB2 Instance - Directory Server) [1]tests the DB2 manager status of the DB2 instance on
data server 1 in a high availability environment by running the db2status script.

Resources

The Database (DB2 Instance - Directory Server) [1] test uses the following resource:
v The DB2 Directory Server instance (on the data server)

Problem determination
If the Database (DB2 Instance - Directory Server) [1] test fails, do the following to find and resolve the
access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
dbstdsservgrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 821 for action.
v To check the status of the standby server, specify 823 for action.
v To start the primary server, specify 141 for action.
v To start the standby server, specify 151 for action.
v To stop the primary server, specify 701 for action.
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v To stop the standby server, specify 711 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Check that there is network connectivity between the application server where the test was initiated
and the data server where the database resides. This can be done by sending ping commands with
both the short and fully-qualified host name of the data server from the application server. The results
of the ping commands will show if the host name is being correctly resolved by the DNS or
/etc/hosts file.

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

5. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.

6. Verify that the database manager used by the data server is started.
a. On the data server, run the following command from a command window as the Directory Server

instance user.
db2 get snapshot for dbm | grep "Database manager status"

If the database manager is started for the Directory Server instance, the following message is
displayed: Database manager status = Active.

7. If the DB2 processes are not running, start them by running su - dsrdbm01 from the command
window if running as the root user. Otherwise, run db2start to start the Database Manager.

8. Check the DB2 logs for errors related to the database instance used for this test. The logs are located
on the data server in the /datahome/dsrdbm01/sqllib/db2dump directory.

9. Check the db2diag.log for errors issued when starting the database used for this test.

What to do next

Resolve any issues or errors found and retry the test.

Database (DB2 Instance - Directory Server) [2] Test
The Database (DB2 Instance - Directory Server) [2] tests the DB2 manager status of the DB2 instance on
data server 2 in a high availability environment by running the db2status script.

Resources

The Database (DB2 Instance - Directory Server) [2] test uses the following resource:
v The DB2 Directory Server instance (on the data server)

Problem determination
If the Database (DB2 Instance - Directory Server) [2] test fails, do the following to find and resolve the
access problem.
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Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
dbstdsservgrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 821 for action.
v To check the status of the standby server, specify 823 for action.
v To start the primary server, specify 141 for action.
v To start the standby server, specify 151 for action.
v To stop the primary server, specify 701 for action.
v To stop the standby server, specify 711 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Check that there is network connectivity between the application server where the test was initiated
and the data server where the database resides. This can be done by sending ping commands with
both the short and fully-qualified host name of the data server from the application server. The results
of the ping commands will show if the host name is being correctly resolved by the DNS or
/etc/hosts file.

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

5. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.

6. Verify that the database manager used by the data server is started.
a. On the data server, run the following command from a command window as the Directory Server

instance user.
db2 get snapshot for dbm | grep "Database manager status"
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If the database manager is started for the Directory Server instance, the following message is
displayed: Database manager status = Active.

7. If the DB2 processes are not running, start them by running su - dsrdbm01 from the command
window if running as the root user. Otherwise, run db2start to start the Database Manager.

8. Check the DB2 logs for errors related to the database instance used for this test. The logs are located
on the data server in the /datahome/dsrdbm01/sqllib/db2dump directory.

9. Check the db2diag.log for errors issued when starting the database used for this test.

What to do next

Resolve any issues or errors found and retry the test.

Database (DB2 Instance - Middleware) Test
The Database (DB2 Instance - Middleware) tests the DB2 manager status of the DB2 instance on the data
server by running the db2status script.

Resources

The Database (DB2 Instance - Middleware) test uses the following resource:
v The DB2 Middleware instance (on the data server)

Problem determination
If the Database (DB2 Instance - Middleware) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use dbsdb24mid
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the component and to start
and stop it as needed. For component use db24mid and specify your topology password for
topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
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su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. Check that there is network connectivity between the application server where the test was initiated
and the data server where the database resides. This can be done by sending ping commands with
both the short and fully-qualified host name of the data server from the application server. The results
of the ping commands will show if the host name is being correctly resolved by the DNS or
/etc/hosts file.

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

5. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.

6. Verify that the database manager used by the data server is started.
a. On the data server, run the following command from a command window as the Middleware

instance user.
db2 get snapshot for dbm | grep "Database manager status"

If the database manager is started for the Middleware instance, the following message is
displayed: Database manager status = Active.

7. If the DB2 processes are not running, start them by running su - db2inst1 from the command
window if running as the root user. Otherwise, run db2start to start the Database Manager.

8. Check the DB2 logs for errors related to the database instance used for this test. The logs are located
on the data server in the /datahome/db2inst1/sqllib/db2dump directory.

9. Check the db2diag.log for errors issued when starting the database used for this test.

What to do next

Resolve any issues or errors found and retry the test.

Database (DB2 Instance - Middleware) [1] Test
The Database (DB2 Instance - Middleware) [1] tests the DB2 manager status of the DB2 instance on data
server 1 in a high availability environment by running the db2status script.

Resources

The Database (DB2 Instance - Middleware) [1] test uses the following resource:
v The DB2 Middleware instance (on the data server)

Problem determination
If the Database (DB2 Instance - Middleware) [1] test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
dbsdb24midgrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:
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su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 821 for action.
v To check the status of the standby server, specify 823 for action.
v To start the primary server, specify 141 for action.
v To start the standby server, specify 151 for action.
v To stop the primary server, specify 701 for action.
v To stop the standby server, specify 711 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Check that there is network connectivity between the application server where the test was initiated
and the data server where the database resides. This can be done by sending ping commands with
both the short and fully-qualified host name of the data server from the application server. The results
of the ping commands will show if the host name is being correctly resolved by the DNS or
/etc/hosts file.

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

5. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.

6. Verify that the database manager used by the data server is started.
a. On the data server, run the following command from a command window as the Middleware

instance user.
db2 get snapshot for dbm | grep "Database manager status"

If the database manager is started for the Middleware instance, the following message is
displayed: Database manager status = Active.

7. If the DB2 processes are not running, start them by running su - db2inst1 from the command
window if running as the root user. Otherwise, run db2start to start the Database Manager.

8. Check the DB2 logs for errors related to the database instance used for this test. The logs are located
on the data server in the /datahome/db2inst1/sqllib/db2dump directory.
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9. Check the db2diag.log for errors issued when starting the database used for this test.

What to do next

Resolve any issues or errors found and retry the test.

Database (DB2 Instance - Middleware) [2] Test
The Database (DB2 Instance - Middleware) [2]tests the DB2 manager status of the DB2 instance on data
server 2 in a high availability environment by running the db2status script.

Resources

The Database (DB2 Instance - Middleware) [2] test uses the following resource:
v The DB2 Middleware instance (on the data server)

Problem determination
If the Database (DB2 Instance - Middleware) [2] test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
dbsdb24midgrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 821 for action.
v To check the status of the standby server, specify 823 for action.
v To start the primary server, specify 141 for action.
v To start the standby server, specify 151 for action.
v To stop the primary server, specify 701 for action.
v To stop the standby server, specify 711 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Check that there is network connectivity between the application server where the test was initiated
and the data server where the database resides. This can be done by sending ping commands with
both the short and fully-qualified host name of the data server from the application server. The results
of the ping commands will show if the host name is being correctly resolved by the DNS or
/etc/hosts file.

4. Review the log files for runtime exceptions.
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a. On the application server review the following WebSphere Portal logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

5. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used. For
this reason if the df -h command returns that the file system is 90% or more full, you should consider
that the file system has reached capacity.

6. Verify that the database manager used by the data server is started.
a. On the data server, run the following command from a command window as the Middleware

instance user.
db2 get snapshot for dbm | grep "Database manager status"

If the database manager is started for the Middleware instance, the following message is
displayed: Database manager status = Active.

7. If the DB2 processes are not running, start them by running su - db2inst1 from the command
window if running as the root user. Otherwise, run db2start to start the Database Manager.

8. Check the DB2 logs for errors related to the database instance used for this test. The logs are located
on the data server in the /datahome/db2inst1/sqllib/db2dump directory.

9. Check the db2diag.log for errors issued when starting the database used for this test.

What to do next

Resolve any issues or errors found and retry the test.

Directory (Tivoli Directory Server console) Test
The Directory (Tivoli Directory Server console) test determines if the Tivoli Directory Server is available
by sending an HTTP request to the server.

Resources

The Directory (Tivoli Directory Server console) test uses the following resource:
v Tivoli Directory Server (on the data server)

Problem determination
If the Directory (Tivoli Directory Server console) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
dbstdsserv (in a standard environment) or dbstdsservgrp (in a high availability environment) and
specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
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su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with
the desired options. For component use tds and specify your topology password for
topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 811 for action.
v To check the status of the standby server, specify 813 for action.
v To start the primary server, specify 101 for action.
v To start the standby server, specify 111 for action.
v To stop the primary server, specify 741 for action.
v To stop the standby server, specify 751 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

5. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the Tivoli Directory Server LDAP server is running.
a. Log on to a terminal session on the data server as root.
b. Run the ps -ef | grep ibmslapd command. The results will be similar to the following:

dsrdbm01 13797 1 0 Apr26 pts/1 00:00:09 /opt/ibm/ldap/V6.3/sbin/64/ibmslapd -I dsrdbm01 -t -n
root 32080 19149 0 23:17 pts/1 00:00:00 grep ibmslapd

This example shows that the Tivoli Directory Server daemon, ibmslapd, is running.
c. Run the ps -ef | grep ibmdiradm command. The results will be similar to the following:
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root 4394 14038 0 14:17 pts/2 00:00:00 grep ibmdiradm
dsrdbm01 11055 1 0 Apr26 pts/1 00:00:00 /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t

This example shows that the Tivoli Directory Server daemon, ibmdiradm, is running.
7. If the Tivoli Directory Server, ibmslapd, is not running, do the following.

a. As a root Linux user, run /opt/ibm/ldap/V6.3/sbin/ibmslapd -I dsrdbm01 to start the Directory
Server

8. If the Tivoli Directory Administration Server, ibmdiradm, is not running, do the following.
a. On a terminal session on the data server, run su - dsrdbm01.
b. Run /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t to start the application server.

9. If the Tivoli Directory Server, ibmslapd, is running, do the following.

Note: Do this step even if the Tivoli Directory Server was started in the previous step.
a. Log on to a terminal session on the data server as dsrdbm01.
b. Run idsldapsearch -h localhost -D "cn=root" -w "ADMIN_PASSWORD" -s sub uid=* where

ADMIN_PASSWORD is the LDAP Root Administrator account password. The existing LDAP user
objects will be displayed.

10. Verify that the Tivoli Directory Server Web Administration Tool is running. The Tivoli Directory
Server Web Administration Tool is used to stop and start the LDAP instance, add users or accounts,
and view log files.
a. Log on to a terminal session on the application server as ibmadmin.
b. Run the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/serverStatus.sh -all -username

waswebadmin -password WAS_ADMIN_PASSWORD command on the application server where
WAS_ADMIN_PASSWORD is the WebSphere Application Server administrator password. If the
tool is running, a message similar to the following will be returned.
ADMU0508I: The Application Server "tdsServer" is STARTED

If the following message is returned, the tdsServer needs to be started.
ADMU0509I: The Application Server "tdsServer" cannot be reached. It appears to be stopped.

c. Start the tdsServer by running the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/
startServer.sh tdsServer command. The server, tdsServer, will start and a message similar to
the following will be displayed.
ADMU3000I: Server tdsServer open for e-business; process id is 26654

11. Access the Tivoli Directory Server Web Administration Tool at: http://DATA_SERVER_HOST:9062/
IDSWebApp/IDSjsp/Login.jsp where DATA_SERVER_HOST is the host name of the data server.

12. Log on with the LDAP Root Administrator Account, cn=root, and the appropriate password. The
LDAP Server name should be DATABASE_DIRECTORY_SERVER_HOST:389 where
DATABASE_DIRECTORY_SERVER_HOST is the host name of the data server.

13. Click Server Administration > Start/stop/reset server. The LDAP server status will be displayed.
This page can also be used to start, stop, or reset the LDAP server.

What to do next

Resolve any issues or errors found and retry the test.

Directory (Tivoli Directory Server) Test
The Directory (Tivoli Directory Server) test determines if the Tivoli Directory Server is available by
sending an HTTP request to the server.

Resources

The Directory (Tivoli Directory Server) test uses the following resource:
v Tivoli Directory Server (on the data server)
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Problem determination
If the Directory (Tivoli Directory Server) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
dbstdsserv and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the component and to start
and stop it as needed. For component use tds and specify your topology password for
topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

4. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the Tivoli Directory Server LDAP server is running.
a. Log on to a terminal session on the data server as root.
b. Run the ps -ef | grep ibmslapd command. The results will be similar to the following:

dsrdbm01 13797 1 0 Apr26 pts/1 00:00:09 /opt/ibm/ldap/V6.3/sbin/64/ibmslapd -I dsrdbm01 -t -n
root 32080 19149 0 23:17 pts/1 00:00:00 grep ibmslapd

This example shows that the Tivoli Directory Server daemon, ibmslapd, is running.
c. Run the ps -ef | grep ibmdiradm command. The results will be similar to the following:

root 4394 14038 0 14:17 pts/2 00:00:00 grep ibmdiradm
dsrdbm01 11055 1 0 Apr26 pts/1 00:00:00 /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t

This example shows that the Tivoli Directory Server daemon, ibmdiradm, is running.
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6. If the Tivoli Directory Server, ibmslapd, is not running, do the following.
a. As a root Linux user, run /opt/ibm/ldap/V6.3/sbin/ibmslapd -I dsrdbm01 to start the Directory

Server
7. If the Tivoli Directory Administration Server, ibmdiradm, is not running, do the following.

a. On a terminal session on the data server, run su - dsrdbm01.
b. Run /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t to start the application server.

8. If the Tivoli Directory Server, ibmslapd, is running, do the following.

Note: Do this step even if the Tivoli Directory Server was started in the previous step.
a. Log on to a terminal session on the data server as dsrdbm01.
b. Run idsldapsearch -h localhost -D "cn=root" -w "ADMIN_PASSWORD" -s sub uid=* where

ADMIN_PASSWORD is the LDAP Root Administrator account password. The existing LDAP user
objects will be displayed.

9. Verify that the Tivoli Directory Server Web Administration Tool is running. The Tivoli Directory
Server Web Administration Tool is used to stop and start the LDAP instance, add users or accounts,
and view log files.
a. Log on to a terminal session on the application server as ibmadmin.
b. Run the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/serverStatus.sh -all -username

waswebadmin -password WAS_ADMIN_PASSWORD command on the application server where
WAS_ADMIN_PASSWORD is the WebSphere Application Server administrator password. If the
tool is running, a message similar to the following will be returned.
ADMU0508I: The Application Server "tdsServer" is STARTED

If the following message is returned, the tdsServer needs to be started.
ADMU0509I: The Application Server "tdsServer" cannot be reached. It appears to be stopped.

c. Start the tdsServer by running the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/
startServer.sh tdsServer command. The server, tdsServer, will start and a message similar to
the following will be displayed.
ADMU3000I: Server tdsServer open for e-business; process id is 26654

10. Access the Tivoli Directory Server Web Administration Tool at: http://DATA_SERVER_HOST:9062/
IDSWebApp/IDSjsp/Login.jsp where DATA_SERVER_HOST is the host name of the data server.

11. Log on with the LDAP Root Administrator Account, cn=root, and the appropriate password. The
LDAP Server name should be DATABASE_DIRECTORY_SERVER_HOST:389 where
DATABASE_DIRECTORY_SERVER_HOST is the host name of the data server.

12. Click Server Administration > Start/stop/reset server. The LDAP server status will be displayed.
This page can also be used to start, stop, or reset the LDAP server.

What to do next

Resolve any issues or errors found and retry the test.

Directory (Tivoli Directory Server) [1] Test
The Directory (Tivoli Directory Server) [1] test determines if the Tivoli Directory Server is available by
sending an HTTP request to the server.

Resources

The Directory (Tivoli Directory Server) [1] test uses the following resource:
v Tivoli Directory Server (on the data server)

Problem determination
If the Directory (Tivoli Directory Server) [1] test fails, do the following to find and resolve the access
problem.
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Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
dbstdsservgrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 811 for action.
v To check the status of the standby server, specify 813 for action.
v To start the primary server, specify 101 for action.
v To start the standby server, specify 111 for action.
v To stop the primary server, specify 741 for action.
v To stop the standby server, specify 751 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. On the data server review the following Tivoli Directory Server log: /datahome/dsrdbm01/
idsslapd-dsrdbm01/logs/audit.log

4. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the Tivoli Directory Server LDAP server is running.
a. Log on to a terminal session on the data server as root.
b. Run the ps -ef | grep ibmslapd command. The results will be similar to the following:

dsrdbm01 13797 1 0 Apr26 pts/1 00:00:09 /opt/ibm/ldap/V6.3/sbin/64/ibmslapd -I dsrdbm01 -t -n
root 32080 19149 0 23:17 pts/1 00:00:00 grep ibmslapd

This example shows that the Tivoli Directory Server daemon, ibmslapd, is running.
c. Run the ps -ef | grep ibmdiradm command. The results will be similar to the following:

root 4394 14038 0 14:17 pts/2 00:00:00 grep ibmdiradm
dsrdbm01 11055 1 0 Apr26 pts/1 00:00:00 /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t

This example shows that the Tivoli Directory Server daemon, ibmdiradm, is running.
6. If the Tivoli Directory Server, ibmslapd, is not running, do the following.

a. As a root Linux user, run /opt/ibm/ldap/V6.3/sbin/ibmslapd -I dsrdbm01 to start the Directory
Server
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7. If the Tivoli Directory Administration Server, ibmdiradm, is not running, do the following.
a. On a terminal session on the data server, run su - dsrdbm01.
b. Run /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t to start the application server.

8. If the Tivoli Directory Server, ibmslapd, is running, do the following.

Note: Do this step even if the Tivoli Directory Server was started in the previous step.
a. Log on to a terminal session on the data server as dsrdbm01.
b. Run idsldapsearch -h localhost -D "cn=root" -w "ADMIN_PASSWORD" -s sub uid=* where

ADMIN_PASSWORD is the LDAP Root Administrator account password. The existing LDAP user
objects will be displayed.

9. Verify that the Tivoli Directory Server Web Administration Tool is running. The Tivoli Directory
Server Web Administration Tool is used to stop and start the LDAP instance, add users or accounts,
and view log files.
a. Log on to a terminal session on the application server as ibmadmin.
b. Run the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/serverStatus.sh -all -username

waswebadmin -password WAS_ADMIN_PASSWORD command on the application server where
WAS_ADMIN_PASSWORD is the WebSphere Application Server administrator password. If the
tool is running, a message similar to the following will be returned.
ADMU0508I: The Application Server "tdsServer" is STARTED

If the following message is returned, the tdsServer needs to be started.
ADMU0509I: The Application Server "tdsServer" cannot be reached. It appears to be stopped.

c. Start the tdsServer by running the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/
startServer.sh tdsServer command. The server, tdsServer, will start and a message similar to
the following will be displayed.
ADMU3000I: Server tdsServer open for e-business; process id is 26654

10. Access the Tivoli Directory Server Web Administration Tool at: http://DATA_SERVER_HOST:9062/
IDSWebApp/IDSjsp/Login.jsp where DATA_SERVER_HOST is the host name of the data server.

11. Log on with the LDAP Root Administrator Account, cn=root, and the appropriate password. The
LDAP Server name should be DATABASE_DIRECTORY_SERVER_HOST:389 where
DATABASE_DIRECTORY_SERVER_HOST is the host name of the data server.

12. Click Server Administration > Start/stop/reset server. The LDAP server status will be displayed.
This page can also be used to start, stop, or reset the LDAP server.

What to do next

Resolve any issues or errors found and retry the test.

Directory (Tivoli Directory Server) [2] Test
The Directory (Tivoli Directory Server) [2] test determines if the Tivoli Directory Server is available by
sending an HTTP request to the server.

Resources

The Directory (Tivoli Directory Server) [2] test uses the following resource:
v Tivoli Directory Server (on the backup data server)

Problem determination
If the Directory (Tivoli Directory Server) [2] test fails, do the following to find and resolve the access
problem.
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Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
dbstdsservgrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 811 for action.
v To check the status of the standby server, specify 813 for action.
v To start the primary server, specify 101 for action.
v To start the standby server, specify 111 for action.
v To stop the primary server, specify 741 for action.
v To stop the standby server, specify 751 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere
Portal logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the data server review the following Tivoli Directory Server log: /datahome/dsrdbm01/
idsslapd-dsrdbm01/logs/audit.log

4. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the Tivoli Directory Server LDAP server is running.
a. Log on to a terminal session on data server 2 as root.
b. Run the ps -ef | grep ibmslapd command. The results will be similar to the following:

dsrdbm01 13797 1 0 Apr26 pts/1 00:00:09 /opt/ibm/ldap/V6.3/sbin/64/ibmslapd -I dsrdbm01 -t -n
root 32080 19149 0 23:17 pts/1 00:00:00 grep ibmslapd

This example shows that the Tivoli Directory Server daemon, ibmslapd, is running.
c. Run the ps -ef | grep ibmdiradm command. The results will be similar to the following:

root 4394 14038 0 14:17 pts/2 00:00:00 grep ibmdiradm
dsrdbm01 11055 1 0 Apr26 pts/1 00:00:00 /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t
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This example shows that the Tivoli Directory Server daemon, ibmdiradm, is running.
6. If the Tivoli Directory Server, ibmslapd, is not running, do the following.

a. As a root Linux user, run /opt/ibm/ldap/V6.3/sbin/ibmslapd -I dsrdbm01 to start the Directory
Server

7. If the Tivoli Directory Administration Server, ibmdiradm, is not running, do the following.
a. On a terminal session on data server 2, run su - dsrdbm01.
b. Run /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t to start the application server.

8. If the Tivoli Directory Server, ibmslapd, is running, do the following.

Note: Do this step even if the Tivoli Directory Server was started in the previous step.
a. Log on to a terminal session on the data server as dsrdbm01.
b. Run idsldapsearch -h localhost -D "cn=root" -w "ADMIN_PASSWORD" -s sub uid=* where

ADMIN_PASSWORD is the LDAP Root Administrator account password. The existing LDAP user
objects will be displayed.

9. Verify that the Tivoli Directory Server Web Administration Tool is running. The Tivoli Directory
Server Web Administration Tool is used to stop and start the LDAP instance, add users or accounts,
and view log files.
a. Log on to a terminal session on application server 2 as ibmadmin.
b. Run the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/serverStatus.sh -all -username

waswebadmin -password WAS_ADMIN_PASSWORD command on application server 2 where
WAS_ADMIN_PASSWORD is the WebSphere Application Server administrator password. If the
tool is running, a message similar to the following will be returned.
ADMU0508I: The Application Server "tdsServer" is STARTED

If the following message is returned, the tdsServer needs to be started.
ADMU0509I: The Application Server "tdsServer" cannot be reached. It appears to be stopped.

c. Start the tdsServer by running the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/
startServer.sh tdsServer command. The server, tdsServer, will start and a message similar to
the following will be displayed.
ADMU3000I: Server tdsServer open for e-business; process id is 26654

10. Access the Tivoli Directory Server Web Administration Tool at: http://DATA_SERVER_HOST:9062/
IDSWebApp/IDSjsp/Login.jsp where DATA_SERVER_HOST is the host name of the backup data
server.

11. Log on with the LDAP Root Administrator Account, cn=root, and the appropriate password. The
LDAP Server name should be DATABASE_DIRECTORY_SERVER_HOST:389 where
DATABASE_DIRECTORY_SERVER_HOST is the host name of the backup data server.

12. Click Server Administration > Start/stop/reset server. The LDAP server status will be displayed.
This page can also be used to start, stop, or reset the LDAP server.

What to do next

Resolve any issues or errors found and retry the test.

Directory (Tivoli Directory Server Proxy) [1] Test
The Directory (Tivoli Directory Server Proxy) [1] test determines if the Tivoli Directory Server is available
by sending an HTTP request to the server.

Resources

The Directory (Tivoli Directory Server Proxy) [1] test uses the following resource:
v Tivoli Directory Server (on the analytics server)
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Problem determination
If the Directory (Tivoli Directory Server Proxy) [1] test fails, do the following to find and resolve the
access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
apptdsproxygrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 815 for action.
v To check the status of the standby server, specify 817 for action.
v To start the primary server, specify 121 for action.
v To start the standby server, specify 131 for action.
v To stop the primary server, specify 731 for action.
v To stop the standby server, specify 721 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

4. Verify that the file system on the analytics server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100%
used. For this reason if the df -h command returns that the file system is 90% or more full, you
should consider that the file system has reached capacity.

5. Verify that the file system on the data server has not reached capacity. This can be determined by
running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the Tivoli Directory Server LDAP server is running.
a. Log on to a terminal session on the analytics server as root.
b. Run the ps -ef | grep ibmslapd command. The results will be similar to the following:

dsrdbm01 13797 1 0 Apr26 pts/1 00:00:09 /opt/ibm/ldap/V6.3/sbin/64/ibmslapd -I dsrdbm01 -t -n
root 32080 19149 0 23:17 pts/1 00:00:00 grep ibmslapd

This example shows that the Tivoli Directory Server daemon, ibmslapd, is running.
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c. Run the ps -ef | grep ibmdiradm command. The results will be similar to the following:
root 4394 14038 0 14:17 pts/2 00:00:00 grep ibmdiradm
dsrdbm01 11055 1 0 Apr26 pts/1 00:00:00 /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t

This example shows that the Tivoli Directory Server daemon, ibmdiradm, is running.
7. If the Tivoli Directory Server, ibmslapd, is not running, do the following.

a. As a root Linux user, run /opt/ibm/ldap/V6.3/sbin/ibmslapd -I dsrdbm01 to start the Directory
Server

8. If the Tivoli Directory Administration Server, ibmdiradm, is not running, do the following.
a. On a terminal session on the analytics server, run su - dsrdbm01.
b. Run /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t to start the application server.

9. If the Tivoli Directory Server, ibmslapd, is running, do the following.

Note: Do this step even if the Tivoli Directory Server was started in the previous step.
a. Log on to a terminal session on the data server as dsrdbm01.
b. Run idsldapsearch -h localhost -D "cn=root" -w "ADMIN_PASSWORD" -s sub uid=* where

ADMIN_PASSWORD is the LDAP Root Administrator account password. The existing LDAP user
objects will be displayed.

10. Verify that the Tivoli Directory Server Web Administration Tool is running. The Tivoli Directory
Server Web Administration Tool is used to stop and start the LDAP instance, add users or accounts,
and view log files.
a. Log on to a terminal session on the analytics server as ibmadmin.
b. Run the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/serverStatus.sh -all -username

waswebadmin -password WAS_ADMIN_PASSWORD command on the analytics server where
WAS_ADMIN_PASSWORD is the WebSphere Application Server administrator password. If the
tool is running, a message similar to the following will be returned.
ADMU0508I: The Application Server "tdsServer" is STARTED

If the following message is returned, the tdsServer needs to be started.
ADMU0509I: The Application Server "tdsServer" cannot be reached. It appears to be stopped.

c. Start the tdsServer by running the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/
startServer.sh tdsServer command. The server, tdsServer, will start and a message similar to
the following will be displayed.
ADMU3000I: Server tdsServer open for e-business; process id is 26654

11. Access the Tivoli Directory Server Web Administration Tool at: http://
APPLICATION_SERVER_HOST:9081/IDSWebApp where APPLICATION_SERVER_HOST is the host name of
application server 1.

12. Log on with the LDAP Root Administrator Account, cn=root, and the appropriate password. The
LDAP Server name should be DATABASE_DIRECTORY_SERVER_HOST:389 where
DATABASE_DIRECTORY_SERVER_HOST is the host name of the analytics server.

13. Click Server Administration > Start/stop/reset server. The LDAP server status will be displayed.
This page can also be used to start, stop, or reset the LDAP server.

What to do next

Resolve any issues or errors found and retry the test.

Directory (Tivoli Directory Server Proxy) [2] Test
The Directory (Tivoli Directory Server Proxy) [2] test determines if the Tivoli Directory Server is available
by sending an HTTP request to the server.
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Resources

The Directory (Tivoli Directory Server Proxy) [2] test uses the following resource:
v Tivoli Directory Server (on analytics server 2)

Problem determination
If the Directory (Tivoli Directory Server Proxy) [2] test fails, do the following to find and resolve the
access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
apptdsproxygrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. Use the platform control tool to check the status of the servers and to start and stop them as
needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 815 for action.
v To check the status of the standby server, specify 817 for action.
v To start the primary server, specify 121 for action.
v To start the standby server, specify 131 for action.
v To stop the primary server, specify 731 for action.
v To stop the standby server, specify 721 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere
Portal logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

4. Verify that the file system on the analytics server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100%
used. For this reason if the df -h command returns that the file system is 90% or more full, you
should consider that the file system has reached capacity.

5. Verify that the Tivoli Directory Server LDAP server is running.
a. Log on to a terminal session on analytics server 2 as root.
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b. Run the ps -ef | grep ibmslapd command. The results will be similar to the following:
dsrdbm01 13797 1 0 Apr26 pts/1 00:00:09 /opt/ibm/ldap/V6.3/sbin/64/ibmslapd -I dsrdbm01 -t -n
root 32080 19149 0 23:17 pts/1 00:00:00 grep ibmslapd

This example shows that the Tivoli Directory Server daemon, ibmslapd, is running.
c. Run the ps -ef | grep ibmdiradm command. The results will be similar to the following:

root 4394 14038 0 14:17 pts/2 00:00:00 grep ibmdiradm
dsrdbm01 11055 1 0 Apr26 pts/1 00:00:00 /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t

This example shows that the Tivoli Directory Server daemon, ibmdiradm, is running.
6. If the Tivoli Directory Server, ibmslapd, is not running, do the following.

a. As a root Linux user, run /opt/ibm/ldap/V6.3/sbin/ibmslapd -I dsrdbm01 to start the Directory
Server

7. If the Tivoli Directory Administration Server, ibmdiradm, is not running, do the following.
a. On a terminal session on analytics server 2, run su - dsrdbm01.
b. Run /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t to start the application server.

8. If the Tivoli Directory Server, ibmslapd, is running, do the following.

Note: Do this step even if the Tivoli Directory Server was started in the previous step.
a. Log on to a terminal session on the data server as dsrdbm01.
b. Run idsldapsearch -h localhost -D "cn=root" -w "ADMIN_PASSWORD" -s sub uid=* where

ADMIN_PASSWORD is the LDAP Root Administrator account password. The existing LDAP user
objects will be displayed.

9. Verify that the Tivoli Directory Server Web Administration Tool is running. The Tivoli Directory
Server Web Administration Tool is used to stop and start the LDAP instance, add users or accounts,
and view log files.
a. Log on to a terminal session on analytics server 2 as ibmadmin.
b. Run the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/serverStatus.sh -all -username

waswebadmin -password WAS_ADMIN_PASSWORD command on analytics server 2 where
WAS_ADMIN_PASSWORD is the WebSphere Application Server administrator password. If the
tool is running, a message similar to the following will be returned.
ADMU0508I: The Application Server "tdsServer" is STARTED

If the following message is returned, the tdsServer needs to be started.
ADMU0509I: The Application Server "tdsServer" cannot be reached. It appears to be stopped.

c. Start the tdsServer by running the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/
startServer.sh tdsServer command. The server, tdsServer, will start and a message similar to
the following will be displayed.
ADMU3000I: Server tdsServer open for e-business; process id is 26654

10. Access the Tivoli Directory Server Web Administration Tool at: http://DATA_SERVER_HOST:9062/
IDSWebApp/IDSjsp/Login.jsp where DATA_SERVER_HOST is the host name of the backup analytics
server.

11. Log on with the LDAP Root Administrator Account, cn=root, and the appropriate password. The
LDAP Server name should be DATABASE_DIRECTORY_SERVER_HOST:389 where
DATABASE_DIRECTORY_SERVER_HOST is the host name of the backup analytics server.

12. Click Server Administration > Start/stop/reset server. The LDAP server status will be displayed.
This page can also be used to start, stop, or reset the LDAP server.

What to do next

Resolve any issues or errors found and retry the test.

Messaging (Message Broker install check) Test
The Messaging (Message Broker install check) test determines if the message broker and queue manager
can be accessed.
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Resources

The Messaging (Message Broker install check) uses the following resource:
v WebSphere Portal Server (on the application server).

Problem determination
If the Messaging (Message Broker install check) test fails, do the following to find and resolve the
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use msgmb and
specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

Alternately, the following commands can be run from the analytics server to check the status of IBM
Message Broker:
su - mqm

mqsilist

If IBM Message Broker is running, BIP1284I: Broker 'IOC_BROKER' on queue manager 'IOC.MB.QM' is
running. and will be returned. If IBM Message Broker is not running, BIP1285I: Broker 'IOC_BROKER'
on queue manager 'IOC.MB.QM' is stopped. will be returned.
The following commands can also be used to stop IBM Message Broker and the queue manager:
su - mqmconn

source /opt/IBM/mqsi/8.0.0.1/bin/mqsiprofile

mqsistop IOC_BROKER -q

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the component and to start
and stop it as needed. For component use wmb and specify your topology password for
topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password
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3. Check the logs for errors. The logs are located on the analytics server in the /var/log/messages
directory. Look for messages with the prefix 'BIP'. Also look for queue names and timestamps when
the test was run.

4. Check that there is network connectivity between the application server) and the analytics server. This
can be done by sending ping commands with both the short and fully-qualified host name of the
analytics server from the application server and vice versa. The results of the ping commands will
show if the host name is being correctly resolved by the DNS or /etc/hosts file.

5. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

6. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

7. 1.6.0.2 If IBM Message Broker is not running, start it using the platform control tool or by the
following steps.
a. Run the following commands.

su - mqmconn

source /opt/IBM/mqsi/8.0.0.1/bin/mqsiprofile

The following should be returned.
MQSI 8.0.0.3
/opt/IBM/mqsi/8.0.0.1

b. Run the following command:
mqsistart IOC_BROKER

The following should be returned.
BIP8096I: Successful command initiation, check the system log to
ensure that the component started without problem and that it
continues to run without problem.

What to do next

Resolve any issues or errors found and retry the test.

Messaging (Message Broker install check) [1] Test
The Messaging (Message Broker install check) [1] test determines if the message broker and queue
manager can be accessed on the primary server in a high availability environment.

Resources

The Messaging (Message Broker install check) [1] test uses the following resource:
v WebSphere Portal Server (on the application server).

Problem determination
If the Messaging (Message Broker install check) [1] test fails, do the following to find and resolve the
access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use msgmbgrp
and specify your topology password for topology_password.
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a. To check the status of the component run the following commands:
su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 851 for action.
v To check the status of the standby server, specify 853 for action.
v To start the primary server, specify 241 for action.
v To start the standby server, specify 251 for action.
v To stop the primary server, specify 631 for action.
v To stop the standby server, specify 621 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Check that there is network connectivity between the application server) and the analytics server. This
can be done by sending ping commands with both the short and fully-qualified host name of the
analytics server from the application server and vice versa. The results of the ping commands will
show if the host name is being correctly resolved by the DNS or /etc/hosts file.

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Check the logs for errors. The logs are located on the analytics server in the /var/log/messages
directory. Look for messages with the prefix 'BIP'. Also look for queue names and timestamps when
the test was run.

What to do next

Resolve any issues or errors found and retry the test.

Messaging (Message Broker install check) [2] Test
The Messaging (Message Broker install check) [2] test determines if the message broker and queue
manager can be accessed on the backup server in a high availability environment.
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Resources

The Messaging (Message Broker install check) [2] test uses the following resourc:
v WebSphere Portal Server (on the application server).

Problem determination
If the Messaging (Message Broker install check) [2] test fails, do the following to find and resolve the
access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use msgmbgrp
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 851 for action.
v To check the status of the standby server, specify 853 for action.
v To start the primary server, specify 241 for action.
v To start the standby server, specify 251 for action.
v To stop the primary server, specify 631 for action.
v To stop the standby server, specify 621 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Check that there is network connectivity between the application server) and the analytics server. This
can be done by sending ping commands with both the short and fully-qualified host name of the
analytics server from the application server and vice versa. The results of the ping commands will
show if the host name is being correctly resolved by the DNS or /etc/hosts file.

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

314 IBM Intelligent Operations Center: IBM Intelligent Operations Center Product Documentation



5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Check the logs for errors. The logs are located on the analytics server in the /var/log/messages
directory. Look for messages with the prefix 'BIP'. Also look for queue names and timestamps when
the test was run.

What to do next

Resolve any issues or errors found and retry the test.

Mobile (IBM Worklight console) Test
The Mobile (IBM Worklight console) test determines if the IBM Worklight server is running and the
administration console is available.

Resources

The Mobile (IBM Worklight console) test uses the following resource:
v WebSphere Application Server named WorklightServer1

Problem determination
If the Mobile (IBM Worklight console) test fails, do the following to find and resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appwrklt
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the component and to start
and stop it as needed. For component use wrklt and specify your topology password for
topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password
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3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the aplication server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/logs/WorklightServer1/

SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/logs/WorklightServer1/
SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WorklightServer1 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/WorklightProfile1/bin/startNode.sh . Skip this step if message ADMU0508I:
The Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent,
a message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "WorklightServer1" cannot be reached. It
appears to be stopped. is displayed, start the WorklightServer1 server using the following
command: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/startServer.sh
WorklightServer1. Skip this step if message ADMU0508I: The Application Server
"WorklightServer1" is STARTED. is displayed. If you had to start WorklightServer1, a message
similar to the following will be displayed: ADMU3000I: Server WorklightServer1 open for
e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WorklightServer1

Stop servers in this order:
a. WorklightServer1
b. nodeagent
The WorklightServer1 server is stopped by running the following command in a command window
on the application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/
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stopServer.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER
is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere
Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WorklightServer1 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WorklightServer1 server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/
bin/startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WorklightServer1

Stop servers in this order:
a. WorklightServer1
b. nodeagent
To stop the WorklightServer1 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

Mobile (IBM Worklight console) [1] Test
The Mobile (IBM Worklight console) [1] test determines if the primary IBM Worklight server in a high
availability environment is running and the administration console is available.

Resources

The Mobile (IBM Worklight console) [1] test uses the following resource:
v WebSphere Application Server named WorklightServer1

Problem determination
If the Mobile (IBM Worklight console) [1] test fails, do the following to find and resolve the access
problem.
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Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
appwrkltgrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the aplication server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/logs/WorklightServer1/

SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/logs/WorklightServer1/
SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WorklightServer1 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
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WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/WorklightProfile1/bin/startNode.sh . Skip this step if message ADMU0508I:
The Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent,
a message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "WorklightServer1" cannot be reached. It
appears to be stopped. is displayed, start the WorklightServer1 server using the following
command: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/startServer.sh
WorklightServer1. Skip this step if message ADMU0508I: The Application Server
"WorklightServer1" is STARTED. is displayed. If you had to start WorklightServer1, a message
similar to the following will be displayed: ADMU3000I: Server WorklightServer1 open for
e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WorklightServer1

Stop servers in this order:
a. WorklightServer1
b. nodeagent
The WorklightServer1 server is stopped by running the following command in a command window
on the application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/
stopServer.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER
is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere
Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WorklightServer1 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WorklightServer1 server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/
bin/startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.
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Start servers in this order:
a. nodeagent
b. WorklightServer1

Stop servers in this order:
a. WorklightServer1
b. nodeagent
To stop the WorklightServer1 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile1/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

Mobile (IBM Worklight console) [2] Test
The Mobile (IBM Worklight console) [2] test determines if the backup IBM Worklight server in a high
availability environment is running and the administration console is available.

Resources

The Mobile (IBM Worklight console) [2] test uses the following resource:
v WebSphere Application Server named WorklightServer2

Problem determination
If the Mobile (IBM Worklight console) [2] test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use
appwrkltgrp and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
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su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On application server 2 review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/logs/WorklightServer2/

SystemOut.log

v /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/logs/WorklightServer2/
SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WorklightServer2 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server 2 system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServer/profiles/WorklightProfile2/bin/startNode.sh . Skip this step if message ADMU0508I:
The Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent,
a message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "WorklightServer2" cannot be reached. It
appears to be stopped. is displayed, start the WorklightServer2 server using the following
command: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/bin/startServer.sh
WorklightServer2. Skip this step if message ADMU0508I: The Application Server
"WorklightServer2" is STARTED. is displayed. If you had to start WorklightServer2, a message
similar to the following will be displayed: ADMU3000I: Server WorklightServer2 open for
e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WorklightServer2

Stop servers in this order:
a. WorklightServer2
b. nodeagent
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The WorklightServer2 server is stopped by running the following command in a command window
on the application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/bin/
stopServer.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER
is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere
Application Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WorklightServer2 server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WorklightServer2 server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/
bin/startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WorklightServer2

Stop servers in this order:
a. WorklightServer2
b. nodeagent
To stop the WorklightServer2 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServer/profiles/WorklightProfile2/bin/stopNode.sh
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Password Management (Password synchronization agent) Test
The Password Management (Password synchronization agent) tests access to the password management
synchronization agent.

Resources

The Password Management (Password synchronization agent) test uses the following resources:
v Tivoli Directory Server (on the data server)
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v Tivoli Directory Integrator (on the data server)

Problem determination
If the Password Management (Password synchronization agent) test fails, do the following to find and
resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use dbstdi and
specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the component and to start
and stop it as needed. For component use tdi and specify your topology password for
topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. On the data server review all the Tivoli Directory Server logs in the following directory:
v /opt/IBM/TDI/V7.1/timsol/logs

c. On the data server review all the Tivoli Directory Server logs:
v /opt/IBM/TDI/V7.1/pwd_plugins/tds/plugin.log

v /opt/IBM/TDI/V7.1/pwd_plugins/tds/proxy.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the Tivoli Directory Integrator server is started.
a. Log on to the data server as the ibmadmin user.
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b. Start or restart the server.
v To start the server, run the /opt/IBM/TDI/V7.1/timsol/ITIMAd start command.
v To restart the server, run the /opt/IBM/TDI/V7.1/timsol/ITIMAd restart command.

6. Verify that the Tivoli Directory Server LDAP server is running.
a. Log on to a terminal session on the data server as the root user.
b. Run the ps -ef | grep ibmslapd command. The results will be similar to the following showing

that the Tivoli Directory Server daemon, ibmslapd, is running.
dsrdbm01 13797 1 0 Apr26 pts/1 00:00:09 /opt/ibm/ldap/V6.3/sbin/64/ibmslapd -I dsrdbm01 -t -n
root 32080 19149 0 23:17 pts/1 00:00:00 grep ibmslapd

c. Run the ps -ef | grep ibmdiradm command. The results will be similar to the following showing
that the Tivoli Directory Server daemon, ibmdiradm, is running.
root 4394 14038 0 14:17 pts/2 00:00:00 grep ibmdiradm
dsrdbm01 11055 1 0 Apr26 pts/1 00:00:00 /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t

7. If the Tivoli Directory Server ibmslapd is not running, run the opt/ibm/ldap/V6.3/sbin/ibmslapd -I
dsrdbm01 as a root users to start the directory server.

8. If the Tivoli Directory Server administration server ibmdiradm is not running, run the
opt/ibm/ldap/V6.3/sbin/ibmdiradm -I dsrdbm01 command as a root user to start the administration
server.

What to do next

Resolve any issues or errors found and retry the test.

Password Management (Password synchronization agent) [1] Test
The Password Management (Password synchronization agent) [1] test access to the password
management synchronization agent on data server 1 in a high availability environment.

Resources

The Password Management (Password synchronization agent) [1] test uses the following resources:
v Tivoli Directory Server (on the data server)
v Tivoli Directory Integrator (on the data server)

Problem determination
If the Password Management (Password synchronization agent) [1] test fails, do the following to find and
resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use dbstdigrp
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password
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2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To start the primary server, specify 101-AUX for action.
v To start the standby server, specify 111-AUX for action.
v To stop the primary server, specify 751-AUX for action.
v To stop the standby server, specify 741-AUX for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On data server 1 review all the Tivoli Directory Server logs in the following directory:
v /opt/IBM/TDI/V7.1/timsol/logs

d. On data server 1 review all the Tivoli Directory Server logs:
v /opt/IBM/TDI/V7.1/pwd_plugins/tds/plugin.log

v /opt/IBM/TDI/V7.1/pwd_plugins/tds/proxy.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the Tivoli Directory Integrator server is started.
a. Log on to data server 1 as the ibmadmin user.
b. Start or restart the server.

v To start the server, run the /opt/IBM/TDI/V7.1/timsol/ITIMAd start command.
v To restart the server, run the /opt/IBM/TDI/V7.1/timsol/ITIMAd restart command.

6. Verify that the Tivoli Directory Server LDAP server is running.
a. Log on to a terminal session on data server 1 as the root user.
b. Run the ps -ef | grep ibmslapd command. The results will be similar to the following showing

that the Tivoli Directory Server daemon, ibmslapd, is running.
dsrdbm01 13797 1 0 Apr26 pts/1 00:00:09 /opt/ibm/ldap/V6.3/sbin/64/ibmslapd -I dsrdbm01 -t -n
root 32080 19149 0 23:17 pts/1 00:00:00 grep ibmslapd

c. Run the ps -ef | grep ibmdiradm command. The results will be similar to the following showing
that the Tivoli Directory Server daemon, ibmdiradm, is running.
root 4394 14038 0 14:17 pts/2 00:00:00 grep ibmdiradm
dsrdbm01 11055 1 0 Apr26 pts/1 00:00:00 /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t

7. If the Tivoli Directory Server ibmslapd is not running, run the opt/ibm/ldap/V6.3/sbin/ibmslapd -I
dsrdbm01 as a root users to start the directory server.

8. If the Tivoli Directory Server administration server ibmdiradm is not running, run the
opt/ibm/ldap/V6.3/sbin/ibmdiradm -I dsrdbm01 command as a root user to start the administration
server.
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What to do next

Resolve any issues or errors found and retry the test.

Password Management (Password synchronization agent) [2] Test
The Password Management (Password synchronization agent) [2] tests access to the password
management synchronization agent on data server 2 in a high availability environment.

Resources

The Password Management (Password synchronization agent) [2] test uses the following resource:
v Tivoli Directory Server (on the data server)
v Tivoli Directory Integrator (on the data server)

Problem determination
If the Password Management (Password synchronization agent) [2] test fails, do the following to find and
resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use dbstdigrp
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To start the primary server, specify 101-AUX for action.
v To start the standby server, specify 111-AUX for action.
v To stop the primary server, specify 751-AUX for action.
v To stop the standby server, specify 741-AUX for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log
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c. On data server 2 review all the Tivoli Directory Server logs in the following directory:
v /opt/IBM/TDI/V7.1/timsol/logs

d. On data server 2 review all the Tivoli Directory Server logs:
v /opt/IBM/TDI/V7.1/pwd_plugins/tds/plugin.log

v /opt/IBM/TDI/V7.1/pwd_plugins/tds/proxy.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the Tivoli Directory Integrator server is started.
a. Log on to data server 2 as the ibmadmin user.
b. Start or restart the server.

v To start the server, run the /opt/IBM/TDI/V7.1/timsol/ITIMAd start command.
v To restart the server, run the /opt/IBM/TDI/V7.1/timsol/ITIMAd restart command.

6. Verify that the Tivoli Directory Server LDAP server is running.
a. Log on to a terminal session on data server 2 as the root user.
b. Run the ps -ef | grep ibmslapd command. The results will be similar to the following showing

that the Tivoli Directory Server daemon, ibmslapd, is running.
dsrdbm01 13797 1 0 Apr26 pts/1 00:00:09 /opt/ibm/ldap/V6.3/sbin/64/ibmslapd -I dsrdbm01 -t -n
root 32080 19149 0 23:17 pts/1 00:00:00 grep ibmslapd

c. Run the ps -ef | grep ibmdiradm command. The results will be similar to the following showing
that the Tivoli Directory Server daemon, ibmdiradm, is running.
root 4394 14038 0 14:17 pts/2 00:00:00 grep ibmdiradm
dsrdbm01 11055 1 0 Apr26 pts/1 00:00:00 /opt/ibm/ldap/V6.3/sbin/64/ibmdiradm -I dsrdbm01 -t

7. If the Tivoli Directory Server ibmslapd is not running, run the opt/ibm/ldap/V6.3/sbin/ibmslapd -I
dsrdbm01 as a root users to start the directory server.

8. If the Tivoli Directory Server administration server ibmdiradm is not running, run the
opt/ibm/ldap/V6.3/sbin/ibmdiradm -I dsrdbm01 command as a root user to start the administration
server.

What to do next

Resolve any issues or errors found and retry the test.

Password Management (Tivoli Directory Integrator) Test
The Password Management (Tivoli Directory Integrator) tests access to Tivoli Directory Integrator.

Resources

The Password Management (Tivoli Directory Integrator) test uses the following resource:
v Tivoli Directory Server (on the data server)
v Tivoli Directory Integrator (on the data server)

Problem determination
If the Password Management (Tivoli Directory Integrator) test fails, do the following to find and resolve
the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use dbstdi (in a
standard environment) or dbstdigrp (in a high availability environment) and specify your topology
password for topology_password.
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a. To check the status of the component run the following commands:
su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use tdi and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To start the primary server, specify 101-AUX for action.
v To start the standby server, specify 111-AUX for action.
v To stop the primary server, specify 751-AUX for action.
v To stop the standby server, specify 741-AUX for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the data server review all the Tivoli Directory Server logs in the following directory:
v /opt/IBM/TDI/V7.1/timsol/logs

d. On the data server review all the Tivoli Directory Server logs:
v /opt/IBM/TDI/V7.1/pwd_plugins/tds/plugin.log

v /opt/IBM/TDI/V7.1/pwd_plugins/tds/proxy.log
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5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the Tivoli Directory Integrator server is started.
a. Log on to the data server as the ibmadmin user.
b. Start or restart the server.

v To start the server, run the /opt/IBM/TDI/V7.1/timsol/ITIMAd start command.
v To restart the server, run the /opt/IBM/TDI/V7.1/timsol/ITIMAd restart command.

What to do next

Resolve any issues or errors found and retry the test.

Portal (WebSphere Portal console via Web Server) Test
The Portal (WebSphere Portal console via Web Server) test tests web server access to the WebSphere
Portal console.

Resources

The Portal (WebSphere Portal console via Web Server) test uses the following resource:
v WebSphere Application Server on the application server.

Problem determination
If the Portal (WebSphere Portal console via Web Server) test fails, do the following to find and resolve the
access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appwpe and
specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the component and to start
and stop it as needed. For component use wpe and specify your topology password for
topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password
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c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WebSphere_Portal server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/wp_profile/bin/serverStatus.sh -all

-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server
administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
wp_profile/bin/startNode.sh . Skip this step if message ADMU0508I: The Application Server
"nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a message similar to the
following will be displayed: ADMU3000I: Server nodeagent open for e-business; process id is
26654.

a. If message ADMU0509I: The Application Server "WebSphere_Portal" cannot be reached. It
appears to be stopped. is displayed, start the WebSphere_Portal server using the following
command: /opt/IBM/WebSphere/wp_profile/bin/startServer.sh WebSphere_Portal. Skip this step
if message ADMU0508I: The Application Server "WebSphere_Portal" is STARTED. is displayed. If
you had to start WebSphere_Portal, a message similar to the following will be displayed:
ADMU3000I: Server WebSphere_Portal open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal

Stop servers in this order:
a. WebSphere_Portal
b. nodeagent
The WebSphere_Portal server is stopped by running the following command in a command window
on the application server: /opt/IBM/WebSphere/wp_profile/bin/stopServer.sh -all -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server administrator
password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
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-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WebSphere_Portal server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WebSphere_Portal server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/wp_profile/bin/startNode.sh command in
a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal

Stop servers in this order:
a. WebSphere_Portal
b. nodeagent
To stop the WebSphere_Portal server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Portal (WebSphere Portal console via Web Server) [1] Test
The Portal (WebSphere Portal console via Web Server) [1] test tests web server access to the WebSphere
Portal console on the primary server in a high availability environment.

Resources

The Portal (WebSphere Portal console via Web Server) [1] test uses the following resource:
v WebSphere Application Server on the application server.

Problem determination
If the Portal (WebSphere Portal console via Web Server) [1] test fails, do the following to find and resolve
the access problem.
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Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appwpegrp
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To start the primary web servers, specify 701 for action.
v To start the standby web servers, specify 711 for action.
v To stop the primary web servers, specify 511 for action.
v To stop the standby web servers, specify 501 for action.
v To check the status of the primary Portal servers, specify 831 for action.
v To check the status of the standby Portal servers, specify 833 for action.
v To start the primary Portal servers, specify 201 for action.
v To start the standby Portal servers, specify 211 for action.
v To stop the primary Portal servers, specify 661 for action.
v To stop the standby Portal servers, specify 671 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WebSphere_Portal server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/wp_profile/bin/serverStatus.sh -all

-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server
administrator password.
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c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
wp_profile/bin/startNode.sh . Skip this step if message ADMU0508I: The Application Server
"nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a message similar to the
following will be displayed: ADMU3000I: Server nodeagent open for e-business; process id is
26654.

a. If message ADMU0509I: The Application Server "WebSphere_Portal" cannot be reached. It
appears to be stopped. is displayed, start the WebSphere_Portal server using the following
command: /opt/IBM/WebSphere/wp_profile/bin/startServer.sh WebSphere_Portal. Skip this step
if message ADMU0508I: The Application Server "WebSphere_Portal" is STARTED. is displayed. If
you had to start WebSphere_Portal, a message similar to the following will be displayed:
ADMU3000I: Server WebSphere_Portal open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal

Stop servers in this order:
a. WebSphere_Portal
b. nodeagent
The WebSphere_Portal server is stopped by running the following command in a command window
on the application server: /opt/IBM/WebSphere/wp_profile/bin/stopServer.sh -all -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server administrator
password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WebSphere_Portal server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WebSphere_Portal server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/wp_profile/bin/startNode.sh command in
a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal
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Stop servers in this order:
a. WebSphere_Portal
b. nodeagent
To stop the WebSphere_Portal server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Portal (WebSphere Portal console via Web Server) [2] Test
The Portal (WebSphere Portal console via Web Server) [2] test tests web server access to the WebSphere
Portal console on the backup server in a high availability environment.

Resources

The Portal (WebSphere Portal console via Web Server) [2] test uses the following resource:
v WebSphere Application Server on application server 2.

Problem determination
If the Portal (WebSphere Portal console via Web Server) [2] test fails, do the following to find and resolve
the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appwpegrp
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To start the primary server, specify 701 for action.
v To start the standby server, specify 711 for action.
v To stop the primary server, specify 511 for action.
v To stop the standby server, specify 501 for action.
v To check the status of the primary Portal servers, specify 831 for action.
v To check the status of the standby Portal servers, specify 833 for action.
v To start the primary Portal servers, specify 201 for action.
v To start the standby Portal servers, specify 211 for action.
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v To stop the primary Portal servers, specify 661 for action.
v To stop the standby Portal servers, specify 671 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On application server 2 review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_Portal_Node2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_Portal_Node2/SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WebSphere_Portal_Portal_Node2 server is started. Verification can be done using the
WebSphere Application Server Administrative Console or by manual steps. The following are the
manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/wp_profile/bin/serverStatus.sh -all

-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server
administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
wp_profile/bin/startNode.sh . Skip this step if message ADMU0508I: The Application Server
"nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a message similar to the
following will be displayed: ADMU3000I: Server nodeagent open for e-business; process id is
26654.

a. If message ADMU0509I: The Application Server "WebSphere_Portal_Portal_Node2" cannot be
reached. It appears to be stopped. is displayed, start the WebSphere_Portal_Portal_Node2
server using the following command: /opt/IBM/WebSphere/wp_profile/bin/startServer.sh
WebSphere_Portal_Portal_Node2. Skip this step if message ADMU0508I: The Application Server
"WebSphere_Portal_Portal_Node2" is STARTED. is displayed. If you had to start
WebSphere_Portal_Portal_Node2, a message similar to the following will be displayed: ADMU3000I:
Server WebSphere_Portal_Portal_Node2 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal_Portal_Node2

Stop servers in this order:
a. WebSphere_Portal_Portal_Node2
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b. nodeagent
The WebSphere_Portal_Portal_Node2 server is stopped by running the following command in a
command window on the application server: /opt/IBM/WebSphere/wp_profile/bin/stopServer.sh
-all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application
Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WebSphere_Portal_Portal_Node2 server is started. Verification can be done using the
WebSphere Application Server Administrative Console or by manual steps. The following are the
steps using the WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WebSphere_Portal_Portal_Node2 server by clicking Servers > Server Types
> WebSphere application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/wp_profile/bin/startNode.sh command in
a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal_Portal_Node2

Stop servers in this order:
a. WebSphere_Portal_Portal_Node2
b. nodeagent
To stop the WebSphere_Portal_Portal_Node2 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Portal (WebSphere Portal console) Test
The Portal (WebSphere Portal console) test tests access to the WebSphere Portal console.

Resources

The Portal (WebSphere Portal console) test uses the following resource:
v WebSphere Application Server on the application server.

336 IBM Intelligent Operations Center: IBM Intelligent Operations Center Product Documentation



Problem determination
If the Portal (WebSphere Portal console) test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appwpe and
specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the component and to start
and stop it as needed. For component use wpe and specify your topology password for
topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WebSphere_Portal server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
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b. In a command window, run: /opt/IBM/WebSphere/wp_profile/bin/serverStatus.sh -all
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server
administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
wp_profile/bin/startNode.sh . Skip this step if message ADMU0508I: The Application Server
"nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a message similar to the
following will be displayed: ADMU3000I: Server nodeagent open for e-business; process id is
26654.

a. If message ADMU0509I: The Application Server "WebSphere_Portal" cannot be reached. It
appears to be stopped. is displayed, start the WebSphere_Portal server using the following
command: /opt/IBM/WebSphere/wp_profile/bin/startServer.sh WebSphere_Portal. Skip this step
if message ADMU0508I: The Application Server "WebSphere_Portal" is STARTED. is displayed. If
you had to start WebSphere_Portal, a message similar to the following will be displayed:
ADMU3000I: Server WebSphere_Portal open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal

Stop servers in this order:
a. WebSphere_Portal
b. nodeagent
The WebSphere_Portal server is stopped by running the following command in a command window
on the application server: /opt/IBM/WebSphere/wp_profile/bin/stopServer.sh -all -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server administrator
password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WebSphere_Portal server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WebSphere_Portal server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/wp_profile/bin/startNode.sh command in
a command window.

Important: Servers must be started and stopped in a specific order.
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Start servers in this order:
a. nodeagent
b. WebSphere_Portal

Stop servers in this order:
a. WebSphere_Portal
b. nodeagent
To stop the WebSphere_Portal server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Portal (WebSphere Portal console) [1] Test
The Portal (WebSphere Portal console) [1] test tests access to the WebSphere Portal console on the
primary server in a high availability environment.

Resources

The Portal (WebSphere Portal console) [1] test uses the following resource:
v WebSphere Application Server on the application server.

Problem determination
If the Portal (WebSphere Portal console) [1] test fails, do the following to find and resolve the access
problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appwpegrp
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
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v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WebSphere_Portal server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/wp_profile/bin/serverStatus.sh -all

-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server
administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
wp_profile/bin/startNode.sh . Skip this step if message ADMU0508I: The Application Server
"nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a message similar to the
following will be displayed: ADMU3000I: Server nodeagent open for e-business; process id is
26654.

a. If message ADMU0509I: The Application Server "WebSphere_Portal" cannot be reached. It
appears to be stopped. is displayed, start the WebSphere_Portal server using the following
command: /opt/IBM/WebSphere/wp_profile/bin/startServer.sh WebSphere_Portal. Skip this step
if message ADMU0508I: The Application Server "WebSphere_Portal" is STARTED. is displayed. If
you had to start WebSphere_Portal, a message similar to the following will be displayed:
ADMU3000I: Server WebSphere_Portal open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal

Stop servers in this order:
a. WebSphere_Portal
b. nodeagent
The WebSphere_Portal server is stopped by running the following command in a command window
on the application server: /opt/IBM/WebSphere/wp_profile/bin/stopServer.sh -all -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server administrator
password.
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The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WebSphere_Portal server is started. Verification can be done using the WebSphere
Application Server Administrative Console or by manual steps. The following are the steps using the
WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WebSphere_Portal server by clicking Servers > Server Types > WebSphere
application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/wp_profile/bin/startNode.sh command in
a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal

Stop servers in this order:
a. WebSphere_Portal
b. nodeagent
To stop the WebSphere_Portal server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Portal (WebSphere Portal console) [2] Test
The Portal (WebSphere Portal console) [2] test tests access to the WebSphere Portal console on the backup
server in a high availability environment.

Resources

The Portal (WebSphere Portal console) [2] test uses the following resource:
v WebSphere Application Server on application server 2.

Problem determination
If the Portal (WebSphere Portal console) [2] test fails, do the following to find and resolve the access
problem.
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Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appwpegrp
and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 Use the platform control tool to check the status of the servers and to start and
stop them as needed. Run the following commands with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

3. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On application server 2 review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_Portal_Node2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_Portal_Node2/SystemErr.log

4. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

5. Verify that the WebSphere_Portal_Portal_Node2 server is started. Verification can be done using the
WebSphere Application Server Administrative Console or by manual steps. The following are the
manual steps:
a. On the application server system log on as ibmadmin.
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b. In a command window, run: /opt/IBM/WebSphere/wp_profile/bin/serverStatus.sh -all
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server
administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
wp_profile/bin/startNode.sh . Skip this step if message ADMU0508I: The Application Server
"nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a message similar to the
following will be displayed: ADMU3000I: Server nodeagent open for e-business; process id is
26654.

a. If message ADMU0509I: The Application Server "WebSphere_Portal_Portal_Node2" cannot be
reached. It appears to be stopped. is displayed, start the WebSphere_Portal_Portal_Node2
server using the following command: /opt/IBM/WebSphere/wp_profile/bin/startServer.sh
WebSphere_Portal_Portal_Node2. Skip this step if message ADMU0508I: The Application Server
"WebSphere_Portal_Portal_Node2" is STARTED. is displayed. If you had to start
WebSphere_Portal_Portal_Node2, a message similar to the following will be displayed: ADMU3000I:
Server WebSphere_Portal_Portal_Node2 open for e-business; process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal_Portal_Node2

Stop servers in this order:
a. WebSphere_Portal_Portal_Node2
b. nodeagent
The WebSphere_Portal_Portal_Node2 server is stopped by running the following command in a
command window on the application server: /opt/IBM/WebSphere/wp_profile/bin/stopServer.sh
-all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the
WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application
Server administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

6. Verify that the WebSphere_Portal_Portal_Node2 server is started. Verification can be done using the
WebSphere Application Server Administrative Console or by manual steps. The following are the
steps using the WebSphere Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the WebSphere_Portal_Portal_Node2 server by clicking Servers > Server Types
> WebSphere application servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/wp_profile/bin/startNode.sh command in
a command window.
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Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. WebSphere_Portal_Portal_Node2

Stop servers in this order:
a. WebSphere_Portal_Portal_Node2
b. nodeagent
To stop the WebSphere_Portal_Portal_Node2 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/wp_profile/bin/stopNode.sh -username WAS_ADMIN_USER
-password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator ID (normally
admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Security (IBM Security Identity Manager administration console) Test
The Security (IBM Security Identity Manager administration console) test determines if the IBM Security
Identity Manager server is running and the administration console is available.

Resources

The Security (IBM Security Identity Manager administration console) test uses the following resource:
v WebSphere Application Server named isim1.

Problem determination
If the Security (IBM Security Identity Manager administration console) test fails, do the following to find
and resolve the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appisim (in
a standard environment) or appisimgrp (in a high availability environment) and specify your topology
password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use sim and specify your topology password for topology_password.
a. To check the status of the component run the following commands:
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su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServerv7/profiles/isim1/logs/isim1/SystemOut.log

v /opt/IBM/WebSphere/AppServerv7/profiles/isim1/logs/isim1/SystemErr.log

5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the isim1 server is started. Verification can be done using the WebSphere Application
Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServerv7/profiles/isim1/bin/startNode.sh . Skip this step if message ADMU0508I: The
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Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "isim1" cannot be reached. It appears to be
stopped. is displayed, start the isim1 server using the following command: /opt/IBM/WebSphere/
AppServerv7/profiles/isim1/bin/startServer.sh isim1. Skip this step if message ADMU0508I: The
Application Server "isim1" is STARTED. is displayed. If you had to start isim1, a message
similar to the following will be displayed: ADMU3000I: Server isim1 open for e-business;
process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. isim1

Stop servers in this order:
a. isim1
b. nodeagent
The isim1 server is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/stopServer.sh -all
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server
administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

7. Verify that the isim1 server is started. Verification can be done using the WebSphere Application
Server Administrative Console or by manual steps. The following are the steps using the WebSphere
Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the isim1 server by clicking Servers > Server Types > WebSphere application
servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. isim1

Stop servers in this order:
a. isim1
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b. nodeagent
To stop the isim1 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Security (IBM Security Identity Manager console) Test
The Security (IBM Security Identity Manager console) test determines if the IBM Security Identity
Manager server is running and the console is available.

Resources

The Security (IBM Security Identity Manager console) test uses the following resource:
v WebSphere Application Server named isim1.

Problem determination
If the Security (IBM Security Identity Manager console) test fails, do the following to find and resolve the
access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appisim (in
a standard environment) or appisimgrp (in a high availability environment) and specify your topology
password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use sim and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
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su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServerv7/profiles/isim1/logs/isim1/SystemOut.log

v /opt/IBM/WebSphere/AppServerv7/profiles/isim1/logs/isim1/SystemErr.log

5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the isim1 server is started. Verification can be done using the WebSphere Application
Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServerv7/profiles/isim1/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "isim1" cannot be reached. It appears to be
stopped. is displayed, start the isim1 server using the following command: /opt/IBM/WebSphere/
AppServerv7/profiles/isim1/bin/startServer.sh isim1. Skip this step if message ADMU0508I: The
Application Server "isim1" is STARTED. is displayed. If you had to start isim1, a message
similar to the following will be displayed: ADMU3000I: Server isim1 open for e-business;
process id is 26654.
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Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. isim1

Stop servers in this order:
a. isim1
b. nodeagent
The isim1 server is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/stopServer.sh -all
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server
administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

7. Verify that the isim1 server is started. Verification can be done using the WebSphere Application
Server Administrative Console or by manual steps. The following are the steps using the WebSphere
Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the isim1 server by clicking Servers > Server Types > WebSphere application
servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. isim1

Stop servers in this order:
a. isim1
b. nodeagent
To stop the isim1 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.
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What to do next

Resolve any issues or errors found and retry the test.

Security (IBM Security Identity Manager self console) Test
The Security (IBM Security Identity Manager self console) test determines if the IBM Security Identity
Manager server is running and the self console is available.

Resources

The Security (IBM Security Identity Manager self console) test uses the following resource:
v WebSphere Application Server named isim1.

Problem determination
If the Security (IBM Security Identity Manager self console) test fails, do the following to find and resolve
the access problem.

Procedure
1. 1.6.0.2 Use the platform control tool to check the status of the components and to start and stop

them as needed. Run the following command with the desired options. For component use appisim (in
a standard environment) or appisimgrp (in a high availability environment) and specify your topology
password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

2. 1.6 1.6.0.1 If running in a standard environment, use the platform control tool to check the
status of the components and to start and stop them as needed. Run the following command with the
desired options. For component use sim and specify your topology password for topology_password.
a. To check the status of the component run the following commands:

su - ibmadmin

IOCControl -a status -c component -p topology_password

b. To start the component run the following commands:
su - ibmadmin

IOCControl -a start -c component -p topology_password

c. To stop the component run the following commands:
su - ibmadmin

IOCControl -a stop -c component -p topology_password

3. 1.6 1.6.0.1 If running in a high availability environment, use the platform control tool to
check the status of the components and to start and stop them as needed. Run the following
command with the desired options.
v To check the status of the primary server, specify 831 for action.
v To check the status of the standby server, specify 833 for action.
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v To start the primary server, specify 201 for action.
v To start the standby server, specify 211 for action.
v To stop the primary server, specify 671 for action.
v To stop the standby server, specify 661 for action.

Specify your topology password for topology_password.
su - ibmadmin

IOCControl -a action -p topology_password

4. Review the log files for runtime exceptions.
a. On the application server review the following WebSphere Portal logs:

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal/SystemErr.log

b. In a high availability environment, on application server 2 review the following WebSphere Portal
logs:
v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemOut.log

v /opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2/SystemErr.log

c. On the application server review the following WebSphere Application Server logs:
v /opt/IBM/WebSphere/AppServerv7/profiles/isim1/logs/isim1/SystemOut.log

v /opt/IBM/WebSphere/AppServerv7/profiles/isim1/logs/isim1/SystemErr.log

5. Verify that the file system on the application server has not reached capacity. This can be determined
by running the df -h command. The file system can be considered full even if it less than 100% used.
For this reason if the df -h command returns that the file system is 90% or more full, you should
consider that the file system has reached capacity.

6. Verify that the isim1 server is started. Verification can be done using the WebSphere Application
Server Administrative Console or by manual steps. The following are the manual steps:
a. On the application server system log on as ibmadmin.
b. In a command window, run: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/

serverStatus.sh -all -username WAS_ADMIN_USER -password WAS_ADMIN_PWD where
WAS_ADMIN_USER is the WebSphere administrator ID (normally admin) and WAS_ADMIN_PWD
is the WebSphere Application Server administrator password.

c. If message ADMU0509I: The Application Server "nodeagent" cannot be reached. It appears to
be stopped. is displayed, start the nodeagent using the following command: /opt/IBM/WebSphere/
AppServerv7/profiles/isim1/bin/startNode.sh . Skip this step if message ADMU0508I: The
Application Server "nodeagent" is STARTED. is displayed. If you had to start the nodeagent, a
message similar to the following will be displayed: ADMU3000I: Server nodeagent open for
e-business; process id is 26654.

a. If message ADMU0509I: The Application Server "isim1" cannot be reached. It appears to be
stopped. is displayed, start the isim1 server using the following command: /opt/IBM/WebSphere/
AppServerv7/profiles/isim1/bin/startServer.sh isim1. Skip this step if message ADMU0508I: The
Application Server "isim1" is STARTED. is displayed. If you had to start isim1, a message
similar to the following will be displayed: ADMU3000I: Server isim1 open for e-business;
process id is 26654.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. isim1

Stop servers in this order:
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a. isim1
b. nodeagent
The isim1 server is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/stopServer.sh -all
-username WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere
administrator ID (normally admin) and WAS_ADMIN_PWD is the WebSphere Application Server
administrator password.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

7. Verify that the isim1 server is started. Verification can be done using the WebSphere Application
Server Administrative Console or by manual steps. The following are the steps using the WebSphere
Application Server Administrative Console:
a. Log on to the WebSphere Application Server Administrative Console at http://

APPLICATION_SERVER_HOST:9061/ibm/console using the WebSphere Application Server
Administrative ID admin and password. APPLICATION_SERVER_HOST is the host name for the
application server.

b. View the status of the isim1 server by clicking Servers > Server Types > WebSphere application
servers.

The icon means the server is started. If required, select the server and click Restart to restart
the server.

The icon means the server is stopped. Select the server and click Start to start the server.
The icon means the server status is unavailable. The Node Agent might not be running. To
start the Node Agent run the /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/
startNode.sh command in a command window.

Important: Servers must be started and stopped in a specific order.

Start servers in this order:
a. nodeagent
b. isim1

Stop servers in this order:
a. isim1
b. nodeagent
To stop the isim1 server, select the server and click Stop.
The nodeagent is stopped by running the following command in a command window on the
application server: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/stopNode.sh -username
WAS_ADMIN_USER -password WAS_ADMIN_PWD where WAS_ADMIN_USER is the WebSphere administrator
ID (normally admin) and WAS_ADMIN_PWD is the WebSphere administrator password.

What to do next

Resolve any issues or errors found and retry the test.

Logging and analyzing usage data
IBM Intelligent Operations Center logs usage data that can them be processed using a usage analysis
application.
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These logs provide information on session activities such as login, logout, time out, and login failures.
The log entries comply with the NCSA combined industry standard.

By analyzing the log entries you can monitor the usage of IBM Intelligent Operations Center.

Usage analysis logs
IBM Intelligent Operations Center usage records are written to dedicated log files. WebSphere Portal is
configured to rotate the logs every six hours. The rotation interval can be customized.

The usage analysis logs can be found on the application server in a standard environment and on
application server 1 and application server 2 in a high availability environment. The logs are in the
following directory:
wp_root/logs/wp_server_name/SiteAnalyzerLogs

where wp_root is the WebSphere Portal home directory and wp_server_name is the WebSphere Portal server
name.

Log files are named in the following format: sa_CREATE_TIME_CLOSE_TIME.log where CREATE_TIME
is the timestamp when the log was created and CLOSE_TIME is the timestamp when the log was closed.
The CREATE_TIME and CLOSE_TIME timestamps are in YYYY.MM.DD-hh.mm.ss format; where YYYY is
year, MM is month, DD is day, hh is hour, mm is minutes and ss is seconds.

Logging must be enabled to capture usage analysis data. Logging is enabled by default.
Related information:

Enabling site analysis logging in WebSphere Portal

Running the usage analysis tool
The usage analysis tool processes the usage analytics logs and saves the data for realtime and historical
reporting purposes.

About this task

The tool stores the following analysis information in the USAGEAN database in the SCHUSAG.USAGEDATA table.
The processed logs are stored in the /opt/IBM/WebSphere/usageAnalysis/Archive_date_time/logs
directory where date_time is the timestamp when the tool was run.
v src_ip - the source IP address where the WebSphere Portal URL (req_url) request originated.
v req_user - the user who requested the WebSphere Portal URL (req_url).
v req_datetime - the date and time when the WebSphere Portal URL (req_url) was requested.
v req_url - the WebSphere Portal URL that was requested by the user (req_user).
v cookies - the cookies that were passed with the WebSphere Portal URL (req_url) request.
v sa_filename - the name of the processed usage analytics log file.
v p_server - the WebSphere Portal server where the usage analytics log file (sa_filename) originated.

This information is useful for installations with more than one WebSphere Portal node.
v created - the date and time when the entry was created in the database.

The Usage Analysis tool can be configured by changing the following properties in the
/opt/IBM/WebSphere/usageAnalysis/runAnalysisTool.sh file.
v IS_DEBUG can be set to yes or no indicating whether debug statements are displayed when the Usage

Analysis tool is run. The default is no indicating that debug statements are not displayed.
v IS_FORCE can be set to yes or no indicating if a previously processed usage analysis file should be

reprocessed. When set to yes existing entries in the database are deleted and the log is reprocessed.
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To run the usage analytics tool, do the following.

Procedure
1. In a standard environment, sign on to the application server server as the ibmadmin user. If running a

high availability environment, sign on to application server 1 and application server 2 in turn and run
the following steps.

2. Change to the was_root/usageAnalysis directory where was_root is the WebSphere Application Server
home directory. For example, /opt/IBM/WebSphere/usageAnalysis.

3. Run ./runAnalysisTool.sh -h database_server_hostname -p db2inst1_password

Where database_server_hostname is the host name of the data server or data server 1 and
db2inst1_password is the password defined by the DEFAULT.PWD.DB2 in the topology properties file.

Results

The analysis results are written to the USAGEAN database.

354 IBM Intelligent Operations Center: IBM Intelligent Operations Center Product Documentation



Chapter 8. Maintaining the solution

To keep IBM Intelligent Operations Center running smoothly, schedule regular maintenance. Implement a
log file maintenance plan, and tune the system to optimize performance.

Support knowledge base query

The following link starts a customized query of the live Support knowledge base for all versions of IBM
Intelligent Operations Center: View all maintenance tips for IBM Intelligent Operations Center.

Backing up and recovering data
Create a plan for periodically backing up and recovering data for your deployment of IBM Intelligent
Operations Center. Backing up and recovering data files and databases is an essential operation for any
business system, particularly for data and applications that are running in production environments.

Before you begin

Before you back up IBM Intelligent Operations Center, make the following decisions:
v Decide which utility to use. You can use Tivoli Storage Manager or another backup and recovery

utility. Refer to either the Tivoli Storage Manager product documentation, or the documentation for the
utility that you choose to use.

v Determine whether you want to do either an offline backup, or an online backup. If you do an offline
backup, the IBM Intelligent Operations Center servers are stopped before you run the backup
procedure. If you do an online backup, the IBM Intelligent Operations Center servers remain
operational while you run the backup procedure. If you choose to do an online backup, ensure that the
techniques and tools that you use for the file system and database backup support the capturing of
online backups. For example, if an open file or a modified database is encountered during an online
backup, ensure that it does not cause the backup to fail.

Related information:

Tivoli Storage Manager product documentation

Backing up data
Schedule your chosen backup and recovery utility to periodically run an automated backup procedure on
the IBM Intelligent Operations Center file system and databases. The frequency of the backups depends
on how frequently changes are made to the data, and on how critical the data is.

Backing up the file system
Periodically run an automated backup procedure on the IBM Intelligent Operations Center directories
that are on each server. For complete protection, it is important that you back up all the directories.

About this task

Back up all the files and subdirectories that are in each specified directory.

Note: Do the file system backup at the same time as the database backup.

Procedure

Schedule your chosen backup utility to periodically back up the specified directories on each server, as
indicated in the following table:
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Table 52. IBM Intelligent Operations Center directories to back up on each server

Server Directories

Application server /opt/IBM/WebSphere/
/opt/IBM/WebSphere_STProxy
/opt/IBM/TDI/V7.1/pwd_plugins/pam
/opt/IBM/isim/data
/opt/IBM/isim/extensions/6.0
/opt/IBM/isim/config
/opt/IBM/PMT
/opt/IBM/ISP
/opt/IBM/ioc
/local/notesdata
/home/ibmadmin
/home/ibmuser

Web server /opt/IBM/HTTPServer/conf
/opt/IBM/TDI/V7.1/pwd_plugins/pam
/opt/IBM/WebSphere/Plugins
/opt/IBM/ISP
/home/ibmadmin
/home/ibmuser

Analytics server /opt/IBM/WebSphere/
/opt/IBM/ISP
/opt/IBM/mqsi
/opt/IBM/cognos
/opt/IBM/ILOG
/opt/ibm/ioc
/opt/mqm
/var/mqm
/var/mqsi
/home/ibmadmin
/home/ibmuser
/datahome/proxy/idsslapd-proxy
/opt/IBM/TDI/V7.1/pwd_plugins/pam

Data server /datahome/dsrdbm01/idsslapd-dsrdbm01
/opt/IBM/ISP
/home/ibmadmin
/home/ibmuser
/opt/IBM/TDI/V7.1/pwd_plugins/pam
/opt/IBM/TDI/V7.1/pwd_plugins/tds
/opt/IBM/TDI/V7.1/timsol

Backing up the databases
Periodically run an automated backup procedure on the IBM Intelligent Operations Center databases,
including the directory server or user registry. For complete protection, ensure that you back up all the
databases.

About this task

For more information about the tools and processes that are available to back up the databases, see the
link at the end of the topic to the DB2 product documentation.

When you back up Tivoli Directory Server, you can either back up database information only, or you can
back up complete Tivoli Directory Server instance information. For more information about methods for
backing up and restoring Tivoli Directory Server instance information, see the administration guide in the
Tivoli Directory Server product documentation.

Note: Do the database backups at the same time as the file system backup.
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Procedure

Schedule your chosen backup tool to periodically back up the specified databases for each component in
IBM Intelligent Operations Center, as indicated in the following table:

Table 53. Databases to back up in each component

Component Database instance Database

WebSphere Portal Server db2inst1 CUSTDB

db2inst1 FDBKDB

db2inst1 LKMDDB

db2inst1 JCRDB

db2inst1 RELDB

db2inst1 COMMDB

IBM Business Monitor db2inst1 MONITOR

db2inst1 WBMDB

IBM Cognos Business Intelligence db2inst1 CXLOGDB

db2inst1 CXCONTDB

Usage analysis tool db2inst1 USAGEAN

Tivoli Identity Manager db2inst1 ITIMDB

IBM Worklight db2inst1 WLREPORT

db2inst1 APPCNTR

db2inst1 WRKLGHT

IBM Intelligent Operations Center
application

db2inst2 IOCDB, IOCME 1.6.0.2 XMDB

System verification check tool db2inst2 CATSCHDB

LDAP dsrdbm01 LDAPDB

Related information:

IBM Tivoli Directory Server product documentation

IBM DB2 Database for Linux, UNIX, and Windows product documentation

Recovering data from a backup
If data that is either in your IBM Intelligent Operations Center files or in your databases is corrupted or
lost, recover data from your backed up files and databases.

Before you begin

Before you recover data from a backup, prepare your target environment. You must install an instance of
IBM Intelligent Operations Center that you can use as the restoration target for your recovered files and
databases. For information about installing an instance of IBM Intelligent Operations Center, see the link
at the end of the topic to the installing and configuring section.

About this task

Note the following points that relate to recovering databases:
v If you restore databases, you must also restore the data files that were archived when the backup

image was taken.
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v When you restore databases, ensure that databases are restored for a period that ends at the time when
you completed the file system backup. Otherwise, the configuration files and the data files might not
be synchronized with the information that is in the databases.

v If you are recovering data in a high availability environment, you must configure the DB2 high
availability disaster recovery again after you restore the databases. For more information about
configuring DB2 high availability disaster recovery, see the DB2 product documentation.

Procedure
1. To stop all the IBM Intelligent Operations Center servers, run the IOCControl script that is in the

platform control tool:
a. Locate the IOCControl script in the /opt/IBM/ISP/mgmt/scripts directory that is on the Analytics

server.
b. Log on as user ibmadmin.
c. Run the IOCControl script with the appropriate options:

v In a standard environment, enter the following command:
./IOCControl –a stop –c all –p password

v In a high availability environment, enter the following command:
./IOCControl –a 091 –p password

2. To start the database servers, run the IOCControl script with the appropriate options:
v In a standard environment, enter the following commands:

./IOCControl –a start –c db24mid –p password

./IOCControl –a start –c db24app –p password

v In a high availability environment, enter the following commands:
./IOCControl –a 141 –p password
./IOCControl –a 151 –p password

3. Delete the files and directories that are listed in the table in the Backing up the file system topic. See the
link at the end of the topic.

4. Restore the backed up files and directories that are listed in the table in the Backing up the file system
topic. See the link at the end of the topic.

5. Restore the backed up databases.
6. To start all the IBM Intelligent Operations Center servers, run the IOCControl script:

a. Locate the IOCControl script in the /opt/IBM/ISP/mgmt/scripts directory that is on the Analytics
server.

b. Log on as user ibmadmin.
c. Run the IOCControl script with the appropriate options:

v In a standard environment, enter the following command:
./IOCControl –a start –c all –p password

v In a high availability environment, enter the following command:
./IOCControl –a 001 –p password

Related concepts:
Chapter 2, “Installing the solution,” on page 21
IBM Intelligent Operations Center provides installation options to install the IBM Intelligent Operations
Center environment and application. After installing IBM Intelligent Operations Center, some additional
configuration is required.
Related information:

IBM DB2 Database for Linux, UNIX, and Windows product documentation
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Log file maintenance
IBM Intelligent Operations Center stores log files in several different locations. To prevent system
outages, periodically back up the database, archive log files, and remove the original log files.

IBM Intelligent Operations Center uses DB2 databases to store the information that is displayed in the
user interface, in reports, in KPIs, and through APIs. As the data arrives in IBM Intelligent Operations
Center, DB2 records information in logs that ensure transaction consistency and the ability to recover
from system failures. As the volume of data increases in IBM Intelligent Operations Center, the number of
log files increases significantly.

Monitor the amount of disk space that is required for log files. The amount of disk space that is required
depends on the size of your scheduled data loads. If you do not manage log files, eventually the log files
can fill up a file system partition and space for active logs becomes unavailable. The negative
consequences are that many basic features in IBM Intelligent Operations Center do not work correctly.
The approach that you take to managing log files depends on your approach to backing up and
recovering data in IBM Intelligent Operations Center.

You can use a combination of the following methods. The method that you choose depends on the
characteristics of each data source. Variations in the methods include turning off logging for the initial
loads, or implementing circular logs that overwrite old records. These methods prevent out of space
errors but prohibit recoverability to the last transaction. For more information, go to the link at the end of
the topic for the IBM DB2 10.1 Data Recovery and High Availability Guide and Reference and see the section
about storage considerations for recovery.

Logging turned off

If data can be easily reproduced from an external system of record, turn off logging completely. Turning
off logging saves space and also improves load performance significantly. You can recover from a failure
by reloading the data from the external system of record. Because you must load all the history that is
required, this method can take a long time if the data volumes are large.

Logging turned off and backups implemented daily

If you cannot easily reproduce the data for more than a single day and it is acceptable to reload some
data, turn off logging and implement daily backups. You can recover from a failure by restoring the
backup from the previous day and by reloading the activity for today. Backups can be either standard
DB2 backups, or virtual machine snapshots. This method saves space and improves performance, and is
the most suitable method for standard IBM Intelligent Operations Center data sources that are populated
by using either an extract, transform, and load (ETL) process, or by using exports.

Logging turned on

If you require data recovery up to the last transaction and you do not want to reload data from the
external system of record, then you must determine the amount of space that is necessary to handle
active logs and backups. It is critical that you implement either regular full backups, or regular
incremental backups, or a combination of regular full and incremental backups so that you can reclaim
space for active log files. The following steps outline a sample backup process, where each backup step is
done after an appropriate period:
1. Load initial data.
2. Implement a full database backup, backup_1.
3. Load scheduled data that creates corresponding logs activelog_1 and activelog_2.
4. Implement an incremental database backup, backup_2.
5. Either archive, or delete, activelog_1, and activelog_2.
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6. Load scheduled data that creates corresponding logs activelog_3 and activelog_4.
7. Implement an incremental database backup, backup_3.
8. Either archive, or delete, activelog_3, and activelog_4.
9. Load scheduled data that creates corresponding logs activelog_5 and activelog_6.

10. Implement a full database backup, backup_4.

As an example, if you need to recover data after a failure that occurs just after step 6 above, you can
recover the data as shown in the following steps:
1. Restore the full database backup, backup_1.
2. Restore the incremental database backup, backup_2.
3. Apply the active logs activelog_3 and activelog_4.
Related information:

IBM DB2 10.1 Data Recovery and High Availability Guide and Reference

Tuning performance
The following sections describe how to tune the application server and WebSphere Application Server.
Related information:

WebSphere Application Server product documentation

Tuning the application server
About this task

Use the following guidelines, which are based on the results of performance tests, to set the Java virtual
machine heap size.

Procedure
1. Set the minimum and maximum heap sizes to the same values.
2. Set the heap size to a value that is compatible with the physical memory and that is above 2 GB.

What to do next

For more information, see the related link.

Tuning WebSphere Application Server
For information about tuning the performance of WebSphere Application Server Version 8, see the related
link.

Configuring DB2 performance monitoring data collection
To enable performance monitoring of the DB2 instance and databases, configure DB2 to collect data that
is related to each DB2 monitor switch. Turn on the monitor switches to enable the database instances to
be monitored by using the DB2 monitor routines.

About this task

Use the following procedure to set the values of the relevant DB2 performance monitor switches to ON.
Do the procedure on both db2inst1 and db2inst2.
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Procedure
1. On the data server, log on as the DB2 instance owner for db2inst1.
2. Enter the following commands.

Note: Enter the db2 update command on one line as a single command.
db2 attach to db2inst1

db2 update dbm cfg using DFT_MON_BUFPOOL ON DFT_MON_LOCK ON DFT_MON_SORT ON
DFT_MON_STMT ON DFT_MON_TABLE ON DFT_MON_TIMESTAMP ON DFT_MON_UOW ON
HEALTH_MON OFF

db2stop

db2start

3. Repeat the previous steps but replace db2inst1 with db2inst2.

What to do next

To check the DB2 performance monitor switch settings, complete the following steps on both db2inst1
and db2inst2:
1. On the data server, log on as the DB2 instance owner for db2inst1.
2. Enter the following command:

db2 get dbm cfg |grep _MON

3. Repeat the previous steps but replace db2inst1 with db2inst2.

Modifying the topology password
The topology password is used during the installation process to encrypt and access the file defining the
solution topology. The password is created during the installation process when a keystore is created. If
required, the password can be changed by deleting the keystore and specifying a new topology
password.

About this task

On the installation server, go to the directory where the IBM Intelligent Operations Center installation
package was copied. In these steps, this directory is referred to as install_home.

Procedure
1. Log on as root or switch to the root account by running the su - command.
2. Change to the install_home/ioc16 directory.
3. Delete the install_home/ioc16/resource/ioc.keystore file.
4. Run the ./iop.std.install.sh -p topology_password 3 command for a standard environment or the

./iop.ha.install.sh -p topology_password 3 command for a high availability environment where
topology_password is the password to be created for the topology.

5. Make a note of the password for future use.

Important: The topology password is needed when running the password management tool and
platform control tool.

Updating the LTPA token for single sign-on
IBM Intelligent Operations Center uses a Lightweight Third-Party Authentication (LTPA) token to enable
single sign-on across many services. The token and keys generated during installation do not expire. It is
a good security practice to periodically regenerate the LTPA token and update the services using it.
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Before you begin

The IBM Intelligent Operations Center product must be installed and all services started before updating
the LTPA token.

This procedure requires that all services are stopped and started, so the update should not be done while
the system is in production. Any users logged into the system will experience a service disruption and
can lose data.

Procedure

Generate a new LTPA token for the application server
1. On the application server open a web browser and go to http://application_host:9061/ibm/

console where application_host is the host name of the application server.
2. Log on as the admin user with the password specified in the topology properties file

WAS.ADMIN.ACCOUNT.PWD parameter.
3. Click Security > Global Security > LTPA.
4. Enter a password twice for the new LTPA token. The password is used to encrypt the LTPA token.

This password will be used when importing the LTPA token. Record the password as the
WAS.LTPA.PWD parameter in the topology properties file.

5. Enter the path and filename where the LTPA token will be saved, for example, /tmp/newapp.ltpa. If
you specify a different path or file name, substitute your path and filename for /tmp/newapp.ltpa in
the rest of these steps.

6. Click Export Keys. The new LTPA token is saved as /tmp/newapp.ltpa.
7. Click Messages > Save. Updates will be saved. Ignore any warnings about the single sign-on

domain not being defined.
8. On the application server, log on as the root user and open a terminal window.
9. Run the cp /tmp/newapp.ltpa /opt/IBM/ISP/stproxy.ltpa command. This replaces the file that was

created when IBM Intelligent Operations Center was installed.
Update single sign-on for the collaboration service.
10. Follow the steps in “Configuring single sign-on for collaboration services” on page 69 to update

single sign-on for the collaboration service.
Stop and restart all services.
11. Using the platform control tool stop all services.
12. Using the platform control tool start all services. LTPA tokens will be propagated between

WebSphere Application Server and the Lotus Domino server.

Setting the session timeout
The session timeout determines the time a user can remain idle before the session is terminated and the
user must log in again. The session time out includes administrators logged in through the portal service.

About this task

When IBM Intelligent Operations Center is installed, no session time out is defined. Users will stay
logged in until they log out even if the session is idle.

If your organization has security policies requiring that sessions log out after a period of inactivity, use
the following steps to define a session timeout for your IBM Intelligent Operations Center system.

Procedure

Configure server timeouts.

362 IBM Intelligent Operations Center: IBM Intelligent Operations Center Product Documentation



1. Using a web browser go to http://application_server:9061/ibm/console where application_server is
the host name of the application server in a standard environment and application server 1 in a high
availability environment.

2. Log on as the admin user with the password defined for PORTAL.ADMIN.ACCOUNT.PWD in the topology
properties file.

3. Click Servers > Server Type > WebSphere Application Servers > WebSphere Portal.
4. Click Container Settings > Session management > Set Timeout.
5. Enter the desired timeout value in minutes.
6. Click OK.
7. Click Save.
8. Click Servers > Server Type > WebSphere Application Servers > STProxyServer1.
9. Click Container Settings > Session management > Set Timeout.

10. Enter the desired timeout value in minutes.
11. Click OK.
12. Click Save.
13. Click Servers > Server Type > WebSphere Application Servers > CongnosX_GW1.
14. Click Container Settings > Session management > Set Timeout.
15. Enter the desired timeout value in minutes.
16. Click OK.
17. Click Save.
18. Click Servers > Server Type > WebSphere Application Servers > CongnosX_Disp1.
19. Click Container Settings > Session management > Set Timeout.
20. Enter the desired timeout value in minutes.
21. Click OK.
22. Click Save.
If running in a high availability environment, configure the following additional servers.
23. Click Servers > Server Type > WebSphere Application Servers > CongnosX_Disp2.
24. Click Container Settings > Session management > Set Timeout.
25. Enter the desired timeout value in minutes.
26. Click OK.
27. Click Save.
28. Click Servers > Server Type > WebSphere Application Servers > CongnosX_GW2.
29. Click Container Settings > Session management > Set Timeout.
30. Enter the desired timeout value in minutes.
31. Click OK.
32. Click Save.
33. Click Servers > Server Type > WebSphere Application Servers > WebSphere_Portal_PortalNode2.
34. Click Container Settings > Session management > Set Timeout.
35. Enter the desired timeout value in minutes.
36. Click OK.
37. Click Save.
Set the Cognos inactivity timeout.
38. Log on to the analytics server in the standard environment and both analytics server 1 and analytics

server 2 in the high availability environment as the root user.
39. Run /opt/IBM/cognos/c10_64/bin64/cogconfig.sh

40. Click Security > Authentication.
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41. Specify the desired timeout value in seconds for Inactivity timeout in seconds.
42. Click File > Save.
43. Repeat for the second analytics server in the high availability environment.
Restart the server.
44. Stop and restart the application and analytic components using the platform control tool.
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Chapter 9. Viewing, filtering, and analyzing data

Use the IBM Intelligent Operations Center status views and operations views to view your data either on
maps, or in a list. You can set filter criteria to determine what data is displayed. Analyze your data either
in reports, by viewing KPIs, or by analyzing data hotspots. In the My Activities window, you can manage
activities that have been assigned to you through standard operating procedures.

IBM Intelligent Operations Center is a web-based solution that uses portal technology. You can access the
solution with any of the supported web browsers.
Related information:

Supported browsers for the IBM Intelligent Operations Center

Sample user views
IBM Intelligent Operations Center provides sample operations and status views for supervisor, operator,
and executive users. Use the views to access the information that you need and respond to events as
required. There are also administration views.

The menus that are listed in the following table are displayed near the top of every view:

Table 54. Menus that are displayed in every view

Menu Description

Notifications The Notifications window displays a dynamic list of
notifications and their details.

My Activities The My Activities window displays a dynamic list of
activities that are associated with active instances of
standard operating procedures.

Contacts The Contacts window can display a list of your
contacts that are organized by category. You can
organize contacts in categories that are based on the
people you want to communicate with; for example,
you can have a category for general work contacts, and
another category for project work contacts. You can
send instant messages within the solution, and modify
your online status, contacts, or groups.

More Actions More Actions is a context-sensitive menu. The options
that are displayed relate to the panel that is in focus.

Help The Help menu is denoted by a question mark icon. It
is a context-sensitive menu that contains links to local
product documentation. The links are relevant to the
panels and menu options that are currently displayed
in the view. The menu also contains a link to the online
complete product documentation, which is labeled
Online Full Help.

The following topics outline the panels that are displayed in each of the views.
Related tasks:
“Creating or customizing a page” on page 173
If you are an administrator, you can create new pages to be included in IBM Intelligent Operations
Center, and specify what content to display on those pages. You can customize the appearance and layout
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of the content that is included on each page.

Operations with maps
Use the operations views to maintain awareness and obtain an overview of data updates that are
associated with location. Each operations view is an interactive web page that consists of independent
elements that cooperate with each other to provide comprehensive information and interaction for the
user.

The data that is available in the view depends on the access permission that is assigned to the user. A
group of users in an organization is assigned a set of permissions. Members of the group can see only the
data that is appropriate to their job role.

Select the required view from the Citywide menu on the top menu bar. The views that are available to a
user depend on the access permission that is assigned to the user. Each group of users can see only those
pages that are appropriate to the job role that is associated with that group. The operations views that are
provided are outlined in the following table.

Table 55. Operations views

Views Description

Supervisor: Operations Use the Supervisor: Operations view to obtain an
overview of current data. The Supervisor: Operations
view is intended for supervisors and managers who are
monitoring current data and anticipating future issues.

Operator: Operations Use the Operator: Operations view to maintain
awareness of current data items and their location. The
Operator: Operations view is intended for operators,
managers, or others who are monitoring and responding
to data.

Executive: Operations Use the Executive: Operations to obtain a consolidated
view of current data. The Executive: Operations enables
users with cross-organization responsibility to manage
and respond to changes in relation to data and location.

The operations views contain the following panels:

Filter panel
In the appropriate operations view, use the filter panel to define what data is displayed in the
content panel.

Content panel
In the content panel of the operations view, you can view data on a geospatial map, on a location
map, or in list format.

Supporting content panel
In the supporting content panel, you can view reports of events as graphs, tables, or pie charts.

Status with KPIs
Use the status views to obtain a consolidated view of key performance indicators (KPIs) that highlight
key data. Users can monitor, manage, and respond to status changes in relation to the key areas of
organizational performance.

The KPIs that are available in the view depend on the access permission that is assigned to the user. A
group of users in an organization is assigned a set of permissions. Members of the group can see only
those KPIs that are appropriate to their job.

366 IBM Intelligent Operations Center: IBM Intelligent Operations Center Product Documentation



Select the required view from the Citywide menu on the top menu bar. The view that is available to a
user depends on the access permission that is assigned to the user. Each group of users can see only
those pages that are appropriate to the job role that is associated with that group. The status views that
are provided are outlined in the following table.

Table 56. Status views

Views Description

Supervisor: Status Use the Supervisor: Status view to see the status of
selected KPIs for the organization that you are
supervising. The Supervisor: Status view is intended for
supervisors who are monitoring KPIs that are associated
with day-to-day operations.

Executive: Status Use the Executive: Status view to see all KPIs for a single
organization or across multiple organizations that you
are managing. See recent changes in the KPI status so
that you can plan and direct operations as necessary. The
Executive: Status view is intended to provide an
executive-level summary of the status of KPIs across the
organizations that you are managing.

The status views contain the following elements:

Navigation tree
In the status views, use the navigation panel to define the data that is displayed in the content
panel.

Content panel
In the content panel of the status view, you can view the highest level KPIs, or drill down to
view underlying KPIs as required.

Area status with KPIs
1.6.0.1 1.6.0.2

Use the area status views to obtain a view of key performance indicators (KPIs) that highlights key data
for specific named areas. Users can monitor, manage, and respond to status changes in relation to
organizational performance in specific areas of the map.

The KPIs that are available in the view depend on the access permission that is assigned to you and on
the named areas that you select. A group of users in an organization is assigned a set of permissions.
Members of the group can see only those KPIs that are appropriate to their job.

Select the required view from the Citywide menu on the top menu bar. The view that is available to a
user depends on the access permission that is assigned to the user. Each group of users can see only
those pages that are appropriate to the job role that is associated with that group. The sample area status
views that are provided are outlined in the following table.

Table 57. Area status views

Views Description

Supervisor: Area Status Use the Supervisor: Area Status view to see the status of
selected KPIs for the organization in the areas that you
are supervising. The Supervisor: Area Status view is
intended for supervisors who are monitoring KPIs that
are associated with day-to-day operations in specific
areas.
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Table 57. Area status views (continued)

Views Description

Executive: Area Status Use the Executive: Area Status view to see the KPIs for
the organizations and areas that you are managing. See
recent changes in the KPI status so that you can plan and
direct operations as necessary. The Executive: Area Status
view is intended to provide an executive-level summary
of the status of KPIs across the organizations and in the
areas that you are managing.

The area status views contain the following elements:

Map and list panel
In the area status views, use the map and list panel to define the data that is displayed in the
content panel. You can use the Map or List tab to select the named areas you want to focus on.
The selected named areas define the data that is displayed in the content panel.

Content panel
In the content panel of the status view, you can view the highest level KPIs, or drill down to
view underlying KPIs as required.

Map

Select one or more data sources from the list in the Select named area data sources field at the top of the
map and list panel. All the named areas for all the data sources are shown on the map. Highlight a
named area shape on the map to have the relevant KPIs displayed on the content panel.

List

Select one or more data sources from the list in the Select named area data sources field at the top of the
map and list panel. All the named areas for all the data sources that are selected are shown on the list. In
the View data source field, you can select a specific data source to see only the named areas that are
associated with that data source displayed on the list. Click a named area row on the table to have the
relevant KPIs displayed on the content panel.

For more general information about the map and list tabs, see the link at the end of the topic. For more
detailed information about viewing the KPIs, see the link at the end of the topic.

For more information about configuring KPIs for named areas, see the links at the end of
the topic.
Related concepts:
“Viewing data on the maps and list” on page 369
In the content panel of the operations view, you can view data on a geospatial map, on a location map,
or in list format.
“Monitoring status through KPIs” on page 384
Use the status view to see the status of key performance indicators (KPIs) in summary or in detail
format.
“Configuring KPIs” on page 120
In the Solution Administration view, you can configure Key Performance Indicators (KPIs) and their
hierarchical display in the user interface. The KPIs are displayed on the status views in IBM Intelligent
Operations Center.
“Configuring a data source” on page 99
Use the Data Sources tool to configure a data source that supplies data to IBM Intelligent Operations
Center.
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Administration and configuration views
Use the administration views to manage and configure IBM Intelligent Operations Center.

Solution Administration
In the Solution Administration view, you can view product version details, access administration
consoles, run system verification checks, and administer system properties. You can also configure the
components.

You can configure the following components:
v Data sources
v Filter panel
v Geospatial map
v Key performance indicators
v Location maps
v Standard operating procedures
v 1.6.0.1 1.6.0.2 Hotspots
v 1.6.0.2 User interface components

To access the Solution Administration view, from the Administration menu at the top of the view, click
Solution Administration.

Portal Administration
Use the Portal Administration view to manage, maintain, and operate the content of the IBM Intelligent
Operations Center interface, and to assign who can access the different features of the interface.

To access the Portal Administration view, from the Administration menu at the top of the view, select
Portal Administration.
Related concepts:
Chapter 3, “Securing the solution,” on page 89
Security is important within the IBM Intelligent Operations Center because the solution is central to
essential operations. To ensure security, it is important that you are aware of the default settings and that
you manage users of the solution to give all users the correct level of access.
“Customizing the user interface” on page 173
You can customize elements of the IBM Intelligent Operations Center user interface to suit your
operation.

Viewing data on the maps and list
In the content panel of the operations view, you can view data on a geospatial map, on a location map,
or in list format.

Note: On a geospatial map the world view icon works as described in the "Controlling the map" topic.
On a location map, when you click the world view icon, the default view of the location map is
displayed.
Related concepts:
“What's new for the user” on page 8
In IBM Intelligent Operations Center 1.6, you can use the new filter panel to filter the data that is
displayed on a map, or in reports.

Controlling the map
You can move the cursor around the map by using your mouse or keyboard.
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Controls at the top of the map

The following controls are available at the top of the map:
v Pan arrows (up, down, left, right)
v Zoom in
v World view (zooms out to the maximum extent)
v Zoom out

Controls for moving around the map

To move around the map, you can use the following controls:
v Click and drag the map by using the mouse
v Press the up pan arrow, or the up arrow key on the keyboard, to pan north
v Press the down pan arrow, or the down arrow key on the keyboard, to pan south
v Press the right pan arrow, or the right arrow key on the keyboard, to pan east
v Press the left pan arrow, or the left arrow key on the keyboard, to pan west

Zoom controls for magnifying or reducing the scale of the map

To zoom in and out of the map, you can use the following controls:
v Click the + map icon to zoom in, or the - map icon to zoom out of the center of the map
v Double-click the selected location to center the map and zoom in to that location
v Click the World view icon to maximize the zoom out to show the world view
v Press the + key on the keyboard to zoom in
v Press the - key on the keyboard to zoom out
v Press Shift while you use the mouse to draw a rectangle around the area to zoom in on
Related tasks:
“Setting the map center and zoom” on page 118
As an administrator, you can set the center point coordinates and the zoom level of any geospatial base
map in the solution.

Map tab
Use the Map tab to see current information that is represented on a geospatial map. You can obtain
information from data items marked on the map. Select your data sources on the filter panel and your
base map from the list of maps available in the solution.

The Map tab provides you with a visual representation of data items associated with their relevant
positions on the map. Using information that is displayed on the Map together with Location Map, and
List tabs, you can identify issues, resources, location patterns, conflicts, and synergies. You can easily
keep up with rapidly changing situations, accessing relevant data sources and data feeds.

The Map, Location Map, and List tabs are linked together to share input and changes to the data items
displayed. You can set filters on the filter panel for the data items you want to see. This setting controls
which data items are displayed on the Map, Location Map, and List tabs. On the List tab, you can see the
name of the selected data source and all its current data items listed with their properties.
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Map tab elements

The Map tab has two interactive interface elements as shown in the following table.

Table 58. Map interface elements

Interface element Description

Geospatial map The selected base map is displayed with markers that indicate where data items and
detailed location maps exist.

More Actions menu A menu of actions that is associated with the map:

New item
Add a data item to the map at that position, for more information about
adding a data item, see the link at the end of the topic.

Reset map
Return to the default base map for the solution. Reset the map to override
your center point and zoom level with the default settings.

1.6.0.2 Upload CSV
If you have read and write permission for the selected data source, upload a
CSV file that supplies data for the selected data source. An administrator
configures user permissions on the Security tab of the data sources tool.

Base maps
Display an alternative base map, select the required map from the list of
available maps.

Note: When you log on to the system for the first time, the map center point and zoom level is set to the
default. Subsequently, when you log on to the system, the center point and zoom level is retrieved from
your previous session. If the default map settings are changed by an administrator, reset the map to see
the new default settings.

The map is updated with data items in relation to positions on the map, subject to settings on the filter
panel. Settings on the filter panel control which data sources are used and which data items are
displayed.

Where more detailed location maps are available, the location is indicated on the map. Location maps can
be viewed on the Location Map tab.

Note: A data item must have latitude and longitude coordinates to be shown on the Map
tab. If a data item has an area name, it is displayed on the Location Map tab only.

Map markers

The position on the map of data items or location maps is indicated with markers as shown in the
following table.

Table 59. Map markers

Marker Type Description

Single-point icon An icon marker indicates a point location on the map that is associated with a data
item, with a unique icon picture to represent each data source.

Polygon A shape outlines on the map the area that is associated with a data item.

Line A line segment or a set of lines outlines on the map the lines that are associated with a
data item.
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Table 59. Map markers (continued)

Marker Type Description

Multi-point A single data item can be associated with more than one point on the map. A
multi-point data item is represented by the same marker at more than one location.
When you select one of these markers, the other icons that are associated with the data
item are also highlighted at the same time.

Location map Location map marker indicates for that position on the map a collection of one or more
location maps are available on the Location Map tab

To display details for a single data item, click the marker on the map. The preview card initially displays
minimal and key properties. Depending on the data source, you can click for more information and
actions that are associated with an item. You can update a data item if the data source is designed to
allow an update.

To display detail for a collection of location maps, click the marker on the map. The preview card initially
displays the number of location maps and the number of items that are associated with those maps. To
view a map on the Location Map tab, click More Actions and click the map name.

If you have administration access, you can go to the Solution Administration view to
configure what is shown on this tab.
Related concepts:
“Configuring geospatial maps” on page 117
In the Solution Administration view, you can configure the maps that are available to the user, the initial
map center point, and the map zoom level.

Adding a point data item
Create a data item that is associated with a point on the map. The data item is added to the Map and List
tabs at the same time.

About this task

Select a data source and a position on the map for the new data item. Then, enter values of the properties
that are relevant to the data source and the item you want to add to the map.

Note: It is possible to add a data item that is not covered by your current filter panel setting. In that case,
the item is added to the solution, but it is not displayed on the map or list unless the filter panel is
changed to include it.

Procedure
1. In the operations view, on the action bar at the top of the view, click More Actions > New Item. The

New Item window is displayed.
2. Select a data source from the data item type drop-down list to see all of the associated geometries or

markers. The data sources that are available for selection are those data sources that are associated
with each particular filter panel.

3. Drag your selected geometry type or marker to the map in the location that you want for your new
data item. The Add New Item window is displayed. 1.6.0.2 Select the marker type from the
available geometries that are displayed. If you draw multiple points on the map, click Done Drawing
when you have finished drawing all of the points.

4. Complete the appropriate fields for the properties of the data item. Properties that are marked with
an asterisk are required for the successful creation of the new item. Those properties that are not
marked with an asterisk are optional.
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The location field is always completed automatically with the word 'Point' and the latitude and
longitude coordinates of the position on the map. Depending on the data source configuration, other
properties of the new data item can be completed automatically. 1.6.0.2 If the solution is configured
with a geocoding provider, you can complete the location field with a street name. Also, if you add an
item using the List tab, WKT (Well-known text) is the required format for entering the latitude and
longitude coordinates. Enter the latitude and longitude coordinates in longitude-latitude order in the
interface.

5. To add the item or items to the map, click Save.

Results

An icon that represents the data source of the new item is displayed in the position on the map. You can
view the details of the new item on a preview card from the Map, or on the List tab.

Note:

1.6.0.1 1.6.0.2 To create a new data item that is represented by an area or a line on the geospatial
map, see the link at the end of the topic.

Data items that are represented by lines, or other multi-point formats can be added to the map only
when received from the data source as a result of polling. Location map markers can be added to the
geospatial map as a result of configuration in the Location Map configuration tool.
Related tasks:

1.6.0.1 1.6.0.2 “Adding an area or a line data item”
You can create a data item that is associated with an area on a geospatial map and added to a data
source. The data item is added to the Map and List tabs at the same time.

Adding an area or a line data item
1.6.0.1 1.6.0.2

You can create a data item that is associated with an area on a geospatial map and added to a data
source. The data item is added to the Map and List tabs at the same time.

About this task

Select a data source and a start position on the map to associate with your new data item. Then, draw
the shape to represent the area on the map and enter values of the properties that are relevant to an item
for the data source.

Note: It is possible to add a data item that is not covered by your current filter panel settings. In that
case, the item is added to the solution, but it is not displayed on the map or list unless the filter panel
settings are changed to include it.

Procedure
1. In the operations view, on the action bar at the top of the view, click More Actions > New Item. The

New Item window is displayed.
2. Select a data source from the data item type drop-down list to see all of the associated geometries or

markers. The data sources that are available for selection are those data sources that are associated
with each particular filter panel.

3. Drag your selected geometry type or marker to the map in the location that you want for your new
data item.

4. You can create a data item that is associated with an area or a line that you draw on the map, and
then the data item is added to a data source.
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v To draw an area on the map, click the required start position on the map and then click each corner
of a polygon to draw your shape on the map. Double-click to finish the polygon. A new area is
displayed on the map.

v 1.6.0.2 If you are drawing a line, multi-line or multi-polygon, select the drawing tool from the
available geometries that are displayed, and click the required start position on the map.
Double-click to finish drawing a line, or a line in a multi-line, or a polygon in a multi-polygon. If
you draw a multi-line or multi-polygon on the map, click Done Drawing when you have finished
drawing.

The Add New Item window is displayed.
5. Complete the appropriate fields for the properties of the data item. Properties that are marked with

an asterisk are required for the successful creation of the new item. Those properties not marked with
an asterisk are optional.
The location field is always completed automatically with the word 'Polygon' and the latitude and
longitude coordinates of the positions that represent the area shape on the map. Depending on the
data source configuration, other properties of the new data item can be completed automatically.

6. To add the item or items to the map, click Save.

Results

A shape that represents the area of the new item is displayed on the map. You can view the details of the
new item on a preview card from the Map tab, or from a row on the List tab. If a data source is
configured as data for boundary, the new area name is available for selection on the boundary pane of
the filter panel.

Note: To create a new data item that is represented by a point position on the geospatial map, see the
link at the end of topic. Data items that are represented by lines, or other multi-point shapes, can be
added to the map only when received from a data source as a result of polling. Location map markers
are added to the geospatial map as a result of configuration in the Location Map configuration tool.
Related tasks:
“Adding a point data item” on page 372
Create a data item that is associated with a point on the map. The data item is added to the Map and List
tabs at the same time.

Viewing KML overlays
1.6.0.2

If an administrator configures one or more KML overlays for the map, the Map Overlays pane is
displayed in the filter panel. A KML overlay contains extra information about data items that can be
displayed on the map, for example, locations and icons.

Before you begin

To update the data items that are displayed on the map through the KML overlay, an administrator must
update the KML overlay file.

About this task

As an example, a KML overlay might contain a pipe map for a city. If you select the KML overlay for the
pipe map, it is displayed on top of the map as if it is part of the map.

Procedure
v To display a KML overlay on the map, in the Map Overlays pane in the filter panel, select the KML

overlay that you want to display.
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v If an administrator updates the data that is contained in a KML overlay file, refresh the browser to see
the updates.

Related tasks:
“Adding KML overlays” on page 119
A KML file contains layers and collections of features that you can add onto an IBM Intelligent
Operations Center map. If you have data in XML format, you can use the KML schema to add features
onto a map without requiring a data source. As an administrator, you can add KML overlays to base
maps.

Location Map tab
Use the Location Map tab to obtain current information about what is happening at a specific location.
You can obtain information from data items marked on the location map. Select your data sources on the
filter panel and your location map from the list of maps available in the solution. A location map in IBM
Intelligent Operations Center is a map, diagram, or plan with predefined areas for interaction, for
example, seating areas in a major sports stadium.

The Location Map tab provides you with a visual representation of data items that are associated with
the relevant areas on a location map. Using information that is displayed on the Location Map together
with Map, and List tabs, you can identify issues, resources, location patterns, conflicts, and synergies. You
can easily keep up with rapidly changing situations, accessing the relevant data sources and data feeds.

The Map, Location Map, and List tabs are linked together to share input and changes to the data items
displayed. You can set filters on the filter panel for the data items you want to see. This setting controls
which data items are displayed on the Map, Location Map, and List tabs. On the List tab, you can see the
name of the selected data source and all its current data items listed with their properties.

Location Map tab elements

The Location Map tab has three interactive interface elements as shown in the following table:

Table 60. Location Map interface elements

Interface element Description

Map menu An alphabetical list of the available location maps that are organized by collection and
by category

Location map The selected location map that is divided into interactive areas, which contain markers
to indicate where data items exist

More Actions menu A menu of actions that is associated with the map:

New item
To add a data item to the map at that position, for more information about
adding an data item, see the link at the end of the topic

In the map menu, a collection consists of one or more location maps, and a category consists of one or
more collections of maps. A collection usually represents a specific location or building, and is also
assigned a position for display on a geospatial map. A category is assigned an appropriate name, which
makes it easier for you to find the collection you are looking for.

The map is updated with data items in relation to areas on the map, subject to settings you select on the
filter panel. Settings on the filter panel control which data sources are used and which data items are
displayed.

Note: A data item must have latitude and longitude coordinates to be shown on the Map
tab. If a data item has an area name, it is displayed on the Location Map tab only.
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Location map markers

The following types of marker represent the position of data items on the location map:

Table 61. Location map markers

Marker Type Description

Icon Indicates the occurrence of a data item in an area with a unique icon to represent each
data source

Cluster Indicates the occurrence of more than one data item in the same area with a number
that represents the number of data items in that area

To display details for a single data item, click the marker on the map. The preview card initially displays
minimal and key properties. Depending on the data source, you can click for more information and
actions that are associated with an item. You can update a data item if the data source is designed to
allow an update.

If more than one data item occurs in the same area, the items are represented by a cluster marker. When
you click this marker, the names of the data items are displayed. You can then display details of an
individual data item by clicking that item. When you highlight a cluster marker, it changes color.

If you have administration access, you can go to the Solution Administration view to
configure what is shown on this tab.
Related concepts:
“Configuring location maps” on page 132
In the System Administration view, you can customize location maps for display on the Location Map
tab. The Location Map tab is part of the content panel on the operations views.

Adding a data item to the location map
You can create a data item that is associated with an area on a location map and added to a data source.
The data item is added to the Location Map and List tabs at the same time.

About this task

Select an area on the map and a data source to associate with your new data item. Then, enter details of
the properties that are relevant to the data source and the item you want to add to the map.

Note: It is possible to add a data item that is not covered by your current filter panel selection. In that
case, the item is added to the solution, but it is not displayed on the map or list. To display the item,
change the filter panel selection to include it.

Procedure
1. Click More Actions > New Item. The New Item window is displayed.
2. Select a map marker from the palette that represents the available data sources for location maps. The

data sources that are available for selection are those data sources that are configured to display on a
location map.

3. Drag the marker onto the map in the position you want to specify for your new data item. The Add
New Item window is displayed.

4. Complete the appropriate fields for the properties of the data item. Properties marked with an asterisk
are required for the successful creation of the new item. Those properties not marked with an asterisk
are optional. The location field is completed automatically for the location map collection with the
latitude and longitude of the position on the geospatial map. The area name field is completed
automatically with the name of the area on the location map. Depending on the data source, other
properties of the new data item can be completed automatically.
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5. Click Save to save the item, or Close to stop adding the item.

Results

An icon that represents the data source of the new item is displayed in the area on the location map. You
can view the details of the new item on a preview card from the location map, or on the List tab.

List tab
Use the List tab to view, monitor, and manage data items in the IBM Intelligent Operations Center.

The List tab contains an interactive list of data items and their details. All the data items that match the
filter panel settings are available to view on the List tab.

The Map, Location Map, and List tabs are linked together to share input and changes to the data items
displayed. You can set filters on the filter panel for the data items you want to see. This setting controls
which data items are displayed on the Map, Location Map, and List tabs. On the List tab, you can see the
name of the selected data source and all its current data items listed with their properties.

You can view data items from one data source at a time and select the data source that you want to view
from the drop-down list of data sources at the top of the List tab.

The list outlines the minimal and key properties that describe an item. You can adjust the width and sort
order of each column.

To display details for a single data item, click the row. The preview card initially displays minimal and
key properties. Depending on the data source, you can click for more information and actions that are
associated with an item. If the item occurs on the geospatial map, you can highlight the item on the map
by clicking More Actions > Highlight On Map. You can update a data item if the data source is
configured to allow an update.

To highlight from the list one or more items on the geospatial map, select the items on the list and on the
top menu bar click More Actions > Highlight On Map.

The list is refreshed regularly with updates, subject to any filters you set.

Adding a data item to the list
You can create a data item on the List tab that is added to a data source. The data item is added to the
list and, depending on the data source, can also be added to a map at the same time.

Procedure
1. In the operations view, on the action bar at the top of the view, click More actions > New item. The

Add New Item window is displayed. The data item properties reflect the data source that is selected
on the List tab.

2. Complete the appropriate fields values of the properties of the data item. Properties that are marked
with an asterisk are required for the successful creation of the new item. Those properties not marked
with an asterisk are optional. Depending on the data source configuration, some fields are completed
automatically. You must complete the location field for a data item to display on a map. WKT
(Well-known text) is the required format for entering the latitude and longitude coordinates of
positions on the map, in the order of longitude and then latitude. 1.6.0.2 The allowed length for the
field values is defined by the data source.
v For an item that is represented by a map marker on a geospatial map, in the location field, enter

the word point and the coordinates for the point.
v For an item that is represented by a map marker on a location map,
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– in the location field, enter the word point and the coordinates for the position on the geospatial
map

– in the area name field, enter the name of the location map area
v 1.6.0.1 1.6.0.2 For an item that is represented by a shape on the geospatial map, enter the

word polygon and the coordinates for points that make up the polygon. The first and last point of
the polygon must be the same to ensure that the polygon can be drawn successfully.

3. Click Save to save the item, or Close to cancel adding the item.

Results

You can view the new item on the List tab and also on the map tabs when the data item has the
appropriate properties.

Filtering data on the maps and list
In the appropriate operations view, use the filter panel to define what data is displayed in the content
panel. The content panel contains the Map tab, the Location Map tab, and the List tab.

The filter panel has the following predefined panes:
v Saved Filters
v Date & Time
v Boundary

The filter panel also has dynamic panes that contain the data source categories that are defined for the
filter panel.

In the predefined and dynamic panes, you can apply filter criteria to define what data is displayed in the
content panel. After you apply a set of filter criteria, you can name and save the set of filter criteria. You
can view and access saved sets of filter criteria in the Saved Filters pane. To clear the current filter
settings, near the bottom of the filter panel, click Clear.

1.6.0.2

Displaying data items on the map

Data items are displayed on the map according to the selections that you make in the filter panel. If the
number of data items that should be displayed exceeds the value that is configured in the
MaxFeaturesToRenderOnMap system property, the excess data items are not displayed. A warning message
is displayed that indicates that some data items are not displayed.
Related tasks:
“Setting displayed and returned data item limits” on page 118
You can set the maximum number of data items that are returned to the map and the list, and that are
rendered on the map.
“Configuring system properties” on page 189
View, create, modify, and delete system properties in the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent Operations Center.

Creating and saving filters
You can create and save filter criteria that are based on date, time, location, and configured data sources.

About this task

To create a filter, in the filter panel, specify selection criteria in the appropriate panes. You can save the
filter for later use.
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Each time that you modify a setting or make a selection in one of the panes in the filter panel, a progress
bar is displayed until the data in the content panel has been updated.

Procedure
v To create a filter, specify the appropriate settings in the following panes:

– Date & Time
– Boundary
– One or more filter panes

v To save the current filter settings, do the following substeps:
1. Near the bottom of the filter panel, click Save.
2. In the Save As window, for Name, enter a name for the filter.
3. Click one of the following options to indicate whether the filter is private or public:

– Private (for my use only)

– Public (anyone can use)

v To clear the current filter settings, near the bottom of the filter panel, click Clear.

Viewing, applying, and deleting saved filters or favorites
In either the Saved Filters pane, or the Favorites pane, you can view, apply, and delete filters that have
been saved.

About this task

Depending on which version of IBM Intelligent Operations Center is installed, saved filters are displayed
either on the Saved Filters pane, or the Favorites pane. An icon next to each filter indicates whether a
filter is private and for your use only, or public and for anyone to use.

Procedure

In the filter panel, click either Saved Filters, or Favorites. Choose one of the following options:
v To apply either a saved filter, or a favorite, click the name in the list to select it.
v To delete either a saved filter, or a favorite, click the Delete icon.

Filtering by date and time
In the Date & Time pane, define the period for which you want data to be displayed in the content panel.

Procedure
1. In the filter panel, click Date & Time.
2. Under Start, define the start date and time of the period:

a. Click the calendar icon, and then choose a date.
b. From the Time list, select a time.

3. Under End, define the end date and time of the period:
a. Click the calendar icon, and then choose a date.
b. From the Time list, select a time.

4. Optional: If you want to further limit the period for which data is displayed to a predefined holiday
or range, select a value from the Only on list.

Filtering by boundary
In the Boundary pane, define the boundary for which you want data to be displayed in the content
panel.
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About this task

1.6.0.1 1.6.0.2 If a data source is configured as data for boundary, it is displayed in the Boundary
pane. You can set the boundary to one or more named areas that are defined in data items that are
received from the data source.

Procedure

In the Boundary pane
v To set the boundary to the current zoom level and pan location that is set on the Map tab, click either

1.6 1.6.0.1 Area currently displayed on map, or 1.6.0.2 Area within visible map.
v 1.6.0.1 1.6.0.2 To set the boundary to a named area, do the following steps:

1. Click either 1.6.0.1 Named area, or 1.6.0.2 Area within selected boundaries.
2. Select a data source from the first list, which is the Boundary area type list.
3. Select one or more named areas from the second list, which is the Boundary area list.

The named areas that you select are highlighted on the map.

Creating named areas
1.6.0.1 1.6.0.2

On the map, you can draw named areas for data sources that have been defined as named area types.

Before you begin

Create a named area type data source by following the instructions in the “Configuring a data source” on
page 99 section. Note the following points:
v On the Acquire tab, for the data source acquisition method, select User interface entry for geospatial

maps.
v On the Basics tab, for Data for boundary, select Yes.

Configure a pane on the filter panel to display the named area type data source. For more information,
see the “Configuring the filter panel” on page 114 section.

About this task

The following procedure describes how to create named areas by drawing them on the map. Instead of
drawing each named area polygon individually on the map, you can define many named areas either in
a CSV file, or by using SQL. Then, you create a named area type data source that acquires the named
area data from either the CSV file, or from the SQL. For more information about using SQL to define
named areas, see the Defining named areas by using SQL topic.

Procedure
1. On the action bar at the top of the view, click More Actions > New Item.
2. 1.6.0.2 Choose a named area data source from the Choose Data Item Type list.
3. Drag the icon that represents the named area data source from the New Item window to the map,

and then draw a named area.
4. Double-click, and then enter values in the appropriate fields for the properties of the named area data

item.
5. To add the named area data item to the map, click Save.
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What to do next

On the map, you can view data items that are contained in the named area. In the filter panel, set the
boundary to display data items that are in the named area:
1. Click either 1.6 1.6.0.1 Named area, or 1.6.0.2 Area within selected boundaries.
2. From the first list, which is the Boundary area type list, select the named area type data source.
3. From the second list, which is the Boundary area list, select the named area that you created.
Related tasks:
“Defining named areas by using SQL” on page 149
You might want to define a named area type data source that has many named areas. Instead of drawing
each named area polygon individually on the map, you can define the named area polygons by using an
SQL table. Then, create a data source that connects to a database to acquire the named area data from the
SQL table.
“Adding an area or a line data item” on page 373
You can create a data item that is associated with an area on a geospatial map and added to a data
source. The data item is added to the Map and List tabs at the same time.

Filtering by data sources
In the filter panes, define the data sources for which you want to display data in the content panel.

Procedure

Repeat the following steps for each of the data sources for which you want to display data.
1. In the filter panel, click the data source group.
2. Select the check boxes next to the required data sources.
3. Optional: For each data source, if more filter criteria are specified in the configuration of the data

source, you can specify more filter criteria:
a. Click More. The More button is displayed only if more filter criteria are available.
b. In the More Filters window, select one or more values from at least one of the lists of filter

options. If you select multiple values from only one list of filter options, then a data item must
match only one of the selected values that is in the list for it to be displayed in the filtered results.
If you select multiple values from more than one list of filter options, then a data item must match
at least one of the selected values that is in each list for it to be displayed in the filtered results.

Results

The first time that you select a data source, the browser displays the most current data that satisfies the
filter criteria. After the initial query for data source information, the browser polls the server in the
background, at intervals that are defined by the automatic refresh interval. The browser uses polled data
to update the map, list, or location map with any new, updated, or deleted data source records.

Setting the automatic refresh interval
You can set the automatic refresh interval in IBM Intelligent Operations Center to control how often to
refresh the user interface with information that is arriving into the system. This includes information that
is displayed on the map, in the list, or on the location map. This setting has an impact on the overall
performance of the system, especially when there are multiple users that are active concurrently, so
activate the automatic refresh feature only when necessary.

Before you begin

If you are using a browser as an active operations console to see the latest activity as it arrives, select a
time range in the filter panel; for example, the previous week. Then, use the following procedure to set
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the automatic refresh interval to a required value that is based on the data that is selected. The single
client operations view can be displayed on a large monitor in a control room.

About this task

Set the automatic refresh interval by using your knowledge of the information sources that are displayed.
For example, if weather events arrive once per hour, and you set the automatic refresh interval to 5
minutes, the automatic refresh returns new data only 1 out of every 12 refreshes. This is a waste of
system resources for the remaining 11 refreshes per hour.

Turn the automatic refresh feature off for most system interactions, where you are doing basic planning
and analysis by filtering different information that is on the display.

Note: If you add, update, or delete an item on the base map, a refresh occurs immediately, regardless of
your settings. The refresh updates the automatic refresh interval timer so that duplicate refreshes do not
occur.

Procedure

Set the automatic refresh interval in any of the operations views.
1. In the Auto refresh field, either click the arrows to select a value, or enter a value. You can specify a

value from 0 to 60 inclusive. If you specify a value of 0, the automatic refresh feature is turned off.
2. To specify the interval type, select a value from the list. You can select an interval type of seconds,

minutes, hours, days, weeks, or months.

Results

The results that are displayed in the browser after a refresh vary depending on the filter criteria that you
select and on your configuration. New and updated items are displayed only if they match the current
filter criteria. Deleted items are removed from the map.

Viewing reports
Use the supporting content panel to view reports of events as graphs, tables, or pie charts. The reports
that are displayed are dependent on specific data source outputs and specific events that you can select
from the filter panel and that are visible in the current view of the map only. View data source results by
time, either in bar chart or tabular format. You can also view results by data source, either in pie chart or
tabular format. Toggle between the chart and tabular format by clicking the Chart and List tabs in the
Data Source Results By Time and Total Results By Data Source reports. These reports help you to identify
trends and plan responses to current and future events.

Viewing reports in the solution

View reports by clicking the splitter bar on the trailing side of the map portal that expands the
supporting content panel, where two reports are vertically displayed within the supporting content panel.
By default, the top, or Data Source Results By Time report displays a graph of data source results by
time. The bottom, or Total Results By Data Source report displays the results by data source. Select any
number of events from the filter panel, and the solution can generate reports that are based on those
events. The reports for events that are visible in the current view of the map only, are automatically
displayed in the supporting content panel.

Viewing data source results by time in a bar chart

By default, a bar chart that maps data source results against time in months is displayed in the Chart tab
of the Data Source Results By Time report. Select days, weeks, or months, from the Distributed By
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drop-down list, which is available only in the List tab. Months is the default value in the drop-down list.
Switch to a table view of the same results over the same time periods by clicking the List tab.

Viewing data source results by time in a table

Click the List tab when the bar chart is displayed in the Data Source Results By Time report. The results
of the bar chart are displayed in tabular format in the same report. The following table lists the displayed
columns and drop-down elements.

Table 62. Data source results by time in a table

Field Description

Distributed By Select a value from this drop-down list to determine the
legend that is used by the report. The possible values are
below.

v Day

v Week

v Month

Data Source An alphabetically ordered list of data sources that are
used by the application for the report. Toggle the order
by clicking the bidirectional arrow beside the column
name.

Month An ordered list of the months that are considered in the
report for the data source. Toggle the order by clicking
the bidirectional arrow beside the column name.
Alternative values for this field are Day and Week.

Count An ordered list of the number of incidents for each data
source. Toggle the order by clicking the bidirectional
arrow beside the column name.

Viewing results by data source in a pie chart

By default, a pie chart is displayed in the Chart tab of the Total Results By Data Source report. The pie
chart displays a breakdown of the results in the bar chart or the table in the Data Source Results By Time
report above the pie chart. Switch to a table view of the pie chart data by clicking the List tab.

Viewing results by data source in a table

Click the List tab when the pie chart is displayed in the Total Results By Data Source report. The results
of the pie chart are displayed in tabular format. The following table lists the displayed columns.

Table 63. Results by data source in a table

Column Description

Data Source An alphabetically ordered list of data sources that are
used by the application for the report. Toggle the order
by clicking the bidirectional arrow beside the column
name.

Count An ordered list of the number of incidents for the data
source. Toggle the order by clicking the bidirectional
arrow beside the column name.

Percentage of total results The percentage of total results for each data source.
Toggle the order that the percentages are displayed in by
clicking the bidirectional arrow beside the column name.
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Monitoring status through KPIs
Use the status view to see the status of key performance indicators (KPIs) in summary or in detail
format.

The status view provides a summary of the status of the KPIs that you have permission to view. View the
current KPI status so that you can plan and act if necessary.

There is a view filter on the legend bar. From a check box menu, you can select the range of KPIs that
you want to view. By default all ranges are selected.

Status view navigation

In the Top Line view, each column contains KPIs of a kind that are grouped under the KPI model name
at the top of the column. The KPIs that are associated with each KPI group are represented by colored
cells according to predefined status. The color code is explained in the legend at the top of the view. To
see KPI details, click the cell. A preview card is displayed with the status, value, KPI type, and range
type of the KPI. If the KPI is composed of underlying child KPIs, the preview card contains a More
Actions menu. To focus on a specific KPI, on the menu, select Drill In to display underlying KPIs. You
can repeat this action at each KPI level until you reach a level where there are no underlying KPIs. For
each KPI, you can also see all of the underlying KPIs. To navigate back to focus on a higher level, click
the required node on the navigation tree.

1.6.0.2 To view any available reports that are mapped to a specific KPI, on the More Actions menu,
select View Reports.

KPI color code

Each KPI is represented by a colored cell. The cell color for a KPI reflects its status.

The color code that is supplied with the sample KPIs for the solution is as follows:
v Green indicates that the status is acceptable, based on the parameters for that KPI, no action is

required.
v Yellow indicates that caution or monitoring is required, action may be required.
v Red indicates that the status is critical and action is recommended.
v Gray indicates that there is insufficient data available to calculate the KPI status.

The color code is defined in the legend at the top of the view.

KPI updates

When an underlying child KPI is updated, the change is reflected in the status view. For example, one of
the sample KPIs that determine the status of the Water Quality KPI changes status from acceptable to
caution. The change is reflected by a change in the background color of the Water Quality cell from green
to yellow. In addition, on the icon on the Notifications button, the number changes to notify a KPI
change.

When the solution receives data that is related to the calculation of a KPI, there is a corresponding color
change in the cell on the status view. This feature is an advantage when the KPI is one that is likely to
receive changes in real time, for example, airport delays. It is not relevant to historical KPIs, for example,
a KPI measuring water level for flood control. For that KPI, regular daily measurements are taken and
there is unlikely in the interim to be a sudden change that affects status.
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Configuring KPIs

If you have administration access, you can go to the Solution Administration view to configure what is
shown on the status view.

A set of sample KPIs is provided with the solution. These KPIs are designed to provide guidance for
planning and implementing different types of KPIs to suit your organization. Examples are provided in
the areas of water, transportation, and public safety.
Related concepts:
“Configuring KPIs” on page 120
In the Solution Administration view, you can configure Key Performance Indicators (KPIs) and their
hierarchical display in the user interface. The KPIs are displayed on the status views in IBM Intelligent
Operations Center.
“Area status with KPIs” on page 367
Use the area status views to obtain a view of key performance indicators (KPIs) that highlights key data
for specific named areas. Users can monitor, manage, and respond to status changes in relation to
organizational performance in specific areas of the map.
Related tasks:
“Mapping KPIs to reports” on page 125
As an administrator, you can map KPIs to reports that are displayed in the status views. You can map the
same report to more than one KPI. Optionally, you can add a set of parameters to each report that might
modify the data that is displayed by the report. The parameter values are used to generate a Cognos
reports query, and the parameter values are also displayed as a label on the instance of the generated
report.

Viewing reports from KPI preview cards
1.6.0.2

From the KPI preview cards in the status views, you can view reports that are mapped to KPIs.

Procedure
1. On the KPI preview card, click More Actions > View Reports.
2. Select one or more check boxes for the available reports and click OK. The reports are displayed in

their selected report format in the KPI reports portlet in the status view.

Analyzing data hotspots
1.6.0.1 1.6.0.2

Use the Map tab to analyze data, for the areas that you select on the map, in the form of hotspots that
are generated by a predefined analysis. The hotspots view assists you in monitoring, managing, and
responding to key issues.

Filters on the filter panel can be combined with the analysis to provide comprehensive information and
interaction facilities. Looking at the analysis result, you can quickly identify locations where there are
hotspots for particular patterns of data. For example, hotspots can indicate that high levels of petty crime
are associated with street light outages in a city. This data can support your decision-making, for
example, preparing for a city council or neighborhood meeting.

You choose on the filter panel the timeframe for the analysis. The filter panel lists the named areas that
you can choose to focus on, or you can look at all of the map within the boundary shown. The filter
panel lists the set of hotspot analyses available. The hotspot analysis that you select defines the data
sources and the type of analysis that is to be applied to the data items.
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When you run an analysis, the map shows you any hotspots that are generated by that analysis and by
the filter criteria. The hotspots represent clusters of data items, according to the distance, time, and source
correlation rules in the analysis definition. Each hotspot is shown as a colored circle on the geospatial
map. Details of each hotspot are shown on the List tab.

You can interpret information from the hotspots that are shown on the map according to the color,
location, and size of the circle.
v The color of the circle indicates the score that is calculated for number of related items in the cluster.

The color range is from red to yellow to indicate a score range from the most to the least proportion of
related items.

v The location of the circle is determined by the position of the center. The center of the circle is the
center point in relation to the positions of all the items that are collected in the cluster.

v The radius of the circle is the distance between the center and the position of the item that is furthest
from the center.

Hotspots are displayed on the map when data items follow a pattern that is based on the correlation
rules that are configured in the analysis definition.

Details of each hotspot are displayed in a preview card when you click the hotspot.

Score The result of a calculation that is based on the number of related items in the cluster. In addition
to showing the score as a percentage value, a bar graph icon is also shown with color intensity
that ranges from gray through yellow to red for increasing score.

Name The name of this hotspot analysis and a number that is awarded automatically to each cluster.
The number awarded ranges from the lowest number, 1, to the highest number that is equal to
the total number of hotspots.

Start The earliest of the start dates of all the items in the cluster.

End The latest of the end dates of all the items in the cluster.

Last Update
The most recent of the last update dates of all the items in the cluster.

Data Items
The total number of items in the cluster.

Radius
The distance between the center and the position of the item that is furthest from the center of
the cluster.

Unit The unit of measurement that is used for distance (yards or meters).

Analysis type
The type of analysis selected in the hotspot analysis definition. The options for hotspot analysis
are: 'Cluster by distance', 'Cluster by distance and correlate data sources', or 'Cluster by distance
and correlate data sources with time'.

Data source
The number of data items in the hotspot listed separately for each data source.

Details of each hotspot are also listed in a row on the List tab.

For more information hotspot analysis definition, consult with your administrator. For general
instructions on using the map and list tabs, see the links at the end of the topic.

For information about configuring analysis views, see the link to Configuring hotspot
analysis. For information about configuring named areas, see the link to Configuring a data source in the
solution
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Related concepts:
“Filtering data on the maps and list” on page 378
In the appropriate operations view, use the filter panel to define what data is displayed in the content
panel. The content panel contains the Map tab, the Location Map tab, and the List tab.
“Viewing data on the maps and list” on page 369
In the content panel of the operations view, you can view data on a geospatial map, on a location map,
or in list format.
“Configuring a data source” on page 99
Use the Data Sources tool to configure a data source that supplies data to IBM Intelligent Operations
Center.
“Configuring hotspot analysis” on page 128
Use the Hotspots tool to configure hotspot analysis definitions for the solution. Hotspot analysis can
highlight patterns of data in relation to time and position on the geospatial map. As an administrator you
can create a hotspot analysis definition, update an analysis that is already listed, or delete a hotspot
analysis definition from the solution.

Running hotspot analysis
1.6.0.1 1.6.0.2

In the filter panes, select the hotspot analysis for which you want to display data in the content panel.

Procedure

Repeat the following steps for each of hotspot analyses for which you want to display data.
1. In the filter panel, click the hotspot analysis group.
2. Select the check boxes next to the required hotspot analyses.

Results

Hotspots are generated on the geospatial map and list according to the criteria defined in the hotspot
analysis definition

Viewing notifications
Click Notifications to view a dynamic list of your notifications and their details.

To see whether there are notifications for you, look for an icon on the Notifications button. If there are no
notifications for you, there is no icon. If there are notifications for you, the number of notifications is
displayed on the icon.

1.6.0.2 The shape and color of the icon indicates the highest severity of notifications that are in the
list:
v An orange square with rounded corners indicates that the list contains only normal notifications.
v A yellow triangle indicates that the list contains notifications with a maximum severity of warning.
v A red circle indicates that the list contains notifications with a maximum severity of critical.

Notifications is an interactive window that contains a list of all the current notifications that are relevant
to you. You see only notifications that are sent to you or to the user groups that you are a member of.

Notifications are received when a predefined key performance indicator (KPI) value change occurs, where
the new value is in a different range to the existing value. For example, the water level measurement of a
reservoir is unacceptably low and the users with access to the KPI are notified.
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1.6.0.1 1.6.0.2 Notifications also display errors from background processes.

Notifications list

The Notifications window provides a dynamic, interactive list of notifications. The list contains key
information for each notification: a headline description, and the sent date and time. The list is sorted in
an order that is based on the sent date and time, starting with the most recent notification. You can
change the sort order in the list.

1.6.0.1 1.6.0.2 A column in the Notifications list also indicates the severity of each notification.

Initially, the Notifications window displays a list of all of your current notifications. To see more
information about a specific notification, click the row for that notification. The preview card for a
notification displays its key properties, including the full description, the sent date and time, and the
sender.

1.6.0.1 1.6.0.2 The preview card also indicates the number of times that the notification has been
sent.

To remove the notification from the list, click More Actions on the preview card, and then click Cancel.
To close the preview card and return to the list, click the close icon at the top of the card.

Note: Remove a notification only after you are certain it is obsolete because the notification is removed
for all recipients when you close it.

A summary bar at the end of the list indicates the total number of notifications that are displayed and the
number of notifications that are selected. Scroll down through the list with the side-bar.

To close the Notifications window, click Notifications on the menu bar.

In the user profile notification settings, you can customize the number of days for which notifications are
displayed. By default, each notification is displayed for a maximum period of three days.

1.6.0.2 Notifications can be displayed for a maximum of 200 days.

You can set the length of time that a notification is displayed for you before the notification is removed
from the list. On the top menu bar, click your user name and then click Edit Profile. Enter a number in
the Notification display limit field to specify a value for the length of time in days that each notification
is displayed. The default time limit is three days.

Configuring notification settings
1.6.0.2

You can configure the solution to notify you if a specific event occurs. There are three types of
notifications: system, SMS, and email. You can view and edit your notification settings in your IBM
Intelligent Operations Center user profile.

About this task

System notifications are displayed in the Notifications window in the content panel. SMS notifications are
sent by SMS message, and email notifications are sent by email.

Procedure
1. To modify your user profile, click Manage Profile from the list that is next to your user name at the

top of the view.
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a. To configure the telephone number for the SMS message and to configure the email address, click
Manage Profile > My Profile.

2. To configure whether to receive notifications, the types of notifications that you receive, and the
length of time to display notifications for, click on the My Notification Settings tab.

3. Select a component and configure the notification settings.
v To configure KPI notification settings, select Key Performance Indicators.

Note: Define the status criteria that determines whether you receive KPI notifications, and the
notification method. For example, configure the solution so that you receive notifications by SMS
message if KPIs changed to critical status in the previous hour.

v To configure system error notification settings, such as data import notification settings, select
System Errors.
– To configure IBM Cognos Business Intelligence notification settings, select Cognos Business

Intelligence

– To configure analytics notification settings, select Analytics.
– To configure data import notification settings, select Data Import.

Related tasks:
“Viewing or editing your user profile” on page 169
You can view and edit the information in your solution user profile. Edit your user profile to set your
time zone, language preference, and notification settings. You can also reset your password and modify
your personal details.
“Defining the optimized interactive processes communication method” on page 76
The Optimized Interactive Processes (OIP) Extreme Messaging (XM) component packaged with IBM
Intelligent Operations Center must be configured to define the communication methods if email or SMS
notifications are to be used. If email is to be used, the server SMTP services are used to deliver outgoing
email. For SMS notifications an SMS gateway provided by a third party is required. If neither notification
method is required, these steps are optional.

Managing activities
Click My Activities to view a dynamic list of activities that are owned or monitored by the currently
logged on user. However, an administrator can see the activities for all owners and monitors in the My
Activities window.

Each time a standard operating procedure is launched, the associated activities are assigned to owners.

An icon is displayed on the My Activities button that indicates the number of standard operating
procedures that are active. To view the activities for which you are an owner or a monitor, click My
Activities. In the My Activities window, the activities are grouped by their parent standard operating
procedure instance.

For each instance of a standard operating procedure that has been launched, the My Activities window
displays all the activities, including those activities that have been completed.

The following activity due icons are displayed near the top of the My Activities window:

Past Due
Activities whose completion is past due.

Due Today
Activities that are due to be completed today.

Future Activities whose completion is due in the future.
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When an activity is started, the due date is calculated by adding the start time to the duration of the
activity. The activity due dates are used to calculate the number that is displayed in each of the activity
due icons.

In the My Activities window, standard operating procedures are displayed in alphabetical order. Next to
each standard operating procedure in the list that has past due activities, a red icon indicates the number
of activities that are past due.
Related concepts:
“Configuring standard operating procedures” on page 136
A standard operating procedure is a set of instructions that describes all the relevant steps and activities
of a process or procedure. Standard operating procedures are essential to an organization to deliver
consistent, measured, high-quality responses to complex and unpredictable events.

Viewing, editing, and completing activities
The following steps show how to manage your activities in the My Activities window.

To view the activities for the instance of a standard operating procedure that has been launched, expand
the name of the standard operating procedure. All the activities for the instance of the standard operating
procedure are displayed, including the status and due date, until the instance is completed. The instance
of the standard operating procedure is closed when all the activities are either completed, or skipped. You
can also stop an instance of a standard operating procedure manually. To refresh the information that is
displayed in the My Activities window, click Refresh.

Click an activity and then choose from the following options:
v To start an activity, from the list, select Start. If the activity is defined as an automated activity in the

standard operating procedure definition, the workflow that is assigned to the activity is started
automatically, and the activity is finished automatically. If the activity is an If-Then-Else activity, to start
one of the branches that is defined for the activity, from the list, select either Start Then, or Start Else.

Note: If it has been specified that certain activities are done in order, you will not be able to start an
activity that must be done in order until you have completed the predecessor activities that it depends
on.

v To skip an activity, from the list, select Skip. This option is not available for activities that are marked
as required.

v To complete an activity, from the list, select Complete.
v To add a reference to an activity, use the following substeps:

1. From the list, select Add Reference.
2. In the Add a Reference to the Library window, select a value from the Reference list. If you select

Add New, enter the details for the new reference, and then click Add.
3. Click Add.
4. To see the reference that you added, from the list, select Show Details.

v To add a comment to an activity, use the following substeps:
1. From the list, select Add Comment.
2. In the Add Comment window, enter a comment in the Comment field.
3. Click Save.
4. To see the comment that you added, from the list, select Show Details.

v To view the details for an activity, including references and comments, use the following substeps:
1. From the list, select Show Details.
2. In the Activity Details window, click either the References, Roles, Comments, or Change Log tab.

v To send a notification, use the following substeps:
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1. From the list, select Send Email.
2. Select a value for Notification template.
3. For To, enter the email address of the recipient.
4. For Subject, enter a subject for the email.
5. For Message, you can enter your own message. In addition, to append details of the current

standard operating procedure, activity, or event, select a value from the Related to list, and then
click Append. You can use the Related to list to append details from multiple items.

6. Optionally, enter values for User and Password, for authentication to the SMTP server.
7. Click Send.

v To view the details for the instance of the standard operating procedure, click the i icon next to the
name of the standard operating procedure. In the Standard Operating Procedure Details window,
choose from the following options:
– To edit basic information for the standard operating procedure instance, from the list, select Edit. To

save your changes to the basic information, click Save. Alternatively, to cancel your changes, click
Cancel.

– To either view or edit activities, references, and roles, or to view the comments and change log for
the standard operating procedure instance, click the tabs.

– To stop the instance of the standard operating procedure, from the list, select Stop.
– To export details of the standard operating procedure instance, from the list, select Export.
– To add a comment to the instance of the standard operating procedure, from the list, select Add

Comment.

For more details about editing standard operating procedures, see the link at the end of the topic to the
section about configuring standard operating procedures.

Related concepts:
“Configuring standard operating procedures” on page 136
A standard operating procedure is a set of instructions that describes all the relevant steps and activities
of a process or procedure. Standard operating procedures are essential to an organization to deliver
consistent, measured, high-quality responses to complex and unpredictable events.

Linking data items to standard operating procedures
1.6.0.1 1.6.0.2

Through the preview card, you can either associate a data item to an instance of a standard operating
procedure that is already running, or you can launch a new instance of a standard operating procedure.

Before you begin

A solution administrator must use the data source configuration tool to assign the standard operating
procedure actions to the appropriate data source. The names of the standard operating procedure actions
are LaunchSop and AssociateSop. Then, for data items that are received from the data source, the standard
operating procedure options are displayed in the More Actions menu on the preview card.

Procedure

Choose one of the following options from the More Actions menu on the preview card for a data item:
v To associate the data item to an instance of a standard operating procedure that is already running,

click Associate to a Running Standard Operating Procedure and select a standard operating
procedure in the list. You can associate a data item to instances of one or more standard operating
procedures.
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v To disassociate the data item from an instance of a standard operating procedure, click Associate to a
Running Standard Operating Procedure and clear the selection for the standard operating procedures
in the list.

v To launch an instance of a standard operating procedure, click Launch Standard Operating Procedure,
and then choose one of the following options:
– Select Routed standard operating procedure definitions. Use this option to select a standard

operating procedure from a list of standard operating procedures that the corresponding data source
is routed to, based on the data source configuration.

– Select All standard operating procedure definitions. Use this option to select a standard operating
procedure from a list of all the available standard operating procedures.

You cannot launch an instance of a standard operating procedure that is already associated to a data
item. Each data item can launch only one instance of each standard operating procedure.

v To view a list of the standard operating procedures that are associated to the data item, click View
Standard Operating Procedures.

Managing contacts
Click Contacts to send instant messages to other users within the solution.

Note: You must log on to the solution portal by using the fully qualified domain name of the IBM
Intelligent Operations Center application server. If you log on to the portal by using an IP address or a
host name alias instead of the registered fully qualified domain name, this instant messaging window
does not display correctly.

Your default status indicates that you are available. You can change your status indicator to indicate that
you are away from your computer, in a meeting, or that you do not want to be disturbed. You can also
change your default status message. To change your status, at the top of the window, click the
drop-down button beside your status indicator.

You can set up a list of your contacts that is organized by category. You can organize contacts in
categories that are based on the people you want to communicate with. For example, you can have a
category for general work contacts and another category for project work contacts.

To communicate with contacts, select from the contacts you set up, or find a contact by typing a name in
the field provided. The status of each user is displayed with their name. You can also modify your own
online status, contacts, or groups. Click the menus at the top of the window:
v File to add contacts, modify groups, or log off
v Tools to set up a chat, or announcement; or to change your privacy settings
v Help to get more detailed information about how to use the portlet

The meeting room facility is not available in IBM Intelligent Operations Center.

Note: A list is displayed with the status of all users who are logged on. Occasionally, when a user who is
logged on closes the browser window or logs off, the status of that user might be still displayed as
logged on until the session expires. However, any messages that are sent to that user after the user closed
the browser window, or logged off, are not delivered. An error message is then displayed to a user who
is trying to send a message to that user. To ensure that your status is always updated immediately to
"unavailable", log off by clicking File > Log Out.
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Chapter 10. Troubleshooting and support

To isolate and resolve problems with your IBM software, you can use the troubleshooting and support
information, which contains instructions for using the problem-determination resources that are provided
with your IBM products.

Techniques for troubleshooting problems
Troubleshooting is a systematic approach to solving a problem. The goal of troubleshooting is to
determine why something does not work as expected and how to resolve the problem.

The first step in the troubleshooting process is to describe the problem completely. Problem descriptions
help you and the IBM technical-support representative know where to start to find the cause of the
problem. This step includes asking yourself basic questions:
v What are the symptoms of the problem?
v Where does the problem occur?
v When does the problem occur?
v Under which conditions does the problem occur?
v Can the problem be reproduced?

The answers to these questions typically lead to a good description of the problem, which can then lead
you to a problem resolution.

What are the symptoms of the problem?

When starting to describe a problem, the most obvious question is “What is the problem?” This question
might seem straightforward; however, you can break it down into several more-focused questions that
create a more descriptive picture of the problem. These questions can include:
v Who, or what, is reporting the problem?
v What are the error codes and messages?
v How does the system fail? For example, is it a loop, hang, crash, performance degradation, or incorrect

result?

Where does the problem occur?

Determining where the problem originates is not always easy, but it is one of the most important steps in
resolving a problem. Many layers of technology can exist between the reporting and failing components.
Networks, disks, and drivers are only a few of the components to consider when you are investigating
problems.

The following questions help you to focus on where the problem occurs to isolate the problem layer:
v Is the problem specific to one platform or operating system, or is it common across multiple platforms

or operating systems?
v Is the current environment and configuration supported?

If one layer reports the problem, the problem does not necessarily originate in that layer. Part of
identifying where a problem originates is understanding the environment in which it exists. Take some
time to completely describe the problem environment, including the operating system and version, all
corresponding software and versions, and hardware information. Confirm that you are running within an
environment that is a supported configuration; many problems can be traced back to incompatible levels
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of software that are not intended to run together or have not been fully tested together.

When does the problem occur?

Develop a detailed timeline of events leading up to a failure, especially for those cases that are one-time
occurrences. You can most easily develop a timeline by working backward: Start at the time an error was
reported (as precisely as possible, even down to the millisecond), and work backward through the
available logs and information. Typically, you need to look only as far as the first suspicious event that
you find in a diagnostic log.

To develop a detailed timeline of events, answer these questions:
v Does the problem happen only at a certain time of day or night?
v How often does the problem happen?
v What sequence of events leads up to the time that the problem is reported?
v Does the problem happen after an environment change, such as upgrading or installing software or

hardware?

Responding to these types of questions can give you a frame of reference in which to investigate the
problem.

Under which conditions does the problem occur?

Knowing which systems and applications are running at the time that a problem occurs is an important
part of troubleshooting. These questions about your environment can help you to identify the root cause
of the problem:
v Does the problem always occur when the same task is being performed?
v Does a certain sequence of events need to occur for the problem to surface?
v Do any other applications fail at the same time?

Answering these types of questions can help you explain the environment in which the problem occurs
and correlate any dependencies. Remember that just because multiple problems might have occurred
around the same time, the problems are not necessarily related.

Can the problem be reproduced?

From a troubleshooting standpoint, the ideal problem is one that can be reproduced. Typically, when a
problem can be reproduced you have a larger set of tools or procedures at your disposal to help you
investigate. Consequently, problems that you can reproduce are often easier to debug and solve.
However, problems that you can reproduce can have a disadvantage: If the problem is of significant
business impact, you do not want it to recur. If possible, re-create the problem in a test or development
environment, which typically offers you more flexibility and control during your investigation.
v Can the problem be re-created on a test system?
v Are multiple users or applications encountering the same type of problem?
v Can the problem be re-created by running a single command, a set of commands, or a particular

application?
Related tasks:
“Searching knowledge bases” on page 441
You can often find solutions to problems by searching IBM knowledge bases. You can optimize your
results by using available resources, support tools, and search methods.
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Enabling traces and viewing log files
To troubleshoot a problem in IBM Intelligent Operations Center, you might need to analyze log files in
several systems.

The following procedures describe how to enable traces and view logs for the following systems:
v WebSphere Portal
v IBM Business Monitor
Related concepts:
“Verifying the components” on page 209
The system verification check tool tool tests components within IBM Intelligent Operations Center to
determine if they are accessible and operational.
“Log file maintenance” on page 359
IBM Intelligent Operations Center stores log files in several different locations. To prevent system
outages, periodically back up the database, archive log files, and remove the original log files.

Enabling tracing and viewing logs on WebSphere Portal
About this task

If IBM Intelligent Operations Center is deployed in a high availability environment, enable tracing and
view the logs on both of the following servers: application server 1 and application server 2.

WebSphere Portal logs are at the following locations:

Standard environment
/opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal

High availability environment
/opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal on application server 1

/opt/IBM/WebSphere/wp_profile/logs/WebSphere_Portal_PortalNode2 on application server 2

To start the traces and view the logs, enter the commands at run time as the root user. Remember to
remove all logging after troubleshooting

Procedure
1. In the Solution Administration view, click System Administration > Administration Consoles.
2. Click Application server to log on to the WebSphere Application Server 8.0 Deployment Manager

console.
3. Click Troubleshooting > Logs and Trace.
4. Click WebSphere_Portal > Change log level details.
5. Click the Runtime tab and enter the following command to troubleshoot all components:

*=warning: com.ibm.ioc.*=all

You can specify more specific trace commands:
v If a data source is created successfully but no information from it is displayed, enter the following

trace command to turn on logging. Then, attempt to re-create the issue; for example, create another
data source:
*=warning: com.ibm.ioc.logger.DataRecieverLogger=all:

v To troubleshoot filter panel issues, enter the following trace command:
*=warning: com.ibm.ioc.logger.FilterLogger=all:

v To troubleshoot map and list issues, enter the following trace command:
*=warning: com.ibm.ioc.logger.StatLogger=all:
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v To troubleshoot KPI issues, enter the following trace command:
*=warning: com.ibm.ioc.logger.KpiLogger=all:

6. Click OK.
7. To view a log, for example on application server 1, enter the following commands:

cd /opt/IBM/WebSphere/wp_profile1/logs/WebSphere_Portal
tail –f trace.log

What to do next

When you finish troubleshooting, remove all the traces.

Enabling tracing and viewing logs for IBM Business Monitor on the
application server
About this task

If IBM Intelligent Operations Center is deployed in a high availability environment, enable tracing and
view the logs on both the following servers: WBM_DE.AppTarget.WBMNode1.0, and
WBM_DE.AppTarget.WBMNode2.0

Logs for IBM Business Monitor on the application server are at the following locations:

Standard environment
/opt/IBM/WebSphere/AppServer/profiles/wbmProfile1/logs/WBM_DE.AppTarget.WBMNode1.0

High availability environment
/opt/IBM/WebSphere/AppServer/profiles/wbmProfile2/logs/WBM_DE.AppTarget.WBMNode2.0

To start the traces and view the logs, enter the commands at run time as the root user.

Procedure
1. In the Solution Administration view, click System Administration > Administration Consoles.
2. Click Application server to log on to the WebSphere Application Server 8.0 Deployment Manager

console.
3. Click Troubleshooting > Logs and Trace.
4. Click WBM_DE.AppTarget.WBMNode1.0 > Change log level details.
5. Click the Runtime tab and enter the following trace level code: com.ibm.wbimonitor.*=all
6. Click OK.

What to do next

When you finish troubleshooting, remove all the traces.

ISA Data Collector for IBM Intelligent Operations Center
ISA Data Collector for IBM Intelligent Operations Center helps troubleshoot problems with IBM
Intelligent Operations Center and other IBM software products.

The tool collects information required that is required to troubleshoot problems in the IBM Intelligent
Operations Center environment. The tool also sends the logs to a staging location for use by IBM
Support. The following types of information are collected:
v Platform problem determination files
v System log and trace files
v Platform provisioning files
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v System configuration files
v Java dump files
v Problem determination framework internal log files
v Installation log files
v List of installed rpm packages

Installing ISA Data Collector
Use your browser to access the ISA Data Collector for IBM Intelligent Operations Center through the
provided web link. You can collect data on your current system directly from the browser. Alternatively,
you can download a utility that you can use to collect data from either the current system, or another
system.

Procedure
1. Go to the IBM Support Assistant Data Collector site.
2. Choose one of the following options:

v Collect data from the current system by using the current browser:
a. Select this system using the current browser.
b. Review and accept the terms in the license agreement.
c. Click Start Collection.

v Collect data from either the current system, or from another system, by using a downloadable
utility:
a. Select this or another system using a downloadable utility.
b. Review and accept the terms in the license agreement.
c. Click the download option for your operating system.
d. Run the isadc utility.

Related information:

IBM Support Assistant Data Collector for IBM Intelligent Operations Center 1.6.x

Creating a data collection
ISA Data Collector for IBM Intelligent Operations Center collects logs and other information from the
IBM Intelligent Operations Center system for troubleshooting within your organization or to be provided
to IBM Support with a support request.

Procedure
1. Run cd /tmp/isadc to change to the isadc directory.
2. Run ./isadc.sh Information on the data collector is displayed.
3. Follow the prompts to create the data collection.
4. Enter whether or not the collection will be sent to IBM Support.

Results

The collected information is saved as the specified file name and sent to IBM support, if requested.
Related concepts:
“Naming data collections to be sent to IBM Support” on page 398
Collections sent to the IBM Support site must meet specific naming standards.
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Naming data collections to be sent to IBM Support
Collections sent to the IBM Support site must meet specific naming standards.

Files names must meet one of the following formats:
pmr_number.branch_number.country_code.short_description.zip

or

pmr_number,branch_number,country_code,short_description.zip

For example: 34143.055.000.logs.zip

The second format is acceptable for compatibility with prior versions of ISA Data Collector. The first
format, using periods instead of commas, is the preferred format.

ISA Data Collector validates the file name before sending a collection to IBM Support. If the file name
does not meet naming standards, the user is prompted to change the file name before the file is sent.

Known issues with ISA Data Collector for IBM Intelligent Operations
Center
There are issues and limitations with ISA Data Collector for IBM Intelligent Operations Center.
v If the application server is not running, information about software versions and applied fixes will not

be included in the collection.
v If the collector cannot access a server, the server is bypassed and no logs are collected. No error is

issued.
If logs exist on a server, but were not collected, check the connectivity between the server and the
analytics server in a standard environment and analytics server 1 in a high availability environment

IBM Intelligent Operations Center Messages
Each message topic helps you to identify the cause of a particular error condition in the IBM Intelligent
Operations Center and recommends actions to take to resolve the error.

To help you understand the errors that you might encounter while using IBM Intelligent Operations
Center, each message topic is divided into three sections: the message that is displayed in the IBM
Intelligent Operations Center or its logs, an explanation, and an action.

The message
Contains two identifiers, which are the error identification and associated text. The error
identification is the message ID. It is a unique number that identifies a message. A final character
of E indicates that the message resulted from an error, W indicates a warning message, and I
indicates an information message.

The explanation
Contains an additional explanation of the message.

The user response
Suggests the corrective action for resolving the error.

To help you search for information about an error message, enter the ID number of the error message in
the Search field in the information center.

Note: The topics in this section contain only messages that are specific to IBM Intelligent Operations
Center. For all other messages, see the product documentation.
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CIYBA0050E Cannot locate configuration file {0}. Add
the enclosing folder to classpath.

Explanation: Installation properties are supplied to the
IBM Intelligent Operations Center installation tool in
the custom.properties file. This file is located in the
install-root/resource directory. This file must be
located in the classpath of the installation tool.

User response: Ensure the install-root/resource/
custom.properties file is in the classpath.

CIYBA0051E Cannot load configuration file {0}. Add
the folder to classpath and ensure the
file is readable.

Explanation: Installation properties are supplied to the
IBM Intelligent Operations Center installation tool in
the custom.properties file. This file is located in the
install-root/resource directory.

This message is caused by one of the following
conditions:

v The file was not found.

v The file could not be read.

v The file is not in a properties file format.

User response: Check the install-root/resource/
custom.properties and make sure the
common.properties file exists and that it can be read.
Check that the file is in the properties file format.

CIYBA0052E {0} does not contain a value for the
remote connection specification property
(connection.options).

Explanation: The installer is attempting to override
the permitted remote connection protocol specifications
by supplying a connection.options property in the
install-root/resource/custom.properties file. The
supplied value is empty.

User response: Add a valid remote connection
property list. The list is a comma-separated string. For
example, ssh-pw,ssh-key.

Valid protocols are:

ssh-pw SSH with password authentication.

ssh-key
SSH with RSA or DSA keys

Optionally the connection.options property can be
commented out. In that case the default connection
protocol of ssh-pw will be used.

CIYBA0053E Unsupported remote connection type
specified: {0}.

Explanation: The installer is attempting to override
the permitted remote connection protocol specifications
by supplying a connection.options property in the

install-root/resource/custom.properties file. One or
more of the specified values is in error.

User response: Add a valid remote connection
property list. The list is a comma-separated string. For
example, ssh-pw,ssh-key.

Valid protocols are:

ssh-pw SSH with password authentication.

ssh-key
SSH with RSA or DSA keys

CIYBA0054E An identity file (property: ssh.identity)
was not specified for the remote
connection protocol "{0}".

Explanation: The remote connection protocol, ssh-key,
is the sole remote connection protocol specified in the
install-root/resource/custom.properties file. An
identity file (the SSH private key) must be specified
when choosing the ssh-key protocol.

User response: Specify the identity file in the
ssh.identity property in the install-root/resource/
custom.properties file.

CIYBA0055E Cannot read key identity file: {0}.

Explanation: A SSH identity file was specified in the
ssh.identitiy property in the install-root/resource/
custom.properties file, but the identity file cannot be
found.

User response: Specify a valid identity file in the
ssh.identity property.

CIYBA0056E Unexpected error processing key
identity file: {0}. Details: {1}.

Explanation: An unanticipated exception has occurred
while using the SSH identity file to establish remote
communications.

User response: Use the details in {1} to determine the
root cause of the exception.

CIYBA0059E Terminating installation due to invalid
remote connection configuration.

Explanation: The installation process is terminating
because the remote communication properties are
configured incorrectly.

User response: No action is required.

CIYBA0101E The Topology File {0} is not valid.

Explanation: The installer attempted to validate the
{0} topology file and found that the topology file
contained errors. These errors can include:

v Not all required components existing in the topology
file.

CIYBA0050E • CIYBA0101E
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v Prerequisite components not listed before dependant
components.

v Components that should be deployed sequentially
are in the parallel development stanza.

User response: Correct the topology file and rerun the
installation.

CIYBA0102E The topology or the topology
specification files were not found.

Explanation: Each installation topology has an
associated .xml file and specification. One or both of
these files could not be found.

User response: Make sure that all the installation files
were extracted to the installation server. Check that the
image.basedir.local property in the
custom.properties file is set to the correct location. The
custom.propeties file is in the /resource subdirectory
on the installation server where the installation package
was extracted.

CIYBA0103E The {0} script to install a component
does not exist.

Explanation: The installation program attempted to
locate a script for a component and that script was not
found.

User response: Check that the installation media was
extracted on the installation server. Check that the base
directory was correctly configured in the
custom.properties file. The base directory is used to
derive the location of the installation script.

CIYBA0104E The Topology file contains invalid
entries.

Explanation: The installer encountered an error while
reading the topology file and creating the deployable
units for each component. This is normally an internal
error unless a custom topology is being installed.

The topology file might be corrupted or incorrectly
specified.

User response: Check the topology file for the
following problems:

v Duplicate component IDs.

v Missing component IDs or type attributes.

v Specification of a connection attribute where no
parent component exists.

v The topology fails XML schema validation.

CIYBA0105E The {0} file could not be found.

Explanation: The installation program could not find
the {0} file.

User response: Make sure that all the installation files
were extracted to the installation server. Check that the

image.basedir.local property in the
custom.properties file is set to the collect location. The
custom.propeties file is in the /resource subdirectory
on the installation server where the installation package
was extracted.

CIYBA0106E The {0} file could not be saved.

Explanation: The installation program attempted to
write the file named {0} and a file I/O error was
returned.

User response: Check that the specified location can
be accessed using the installer’s user ID. Make sure
there is sufficient space on the disk and that the
partition is not corrupt.

CIYBA0107E Property reference {0} was not found in
Topology file {1}

Explanation: During installation some of the
components require property values from prerequisite
software. These components use properties references
in the topology file to determine the required property
values. The property reference could not be found in
the topology file.

User response: The topology file is corrupted. This
could be due to manual edits that introduced invalid
entries or that the installation did not write a topology
file with correct values. Determine which components
were incorrectly installed. Remove any incorrectly
installed components, correct the topology file, and
reinstall.

CIYBA0108E Component {0} was not found in
Topology file {1}.

Explanation: The installation program expected to
find the {0} component ID in the {1} topology file. The
component ID was not found. The problem might be
due to an incorrectly specified dependency in a
connection element of another component.

User response: Review the topology file for references
to {0}. Correct any incorrect connection elements for the
{0} component and reinstall.

CIYBA0109E Property {0}.{1} in Topology File {2} is
invalid.

Explanation: The property was not found in the
topology file or in a specification properties file.

User response: If missing, add the property to the
specification properties file or the topology file. This
error might also be due to the property being
misspelled. Correct the topology file or specification
properties file and reinstall.

CIYBA0102E • CIYBA0109E
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CIYBA0110E The property {0}.{1} in Topology File {2}
cannot be found.

Explanation: A deployable unit reference another
deployable unit indicated by role {1}. Either the
dependent deployable unit is not found or there is a
mismatch in roles.

User response: The topology file indicated contains
references to the property shown, however the
definition of that property cannot be found in the
topology file. This situation could arise if the topology
file was manually edited and a component was
removed, however references to that component still
exist.

CIYBA0111E Cannot retrieve master host for
component {0}.

Explanation: A topology component must be
associated with a target host. An orphan topology
component is specified.

User response: Check the {0} topology component and
make sure it has a sequence of connection attributes
that ultimately has a component with a host attribute.

CIYBA0112E Failed to read Topology File {0}

Explanation: The installation program was unable to
read the specified topology file.

User response: Check that the indicated topology file
is in the installation directory and that the installation
program can access the directory.

CIYBA0113E Failed to save file {0}.

Explanation: The installation program was unable to
save the indicated file.

User response: Check that the installation program
has access to the installation directory.

CIYBA0114E The {0}.{1} property cannot be set.

Explanation: The installation program was unable to
update the indicated property.

User response: The topology file is either corrupted or
was manually edited and introduced invalid property
values. Correct the topology file and rerun the
installation.

CIYBA0115E The Topology File {0} cannot be found.

Explanation: The installation program was unable to
access the indicated topology file.

User response: Check that the topology file is in the
directory specified by the installation program and
make sure the installation program can access the
directory.

CIYBA0116E Unable to write to properties file {0}.

Explanation: The installation program was unable to
write the indicated properties file.

User response: Check that the user ID used by the
installation program has access to the temporary
directories on the target servers. The directory on the
target servers where the temporary installation scripts
will be written is specified by the
Unix.script.basedir.remote property in the
custom.properties file. Correct this property value if
incorrectly specified.

CIYBA0117E The installer failed to create the
keystore.

Explanation: The installation program was unable to
create the key store.

User response: Check that the user ID being used by
the installation program has access to all subdirectories
where the installation media was extracted.

CIYBA0118E The installer was unable to access the
keystore using the supplied password.
The password is incorrect or the
keystore is corrupt.

Explanation: The installation program was unable to
access the keystore.

User response: Check that the supplied password is
correct and the keystore was not corrupted. Regenerate
the keystore with a new password by reinstalling the
solution.

CIYBA0119E Unable to encrypt property {0} in
Topology file {1}.

Explanation: The installation program attempted to
encrypt the indicated property using the password
supplied in the topology file and was unable to do so.

User response: Check that the keystore is not
corrupted and that the password for the topology is
correct. If needed, recreate the keystore with a new
password by reinstalling.

CIYBA0120E Unable to decrypt property {0} in
topology file {1}

Explanation: An attempt to read and decrypt the
indicated property failed.

User response: Check that the user ID used by the
installation program can access the indicated topology
file and that the topology file is in the expected
location. Check that the password and secret key are
correct. Rerun the installation.

CIYBA0110E • CIYBA0120E
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CIYBA0121E The keystore file {0} already exists.

Explanation: This error should not occur using the
IBM Installation Manager installation. IBM Installation
Manager controls the installation flow and ensure there
an attempt is not made to regenerate the keystore.

User response: Check that the installation has not
already been run. Rerun the installer once the existing
keystore from a previous installation attempt has been
removed.

CIYBA0122E The keystore for the Topology does not
exist. Run the createSecretKey
command.

Explanation: This error should not occur when
running the IBM Installation Manager installation. The
IBM Installation Manager installation automatically
accepts the SecretKey and generates the keystore.

User response: If running a step-by-step installation,
follow the steps to generate a keystore.

CIYBA0123E The Topology {0} is not completely
installed.

Explanation: The installation program has determined
that not all the components in the topology have been
installed.

User response: Check the topology file and determine
which components have not been installed. Restart the
installation.

CIYBA0124E The {0} properties file cannot be found.

Explanation: The installation program attempted to
read the indicated properties file. However, the file
could not be found.

User response: Check that the installation package
was property extracted. Check that the user ID used by
the installation program has access to all directories
where the package was extracted.

CIYBA0125E Unable to write to the properties file {0}

Explanation: The installation program attempted to
update a file with the runtime variable values and an
I/O exception was returned.

User response: Check that the location specified can
be accessed using the installation program user ID.
Check that there is sufficient space in the file system
and the disk partition is not corrupt.

CIYBA0126E Unable to set the value for property {0}
from Topology file {1}

Explanation: The installation program was unable to
set the specified property value.

User response: Check that the property in the
indicated topology file has the correct XML syntax.
Check that the topology file is not corrupt or
malformed. Remove any special characters from the file
and restart the installation.

CIYBA0127E Unable to read the solution specification
file {0}

Explanation: The installation program tried to read
the indicated file and a file I/O error was returned.

User response: Check that the file exists in the
specified location. Check that the user ID used by the
installation program has access to all directories where
the package was extracted.

CIYBA0128E The {0} file could not be saved.

Explanation: The installation program attempted to
write the indicated file and a file I/O error was
returned.

User response: Check that the location specified can
be accessed by the user ID used by the installation
program. Check that there is enough space in the file
system and that the disk partition is not corrupt.

CIYBA0129E Unable to read the solution package file
{0}.

Explanation: The installation program attempted to
read the indicated file and a file I/O error was
returned.

User response: Check that the file exists in the
specified location. Check that the user ID used by the
installation program has access to all directories where
the package was extracted.

CIYBA0130E The solution package file : {0} does not
exist.

Explanation: The installation program tried to read
the indicated file and a file I/O error was returned.

User response: Check the permissions of the file
indicated in the message. Ensure the user ID used by
the installation program has permission to read the file.
Modify the file permissions if needed.

CIYBA0131E The installer failed to load the {0}
Topology file. File I/O message was {1}.

Explanation: The indicated error was returned when
attempting to import the specified topology file.

User response: Check that the indicated topology file
is in the correct directory. Check that the topology file
does not contain any invalid characters. Check that the
installation program can access the directory containing
the topology file.
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CIYBA0140E Unable to access required Transformer
or XSL files.

Explanation: The installation program attempted to
read a required Transformer or XSL files and was
unable to do so.

User response: Check that the location where the
installation package was extracted can be accessed by
the user ID used by the installation program. Make
sure the disk partition is not corrupt. Extract the
installation package again and retry the installation.

CIYBA0141E Unable to locate installation file {0}.

Explanation: The installation program attempted to
read the indicated file and a file I/O error was
returned.

User response: Check that the file exists in the
specified location. Check that the user ID used by the
installation program can access all directories
containing the extracted installation package.

CIYBA0142E Unable to write to installation file {0}.

Explanation: The installation program tried to write
the indicated file and a file I/O error was returned.

User response: Check that the user ID used by the
installation program has access to all directories
containing the extracted installation package. Check
that the disk partition is not corrupt and has not run
out of space.

CIYBA0143E The installation program failed to
process the Topology File.

Explanation: The installation program reads the
topology file and generates intermediate files
containing runtime values. The installation program
encountered an error while processing the topology file
and writing the intermediate files. File I/O errors are
the likely cause of this error.

User response: Check that the user ID used by the
installation program has access to all directories where
the installation package was extracted. Check that the
disk partition is not corrupt or out of space.

CIYBA0150E Unable to read the Topology
Specification file {0}.

Explanation: The installation program tried to read
the indicated file and a file I/O was returned.

User response: Check that the file exists in the
specified location. Check that the user ID being used by
the installation program has access to all directories
where the installation package was extracted.

CIYBA0160E The rule specification file was not
found in the {0} directory.

Explanation: The installation program tried to load
the rule-spec.xml file, which defines the precheck
rules, and was unable to do so.

User response: Check that the indicated directory
exists. Also make sure the directory can be accessed by
the user ID used by the installation program.

CIYBA0161E The rule name {0} is invalid.

Explanation: The installation program identified an
incorrect rule name in the rule-spec.xml file. This file
defines rules used by the precheck step.

User response: Check that the rule name is correct in
the rule-spec.xml file. Refer to an unchanged version
of the rule-spec.xml file for the correct rule name.

CIYBA0162E Installation prerequisite checking for
topology {0} discovered problems.

Explanation: The precheck step has failed with one or
more of the configuration targets failing to meet the
supported system requirements.

User response: Check that the planned topology
meets the minimum supported requirements.

CIYBA0163W The OS type of target server {0} is not
{1}.

Explanation: The precheck step has detected an
unsupported operating system on the indicated target
server.

User response: Make sure the operating system on the
target server meets the supported system requirements.

CIYBA0164W The {0} server was expected to have a
{1} bit OS.

Explanation: The precheck step has detected an
incorrect operating system on the target server.

User response: Check that the operating system type
on the target server meets the system requirements.

CIYBA0165W CPU of target server {0} is not a x86 or
s390 64bit CPU.

Explanation: The precheck step has detected an
unsupported CPU type for the indicated target server.

User response: Check that the CPU type for the target
server meets system requirements.
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CIYBA0166E Cannot connect to target server {0}.

Explanation: The installation program could not
connect to the remote server when running the
precheck step.

User response: Check connectivity between the
installation server and the target servers. Check the
precheck logs for other errors.

CIYBA0167E Cannot connect to server {0} because of
the wrong host name, account or
password was specified.

Explanation: The installation program failed when
running the precheck step. The installation program
was unable to connect to the target server.

User response: Check that the hostname is the correct
format and the login details are correct for the remote
server. Check the precheck logs for additional
information.

CIYBA0168E The {2} for servers {0} and {1} are not
synchronized.

Explanation: There is a {2} difference between {0} and
{1} servers.

User response: Check that the {2} is the same for all
{0} and {1} servers.

CIYBA0171I Installation prerequisite checking is
starting using instance {0}.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0172I Installation prerequisite check finished
successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0173I Installation prerequisite check finished
with {0} warnings and {1} errors:

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0176E The login information for server {0} is
incorrect. Verify the user id and
password for the server.

Explanation: The installation program precheck step
found incorrect login information for the target server.

User response: Check that the account details for the

server have the correct user ID and password.

CIYBA0177W Unable to connect to the remote server.
Waiting to retry.

Explanation: The installation program precheck step
failed to connect to the remote server. The connection
will be reattempted.

User response: No action is required. The installation
program will wait the amount of time specified in the
waiting.time property in the custom.properties file
and will then reattempt the connection.

CIYBA0178W Cannot connect to {0}, waiting {1}
milliseconds before next connection
attempt.

Explanation: There are connectivity issues in the
system.

User response: If multiple connection attempts fail,
contact the network administrator to resolve the
connectivity issues and retry the installation.

CIYBA0179E No value was provided for key {0} in the
topology properties file.

Explanation: The installation program precheck step
was unable to retrieve values for the hostname, user
name, or password from the properties file.

User response: Check that the hostname, user name,
and password are specified correctly in the properties
file.

CIYBA0180E The user ID entered for server {0} does
not have root privileges.

Explanation: The installation program precheck step
detected that the account used for the indicated server
does not have root privileges.

User response: Change the user ID used for the server
to one that has root privileges or add root privileges to
the user ID specified for the server.

CIYBA0183E Value {0} for key {1} in not valid, it
should be "EM64T" or "AMD64" or
"S390".

Explanation: The key value should be one of the
specified values.

User response: Correct the value and rerun the
installation.

CIYBA0184E Value {0} for key {1} is not a valid host
name

Explanation: The installation program precheck step
determined the value provided is not a valid hostname.
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User response: Check that the host name is the correct
format and has a correct value.

CIYBA0185E Install prerequisite check failed on rule
{0}

Explanation: The installation program precheck step
failed when checking the specified rule.

User response: Check the precheck logs for addition
messages. Correct the error and retry the installation.

CIYBA0187E SSH keystore "{0}" was specified, but
could not be accessed. Certificate-based
SSH protocol will be unavailable.
Details: {1}.

Explanation: The installation program precheck step
detected invalid data in the SSH keystore when
attempting to connect to the target server.

User response: Review the details in the message and
verify that the provided keystore has adequate entries.

CIYBA0190E The component {0} must appear before
component {1} in topology file.

Explanation: The topology file was incorrectly
changed. A prerequisite component appears after a
component that depends upon it.

User response: Change the topology file so the
components that have dependencies are after the
components they depend on.

CIYBA0191E There is a dependency between
component {0} and component {1} in the
Topology File. The components cannot
deployed in parallel.

Explanation: The components cannot be deployed in
parallel if there is a dependency between them. For
example, if component 2 is a prerequisite of component
1.

User response: Remove the components from the
parallel stanza of the topology file.

CIYBA0192E The property {1}.{2} has an invalid
reference value of {0} in the Topology
File.

Explanation: The reference value included in the
message is not valid for the indicated property.

User response: Use the ID field to find the property
definition and make sure all references to the property
have the correct value.

CIYBA0193E The component {0} has duplicate
connections {1} identified in the
Topology File.

Explanation: Duplicate connections for the component
are defined in the topology file.

User response: Remove the duplicate connection
information in the topology file and rerun the
installation program.

CIYBA0194E The property {0} is duplicated in
component {0}

Explanation: A duplicate property is defined for the
component.

User response: Remove the duplicate property for the
component in the property file.

CIYBA0195E The component {0} in the Topology file
has an invalid property {0}.

Explanation: The property specified was unexpected
for the indicated component. This could be caused by a
misspelled property or a property missing from the
property specification.

User response: Add the specified property to the
properties file or the topology. If the property was
misspelled, correct the misspelling. Correct the
topology file or specification properties file and restart
the installation.

CIYBA0196E The component {1} is missing property
{0}

Explanation: The component must have the indicated
property. The error could be caused by a misspelled
property or due to the property being missing from the
property specification file.

User response: Add the property to the specification
properties file or topology. If the error is due to a
misspelling, correct the misspelling. Restart the
installation.

CIYBA0197E Component {1} has an invalid
component type {0} specified.

Explanation: An invalid component type was
specified for the component.

User response: Check that the specification file for the
component contains the component type. Component
specification files are located in the
install_home/ioc16/spec/component subdirectory on
the installation server.
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CIYBA0198E The connection {0} is not valid for
component {1}

Explanation: The defined connection is not valid for
the component.

User response: Check the spelling of the connection in
the topology file for the component and make sure it is
not misspelled.

CIYBA0199E The {0} connection was missing from
component {1}.

Explanation: No connection is defined for the
indicated component.

User response: Check the component specification file
and make sure the connection information is included.

CIYBA0200E The connection information for {0} does
not exist.

Explanation: The connection ID is missing for the
indicated component.

User response: Check that the connection ID is
specified in the topology file. Check that the connection
ID is spelled correctly and refers to a stanza in the
topology file defining the associated component for the
connection ID.

CIYBA0201E Cannot connect to remote server {0}.

Explanation: The installation program found a
connectivity problem to the indicated server.

User response: Check that there are no connection
issues between the servers. Run the installation
program precheck step and resolve any connectivity
issues.

CIYBA0202E User name or password is invalid for
server {0}.

Explanation: The installation program found invalid
credentials for the indicated server.

User response: Check that the server credentials are
correct in the topology file.

CIYBA0203E File {0} does not exist.

Explanation: An attempt to load the properties file
returned an error.

User response: Check that the path to the properties
file is correct and that the file exists.

CIYBA0204E Cannot read or write file {0}.

Explanation: The installation program tried to load
the properties file and an error was returned.

User response: Check that the properties file path is
correct and the indicated file exists.

CIYBA0205E Cannot create directory {0} on {1}.

Explanation: The installation program was unable to
create a directory on the remote server.

User response: Check that there is enough space on
the remote server and that the user ID used by the
installation program has sufficient access rights and
adequate permissions to create a directory.

CIYBA0206E Fail to upload file {0} to remote directory
{1} on server {2}.

Explanation: The installation program was unable to
copy files to the indicated directory on the remote
server.

User response: Check that there is enough space on
the remote server and that the user ID used by the
installation program has sufficient access rights and
adequate permission to write files to the remote server.

CIYBA0207E No image defined for {0}.

Explanation: The installation program was unable to
retrieve image data for the properties file.

User response: Check that the properties file contains
an image field with the data component.

CIYBA0208E Fail to upload image of component {0} to
remote server {1}.

Explanation: The installation program was unable to
copy the image files to a directory on the remote server.

User response: Check that there is enough space on
the remote server and that the user ID used by the
installation program has sufficient access rights and
adequate permission to write to the directory on the
remote server. Also check that the remote directory
name is correct.

CIYBA0209I Host name : {0}.

Explanation: This message is for informational
purposes only.

User response: No action is required.
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CIYBA0210I OSType={0},OSBit={1},CPUArch={2}.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0211I Remote path : {0}.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0212I Local path : {0}.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0213E Fail to download file {0} from remote
server {1}.

Explanation: The installation program was unable to
copy the image files from a remote directory server to
the local server.

User response: Check that there is enough space on
the local server and that the user ID used by the
installation program has sufficient access rights and
adequate permissions to write to the directory. Also
check that the local and remote directory names are
correct.

CIYBA0214E Download file {0}.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0215I Command : {0}.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0216I Command exit code : {0}.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0217I Command output : {0}.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0218E Command failed with return code {0}.

Explanation: The command did not successfully
complete.

User response: Check the log files for further details.

CIYBA0219I Upload file {0}.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0220I Local image directory : {0}.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0221I Remote image directory : {0}.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0222E Remote image {0} already exists.

Explanation: The file already exists on the target
server. The installation process includes transferring
media to target servers. This message indicates the
required image has already been transferred.

User response: This message indicates that media
from a previous installation attempt still exists on the
target servers. If the user intended to start a new
installation, the media should be deleted so that it can
be uploaded again.

CIYBA0223E Cannot launch command on server {0}.

Explanation: The installation program could not run
the IOC command from the remote server to the local
server.

User response: Check the connection between the
local server and the remote server. Check that the user
ID used by the installation program has sufficient
access rights and adequate permission to run the
command.

CIYBA0224E Get backup files from folder {0} on
server {1}.

Explanation: This message is for informational
purposes only.

User response: No action is required.
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CIYBA0225E Failed to get backup files from folder {0}
on server {1}.

Explanation: The installation program was unable to
retrieve files from a remote backup folder to a local
folder.

User response: Check the connection between the
local and remote servers. Check that the user ID used
by the installation program has sufficient access rights
and adequate permission to access the folders.

CIYBA0226E No backup folder {0} exists on server {1}.

Explanation: The installation program was unable to
retrieve files from a remote backup folder to a local
folder.

User response: Check that the remote directory and
folder exists.

CIYBA0227E Value must be provided for ID and path
attributes.

Explanation: The installation was unable to identify
the component ID and path attribute.

User response: Check that the component ID and path
arguments are provided within the task arguments.

CIYBA0228I Exec command: {0}.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0229E Insufficient disk space in target
directory {0}.

Explanation: The installation program did not find
enough space in the target directory.

User response: Check that the indicated directory has
enough allocated space and can be accessed by the user
ID used by the installation program.

CIYBA0230I IBM Intelligent Operations Center
Command Line Version: {0}

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0231I Import topology "{0}" successful.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0232E Topology name "{0}" was not found
under the ../topology folder.

Explanation: The installation program was unable to
find the indicated topology in the ../topology folder.

User response: Check that the topology file exists in
the ../topology folder and that it is in a valid XML
format.

CIYBA0233I Current topology is "{0}".

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0234E ANT_HOME is not set or set incorrectly.

Explanation: The installation program encountered a
problem in the ANT_HOME environment variable.

User response: Check that the ANT_HOME variable is set
to a valid ANT version.

CIYBA0237E Component ID "{0}" is invalid.

Explanation: The installation program found an
incorrect component ID in the topology file.

User response: Check that the component ID exists
and is named correctly in the topology file.

CIYBA0238E Action "{0}" for component ID "{1}" is
invalid.

Explanation: The indicated action is incorrect for the
current component in the topology file.

User response: Check the topology file and make sure
the defined action is suitable for the component.

CIYBA0239E If you want more detailed operation
messages, please check {0}.

Explanation: The command did not successfully
complete.

User response: Check the log file indicated by {0} for
actions to be taken.

CIYBA0240I Command completed successfully or
completed successfully with warnings.

Explanation: This message is for informational
purposes only.

User response: No action is required.
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CIYBA0241E Command failed :

Explanation: The displayed command failed.

User response: The action to be taken will depend on
the command that failed. Review the command and the
logs to determine the cause of the failure.

CIYBA0242E Please remove the ".xml" from parameter
"{0}".

Explanation: The parameter shown includes the file
extension .xml.

User response: XML filename parameters should not
include the .xml extension. Remove .xml from the
parameter and retry the command.

CIYBA0243E IOP_CIPHER_ALG or
IOP_CIPHER_KEYSIZE environment
variables are incorrectly set. Set to
appropriate JCE-compliant values.

Explanation: The installation program was unable to
identify a correct value for the cipher used in the
encryption.

User response: Check that the CIPHER_ALG and
IOP_CIPHER_KEYSIZE environment values are correctly
set.

CIYBA0244E "{0}" is not a valid parameter.

Explanation: The indicated parameter is not a valid
parameter.

User response: Remove or correct the parameter and
retry the command.

CIYBA0245E "-{0}" miss parameter.

Explanation: The indicated parameter is required but
missing from the command.

User response: Rerun the command with the missing
parameter.

CIYBA0249I Prepare operation scripts.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0250I Operation complete.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0251I Operation sequence started.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0252I Operation sequence finished.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0253I Upload component [{0}] images to host
[{1}]

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0254I Install component [{0}] on host [{1}]

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0255I Uninstall component [{0}] on host [{1}]

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0256I Start component [{0}] on host [{1}]

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0257I Stop component [{0}] on host [{1}]

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0258I Propagate component [{0}] on host [{1}]

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0261I {0} tasks are running

Explanation: This message is for informational
purposes only.

User response: No action is required.
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CIYBA0262I The total {0} tasks will be performed

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0263I Backup component [{0}] on host [{1}]

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYBA0264E Cannot load log configuration file {0}.

Explanation: The logging function cannot find the
property file containing the logging configuration
parameters.

User response: Check that installation package was
fully extracted and that it is located on a file system
accessible to the user ID running the installation
program.

CIYBA0265E Can not create file handler for log.

Explanation: The logging function attempted to open
a file using a system file handle and was unable to do
so.

User response: Have the system administrator check
the number of file handles available to the system.
Ensure the file system where the installation package
was extracted is not corrupt.

CIYBA0266E The required RPM package {0} is not
installed on the {1} server.

Explanation: The indicated RPM package is not
installed on the server.

User response: Install the supported RPM package on
the server.

CIYBA0267E The {1} server does not have enough
disk space. {0} disk space is required.

Explanation: The server does not have enough disk
space or the server does not meet the system
requirements for disk space.

User response: Delete files to make space available on
the server so the minimum space requirements are met.

CIYBA0268E The {1} server does not have enough
memory. {0} GB of memory is required.

Explanation: There is not enough RAM on the
indicated server. The server does not meet system
requirements for minimum RAM.

User response: Add RAM to the server.

CIYBA0269I The {0} directory cannot be created on
server {1}. The directory already exists.

Explanation: The specified directory already exists on
the server.

User response: Remove the directory on the server.

CIYBA0270I The tcp ip port {0} is in already in use
on server {1}. This is a required port and
must be available prior to installation.

Explanation: The program or process is already
configured to use a required TCP/IP port on the server.

User response: Reconfigure the server so the required
port is available. Rerun the installation.

CIYBA0271E Server {1} does not have the expected
fully-qualified Host Name, or short
Host Name, or default Host Name. The
expected FQH is {0}.

Explanation: The server does not have the expected
fully qualified host name.

User response: If using the IBM Installation Manager
installation, enter the fully qualified hostname for the
server. If using the step-by-step installation, enter the
fully qualified host name in the SERVERS section of the
topology Properties file. Correct the server listed in the
error message.

CIYBA0272E The network connection from server {1}
to server {0} is broken.

Explanation: There is no network connectivity
between the two indicated servers.

User response: Check the connectivity between the
servers. If the problem persists, contact the system
network administrator.

CIYBA0273I Server {0} is running SELinux which is
unsupported.

Explanation: SELinux is not supported by IBM
Intelligent Operations Center.

User response: Install a supported Linux version.

CIYBA0274E An active firewall was detected on
server {0}. All firewalls must be disabled
prior to installation.

Explanation: The server has an active firewall.

User response: Disable the firewall on the server
during the installation process.
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CIYBA0275I Unable to find a DNS entry for server
{0}. DNS lookup by IP or Host Name
failed.

Explanation: The server is either not configured
correctly in the DNS, or the DNS is not functioning
properly. The DNS lookup command failed for the
server by IP address and by host name.

User response: Contact the system network
administrator for the server and correct the DNS entry
of DNS

CIYBA0276E Server {1} has a system setting that does
not meet installation requirements. See
previous message for details.

Explanation: The system setting for the maximum
number of open files does not meet installation
requirements.

User response: The ulimit setting needs to be
modified to the indicated value.

CIYBA0277I The Linux release found does not meet
installation requirements. The expected
release is {0}.

Explanation: The Linux installed on the indicated
server is not supported.

User response: Install a supported Linux version.

CIYBA0278I The Linux distribution found does not
meet requirements. The expected
distribution is {0}

Explanation: The Linux installed is not supported.

User response: Install a supported Linux distribution.

CIYBA0279E WebSphere Application Server profile
{0} is not started or account or password
is invalid on server {4}.

Explanation: The WebSphere Application Server
profile is not started or an attempt was made to start it
with invalid credentials.

User response: Start the WebSphere Application
Server profile using a correct user ID and password.

CIYBA0281E Server {0} does not have IPv6 enabled.
Enable IPv6 on the server before
installation.

Explanation: The indicated server does not have IPv6
configured.

User response: Enable IPv6 on the indicated server.

CIYBA0282E Some of the files located in the {0}
directory on the media server are
corrupt.

Explanation: All installation files have MD5
checksums that need to be verified prior to installation.
The MD5 checksum on some files located in the
indicated directory do not have valid MD5 checksums.

User response: Extract the installation package again,
or recopy the files to the directory.

CIYBA0283E SSH on server {0} is not configured
correctly. Password authentication using
SSH is needed but not configured on
server.

Explanation: The SSH configuration on the indicated
server is incorrect.

User response: Reconfigure the /etc/ssh/sshd_config
file as follows:

v Remove all AllowUsers and AllowGroups statements.

v Specify YES for PermitRootLogin.

v Specify YES for Password Authentication.

These changes will allow only root users to access the
server using SSH with password authentication.

CIYBA0284E {0} was found to be a symbolic [soft]
link. Symbolic links are not permitted.

Explanation: Symbolic or soft links to files or
directories are not supported.

User response: Remove symbolic links and provide
the direct path or file name.

CIYBA0285E Tivoli Directory Server instance {0} is
not started on server {1}.

Explanation: The indicated Tivoli Directory Server
instance needs to be started.

User response: Start the Tivoli Directory Server.

CIYBA0286E IBM DB2 instance {0} is not started on
server {1}.

Explanation: The indicated DB2 instance is not
started.

User response: Start the DB2 instance.

CIYBA0287E WebSphere Application Server {1} on
profile {0} is not started on server {2}.

Explanation: The indicated WebSphere Application
Server profile is not started on the indicated server.

User response: Start the WebSphere Application
Server profile.
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CIYBA0288E Server {0} does not have "localhost"
mapped to 127.0.0.1.

Explanation: In the host file for each server the
localhost entry must be mapped to 127.0.0.1.

User response: Update the host file on the server to
map the localhost value to 127.0.0.1.

CIYBA0289I The {1} server does not have the
required number of CPUs. The required
number of CPUs for this machine is {0}.

Explanation: The server does not have enough CPU
resources to meet requirements.

User response: Add CPU resources to the indicated
server.

CIYBA0301E A button was clicked to run a test but
no matching properties were found in
the properties file.

Explanation: The properties for the test were not
found in the properties file.

User response: Click Reset. This will cause the
program to read the current properties file in case
changes were made. Retry the test.

CIYBA0302E Every test must have certain properties.
The class property is one of them.
Parameters: {0}: class name {1}: method
name {2}: sequence number

Explanation: Test definition is missing the class
property.

User response: Search for the sequence number in the
properties file. Add a class property for the test. This is
the class name of the test. This is usually the class
name of the remote execution agent (the code that
forwards the test request to IopCatRemoteResponder for
execution.

For example:
0070.classname=com.ibm.iop.cat.fw.remote.IopCatRemoter

CIYBA0303E Every test must have certain properties.
The display label property is one of
them. Parameters: {0}: class name {1}:
method name {2}: sequence number

Explanation: Test definition is missing the display
label.

User response: Search for the sequence number in the
properties file. Add a displaylabel property for the
test. This is the text that will be displayed on the
button.

CIYBA0304E A button was clicked to run a test but
no matching test was found in the
properties file.

Explanation: The currently loaded properties file does
not define the requested test.

User response: Click Reset. The current properties file
will be reloaded.

CIYBA0305E A button was clicked to run a test but
no configuration information can be
found for the test.

Explanation: Configuration information is not
available for the test.

User response: Click Reset. The current properties file
will be reloaded.

CIYBA0306E The code specified by the class could
not be found. Parameter:{0}: class name
(not found)

Explanation: Either the classname was not specified
correctly in the properties file or the code was not
found.

User response: Check the shared libraries for the
IopCatRemoteResponder application to see if one or
more shared libraries are missing or not specified.

CIYBA0307E Common variables apply to all tests.
The name, class or debug variables
cannot be set using common.
Parameters: {0}: class name {1}: method
name {2}: property key string

Explanation: Common was used to set name, class, or
debug.

User response: Search for the key and remove the
offending line. For example, common.name used to name
all tests with the same name.

CIYBA0308E An exception occurred in class {0},
method {1}. Details {2}

Explanation: An exception occurred.

User response: Examine the exception string to
determine why the test failed. This may be a normal
test failure. For example, "Connection refused" usually
means no program was listening on a given port so the
service is not running.

CIYBA0309E {0}.{1}() - Test[{2}] - Exception: {3}

Explanation: A runtime exception occurred in the
indicated test.

User response: Review the error message for details.
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CIYBA0310E An unexpected Exception occurred while
running this test.

Explanation: An unexpected exception occurred.

User response: Review other exceptions for additional
details.

CIYBA0312I The Web test received the expected
HTTP response code (either in the range
200-299 or specified by the property
expectedRcode). Parameters: {0}: class
name

Explanation: Indicates the test was successful.

User response: No action is required.

CIYBA0313E The Web test did not receive the
expected HTTP response code (either in
the range 200-299 or specified by the
property expectedRcode). Parameters:
{0}: class name {1}: HTTP response code

Explanation: An unexpected HTTP response code was
received.

User response: Check the URL specified by the
hosturl property either with a browser or the wget
command.

CIYBA0314I Test response code: {0} Response text: {1}
Details: {2}.

Explanation: This message returns the test response as
a string.

User response: No action is required.

CIYBA0315E All tests must have properties. No
properties were passed into this test.

Explanation: Properties were missing from the test
invocation.

User response: This message should not occur since
properties are passed by the framework. Contact IBM
Software Support.

CIYBA0320E An expected string was not found in
output text ''{1}''. Class name {0}

Explanation: The SSH tests login to the server, runs
the commands, and checks for an expected string in the
output from the commands. No expected string was
specified in the properties for this test.

User response: Check the expected key for the test.
Add or modify the property to specify a string
expected to be contained in the output for the
commands specified in the commmands property.

CIYBA0322E Expected string not found in output text
''{1}''. Class name {0}

Explanation: The SSH tests log on to the server, runs
the commands, and checks for an expected string in the
output from the commands. The expected string was
not found in the output.

User response: Check the expected key for the test
and the output text. This could indicate the test failed.
If the output text contains "keyboard interactive not
allowed" it could mean that the user ID or password
used to log on to the remote server is incorrect. Check
the user, password, and hostname properties for the test.
The password is an alias to a password in the keystore.

CIYBA0323E Unexpected exception ''{1}''. Class name
{0}

Explanation: An unexpected exception occurred.

User response: If the output text contains "keyboard
interactive not allowed" it could mean that the user ID
or password used to log on to the remote server is
incorrect. Check the user, password, and hostname
properties for the test. The password is an alias to a
password in the keystore.

CIYBA0340E The test execution agent
(IopCatRemoteResponder) was unable
to parse the input JSON data.
Parameters: {0}: class name {1}: method
name {2}: post data

Explanation: The user interface and test execution
agent communicate using JSON. This error means the
test execution agent (IopCatRemoteResponder) was
unable to parse the input JSON data.

User response: Examine the post data to see if it is in
the correct JSON format.

CIYBA0341E An exception was encountered while
running the test. Parameters: {0}: class
name {1}: method name {2}: exception
string

Explanation: An exception was encountered while
running the test.

User response: Check the exception string to
determine why the test failed. This might be a normal
test failure. For example, "Connection refused" usually
means no program was listening on the port so the
service is not running.

CIYBA0342E The test execution agent
(IopCatRemoteResponder) was unable
to send a reply back to the user
interface. Parameters: {0}: class name {1}:
method name {2}: exception string

Explanation: The user interface and test execution
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agent communicate using JSON. This error means the
test execution agent (IopCatRemoteResponder) was
unable to send a reply back to the user interface.

User response: Check the exception string to
determine why the reply could not be sent. This could
occur if the test took too long and the user interface is
no longer waiting.

CIYBA0343E An expected Key prefix is missing.
Parameters: {0}: class name {1}: method
name {2}: property key string

Explanation: All properties for a given test are
prefixed by the same number. This provides the
grouping since properties files are not positional.

User response: Search for the key in the properties file
and add the appropriate prefix. For example, the
following is incorrect:
classname = com.ibm.iop.cat.fw.remote.IopCatRemoter
0050.rhosturl = https://${APP_HOSTNAME_1}:9443/IopCatRemoteResponder/IopCatRemoteResponder
0050.remoteclassname= com.ibm.iop.cat.fw.Echo
0050.displaylabel = Internal Diagnostic (Echo REST remoted)
0050.comment = Self diagnostic CAT check. Tests link between to CAT modules.
0050.failinfopage = cct_echo_rest_remoted_test.html

Should be:
0050.classname = com.ibm.iop.cat.fw.remote.IopCatRemoter
0050.rhosturl = https://${APP_HOSTNAME_1}:9443/IopCatRemoteResponder/IopCatRemoteResponder
0050.remoteclassname= com.ibm.iop.cat.fw.Echo
0050.displaylabel = Internal Diagnostic (Echo REST remoted)
0050.comment = Self diagnostic CAT check. Tests link between to CAT modules.
0050.failinfopage = cct_echo_rest_remoted_test.html

CIYBA0345E Invalid Key - The key prefix is not
numeric. Parameters: {0}: class name {1}:
method name {2}: sequence number

Explanation: Every test must have a numeric prefix
grouping all of the properties for a given test. The
prefix given is not numeric.

User response: Search for the sequence number in the
properties file. Change the prefix to be numeric and use
that same prefix for the rest of the properties for the
test.

CIYBA0347E An Exception has occurred. Parameters:
{0}: class name {1}: method name {2}:
exception string

Explanation: An exception has occurred.

User response: Examine the exception string to
determine why the test failed. This might be a normal
test failure. For example, "Connection refused" usually
means no program was listening on the port so the
service is not running.

CIYBA0348E A button was clicked to run a test but
no matching properties were found in
the properties file.

Explanation: No properties were found for the test.
The properties file might have been changed.

User response: Click Reset. The current properties file
will be reloaded.

CIYBA0349E The code specified by the class could
not be found. Parameter: {0}: class name
(not found)

Explanation: Either the classname is not correctly
specified in the properties file or the code was not
found.

User response: Check the shared libraries for the
IopCatRemoteResponder to see if one or more shared
libraries are missing.

CIYBA0401E The platform control tool properties
template file name was not specified or
was incorrect.

Explanation: The parameter for the platform control
tool properties template file is missing.

User response: Enter the correct name for the
platform control tool properties file.

CIYBA0402E The IBM Intelligent Operations Center
topology properties file name was not
specified or was incorrect.

Explanation: The parameter for the IBM Intelligent
Operations Center topology properties file is missing or
incorrect.

User response: Enter the correct name for the IBM
Intelligent Operations Center topology properties file.

CIYBA0403E The platform control tool properties
template file name was not specified or
was incorrect.

Explanation: The parameter specifying the platform
control tool properties template file is missing.

User response: Enter the correct file name for the
platform control tool topology properties file.

CIYBA0404E The IBM Intelligent Operations Center
topology properties file cannot be
found.

Explanation: The IBM Intelligent Operations Center
topology properties file cannot be found.

User response: Check that the IBM Intelligent
Operations Center topology properties file is located in
the install_home/ioc16/topology directory on the
installation server.

CIYBA0405E Missing password in the Topology File
for property:

Explanation: A password was not found in the
indicated topology properties file.

User response: A password for the topology file is
required. Enter a password for the topology.
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CIYRS0000E An error occurred while creating the
system property {0}.

Explanation: The system property with name {0} was
not created because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0000I The system property {0} was created.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0001E An error occurred while updating the
system property {0}.

Explanation: The system property with name {0} was
not updated because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0001I The system property {0} was updated.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0002E An error occurred while deleting the
system property {0}.

Explanation: The system property with name {0} was
not deleted because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0002I The system property {0} was deleted.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0003E An error occurred while creating the
pane {0}.

Explanation: The filter panel REST service was not
able to complete the insert request because of an
internal SQL exception.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0003I The pane {0} was created.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0004E An error occurred while updating the
pane {0}.

Explanation: The filter panel REST service was not
able to complete the update request. A possible reason
is that a concurrent update request is in progress.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0004I The pane {0} was updated.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0005E An error occurred while deleting the
pane {0}.

Explanation: The filter panel REST service was not
able to complete the delete request because of an
internal SQL exception.
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User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0005I The pane {0} was deleted.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0006I The Date & Time pane was saved.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0007E An error occurred while deleting data
source {0}.

Explanation: The specified data source was not
deleted because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

CIYRS0007I The data source {0} is deleted.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0008E An error occurred while saving data
source {0}.

Explanation: The specified data source was not saved
because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

CIYRS0008I The data source {0} is saved.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0009E An error occurred while saving
translated text for data source {0}.

Explanation: The translated text that you entered for
the specified data source was not saved because an
error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

CIYRS0010E No properties were found for data
source {0}.

Explanation: No properties were found in the
specified data source.

User response: Verify that all the values you provided
for your data source are correct. If you created a
customized receiver, check for receiver issues. Refresh
the browser window and try again. If the problem
persists, contact an administrator who can ensure that
the data server is running and correctly configured. If
the error still recurs, contact IBM support.

CIYRS0011E You cannot edit standard operating
procedures that are not in draft status.

Explanation: You tried to edit a standard operating
procedure definition that is not in draft status. If you
want to edit a standard operating procedure definition,
you must first create a draft version.

User response: Create a draft version of the standard
operating procedure definition that you want to edit.
For more information about creating drafts, see the link
at the end of the topic.

Related tasks:

“Working with drafts and approvals” on page 139
When you create a standard operating procedure
definition, a draft version is saved initially. When you
submit a draft version for approval, a version of the
standard operating procedure definition is saved,
where the version name is the approval time stamp
value. You can create another draft that is based on an
approved version.

CIYRS0012E A transitional update cannot be
requested.

Explanation: The data server cannot process the
update to the standard operating procedure definition
because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

CIYRS0005I • CIYRS0012E

416 IBM Intelligent Operations Center: IBM Intelligent Operations Center Product Documentation



“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0013E You are not authorized to create
standard operating procedures.

Explanation: Only authorized standard operating
procedure authors and administrators can configure
standard operating procedure definitions. Authorized
standard operating procedure authors are listed in the
SopAuthorRoles system property. Authorized standard
operating procedure administrators are listed in the
SopAdminRoles system property.

User response: Ask an authorized standard operating
procedure author or administrator to create the
standard operating procedure definition for you.
Alternatively, ask an administrator to add you to the
list of authorized standard operating procedure
authors. For more information about roles that relate to
the creation and administration of standard operating
procedures, see the link at the end of the topic.

Related concepts:

“Defining standard operating procedure roles” on page
97
The standard operating procedure component obtains
the current authentication credentials to determine
what actions each user is authorized to do. Each user is
authorized to do standard operating procedure actions
that are based on the LDAP Roles that the user is
assigned to, and must match the distinguished name
(DN) that is used in association with the standard
operating procedure objects.

CIYRS0014E A transitional standard operating
procedure definition exists for the
current user.

Explanation: You have previously created a draft
version of the selected standard operating procedure
definition that has not been committed.

User response: Either commit, or delete, the draft
version of the selected standard operating procedure
definition that you created previously.

CIYRS0015E The selected standard operating
procedure definition is not in draft
status.

Explanation: The change cannot be made to the
standard operating procedure definition because the
definition is not in draft status.

User response: Create a draft version of the standard
operating procedure definition before you attempt to
change it.

Related tasks:

“Working with drafts and approvals” on page 139
When you create a standard operating procedure
definition, a draft version is saved initially. When you
submit a draft version for approval, a version of the
standard operating procedure definition is saved,
where the version name is the approval time stamp
value. You can create another draft that is based on an
approved version.

CIYRS0016E A draft version could not be created
because an approval request is pending.

Explanation: You cannot create a draft version of a
standard operating procedure definition if a draft exists
that has been submitted for approval.

User response: Either discard the draft, or wait for the
current draft to be approved, before you create another
draft version of the standard operating procedure
definition. For more information about working with
drafts and approvals, see the link at the end of the
topic.

Related tasks:

“Working with drafts and approvals” on page 139
When you create a standard operating procedure
definition, a draft version is saved initially. When you
submit a draft version for approval, a version of the
standard operating procedure definition is saved,
where the version name is the approval time stamp
value. You can create another draft that is based on an
approved version.

CIYRS0017E The reference could not be found.

Explanation: The reference that is included in the
standard operating procedure definition cannot be
found. A possible reason is that it has been deleted
from the reference library.

User response: Check whether the reference is in the
library. If necessary, do one or more of the following
options:

v Add a new reference to the library.

v Edit the reference in the standard operating
procedure definition.

v Edit the reference in the standard operating
procedure instance.

CIYRS0018E You cannot edit shared references.

Explanation: Only users who are listed in the
ReferenceLibrarianRoles system property can edit
shared references. Users who are listed in the
SopAdminRoles system property and the SopAuthorRoles
system property can edit and delete only references
that they have created.

User response: Ask an authorized reference librarian
to edit a shared reference for you.

Related concepts:
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“Defining standard operating procedure roles” on page
97
The standard operating procedure component obtains
the current authentication credentials to determine
what actions each user is authorized to do. Each user is
authorized to do standard operating procedure actions
that are based on the LDAP Roles that the user is
assigned to, and must match the distinguished name
(DN) that is used in association with the standard
operating procedure objects.

CIYRS0019E The standard operating procedure
definition is not editable.

Explanation: You cannot edit the standard operating
procedure definition because it is not in draft status.
Another administrator might have created a draft
version of the standard operating procedure definition.

User response: Check whether a draft version that is
owned by another administrator exists. If a draft
version exists, ensure that it is either committed, or
deleted, before you create another draft version.

Related tasks:

“Working with drafts and approvals” on page 139
When you create a standard operating procedure
definition, a draft version is saved initially. When you
submit a draft version for approval, a version of the
standard operating procedure definition is saved,
where the version name is the approval time stamp
value. You can create another draft that is based on an
approved version.

CIYRS0020E The item could not be found.

Explanation: The data item that is referenced by the
standard operating procedure could not be found.

User response: Check the ID of the data item.

CIYRS0021E No recipients were specified.

Explanation: You must specify at least one recipient
email address for the notification.

User response: Enter one or more recipient email
addresses for the notification.

CIYRS0022E No valid notification requests were
provided.

Explanation: The format of the content that is
included in the notification template is incorrect.

User response: Check and correct the format of the
content that is included in the notification template.

CIYRS0023E No standard operating procedure
definitions that match the filter criteria
could be found.

Explanation: No standard operating procedure
definitions match the filter criteria that you specified in
your request.

User response: Check and amend the filter criteria in
your request.

CIYRS0024E An internal processing error occurred.

Explanation: An internal processing error occurred
that prevented the request from being processed.

User response: Review the log files. For further
assistance, contact IBM Support.

Related concepts:

“Enabling traces and viewing log files” on page 395
To troubleshoot a problem in IBM Intelligent
Operations Center, you might need to analyze log files
in several systems.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0025E The imported XML file is invalid.

Explanation: The imported XML file could not be read
because it contains invalid XML.

User response: Check the XML file and ensure that it
contains valid XML, then import the XML file again.

CIYRS0026E The format of the input data is invalid.

Explanation: The request to the REST service
contained data that is formatted incorrectly.

User response: Check the format of the data in the
request and try again.

CIYRS0027E A communication error occurred while
processing the client request.

Explanation: The data in the request could not be read
because of a communication error.

User response: Review the log files. For further
assistance, contact IBM Support.

CIYRS0028E Invalid automation details were
provided.

Explanation: Insufficient details were specified for an
automation activity.

User response: For information about automation
activities, see the link at the end of the topic to the IBM
SmartCloud Control Desk 7.5.1 product documentation.
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For help with resolving problems that are related to
automated activities, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

Related information:

IBM SmartCloud Control Desk Version 7.5.1
product documentation

CIYRS0029E No automation key is available.

Explanation: An automation key is not available for
an automation activity.

User response: For information about automation
activities, see the link at the end of the topic to the IBM
SmartCloud Control Desk 7.5.1 product documentation.
For help with resolving problems that are related to
automated activities, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

Related information:

IBM SmartCloud Control Desk Version 7.5.1
product documentation

CIYRS0030E The automated activity could not be
started.

Explanation: The automated activity could not be
started.

User response: For information about automation
activities, see the link at the end of the topic to the IBM
SmartCloud Control Desk 7.5.1 product documentation.
For help with resolving problems that are related to
automated activities, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

Related information:

IBM SmartCloud Control Desk Version 7.5.1
product documentation

CIYRS0031E The automated activity could not be
stopped.

Explanation: The automated activity, which was
completed, could not be stopped.

User response: For information about automation
activities, see the link at the end of the topic to the IBM
SmartCloud Control Desk 7.5.1 product documentation.

For help with resolving problems that are related to
automated activities, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

Related information:

IBM SmartCloud Control Desk Version 7.5.1
product documentation

CIYRS0032E An unsolicited response that could not
be processed was received from the
automation engine.

Explanation: An unsolicited response that could not
be processed was received from the automation engine.

User response: For information about automation
activities, see the link at the end of the topic to the IBM
SmartCloud Control Desk 7.5.1 product documentation.
For help with resolving problems that are related to
automated activities, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

Related information:

IBM SmartCloud Control Desk Version 7.5.1
product documentation

CIYRS0033E An automation with handle ID {0} was
not found.

Explanation: An automated work order that an
automation activity attempted to initiate, and that has
the handle ID {0}, was not found.

User response: For information about automation
activities, see the link at the end of the topic to the IBM
SmartCloud Control Desk 7.5.1 product documentation.
For help with resolving problems that are related to
automated activities, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

Related information:

IBM SmartCloud Control Desk Version 7.5.1
product documentation

CIYRS0034E The automation engine returned error
{0}.

Explanation: A problem that is related to an
automation activity occurred in the automation engine,
as indicated by the error code {0}.
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User response: For information about automation
activities, see the link at the end of the topic to the IBM
SmartCloud Control Desk 7.5.1 product documentation.
For help with resolving problems that are related to
automated activities, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

Related information:

IBM SmartCloud Control Desk Version 7.5.1
product documentation

CIYRS0035E The activity is not an automated activity.

Explanation: An automation ID was requested for an
activity that is not an automation activity.

User response: Verify that an activity is an automation
activity before you request an automation ID for the
activity.

CIYRS0036I {0} standard operating procedures were
imported.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0037E The activity type definitions that are on
the import target system are not
consistent with the activity type
definitions that are on the import source
system.

Explanation: The activity types that are specified on
the source system do not match the activity types that
are specified on the target system.

User response: Before you import standard operating
procedure definitions, ensure that the same types of
activities are specified on both the source system and
the target system.

CIYRS0038E You cannot delete required activities.

Explanation: For an instance of a standard operating
procedure that has been launched, you cannot delete
activities that have been indicated as required in the
definition of the standard operating procedure.

User response: You must complete activities that have
been indicated as required in the definition of the
standard operating procedure.

CIYRS0039E You cannot edit completed or skipped
activities.

Explanation: The activity that you are trying to edit
has already been either completed, or skipped.

User response: None.

CIYRS0041E You cannot delete a standard operating
procedure definition where instances
exist that have been created based on
the standard operating procedure
definition.

Explanation: Active instances exist for the standard
operating procedure definition that you are trying to
delete. You cannot delete a standard operating
procedure definition for which there are active
instances.

User response: Wait for the status of all the active
instances of the selected standard operating procedure
definition to be completed before you attempt to delete
the definition. For information about viewing the status
of the instances of a standard operating procedure, see
the link at the end of the topic.

Related tasks:

“Viewing and editing definitions” on page 140
Use the following procedure to view and edit standard
operating procedure definitions.

CIYRS0042E You can stop only standard operating
procedures that have been started.

Explanation: You attempted to stop an instance of a
standard operating procedure that is not started.

User response: Review the status of an instance of a
standard operating procedure in either the Solution
Administration view, or by using the standard
operating procedure REST interface.

Related tasks:

“Viewing and editing instances of a standard operating
procedure” on page 141
For a standard operating procedure definition, you can
review the instances of the standard operating
procedure that have been launched. You can view an
instance in the Standard Operating Procedure Details
window, where you can edit an instance, or change the
status of an instance.

CIYRS0043E You can start only standard operating
procedures that are stopped.

Explanation: You attempted to start an instance of a
standard operating procedure that is not stopped.

User response: Review the status of an instance of a
standard operating procedure in either the Solution
Administration view, or by using the standard
operating procedure REST interface.
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Related tasks:

“Viewing and editing instances of a standard operating
procedure” on page 141
For a standard operating procedure definition, you can
review the instances of the standard operating
procedure that have been launched. You can view an
instance in the Standard Operating Procedure Details
window, where you can edit an instance, or change the
status of an instance.

CIYRS0044E If you select a duration unit other than
"None", you must specify a valid
duration value.

Explanation: You selected a duration unit other than
None but you did not enter a value for the duration of
the activity.

User response: In the Duration field, enter a
numerical value for the duration of the activity.

CIYRS0045E You must enter a value for "Name".

Explanation: You did not enter a value for the name
of the standard operating procedure definition.

User response: In the Name field, enter a name for
the standard operating procedure definition.

CIYRS0046E The following fields exceed their
maximum length.

Explanation: The fields that are indicated contain data
that exceeds the maximum length.

User response: Ensure that the data in each field does
not exceed the maximum field length that is indicated
in the following table:

Field Maximum length

NAME 128

DESCRIPTION 1024

COMMENT 1024

PROPERTY 64

CRITERIA 512

URI 2083

STATUS 256

CIYRS0047E An error occurred while importing
standard operating procedures: {0}.

Explanation: The standard operating procedure
definitions that are indicated in {0} could not be
imported from the XML file that you imported.

User response: In the XML file that you are importing,
check the format of the standard operating procedure

definitions that are indicated in {0}. Review the log files
for more details.

Related concepts:

“Enabling traces and viewing log files” on page 395
To troubleshoot a problem in IBM Intelligent
Operations Center, you might need to analyze log files
in several systems.

CIYRS0048E An error occurred while starting the
automation. The automation engine
reported the following error: {0}.

Explanation: The automation activity could not be
started because the error that is indicated in {0}
occurred in the automation engine.

User response: For information about automation
activities, see the link at the end of the topic to the IBM
SmartCloud Control Desk 7.5.1 product documentation.
For help with resolving problems that are related to
automated activities, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

Related information:

IBM SmartCloud Control Desk Version 7.5.1
product documentation

CIYRS0049E You are not authorized to delete
instances of standard operating
procedures that are associated with this
standard operating procedure definition.

Explanation: Only authorized standard operating
procedure administrators and users who have been
granted write access in the standard operating
procedure definition can delete instances of standard
operating procedures. Authorized standard operating
procedure administrators are listed in the
SopAdminRoles system property.

User response: Ask either an authorized standard
operating procedure administrator or a user who has
been granted write access in the standard operating
procedure definition to delete the instance of the
standard operating procedure for you. For more
information about roles that relate to the administration
of standard operating procedures, see the link at the
end of the topic.

Related concepts:
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“Defining standard operating procedure roles” on page
97
The standard operating procedure component obtains
the current authentication credentials to determine
what actions each user is authorized to do. Each user is
authorized to do standard operating procedure actions
that are based on the LDAP Roles that the user is
assigned to, and must match the distinguished name
(DN) that is used in association with the standard
operating procedure objects.

Related tasks:

“Configuring standard operating procedure definitions”
on page 136
When you define a standard operating procedure, you
define activities that are included in the standard
operating procedure. You can specify the order in
which some or all of the activities in a standard
operating procedure are executed. For example, you
can specify that a particular activity is not started until
the previous activity is completed or skipped. You also
assign owners and monitors to the standard operating
procedure.

CIYRS0050E You are not authorized to update either
the standard operating procedure, or the
activity.

Explanation: Only authorized standard operating
procedure administrators and users who have been
granted write access in the standard operating
procedure definition can update instances of standard
operating procedures and associated activities.
Authorized standard operating procedure
administrators are listed in the SopAdminRoles system
property.

User response: Ask either an authorized standard
operating procedure administrator or a user who has
been granted write access in the standard operating
procedure definition to remove the instance of the
standard operating procedure for you. For more
information about roles that relate to the administration
of standard operating procedures, see the link at the
end of the topic.

Related concepts:

“Defining standard operating procedure roles” on page
97
The standard operating procedure component obtains
the current authentication credentials to determine
what actions each user is authorized to do. Each user is
authorized to do standard operating procedure actions
that are based on the LDAP Roles that the user is
assigned to, and must match the distinguished name
(DN) that is used in association with the standard
operating procedure objects.

Related tasks:

“Configuring standard operating procedure definitions”
on page 136
When you define a standard operating procedure, you
define activities that are included in the standard
operating procedure. You can specify the order in
which some or all of the activities in a standard
operating procedure are executed. For example, you
can specify that a particular activity is not started until
the previous activity is completed or skipped. You also
assign owners and monitors to the standard operating
procedure.

CIYRS0053E The request could not be authorized.

Explanation: You are not authorized to access the
resource.

User response: Ask an authorized standard operating
procedure administrator to create the request for you.
Alternatively, ask an administrator to add you to the
list of authorized standard operating procedure
administrators. For more information about roles that
relate to the administration of standard operating
procedures, see the link at the end of the topic.

Related concepts:

“Defining standard operating procedure roles” on page
97
The standard operating procedure component obtains
the current authentication credentials to determine
what actions each user is authorized to do. Each user is
authorized to do standard operating procedure actions
that are based on the LDAP Roles that the user is
assigned to, and must match the distinguished name
(DN) that is used in association with the standard
operating procedure objects.

CIYRS0054E Either the request could not be
authorized, or the ID does not exist.

Explanation: Either you are not authorized to access
the resource, or you specified an ID that does not exist.

User response: Verify the ID of the resource. For
information about who is authorized to access
resources, see the link at the end of the topic to error
message CIYRS0053E.

Related information:

“CIYRS0053E”
The request could not be authorized.

CIYRS0055E You cannot start this activity.

Explanation: You cannot start the selected activity
because it is not in waiting status.

User response: Review the status of an activity in
either the Solution Administration view, or by using the
standard operating procedure REST interface.

Related tasks:
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“Viewing and editing instances of a standard operating
procedure” on page 141
For a standard operating procedure definition, you can
review the instances of the standard operating
procedure that have been launched. You can view an
instance in the Standard Operating Procedure Details
window, where you can edit an instance, or change the
status of an instance.

CIYRS0056E You cannot skip this activity.

Explanation: You cannot skip this activity because it is
specified as a required activity in the standard
operating procedure definition.

User response: Complete the required activity.

CIYRS0057E You cannot complete this activity.

Explanation: You attempted to complete an activity
that is not started.

User response: Review the status of an activity in
either the Solution Administration view, or by using the
standard operating procedure REST interface.

Related tasks:

“Viewing and editing instances of a standard operating
procedure” on page 141
For a standard operating procedure definition, you can
review the instances of the standard operating
procedure that have been launched. You can view an
instance in the Standard Operating Procedure Details
window, where you can edit an instance, or change the
status of an instance.

CIYRS0058E The reference could not be found or
parsed.

Explanation: Either the reference URL is incorrect, or
the content at the URL is incorrect. For example, the
reference content might have been deleted.

User response: Check the reference URL. If the URL is
correct, check the content at the URL. Correct either the
reference URL, or the reference content, as appropriate.
Also, see the related topic for message CIYRS0017E.

Related information:

“CIYRS0017E” on page 417
The reference could not be found.

CIYRS0059E You cannot stop this activity.

Explanation: You attempted to stop an activity that is
not started.

User response: Review the status of an activity in
either the Solution Administration view, or by using the
standard operating procedure REST interface.

Related tasks:

“Viewing and editing instances of a standard operating
procedure” on page 141
For a standard operating procedure definition, you can
review the instances of the standard operating
procedure that have been launched. You can view an
instance in the Standard Operating Procedure Details
window, where you can edit an instance, or change the
status of an instance.

CIYRS0060E This activity is not started.

Explanation: You attempted to query the automation
status of an activity that is not started.

User response: Review the status of an activity in
either the Solution Administration view, or by using the
standard operating procedure REST interface.

Related tasks:

“Viewing and editing instances of a standard operating
procedure” on page 141
For a standard operating procedure definition, you can
review the instances of the standard operating
procedure that have been launched. You can view an
instance in the Standard Operating Procedure Details
window, where you can edit an instance, or change the
status of an instance.

CIYRS0061E You are not authorized to create, edit, or
delete a reference.

Explanation: Only users who are listed in the
following system properties are authorized to create,
edit, or delete references in the library:

v ReferenceLibrarianRoles

v SopAdminRoles

v SopAuthorRoles

For more information about creating, editing, and
deleting references, see the link at the end of the topic.

User response: Ask an authorized user to create, edit,
or delete a reference for you.

Related concepts:

“Defining standard operating procedure roles” on page
97
The standard operating procedure component obtains
the current authentication credentials to determine
what actions each user is authorized to do. Each user is
authorized to do standard operating procedure actions
that are based on the LDAP Roles that the user is
assigned to, and must match the distinguished name
(DN) that is used in association with the standard
operating procedure objects.

CIYRS0062E You cannot delete references that are
currently being used.

Explanation: The reference that you are trying to
delete in the library is used in an instance of an active
standard operating procedure.
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User response: Review the active instances of
standard operating procedures to see where the
reference is being used, and wait for the instances to be
completed. Also, to prevent future errors, delete the
reference from all standard operating procedure
definitions. Then, delete the reference in the library.

Related tasks:

“Viewing and editing definitions” on page 140
Use the following procedure to view and edit standard
operating procedure definitions.

CIYRS0063E The duration value that you entered is
not valid. Check the value and try again.

Explanation: If you specify a duration for an activity,
the value must be a numerical integer.

User response: Enter a numerical integer in the
Duration field.

CIYRS0065E An error occurred while saving the
filter/favorite {0}.

Explanation: The filter panel REST service was not
able to complete the insert request because of an
internal SQL exception.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0065I The filter/favorite {0} was saved.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0066E An error occurred while deleting the
filter/favorite {0}.

Explanation: The filter panel REST service was not
able to complete the delete request because of an
internal SQL exception.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0066I The filter {0} was deleted.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0067E You cannot launch a standard operating
procedure that is in draft status.

Explanation: The version of the standard operating
procedure that you are trying to launch is in draft
status. You can launch only versions of standard
operating procedures that have been approved.

User response: Either submit the draft standard
operating procedure definition for approval, or launch
a previously approved version of the standard
operating procedure definition, if a suitable one exists.
For more information about working with draft and
approved versions of standard operating procedures,
see the link at the end of the topic.

Related tasks:

“Working with drafts and approvals” on page 139
When you create a standard operating procedure
definition, a draft version is saved initially. When you
submit a draft version for approval, a version of the
standard operating procedure definition is saved,
where the version name is the approval time stamp
value. You can create another draft that is based on an
approved version.

CIYRS0068E At least one activity definition must be
defined.

Explanation: You must add at least one activity
definition to a standard operating procedure definition.

User response: Click Add. In the Create Activity
Definition window, either select an activity definition
from the Name list, or specify a new activity definition.

Related tasks:

“Configuring standard operating procedure definitions”
on page 136
When you define a standard operating procedure, you
define activities that are included in the standard
operating procedure. You can specify the order in
which some or all of the activities in a standard
operating procedure are executed. For example, you
can specify that a particular activity is not started until
the previous activity is completed or skipped. You also
assign owners and monitors to the standard operating
procedure.

CIYRS0070I The Saved Filters/Favorites pane was
saved.

Explanation: This message is for informational
purposes only.

User response: No action is required.
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CIYRS0071E An error occurred while creating the
system property. A system property with
the name {0} already exists.

Explanation: The system property could not be
created because you assigned it a name that is already
assigned to another system property. Names of system
properties must be unique.

User response: Create the system property with a
unique name.

CIYRS0072E The image path {0} could not be found.

Explanation: The path value {0} does not exist. Either
the path to the image, or the image file name, is
incorrect.

User response: Check and correct the image path and
file name, and then submit your request again.

CIYRS0073E The data source is missing the required
data source label.

Explanation: You did not provide a name for the data
source in the Data source label field.

User response: Provide a name for your data source
in the Data source label field.

CIYRS0074E The data source is missing the required
connection protocol.

Explanation: You did not specify the method of data
acquisition for your data source.

User response: Provide a data acquisition method for
your data source from the supported options, either a
standard CSV file or DB2 database.

CIYRS0075E The data source connection protocol is
unsupported.

Explanation: The system does not recognize the
method of data acquisition you specified for your data
source.

User response: Provide a data acquisition method for
your data source from the supported options, either a
standard CSV file or DB2 database.

CIYRS0076E No data source properties were found
for the combination of Connection
Information values you specified.

Explanation: No properties were found in the data
source with the values you specified in the Connection
Information fields.

User response: Verify that all the values in
Connection Information fields are correct and try
again.

CIYRS0077E The CSV directory path is missing or
incorrect.

Explanation: There is no file path provided for the
CSV file, or the file path that is in the Directory field is
incorrect.

User response: Verify that the file path in the
Directory field is the correct file path for the CSV file
data source.

CIYRS0078E The CSV filename is missing or
incorrect.

Explanation: There is no file name, or the file name in
the File name field is incorrect.

User response: Verify that the correct file name for the
CSV file data source is in the File name field.

CIYRS0079E The CSV file could not be found or
could not be read.

Explanation: The system cannot find a CSV file with
the values provided in the Connection Information
fields, or the file is found but cannot be read.

User response: Verify that a CSV file exists
corresponding to the values specified in Connection
Information fields. Verify that the content is in the
standard format.

CIYRS0080E The database type is missing or
incorrect.

Explanation: You did not specify the correct value for
How to acquire data.

User response: Provide a data acquisition method for
your data source from the supported options, either a
standard CSV file or DB2 database.

CIYRS0081E It was not possible to ping the
hostname or IP.

Explanation: When the system pings the value in the
Host name or IP field, no response is received.

User response: Verify that the host name or IP value
is correct. Ensure that there are no firewall issues.

CIYRS0082E The database port is missing or
incorrect.

Explanation: There is no value in the Port field for the
database, or the value that is supplied is incorrect.

User response: Verify that the value for the database
port is correct.
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CIYRS0083E The database user ID is missing or
incorrect.

Explanation: There is no value in the User ID field for
the database, or the value is incorrect.

User response: Verify that the value for the database
user ID is correct.

CIYRS0084E The database password is missing or
incorrect.

Explanation: There is no value in the Password field
for the database, or the value is incorrect.

User response: Verify that the value for the database
password is correct.

CIYRS0085E The database name is missing or
incorrect.

Explanation: There is no value in the Database name
field, or the value is incorrect.

User response: Verify that the value for the database
name is correct.

CIYRS0086E The database table is missing or
incorrect.

Explanation: There is no value in the Database table
field, or the value is incorrect.

User response: Verify that the database table name is
fully qualified with a schema prefix, for example,
IOC.STAGING.

CIYRS0087E The program failed to connect to the
database with the combination of host
name, port, user ID, and password that
you specified.

Explanation: The system cannot connect to the
database with the values specified in the Connection
Information fields.

User response: Verify that the values in Connection
Information fields are correct for the database data
source connection.

CIYRS0088E The database table name is missing the
schema prefix.

Explanation: There is no schema prefix on the value
in the Database table field.

User response: Verify that the database table name is
fully qualified with a schema prefix, for example,
IOC.STAGING.

CIYRS0089E An error occurred while creating
category {0}.

Explanation: The category that is indicated in {0} was
not created because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0089I Category {0} is created.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0091E An error occurred while creating
collection {0}.

Explanation: The collection that is indicated in {0} was
not created because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0091I Collection {0} is created.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0092E An error occurred while updating
collection {0}.

Explanation: The collection that is indicated in {0} was
not updated because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.
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CIYRS0092I Collection {0} is updated.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0093E An error occurred while creating
location map {0}.

Explanation: The location map that is indicated in {0}
was not created because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0093I Location map {0} is created.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0094E An error occurred while updating the
location map.

Explanation: The location map was not updated
because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0094I Location map updated.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0095E An error occurred while deleting
location map {0}.

Explanation: The location map that is indicated in {0}
was not deleted because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and

correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0095I Location map {0} is deleted.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0096E An error occurred while deleting
category {0}.

Explanation: The category that is indicated in {0} was
not deleted because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0096I Category {0} is deleted.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0097E An error occurred while deleting
collection {0}.

Explanation: The collection that is indicated in {0} was
not deleted because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0097I Collection {0} is deleted.

Explanation: This message is for informational
purposes only.

User response: No action is required.
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CIYRS0099E An error occurred while creating areas.

Explanation: Some areas might have been created.
However, at least one area was not created because an
error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0099I Areas have been created.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0100E An internal processing error occurred.

Explanation: The request could not be processed
because an internal processing error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0101E An error occurred while defining the
requested data source {0}.

Explanation: The data source {0} could not be defined
because there is an error in the definition of the data
source.

Response: Check the definition of the data source.

CIYRS0102E The criteria that were entered are not
valid. Check the criteria and try again.

Explanation: The criteria that you specified in the
request are not in the correct format.

User response: Check the format of the criteria in
your request. Format a list of key value properties as a
URL encoded comma-separated list of parameters.

CIYRS0103E Data source {0} has no view defined.
Check the configuration and try again.

Explanation: A view is not defined for the data source
{0}.

Response: Check the definition of the data source.

CIYRS0104E Data source {0} has no columns defined.
Check the configuration and try again.

Explanation: In the database, no property columns are
defined for data source {0}.

Response: Check the definition of the data source.

CIYRS0105E There is no data source with id {0}.

Explanation: A data source that has the id value {0}
does not exist.

User response: Check whether the id value is correct,
or that the data source has been created correctly.

CIYRS0106E A positive double value is required for
the buffer.

Explanation: The buffer value that you specified is
invalid.

User response: Specify a positive decimal value for
the buffer value.

CIYRS0107E Boundaries are required.

Explanation: You must include the boundary
coordinates in the request.

User response: Specify the boundary coordinates in
the request.

CIYRS0108E The request contains invalid WKT
input.

Explanation: The request contains input that is not
valid well-known text (WKT) format.

User response: Ensure that the request input is valid
WKT format.

CIYRS0109E The coordinates that you entered are out
of bounds. Check the coordinates and
try again.

Explanation: The coordinates that you are entered are
not inside the map.

User response: Ensure that the coordinates that you
specify are inside the map boundary.
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CIYRS0110E The coordinates that you entered are
invalid; the polygon is not closed.
Check the coordinates and try again.

Explanation: The coordinates that you specified do
not form a closed polygon.

User response: Ensure that you specify coordinates
that form a closed polygon.

CIYRS0111E The buffer value is out of bounds.
Check the buffer value and try again.

Explanation: You must specify a buffer value that
corresponds to a closed polygon that is inside the map
boundary.

User response: Enter a buffer value that corresponds
to a closed polygon that is inside the map boundary.

CIYRS0112E An invalid sort option {0} was used.

Explanation: You can use only data source column
names to specify a sort function.

User response: Specify the sort function by using data
source column names.

CIYRS0113E An invalid time stamp value {0} was
used.

Explanation: The request contains an invalid time
stamp value {0}.

User response: Enter a valid LONG time stamp value
that complies with ISO8601.

CIYRS0114E The criterion format {0} is incorrect.

Explanation: The criterion {0} that you specified in the
request is not in the correct format.

User response: Check the format of the criterion {0}.

CIYRS0115E Column {0} was not found in the data
source definition.

Explanation: Column {0} that you specified in your
request does not exist in the data source definition.

User response: Check the columns in the data source
definition.

CIYRS0116E An invalid operator {0} was used.

Explanation: The request contains an invalid operator
{0}.

User response: In a request, only the following
operators are valid: =, >, >=, <, <=

CIYRS0117E An error occurred while updating data
receiver {0}.

Explanation: The data receiver that is indicated in {0}
was not updated because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0118E The unique text identifier value is
already used by another Data source.

Explanation: The value in the Data source unique text
identifier field is in use for another data source.

User response: Verify that the value in the Data
source unique text identifier field is unique to the data
source.

CIYRS0119E The pane cannot be created because
another pane already uses the selected
color.

Explanation: You assigned a color to the pane that is
already used by another pane. You must assign a
unique color to each pane.

User response: Assign a color to the pane that is not
used by another pane.

CIYRS0120E The pane cannot be updated because
another pane already uses the selected
color.

Explanation: You assigned a color to the pane that is
already used by another pane. You must assign a
unique color to each pane.

User response: Assign a color to the pane that is not
used by another pane.

CIYRS0121I Image file {0} was uploaded successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0122E The location map image file type is not
supported: {0}.

Explanation: The format of the location map image
file that you are trying to upload is not supported.

User response: Ensure that the format of the location
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map image file that you want to upload is either PNG,
JPG, GIF, or SVG.

Related tasks:

“Viewing and uploading map images” on page 133
As an administrator, you can view or upload map
images that are available to use when you are creating
location maps in the solution.

CIYRS0123E The map icon image file type is not
supported: {0}.

Explanation: The format of the map icon image file
that you are trying to upload is not supported.

User response: Ensure that the format of the map icon
image file that you want to upload is transparent PNG.

Related concepts:

“Data item icons” on page 183
You can design your own icons and upload image files
to represent data items in the operations views, the
status views, and the Solution Administration view.
The image files that you upload must meet certain
requirements.

CIYRS0124E An error occurred while uploading the
image file.

Explanation: The image file was not uploaded because
an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0125E An error occurred while creating a data
receiver for the data source

Explanation: A data receiver was not created for the
data source because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

CIYRS0126E An error occurred while updating the
data receiver for this data source

Explanation: The data receiver for the data source was
not updated because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and

correctly configured. If the error still recurs, contact
IBM support.

CIYRS0183I One or more standard operating
procedure instances were successfully
created.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0183E An error occurred while launching the
standard operating procedures.

Explanation: An error occurred that prevented the
standard operating procedures from being launched.

User response: Review the log files. For further
assistance, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0184I {0} has been associated with {1}

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0184E An error occurred while associating the
item to one or more standard operating
procedure instances that are running.

Explanation: An error occurred that prevented the
item from being associated to one or more standard
operating procedure instances.

User response: Review the log files. For further
assistance, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0185I The hotspot analysis {0} was created.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0185E An error occurred while creating the
hotspot analysis.

Explanation: The hotspot analysis definition could not
be created because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
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who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

CIYRS0186I The hotspot analysis {0} was updated.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0186E An error occurred while updating the
hotspot analysis.

Explanation: The hotspot analysis definition could not
be updated because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

CIYRS0187I The hotspot analysis {0} was deleted.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0187E An error occurred while deleting the
hotspot analysis.

Explanation: The hotspot analysis definition could not
be deleted because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

CIYRS0188E An error occurred while creating the
hotspot analysis. A hotspot analysis
with the same name already exists.

Explanation: You cannot create a hotspot analysis
definition that has the same name as an existing
definition.

User response: Enter a unique name for the hotspot
analysis definition that you want to create.

CIYRS0189W The selected filter criteria would return
{0} records, which exceeds the
configured limit of {1}. Only {2} records
were returned.

Explanation: You specified filter criteria that would
return a number of data items that exceeds the
configured limit. Therefore, fewer data items were
returned, as indicated in the message.

User response: Specify more restrictive filter criteria to
return a number of data items that is within the
configured limit. Alternatively, increase the configured
limit by editing the StatMaxAllowedFeaturesInResponse
system property.

Related tasks:

“Configuring system properties” on page 189
View, create, modify, and delete system properties in
the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent
Operations Center.

“Setting displayed and returned data item limits” on
page 118
You can set the maximum number of data items that
are returned to the map and the list, and that are
rendered on the map.

CIYRS0190E The data source {0} is required by {1}.

Explanation: The data source cannot be deleted
because the service that is indicated in the message is
using it.

User response: Verify whether the service that is
indicated in the message is still using the data source.
If the service no longer requires the data source,
remove the reference from the service to the data
source, and then delete the data source.

CIYRS0191I The Cognos models were successfully
updated.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0191E The Cognos models were not updated.

Explanation: An error occurred that prevented the
Cognos models from being updated.

User response: Review the log files. If you are
generating Cognos models in a high availability
environment, see the Configure the Cognos model in a
high availability environment link for a possible solution.
For further assistance, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

“Configure the Cognos model in a high availability
environment” on page 75
IBM Intelligent Operations Center can publish a
Cognos model when a data source is created or
updated. In a high availability environment, you must
configure Cognos to enable IBM Intelligent Operations
Center to publish the Cognos model.
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CIYRS0192I {0} has been disassociated from {1}

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0193E An error occurred while updating your
profile.

Explanation: An error occurred while updating your
profile.

User response: Review the log files. For further
assistance, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0194I Your profile was updated.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0195I The new password was saved
successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0196E An error occurred while the password
was being saved.

Explanation: An error occurred while the password
was being saved.

User response: Review the log files. For further
assistance, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0197I The notifications settings were saved
successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0198E An error occurred while the notification
settings were being saved.

Explanation: An error occurred while the notification
settings were being saved.

User response: Review the log files. For further

assistance, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0199I The display settings were saved
successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0200E An error occurred while the display
settings were being saved.

Explanation: An error occurred while the display
settings were being saved.

User response: Review the log files. For further
assistance, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0201I The profile was saved successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0202E An error occurred while the profile was
being saved.

Explanation: An error occurred while the profile was
being saved.

User response: Review the log files. For further
assistance, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0203I The custom component was created
successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0203E An error occurred while the custom
component was being created.

Explanation: An error occurred while the custom
component was being created.

User response: Review the log files. For further
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assistance, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0204I The custom component was updated
successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0204E An error occurred while the custom
component was being updated.

Explanation: An error occurred while the custom
component was being updated.

User response: Review the log files. For further
assistance, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0205I The custom component was deleted
successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0205E An error occurred while the custom
component was being deleted.

Explanation: An error occurred while the custom
component was being deleted.

User response: Review the log files. For further
assistance, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYRS0206I The customization was saved
successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYRS0206E An error occurred while the
customization was being saved.

Explanation: An error occurred while the
customization was being saved.

User response: Review the log files. For further
assistance, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYUI0000E You cannot edit the selected pane.

Explanation: In the pane that you selected, no options
exist that you can configure.

User response: None.

CIYUI0001E You cannot delete the selected pane.

Explanation: You cannot delete the selected pane
because it is a predefined pane. You can delete only
dynamic panes that display data sources.

User response: None.

CIYUI0002E An invalid module definition was
specified as a "More Actions" extension
in the preview card.

Explanation: An error occurred while a More Actions
extension was being loaded.

User response: Verify that the extension is correctly
defined in the database table. For more information
about defining custom actions, see the link at the end
of the topic.

Related tasks:

“Assigning actions to your data source” on page 113
You can choose which user actions to apply to data
items that are received from your data source. Some
actions are applied by default.

“Defining custom actions for data sources” on page 182
You can define custom actions that are displayed as
available actions on the Actions tab in the data source
configuration tool. If you assign a custom action to a
data source, it is displayed in the More Actions menu
that is on the preview card for the data source.

CIYUI0003E An invalid module definition was
specified in the portlet configuration
parameter.

Explanation: An invalid module definition was loaded
into the content panel.

User response: Verify that the module definition is
correctly defined.

Related tasks:
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“Customizing the content panel” on page 174
You can customize the content panel in IBM Intelligent
Operations Center, and specify which tabs and content
to display. The content panel is implemented through a
content viewer portlet, and an administrator can
customize it through the WebSphere Portal
administrative interface.

CIYUI0004I The data item was created successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYUI0005I The data item was updated successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYUI0006E Another user has updated the item.

Explanation: Another user has saved a change to the
item since you started editing the item.

User response: Close the item, then open it again and
edit it as required.

CIYUI0007E An error occurred while saving the item.

Explanation: The item was not saved because an error
occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYUI0008E An invalid module definition was
specified as a "More Actions" extension
for the list.

Explanation: An error occurred while a More Actions
extension was being loaded into the List tab.

User response: Verify that the extension is correctly
defined in the database table. For more information
about defining custom actions, see the link at the end
of the topic.

Related tasks:

“Defining custom actions for data sources” on page 182
You can define custom actions that are displayed as
available actions on the Actions tab in the data source
configuration tool. If you assign a custom action to a
data source, it is displayed in the More Actions menu

that is on the preview card for the data source.

CIYUI0009E An error occurred while saving the base
map.

Explanation: The base map was not saved because an
error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYUI0010E You must select another map as the
default base map before you can delete
this base map.

Explanation: You cannot delete the selected map
because it is the default base map.

User response: If you want to delete the selected map,
you must set another map as the default base map.

Related tasks:

“Managing base maps” on page 117
As an administrator, you can create, edit, or delete base
maps in the solution.

CIYUI0013E An error occurred while deleting the
base map.

Explanation: The base map was not deleted because
an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYUI0014E An error occurred while saving the
center point coordinates and zoom level.

Explanation: The center point coordinates and zoom
level were not saved because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:
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“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYUI0014I The center point coordinates and zoom
level have been successfully updated.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYUI0015E An error occurred while retrieving the
map settings.

Explanation: The map settings were not retrieved
because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYUI0016I No base maps have been configured. An
administrator can add geospatial maps
by selecting "Solution Administration"
and then "Configuration Tools".

Explanation: This is an informational message that
indicates that no base maps have been configured.

User response: An administrator can configure
geospatial maps in the Solution Administration view.
For more information, see the link at the end of the
topic.

Related concepts:

“Configuring geospatial maps” on page 117
In the Solution Administration view, you can configure
the maps that are available to the user, the initial map
center point, and the map zoom level.

CIYUI0017E An error occurred while retrieving the
map.

Explanation: The map was not retrieved because an
error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYUI0018I The record was cancelled successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYUI0019E An error occurred while attempting to
cancel the record.

Explanation: The record could not be canceled
because an error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYUI0020I The records were cancelled successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYUI0021E An error occurred while attempting to
cancel one of the records.

Explanation: One of the records could not be canceled
because an error occurred.

User response: Review the log files. For further
assistance, contact IBM Support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYUI0022E An error occurred while loading the
data source extension module {0}.

Explanation: The data source extension module that is
indicated in {0} was not loaded because an error
occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.
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CIYUI0023E An error occurred while loading the
data source configurations.

Explanation: The data source configurations were not
loaded because an error occurred.

User response: Verify that the password is correct.
Refresh the browser window and try again. If the
problem persists, contact an administrator who can
ensure that the data server is running and correctly
configured. If the error still recurs, contact IBM
support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYUI0024E The selected data source {0} has not
been fully configured.

Explanation: The configuration of the data source that
is indicated in {0} is not complete.

User response: Ask an administrator to check the
configuration of the data source. For more information
about configuring data sources, see the link at the end
of the topic.

Related concepts:

“Configuring a data source” on page 99
Use the Data Sources tool to configure a data source
that supplies data to IBM Intelligent Operations Center.

CIYUI0025E An error occurred while loading data for
data source {0}.

Explanation: The data for the data source that is
indicated in {0} was not loaded because an error
occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYUI0026E An error occurred while loading the
data source; the "More Actions" module
{0} is invalid.

Explanation: An error occurred while a More Actions
extension was being loaded.

User response: Verify that the extension is correctly
defined in the database table. For more information
about defining custom actions, see the link at the end
of the topic.

Related tasks:

“Defining custom actions for data sources” on page 182
You can define custom actions that are displayed as
available actions on the Actions tab in the data source
configuration tool. If you assign a custom action to a
data source, it is displayed in the More Actions menu
that is on the preview card for the data source.

CIYUI0027E Complete the existing expressions
before adding a new one.

Explanation: You clicked Add Routing Expression
while an expression you added previously is
incomplete.

User response: Enter the values to complete the
routing expression you added before you click Add
Routing Expression again.

CIYUI0028E Complete the existing styles before
adding a new one.

Explanation: You clicked Add Style while a style you
added previously is incomplete.

User response: Enter the values to complete the style
you added before you click Add Style again.

CIYUI0029E No area exists where the item has been
dropped.

Explanation: You added an item to a part of the
location map for which an area is not configured.

User response: Ensure that you add an item to a part
of the location map that is included in a configured
area. If necessary, ask an administrator to configure a
new area on the location map.

Related tasks:

“Adding a data item to the location map” on page 376
You can create a data item that is associated with an
area on a location map and added to a data source. The
data item is added to the Location Map and List tabs at
the same time.

“Creating, updating, or deleting areas on a location
map” on page 135
As an administrator you can create, update, or delete
areas for display on your location map.

CIYUI0030E The Google Maps API could not be
loaded.

Explanation: The Google Maps API service is not
available.

User response: Check whether the Google Maps API
service is available online. If the service is not available,
wait until the service becomes available and then try
again.
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CIYUI0031E Select an existing data source before
saving changes.

Explanation: You clicked Save without selecting a
data source, or without changing a data source.

User response: Select a data source and change it
before you click Save again.

CIYUI0032E Complete the required minimal property
fields before saving.

Explanation: You did not complete all the required
fields on the Minimal properties tab before you saved
your data source configuration.

User response: Enter the required values on the
Minimal properties tab and click Save. For more
information about the required values on the Minimal
properties tab, see the link at the end of the topic.

Related reference:

“Data source minimal property settings” on page 105
Assign properties from your data source to each
minimal property and choose the settings that are
appropriate for your data.

CIYUI0033E You are not authorized to save changes
to the selected DataSource.

Explanation: You do not have the authority that is
required to update the data source that you selected.

User response: Contact an administrator or the creator
of the data source to give you the authority to update
the data source.

CIYUI0034E Pane {0} could not be moved.

Explanation: Pane {0} could not be moved because an
error occurred.

User response: Refresh the browser window and try
again. If the problem persists, contact an administrator
who can ensure that the data server is running and
correctly configured. If the error still recurs, contact
IBM support.

CIYUI0036E An error occurred while uploading the
image. Please try again.

Explanation: The image could not be uploaded
because an error occurred.

User response: Ensure that the image file is in one of
the accepted formats. For more information about
uploading images, see the link at the end of the topic.

If the problem persists, refresh the browser window
and try again. If the error recurs, contact an
administrator who can ensure that the data server is
running and correctly configured. If the error still
recurs, contact IBM support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

“Viewing and uploading map images” on page 133
As an administrator, you can view or upload map
images that are available to use when you are creating
location maps in the solution.

CIYUI0036I Image uploaded successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYUI0037I Please select a valid category, collection
or map to delete.

Explanation: You tried to delete the Location Map
Images menu option, which is an invalid option for
deletion.

User response: Select a valid category, collection, or
map to delete.

CIYUI0038E Select an existing data source to delete.

Explanation: You clicked Delete without selecting a
data source.

User response: Select the data source that you want to
delete and click Delete.

CIYUI0039E You are not authorized to delete to the
selected DataSource.

Explanation: You do not have the authority that is
required to delete the data source that you selected.

User response: Contact an administrator or the creator
of the data source to give you the authority to delete
the data source.

CIYUI0040E Value is required to proceed.

Explanation: You did not enter values into one or
more of the fields that are required.

User response: Ensure that you enter values into all
the fields that are required.

CIYUI0040I Value is required to proceed.

Explanation: You did not enter values into one or
more of the fields that are required.

User response: Ensure that you enter values into all
the fields that are required.
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CIYUI0041I Icon upload complete.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYUI0042E The area was removed. An area cannot
overlap an existing area.

Explanation: The area that you are trying to create
was removed because it overlaps another area.

User response: Review the areas that have already
been created. When you create an area, ensure that you
draw an area that does not overlap another area.

Related tasks:

“Creating, updating, or deleting areas on a location
map” on page 135
As an administrator you can create, update, or delete
areas for display on your location map.

CIYUI0043E The data item does not match the
routing expressions.

Explanation: The incoming data item does not match
any of the routing expressions that are defined for the
data source. The data item will be discarded.

User response: If you want similar data items to be
routed to a component in IBM Intelligent Operations
Center, review and update the routing criteria that are
defined for the data source.

Related tasks:

“Routing data from your data source” on page 111
For the data that is received from your data source, set
routing expressions that define how the data is
processed by the solution. Data items that match the
required expression or combination of expressions are
routed to the selected destination.

CIYUI0044E Lines cannot intersect each other.

Explanation: This message occurs when you attempt
to complete a polygon shape that is drawn on the map
with one or more lines that are crossed.

User response: When you draw a polygon on the
map, ensure that the lines that compose the sides of the
polygon do not cross. Redraw the polygon so that the
sides meet at the corners of the polygon shape.

CIYUI0045W If you select more than three data
sources, the performance of the system
slows down significantly when hotspots
are generated.

Explanation: Performance can be affected by the
number of data sources that are selected for analysis
and to a lesser extent by the number of data items in
the data sources.

User response: Select only data sources that are
essential to your analysis. Be prepared for a slower
response with more two or more data sources and
higher numbers of data items.

CIYUI0046E An error occurred while retrieving the
KPI model list.

Explanation: There is a problem communicating with
IBM Business Monitor.

User response: Ensure that the IBM Business Monitor
models are deployed correctly.

CIYUI0047E An error occurred while saving the KPI
hierarchy.

Explanation: There is an error in the message that is
sent from the rest service. The JSON cannot be parsed.

User response: Check the system logs for
communication errors with the data server or contact
your administrator for assistance.

CIYUI0048E The data item could not be added. The
area name on the location map exceeds
the character limit of the area name
property in the data source.

Explanation: The incoming data item does not match
any of the routing expressions that are defined for the
data source. The data item will be discarded.

User response: If you want similar data items to be
routed to a component in IBM Intelligent Operations
Center, review and update the routing criteria that are
defined for the data source.

CIYUI0049I The KPI hierarchy was imported
successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYUI0049E The KPI hierarchy import operation
failed.

Explanation: The KPI hierarchy import operation
failed.

User response: The KPI hierarchy import failed. For
more information, see the server logs.

CIYUI0050I The KPI hierarchy was exported
successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.
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CIYUI0051E An error occurred while the custom
component was being updated. The
component cannot be loaded.

Explanation: An error occurred while the custom
component was being updated.

User response: Verify that the path location, the path
name, and the module name are correct. Then, try
again.

Related tasks:

“Creating components” on page 175
Use the component customization tool to create
customized components that you can add to the user
interface. For example, you can either create your own
customized preview card, or you can create actions that
you make available in the More Actions menu on the
preview card. You can also create customized full
properties windows and advanced visualization
components.

CIYUI0052E The component cannot be loaded.

Explanation: The component cannot be loaded

User response: Verify that the path location, the path
name, and the module name are correct. Then, try
again.

Related tasks:

“Creating components” on page 175
Use the component customization tool to create
customized components that you can add to the user
interface. For example, you can either create your own
customized preview card, or you can create actions that
you make available in the More Actions menu on the
preview card. You can also create customized full
properties windows and advanced visualization
components.

CIYUI0053E A preview card component was not
specified for the selected item's data
source.

Explanation: The preview card component was not
specified.

User response: In the Solution Administration view,
use the component customization tool to assign a
preview card component to the data source.

Related tasks:

“Customizing components” on page 174
To extend and customize the functionality of your
solution, you can create customized components that
you can add to the user interface. You can also replace
an existing component with a customized component.
For example, for a particular system component, you
can replace an existing preview card with a new,
customized preview card.

CIYUI0054E A full properties window component
was not specified for the selected item's
data source.

Explanation: A full properties window component
was not specified.

User response: In the Solution Administration view,
use the component customization tool to assign a full
properties window component to the data source.

Related tasks:

“Customizing components” on page 174
To extend and customize the functionality of your
solution, you can create customized components that
you can add to the user interface. You can also replace
an existing component with a customized component.
For example, for a particular system component, you
can replace an existing preview card with a new,
customized preview card.

CIYUI0055E An invalid module definition was
specified for the preview card
component.

Explanation: An invalid module definition was
specified for the preview card component.

User response: Verify that the path location, the path
name, and the module name are correct. Then, try
again.

Related tasks:

“Creating components” on page 175
Use the component customization tool to create
customized components that you can add to the user
interface. For example, you can either create your own
customized preview card, or you can create actions that
you make available in the More Actions menu on the
preview card. You can also create customized full
properties windows and advanced visualization
components.

CIYUI0056E An invalid module definition was
specified for the full properties window
component.

Explanation: An invalid module definition was
specified for the full properties window component.

User response: Verify that the path location, the path
name, and the module name are correct. Then, try
again.

Related tasks:

“Creating components” on page 175
Use the component customization tool to create
customized components that you can add to the user
interface. For example, you can either create your own
customized preview card, or you can create actions that
you make available in the More Actions menu on the
preview card. You can also create customized full
properties windows and advanced visualization
components.
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CIYUI0057E The data import operation failed for
data source {0}.

Explanation: The data import operation failed for the
data source that is indicated because of an exception
that is indicated in the notification description.

User response: For more information, see the
SystemOut.log file. For further assistance, contact IBM
support.

Related tasks:

“Contacting IBM Support” on page 443
IBM Support provides assistance with product defects,
answering FAQs, and performing rediscovery.

CIYUI0058E "{0}" is an invalid module definition.

Explanation: The selected component has an invalid
module definition.

User response: Verify that the path location, the path
name, and the module name are correct. Then, try
again.

Related tasks:

“Creating components” on page 175
Use the component customization tool to create
customized components that you can add to the user
interface. For example, you can either create your own
customized preview card, or you can create actions that
you make available in the More Actions menu on the
preview card. You can also create customized full
properties windows and advanced visualization
components.

CIYUI0059E The logon attempt failed because either
your user ID or your password is
incorrect.

Explanation: Either the user ID, or the password, that
you entered when you logged on is incorrect.

User response: Verify that the user ID and the
password are correct. Then, try again.

CIYUI0060W Only {0} data items can be rendered on
the map with the current filter criteria,
and in accordance with the configured
limit.

Explanation: Data items are displayed on the map
according to the selections that you make in the filter
panel. If the number of data items that should be
displayed exceeds the value that is configured in the
MaxFeaturesToRenderOnMap system property, the excess
data items are not displayed.

User response: Edit the value of the
MaxFeaturesToRenderOnMap system property. If you
increase the value significantly, performance might be
diminished.

Related tasks:

“Setting displayed and returned data item limits” on
page 118
You can set the maximum number of data items that
are returned to the map and the list, and that are
rendered on the map.

“Configuring system properties” on page 189
View, create, modify, and delete system properties in
the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent
Operations Center.

CIYUI0061W The selected data item cannot be
rendered on the map because, with the
current filter criteria, the configured
limit for maximum displayed items is
exceeded.

Explanation: Data items are displayed on the map
according to the selections that you make in the filter
panel. If the number of data items that should be
displayed exceeds the value that is configured in the
MaxFeaturesToRenderOnMap system property, the excess
data items are not displayed.

User response: Edit the value of the
MaxFeaturesToRenderOnMap system property. If you
increase the value significantly, performance might be
diminished.

Related tasks:

“Setting displayed and returned data item limits” on
page 118
You can set the maximum number of data items that
are returned to the map and the list, and that are
rendered on the map.

“Configuring system properties” on page 189
View, create, modify, and delete system properties in
the system properties table. The system properties
affect the system-wide configuration of IBM Intelligent
Operations Center.

CIYUI0062E The file was not uploaded because it
does not contain a valid image.

Explanation: The file was not uploaded because it is
not a valid image file.

User response: Verify that the format and contents of
the file that you want to upload are correct. Then, try
again.

CIYUI0063E The file was not uploaded because it is
not a valid CSV file.

Explanation: The file was not uploaded because it is
not a valid CSV file.

User response: Verify that the type of the file that you
want to upload is a CSV file. Then, try again.
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CIYUI0064E Before you can save the current filter
panel criteria as a favorite, you must
correct one or more errors in the {0}
pane.

Explanation: The filter pane that is indicated in the
message contains one or more errors.

User response: Correct the errors that are in the filter
pane.

Related concepts:

“Filtering data on the maps and list” on page 378
In the appropriate operations view, use the filter panel
to define what data is displayed in the content panel.
The content panel contains the Map tab, the Location
Map tab, and the List tab.

CIYUI0065E An error occurred while the CSV file
was being uploaded.

Explanation: An error occurred while the CSV file was
being uploaded.

User response: Verify that the format and contents of
the file that you want to upload are correct. If the
problem persists, check the log files.

CIYUI0065I The CSV file was uploaded successfully.

Explanation: This message is for informational
purposes only.

User response: No action is required.

CIYUI0067E The activity cannot be saved because it
launches an instance of a standard
operating procedure that might cause a
loop. For example, the activity launches
an instance of a standard operating
procedure that in turn launches another
instance of the activity's parent standard
operating procedure.

Explanation: The activity that you are attempting to
save would launch an instance of a standard operating
procedure that might cause a loop, as described in the
message.

User response: Edit the activity definition so that the
activity does not launch an instance of a standard
operating procedure that in turn launches another
instance of a standard operating procedure that the
activity is related to.

Using knowledge bases and IBM Support
This section contains topics for using knowledge bases, Fix Central, and IBM Support to find
troubleshooting information.

Searching knowledge bases
You can often find solutions to problems by searching IBM knowledge bases. You can optimize your
results by using available resources, support tools, and search methods.

About this task

You can find useful information by searching the information center for IBM Intelligent Operations
Center, but sometimes you need to look beyond the information center to answer your questions or
resolve problems.

Procedure

To search knowledge bases for information that you need, use one or more of the following approaches:
v Search for content by using IBM Support Assistant Lite (ISA Lite).

ISA Lite is a no-charge software tool that helps you answer questions and resolve problems with IBM
software products. For instructions for downloading and installing ISA Lite, see the links at the end of
the topic.

v Find the content that you need by using the IBM Support Portal.
The IBM Support Portal is a unified, centralized view of all technical support tools and information for
all IBM systems, software, and services. The IBM Support Portal lets you access the IBM electronic
support portfolio from one place. You can tailor the pages to focus on the information and resources
that you need for problem prevention and faster problem resolution. Familiarize yourself with the IBM
Support Portal by viewing the demo videos (https://www.ibm.com/blogs/SPNA/entry/
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the_ibm_support_portal_videos) about this tool. These videos introduce you to the IBM Support Portal,
explore troubleshooting and other resources, and demonstrate how you can tailor the page by moving,
adding, and deleting portlets.

v Search for content about IBM Intelligent Operations Center by using one of the following additional
technical resources:
– IBM Intelligent Operations Center technotes and APARs (problem reports)
– IBM Intelligent Operations Center Support Portal page
– IBM Intelligent Operations Center Forums and communities page
– IBM Smarter Cities Software Solutions Redbooks
– IBM Intelligent Operations Center publication library page

v Search for content by using the IBM masthead search. You can use the IBM masthead search by typing
your search string into the Search field at the top of any ibm.com page.

v Search for content by using any external search engine, such as Google, Yahoo, or Bing. If you use an
external search engine, your results are more likely to include information that is outside the ibm.com
domain. However, sometimes you can find useful problem-solving information about IBM products in
newsgroups, forums, and blogs that are not on ibm.com.

Tip: Include “IBM” and the name of the product in your search if you are looking for information
about an IBM product.

Related concepts:
“Viewing product version details” on page 187
In the Solution Administration view, you can view details of the version of IBM Intelligent Operations
Center and the integrated IBM Smarter Cities Software Solutions that you installed. You can also view
details of any updates that you applied since installation.
“ISA Data Collector for IBM Intelligent Operations Center” on page 396
ISA Data Collector for IBM Intelligent Operations Center helps troubleshoot problems with IBM
Intelligent Operations Center and other IBM software products.
“Techniques for troubleshooting problems” on page 393
Troubleshooting is a systematic approach to solving a problem. The goal of troubleshooting is to
determine why something does not work as expected and how to resolve the problem.

Getting fixes from Fix Central
You can use Fix Central to find the fixes that are recommended by IBM Support for various products,
including IBM Intelligent Operations Center. With Fix Central, you can search, select, order, and
download fixes for your system with a choice of delivery options. A product fix for IBM Intelligent
Operations Center might be available to resolve your problem.

Procedure

To find and install fixes:
1. Obtain the tools that are required to get the fix. If it is not installed, obtain your product update

installer. You can download the installer from Fix Central. This site provides download, installation,
and configuration instructions for the update installer.

2. Select IBM Intelligent Operations Center as the product, and select one or more check boxes that are
relevant to the problem that you want to resolve.

3. Identify and select the fix that is required.
4. Download the fix.

a. Open the download document and follow the link in the “Download Package” section.
b. When downloading the file, ensure that the name of the maintenance file is not changed. This

change might be intentional, or it might be an inadvertent change that is caused by certain web
browsers or download utilities.
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5. To apply the fix, follow the instructions in the “Installation Instructions” section of the download
document.

6. Optional: Subscribe to receive weekly email notifications about fixes and other IBM Support updates.
Related tasks:
“Subscribing to support updates” on page 444
To stay informed of important information about the IBM products that you use, you can subscribe to
updates.
Related information:

Fix Central help

Contacting IBM Support
IBM Support provides assistance with product defects, answering FAQs, and performing rediscovery.

Before you begin

After trying to find your answer or solution by using other self-help options such as technotes, you can
contact IBM Support. Before contacting IBM Support, your company must have an active IBM software
subscription and support contract, and you must be authorized to submit problems to IBM. For
information about the types of available support, see the Support portfolio topic in the Software Support
Handbook.

Procedure

Complete the following steps to contact IBM Support with a problem:
1. Define the problem, gather background information, and determine the severity of the problem. For

more information, see the Getting IBM support topic in the Software Support Handbook.
2. Gather diagnostic information. For information about using IBM Support Assistant Lite to collect IBM

Intelligent Operations Center log files, see the link at the end of the topic.
3. Submit the problem to IBM Support in one of the following ways:

v Using IBM Support Assistant Lite (ISA Lite). See the link at the end of the topic.
v Online through the IBM Intelligent Operations Center Support Portal page: You can open, update,

and view all your Service Requests from the Service Request portlet on the Service Request page.
v By phone: For the phone number to call in your region, see the Directory of worldwide contacts

web page.

Results

If the problem that you submit is for a software defect or for missing or inaccurate documentation, IBM
Support creates an Authorized Program Analysis Report (APAR). The APAR describes the problem in
detail. Whenever possible, IBM Support provides a workaround that you can implement until the APAR
is resolved and a fix is delivered. IBM publishes resolved APARs on the IBM Support website daily, so
that other users who experience the same problem can benefit from the same resolution.

What to do next

Be prepared to work with the IBM technical-support representative by using IBM Assist On-Site, which is
a remote-assistance plug-in that you can download to your computer. The IBM technical-support
representative can use IBM Assist On-Site to view your desktop and share control of your mouse and
keyboard. This tool can shorten the time that it takes to identify the problem, collect the necessary data,
and solve the problem. For more information, see IBM Assist On-Site.
Related concepts:
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“Viewing product version details” on page 187
In the Solution Administration view, you can view details of the version of IBM Intelligent Operations
Center and the integrated IBM Smarter Cities Software Solutions that you installed. You can also view
details of any updates that you applied since installation.
“ISA Data Collector for IBM Intelligent Operations Center” on page 396
ISA Data Collector for IBM Intelligent Operations Center helps troubleshoot problems with IBM
Intelligent Operations Center and other IBM software products.

Subscribing to support updates
To stay informed of important information about the IBM products that you use, you can subscribe to
updates.

About this task

By subscribing to receive updates, you can receive important technical information and updates for
specific IBM Support tools and resources. You can subscribe to updates by using one of two approaches:

RSS feeds
The following RSS feed is available for IBM Intelligent Operations Center: IBM Intelligent
Operations Center.

For general information about RSS, including steps for getting started and a list of RSS-enabled
IBM web pages, visit the IBM Software Support RSS feeds site.

My Notifications
With My Notifications, you can subscribe to Support updates for any IBM product. (My
Notifications replaces My Support, which is a similar tool that you might have used in the past.)
With My Notifications, you can specify that you want to receive daily or weekly email
announcements. You can specify what type of information you want to receive (such as
publications, hints and tips, product flashes (also known as alerts), downloads, and drivers). My
Notifications enables you to customize and categorize the products about which you want to be
informed and the delivery methods that best suit your needs.

Procedure

To subscribe to Support updates:
1. To subscribe to the IBM Intelligent Operations Center RSS feed, use the following substeps:

a. Open the link IBM Intelligent Operations Center RSS feed.
b. In the Subscribe with Live Bookmark window, select a folder in which to save the RSS feed

bookmark and click Subscribe.

For more information on subscribing to RSS feeds, see the IBM Software Support RSS feeds link in the
Related information section at the end of the topic.

2. To subscribe to My Notifications, go to the IBM Support Portal and click My Notifications in the
Notifications portlet.

3. Sign in using your IBM ID and password, and click Submit.
4. Identify what and how you want to receive updates.

a. Click the Subscribe tab.
b. Select IBM Intelligent Operations Center and click Continue.
c. Select your preferences for how to receive updates, whether by email, online in a designated

folder, or as an RSS or Atom feed.
d. Select the types of documentation updates that you want to receive, for example, new information

about product downloads and discussion group comments.
e. Click Submit.
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Results

Until you modify your RSS feeds and My Notifications preferences, you receive notifications of updates
that you have requested. You can modify your preferences when needed (for example, if you stop using
one product and begin using another product).
Related tasks:
“Getting fixes from Fix Central” on page 442
You can use Fix Central to find the fixes that are recommended by IBM Support for various products,
including IBM Intelligent Operations Center. With Fix Central, you can search, select, order, and
download fixes for your system with a choice of delivery options. A product fix for IBM Intelligent
Operations Center might be available to resolve your problem.

Related information

IBM Software Support RSS feeds

Subscribe to My Notifications support content updates

My notifications for IBM technical support

My notifications for IBM technical support overview

Exchanging information with IBM
To diagnose or identify a problem, you might need to provide IBM Support with data and information
from your system. In other cases, IBM Support might provide you with tools or utilities to use for
problem determination.
Related concepts:
“Enabling traces and viewing log files” on page 395
To troubleshoot a problem in IBM Intelligent Operations Center, you might need to analyze log files in
several systems.
“ISA Data Collector for IBM Intelligent Operations Center” on page 396
ISA Data Collector for IBM Intelligent Operations Center helps troubleshoot problems with IBM
Intelligent Operations Center and other IBM software products.

Sending information to IBM Support
To reduce the time that it takes to resolve your problem, you can send trace and diagnostic information
to IBM Support.

Procedure

To submit diagnostic information to IBM Support:
1. Open a problem management record (PMR) using The Service Request tool.
2. Collect the diagnostic data that you need. Diagnostic data helps reduce the time that it takes to

resolve your PMR. You can collect the diagnostic data automatically or manually:
v Collect the data automatically using IBM Support Assistant Lite (ISA Lite). See the link near the top

of the topic.
v Collect the data manually. For information about IBM Intelligent Operations Center log files, see the

links near the top of the topic.
3. Compress the files into either a ZIP file, or a TAR file.
4. Transfer the compressed file to IBM. You can use one of the following methods to transfer the

compressed file to IBM:
v The Service Request tool
v Standard data upload methods: FTP, HTTP
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v Secure data upload methods: FTPS, SFTP, HTTPS
v Email
All of these data exchange methods are explained on the IBM Support site.

Receiving information from IBM Support
Occasionally an IBM technical-support representative might ask you to download diagnostic tools or
other files. You can use FTP to download these files.

Before you begin

Ensure that your IBM technical-support representative provided you with the preferred server to use for
downloading the files and the exact directory and file names to access.

Procedure

To download files from IBM Support:
1. Use FTP to connect to the site that your IBM technical-support representative provided and log in as

anonymous. Use your email address as the password.
2. Change to the appropriate directory:

a. Change to the /fromibm directory.
cd fromibm

b. Change to the directory that your IBM technical-support representative provided.
cd nameofdirectory

3. Enable binary mode for your session.
binary

4. Use the get command to download the file that your IBM technical-support representative specified.
get filename.extension

5. End your FTP session.
quit

Known problems and solutions for IBM Intelligent Operations Center
Some common problems with IBM Intelligent Operations Center are documented, along with their
solutions or workarounds. If you have a problem with IBM Intelligent Operations Center, review the
problem-solution topics to determine if a solution is available to the problem that you are experiencing.

Data sources or data items not being displayed
In certain circumstances, data sources or data items are not displayed in the solution.

Symptoms

The target table in the solution is populated with data but no items are displayed.

Resolving the problem

There are three known instances where data sources or data items are not displayed in the solution. See
the subtopics for resolutions of these issues.

Data items not being displayed because of date or zoom level selection
Due to incorrect solution configuration, data items might not be displayed in the solution.
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Symptoms

The target table in the solution is populated with data but no data items are displayed.

Resolving the problem

Ensure that the start date for your data item falls within the data selection in your filter panel. Also, the
zoom level might be unsuitable for the data that you are viewing. Ensure that the current zoom level
applies to the list as well as to the map. You might also select world view in your map.

Data items not being displayed on the map because of Area name field population
Due to incorrect solution configuration, data items might not be displayed in the solution. If you
populate the Area name field when you create a data source, data items might not be displayed on the
map.

Symptoms

The target table in the solution is populated with data but no data items are displayed on the map.

Resolving the problem

Recreate the data source without populating the Area name field.

Data source routing updates not reflected in filtered results
If you edit the routing criteria for a data source, it might take several refresh cycles before data items that
match the updated routing criteria are displayed.

Symptoms

You have created a data source with routing criteria. You have configured the filter criteria so that data
items from the data source are displayed in either the maps, or in a list. You update the routing criteria
for the data source, and then you wait for the refresh interval. Extra data items that you expect to be
displayed, might not be displayed. Items that meet the previous routing criteria are still displayed.

Resolving the problem

The data items that are displayed in the filtered results do not reflect the updated routing criteria because
of how the data receiver processes the last updated time stamps for the data items. If you update the
routing criteria for a data source, records that match the updated routing criteria are processed when the
lastupdatedatetime field of the records is updated. Therefore, it might take several refresh cycles before
data items that match the updated routing criteria are displayed. However, items that met the previous
routing criteria are still displayed because they have already been processed and the routing affects only
either unprocessed, or updated, staging data.
Related tasks:
“Routing data from your data source” on page 111
For the data that is received from your data source, set routing expressions that define how the data is
processed by the solution. Data items that match the required expression or combination of expressions
are routed to the selected destination.

Relocated items are not removed after a refresh
In either the map, the location map, or the list, if you update the location of an item to outside the
viewable map area, the item remains in its previous location. The updated item is not removed from the
viewable map area until the browser window is refreshed.
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Symptoms

If you relocate an item to outside the viewable map area, the item remains visible after the automatic
refresh interval expires. The automatic refresh returns only the items that are in the current viewable map
area that have changed since the last refresh. Because the updated item is no longer in the viewable map
area, the item is not returned as a changed item. Therefore, the item is not removed from either the map,
the location map, or the list.

Resolving the problem

Refresh the browser to rerun a full query and cause the updated item to be removed from either the map,
the location map, or the list. Alternatively, change the zoom level on the map to refresh the data.
Changing the zoom level on the map might refresh the data more quickly than refreshing the browser.

System performance issues
System performance issues and unexplained user interface errors can occur if log files fill up a file system
partition and space for active logs becomes unavailable.

Symptoms

Errors might occur when you attempt to save data or use features in IBM Intelligent Operations Center.

Resolving the problem

Check that the file systems on the data server are not full. See the related link for information about how
to maintain database log files.
Related concepts:
“Log file maintenance” on page 359
IBM Intelligent Operations Center stores log files in several different locations. To prevent system
outages, periodically back up the database, archive log files, and remove the original log files.

Third-party server not responding
In the standard topology, you might receive the Third-party server not responding error message after
you log on to WebSphere Portal.

Symptoms

You receive the Third-party server not responding error message after you log on to WebSphere Portal.

Resolving the problem
1. To query the status of WebSphere Portal, enter the following commands to log on to the server where

the IOCControl script is, and to run the IOCControl script. By default, the IOCControl script is on the
installation server.
su – ibmadmin
IOCControl -a status -c wpe -p topology_password

If WebSphere Portal is running, a message that is similar to the following example is displayed:
Executing query command.....completed.
IBM WebSphere Portal Extend [ on ]
Command completed successfully.

2. If WebSphere Portal is not running, enter the following command:
IOCControl -a start -c wpe -p topology_password
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Authentication mechanism not available
In the standard topology, you might receive the HPDIA0119W Authentication mechanism is not available
error message after you log on to WebSphere Portal.

Symptoms

You receive the HPDIA0119W Authentication mechanism is not available error message after you log on
to WebSphere Portal.

Resolving the problem
1. To log on to the application server as ibmadmin, and to query the status of Tivoli Directory Server,

enter the following commands:
su – ibmadmin
IOCControl -a status -c tds -p topology_password

If Tivoli Directory Server is running, a message that is similar to the following example is displayed:
Executing query command.....completed.
IBM Tivoli Directory Server [ on ]
Command completed successfully.

2. If Tivoli Directory Server is not running, enter the following command:
IOCControl -a start -c tds -p topology_password

KPI data is not displayed in the status views
KPI data might not display in the status views because of a change in the security settings, or an issue
with IBM Business Monitor.

Symptoms

KPI data does not display in the status views of the solution.

Resolving the problem
v Check whether the issue is related to a change in security settings:

1. Check your port settings. If an administrator changes the HTTPS secure connection settings in the
system properties, and you do not change the port settings accordingly, a problem occurs when the
status views retrieve data from IBM Business Monitor.

2. Check whether the SSL certificate has expired. If the SSL certificate has expired, import a new SSL
certificate into the WebSphere Application Server truststore.

3. Check the credentials that are used to connect to IBM Business Monitor. If an administrator has
updated the credentials, update the credentials that are stored in the wbmadmin JAAS entry in
WebSphere Application Server.

v To check the status of IBM Business Monitor, log on to the WebSphere Application Server
administration console. For more information about accessing administration consoles, see the link.
1. In the WebSphere Application Server administration console, click Servers > Clusters > WebSphere

Application Server clusters.
2. Choose the appropriate option:

– If the status of WBM.DE.AppTarget is stopped, restart it.
– If the status of WBM.DE.AppTarget is not stopped, stop it and then restart it.

If the issue is not resolved, then proceed to the next substep.
3. Check the IBM Business Monitor logs to investigate and resolve any issues with IBM Business

Monitor. For more information about checking the logs, see the link at the end of the topic.
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4. When all IBM Business Monitor issues are resolved, log on to the WebSphere Application Server
administration console and restart IBM Business Monitor.

Related concepts:
“Administering the services” on page 187
Use the Administration Consoles to administer the services that are provided by the solution.

KPI events not updated in the status views
KPI event data might not be updated in the status views.

Symptoms

KPI event data does not update in the status views.

Resolving the problem
v Confirm that KPI event updates are reaching IBM Business Monitor:

1. Log on to the WebSphere Application Server administration console. For more information about
accessing administration consoles, see the link at the end of the topic.

2. Click Troubleshooting > Monitor Models > Failed Event Sequences. Delete any KPI events that
are displayed on the page.

3. Restart IBM Business Monitor.
4. Click Applications > Monitor Services > Recorded Events Management > Enable/Disable Events

Record, and enable event recording.
5. Click Applications > Monitor Services > Recorded Events Management > Events Management.

Check on the page that at least two events are created for every KPI event that is sent to IBM
Intelligent Operations Center.

v Confirm that KPI events are being updated in the status views. For more information about viewing
KPIs, see the link at the end of the topic. If you see that the KPI values are updated in the status
views, then the values are also updated in IBM Business Monitor.

Related concepts:
“Administering the services” on page 187
Use the Administration Consoles to administer the services that are provided by the solution.
“Monitoring status through KPIs” on page 384
Use the status view to see the status of key performance indicators (KPIs) in summary or in detail
format.

KPI report associated with a data source cannot be deleted
When you delete a data source that is associated with a KPI report, the KPI report remains mapped to
the data source. If you access the report, an error is displayed.

Symptoms

If you delete a data source that is associated with a KPI report, the report remains mapped to the data
source. If you access the KPI report after you have deleted the data source, the following error is
displayed:
An error occurred while performing operation ’sqlPrepareWithOptions’ status=’-69’.

Resolving the problem

If the link to a KPI report is broken, you can disassociate the report from the KPI with the KPI
customization tool. Alternatively, reassociate the KPI report with an existing data source to generate a
new report.
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Date and time format displayed incorrectly in the Arabic locale
In the IBM Intelligent Operations Center user interface, if you select the Arabic locale, the date and time
are formatted incorrectly.

The Dojo toolkit, which is used to implement the IBM Intelligent Operations Center user interface, does
not currently support Arabic numerals.

Unable to start the LDAP server using the Tivoli Directory Server Web
Administration Tool
When trying to start the LDAP server using the Tivoli Directory Server Web Administration Tool, an
HTTP 500 error is returned and the LDAP server will not start.

Resolving the problem

Start Tivoli Directory Server using the platform control tool.
Related concepts:
“Starting, stopping, and querying status in a standard environment” on page 190
The platform control tool allows a user to stop, start, and query IBM Intelligent Operations Center
components running in a standard environment. A platform control tool tool is also available for IBM
Intelligent Operations Center running in a high availability environment.
“Starting, stopping, and querying status in a high availability environment” on page 198
The platform control tool allows a user to stop, start, and query IBM Intelligent Operations Center
services running in a high availability environment. A platform control tool tool is also available for IBM
Intelligent Operations Center running in a standard environment.

Connections refused with large number of users
In IBM Intelligent Operations Center, if there are more than approximately 400 users, some connections
might be refused.

Symptoms

If there are more than approximately 400 users in IBM Intelligent Operations Center, some connections to
the solution might be refused. This occurs because the sockets are exhausted on the IBM HTTP Server.
You might have to increase the maximum allowed number of clients to resolve this issue.

Resolving the problem

The IBM Intelligent Operations Center user interface can send many AJAX requests from each browser
page. It might be necessary to increase the maximum number of clients that are supported by IBM HTTP
Server. In the httpd.conf file, a stanza defines the settings for the worker MPM (Multi-Processing
Module), as shown in the following example:
# worker MPM
#
# ThreadLimit: maximum setting of ThreadsPerChild
# ServerLimit: maximum setting of StartServers
# StartServers: initial number of server processes to start
# MaxClients: maximum number of simultaneous client connections
# MinSpareThreads: minimum number of worker threads which are kept spare
# MaxSpareThreads: maximum number of worker threads which are kept spare
# ThreadsPerChild: constant number of worker threads in each server process
# MaxRequestsPerChild: maximum number of requests a server process serves
<IfModule worker.c>

ThreadLimit 25
ServerLimit 64
StartServers 1
MaxClients 600
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MinSpareThreads 25
MaxSpareThreads 75
ThreadsPerChild 25
MaxRequestsPerChild 0

</IfModule>

The default value of the MaxClients setting is 600. Complete the following steps to increase the maximum
number of clients:
1. Change the value of the MaxClients setting to a value that is more appropriate for the user load and

complexity of the client page.

Note: As a guide, set the value of the MaxClients setting to a value that is equal to 2.5 - 3 times the
number of concurrent users that might view an IBM Intelligent Operations Center browser page.

2. Restart IBM HTTP Server for the changes to take effect.

IBM Intelligent Operations Center stops responding if the primary
application server becomes inoperable
In an IBM Intelligent Operations Center high availability environment, if the primary application server
becomes inoperable, IBM Intelligent Operations Center stops responding to user input.

Symptoms

To provide a working high availability implementation, the IBM Intelligent Operations Center installation
uses the primary application server as the host file system. If the primary application server becomes
inoperable for any reason, the data that is hosted and shared on the file system is no longer accessible to
the secondary application server. The secondary application server then becomes inoperable.

IBM Intelligent Operations Center stops responding to user input if the primary application server
becomes inoperable in a high availability environment.

Resolving the problem

Replace the default IBM Intelligent Operations Center NFS configuration for hosting image, CSV, and JAR
files with a stand-alone NFS server. In the steps, use the following directories:
/opt/IBM/ioc/csv
/opt/IBM/ioc/lib
/opt/IBM/WebSphere/wp_profile/installedApps/cell1/ioc_theme_ear.ear/

ioc_theme_static_js_web.war/images

1. Create and export the directories on the stand-alone NFS server.
2. Copy the contents of the same directories that are on the primary application server to the directories

that you just created on the stand-alone NFS server.
3. For the directories on the primary application server, delete the contents and also remove the export.
4. Configure the primary application server and the secondary application server to mount the

directories from the stand-alone NFS file server.
5. After you complete the configuration, stop and restart the NFS service on the primary application

server and the secondary application server.

Data import fails
When you import data from a data source into IBM Intelligent Operations Center, if the correct data and
data types are not used, the data import fails and an error is displayed.
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Symptoms

If you import data from a data source into IBM Intelligent Operations Center, where the solution start
date and end date columns are configured as string values, and the data source time column contains
values that are not time type values, the following error is displayed:
[2/10/14 13:38:28:367 GMT] 00000051 DataReceiverL I com.ibm.ioc.datareceiver.utils.DataReceiverUtil
parseStartAndEndDateFromString java.text.ParseException: Unparseable date: "2008-10-02"

at java.text.DateFormat.parse(DateFormat.java:348)
at com.ibm.ioc.datareceiver.utils.DataReceiverUtil.

parseStartAndEndDateFromString(DataReceiverUtil.java:5077)

Resolving the problem

To prevent the data import error, configure the data source to have start date and end date columns that
are string data types, and leave the time column empty. The data import process correctly assigns the
default time.

Screen reader does not announce time values
The screen reader does not announce time values from list boxes. You can work around this problem by
typing the time into the field in the 12-hour format.

Symptoms

If you use the JAWS screen reader to select a list box that contains time values, the reader announces
"start date and time edit combo required", followed by an announcement of the time. However, the
reader does not announce the time values that you can select from the list to enter into the field.

Resolving the problem

Use the keyboard to type a time value into the field in the 12-hour format that is required by the client
operating system.

Screen reader keyboard instructions announced inconsistently
If you select a translation wizard form field, the screen reader might not announce the keyboard controls
consistently.

Symptoms

The screen reader might not announce the keyboard controls consistently for a translation wizard form
field.

Resolving the problem

If the translation wizard form is displayed, the screen reader announces menu. If required, press the Jaws
key + Insert key combination to revert to keyboard control announcements.

Translation wizard label not announced
If you initially click an empty field in a translation wizard form, the label name is announced by the
screen reader. However, if you return to the completed field in the translation wizard form, the screen
reader might not announce the label name.

Symptoms

The screen reader might not announce the label name for a completed field in a translation wizard form.
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Resolving the problem

Update either your browser, or your version of Jaws. The issue does not occur in Firefox 24 with Jaws
14.0.1823. Also, the issue does not occur in Firefox 17 with any version of either Jaws 14, or Jaws 15.
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Chapter 11. Reference

These topics contain additional reference information to help you.

IBM Intelligent Operations Center REST interface
IBM Intelligent Operations Center provides a set of APIs that are implemented by using Representational
State Transfer (REST) Services. The REST services provide a set of uniform resource identifiers (URIs) that
access data in IBM Intelligent Operations Center components, such as system properties and key
performance indicators (KPIs).

You can call the services with any HTTP client application, and define an expected response in the form
of a JavaScript Object Notation (JSON) object. The JSON format can be easily parsed and processed by
JavaScript, and other products, tools, and languages, which gives you greater flexibility in using your
own environment.

Many of the services take a simple HTTP GET URI as input. More complicated services take JSON input
through HTTP GET for retrieval, HTTP POST for create, or HTTP PUT for update. Results are returned in
JSON, and error messages and status indicators are returned in the HTTP response as JSON output.

Resource URIs

Each IBM Intelligent Operations Center REST resource URI has the following format:
http://{host}:{port}//ibm/ioc/api/{service-name}/{resource}?{parameters}

Where:
v http://{host}:{port} contains the host address and port
v ibm/ioc/api is the context root
v {service-name} represents the service
v {resource} represents the logical resource
v {parameters} are the parameters to apply to the query

REST services access

Access to the REST services is restricted to authorized IBM Intelligent Operations Center users. In
addition, access to the POST, PUT, and DELETE methods for most services is restricted to administrative
users. An administrative user is a member of at least one of the following groups: CityWideAdmin, and
wpsadmins.

For more information about adding users to groups, see the link at the end of the topic.

Resource versions

The following changes are considered compatible between versions and must be expected by clients:
v Adding a REST resource relationship to the resource model, without affecting existing navigation.
v Adding additive information to REST representations that do not affect existing clients.
v Adding a MIME type or representation support.
v Adding new properties to existing JSON objects that are returned to a client that are ignored by earlier

clients.
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v Adding new properties to existing JSON objects that are received from a client that are defined as
optional.

HTTP methods

The IBM Intelligent Operations Center REST interface provides the following HTTP methods:

GET Read a resource.

POST Create a resource.

PUT Update a resource.

DELETE
Delete a resource.

Error handling

For errors that are recognized during the processing of an IBM Intelligent Operations Center REST
request, an appropriate HTTP status code is returned to the calling client, for example, 200 OK or 404 Not
found.

Supported standards

The IBM Intelligent Operations Center REST APIs support the following Internet standards:

Table 64. Internet standards supported by the IBM Intelligent Operations Center REST APIs

Standard Reference

HTTP 1.1 RFC 2616

MIME, Part 1: Format of Internet Message Bodies RFC 2045

MIME, Part 2: Media Types RFC 2046

MIME Media Types The Internet Corporation for Assigned Names and
Numbers (IANA)

JSON Schema Internet Engineering Task Force

Related tasks:
“Viewing or modifying group membership” on page 94
View or modify group membership to manage the access permissions of users in IBM Intelligent
Operations Center.
Related information:

IBM Intelligent Operations Center V1.6 REST APIs

Products and components installed with IBM Intelligent Operations
Center in a standard topology
The IBM Intelligent Operations Center solution installs a number of software products and components
for the standard topology.

The software products and components and the servers they are installed on are shown in Table 65 on
page 457.
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Table 65. Products installed with IBM Intelligent Operations Center

Product
Application
server Analytics server Data server Web server

Semantic model
server (optional)

1.6.0.2

Tivoli Directory
Server 6.3.0.26
(including the
GSKit upgrade
to 8.0.50.16)

1.6

1.6.0.1

Tivoli Directory
Server 6.3.0.18

not installed not installed installed not installed not installed

1.6.0.2 DB2
Enterprise
Server Edition
10.1.0.3

1.6

1.6.0.1 DB2
Enterprise
Server Edition
10.1.0.1

not installed not installed installed not installed not installed

1.6.0.2 DB2
10.1.0.3 Client

1.6

1.6.0.1 DB2
10.1.0.1 Client

installed installed not installed not installed not installed

1.6.0.2

Tivoli Directory
Integrator 7.1.1.3

1.6

1.6.0.1

Tivoli Directory
Integrator 7.1.1.2

plug-in features
installed

plug-in features
installed

all features
installed

plug-in features
installed

not installed

Tivoli Directory
Integrator
Dispatcher 6.0.6

not installed not installed installed not installed not installed

Tivoli Directory
Integrator
POSIX adapter
6.0.23

not installed not installed installed not installed not installed

IBM Installation
Manager 1.6.0

installed installed not installed installed installed
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Table 65. Products installed with IBM Intelligent Operations Center (continued)

Product
Application
server Analytics server Data server Web server

Semantic model
server (optional)

1.6.0.2

WebSphere
Application
Server 7.0.0.31

1.6

1.6.0.1

WebSphere
Application
Server 7.0.0.27

installed not installed not installed not installed installed

1.6.0.2

WebSphere
Application
Server Network
Deployment
8.0.0.8

1.6

1.6.0.1

WebSphere
Application
Server Network
Deployment
8.0.0.6

installed installed not installed not installed not installed

WebSphere
Application
Server 1.1.0.3
Feature Pack for
Web 2.0 and
Mobile

installed not installed not installed not installed installed

IBM Business
Monitor 8.0.1.0

installed not installed not installed not installed not installed

1.6.0.2

WebSphere
Portal 8.0.0.1
CF08 (including
GSKit fix
IFPI05309)

1.6

1.6.0.1

WebSphere
Portal 8.0.0.1
CF05

installed not installed not installed not installed not installed

1.6.0.2 IBM
HTTP Server
8.0.0.8

1.6

1.6.0.1 IBM
HTTP Server
8.0.0.6

not installed not installed not installed installed not installed
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Table 65. Products installed with IBM Intelligent Operations Center (continued)

Product
Application
server Analytics server Data server Web server

Semantic model
server (optional)

1.6.0.2 IBM
HTTP Server
7.0.0.31

1.6

1.6.0.1 IBM
HTTP Server
7.0.0.27

not installed not installed not installed not installed installed

WebSphere MQ
7.5

not installed installed not installed not installed not installed

1.6.0.2 IBM
Message Broker
8.0.0.3

1.6

1.6.0.1 IBM
Message Broker
8.0.0.1

not installed installed not installed not installed not installed

IBM Cognos
Business
Intelligence 10.2

not installed installed not installed not installed not installed

SPSS Modeler
Base 15.0

not installed installed not installed not installed not installed

SPSS Modeler
Data Access 6.1

not installed installed not installed not installed not installed

1.6.0.2 IBM
ILOG CPLEX
Optimization
Studio 12.6

1.6

1.6.0.1 IBM
ILOG CPLEX
Optimization
Studio 12.5

not installed installed not installed not installed not installed

1.6.0.2 IBM
Java 1.7.0.6.1

1.6

1.6.0.1 IBM
Java 1.7.0.4.2

not installed installed not installed not installed not installed

Lotus Domino
8.5.3.1

installed not installed not installed not installed not installed

Lotus Sametime
Entry 8.5.2.1

installed not installed not installed not installed not installed

IBM Worklight
Consumer
Edition 6.0.0

installed not installed not installed not installed not installed
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Table 65. Products installed with IBM Intelligent Operations Center (continued)

Product
Application
server Analytics server Data server Web server

Semantic model
server (optional)

Lotus Sametime
Proxy 8.5.2

installed not installed not installed not installed not installed

1.6.0.2 IBM
Security Identity
Manager 6.0.0.2

1.6

1.6.0.1 IBM
Security Identity
Manager 6.0

installed not installed not installed not installed not installed

Data Studio
3.2.0 (Optional
component)

not installed not installed installed
Note: IBM
Installation
Manager 1.6.0 will
also be installed
on this server if
Data Studio is
installed.

not installed not installed

Semantic model
services

not installed not installed not installed not installed installed

Jazz Foundation
Server 3.0.1 (for
semantic model
services)

not installed not installed not installed not installed installed

Related concepts:
“What's new in version 1.6.0.2” on page 14
IBM Intelligent Operations Center version 1.6.0.2 provides several new features, and provides updates to
existing features. New features include enhanced user profile management, where users can customize
notification settings. Solution administrators can use a new component customization tool to create
customized user interface components. For KPIs, solution administrators can map KPIs to reports.

Products and components installed with IBM Intelligent Operations
Center in a high availability topology
The IBM Intelligent Operations Center solution installs a number of software products and components
for the high availability topology.

The software products and components and the servers they are installed on in a high availability
environment are shown in Table 66.

Table 66. Products installed with IBM Intelligent Operations Center

Product
Application
server 1

Application
server 2

Analytics server
1

Analytics server
2 Data server 1 Data server 2 Web server 1 Web server 2

Semantic model
server (optional)

1.6.0.2 Tivoli
Directory Server 6.3.0.26
(including the GSKit upgrade to
8.0.50.16)

1.6

1.6.0.1 Tivoli
Directory Server 6.3.0.18

not installed not installed installed installed installed installed not installed not installed not installed
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Table 66. Products installed with IBM Intelligent Operations Center (continued)

Product
Application
server 1

Application
server 2

Analytics server
1

Analytics server
2 Data server 1 Data server 2 Web server 1 Web server 2

Semantic model
server (optional)

1.6.0.2 DB2
Enterprise Server Edition 10.1.0.3

1.6

1.6.0.1 DB2
Enterprise Server Edition 10.1.0.1

not installed not installed not installed not installed installed installed not installed not installed not installed

1.6.0.2 DB2 10.1.0.3
Client

1.6

1.6.0.1 DB2 10.1.0.1
Client

installed installed installed installed not installed not installed not installed not installed not installed

1.6.0.2 Tivoli
Directory Integrator 7.1.1.3

1.6

1.6.0.1 Tivoli
Directory Integrator 7.1.1.2

plug-in features
installed

plug-in features
installed

plug-in features
installed

plug-in features
installed

all features
installed

plug-in features
installed

plug-in features
installed

plug-in features
installed

not installed

Tivoli Directory Integrator
Dispatcher 6.0.6

not installed not installed not installed not installed installed not installed not installed not installed not installed

Tivoli Directory Integrator POSIX
adapter 6.0.23

not installed not installed not installed not installed installed not installed not installed not installed not installed

IBM Installation Manager 1.6.0 installed installed installed installed not installed not installed installed installed installed

1.6.0.2 WebSphere
Application Server 7.0.0.31

1.6

1.6.0.1 WebSphere
Application Server 7.0.0.27

installed installed not installed not installed not installed not installed not installed not installed installed

1.6.0.2 WebSphere
Application Server Network
Deployment 8.0.0.8

1.6

1.6.0.1 WebSphere
Application Server Network
Deployment 8.0.0.6

installed installed installed installed not installed not installed not installed not installed not installed

WebSphere Application Server
1.1.0.3 Feature Pack for Web 2.0
and Mobile

installed installed not installed not installed not installed not installed not installed not installed installed

IBM Business Monitor 8.0.1.0 installed installed not installed not installed not installed not installed not installed not installed not installed

1.6.0.2 WebSphere
Portal 8.0.0.1 CF08 (including
GSKit fix IFPI05309)

1.6

1.6.0.1 WebSphere
Portal 8.0.0.1 CF05

installed installed not installed not installed not installed not installed not installed not installed not installed

1.6.0.2 IBM HTTP
Server 8.0.0.8

1.6

1.6.0.1 IBM HTTP
Server 8.0.0.6

not installed not installed not installed not installed not installed not installed installed installed not installed

1.6.0.2 IBM HTTP
Server 7.0.0.31

1.6

1.6.0.1 IBM HTTP
Server 7.0.0.27

not installed not installed not installed not installed not installed not installed not installed not installed installed

WebSphere MQ 7.5 not installed not installed installed installed not installed not installed not installed not installed not installed
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Table 66. Products installed with IBM Intelligent Operations Center (continued)

Product
Application
server 1

Application
server 2

Analytics server
1

Analytics server
2 Data server 1 Data server 2 Web server 1 Web server 2

Semantic model
server (optional)

1.6.0.2 IBM Message
Broker 8.0.0.3

1.6

1.6.0.1 IBM Message
Broker 8.0.0.1

not installed not installed installed installed not installed not installed not installed not installed not installed

IBM Cognos Business Intelligence
10.2

not installed not installed installed installed not installed not installed not installed not installed not installed

SPSS Modeler Base 15.0 not installed not installed installed installed not installed not installed not installed not installed not installed

SPSS Modeler Data Access 6.1 not installed not installed installed installed not installed not installed not installed not installed not installed

1.6.0.2 IBM ILOG
CPLEX Optimization Studio 12.6

1.6

1.6.0.1 IBM ILOG
CPLEX Optimization Studio 12.5

not installed not installed installed installed not installed not installed not installed not installed not installed

1.6.0.2 IBM Java
1.7.0.6.1

1.6

1.6.0.1 IBM Java
1.7.0.4.2

not installed not installed installed installed not installed not installed not installed not installed not installed

Lotus Domino 8.5.3.1 installed not installed not installed not installed not installed not installed not installed not installed not installed

Lotus Sametime Entry8.5.2.1 installed not installed not installed not installed not installed not installed not installed not installed not installed

IBM Worklight Consumer Edition
6.0.0

installed installed not installed not installed not installed not installed not installed not installed not installed

Lotus Sametime Proxy 8.5.2 installed not installed not installed not installed not installed not installed not installed not installed not installed

1.6.0.2 IBM Security
Identity Manager 6.0.0.2

1.6

1.6.0.1 IBM Security
Identity Manager 6.0

installed not installed not installed not installed not installed not installed not installed not installed not installed

Data Studio 3.2.0 (Optional
component)

not installed not installed not installed not installed Note: IBM
Installation
Manager 1.6.0
will also be
installed on this
server if Data
Studio is
installed.

Note: IBM
Installation
Manager 1.6.0
will also be
installed on this
server if Data
Studio is
installed.

not installed not installed not installed

Semantic model services not installed not installed not installed not installed not installed not installed not installed not installed installed

Jazz Foundation Server 3.0.1 (for
semantic model services)

not installed not installed not installed not installed not installed not installed not installed not installed installed

Related concepts:
“What's new in version 1.6.0.2” on page 14
IBM Intelligent Operations Center version 1.6.0.2 provides several new features, and provides updates to
existing features. New features include enhanced user profile management, where users can customize
notification settings. Solution administrators can use a new component customization tool to create
customized user interface components. For KPIs, solution administrators can map KPIs to reports.

Products included, but not installed, with IBM Intelligent Operations
Center

1.6.0.1

The IBM Intelligent Operations Center package includes products that are not installed when IBM
Intelligent Operations Center is installed. If required for specific use cases, these products can be installed
after IBM Intelligent Operations Center is installed.
v IBM SmartCloud Control Desk 7.5.1
v IBM Social Media Analytics 1.2
v IBM Tivoli Composite Application Manager for Applications 7.2.0.1
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v IBM Tivoli Monitoring 6.3
v IBM Tivoli Netcool/Impact 6.1.1
v IBM Tivoli Netcool/OMNIbus 7.4
v IBM Security Access Manager for Web 7.0
Related concepts:
“What's new in version 1.6.0.2” on page 14
IBM Intelligent Operations Center version 1.6.0.2 provides several new features, and provides updates to
existing features. New features include enhanced user profile management, where users can customize
notification settings. Solution administrators can use a new component customization tool to create
customized user interface components. For KPIs, solution administrators can map KPIs to reports.

Ports used by IBM Intelligent Operations Center servers
IBM Intelligent Operations Center uses specific ports.

The ports used by IBM Intelligent Operations Center are shown in Table 67. In a high availability
environment these ports are used on both the primary and standby servers.

Table 67. Ports used by IBM Intelligent Operations Center

Server Ports required for product use

Application server 84, 1352, 1516, 1533, 2810, 2811, 2812, 2813, 2814, 2815, 7272, 7273, 7274, 7275, 7277, 7278,
7288, 7291, 8082, 8878, 8879, 8882, 8883, 8884, 8885, 8886, 8887, 8888, 8889, 8890, 9044, 9046,
9047, 9048, 9050, 9061, 9063, 9064, 9065, 9066, 9067, 9081, 9082, 9083, 9084, 9085, 9092, 9094,
9101, 9103, 9104, 9105, 9106, 9107, 9201, 9202, 9203, 9204, 9205, 9206, 9207, 9208, 9209, 9210,
9352, 9354, 9355, 9356, 9357, 9358, 9359, 9360, 9361, 9362, 9404, 9406, 9411, 9412, 9414, 9415,
9417, 9418, 9419, 9420, 9422, 9423, 9444, 9445, 9446, 9447, 9448, 9629, 9630, 9631, 9632, 9634,
9635, 9636, 9637, 9638, 9639, 9641, 9809, 9811, 9812, 9813, 9900, 9902, 9904, 9906, 9908, 10025,
10029, 10030, 10033, 10034, 10035, 10036, 10037, 10039, 10039, 10129, 18002

The following are also used in a high availability environment: 10043, 10044, 10045, 10047,
10048, 10050, 10051, 10053, 10056, 10057, 10058

Data server 389, 523, 1098, 1099, 1527, 3538, 3737, 3766, 18001, 18002, 50001, 50002

The following are also used in a high availability environment: 55002, 55003, 55004, 55005,
55006, 55007, 55008, 55009, 55010, 55011, 55012, 55013, 55014, 55015, 55016, 55025

Analytics server 2809, 2810, 4414, 7272, 7273, 8878, 8879, 8882, 8883, 8884, 8891, 9046, 9047, 9048, 9051, 9063,
9064, 9065, 9068, 9081, 9082, 9083, 9086, 9103, 9104, 9105, 9109, 9201, 9202, 9203, 9204, 9353,
9354, 9355, 9356, 9358, 9365, 9411, 9412, 9414, 9415, 9417, 9418, 9427, 9444, 9445, 9446, 9449,
9629, 9630, 9635, 9636, 9637, 9642, 9811, 9812, 9813, 9814, 9900, 9902, 18002

The following are also used in a high availability environment: 389, 3538

Web server 80, 443, 8008, 18002

Semantic model server
(optional)

80, 82, 2809, 2810, 2811, 2812, 2813, 3538, 3737, 7272, 7273, 7274, 7275, 7277, 7281, 8008, 8878,
8879, 8880, 8881, 8882, 8883, 8884, 8885, 8886, 8887, 8888, 9043, 9044, 9045, 9046, 9047, 9048,
9060, 9061, 9062, 9063, 9064, 9065, 9080, 9081, 9082, 9083, 9084, 9100, 9101, 9102, 9103, 9104,
9105, 9201, 9202, 9203, 9204, 9205, 9206, 9207, 9208, 9209, 9210, 9352, 9353, 9354, 9355, 9356,
9357, 9358, 9359, 9360, 9361, 9362, 9402, 9403, 9405, 9406, 9408, 9409, 9411, 9412, 9414, 9415,
9417, 9418, 9443, 9444, 9445, 9446, 9447, 9629, 9630, 9631, 9632, 9633, 9634, 9635, 9636, 9637,
9638, 9639, 9809, 9810, 9811, 9812, 9813, 9814, 9900, 9902, 9904, 9906, 9908

Processes running under the root account
After cyber hygiene completes, some processes must still run under the root account.
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Processes running under the root account can be vulnerable if a user or process can obtain root
privileges through privilege escalation. Normally this is only a problem for services processing requests
originated by a user. User-originated requests can contain maliciously configured input that can
compromise the server. Services processing user requests are systems providing user interfaces or
accessible application programming interfaces (APIs).

Linux daemons are not normally at risk since they usually only start, stop, or respond to well-defined
system events. In many cases these daemons must run as the root account so they can control other
processes or respond to critical system events. As long as a user-accessible server itself is not running as
root, daemons running under the root account do not present as serious an exposure.

Table 68 lists the processes that continue running as the root account after installation is complete.

Table 68. IBM Intelligent Operations Center environment processes running as root
Server Product Process Name Explanation

data server DB2 db2wdog This daemon process receives system
events and propagate them to multiple
child processes. The db2wdog process
manages the db2sync processes and
requires root level management.

data server DB2 db2chkpwd This daemon authenticates the user ID
and password of the user or application
connecting to a database. The db2chkpwd
process needs to read the /etc/shadow
password file.

data server DB2 /opt/IBM/DB2/bin/db2fmcd This daemon serves as a fault monitoring
coordinator. It must run as root to
monitor all DB2 instances.

data server DB2 /usr/sbin/rcst/bin/rmcd and
/usr/sbin/rcst/bin/IBM.ConfigRMd

These commands manage the high
availability solution for DB2. They need
access to all databases on the servers
configured for high availability.

data server DB2 /sbin/srcmstr This daemon starts and monitors all
daemons in the Tivoli System Automation
for Multiplatforms Reliable Scalable
Cluster Technology (TSAMP/RSCT)
environment.

web server IBM HTTP Server httpd -d, http -f Linux requires root access to listen on
ports less than 1024. Standard HTTP
ports are 80 through 443. IBM Intelligent
Operations Center uses port 82. The
httpd -d and http -f processes must run
as root. Any alternate configuration is the
responsibility of the installation as part of
comprehensive network and security
policy and configuration.

application server, analytics server, data
server, web server

Tivoli Directory Integrator /opt/IBM/TDI/V7.1/jvm/jre/bin/java
.... /pwd_plugins/pam/pwsync_ioc.props
, /opt/IBM/TDI/V7.1/jvm/jre/bin/java
.... /pwd_plugins/tds/pwsync_ioc.props

Tivoli Directory Server and Linux
Password Synchronizer Java Proxy
processes must run as root to intercept
password change requests.

PDF library
This topic provides links to the help content in PDF format for convenient printing.
v IBM Intelligent Operations Center publication library page

Glossary
This glossary provides terms and definitions for the IBM Intelligent Operations Center software and
products.

The following cross-references are used in this glossary:
v See refers you from a term to the preferred term or from an abbreviation to the full form.
v See also refers you to a related or contrasting term.

For other terms and definitions, see the IBM Terminology website (opens in new window).
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“A” “B” “C” on page 466 “D” on page 466 “E” on page 467 “G” on page 467 “H” on page 467 “I” on
page 467 “J” on page 468 “K” on page 468 “L” on page 469 “M” on page 469 “N” on page 469 “O” on
page 470 “P” on page 470 “R” on page 470 “S” on page 471 “T” on page 472 “U” on page 472 “V” on
page 473 “W” on page 473 “X” on page 473

A
Abstract Syntax Notation One (ASN.1)

The international standard for defining the syntax of information data. It defines a number of
simple data types and specifies a notation for referencing these types and for specifying values of
these types. The ASN.1 notations can be applied whenever it is necessary to define the abstract
syntax of information without constraining in any way how the information is encoded for
transmission.

access control list (ACL)
In computer security, a list associated with an object that identifies all the subjects that can access
the object and their access rights.

ACL See access control list.

administrator permission
The authority granted to an administrator to give them access to create, configure, and delete
portal resources or users. This authority is granted by membership of a user role group.

aggregation KPI
A KPI value that is calculated from a metric using an aggregation function.

APAR See authorized program analysis report.

ASN.1 See Abstract Syntax Notation One.

asynchronous
Pertaining to events that are not synchronized in time or do not occur in regular or predictable
time intervals.

attribute
A characteristic or trait of an entity that describes the entity; for example, the telephone number
of an employee is one of the employee attributes.

authenticated portal user
A user that is a member of an umbrella group within WebSphere Portal authenticated with a
profile containing a password and user ID.

authentication
A security service that provides proof that a user of a computer system is genuinely who that
person claims to be. Common mechanisms for implementing this service are passwords and
digital signatures.

authorization
The process of granting a user, system, or process either complete or restricted access to an object,
resource, or function.

authorization permission
Access to a portal, resource, or data associated with membership of a group.

authorized program analysis report (APAR)
A request for correction of a defect in a supported release of a program supplied by IBM.

B
base map

A map that depicts background reference information such as landforms, roads, landmarks, and
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political boundaries, onto which other thematic information is placed. A base map is used for
locational reference and often includes a geodetic control network as part of its structure.

C
cache Memory used to improve access times to instructions, data, or both. Data that resides in cache

memory is normally a copy of data that resides elsewhere in slower, less expensive storage, such
as on a disk or on another network node.

CAP See Common Alerting Protocol.

cloud application
An application that is extended to be accessible through the Internet. Cloud applications use large
data centers and powerful servers that host web applications and web services.

Common Alerting Protocol (CAP)
A simple but general format for exchanging all-hazard emergency alerts and public warnings
over all kinds of networks.

common widget
A widget provided by IBM that is not associated with a particular product. See also widget.

configuration

1. The manner in which the hardware and software of a system, subsystem, or network are
organized and interconnected.

2. The process of describing to a system the devices, optional features, and program products
that have been installed so that these features can be used. See also customization.

CSV file
A text file that contains comma-separated values. A CSV file is commonly used to exchange files
between database systems and applications that use different formats.

customization

1. The process of describing optional changes to defaults of a software program that is already
installed on the system and configured so that it can be used. See also configuration.

2. The modification of a portal page or portlet by a user. WebSphere Portal enables a user to
customize a portal page by modifying the page layout and by selecting which portlets will
display per device. See also personalization.

D
dashboard

1. An interface that integrates data from a variety of sources and provides a unified display of
relevant and in-context information.

2. A web page that can contain one or more widgets that graphically represent business data.

data item
Self-contained data messages that can be sent or processed by all components.

data source
An external source of data, for example, a database or a file, that can supply a wide variety of
data in the required format.

domain
An individual division of a major operation, which generally matches the organization structure
and the expertise of the people involved. For example, a city authority is divided into
departments dealing with transportation, water, and public safety.
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E
EAR See enterprise archive.

EJB See Enterprise JavaBeans.

enterprise archive (EAR)
A specialized type of JAR file, defined by the Java EE standard, used to deploy Java EE
applications to Java EE application servers. An EAR file contains EJB components, a deployment
descriptor, and web archive (WAR) files for individual web applications. See also Java archive.

Enterprise JavaBeans (EJB)
A component architecture defined by Sun Microsystems for the development and deployment of
object-oriented, distributed, enterprise-level applications (Java EE).

expression KPI
A KPI that has its value calculated from the values of the other KPIs.

Extensible Markup Language (XML)
A standard metalanguage for defining markup languages that is based on Standard Generalized
Markup Language (SGML).

G
GDDM

See Graphical Data Display Manager.

geospatial
Pertaining to the geographical characteristics of the Earth.

Graphical Data Display Manager (GDDM)
An IBM computer-graphics system that defines and displays text and graphics for output on a
display or printer.

group A collection of users who can share access authorities for protected resources.

H
HA See high availability.

heap In Java programming, a block of memory that the Java virtual machine (JVM) uses at run time to
store Java objects. Java heap memory is managed by a garbage collector, which automatically
de-allocates Java objects that are no longer in use.

high availability (HA)
The ability of IT services to withstand all outages and continue providing processing capability
according to some predefined service level. Covered outages include both planned events, such as
maintenance and backups, and unplanned events, such as software failures, hardware failures,
power failures, and disasters.

hotspot
A colored circle on a geospatial map that represents a cluster of data items that are collected and
analyzed based on proximity and time critera that the user defines.

hover help
Explanatory text that can be viewed by moving a cursor over a graphical user interface (GUI)
item such as an icon, field, or text string. Hover help can contain rich text and links.

I
integration

The software development activity in which separate software components are combined into an
executable whole.
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ISO model
A set of rules for data communication, sanctioned by the International Organization for
Standardization (ISO). The ISO protocols enable systems supplied by different vendors to connect
and communicate. They are the basis of the open systems interconnection (OSI) standards.

J
JAR See Java archive.

Java archive (JAR)
A compressed file format for storing all of the resources that are required to install and run a Java
program in a single file. See also enterprise archive.

Java EE
See Java Platform, Enterprise Edition.

Java Naming and Directory Interface (JNDI)
An extension to the Java platform that provides a standard interface for heterogeneous naming
and directory services.

Java Platform, Enterprise Edition (Java EE)
An environment for developing and deploying enterprise applications, defined by Oracle. The
Java EE platform consists of a set of services, application programming interfaces (APIs), and
protocols that provide the functionality for developing multitiered, web-based applications.
(Oracle)

JavaScript Object Notation (JSON)
A lightweight data-interchange format that is based on the object-literal notation of JavaScript.
JSON is programming-language neutral but uses conventions from various languages.

Java virtual machine (JVM)
A software implementation of a processor that runs compiled Java code (applets and
applications).

JNDI See Java Naming and Directory Interface.

JSON See JavaScript Object Notation.

JVM See Java virtual machine.

K
key performance indicator (KPI)

A quantifiable measure that is designed to track one of the critical success factors of a business
process.

keystore
A repository that contains password information.

KPI See key performance indicator.

KPI model
The part of the monitor model that contains the KPI contexts, which in turn contain key
performance indicators and their associated triggers and events.

KPI policy
A policy that determines if an incoming event is a KPI event update, then sends it for processing
to generate a KPI update or an alert depending on parameters.
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L
latitude

The angular distance of a place north or south of the earth's equator, usually expressed in degrees
and minutes.

layer An overlay that can be placed on the map to provide additional geospatial information.

LDAP See Lightweight Directory Access Protocol.

LDAP Directory Interchange Format (LDIF)
A file format that is used to describe directory information as well as changes that need to be
applied to a directory, such that directory information can be exchanged between directory
servers that are using LDAP.

LDIF See LDAP Directory Interchange Format.

level of service (LOS)
A qualitative measure used in the transportation industry by traffic engineers to determine the
effectiveness of elements of a transportation infrastructure. This measure describes the operational
conditions of traffic as defined in the Highway Capacity Manual.

Lightweight Directory Access Protocol (LDAP)
An open protocol that uses TCP/IP to provide access to directories that support an X.500 model
and that does not incur the resource requirements of the more complex X.500 Directory Access
Protocol (DAP). For example, LDAP can be used to locate people, organizations, and other
resources in an Internet or intranet directory.

linear reference
A location reference marker along a roadway, generally on a shoulder, indicating its location
along a route. An example of a marker is a milepost.

location map
A map or plan containing interactive areas that have been defined in the IBM Intelligent
Operations Center. Events can be associated with one or more of these areas. For example, a
diagram of seating areas in a major sports stadium can be defined so that events that have
occurred can be associated with the appropriate area.

logical zone
A logical grouping of assets or events in a geographical area.

longitude
The angular distance of a place east or west of the meridian at Greenwich, England, usually
expressed in degrees and minutes.

LOS See level of service.

M
monitoring context instance

Information in IBM Business Monitor that is collected at a specific point in time within a
monitoring context.

monitor model
A model that describes the business performance management aspects of a business model,
including events, business metrics, and key performance indicators (KPIs) that are required for
real-time business monitoring.

N
nested KPI

A KPI that is defined as a child of a parent KPI.
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notification
A message that signals an event or key performance indicator (KPI) status change.

notification trigger
A predefined key performance indicator (KPI) value change that causes an alert notification to be
sent to the Coordinator - Alerts portlet.

O
operations view

A web page that contains portlets that can cooperate to facilitate comprehensive information
supply and interaction at operations level for monitoring incoming data from data sources, and
for responding to incoming data.

P
page In a portal environment, the interface element that contains one or more portlets.

personalization
The process of enabling information to be targeted to specific users based on business rules and
user profile information. See also customization.

plug-in
A separately installable software module that adds function to an existing program, application,
or interface.

PMR See problem management record.

polygon
In the GDDM function, a sequence of adjoining straight lines that enclose an area.

polyline
A shape that consists of only straight lines.

portal A single, secure point of access to diverse information, applications, and people that can be
customized and personalized.

portlet
A reusable component that is part of a web application that provides specific information or
services to be presented in the context of a portal.

preview card
A window that is displayed when a user clicks a marker on either a geospatial map or a location
map, or when a user clicks a row on the List tab. The window displays information about the
associated data item.

problem management record (PMR)
The number in the IBM support mechanism that represents a service incident with a customer.

R
RDF See Resource Description Framework.

Really Simple Syndication (RSS)
An XML file format for syndicated web content that is based on the Really Simple Syndication
specification (RSS 2.0). The RSS XML file formats are used by Internet users to subscribe to
websites that have provided RSS feeds.

Representational State Transfer (REST)
A software architectural style for distributed hypermedia systems like the World Wide Web. The
term is also often used to describe any simple interface that uses XML (or YAML, JSON, plain
text) over HTTP without an additional messaging layer such as SOAP.
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resource bundle

1. A structured collection of data that provides a key-value mapping for data (resources) used in
localizing a program. The values are commonly strings, but may themselves be structured
data.

2. A class that contains the text for the store pages. Bundle files are created and accessed
according to the Java PropertyResourceBundle API.

Resource Description Framework (RDF)
A framework for representing information on the web.

REST See Representational State Transfer.

RSS See Really Simple Syndication.

S
Secure Sockets Layer (SSL)

A security protocol that provides communication privacy. With SSL, client/server applications can
communicate in a way that is designed to prevent eavesdropping, tampering, and message
forgery.

SGML
See Standard Generalized Markup Language.

shapefile
A digital file format for geographic information systems software.

single sign-on (SSO)
An authentication process in which a user can access more than one system or application by
entering a single user ID and password.

skin An element of a graphical user interface that can be changed to alter the appearance of the
interface without affecting its functionality.

SOAP A lightweight, XML-based protocol for exchanging information in a decentralized, distributed
environment. SOAP can be used to query and return information and invoke services across the
Internet. See also web service.

solution
A combination of products that addresses a particular customer problem or project.

SOP See standard operating procedure.

SPARQL
A query language for RDF that is used to express queries across diverse data sources. The W3
specification defines the syntax and semantic of the SPARQL query language.

SSL See Secure Sockets Layer.

SSO See single sign-on.

standard environment
IBM Intelligent Operations Center installed on a series of servers, where each server provides
specific services to the solution.

Standard Generalized Markup Language (SGML)
A standard metalanguage for defining markup languages that is based on the ISO 8879 standard.
SGML focuses on structuring information rather than presenting information; it separates the
structure and content from the presentation. It also facilitates the interchange of documents across
an electronic medium.

standard operating procedure (SOP)
A procedure defining a sequence of activities that are triggered in response to an event whose
parameters meet certain predefined conditions.
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Standard Operating Procedure selection matrix
A matrix containing unique sets of event parameters that determine whether a standard operating
procedure is initiated for a particular event.

status view
A web page that facilitates comprehensive information supply at status level for monitoring
incoming data from data sources. For example, a status view can contain a consolidated view of
data that is displayed as key performance indicators.

system properties
System-wide configuration data for the IBM Intelligent Operations Center.

T
TAI See trust association interceptor.

TCP/IP
See Transmission Control Protocol/Internet Protocol.

theme The style element that gives a place a particular look. The portal provides several themes, similar
to virtual wallpaper, which can be chosen when creating a place.

Transmission Control Protocol/Internet Protocol (TCP/IP)
An industry-standard, nonproprietary set of communication protocols that provides reliable
end-to-end connections between applications over interconnected networks of different types.

trigger
A mechanism that detects an occurrence and can cause additional processing in response.

trust association interceptor (TAI)
The mechanism by which trust is validated in the product environment for every request received
by the proxy server. The method of validation is agreed upon by the proxy server and the
interceptor.

U
Uniform Resource Identifier (URI)

1. A compact string of characters for identifying an abstract or physical resource.
2. A unique address that is used to identify content on the web, such as a page of text, a video

or sound clip, a still or animated image, or a program. The most common form of URI is the
web page address, which is a particular form or subset of URI called a Uniform Resource
Locator (URL). A URI typically describes how to access the resource, the computer that
contains the resource, and the name of the resource (a file name) on the computer.

Uniform Resource Locator (URL)
The unique address of an information resource that is accessible in a network such as the
Internet. The URL includes the abbreviated name of the protocol used to access the information
resource and the information used by the protocol to locate the information resource.

URI See Uniform Resource Identifier.

URL See Uniform Resource Locator.

user administrator
A person who adds new users and ensures security by giving users membership of role-based
authorization groups with appropriate permissions.

user permission
The authority granted to a user to give them access to view and work with portal resources. This
authority is granted by membership of a user role group.
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user profile
A description of a user that includes such information as user ID, user name, password, access
authority, and other attributes that are obtained when the user logs on.

user role group
A group that assigns membership to give a new user the appropriate level of access to the
solution. Each new user is added as a member of the appropriate role group. There are different
permission levels associated with each role group.

V
Virtual Network Computing (VNC)

A graphical desktop sharing system that uses the remote frame buffer (RFB) protocol to remotely
control another computer. It transmits the keyboard and mouse events from one computer to
another, relaying the graphical screen updates back in the other direction, over a network.

VNC See Virtual Network Computing.

W
Web Map Service (WMS)

A standard protocol for serving georeferenced map images over the Internet that are generated by
a map server using data from a GIS database. The specification was developed and first
published by the Open Geospatial Consortium in 1999.

web service
A self-contained, self-describing modular application that can be published, discovered, and
invoked over a network using standard network protocols. Typically, XML is used to tag the data,
SOAP is used to transfer the data, WSDL is used for describing the services available, and UDDI
is used for listing what services are available. See also SOAP.

Web Service Definition Language (WSDL)
An XML-based specification for describing networked services as a set of endpoints operating on
messages containing either document-oriented or procedure-oriented information.

widget
A reusable user interface component such as a button, scroll bar, control area, or text edit area,
that can receive input from the keyboard or mouse and can communicate with an application or
with another widget. See also common widget.

WMS See Web Map Service.

WO See work order.

workflow
A specific set of actions appropriate to a particular set of circumstances. The solution can be
customized to trigger appropriate workflows, for example connecting to emergency response
systems.

work order (WO)
A record that contains information about work that must be performed.

WSDL
See Web Service Definition Language.

X
XML See Extensible Markup Language.

XML schema
A mechanism for describing and constraining the content of XML files by indicating which
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elements are allowed and in which combinations. XML schemas are an alternative to document
type definitions (DTDs) and can be used to extend functionality in the areas of data typing,
inheritance, and presentation.

Accessibility
Accessibility features help users with physical disabilities, such as restricted mobility or limited vision, to
use software products successfully.

The major accessibility features in this product enable users to do the following:
v Use assistive technologies, such as screen-reader software and digital speech synthesizer, to hear what

is displayed on the screen. Consult the product documentation of the assistive technology for details
on using those technologies with this product.

v Operate specific or equivalent features using only the keyboard.
v Magnify what is displayed on the screen.

In addition, the documentation was modified to include the following features to aid accessibility:
v All documentation is available in XHTML formats to give the maximum opportunity for users to apply

screen-reader software technology.
v All images in the documentation are provided with alternative text so that users with vision

impairments can understand the contents of the images.

The solution includes the following features to aid accessibility:
v All pages include an accessibility prologue that describes the links that you use to skip over the

navigation elements of each page. The prologue also includes the set of keyboard shortcuts that are
available.

v All pages include landmarks that define the start of the different sections of a page, for example,
banner, navigation and main content.

v Activate the field help where it is present from the keyboard by pressing CTRL+SHIFT+?.
v Activate the Contacts portlet in the solution from the keyboard with the Mozilla Firefox browser by

pressing ALT+SHIFT+C.

Note: Ensure that the Contacts portlet is displayed before you press the shortcut keys. The shortcut
might differ in Chrome and Internet Explorer 9.

v The following web browser and screen reader are recommended:

Web browser
Mozilla Firefox 17 extended support release

Screen reader
Freedom Scientific JAWS 14

Privacy policy considerations
IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies
or other technologies to collect product usage information, to help improve the end user experience, to
tailor interactions with the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings can help enable you to
collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect personally identifiable
information.
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This Software Offering uses cookies for session management and single sign-on configuration. If you
disable cookies, you will not be able to access the system.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, see
IBM’s Privacy Policy at http://www.ibm.com/privacy, and IBM’s Online Privacy Statement at
http://www.ibm.com/privacy/details that includes the section entitled “Cookies, Web Beacons and
Other Technologies”. Also, see the “IBM Software Products and Software-as-a-Service Privacy Statement”
at http://www.ibm.com/software/info/product-privacy.

In Japan, for more information about the use of various technologies, including cookies, for these
purposes, see IBM’s Privacy Policy at http://www.ibm.com/privacy/jp/ja/, and IBM’s Online Privacy
Statement at http://www.ibm.com/privacy/details/jp/ja/ that includes the section entitled “Cookies,
Web Beacons and Other Technologies”. Also, see the “IBM Software Products and Software-as-a-Service
Privacy Statement” at http://www.ibm.com/software/info/product-privacy.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM web sites are provided for convenience only and do not in
any manner serve as an endorsement of those web sites. The materials at those web sites are not part of
the materials for this IBM product and use of those web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
Department T81B F6/Building 503
4205 S. Miami Boulevard
Durham NC 27709-9990
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Trademarks
Cognos, CPLEX, IBM, ibm.com, DB2, Domino, GDDM, ILOG, Lotus, Notes, Passport Advantage,
Rational, Sametime, Tivoli, Service Request Manager, Smarter Cities, SPSS, Redbooks, WebSphere, and
Worklight, are trademarks of the IBM Corporation in the United States, other countries, or both.

Microsoft, Internet Explorer, Windows, and the Windows logo are trademarks of Microsoft Corporation in
the United States, other countries, or both.
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Intel and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the
United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Adobe, Acrobat, Portable Document Format (PDF), and PostScript are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States, other countries, or both.

Oracle, Javascript, JavaBeans, and Java are registered trademarks of Oracle and/or its affiliates.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other names may be trademarks of their respective owners. Other company, product, and service names
may be trademarks or service marks of others.
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Readers’ Comments — We'd Like to Hear from You

IBM Intelligent Operations Center
IBM Intelligent Operations Center
Product Documentation
Version 1 Release 6

We appreciate your comments about this publication. Please comment on specific errors or omissions, accuracy,
organization, subject matter, or completeness of this book. The comments you send should pertain to only the
information in this manual or product and the way in which the information is presented.

For technical questions and information about products and prices, please contact your IBM branch office, your
IBM business partner, or your authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any
way it believes appropriate without incurring any obligation to you. IBM or any other organizations will only use
the personal information that you supply to contact you about the issues that you state on this form.

Comments:

Thank you for your support.

Submit your comments using one of these channels:
v Send your comments to the address on the reverse side of this form.
v Send a fax to the following number: 1-800-227-5088 (US and Canada)

If you would like a response from IBM, please fill in the following information:

Name Address

Company or Organization

Phone No. Email address
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